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Special notice

Before using this information and the product it supports, read the information in Notices  on page 580.



Chapter 1. Test Author Guide

This guide describes how to create test scripts in Rational®  Performance Tester  and enhances tests by 

applying different test elements such as dataset, variables, and verification points. This guide is intended 

for testers.

Creating tests
To create a test, you record representative interactions with an application.

After you record a test, you can play it back to confirm that the recorded actions do what you expect.

Note:  When you record a test that includes a file download, the file is not physically saved to disk. 

However, you can confirm that the file was retrieved from the server by looking in the response of the 

request that asked for the file. One method to locate the request for large downloaded files is to look for a 

request with a large response size.

1. Click the test name  in test editor.

2. Click  Select.

3. Select HTTP Request.

Creating a project
The tests that you create, and the assets associated with the tests, reside in a project on your desktop. 

You can create the project separately, or you can simply record a test, which automatically creates a 

project named testproj.

1. Select File  > New  > Performance Test Project  or .

The Create a Project  window opens.

2. In the Project Name  field, type a name for the project.

If you plan to collect response time breakdown data, do not use a project name that contains 

spaces.

3. Select Use default location.

4. Optional: Click Next  and select the folders to create in the new project. These folders organize your 

files by asset (Tests, Results, and so on).
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5. Click Finish.

After you click finish, you are prompted to record a test. You can create a test from a new recording 

or from an existing recording, or just click Cancel  to create a test project without recording a test.

Performance testing tips
Use these tips to make IBM®  Rational®  Performance Tester  run faster and more efficiently. These tips do 

not apply to IBM®  Rational®  Service Tester for SOA Quality.

The following suggestions can help you to get the best performance from Rational®  Performance Tester:

• Number of computers.  Have at least two computers for a test. The user interface consumes 

significant resources; therefore play back a test or schedule on a computer (agent) that is separate 

from the computer that is running the workbench (UI).

• Number of virtual users at remote locations. When you assign a user group to a remote location, 

do not overload the remote computer (agent). If you exceed the number of virtual users that the 

remote computer can run, the performance measurements of the server will be skewed because 

they will be affected by the performance of the computer. The test results will reflect the load 

of the computer more than the load of the server. For best results on a computer with a 1 GHz 

processor and 1 GB of RAM, do not exceed 1000 concurrent virtual users.

• TCP/IP ports.  Your computer must have a sufficient number of TCP/IP ports. On computers with 

Microsoft™  Windows™, the typical limit is 5000. Issue the netstat -a  command to observe port use. 

If the largest number you see is 5000, then you need to increase the number. To increase it, open 

the registry. Under HKEY_LOCAL_MACHINE/SYSTEM/CurrentControlSet/Services/Tcpip/Parameters, 

create a new dWord  named MaxUserPort, and set its value up to 65000. Restart the computer.

• Open file limit for Linux™.  Computers that are running Linux™  need a per-process open file limit 

higher than 1024. As root, enter ulimit -n 30000  (or another appropriate value) before starting 

Agent Controller.

• Looping within tests.  If you are stress testing a server, your test typically contains a loop. Your 

connection behavior differs depending upon whether the loop is set at the schedule level or at 

the test level. Setting a loop at the test, rather than the schedule, level gives you a performance 

advantage, because the connections are reused during the looping process. For more information, 

see Add a loop  on page .

• Logging levels.  After the test is stable, for maximum performance, reduce the test log level and 

problem determination log level and sample a small number of users. Increase the statistics 

sample interval to 30 or 60 seconds for long-running tests.
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• Workbench heap size.  The Java™  Virtual Machine (JVM) heap size on the workbench is based 

on the available physical memory. Do not run the workbench on a computer with less than 768 

MB of physical memory. The maximum workbench heap size depends on your JVM. Although 

the heap size is not strictly necessary for playback performance, you can increase the workbench 

heap size. To increase the heap size, set the -Xmx parameter in the eclipse.ini  file, which is 

located in the product installation directory. For Windows™, if your physical memory is 3 GB or 

more, then the maximum heap size must not exceed 1200 MB. For Linux™, the maximum heap size 

is approximately 3000 MB. If the workbench is sluggish or fails to start after you increase the heap 

size, reset the heap size to the default by removing the VMARGS=-Xmx  line from the eclipse.ini 

file.

• Location (agent) heap size.  To access maximum heap, after one successful test of any size, 

search for a location (agent) attribute called RPT_DEFAULT_MEMORY_SIZE. If you cannot find this 

attribute, you can specify a maximum heap by creating a new attribute: RPT_VMARGS=-Xmx1500m 

(for example, max heap 1.5 GB). For more information, see Increasing memory allocation  on page 

.

Rational®  Performance Tester  sets heap size for RPT_DEFAULT_MEMORY_SIZE based on the bit-

type of the JRE:

◦ For 32-bit Java Runtime Environment (JREs), Rational®  Performance Tester  sets 70% of the 

size of physical memory to RPT_DEFAULT_MEMORY_SIZE. Typically, the maximum limit is 

set to 1200m.

◦ For 64-bit JREs, some workloads might perform better with a lesser heap size than 70% of 

physical memory up to a maximum of 12000m.

• Disk space.  Verify that there is sufficient free disk space on the workbench and agent computers. 

Also, verify that there is sufficient free disk space on the drive that contains the system temporary 

directory.

• Recording length.  If you record for a relatively long time, test generation also takes a long time. If 

test generation is taking a relatively long time, try shorter recording scenarios.

For more information about capacity planning, see this document.

Recording HTTP tests
When you record a test, the test creation wizard records your interactions with a web-based application, 

generates a test from the recording, and opens the test for editing. You can record tests from Internet 

Explorer (which is the default on Windows™) or from another browser.
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Recording reliable HTTP tests
You use a web browser to capture the HTTP test. To record reliable HTTP tests, certain configuration of 

the web browsers are required. Read the guidelines in this topic for robust HTTP tests.

Remove temporary files

To ensure that your recording accurately captures HTTP traffic, remove temporary files from the web 

browser's cache before you record a test.

To remove temporary files from the Microsoft Internet Explorer cache:

1. Open Internet Explorer, and click Tools  > Options.

2. On the General  tab, click Delete.

3. In the Delete Browsing History  window, click Delete, and then click OK.

To remove temporary files from the Mozilla FireFox cache:

1. Open Mozilla Firefox and click Tools  > Options.

2. Click the Advanced  tab and then the Network  tab.

3. Click Clear Now.

4. Click OK.

Allow recorded pages to load completely

When recording, wait for each page to load completely. This wait does not affect performance results, 

because you can remove extra think time when you play back the test.

Recording with IP addresses
When recording, you can enter the IP address of the website to connect to instead of entering the host 

name. When you play back the test, however, make sure that the IP address can resolve to a host name. 

Typically, this resolution occurs via a reverse DNS lookup.

Note:  While recording a test in Internet Explorer, if you use localhost  in the URL, Internet Explorer 

does not route the traffic through Rational®  Performance Tester  Agent. The test will not contain any 

recorded data. You must use a host name or IP address to record the traffic.

To resolve the IP address, map each IP address to a host name in the /etc/hosts  file. On a Windows 

system, the file is typically stored in C:\windows\system32\drivers\etc\hosts.

If an address cannot be resolved, your test shows a slower connection time. This time might be delayed 

by as much as 8 seconds, depending on the network configuration of the computer.
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Related information

Configuring Internet Explorer for recording from a secure web site  on page7

Recording an HTTP test  on page8

Recording a WebSocket test  on page15

Recording an HTTP test for mobile applications  on page16

Generating HTTP tests from a Web UI test  on page20

Preparing to record a test for the HTTP/2 protocol  on page22

Splitting an HTTP test during recording  on page23

Returning a browser to its initial state if recording is interrupted  on page26

Creating HTTP tests manually  on page27

Creating tests from HTTP Archive files  on page34

Recording Adobe Flex content  on page36

Recording Microsoft Silverlight applications  on page38

Changing HTTP test generation preferences  on page38

Configuring the workbench for NTLMv2 authentication  on page

Configuring Internet Explorer for recording from a secure web site
You can suppress the security warning that Internet Explorer displays when you are recording from a 

secure web site.

IBM®  Rational®  Performance Tester  uses a proxy recording program that intercepts all traffic between 

the browser and the web server. During recording at a secure web site (with a web address that 

starts with https://), by default you see a security warning before every action and must confirm your 

acceptance of a security risk to continue.

If you do nothing, this warning is displayed with every browser action, and you must repeatedly click Yes 

to continue. Performing the following procedure installs the recorder certificate on the local host as a 

trusted authority and thereby disables warnings from Internet Explorer during recording at secure web 

sites. This procedure does not affect other browsers that record from secure web sites—they will display 

warnings before every action.

To disable security warnings when using Internet Explorer to record from a secure web site:
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1. During test recording, the first time the warning is displayed, click View Certificate.

2. In the Certificate  window, click Install Certificate.

3. In the Certificate Import Wizard  window, click Next.

4. On the second page of the wizard, click Next.

5. On the last page of the wizard, click Finish.

6. In the Root Certificate Store  confirmation window, click Yes.

7. In the window that reports that the import was successful, click OK.

8. In the Certificate  window, click OK.

9. In the Security Alert  window, click OK.

Related information

Recording reliable HTTP tests  on page5

Recording an HTTP test  on page8

Recording a WebSocket test  on page15

Recording an HTTP test for mobile applications  on page16

Generating HTTP tests from a Web UI test  on page20

Preparing to record a test for the HTTP/2 protocol  on page22

Splitting an HTTP test during recording  on page23

Returning a browser to its initial state if recording is interrupted  on page26

Creating HTTP tests manually  on page27

Creating tests from HTTP Archive files  on page34

Recording Adobe Flex content  on page36

Recording Microsoft Silverlight applications  on page38

Changing HTTP test generation preferences  on page38

Configuring the workbench for NTLMv2 authentication  on page

Recording an HTTP test
To test the performance of an application, you must first record the HTTP traffic that traverses between 

the client and the server. You record the HTTP traffic of the application by initiating the recording from the 

product. When you record the test, a proxy recorder intercepts the HTTP traffic between the browser and 

the web server.
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Certain websites require appropriate certificates to use a proxy recorder to record the site. The recorder 

certificate is required to record all the secured sites. The client certificate is different and it serves as 

an additional layer of security that is required by the web server to authenticate the client/browser. If 

some applications use Secure Sockets Layer (SSL), the proxy recorder can cause authentication problems 

because SSL relays traffic between the client and the server. Depending on the authentication method in 

place, the client might require the proxy recorder to authenticate itself as the server, and the server might 

require the proxy recorder to authenticate as the client. If the client program requires an authenticated 

server, you must either have access to the server certificate keystore and provide it to the proxy recorder 

or configure the client to accept the default certificate from the proxy recorder instead of the certificate 

from the actual server.

If you have recorded a test that does not use SSL, you can convert that test to be secure by adding an SSL 

object to the corresponding Server Access Configuration in the test. 

To record an application that requires a client-side certificate, import the client certificate to the Rational® 

Performance Tester  project. To import the certificate, click File  > Import  > General  > File System, and 

navigate to the folder that contains the certificates and click Finish.
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The following recorders are available for recording HTTP traffic from a browser:

• SOCKS proxy recorder:  Use this recorder when no proxy connections are required.

• HTTP proxy recorder: Use this recorder when proxy connections are required to connect to the 

network or when the client program does not support SOCKS.

• Socket recorder: Use this recorder for low-level network traffic when the client does not support 

proxies.
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You can record and generate a test by using REST APIs. The API documentation to 

record a test is located at Install_directory\IBM\IBMIMShared\plugins

\com.ibm.rational.test.lt.server.recorder.jar. The API documentation to generate a 

test after the recording completes is located at C:\Program Files\IBM\IBMIMShared\plugins

\com.ibm.rational.test.lt.server.testgen.jar.

1. In the Performance Test perspective, on the toolbar, click the New Test From Recording  icon  or 

click File  > New  > Test From Recording.

2. In the New Test From Recording  wizard, click Create a test from a new recording, select HTTP 

Test, and click Next.

If you are recording sensitive data, click Recording encryption level  and select the encryption level 

to record.

3. On the Select Location  page, select the project and folder to create the test in, type a name for the 

test, and click Next.

If necessary, click the Create the parent folder  icon  to create a performance test project or 

folder.

4. On the Select Client Application  page, select the web browser to use.

The type of application defines the recorder that can be used. The following client application types 

are supported for recording a service test:

• Microsoft Internet Explorer: This option records traffic that is sent and received with Internet 

Explorer.

• Mozilla Firefox: This option records traffic that is sent and received with Firefox.

• Google Chrome: This option records traffic that is sent and received with Chrome.

• Apple Safari: This option records traffic that is sent and received with Safari.

• Opera: This option records traffic that is sent and received with Opera.

• Managed Application: This option starts a browser that is not on the list.

• Microsoft Edge: This option records traffic that is sent and received with Edge.

• Unmanaged Application: This option records HTTP traffic from one or multiple client 

programs that use a proxy. You must manually start the client programs, and the proxy 

recorder records all traffic that is sent and received through the specified network port.

5. Depending on your selection in Step 4, perform one of the following steps: On the Recorder 

Settings  page, depending on the browser that you selected, specify the following details:

a. If you selected a browser, specify the recording method:

• To record HTTP or SOCKS traffic through a proxy, click Record traffic with the proxy 

recorder. To record low-level network traffic for applications where a proxy cannot be 

used, click Record traffic with the socket recorder. Use this option when you are not 

using Mozilla Firefox or Microsoft™  Internet Explorer.
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Note:  When using proxy recording, you can filter out HTTP or HTTPS requests to 

a specific endpoints so that any requests to those endpoints are not recorded. See 

Proxy recording preferences  on page .

• If IBM®  Rational®  Functional Tester  is installed and shell-shared with Rational® 

Performance Tester, for the Web UI tests, you can use the Record user actions  option 

to record the functional aspects of the application in the same HTTP recording 

session. Thus, both the functional and performance aspects of the application are 

recorded.

• If the server requires client SSL authentication, provide the client certificate for the 

proxy recorder to be authenticated by the server as though the proxy recorder were 

the client. Select The server requires a specific client certificate.

To provide single certificate keystore, specify the file name and password of the 

server certificate keystore. If multiple certificates are required, click Multiple 

certificates, and click Add  to specify a certificate keystore file name and password 

for each host name and port.

• To record a secured site using Internet Explorer or Google Chrome on Windows, 

install the recorder certificate by selecting Register the recorder root certificate 

authority. Before the recording starts, the browser prompts you to install the 

certificate. After the recording is stopped, the browser prompts you to uninstall the 

certificate. To avoid multiple prompts for each recording, select Keep the recorder 

root certificate authority after recording.

Note:  If you already had the certificate from a version prior to 9.2.1 and then 

install the latest version of the product, you might have to install the certificate again.

This option is not available when you record by using the Firefox or Safari 

browser. To record a secured site on these browsers, manually import the 

certificate in the browser from the default location C:\Program Files 

(x86)\__VENDOR_NAME__\__VENDOR_NAME__IMShared\plugins

\com.ibm.rational.test.lt.recorder.proxy_version\SSLCertificate. 

For information about how to import the certificates, see the browser's 

documentation.

• If you selected Mozilla Firefox, you can choose to use a temporary Firefox profile. 

This option starts the Firefox browser without any bookmarks, plug-ins, or toolbars 

that might be associated with your usual profile. Select Use an alternate Firefox 

profile, and then select Use a temporary Firefox profile.

unique_23
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• If you clicked Record traffic with the proxy recorder, click Advanced  to specify 

whether to use an HTTP or SOCKS proxy recorder to review and edit network 

connection settings that the browser uses or to specify advanced SSL authentication 

settings. If you clicked Record traffic with the socket recorder, specify the advanced 

SSL authentication settings.

b. If you selected Managed Application, complete the following steps:

i. On the Recording Method  page, click a recorder to record HTTP traffic and click Next.

ii. On the Managed Application Options  page, for Program path, click Browse  to select 

the program. If necessary, specify the Working directory, and in the Arguments  field, 

type the command-line arguments that the program requires. Click Next.

iii. If the program requires user input from a command-line interface, select the Open 

console for user input  check box. Click Next.

iv. Depending on the recording method that you selected, complete one of the following 

steps:

• On the Proxy Recorder Settings  page, specify whether to use an HTTP or 

SOCKS proxy recorder to review and edit network connection settings that the 

browser uses or to specify the advanced SSL authentication settings.

• On the Socket I/O Recorder Secured Settings  page, specify the advanced SSL 

authentication settings.

c. If you selected Unmanaged Application, on the Proxy Recorder Settings  page, specify 

whether to use an HTTP or SOCKS proxy recorder to review and edit network connection 

settings that the browser uses or to specify the advanced SSL authentication settings.

To record an HTTP test from a mobile device, see Recording an HTTP test for mobile 

applications  on page 16.

6. Click Finish.

A progress window opens while your browser starts.

7. In the browser address field, type the address of the web application to test, and activate the link.

Note:  If you enter the address of a secure website (one that starts with https:), your browser 

might display a security alert. Depending on the security certificate for the site, you might be 

required to accept a security risk to proceed with the recording.

8. Complete the user tasks to test. While you are recording, adhere to the following guidelines:

• Wait for each page to load completely. This wait does not affect performance results, 

because you can remove extra waiting time (think time) when you play back the test.

• Do not change any browser preferences.

You can use the Recorder Test Annotations  toolbar to add comments, record synchronizations, or 

take screen captures during the recording.
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• To change the page name, click the Change page name  icon . In the resulting test, the 

page element in the test editor uses the new name; however, the original name is preserved 

in the Page Title Verification Point  area so that page title verification points still work 

correctly.

• To add a comment to the recorded test, click the Insert comment  icon . Add a comment 

when you get a prompt.

• To add a screen capture to the recorded test, click the Capture screen  icon . The screen 

and window captures make your tests easier to read and help you visualize the recorded 

test. You can change the settings for screen captures and add a comment to the image.

• To manually add a synchronization point to the recording, click the Insert synchronization 

icon .

• To manually add a transaction folder to the recording, click the Start Transaction  icon 

 and Stop Transaction  icons  to start and stop the transaction. Transactions can be 

nested.

• To insert a split point into the recorded test, click the  Split point  icon . With split points, 

you can generate multiple tests from a single recording, which you can replay in a different 

order with a schedule. See Splitting an HTTP test during recording  on page 23 for more 

information about splitting a test.

• To filter packets that display during recording sessions, click the Filter packets   icon. 

You can specify the filter criteria for the following elements:

◦ SAP packet type

◦ SAP packet attribute

◦ Socket packet type

◦ Socket packet attribute

◦ Packet type

◦ Proxy connection IDs

◦ Citrix events

◦ A group of conditions

◦ Remote host

You can add and remove packet filters as needed.

9. After you finish the user tasks in the browser, stop the recorder. You can stop the browser by 

closing the client program or by clicking the  Stop  icon  in the Recording Control  view.

10. Select the domains to include in the test and click Finish. The domains that are not selected are 

not included in the test. You can add them back by generating the test again from the recording.
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To include all the domains for all of the recordings, click the Select all and remember my decision 

check box. To enable the filter again for HTTP tests, click Window  > Preferences  > Test  > Test 

Generation  > HTTP Test Generation, and, for Service tests, click Service Test Generation  and then 

click the Enable domain review before test generation  check box.

A progress window is displayed while the test is generated. After the test is complete, the Recording 

Control  view displays the Test generation completed  message, the test navigator lists your test, and the 

test opens in the test editor.

Related information

Recording reliable HTTP tests  on page5

Configuring Internet Explorer for recording from a secure web site  on page7

Recording a WebSocket test  on page15

Recording an HTTP test for mobile applications  on page16

Generating HTTP tests from a Web UI test  on page20

Preparing to record a test for the HTTP/2 protocol  on page22

Splitting an HTTP test during recording  on page23

Returning a browser to its initial state if recording is interrupted  on page26

Creating HTTP tests manually  on page27

Creating tests from HTTP Archive files  on page34

Recording Adobe Flex content  on page36

Recording Microsoft Silverlight applications  on page38

Changing HTTP test generation preferences  on page38

Configuring the workbench for NTLMv2 authentication  on page

Creating tests  on page3

Recording reliable HTTP tests  on page5

Recording sensitive session data  on page141

Recording a test with digital certificates  on page132

Recording a WebSocket test
If your application is based on the WebSocket protocol, you can check the performance of the application 

by creating a recording of the application and playing it back.
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WebSocket is not a separate test extension in the product. To test a WebSocket application, you have to 

record the HTTP  test. After the recording completes, you must not delete or change the content of the 

requests, response, and connection objects in the test script.

To record the HTTP test, see Recording an HTTP test  on page 8. The requests and responses contain 

text or binary data. You can do data correlation on the text data.

Starting from V9.1.1.1, the WebSocket test generation automatically does data correlation. See 

Correlating request and response data  on page 361.

Starting from V9.1.1.1, you can specify error handling behavior for WebSocket tests. See Specifying error 

handling behavior  on page 304.

Starting from V9.2.0, you can add verification points to the requests and responses just as you would do 

to HTTP tests. See Verifying expected behavior  on page 161.

After the test run completes, view the test results by selecting the HTTP WebSocket Report. The report 

displays the number of requests attempted, succeeded, and the rate of success.

Related information

Recording reliable HTTP tests  on page5

Configuring Internet Explorer for recording from a secure web site  on page7

Recording an HTTP test  on page8

Recording an HTTP test for mobile applications  on page16

Generating HTTP tests from a Web UI test  on page20

Preparing to record a test for the HTTP/2 protocol  on page22

Splitting an HTTP test during recording  on page23

Returning a browser to its initial state if recording is interrupted  on page26

Creating HTTP tests manually  on page27

Creating tests from HTTP Archive files  on page34

Recording Adobe Flex content  on page36

Recording Microsoft Silverlight applications  on page38

Changing HTTP test generation preferences  on page38

Configuring the workbench for NTLMv2 authentication  on page
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Recording an HTTP test for mobile applications
You can use IBM®  Rational®  Performance Tester  to test a native or web application from the mobile 

device by using an HTTP protocol.

• You must have installed Rational®  Performance Tester  on your computer.

• You must have a mobile device.

• Rational®  Performance Tester  and the mobile device must be connected to the same wireless 

network.

To record the HTTP traffic to and from the mobile applications, you must download a digital certificate 

to connect to a wireless network, which is same as that hosts Rational®  Performance Tester. To 

record communication between the mobile device and the internet, the computer on which Rational® 

Performance Tester  is installed must be set up as a proxy server. This setup communicates all mobile 

network traffic through Rational®  Performance Tester's recording proxy.

1. To download the certificate from Rational®  Performance Tester  to your computer, perform the 

following sub-steps:

a. In the Performance Test perspective, on the toolbar, click the New Test From Recording icon 

 or click File  > New  > Test From Recording.

b. In the New Test From Recording  wizard, select HTTP Test, and click Next.

c. On the Select Location  page, select the project and folder, type a name for the test, and click 

Next.

d. On the Select Client Application  page, select the Unmanaged Application.

e. On the Proxy Recorder Settings  page, click hyperlinked save  option to save the recorder root 

certificate on your local desktop.

2. Share the downloaded certificate with a mobile device that is under test.

3. To download and install the certificate on a mobile device, perform the following sub-steps 

depending on your mobile device:

iPhone device Android device

a. Open the email that contains certifi

cate on the mobile device.

b. Select the certificate.

c. Choose iPhone  as the device.

d. Go to Settings  > General  > Profile  > 

IBM Performance Tester Recorder.

e. From Install Profile  screen, tap Install.

a. Open the email that contains certifi

cate on the mobile device.

b. Download the certificate.

c. Go to Settings  > Additional settings  > 

Privacy  > Encryption & credentials  > 

Install from storage.

d. Select the certificate to install.
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iPhone device Android device

f. If you have a PIN or passcode set on 

your iPhone, you must enter it. After 

you enter the PIN or passcode, ignore 

the warning and tap Install.

g. Tap Done  to exit the screen.

e. If you have a PIN or password set on 

your Android device, you must enter it 

and tap OK.

f. Specify a name for the certificate and 

click OK.

g. Go to Settings  > Additional settings  > 

Privacy  > Encryption & credentials  > 

User credentials  to view the installed 

certificate.

4. If you are using an iPhone, go to Settings  > General  > About  > Certificate Trust Settings  to 

manually enable the installed certificate.

5. To configure the mobile device proxy, perform the following sub-steps depending on your mobile 

device:

iPhone device Android device

a. From iPhone, go to Settings  > Wi-Fi 

and tap the connected network.

b. In the HTTP PROXY  section, select 

Manual  for Configure Proxy  and speci

fy the following settings:

• Server  - The IP address or the 

host name of the computer that 

hosts Rational®  Performance 

Tester.

• Port  - Enter 1080  as Rational® 

Performance Tester  listening 

port.

• Authentication  - Do not enable.

a. From your Android device, go to Set

tings  > Wi-Fi  and tap the connected 

network.

b. In the PROXY  section, select Manual 

and specify the following settings:

• Hostname  - The IP address or 

the host name of the comput

er that hosts Rational®  Perfor

mance Tester.

• Port  - Enter 1080  as Rational® 

Performance Tester  listening 

port.

• Bypass for  - Leave this field 

blank.

c. In the IP SETTINGS  section, select 

DHCP.

6. To record an HTTP performance test:
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a. From Rational®  Performance Tester  project, right-click the folder where you want your 

recording to be placed, and select New  > Test From Recording.

b. Select HTTP Test  in the Recording Session  window and click Next.

c. On the Select Location  page, select the project and folder, specify a name for the test, and 

click Next.

d. Select Unmanaged Application  in the Select Client Application  window. This option records 

HTTP traffic from a mobile device that uses a proxy.

e. Click Next.

f. Select Proxy Type  as HTTP and Proxy port  as 1080  on the Proxy Recorder Settings  page 

and click Finish.

g. From your mobile device, navigate through your installed application to start the recording. 

If all settings are configured correctly, you can see some activities on the HTTP Proxy 

Recorder  tab during recording.

h. To pause your recording, and if you want to navigate to other section of mobile application 

that needs no recording, click the Pause/Resume Recording  button. Click the button again 

to resume recording.

i. When you finish recording all the required transactions from your mobile application, click 

the Stop  button to stop the recording.

j. Select the domains to include in the test and click Finish.
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A progress window is displayed while the test is generated. After the test is complete, the Recording 

Control view displays the Test generation completed message, the test navigator lists your test, and the 

test opens in the test editor.

Related information

Recording reliable HTTP tests  on page5

Configuring Internet Explorer for recording from a secure web site  on page7

Recording an HTTP test  on page8

Recording a WebSocket test  on page15

Generating HTTP tests from a Web UI test  on page20

Preparing to record a test for the HTTP/2 protocol  on page22

Splitting an HTTP test during recording  on page23

Returning a browser to its initial state if recording is interrupted  on page26

Creating HTTP tests manually  on page27

Creating tests from HTTP Archive files  on page34

Recording Adobe Flex content  on page36

Recording Microsoft Silverlight applications  on page38

Changing HTTP test generation preferences  on page38

Configuring the workbench for NTLMv2 authentication  on page

Generating HTTP tests from a Web UI test
The performance tests record the HTTP traffic against the HTTP server that hosts the application under 

test. You would have recorded many scenarios against the server. If a new version of the server is about 

to be used, there can be changes in the HTTP traffic for all of the existing tests. You might have to re-

record all of the tests to bring them back to the state where they can be run successfully. This is a time-

consuming process.

You must have installed IBM®  Rational®  Performance TesterIBM®  Rational®  Functional Tester  in the 

same package group, also referred to as shell-share mode.

When you know that a new version of the HTTP server is going to be installed and it would impact your 

performance tests, you can record the scenarios with the Web UI Test recorder of Rational®  Functional 

Tester  and then just generate the HTTP tests. When you have all of the HTTP tests generated, you can 
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add the required test elements and run them to view the performance results. When the new version of 

the server is installed, you can start refreshing the generated HTTP tests. This action records the traffic 

from the Web UI test and uses the test elements such as loops and dataset that were edited in the HTTP 

test with the new HTTP traffic. The new HTTP tests are re-recorded with new HTTP traffic without manual 

intervention.

1. From the Web UI perspective, create a Web UI test.

For information about creating a Web UI test, see Recording a Web UI test.

2. In the Test Navigator view of Performance Test perspective, right-click the Web UI test and click 

Generate HTTP Test.

You can have only one Web UI test as the master  test.

The HTTP Test recorder opens the web browser and automatically records the HTTP traffic for the 

UI actions that were recorded in the Web UI test and generates the HTTP test.

3. To refresh the HTTP test, right-click the generated HTTP test and select Refresh HTTP Test.

This option is available only for the HTTP tests that were generated out of Web UI tests.

4. Specify a name for the test, select a project, and click Next.

5. Click Finish.

The HTTP Test recorder opens the web browser and automatically records the HTTP traffic from 

the Web UI test and generates the HTTP test against the new version of the server.

Related information

Recording reliable HTTP tests  on page5

Configuring Internet Explorer for recording from a secure web site  on page7

Recording an HTTP test  on page8

Recording a WebSocket test  on page15

Recording an HTTP test for mobile applications  on page16

Preparing to record a test for the HTTP/2 protocol  on page22

Splitting an HTTP test during recording  on page23

Returning a browser to its initial state if recording is interrupted  on page26

Creating HTTP tests manually  on page27

Creating tests from HTTP Archive files  on page34

Recording Adobe Flex content  on page36

Recording Microsoft Silverlight applications  on page38
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Changing HTTP test generation preferences  on page38

Configuring the workbench for NTLMv2 authentication  on page

Preparing to record a test for the HTTP/2 protocol
To collect the performance data of an application that supports HTTP/2 protocol, record a test against 

the HTTP/2 application. Before recording the HTTP/2 application, follow the procedure in this topic to 

configure your computer.

This configuration is required because this feature is released as Beta and is intended for the non-

production use.

1. Download the following Application Layer Protocol Negotiation (ALPN) boot jar file https://

mvnrepository.com/artifact/org.mortbay.jetty.alpn/alpn-boot/8.1.8.v20160420

2. Create or rename the productInstallDir\jdk  folder to ..\jdk.abc. You can rename the 

folder back to jdk  later to test with Java.

3. Download Oracle Java 1.8.0u92 from http://www.oracle.com/technetwork/java/javase/

downloads/jdk8-downloads-2133151.html. You can then either extract the compressed file or 

install Java at productInstallDir\jdk.

4. Copy the ALPN jar file to productInstallDir\majordomo\lib.

5. From productInstallDir, open eclipse.ini  and add the following flags:

-Xbootclasspath/p:<productInstallDir>\majordomo\lib\alpn-boot-8.1.8.v20160420.jar

Note:  If there are any other flag starting with -X, delete those flags.

6. Configure Rational®  Performance Tester  Agent to use Oracle Java.

a. Stop the Majordomo process.

On Windows systems, run the following command: cd “c:\program files\ibm\sdp

\majordomo�?  ngastop

On Linux systems, run the following command: cd /opt/IBM/SDP/Majordomo ./MDStop.sh

b. Set the environment variable RPT_JAVA  to the Oracle Java binary or executable.

On Windows systems, run the following command: set RPT_JAVA=c:\program files\java

\jdk1.8.0_92\bin\java.exe

On Linux systems, run the following command: export RPT_JAVA=/root/jdk1.8.0_92/jre/

bin/java

c. Start the Majordomo process.
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You can now record a test for the HTTP/2 application. After the recording, in the Version field of request 

details, the requests are marked with HTTP/2 indicating that the HTTP/2 traffic is captured. If the test 

playback fails, check if all the steps are correctly followed.

Related information

Recording reliable HTTP tests  on page5

Configuring Internet Explorer for recording from a secure web site  on page7

Recording an HTTP test  on page8

Recording a WebSocket test  on page15

Recording an HTTP test for mobile applications  on page16

Generating HTTP tests from a Web UI test  on page20

Splitting an HTTP test during recording  on page23

Returning a browser to its initial state if recording is interrupted  on page26

Creating HTTP tests manually  on page27

Creating tests from HTTP Archive files  on page34

Recording Adobe Flex content  on page36

Recording Microsoft Silverlight applications  on page38

Changing HTTP test generation preferences  on page38

Configuring the workbench for NTLMv2 authentication  on page

Splitting an HTTP test during recording
You can insert split points when you record a test. With split points, you can generate multiple tests from 

a single recording that you can replay in a different order with a schedule. You can also create a schedule 

that contains all of the tests that are generated from the split points.

During the recording process, you can select the option to create a schedule for the tests that are 

generated from the split points. The schedule will contain these attributes:

• One user

• One user group for the local computer

• All of the tests from the recording, in serial order

• One stage: Run until finished
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• Recorded think times, with the maximum think time set to 2 seconds

• Statistics:

◦ Statistics log level: All

◦ Statistics sample interval: 5 Seconds

◦ Only store All Hosts statistics

• Test Log:

◦ Show errors and failures: All

◦ Also show warnings: All

◦ And also show all other types: All

• Problem Determination log level: Warning

To insert split points when you record a test:

1. Start recording the test. The Recorder Test Annotations  toolbar opens near the top of the screen.

2. To insert a split point into the recorded test, click the  Split point  icon . The Insert Split Point 

window is displayed.

• Click Test name, and then type a name for this section of the test.

Tip:  You are naming the previous section of the test, not the upcoming section of the 

test.

Repeat this step between recorded user actions as needed to split tests.
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3. Close the client program to stop the recording. The Generate HTTP Test  window is displayed. 

• Type a Test prefix  for all the tests in the schedule.

• Select Generate a schedule containing tests  to create a schedule for the tests. When you 

select this option, you can modify the name of the schedule.

• Select Customize automatic data correlation  to choose automatic data correlation or rule-

based data correlation. If you select this option and choose rule-based data correlation, you 

can specify which data correlation rule sets to use.

4. Click Finish. 

The Test Generation  window displays the status of generating the tests and schedule and the data 

correlation. You can view the test generation log from this window.

5. When test generation is complete, you can select the test to open and then click Open Selected 

Tests, or you can click Close  to finish this process.
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The schedule and tests are generated using the names that you specified in the wizard.

Related information

Recording reliable HTTP tests  on page5

Configuring Internet Explorer for recording from a secure web site  on page7

Recording an HTTP test  on page8

Recording a WebSocket test  on page15

Recording an HTTP test for mobile applications  on page16

Generating HTTP tests from a Web UI test  on page20

Preparing to record a test for the HTTP/2 protocol  on page22

Returning a browser to its initial state if recording is interrupted  on page26

Creating HTTP tests manually  on page27

Creating tests from HTTP Archive files  on page34

Recording Adobe Flex content  on page36

Recording Microsoft Silverlight applications  on page38

Changing HTTP test generation preferences  on page38

Configuring the workbench for NTLMv2 authentication  on page

Splitting a test  on page169

Returning a browser to its initial state if recording is interrupted
Browser options are changed during recording and are reset after recording is complete. If you interrupt 

recording, the browser stays in its changed state, and you may receive The page cannot be displayed 

messages. To fix this, reset the browser to its initial state.

1. Right-click the Internet Explorer icon, and select Properties.

2. On the Connections page, click LAN Settings.

a. If you do not use a proxy, in the Local Area Network (LAN) Settings  window, clear Use a 

proxy server for your LAN.

b. If you use a proxy:

In the Local Area Network (LAN) Settings  window, select Use a proxy server for your LAN, 

and then click Advanced.
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In the Proxy settings  window:

i. Add the proxy address and port number to the HTTP  and the Secure  fields.

ii. Remove the proxy address and port number from the Socks  field.

iii. In the Proxy Settings  window, click OK.

3. In the Local Area Network (LAN) Settings  window, click OK.

4. In the Internet Properties  window, click OK.

Related information

Recording reliable HTTP tests  on page5

Configuring Internet Explorer for recording from a secure web site  on page7

Recording an HTTP test  on page8

Recording a WebSocket test  on page15

Recording an HTTP test for mobile applications  on page16

Generating HTTP tests from a Web UI test  on page20

Preparing to record a test for the HTTP/2 protocol  on page22

Splitting an HTTP test during recording  on page23

Creating HTTP tests manually  on page27

Creating tests from HTTP Archive files  on page34

Recording Adobe Flex content  on page36

Recording Microsoft Silverlight applications  on page38

Changing HTTP test generation preferences  on page38

Configuring the workbench for NTLMv2 authentication  on page

Creating HTTP tests manually
The typical—and simplest—way to create a test is by recording it. However, you can also write a test from 

scratch.

Related information

Recording reliable HTTP tests  on page5

Configuring Internet Explorer for recording from a secure web site  on page7

Recording an HTTP test  on page8
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Recording a WebSocket test  on page15

Recording an HTTP test for mobile applications  on page16

Generating HTTP tests from a Web UI test  on page20

Preparing to record a test for the HTTP/2 protocol  on page22

Splitting an HTTP test during recording  on page23

Returning a browser to its initial state if recording is interrupted  on page26

Creating tests from HTTP Archive files  on page34

Recording Adobe Flex content  on page36

Recording Microsoft Silverlight applications  on page38

Changing HTTP test generation preferences  on page38

Configuring the workbench for NTLMv2 authentication  on page

Creating an empty test
You can create an empty template for a test that you plan to write manually.

1. In the Test Navigator, right-click a project and click New  > Other.

2. In the New  window, expand Test, expand Test Assets, click New Test, and then click Next.

3. In the Enter, create, or select the parent folder  field, click the test project in which to store the test.

4. In the Name  field, type a name for the test, and then click Next.

5. Optionally, in the Test Attributes  window, type a description for the test, and then click Next.

6. In the Protocol and Features  window, select HTTP Protocol, and then click Next.

7. In the HTTP Extension  window, enter the name of the host, and set the options for the test.

8. In the New test summary  window, inspect your selections, and then click Finish.

9. Confirm that you want to open the editor.

A test template opens for you to edit. The following figure shows HTTP test template with the 

default options (one page, one request per page, and a response for the request).
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Related information

Adding templates for new elements  on page29

Adding a header  on page31

Editing header contents  on page33

Adding templates for new elements
You can add a template for a new test element that you plan to write by hand.

To add a template for a page, page request, or basic authentication block to a test:
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1. Open the test. If you are writing a test completely by hand, you can create an empty test as 

explained in Creating an empty test  on page 28.

2. Click the parent or sibling element.

3. Click Add  or Insert.

The editor enforces the test hierarchy: tests contain pages, pages contain requests, and requests 

contain authentication blocks.

• Add  adds the template to the bottom of the selected element: a page is added to the bottom 

of the test, a request is added to the bottom of the selected page, and an authentication 

block is added to the end of the selected page request.

• Insert  inserts the template at the point of the cursor: a page is inserted before the selected 

page, a page request is inserted before the selected request, and an authentication block is 

inserted at the top of the selected page request.

4. Select one of the following options. The options that are displayed depend on the element that you 

select.

Option Description

HTTP Page Adds a page to the test.

HTTP Request Adds a request to the test.

Basic Authentication

Adds an authentication block to a request. A 

folder named Authentication  is added, and 

the Test Element Details  area displays the 

User id, Password, and Realm  fields.

Custom Code

Adds a block of custom code to the test. For 

more information on custom code, see Ex

tending test execution with custom code  on 

page .

Delay Adds a delay to the test.

Loop

Runs part of the test a specific number of 

times. In addition to setting the number of 

iterations, you can control the rate of itera

tions and randomly vary the delay between it

erations. For more information, see Extend

ing test execution with custom code  on page 

.
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Option Description

Condition

Adds a conditional block to the test. In most 

cases, a conditional block issues HTTP re

quests depending on the value of a reference 

or field reference. The reference or field ref

erence must exist in the test and precede the 

conditional block. For more information, see 

Adding conditional logic  on page .

Transaction

Enables you to view performance data about 

the transactions that you have added. In the 

Test Element Details  area, give the transac

tion a meaningful name. This is useful in the 

Transactions report, which lists transactions 

by name. For more information, see Adding a 

transaction to a test  on page .

Random Selector

Enables you to run test elements in random 

order. For more information, see Running test 

elements in random order  on page .

Comment
Adds a comment that appears in the Test El

ement Details  area and in the actual test.

Related information

Creating an empty test  on page28

Adding a header  on page31

Editing header contents  on page33

Adding a header
You can add a standard header or a custom header to a request or response.

1. Open the test.

2. In the test hierarchy, click a request (to add a request header) or the Response Data  folder for a 

request (to add a response header).
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3. In the Test Element Details  area, locate the Request Headers  table, and then click Add.

The Add/Edit Headers  window 

opens.

4. To add a standard header:

a. In the Available Headers  list, locate the header to add and click it.

Use the Quick search  field (start typing the name of a header) and Header types  list (select 

the type of header you are looking for) to quickly locate a header in the Available Headers 

list.

b. Click the right angle bracket (>).

The selected header moves into the Selected headers  list and your cursor is placed in the 

value column.

c. Type the value for the header.

5. To add a custom header:
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a. In the Header types  list, select Custom.

b. At the bottom of the window, in the New custom header  area, type the header information in 

the Name  field and the Value  field, and then click Insert.

The custom header is added to the Selected headers  list.

6. When you have finished adding headers, click OK.

Related information

Creating an empty test  on page28

Adding templates for new elements  on page29

Editing header contents  on page33

Editing header contents
You can modify the contents of the headers that are contained in requests and responses.

1. Open the test.

2. In the test hierarchy, click a request (to edit a request header) or the Response Data  folder for a 

request (to edit a response header).

3. In the Test Element Details  area, locate the Request Headers  table, and double-click the cell 

containing a value that you want to edit.

An ellipsis button is displayed in the Value column.

4. Click Modify.

5. In the Edit Header  window, edit the header value as desired.
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You can create a reference or field reference in the header value.

6. Click Table View  to return to the Request Headers  table.

Related information

Creating an empty test  on page28

Adding templates for new elements  on page29

Adding a header  on page31

Creating tests from HTTP Archive files
To migrate your tests from another tool to IBM®  Rational®  Performance Tester, you can export tests in 

the HTTP Archive (.har) file format and then import or copy the HTTP Archive files to IBM®  Rational® 

Performance Tester. You can then create test scripts from the HTTP Archive files.

Depending on the tool that you use to export tests to the HTTP Archive format, Google Chrome and 

Mozilla Firefox, for example, do not save enough information to reflect exactly what happened on each 

connections. The tool exports the contents, HTTP requests and responses, timings, but connections and 

SSL information is not exported. Use a tool such as Fiddler2 that exports enough information about tests.

When you import or copy an HTTP Archive file, the product displays a message if the Archive file does not 

contain enough information to generate the test.
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1. To create tests from the HTTP Archive file, you must first copy or import the archive file to the Test 

Navigator view of the product. To import the HTTP Archive files in the product, initiate the Import 

action from the Test Navigator view and choose the File System  option in the wizard.

After the import is finished, a new category HTTP Archive  is created in the Test Navigator view.

2. Generate the test from one of the following methods:

a. In the Test Navigator view:

i. Right-click the HTTP Archive file, click Generate Test.

ii. Specify a name for the test, and click Finish.

b. In the product:

35



Test Author Guide

36

i. Click File  > New  > Test from Recording  > Create a test from an existing recording

ii. Select the HTTP Archive file and follow the wizard to create the test.

Note:  If the HTTP Archive file cannot generate a test, a message is displayed 

when you select it.

3. Select the type of test that you want to create and click Next.

4. Select the domains that you want to include in the test and click Finish.

A new test is generated.

You can now run the test. See Running a local schedule or test  on page .

Related information

Recording reliable HTTP tests  on page5

Configuring Internet Explorer for recording from a secure web site  on page7

Recording an HTTP test  on page8

Recording a WebSocket test  on page15

Recording an HTTP test for mobile applications  on page16

Generating HTTP tests from a Web UI test  on page20

Preparing to record a test for the HTTP/2 protocol  on page22

Splitting an HTTP test during recording  on page23

Returning a browser to its initial state if recording is interrupted  on page26

Creating HTTP tests manually  on page27

Recording Adobe Flex content  on page36

Recording Microsoft Silverlight applications  on page38

Changing HTTP test generation preferences  on page38

Configuring the workbench for NTLMv2 authentication  on page

Recording Adobe™  Flex content
You can record an HTTP session that contains traffic to and from a .swf  Adobe™  Flex application.

The Adobe™  Flash plugin must be installed in your web browser to run flex applications (.swf files) and to 

record the HTTP session.
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Adobe™  Flex technology allows communication through XML, SOAP, or AMF. AMF is compressed binary 

data that must transformed into XML to be used in an HTTP performance test.

1. Record the HTTP as described in Recording an HTTP test  on page 8.

By default, Rational®  Performance Tester  transforms the AMF format in to the XML format.

2. Optional:  If you configured the default setting of Rational®  Performance Tester  to not transform 

after the recording, follow the steps in the Transforming binary data in tests  on page 409 topic.

After the transformation, the XML data is generated in the test with "amf" prefixes in the names, as in the 

following example:

<amf3Property amfName="zipcode" amfType="amf3String" zipcode="94103"/>

The generated XML can be used for data correlation. Only the amfValue  attributes or attirbutes without the 

amf  prefix can be used for data correlation.

Note:  Do not modify or use data correlation on any XML attributes that start with the amf  prefix 

except for amfValue. If these attributes are modified, the replay of the test will cause errors.

Related information

Recording reliable HTTP tests  on page5

Configuring Internet Explorer for recording from a secure web site  on page7

Recording an HTTP test  on page8

Recording a WebSocket test  on page15

Recording an HTTP test for mobile applications  on page16

Generating HTTP tests from a Web UI test  on page20

Preparing to record a test for the HTTP/2 protocol  on page22

Splitting an HTTP test during recording  on page23

Returning a browser to its initial state if recording is interrupted  on page26

Creating HTTP tests manually  on page27

Creating tests from HTTP Archive files  on page34

Recording Microsoft Silverlight applications  on page38

Changing HTTP test generation preferences  on page38

Configuring the workbench for NTLMv2 authentication  on page

Recording an HTTP test  on page8
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Recording Microsoft Silverlight applications
To test the performance of an application that was developed by using Microsoft™  Silverlight, you can 

record the application.

Rational®  Performance Tester  supports Microsoft Silverlight 5.

Microsoft™  Silverlight communicates with the server in the Windows™  Communication Foundation (WCF) 

Binary format. After recording the Microsoft Silverlight application, you can transform the format to XML 

for better readability and to apply data correlation.

1. Record the HTTP application as described in Recording an HTTP Test  on page .

By default, Rational®  Performance Tester  transforms the WCF Binary format into XML format.

2. Optional:  If you changed the default setting of Rational®  Performance Tester  to not transform 

after the recording, follow the steps in the Transforming binary data in tests  on page 409 topic.

Related information

Recording reliable HTTP tests  on page5

Configuring Internet Explorer for recording from a secure web site  on page7

Recording an HTTP test  on page8

Recording a WebSocket test  on page15

Recording an HTTP test for mobile applications  on page16

Generating HTTP tests from a Web UI test  on page20

Preparing to record a test for the HTTP/2 protocol  on page22

Splitting an HTTP test during recording  on page23

Returning a browser to its initial state if recording is interrupted  on page26

Creating HTTP tests manually  on page27

Creating tests from HTTP Archive files  on page34

Recording Adobe Flex content  on page36

Changing HTTP test generation preferences  on page38

Configuring the workbench for NTLMv2 authentication  on page
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Changing HTTP test generation preferences
You can change how performance tests are generated, such as how tests process verification points, data 

correlation, and pages.

1. Click Window  > Preferences  > Test  >  Test Generation  > HTTP Test Generation.

2. Select the preference to change.

The test generation preferences are as follows:

Do not generate a new page if think time is less than

Enter the shortest time, in milliseconds, that the generator uses as a delay to emulate 

user think time for an HTTP page. If your tests contain fewer pages than expected, try 

a shorter interval.

Create a new page if delay between requests is greater than

Enter the longest delay, in milliseconds, that the generator allows between page 

requests. If this time is exceeded, a new page is generated. If your tests contain more 

pages than expected, try a longer interval.

Maximum request delay

Enter the longest delay, in milliseconds, that the generator allows before truncating 

HTTP requests. The requests are truncated on the generated test. The recorded test 

still contains the original values, and you can get them back by generating a new test.

Save only the first 4KB of responses larger than

Enter the limit of response data, in KB, that the generator saves. If a response is 

larger than the specified limit, only the first 4 KB of data is saved.

Suppress NSLookup() and use numeric IPs

Select this option to shorten test generation time. The disadvantage is that IP 

addresses in a test are less user-friendly than web page format (www.example.com).

Disable Page Cache Emulation during test generation

Select this option to disable page cache emulation. When page cache emulation is 

enabled, caching information in server response headers is honored. Additionally, 

requests are not submitted to the server for content that is confirmed by the client as 

fresh in the local cache. Page cache emulation is enabled by default.

Enable domain review before test generation
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Clear the check box to not show the test generation page to select specific domains 

to be added to the test. By default, in addition to the domain that you intend to record, 

other domains linked to the original domain are also recorded.

Remove HTTP request delays from page response times

To not include the client delays in the page response times for the test or A schedule, 

in this context, is used to refer to both VU Schedule  and Rate Schedule, select 

this check box. By default, the page response times include delays to represent 

processing time caused by clients such as a web browser. Sometimes this delay 

could exceed the logical limit causing page response times to increase drastically.

Use Legacy Test Generator

Select this option if you have been instructed to use the legacy HTTP test generator.

Automatically include verification point of

Click to specify the types of verification points to be automatically included. If a 

check box for a verification point is selected, the code and edit controls for this type 

of verification point are generated in all tests. Verification points can also be enabled 

or disabled within specific tests.

Relaxed

Response codes that are in the same category (for example, 200, 201, 203, 209) are 

considered equivalent. An error is reported if the response code is not in the same 

category.

Exact

An error is reported if the response code does not match the recorded value exactly.

Accept sizes for primary request within

If you are automatically generating response size verification points, click to specify 

the acceptable size range for primary requests. No error is reported if a response 

is within the specified percentage above or below the expected size. By default, for 

primary requests, HTTP response size  verification points use range matching.

The data correlation preferences are as follows:

Automatically correlate host and port data

By default, host and port data is correlated automatically. If tests in a previous 

release have significant manual correlations, or you are using proxies, the migration 

of the replace-host functionality feature is likely to fail during playback. In this 
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situation, clear the check box. When you reopen your tests, they will not have the 

automatic correlation feature in them.

Automatically correlate URL pathname if redirected by response

Specifies whether URL path names are correlated if they are redirected by a selected 

response code. If a check box for a response code is selected, the test generator 

performs correlations for that response code. This option applies only to responses 

that are redirects, with a status code between 300 and 399.

Automatically correlate Referers

By default, the Referer field in an HTTP request header is correlated automatically. 

Clear the check box if you plan to correlate Referers manually. If you run tests against 

servers that do not require a Referer field, clearing this check box reduces the number 

of correlations performed when the test runs, and can increase user throughput.

Enable all other data correlation

By default, request and response data is correlated automatically. Clear the check 

box to disable automatic data correlation of request and response data. Consider 

clearing the check box if you create your own data correlation rules in the rules editor.

Create substitutions for empty strings

Select this check box to correlate empty strings. For example, strings such as 

spouse name or middle initial sometimes become important to correlate. However, 

correlating empty strings increases the time to generate a test.

Optimize automatic data correlation for execution

Specifies the characteristic that tests are automated for.

• With the Accuracy  setting (the default), many references with an identical 

session ID value are created and the value of each session ID is substituted 

from the nearest previous reference.

• To make a test run faster by reducing the number of references that are 

created during automatic data correlation, change the optimization to 

Efficiency. For example, consider a test where a session ID, which is assigned 

when a user logs in, is included in every subsequent request in the test. With 

the Efficiency  setting, all session IDs are substituted from a single previous 

reference. The downside of this setting is that it can result in incorrect 

correlations. For example, a request that contains the Joe Smith  string might 

be incorrectly correlated with a request that contains the Joe Brown  string.

URL rewriting for execution

41



Test Author Guide

42

Specifies how web addresses (URLs) are rewritten during test execution. When 

correlating data, the test generator replaces part of a URL request string with a value 

that the server returned in response to a previous request.

• Automatic  (default): The test generator automatically determines when 

rewriting the entire URL during substitution will facilitate test execution.

• On: Select to rewrite URLs in every instance of data correlation. This 

produces larger tests that take longer to run. Try this setting if your tests fail 

unexpectedly.

• Off: Select to manually correlate the instances where URL rewriting is needed. 

This setting might cause execution errors.

URL encoding for execution

With this option, you can control the encoding of the URLs. If you set it to Automatic, 

the tool detects the encoding that already exists in the test and applies it to the 

substitution site. If you set it to ON, the tool always encodes the substitutions 

according to the encoding standards. If you set it to OFF, no encoding occurs.

Note:  To turn data correlation off entirely or to set whether names are automatically generated 

for data correlation references, click Window  > Preferences  > Test  >  Test Generation  > HTTP Test 

Generation, and click the Data Correlation  tab.

The data correlation type preferences are as follows:

Data Correlation Types

Specify when to generate data correlation constructs. With the Automatic  setting, 

the test generator creates the required constructs where needed. If the test does not 

contain the required constructs, change the setting to On, which will always perform 

data correlation. If tests do not require a specific construct, select Off, which has the 

additional benefit of improving performance on subsequent test generation.

Jazz Foundation Services

The On  and Automatic  options enable data correlation for Jazz applications that use 

REST storage or query APIs from Jazz Foundation Services. An example of such an 

application is Rational DOORS Next Generation. Although data correlation does not 

typically apply to browser-based Jazz web clients, it may be useful for other HTTP 

client-server applications that use REST services and the Atom Publishing Protocol 

for updating web resources.

Jazz Web Applications
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The On  and Automatic  options enable data correlation for Jazz web applications 

that use the Jazz Foundation web UI framework Examples of these web applications 

are the web interfaces for Rational Quality Manager and Rational Team Concert. 

Data correlation can also be useful for other web applications that contain javascript 

that employs JSON for client-server data exchange. This is a common practice with 

DOJO- and AJAX-based applications.

JSON

To perform data correlation on web applications that uses JSON framework, ensure 

that Automatic or ON is set to the JSON entry.

Prioritize correlation based on ID

Select On  to correlate HTML response code based on its ID attribute. Generally, the 

HTML response code after the recording would appears as <input type="username" 

name="User" id="aaa" value="John"/>. Some applications dynamically update the 

name  attribute. Therefore, when you play back the test, the HTML response code 

would appear as <input type="username" name="idt020" id="aaa" value="John"/

>. Because the name  attribute is changes dynamically, data correlation does not 

occur and the playback fails. When this option is turned on, the ID attribute is 

considered as the basis to correlate the name  attribute in the request and to locate 

the value  attribute.

3. After changing a setting, click Apply.

Related information

Recording reliable HTTP tests  on page5

Configuring Internet Explorer for recording from a secure web site  on page7

Recording an HTTP test  on page8

Recording a WebSocket test  on page15

Recording an HTTP test for mobile applications  on page16

Generating HTTP tests from a Web UI test  on page20

Preparing to record a test for the HTTP/2 protocol  on page22

Splitting an HTTP test during recording  on page23

Returning a browser to its initial state if recording is interrupted  on page26

Creating HTTP tests manually  on page27
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Creating tests from HTTP Archive files  on page34

Recording Adobe Flex content  on page36

Recording Microsoft Silverlight applications  on page38

Configuring the workbench for NTLMv2 authentication  on page

Recording SAP tests
When you record a test, the test creation wizard records your interactions with the SAP server, generates 

a test from the recording, and opens the test for editing. You can record tests from the SAP GUI. You 

can also record SAP batch input tests that can be used to produce a heavy load on the server while 

minimizing the processing requirements for virtual testers.

SAP performance  testing guidelines
Before you test the performance of SAP applications, you must set up your test environment and 

incorporate these guidelines to produce reliable SAP performance tests.

SAP configuration

The SAP GUI client software must be installed on the same computer as IBM®  Rational®  Performance 

Tester. The SAP GUI client is required for recording and running performance tests. For information 

about support of SAP GUI versions, refer to the SAP Note 1412821 - SAP GUI for Windows: Support on 

Windows  for SAP.

The product is optimized by default for SAP GUI version 7.10 or later. To improve performance 

with older SAP GUI 6.20 and 6.40 versions, when running long tests, you must change 

the bridge2java.dll  file located in the C:\Program Files\IBM\SDP\plugins

\com.ibm.rational.test.lt.runtime.sap\<build_identifier>  directory by renaming 

bridge2java.dll  to bridge2javaV7.dll, and then renaming bridge2javaV6.dll  to 

bridge2java.dll.

If you are deploying tests on remote computers to simulate a large number of users, the following 

software must be installed on each remote computer:

• The SAP GUI client software, configured with the same logon properties as the client on which the 

tests were recorded

• TheIBM®  Rational®  Performance Tester  Agent  software that is provided with the product
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Performance testing  relies on the SAP Scripting API and ActiveX. Make sure that these options are 

selected when installing the SAP GUI client.

Performance test  recording and running also require that scripting be enabled on the SAP application 

server and on all SAP GUI clients that are installed on remote computers. See the topic on configuring 

SAP for performance testing for more information.

Limitations

During playback of the performance tests, each virtual user runs SAP GUI in silent mode by default (the 

user interface is not displayed on the screen). However, some modal dialog boxes from the SAP GUI 

might briefly flash on the screen.

Avoid recording SAP tests with the SAP GUI low speed connection setting. You cannot run with a normal 

speed connection tests that you recorded with this setting.

You can have a maximum of only 50 virtual users on an agent for a SAP GUI test.

Batch input tests

You can use batch input tests to simulate a large number of virtual users while minimizing the load on the 

virtual user computers.

Batch input tests access the SAP server at a low level, bypassing the SAP GUI interface, and therefore 

cannot contain any verification points or SAP GUI elements. Their main purpose is to simulate a load on 

the server when added to a test schedule  that already contains SAP performance tests. Only the SAP 

performance tests will provide accurate SAP application performance measurement.

Batch input transactions are recorded in the SAP GUI and exported to the file system. You can then 

generate batch input tests that are based on those recorded transactions.

Note:  Sometimes the default values of the SAP Java Connectors (JCo) parameters are not sufficient 

for the load tests. The default values require some updates both at the SAP R/3 server and client 

end. For the client, in the Additional SAP Connection Properties  window, you must configure the SAP 

JCo parameters options that are available in the test. Alternatively, you can specify the properties as 

RPT_VMARGS in the agent location. For example, RPT_VMARGS=- Djco.cpic_maxconv=1000

Performance

When deploying your performance tests, it is important to use a relevant number of virtual users on 

a given computer. For example, if you deploy too many virtual users on a single computer, the results 

produced will reflect more the load of the test computer than the load of the SAP application server.
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For best results with performance tests on an average test computer with a 1 GHz processor and 1 GB 

of RAM, do not exceed 50 concurrent virtual users. With batch input tests, the maximum number of 

concurrent virtual users is approximately 500.

If you exceed the number of virtual users that a single test computer can run, the measured performance 

of the server will be affected by the performance of the test computer, which will invalidate the final 

results.

When editing a schedule for long performance tests, use these recommendations:

• In the schedule editor, reduce the Test log level  to None.

• In the schedule editor, set the Statistics sample interval  to approximately 1/60 of the run time, for 

example 12 minutes for an estimated 12-hour session.

• When possible, use loops inside test suites rather than loops in the schedule. Using loops inside 

test suites avoids connection problems that might occur over long duration tests and emphasizes 

measurement of the actual SAP transactions rather than the logon process.

If you run a schedule that has an SAP test from Rational®  Performance Tester  Agent in Windows, you 

must then start Rational®  Performance Tester  Agent as a Process. However, Rational®  Performance 

Tester  Agent starts as a Service  by default.

To start the agent as a process, you must perform the following steps:

1. Open Windows Services.

2. Change the Status  of the Majordomo  service from Running  to Stop.

3. Double-click the Majordomo.bat  file from the <SDP_Install_Directory>\Majordomo 

directory to run the agent as a compatible process.

Note:  You must install SAP GUI in the agent computer to run a schedule that has an SAP test.

Long duration test runs

When running long duration test schedules that exceed many hours, use the long run mode process to 

reduce resource consumption with the SAP GUI client. This mode increases the reliability of long duration 

test runs because a new process starts every time the specified number of SAP sessions completes. 

Hence, Windows resource consumption is bare minimum. You must enable this option for each user 

group in the schedule.

In the long run mode, a new process is created each time the number of SAP test instances reaches the 

specified number.

For more information about how to run a long run mode test, see Running a long run mode SAP GUI test 

on page .
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Cleaning the SAP work directory
In some cases, trace files are created by SAP GUI under SapWorkDir  directory when running 

SAP performance tests. You can delete these files by setting and environment variable 

RPT_CLEAN_SAPWORKDIR  or a java VMARG rptCleanSapWorkDir. For example:

• -DrptCleanSapWorkDir=C:\Documents and Settings\UserName\SapWorkDir

• RPT_CLEAN_SAPWORKDIR="C:\Users\UserName\AppData\Local\SAP\SAP GUI\Traces"

If you set the variable to the SapWorkDir  folder location, the contents (*.trc files) of the folder are 

removed when a schedule starts. If the variable is set to true  or on, the product automatically searches 

for the SapWorkDir  folder before removing its contents. If the variable is set to false  or off, no action is 

taken.

Related information

Recording an SAP test  on page47

Recording a specific SAP transaction from a running SAP session  on page51

Inserting a new recording into a SAP test  on page53

Recording a session with HTTP SAP Portal  on page54

Recording a SAP batch input test  on page57

Changing SAP test generation preferences  on page60

Configuring SAP for performance testing  on page

Configuring an environment for batch input tests  on page

Running long duration Citrix tests  on page

Running long run mode SAP GUI test  on page

Recording an SAP test
You can record your interaction with the SAP GUI client to generate an SAP test. When you record, the 

recording wizard opens the SAP GUI client and records all the interactions that occur between the client 

and the server.

You must have completed the following tasks:

• Verified that SAP GUI scripting is enabled on the SAP server and the SAP GUI client. See 

Configuring SAP for performance testing  on page .
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• Working SAP GUI client that you can connect to an SAP server.

• Verified that tests are stored in performance  projects. If your workspace does not contain a project, 

the test creation wizard enables you to creates one.

• Ensured that the session that you are recording is reproducible.

For example, if you create items in SAP and do not delete them, then if items created in SAP are 

already exist when the test is run, that might cause the test to not run as expected.

You can record and generate a test by using REST APIs. The API documentation to 

record a test is located at Install_directory\IBM\IBMIMShared\plugins

\com.ibm.rational.test.lt.server.recorder.jar. The API documentation to generate a 

test after the recording completes is located at C:\Program Files\IBM\IBMIMShared\plugins

\com.ibm.rational.test.lt.server.testgen.jar.

You must install the latest version of SAP GUI when you want to record an SAP test in Rational® 

Performance Tester. For more information about supported SAP GUI versions, see System Requirements 

on page .

Important:

• Both 64-bit and 32-bit Rational®  Performance Tester  supports the SAP protocol.

• When you install Rational®  Performance Tester  by using the shell-shared method and run an SAP 

test or a compound test that has an SAP test in it, the SAP web analytics report displays only the 

SAP Summary  and Screen Performance  pages after the test run is complete.

1. Open Rational®  Performance Tester.

2. Click the New Test From Recording  icon , and then click SAP Test.

Note:  You can also click File  > New  > Test From Recording, and then select SAP Test. You can 

then select the encryption level, if required and click Next  to open the Select Location  page.

The Select Location  page is displayed.

3. Create a test by performing the following steps:

a. Select a project, and then select a folder from the project.

b. Enter a name for the test.

c. Optionally, click Recording encryption level, and then select the encryption level when you 

are recording any sensitive data.

4. Click Next.

The Select Client Application  page is displayed.

5. Select SAP Batch Input Recording  or SAPGUI For Windows, and then click Next.
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Note:  When you record an SAP test by using the SAP GUI For Windows  method and if you use 

many split points, then steps might not split properly after the SAP recording is complete. The split 

action during the SAP recording comes into effect only after an SAP request by changing the state 

of the current screen. After the test generation is complete, you must use the Split Test  action for 

splitting the steps to different SAP tests from the test editor.

6. On the SAP Connection  page, select how to connect to the SAP server:

• In most cases, select SAP Logon; then enter the description normally used by SAP Logon to 

identify the server in SAP system name.

• If your environment does not support SAP Logon, select Server information. In Application 

server, enter the host name or IP address of the server. Then specify a value for System 

number. Enter information in Other options, if required. Refer to your SAP documentation for 

details about the other SAP Logon options.

• If your environment uses gateways or routers to connect to the SAP server, select 

Connection by string. Click Edit  to specify a valid connection string. Refer to your SAP 

documentation for details about connection strings.

• If you have an SAP shortcut file to automate the connection, select SAP shortcut file. Click 

Browse  to specify the location of the file.

• You also have the option of logging on to SAP through the HTTP SAP Portal. See Recording 

a session with HTTP SAP Portal  on page 54 for more information.

• If you want to skip the logon process and start the recording from a specific screen in the 

middle of a session, start a session with the SAP Logon program, go to the screen, and then 

select Record from a running session started with SAP Logon. The recorded test will not 

contain any connection information. This option can be useful for creating split tests. See 

Recording a specific SAP transaction from a running SAP session  on page 51.

7. If this is the first time you record a SAP performance test, read the privacy warning, and select 

Accept.

8. Click Finish  to start recording.

In some cases, you might see a warning that a script is opening a connection to SAP.

9. Log on to SAP and complete the transactions to test.

For security reasons, the password cannot be recorded by the SAP test recorder. Instead, it is 

requested at the end of the recording session.

10. In the SAP GUI window, perform the tasks for testing.

You can use the Recorder Test Annotations  toolbar to add comments, record synchronizations, or 

take screen captures during the recording.
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• To add a comment to the recorded test, click the Insert comment  icon .

• To add a screen capture to the recorded test, click the Capture screen  icon . Screen and 

window captures make your tests easier to read and help you visualize the recorded test. 

You can change the settings for screen captures and add a comment to the image.

• To manually add a test synchronization to the recording, click the Insert synchronization 

icon .

• To insert a split point into the recorded test, click the Split point  icon button. Split 

points allow. With split points, you can generate multiple tests from a single recording, that 

you can replay in a different order with a schedule. SeeSplitting a test during recording  on 

page  for more information about splitting a test.

11. When you have completed the transactions to be tested, stop the recorder by closing the SAP GUI 

or by clicking Stop   in the Recorder Control  view.

12. In the Enter Password  window, enter the password for the account that was used for recording.

This step is required because SAP GUI does not allow direct recording of the password.

A Test Generation Progress  window is displayed while the test is being generated.

The following message is displayed on the progress window: Test Generation completed.

You can now play back the test and check the performance  test  results.

Before playing back a test, in SAP Connection Details editor, click Test Connection  to test the connection 

to the SAP GUI server.

Related information

SAP performance testing guidelines  on page44

Recording a specific SAP transaction from a running SAP session  on page51

Inserting a new recording into a SAP test  on page53

Recording a session with HTTP SAP Portal  on page54

Recording a SAP batch input test  on page57

Changing SAP test generation preferences  on page60

Creating tests  on page3

Recording sensitive session data  on page141

Running long run mode SAP GUI test  on page
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Recording a specific SAP transaction from a running SAP session
You can record certain SAP transactions from a running SAP GUI session to create a test that contains 

some specific part of an SAP session. When you record a session, the recording wizard automatically 

records the transaction that you specified.

• Working SAP GUI client that you can connect to an SAP server.

• Verified that SAP GUI scripting is enabled on the SAP server and the SAP GUI client. See 

Configuring SAP for performance testing  on page .

• You must have logged in to the SAP GUI session with your valid credentials.

When you record a specific SAP transaction session from a running SAP session, you can skip the SAP 

logon process and start the recording from a specific screen in the middle of a running SAP session by 

using the Record from a running session started with SAP Logon  option.

Important:  Do not log off the SAP GUI session until the test run completes.

After the SAP recording is complete, you can run the SAP test and verify the transaction details.

You must install the latest version of SAP GUI when you want to record an SAP test in Rational® 

Performance Tester. For more information about supported SAP GUI versions, see System Requirements 

on page .

1. Open Rational®  Performance Tester.

2. Click the New Test From Recording  icon , and then click SAP Test.

The Select Location  page is displayed.

3. Create a test by performing the following steps:

a. Select a project, and then select a folder from the project.

b. Enter a name for the test.

c. Optionally, click Recording encryption level, and then select the encryption level when you 

are recording any sensitive data.

4. Click Next.

The Select Client Application  page is displayed.

5. Click SAPGUI For Windows, and then select Next.

The SAP Connection  page is displayed.

6. Select Record from a running session started with SAP Logon.

7. Click Finish.

The SAP Easy Access  on the SAP GUI  window is displayed.
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8. Record an SAP transaction (For example, SM04), and then click Exit  to close the transaction 

session.

Important:  Do not log off the SAP GUI session until the test run completes.

9. Open Rational®  Performance Tester, and then click Stop Recording Session.

A Test Generation Progress  window is displayed while the test is being generated.

The following message is displayed on the progress window: Test Generation completed.

You have successfully recorded a specific transaction session from a running SAP session.

You can click Open Test  to open the test in Rational®  Performance Tester. With the SAP GUI session 

open, you can then verify the SAP transaction details and run the test in Rational®  Performance Tester.

Important:  Do not log off the SAP GUI session until the test run completes.

After the test run completes, you can then verify the transaction details from the following pages:

• SAP Summary  page in the SAP Statistical Report

• Test Log  page

Note:  When you use the Record from a running session started with SAP Logon  option to record an 

SAP test, and then if you add that SAP test to a schedule (VU schedule or Rate schedule), the schedule 

run fails and the following error message is displayed in the Test Log  page or Execution Event Console 

log page:  Connection with the existing SAP GUI session or shortcut is not allowed during 

schedule execution

You can then place the transaction session in between an SAP session that has a logon and logoff 

session. You can then save and run the schedule.

Related reference

SAP Performance report  on page

Related information

SAP performance testing guidelines  on page44

Recording an SAP test  on page47

Inserting a new recording into a SAP test  on page53

Recording a session with HTTP SAP Portal  on page54
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Recording a SAP batch input test  on page57

Changing SAP test generation preferences  on page60

Inserting a new recording into a SAP test
You can insert a new recording into a test. Use this feature to add or replace a part of a recorded session.

Inserting a new sequence into a test requires that the SAP session reaches the same state as is expected 

at the point where the new sequence is inserted. To do this, the SAP test recorder automatically replays 

the existing scenario up to the insertion point before starting the new recording.

You must install the latest version of SAP GUI when you want to record an SAP test in Rational® 

Performance Tester. For more information about supported SAP GUI versions, see System Requirements 

on page .

1. In the test editor, select the element before which you want to insert the new recording.

It is easier to manage the new test sequence when the insertion point is at the transaction level of 

the test.

2. Click Insert, and then New recording.

The test starts replaying up to the selected insertion point.

3. When the New Recording  window is displayed, perform the sequence of actions that you want to 

add to the existing test.

4. When you have finished, in the New Recording  window, click Stop  to stop the recording.

A progress window opens while the test is generated. On completion, the Recorder Control  view 

displays the message, Test generation completed, and the test is updated with the new contents.

5. After the test has been updated in the Test Navigator, check that the new sequence was properly 

inserted into the test, and then click File  > Save  to save the test or File  > Revert  to cancel the 

inserted recording.

Related information

SAP performance testing guidelines  on page44

Recording an SAP test  on page47

Recording a specific SAP transaction from a running SAP session  on page51

Recording a session with HTTP SAP Portal  on page54
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Recording a SAP batch input test  on page57

Changing SAP test generation preferences  on page60

Recording a session with HTTP SAP Portal
To measure the performance of a SAP Portal from a web interface, you can record a SAP test by using the 

HTTP SAP Portal option.

Verify that the IBM®  Rational®  Performance Tester  Agent is running on the local computer and that SAP 

GUI Scripting is enabled on the SAP server and the SAP GUI client.

Tests are stored in performance test projects. If your workspace does not contain a project, the test 

creation wizard creates one with a name that you can change. To store a test in a specific project, verify 

that the project exists before you record the test.

Ensure that the session that you are recording is reproducible. For example, if you create items in SAP and 

do not delete them, then they will already exist when the test is run, which might cause the test to fail.

Certain websites require appropriate certificates to use a proxy recorder to record the site. The recorder 

certificate is required to record all the secured sites. The client certificate is different and it serves as 

an additional layer of security that is required by the web server to authenticate the client/browser. If 

some applications use Secure Sockets Layer (SSL), the proxy recorder can cause authentication problems 

because SSL relays traffic between the client and the server. Depending on the authentication method in 

place, the client might require the proxy recorder to authenticate itself as the server, and the server might 

require the proxy recorder to authenticate as the client. If the client program requires an authenticated 

server, you must either have access to the server certificate keystore and provide it to the proxy recorder 

or configure the client to accept the default certificate from the proxy recorder instead of the certificate 

from the actual server.

To record an application that requires a client-side certificate, import the client certificate to the Rational® 

Performance Tester  project. To import the certificate, click File  > Import  > General  > File System, and 

navigate to the folder that contains the certificates and click Finish.
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To record an SAP Portal session:

1. Click File  > New  > Test from Recording; then select SAP Recording, and click Next.

2. Select the project and folder where you want to create the batch input test, type a name for the new 

test, and then click Next.

3. On the SAP session  page of the wizard, select Record a session initiated from HTTP SAP Portal.

4. Select a web browser and click Next.

5. Depending on your selection, take one of the following steps. On the Recorder Settings  page, 

depending on the browser that you selected, specify these details:
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• To record HTTP or SOCKS traffic through a proxy, click Record traffic with the proxy 

recorder. To record low-level network traffic for applications where a proxy cannot be used, 

click Record traffic with the socket recorder. Use this option when you are not using Mozilla 

Firefox or Microsoft™  Internet Explorer.

Note:  When using proxy recording, you can filter out HTTP or HTTPS requests to a 

specific endpoints so that any requests to those endpoints are not recorded. See Proxy 

recording preferences  on page .

• If IBM®  Rational®  Functional Tester  is installed and shell-shared with Rational® 

Performance Tester, for the Web UI tests, you can use the Record user actions  option to 

record the functional aspects of the application in the same HTTP recording session. Thus, 

both the functional and performance aspects of the application are recorded.

• If the server requires client SSL authentication, provide the client certificate for the proxy 

recorder to be authenticated by the server as though the proxy recorder were the client. 

Select The server requires a specific client certificate.

To provide single certificate keystore, specify the file name and password of the server 

certificate keystore. If multiple certificates are required, click Multiple certificates, and click 

Add  to specify a certificate keystore file name and password for each host name and port.

• To record a secured site using Internet Explorer or Google Chrome on Windows, install the 

recorder certificate by selecting Register the recorder root certificate authority. Before the 

recording starts, the browser prompts you to install the certificate. After the recording is 

stopped, the browser prompts you to uninstall the certificate. To avoid multiple prompts for 

each recording, select Keep the recorder root certificate authority after recording.

Note:  If you already had the certificate from a version prior to 9.2.1 and then install the 

latest version of the product, you might have to install the certificate again.

This option is not available when you record by using the Firefox or Safari 

browser. To record a secured site on these browsers, manually import the 

certificate in the browser from the default location C:\Program Files 

(x86)\__VENDOR_NAME__\__VENDOR_NAME__IMShared\plugins

\com.ibm.rational.test.lt.recorder.proxy_version\SSLCertificate. For 

information about how to import the certificates, see the browser's documentation.

• If you selected Mozilla Firefox, you can choose to use a temporary Firefox profile. This 

option starts the Firefox browser without any bookmarks, plug-ins, or toolbars that might be 

associated with your usual profile. Select Use an alternate Firefox profile, and then select 

Use a temporary Firefox profile.
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• If you clicked Record traffic with the proxy recorder, click Advanced  to specify whether to 

use an HTTP or SOCKS proxy recorder to review and edit network connection settings that 

the browser uses or to specify advanced SSL authentication settings. If you clicked Record 

traffic with the socket recorder, specify the advanced SSL authentication settings.

6. To start the recording, click Finish.

The web browser opens.

7. In the web browser, type the URL of an SAP Portal web interface.

8. On the web page, follow the logon procedure, and click the link to open the SAP GUI session. The 

web browser downloads an SAP Portal shortcut file and opens the SAP GUI application with the 

session information that the shortcut file contains.

9. In the SAP GUI client, complete the transactions to record for the test.

10. When you complete the transactions to be tested, stop the recording by closing the SAP GUI and 

the web browser.

At the end of the recording session, one test is created that will contain both HTTP and SAP GUI pages. 

To run an SAP Portal test, click Run Test.

Related information

SAP performance testing guidelines  on page44

Recording an SAP test  on page47

Recording a specific SAP transaction from a running SAP session  on page51

Inserting a new recording into a SAP test  on page53

Recording a SAP batch input test  on page57

Changing SAP test generation preferences  on page60

Recording a SAP batch input test
You can record certain SAP transaction  sessions from SAP GUI with SAP batch input tests recording 

wizard. When you record a session, the recording wizard automatically starts a SAP GUI interface and 

records the transaction that you specified. After you finish the recording, the wizard generates a SAP 

batch input test in IBM®  Rational®  Performance Tester.

You must have added the SAP Java™  Connector (JCo) libraries on your computer. See Configuring an 

environment for batch input tests  on page .
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During a SAP batch input test recording, the SAP batch input test produces only a batch input transaction 

that you specified. The SAP batch input tests do not contain any verification point and do not produce any 

performance result.

You must install the latest version of SAP GUI when you want to record an SAP test in Rational® 

Performance Tester. For more information about supported SAP GUI versions, see System Requirements 

on page .

1. Open Rational®  Performance Tester.

2. Click the New Test From Recording  icon , and then click SAP Test.

Note:  You can also click File  > New  > Test From Recording, and then select SAP Test. You can 

then select the encryption level, if required and click Next  to open the Select Location  page.

The Select Location  page is displayed.

3. Create a test by performing the following steps:

a. Select a project, and then select a folder from the project.

b. Enter a name for the test.

c. Optionally, click Recording encryption level, and then select the encryption level when you 

are recording any sensitive data.

4. Click Next.

The Select Client Application  page is displayed.

5. Select SAP Batch Input Recording, and then click Next.

6. Perform the following steps to enter the connection and transaction details provided by the SAP 

administrator.

a. Enter the following details in the Connection  section.

Fields Action

Client Enter the SAP client details.

User Enter the user name associated with the SAP serv

er.

Password Enter the password associated with the user 

name.

Language Select your language.

Host Enter the SAP host server details.
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Fields Action

System Number Enter the system number that corresponds to an 

SAP instance with the SAP server.

Note:  For IBM®  Rational®  Performance 

Tester, the default value is 00.

b. Click Test Connections  to verify if the connection is established.

The SAP Batch Connection  dialog box is displayed.

A confirmation message is displayed that states that the connection is successful.

c. Click OK.

d. Enter the SAP transaction code in the Code  field.

e. Click Finish.

The SAP GUI  window is displayed.

7. Record the batch input transaction, and then click Save.

The SAP GUI Transaction  page is displayed.

The page displays the details of the transaction that you recorded.

8. Click Exit.

Note:  To exit the SAP GUI Transaction page, you must click Exit. If you exit the page by using 

any other methods, an exception error is displayed.

9. Select the directory where you want to export the recording on your local computer, and then click 

Generate.

The SAPGUI Security  dialog box is displayed.

The dialog box displays the file path for the recording and the directory where the recording is 

being stored.

10. Click Allow  to confirm.

A Test Generation Progress  window is displayed while the test is being generated.

The following message is displayed on the progress window: Test Generation completed.

The SAP batch input transaction is recorded.
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You can click Open Test  to open the test in Rational®  Performance Tester  test editor. You can then verify 

the SAP transaction details and save the test. Later, you can run the test and view the transaction details 

from the following pages:

• Test Log page

• SAP Performance report page (SAP Performance Report  > Batch Input Transaction)

• Functional Test report page

Related reference

SAP Performance report  on page

Related information

SAP performance testing guidelines  on page44

Recording an SAP test  on page47

Recording a specific SAP transaction from a running SAP session  on page51

Inserting a new recording into a SAP test  on page53

Recording a session with HTTP SAP Portal  on page54

Changing SAP test generation preferences  on page60

Configuring an environment for batch input tests  on page

Changing SAP test generation preferences
You can change how SAP performance tests are generated, such as how tests will process verification 

points, data correlation, and pages.

To change the SAP test generation preferences:

1. Click Window  > Preferences.

2. In the list on the left, expand Test, expand Performance Test GenerationTest Generation, and click 

SAP Test Generation.

3. Select the preference to change.

Automatic Generation

These settings specify test elements that are automatically generated after recording 

the test.

Use connection by string
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When enabled, tests are generated with the connection by string 

launch method instead of using the SAP Logon program. This option is 

enabled by default.

Verification points for SAP screen titles

When enabled, this option generates verification points on screen titles 

with each SAP screen. This option is disabled by default.

Verification points for SAP request response time threshold

When enabled, this option generates verification points on the response 

time of the SAP server. If the server response time is above the 

specified threshold, the test produces a failed verification point. This 

option is disabled by default.

Calculate threshold from recorded (%)

This specifes the default response time threshold that is calculated 

when response time verification points are generated. The threshold 

value is calculated as a percentage of the actual response time that 

was measured during the recording. By default, the response time 

threshold is generated with a value of 120% of the recorded response 

time.

Default request timeout [ms]

Specify a timeout value for a request to ping the server. When the request is timed 

out, it no longer pings the server for that request.

GUI on execution

During test execution, it might not be desirable to display the SAP GUI. Hiding the 

SAP GUI improves the performance of the virtual users.  This setting specifies the 

default behavior when the test is generated. However, you can change this setting in 

the test editor by selecting the SAP test element.

Hide GUI during execution

When selected, all instances of the SAP GUI are hidden. In some cases, 

modal dialog boxes from the SAP GUI can flash briefly on the screen. 

This is the default setting.

Note:  If you run a test in the hidden mode and the test fails due to 

modal dialog boxes or pop-up windows in transactions, you must add 
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the RPT_VMARGS  property with value set to rptSapForceShowNone=true  in 

the Location property.

Show GUI for only one virtual user

When selected, the SAP GUI is displayed only for the first virtual user. All 

other instances of the SAP GUI are hidden. This allows you to monitor 

the execution.

Show GUI for all virtual users

When selected, the SAP GUI is displayed for all virtual users.

Password prompt

Specifies behavior of the password request.

Prompt me for password when generating test

When enabled, a password is requested at the end of the recording 

session. If disabled, the password is recorded with an empty string. The 

recorder cannot record the password during the test. Therefore, if this 

option is disabled, the test uses an empty string for the password.

4. After changing a setting, click Apply.

Related information

SAP performance testing guidelines  on page44

Recording an SAP test  on page47

Recording a specific SAP transaction from a running SAP session  on page51

Inserting a new recording into a SAP test  on page53

Recording a session with HTTP SAP Portal  on page54

Recording a SAP batch input test  on page57
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Recording Citrix tests
When you record a test, the test creation wizard records your interactions with the Citrix server, generates 

a test from the recording, and opens the test for editing. You can record a test session in the Citrix 

XenApp client.

Citrix performance testing guidelines
Citrix performance tests use synchronization mechanisms to replay the tests on multiple Citrix sessions 

independently of server performance.

These guidelines will help you record a reliable test and avoid synchronization timeouts during test 

execution.

Ensure that you have a working Citrix client environment and that you can connect to a Citrix server. For 

information about supported Citrix client versions, see IBM Software Product Compatibility Reports.

The most efficient recording method is to specify a published application or a server in the recording 

wizard. It is preferable to specify your login credentials in the wizard instead of recording the login 

sequence as part of the test.

Ensure that the session that you are recording will be reproducible. To record tests that can be reliably 

replayed, follow these guidelines:

• If you save a file during a recorded session, when replaying the tests, some applications might 

produce a warning for an existing filename. If the warning was not in the recorded session, this 

might break the test and cause synchronization timeouts.

• Do not use the mouse wheel to scroll when recording Citrix tests. Mouse wheel events are not 

recorded and will result in synchronization timeouts on execution.

• Anticipate and make provisions for avoidable warnings and unrecorded windows and dialog 

boxes. For example, if you save a file while recording, the test will try to save the same file during 

the replay. Although the file might not exist during the initial recording, it does after recording. 

Attempting to save will generate an overwrite warning and cause synchronization timeouts.

• Disable or turn off warnings, windows, and dialog boxes that are displayed during the first start of 

an application. These items will be captured during the recording, but they might not be displayed 

in subsequent application starts. This will cause synchronization timeouts.

• Use dedicated test user accounts for performance tests. Ensure that the user accounts have 

minimal potential to cause problems if unpredictable mouse events occur outside of the 

application window after a synchronization timeout.
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• Set up the test accounts and applications to minimize unpredictable window events, such as 

new mail notifications, automatic updates, or daily tips. Disable extensible menus and hover text 

tooltips when possible.

• Ensure that all computers used for recording and playback of Citrix tests use the same 

international settings and character sets. Different locales can cause some characters to be 

unavailable or keyboard inputs to be incompatible.

• To launch applications from the desktop, use the Quick Launch bar, desktop shortcuts, or select 

Start  > Run  and enter the name of the application. Do not launch applications or open files from 

locations that are likely to change, such as Favorites, Recent Files, or other dynamic menus.

• When using cascading menus like the Start  menu, always wait for a moment for the submenu 

to display. After the recording, when editing the test, look at the mouse sequences that were 

generated to ensure that they follow the correct path to display the submenu.

• When recording your tests, before interacting with a window or dialog box, click the element to 

ensure that it gets focus, then provide input.

• When an application is busy, for example when the mouse cursor is a sand glass, avoid using the 

mouse or attempting to perform other operations.

• After recording a session, some applications require user input before quitting (for example, to 

record any changes). This can cause discrepancies between the state of the application at the end 

of a session and at the beginning of a test execution. To avoid problems, at the end of a recording 

session, close all applications manually and cleanly end the session by clicking Stop  or Close  on 

the Citrix Recorder  window, rather than from the Start  > Log Off  menu.

• To ensure long duration schedules are run without issues such as test log transfer not completed, 

Citrix Online Plugin or Receiver crashes when virtual users are ramping down, and Citrix processes 

remaining, you must select the Uninterruptible iteration  check box for the loops. When you use 

this option, you must increase the value of Time limit for a user to respond to a stop request  in the 

User Load  tab of the schedule as per the requirement.

After recording, and while you edit the test, it is important to perform regular verification runs in order 

to validate the test with a single user. After each run, open the test log to make sure that the test 

synchronizes correctly. If necessary, change the synchronization level from Mandatory  to Conditional 

or Conditional  to Optional  on window events or image synchronizations that produce unnecessary 

timeouts. Only deploy the test on virtual users or run it in a schedule when the test is robust enough to run 

flawlessly with a single user.

Rational®  Performance Tester  Agent requirements

When you install Rational®  Performance Tester  Agent, by default, the agent starts as a service. To use 

the agent for Citrix recording, it must run as a process. For Windows, open Windows Services. If the 

MajordomoService is set to Automatic  start up, set it to Manual  and then stop the MajordomoService. 
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You can now open the Majordomo folder from the Rational®  Performance Tester  Agent installation path 

and double-click Majordomo.bat.

Optical Character Recognition

You can use optical character recognition when performing image synchronizations. This allows the test 

to synchronize itself by recognizing the contents of a screen area. In some cases, the software can fail to 

correctly recognize portions of text or letters.

To improve results of the optical character recognition, follow these guidelines:

• Use preferably high contrast screen areas where the text is clearly separated from the background.

• Select text areas with a homogeneous font size, style, and color. Mixing text styles will produce 

poor results.

• Try changing the OCR language, OCR zoom factor, OCR brightness, OCR recognition rate  or 

settings in the image synchronization test element. You can change the default values for these 

settings in the Preferences  > Test  > Test Generation  > Citrix Test Generation  window.

• If the test produces image synchronization timeouts because of inconsistent text recognition, 

open the Image Synchronization view in the test log, and add click the Add value  button to add the 

unrecognized text as an alternate synchronization value.

• In some cases, it might be more efficient to use the bitmap hash code method for image 

synchronization, instead of optical character recognition.

When recording image synchronizations with optical character recognition, accuracy of the recognized 

text is not essential. It is only important that the recognized text is consistent each time the test is 

executed for the test to synchronize. For example, if a portion of text is displayed as "Hello" on the screen, 

and recognized as "He110" in the recorded test, you should not attempt to correct the value in the image 

synchronization test element, because the same result should occur when the test is executed for the test 

to synchronize.

Long duration test runs

When running long duration test schedules that exceed 24 hours, use the long run mode to reduces 

resource consumption with the Citrix client. This mode increases the reliability of long duration test runs 

by running the tests in multiple process. You must enable this option for each user group in the schedule.

In long run mode, a new process is created for each virtual tester.
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Related information

Recording a Citrix test  on page66

Recording a test with the Citrix Web Interface  on page70

Inserting a new recording into a Citrix test  on page74

Changing Citrix recording preferences  on page76

Changing Citrix test generation preferences  on page77

Running long duration Citrix tests  on page

Recording a Citrix test
You can record a Citrix session with the Citrix XenApp or XenDesktop. When you record, the recording 

wizard automatically starts the client and configures it for recording. When you have finished recording 

the session, the wizard generates a Citrix performance test.

• Install Citrix Receiver and connect to Citrix XenDesktop. For information about supported versions, 

see the System Requirements  document. Rational®  Performance Tester  V9.1 supports Citrix 

Receiver 4.5 or 4.6 and Citrix XenDesktop 7.8.

• If you use Microsoft Windows 2008, you must have Citrix Receiver 3.3 or 4.1. To run a citrix test 

on Microsoft Windows 2008, you must install Citrix Receiver 3.3 or 4.1 and .Net Framework 3.5. 

To install the .Net Framework 3.5 feature, open Control Panel  and click Turn Windows features on 

or off. In the Add Roles and Features Wizard, on the Features page, select the .Net Framework 3.5 

Features  check box, and click Next. To specify the source files path of the feature, click Specify an 

alternate source path, specify the path, click OK, and click Install.

• The behavior of the recording wizard is controlled by recorder preferences. To inspect the current 

settings, click Window  > Preferences, expand Test, and click Citrix Recording. This procedure 

assumes that default settings are used.

• After you record a test or when you run a test on Windows 2008, the Citrix Image Synchronization 

tab does not display the captured screenshot for Actual Image. The bitmap hash code also varies 

for the actual and expected screenshot. You must use the bitmap hash code of the Expected 

Image  for Actual Image. To do that, in the Citrix Image Synchronization, click the Add Value  icon 

and click Yes  in the confirmation message. The Image Synchronization entry is added to the test. 

Save the test.

• By default, IBM®  Rational®  Performance Tester  Agent starts as a service. If you run a Citrix test on 

an agent, you must start Rational®  Performance Tester  Agent as a process.
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To start an agent as a process:

1. Open the Windows Services window.

2. For the Majordomo  service, change the Startup Type  to Manual  and then change the Status 

to Stop.

3. From the agent's installation directory, open the Majordomo folder, and double-click the 

Majordomo.exe file.

You can record and generate a test by using REST APIs. The API documentation to 

record a test is located at Install_directory\IBM\IBMIMShared\plugins

\com.ibm.rational.test.lt.server.recorder.jar. The API documentation to generate a 

test after the recording completes is located at C:\Program Files\IBM\IBMIMShared\plugins

\com.ibm.rational.test.lt.server.testgen.jar.

To record a Citrix test:

1. In the Performance Test perspective, click the New Test from Recording  toolbar button  or click 

File  > New  > Test from Recording.

2. In the New Test from Recording  wizard, select Create a test from a new recording, select Citrix 

Test, and click Next.

If you are recording sensitive data, you can select a Recording encryption level.

3. On the Select Location  page, select the project and folder locations to contain the new test, type a 

name for the test, and click Next.

If necessary, click the Create Parent Folder   push button to create a new project or folder.

4. On the Citrix Connection Settings  page, specify how to connect to the Citrix server. Complete one 

of these tasks:

• If your Citrix administrator has provided you with an ICA file, complete these steps:

a. Select With ICA file  to use its settings to connect to the server.

b. Click Browse  to locate and select the ICA file on your computer.

c. Click Next  to continue.

• If you want to manually specify the Citrix server to use for the session, complete these 

steps:

a. Select On server  to connect directly to the server.

b. Specify the name or IP address of the server or click Browse  to locate a server or server 

farm on your local network.

c. Optional:  If you need to change the Citrix farm parameters, click Farm Settings.

d. To record a Windows™  desktop session, leave Initial program  blank.

• If your Citrix administrator has published applications on the network, complete these steps:
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a. Select On published application, and click Browse  to choose the application from the list of 

published applications on the server or server farm.

b. Optional: If you need to change the Citrix farm parameters, click Farm Settings.

In this case, the server farm performs the load balancing and selects the server automatically.

5. To make the logon sequence part of the session parameters, select Logon with user-specified 

credentials, type your credentials, and specify the domain name. If this option is disabled, your 

credentials are recorded as part of the logon sequence during the recording.

Note:  If you use the With ICA file  option and the ICA file contains the LogonTicket  command, 

even after you type your credentials as part of this step, you must type your credentials again on 

the Citrix server to start a Citrix test. To avoid entering credentials twice, you can manually remove 

the LogonTicket  command from the ICA file.

6. Click Next  to continue.

7. On the Citrix Session Preferences  page, you can provide a description for the test, change the 

video settings, encryption mode, and advanced options for the Citrix XenApp client. Click Next  to 

continue.

Note:  Because Citrix performance tests are based on low-level interactions with the server, 

including mouse and window coordinates, the Citrix desktop must be large enough to support the 

application under test. You must particularly avoid scrolling windows during the recording.

8. If this is the first time you record a Citrix performance test, read the Privacy Warning, and then 

select Accept  to proceed.

9. To start the recording, click Finish.

The Citrix Recording  window opens, displaying the Citrix XenApp session and a set of recorder 

controls.

10. In the Citrix Recording  window, complete the tasks to test.

You can use the recorder controls in the toolbar to add comments, record synchronizations, or take 

screen captures during the recording.

a. To add a user comment to the recorded test, click the Insert user comment  icon .

Because Citrix tests can be long and difficult to read, meaningful comments can help you 

locate important elements.

b. To add an image synchronization to the recorded test, click the Insert image 

synchronization  icon , select an area of the screen to be used for synchronization, and 

then click the Insert image synchronization  icon again.

Image synchronizations enable the test to keep track of the contents of a screen area during 

the replay instead of focusing only on window events. You can use these screen captures 

to maintain synchronization of a test in applications that do not create or modify many 
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windows, but update the contents of a window regularly. The contents of an image can 

be evaluated either as a bitmap hashcode or as a text value obtained by optical character 

recognition.

c. To insert a response time measurement during the recording, click the Insert response time 

icon  to create a start for the measurement in the recording, and click the icon again to 

create a stop.

d. To add a screen or window capture to the recorded test, click the Capture screen  icon  or 

Capture window  icon .

Screen and window captures make your tests easier to read and help you visualize the 

recorded test. To change the settings for screen and window captures, click the Screen 

capture preferences  icon , and then select one of these options:

No automatic screen capture

Select this option if you do not want the test recorder to record screen 

captures automatically. When this option is selected, you can still record 

screen captures manually. This option is selected by default.

Capture screen every

Select this option to automatically record a periodic screen capture and 

specify the time between captures.

Capture screen on window creation

Select this option to record a screen capture each time a window object is 

created in Citrix.

Exclude tooltips

When Capture screen on window creation  is selected, enable this option to 

prevent creating a screen capture each time a tooltip event is displayed during 

the recording. If this option is disabled, screen captures are recorded when 

tooltips are displayed.

To preview all screen captures, window captures, and image synchronizations on the side of 

the Citrix Recording window, click the Screen capture preview button  icon .

11. When you have completed the sequence of actions to be tested, close the session, and stop the 

recorder by clicking the Stop recording  icon .

A progress window opens while the test is generated. On completion, the Recorder Control  view 

displays the Test generation completed  message, the Test Navigator lists your test, and the test 

opens in the test editor.

69



Test Author Guide

70

Related information

Citrix performance testing guidelines  on page63

Recording a test with the Citrix Web Interface  on page70

Inserting a new recording into a Citrix test  on page74

Changing Citrix recording preferences  on page76

Changing Citrix test generation preferences  on page77

Creating tests  on page

Recording sensitive session data  on page141

Recording a test with the Citrix Web Interface
You can record a Citrix session from the Citrix Web Interface to use the load balancing feature provided by 

this connection method.When you have finished recording the session, the wizard generates a Citrix test.

• By default, IBM®  Rational®  Performance Tester  Agent starts as a service. If you run a Citrix test on 

an agent, you must start Rational®  Performance Tester  Agent as a process.

To start an agent as a process:

1. Open the Windows Services window.

2. For the Majordomo  service, change the Startup Type  to Manual  and then change the Status 

to Stop.

3. From the agent's installation directory, open the Majordomo folder, and double-click the 

Majordomo.exe file.

Certain websites require appropriate certificates to use a proxy recorder to record the site. The recorder 

certificate is required to record all the secured sites. The client certificate is different and it serves as 

an additional layer of security that is required by the web server to authenticate the client/browser. If 

some applications use Secure Sockets Layer (SSL), the proxy recorder can cause authentication problems 

because SSL relays traffic between the client and the server. Depending on the authentication method in 

place, the client might require the proxy recorder to authenticate itself as the server, and the server might 

require the proxy recorder to authenticate as the client. If the client program requires an authenticated 

server, you must either have access to the server certificate keystore and provide it to the proxy recorder 

or configure the client to accept the default certificate from the proxy recorder instead of the certificate 

from the actual server.

../../com.ibm.rational.test.lt.doc/topics/tcreatetest.html
../../com.ibm.rational.test.lt.doc/topics/tcreatetest.html
../../com.ibm.rational.test.lt.doc/topics/tcreatetest.html
../../com.ibm.rational.test.lt.doc/topics/tcreatetest.html
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To record an application that requires a client-side certificate, import the client certificate to the Rational® 

Performance Tester  project. To import the certificate, click File  > Import  > General  > File System, and 

navigate to the folder that contains the certificates and click Finish.

1. Click File  > New  > Test from Recording, and then select Citrix Recording, and click Next.

2. On the Select Location for Test Suite  page, select a project.

3. In Test file name, type a name for the Citrix test, and then click Next.

4. On the Citrix Connection Settings  page, select Through a Web interface, and click Next.

5. On the Select Client Applications  page, select the web browser to use and click Next.
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6. Depending on your selection, take one of the following steps. On the Recorder Settings  page, 

depending on the browser that you selected, specify these details:

• To record HTTP or SOCKS traffic through a proxy, click Record traffic with the proxy 

recorder. To record low-level network traffic for applications where a proxy cannot be used, 

click Record traffic with the socket recorder. Use this option when you are not using Mozilla 

Firefox or Microsoft™  Internet Explorer.

Note:  When using proxy recording, you can filter out HTTP or HTTPS requests to a 

specific endpoints so that any requests to those endpoints are not recorded. See Proxy 

recording preferences  on page .

• If IBM®  Rational®  Functional Tester  is installed and shell-shared with Rational® 

Performance Tester, for the Web UI tests, you can use the Record user actions  option to 

record the functional aspects of the application in the same HTTP recording session. Thus, 

both the functional and performance aspects of the application are recorded.

• If the server requires client SSL authentication, provide the client certificate for the proxy 

recorder to be authenticated by the server as though the proxy recorder were the client. 

Select The server requires a specific client certificate.

To provide single certificate keystore, specify the file name and password of the server 

certificate keystore. If multiple certificates are required, click Multiple certificates, and click 

Add  to specify a certificate keystore file name and password for each host name and port.

• To record a secured site using Internet Explorer or Google Chrome on Windows, install the 

recorder certificate by selecting Register the recorder root certificate authority. Before the 

recording starts, the browser prompts you to install the certificate. After the recording is 

stopped, the browser prompts you to uninstall the certificate. To avoid multiple prompts for 

each recording, select Keep the recorder root certificate authority after recording.

Note:  If you already had the certificate from a version prior to 9.2.1 and then install the 

latest version of the product, you might have to install the certificate again.

This option is not available when you record by using the Firefox or Safari 

browser. To record a secured site on these browsers, manually import the 

certificate in the browser from the default location C:\Program Files 

(x86)\__VENDOR_NAME__\__VENDOR_NAME__IMShared\plugins

\com.ibm.rational.test.lt.recorder.proxy_version\SSLCertificate. For 

information about how to import the certificates, see the browser's documentation.

• If you selected Mozilla Firefox, you can choose to use a temporary Firefox profile. This 

option starts the Firefox browser without any bookmarks, plug-ins, or toolbars that might be 

unique_23
unique_23
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associated with your usual profile. Select Use an alternate Firefox profile, and then select 

Use a temporary Firefox profile.

• If you clicked Record traffic with the proxy recorder, click Advanced  to specify whether to 

use an HTTP or SOCKS proxy recorder to review and edit network connection settings that 

the browser uses or to specify advanced SSL authentication settings. If you clicked Record 

traffic with the socket recorder, specify the advanced SSL authentication settings.

7. To start the recording, click Finish.

The web browser opens.

8. In the web browser, specify the Citrix Web Interface server URL

9. On the Citrix Web Interface page, type your user name, password, and domain to open a session. 

The Citrix Web Interface displays the list of applications published on a server and available to the 

user. Select the application to test.

The Citrix Recording window opens. You can use the recorder controls in the toolbar to add 

comments, record synchronizations, or take screen captures during the recording.

a. To add a user comment to the recorded test, click the Insert user comment  icon .

Because Citrix tests can be long and difficult to read, meaningful comments can help you 

locate important elements.

b. To add an image synchronization to the recorded test, click the Insert image 

synchronization  icon , select an area of the screen that will be used for synchronization, 

and then click the Insert image synchronization  icon again.

Image synchronizations enable the test to keep track of the contents of a screen area during 

the replay instead of focusing only on window events. You can use image synchronizations 

to maintain synchronization of a test in applications that do not create or modify many 

windows, but update the contents of a window regularly. The contents of an image can 

be evaluated either as a bitmap hashcode or as a text value obtained by optical character 

recognition. You can also add verification points to image synchronizations in the test 

editor.

c. To add a screen capture to the recorded test, click the Capture screen  icon .

Screen captures make your tests easier to read and help you visualize the recorded test.

d. To change the settings for screen captures, click Screen capture preferences  icon , and 

then select one of these options:

No automatic screen capture
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Select this option if you do not want the test recorder to record screen 

captures automatically. When this option is selected, you can still record 

screen captures manually. This option is selected by default.

Capture screen every

Select this option to automatically record a periodic screen capture and 

specify the time between captures.

Capture screen on window creation

Select this option to record a screen capture each time a window object is 

created in Citrix.

Exclude tooltips

When Capture screen on window creation  is selected, enable this option to 

prevent creating a screen capture each time a tooltip event is displayed during 

the recording. If this option is disabled, screen captures are recorded when 

tooltips are displayed.

10. When you complete the sequence of actions to be tested, close the session and stop the recorder 

by clicking the Stop recording  ( ) or close the Citrix application and web browser..

A progress window opens while the test is generated. On completion, the Recorder Control  view 

displays the Test generation completed  message, the Test Navigator lists your test, and the test 

opens in the test editor.

The Test editor displays both the HTTP pages and the Citrix user actions.

To run the Citrix Web Interface test, click Run Test  in the Test editor.

Related information

Citrix performance testing guidelines  on page63

Recording a Citrix test  on page66

Inserting a new recording into a Citrix test  on page74

Changing Citrix recording preferences  on page76

Changing Citrix test generation preferences  on page77
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Inserting a new recording into a Citrix test
You can insert a new recording into a Citrix test. Use this feature to add or replace a part of a recorded 

session.

Inserting a new sequence into a test requires that the Citrix session reaches the same state as is 

expected at the point where the new sequence is inserted. For example, if your new sequence must 

interact with a particular window that was created earlier in the test, you must advance to the point where 

that window is in the expected state before the recording can start. To do this, the Citrix test recorder can 

either automatically replay the existing scenario up to the insertion point, or you can manually advance 

the session to the expected state.

When inserting a new sequence into a test, it is important that the context of user actions is preserved 

to ensure that the test synchronizes properly during the replay. The resulting test will probably require 

manual editing to make sure that test can replay smoothly.

Note:  Because Citrix tests contain low level user input and synchronizations, minor changes can 

prevent the test from working. When editing these tests, you must ensure that they are functionally 

identical.

To insert a recording into a test:

1. In the test editor, select the element before which you want to insert the new recording.

It is easier to manage the new test sequence when the insertion point is at the window event level 

of the test.

2. Click Insert, and then Record scenario.

3. In the Update Recording  window, specify how you want the session to reach the state expected at 

the insertion point, and then click OK.

• Select Automatically replay the scenario  to replay the test up to the insertion point. With 

this option, the test replays and stops when it reaches the insertion point. If the replay fails 

to synchronize, you will be asked to manually bring the session to the expected insertion 

point state.

• Select Manually advance to the expected state  to manually put the Citrix session into the 

state that will be expected at the insertion point.

4. After the Citrix session is in the expected state and you are ready to start the new recording, 

engage the Enable/Disable recording  button in the toolbar.

If you chose the automatic replay option, the recording is enabled automatically.

5. Perform the sequence of actions that you want to add to the existing test. When you have finished, 

click the Enable/Disable recording  again to stop the recording.
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Note:  You can restart the recording several times. However, you must be sure that the Citrix 

session resumes from the same state that it was in when it was stopped. If actions are missing 

from the recorded sequence the test is unlikely to synchronize correctly during the replay.

6. When you have completed the sequence of actions to be inserted into the test, close the session 

and stop the recorder by clicking Stop recording .

A progress window opens while the test is generated. On completion, the Recorder Control  view 

displays the message Test generation completed, the Test Navigator lists your test, and the test 

opens in the test editor.

7. After the test has been updated in the Test Navigator, check that the new sequence was properly 

inserted into the test before saving the new test.

Check that the context of the Citrix session is compatible with the user actions at the beginning 

and at the end of the of the inserted sequence. If the results of the insertion were not what you 

expected, you can revert to the previously saved version of the test by clicking File  > Revert  or try to 

correct any problems manually.

Related information

Citrix performance testing guidelines  on page63

Recording a Citrix test  on page66

Recording a test with the Citrix Web Interface  on page70

Changing Citrix recording preferences  on page76

Changing Citrix test generation preferences  on page77

Changing Citrix recording preferences
You can change the behavior of the recorder by changing the preference settings.

1. Click Window  > Preferences.

2. Expand Test  > Recording, and then click Citrix Recording.

3. Select the setting you want to change.

Screen capture options

These settings specify how the test recorder performs screen captures of the Citrix 

desktop during recording.

No automatic screen capture
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Select this option if you do not want the test recorder to record screen 

captures automatically. When this option is selected, you can still 

record screen captures manually. This option is selected by default.

Capture screen every

Select this option to automatically record a periodic screen capture and 

specify the time between captures.

Capture screen on window creation

Select this option to record a screen capture each time a window object 

is created in Citrix.

Exclude tooltips

When Capture screen on window creation  is selected, enable this 

option to prevent creating a screen capture each time a tooltip event 

is displayed during the recording. If this option is disabled, screen 

captures are recorded when tooltips are displayed.

Capture screen on image synchronization

Select this option to ensure that a screen capture is recorded each time an image 

synchronization is recorded.

4. After changing a setting, click Apply.

Related information

Citrix performance testing guidelines  on page63

Recording a Citrix test  on page66

Recording a test with the Citrix Web Interface  on page70

Inserting a new recording into a Citrix test  on page74

Changing Citrix test generation preferences  on page77

Changing Citrix test generation preferences
You can change how Citrix events are converted into performance test elements.

1. Click Window  > Preferences.

2. Expand Test  > Test Generation, and then click Citrix Test Generation.
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3. Select the setting you want to change.

Recording Optimization Options

These settings specify how mouse and window events are interpreted in the 

generated test.

Window activate recording

Specify whether to record no, last, or all window-activate actions when a 

sequence of similar actions is detected.

• none  disables recording of window-activate events.

• last  records only the last of an uninterrupted sequence of 

window events. This eliminates redundant window-activate 

actions from the recording.

• all  records all events of the sequence.

Mouse move recording

This setting specifies which mouse move events are recorded. Relevant 

is the default setting.

• All  records an uninterrupted sequence of mouse movements in 

the generated test.

• Relevant  records only the mouse movements that generate a 

response, such as hover text.

• First and last  records a simplified mouse-move action.

Automatic Generation

These settings specify test elements that are automatically generated after recording 

the test.

Verification point on every window title change

When enabled, this option generates a window title verification point 

whenever the caption changes. If this option is disabled, the window 

title is verified only when a new window is created. This option is 

disabled by default.

Response times for main windows

When enabled, this option generates response time measurements for 

all recorded main window-create events. A main window is a window 

that is created at the top level of the test contents tree and contains 

user actions. The generated response time measurement starts with 
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the keyboard or mouse action that immediately precedes the window-

create event. This option is enabled by default.

Window event synchronization criteria

Use this option to disable window recognition on the window position, size, or title. 

Disable any of these options if the test produces synchronization timeouts because a 

window changes its position, size, or title between or during test runs.

Default Test Execution Delays

This page specifies the default keyboard and mouse delays for the test client. Do not 

change these settings unless you are experiencing problems with events that do not 

run correctly.

Synchronization timeout delay

This is the delay after which a timeout error is produced when a window 

event or an image synchronization element is not recognized during 

test runs. The default value is 15000 milliseconds. The specified 

delay is for synchronizations that are set as conditional. Mandatory 

synchronizations use a delay of three times the specified delay. 

Optional synchronizations use a fixed delay of 2 seconds.

Note:  In the generated test, the Override synchronization timeout 

for a particular window creation event will be enabled with the 

corresponding recorded time only if it is greater than what is specified 

in this preference.

If think time is under x ms, then replace with

If the delay between two events is above the specified limit, then it is 

handled as a think time. If the delay is below the limit, then the test 

generator replaces the think time with one of the following delays. The 

think time is the delay spent by a virtual user before performing an 

action. The default limit is 20000 milliseconds.

Note:  In the generated test, the think time for a particular user 

action will be enabled only when the recorded think time is greater than 

the value specified for this preference.

Delay between mouse down and mouse up in a click
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This is the default delay used to generate a mouse click action 

using a mouse down and a mouse up action. The default value is 20 

milliseconds.

Delay between two mouse clicks in a double click

This is the default delay used to generate a double-click action using 

two mouse clicks. The default value is 50 milliseconds.

Delay between key down and a key up in a stroke

This is the default delay used to generate a key-stroke action using a 

key-down and a key-up action. The default value is 20 milliseconds.

Delay between two keyboard strokes in a text input

This is the default delay used to generate a text input action using 

multiple key stroke actions. The default value is 50 milliseconds.

Default OCR settings

This page specifies the settings for text extraction by optical character recognition 

in image synchronizations. You might need to experiment with various settings 

to obtain good results. These settings define the default behavior for new image 

synchronizations. You can change the behavior for individual image synchronization 

elements by changing the OCR settings  in the test editor.

OCR default language

This is the language of the dictionary that is used to recognize words 

for the application that you are testing. This setting defines the subset 

of languages that will be available in image synchronization elements in 

the test editor.

OCR default zoom factor

This is the enlargement factor that is applied to the image. The default 

setting is medium for standard font sizes. Increase the zoom factor to 

improve recognition of smaller fonts or decrease for larger fonts.

OCR default brightness

This is the brightness level from 0 to 250 that is applied to the image. 

The default setting is 70 for text with normal contrast. Increase the 

brightness setting to improve recognition of darker images or decrease 

for lighter images.

OCR default recognition rate
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This is the rate of recognition that is required for the extracted string 

to match the expected text. Decrease the recognition rate to tolerate 

a proportion of mismatching characters in the recognized text. The 

default is 100%, which means that an exact match is required.

4. After changing a setting, click Apply.

Related information

Citrix performance testing guidelines  on page63

Recording a Citrix test  on page66

Recording a test with the Citrix Web Interface  on page70

Inserting a new recording into a Citrix test  on page74

Changing Citrix recording preferences  on page76

Recording service tests
When you record a test, the test creation wizard records your interactions with the service, generates a 

test from the recording, and opens the test for editing. You can record a test session by invoking service 

calls with the generic service client or by using an existing client. You can also create a service test 

manually or from a Business Process Execution Language (BPEL) model.

Service testing guidelines
Before you can test a service, you must set up your test environment and incorporate these guidelines in 

order to produce reliable tests.

Test prerequisites
Before creating service tests, you might need to perform some initial tasks. These tasks depend on the 

transport and security protocols that are implemented by the web service under test.
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• HTTP: This transport method is supported by default; no additional configuration is required.

• SSL: The workspace must contain the certificate keystore (JKS) files that are required for single or 

double authentication.

• Java™  Message Service (JMS): The Web Services Description Language (WSDL) syntax must be 

compatible with the requirements of the product. Refer to Verifying WSDL syntax compliance for 

JMS services  on page 84.

Test generation
When the test is generated, message call envelopes are created according to the XML schema definition 

(XSD). During this process, mandatory fields are created, and default choices are assumed. You can 

modify these elements in the test editor.

Note:  During recording, you might supply authentication details which are not relevant for the actual 

application under test. To exclude such actions from the generated test, in Window  > Preferences  > Test  > 

Test editor  > Service test  ensure that the Display the 'Skip if Empty' column in XML tree viewer  check box 

is selected. To select the empty XML elements that you want to skip, in the test editor, select the elements 

in the Skip if empty  column.

Encryption and security

The Java™  Runtime Environment (JRE) that the product uses must support the level of encryption 

required by the digital certificate that you select. For example, you cannot use a digital certificate 

that requires 256-bit encryption with a JRE that supports only 128-bit encryption. By default, the 

product is configured with restricted or limited strength ciphers. To use less restricted encryption 

algorithms, you must download and apply the unlimited jurisdiction policy files (local_policy.jar  and 

US_export_policy.jar).

For Oracle Java, download the files from this site:http://www.oracle.com/technetwork/java/javase/

downloads/jce8-download-2133166.html.

Before installing these policy files, back up the existing policy files in case you want to restore the original 

files later. Then overwrite the files in /jre/lib/security/  directory with the unlimited jurisdiction 

policy files.

SSL Authentication
Service tests support simple or double SSL authentication mechanisms:

http://www.oracle.com/technetwork/java/javase/downloads/jce8-download-2133166.html
http://www.oracle.com/technetwork/java/javase/downloads/jce8-download-2133166.html
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• Simple authentication (server authentication): In this case, the test client needs to determine 

whether the service can be trusted. You do not need to setup a key store. If you select the Always 

trust  option, you do not need to provide a server certificat key store.

If you want to really authenticate the service, you can configure an certificate trust store, which 

contains the certificates of trusted services. In this case, the test will expect to receive a valid 

certificate.

• Double authentication (client and server authentication): In this case, the service needs to 

authenticate the test client according to its root authority. You must provide the client certificate 

keystore that needs to be produced to authenticate the test as a certified client.

When recording a service test through a proxy, the recording proxy sits between the service and the 

client. In this case, you must configure the SSL settings of the recording proxy to authenticate itself as 

the actual service to the client (for simple authentication), and as the client to the service (for double 

authentication). This means that you must supply the recording proxy with the adequate certificates.

When using stub services, you can also configure the SSL settings of the stub service to authenticate 

itself as the actual server. This means that you must supply the service stub with the adequate certificate.

NTLM and Kerberos Authentication

The product supports Microsoft™  NT LAN Manager (NTLMv1 and NTLMv2) and Kerberos authentication. 

The authentication information is recorded as part of the test during the recording phase.

To enable NTLMv2 support, you must add a third party library to the workbench. For more information, 

see Configuring the workbench for NTLMv2 authentication  on page 439.

Digital certificates

You can test services with digital certificates for both SSL and SOAP security protocol. Digital certificates 

must be contained in Java™  Key Store (JKS) keystore resources that are accessible in the workspace. 

When dealing with keystore files, you must set the password required to access the keys both in the 

security editor and the test editor. For SOAP security you might have to provide an explicit name for the 

key and provide a password to access the private keys in the keystore.

Limitations

Arrays are not supported.

Because of a lack of specification, attachments are not supported with the Java™  Message Service (JMS) 

transport. The envelope is directly sent using UTF-8 encoding.
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All security algorithms are not always available for every Java™  Runtime Environment (JRE) 

implementation. If a particular security implementation is not available, add the required libraries to the 

class path of the JRE that this product uses.

The generic service tester displays the envelope as reflected in the XML document. However, security 

algorithms consider the envelope as a binary. Therefore, you must set up the SOAP security configuration 

so that incoming and outgoing messages are correctly encrypted but remain decrypted inside the test.

Performance

Virtual user performance depends on the implementation of the container application. For an HTTP 

transport, the product has been tested with a maximum of 900 concurrent virtual users under Windows™ 

and 600 under Linux™. For JMS, the maximum is 100 concurrent virtual users, although this number can 

vary due to the asynchronous implementation of JMS. Beyond these values, connection errors might 

occur and the transaction rate will decrease.

Related information

Verifying WSDL syntax compliance for JMS services  on page84

Recording a service test with the generic service client  on page86

Recording a service test through a client program  on page89

Preparing to record a test for the HTTP/2 service  on page94

Creating a service test from a BPEL model  on page102

Creating a service test manually  on page104

Creating a service test for WebSphere MQ  on page105

Creating a service test for WebSphere Java MQ  on page107

Creating a service test for a plain XML call  on page110

Changing service test generation preferences  on page111

Verifying WSDL syntax compliance for JMS services
Various Java™  Message Service (JMS) providers vary in the syntax used for describing services. Before 

testing JMS services, you must ensure that Web Services Description Language (WSDL) files comply with 

the requirements of the tool.
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1. In the project explorer or test explorer, locate and open the WSDL file for the JMS service that you 

want to test.

If necessary, you can import a WSDL file from the file system by clicking File  > Import  > File 

System.

2. Ensure that the following criteria are met in the syntax of the WSDL file that you use.

• Namespace: xmlns:jms="http://schemas.xmlsoap.org/wsdl/jms/"

• SOAP bindings are set to: transport="http://schemas.xmlsoap.org/soap/jms"

• JMS transports are defined either as a URL or as jms:address  element

3. If the WSDL file is not compliant, edit the file so that it meets the criteria, and then save and close 

the file.

For example, a JMS defined as a URL looks like this:

<soap:address location="jms:/queue?jndiConnectionFactoryName=UIL2ConnectionFactory;

             jndiDestinationName=queue/testQueue;

             initialContextFactory=org.jnp.interfaces.NamingContextFactory;

             jndiProviderURL=9.143.104.47"/>

A JMS defined as an address looks like this:

<jms:address destinationStyle="queue" 

             jndiConnectionFactoryName="myQCF"

             jndiDestinationName="myQ"

             initialContextFactory="com.ibm.NamingFactory" 

             jndiProviderURL="iiop://something:900/">

</jms:address>

Related information

Service testing guidelines  on page81

Recording a service test with the generic service client  on page86

Recording a service test through a client program  on page89

Preparing to record a test for the HTTP/2 service  on page94

Creating a service test from a BPEL model  on page102

Creating a service test manually  on page104

Creating a service test for WebSphere MQ  on page105

Creating a service test for WebSphere Java MQ  on page107
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Creating a service test for a plain XML call  on page110

Changing service test generation preferences  on page111

Recording a service test with the generic service client
You can record a service test by invoking service requests with the generic service client. After you have 

sent the requests and received the responses from the service, select the results in the History section of 

the generic service client to generate a test. If you do not have access to a dedicated client for the service 

calls, the generic service client is the easiest way to generate the calls and to record a test.

If you are testing a SOAP-based web service, ensure that you have access to a valid Web Services 

Description Language (WSDL) file. The wizard can import WSDL files from the workspace, the file 

system, a remote repository, or from a URL. Ensure that the WSDL files use the correct syntax for the test 

environment. The generic service client might not work with some WSDL files.

If you are using Secure Sockets Layer (SSL) authentication, ensure that you have the required key files in 

your workspace.

If you are using SOAP security, ensure that you have configured the environment with the correct libraries 

and configuration files. See Configuring the environment for SOAP security  on page  for more 

information.

If the response in a recording or test generation is in XML and the size of the XML data is higher than the 

value set in the XML Message Received maximum length  field, the response is automatically converted 

to text to avoid any memory issues. To convert the full response to text, the tool checks the value set 

for Text Message Received maximum length. If the value is lesser than the size of the response, the 

response is truncated. If you want the response to be in XML when the response size exceeds the value 

set in XML Message Received maximum length, you can manually increase the value for both recording 

and test generation. To change the value for recording, click Window  > Preferences  > Generic Service 

Client  > Message Edition. To change the value for test generation, click Window  > Preferences  > Test  > 

Test Generation  > Service Test Generation.

You can record and generate a test by using REST APIs. The API documentation to 

record a test is located at Install_directory\IBM\IBMIMShared\plugins

\com.ibm.rational.test.lt.server.recorder.jar. The API documentation to generate a 

test after the recording completes is located at C:\Program Files\IBM\IBMIMShared\plugins

\com.ibm.rational.test.lt.server.testgen.jar.
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To use a WS-SecurityPolicy that is included in a WSDL or an external XML file, you need to configure the 

security policy as described in Using a security policy  on page . If a recording contains the Security 

Assertion Markup Language (SAML) token, the WS Security policy file must rely on the Service Token 

Service (STS) that produces the token. This token can then be used for encryption or other purposes as 

was designed.

Sample policy file that relies on SAML token:

<sp:SupportingTokens xmlns:sp="http://schemas.xmlsoap.org/ws/2005/07/securitypolicy">

<wsp:Policy>

<sp:IssuedToken sp:IncludeToken="http://schemas.xmlsoap.org/ws/2005/07/securitypolicy/IncludeToken/AlwaysToRecipient">

<sp:Issuer>

<Address xmlns="http://www.w3.org/2005/08/addressing">http://9.143.105.204:8080/axis2/services/STS</Address>

</sp:Issuer>

<sp:RequestSecurityTokenTemplate>

<t:TokenType 

 xmlns:t="http://schemas.xmlsoap.org/ws/2005/02/trust">http://docs.oasis-open.org/wss/oasis-wss-saml-token-profile-1.1#

SAMLV2.0</t:TokenType>

<t:KeyType 

 xmlns:t="http://schemas.xmlsoap.org/ws/2005/02/trust">http://schemas.xmlsoap.org/ws/2005/02/trust/SymmetricKey</t:KeyT

ype>

<t:KeySize xmlns:t="http://schemas.xmlsoap.org/ws/2005/02/trust">256</t:KeySize>

</sp:RequestSecurityTokenTemplate>

<wsp:Policy>

<sp:RequireInternalReference/>

</wsp:Policy>

</sp:IssuedToken>

</wsp:Policy>

</sp:SupportingTokens>

1. In the Performance Test perspective, click the New Test from Recording  toolbar button  or click 

File  > New  > Test from Recording.

2. In the New Test from Recording  wizard, click Create a test from a new recording, select Service 

Test, and click Next.

If you are recording sensitive data, you can select a Recording encryption level.

3. On the Select Location  page, select the project and folder where you want to create the test, type a 

name for the test, and click Next.

If necessary, click Create Parent Folder   to create a project or folder

4. On the Select Location  page, select Generic Service Client. 
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This option uses the generic service client if you do not have access to a dedicated client for the 

service calls. See Recording a service test through a client program  on page 89 for information 

about using other client programs to record the test.

5. Click Next. If this is the first time you are recording a web service test, read the Privacy Warning, 

select Accept, and click Finish  to proceed.

The generic service client opens.

6. If your service uses a transport or authentication protocol that requires overriding the default 

settings, then click the Transport  tab and create an HTTP, Java™  Message Service (JMS), IBM® 

WebSphere®  MQ, IBM®  WebSphere®  Java MQ, or Java MQ transport.

7. Click the Requests  tab.

• Right-click WSDLs   and select one of the options to get the WSDL file.

• Right-click WADLs   and select one of the options to get the WADL file.

• Right-click Endpoints   and select one of the options to send the request.

See Sending service requests with the generic service client  on page 431 for more information 

about using the generic service client.

8. After creating the call, click the Edit Data  arrow to change the details of the call if necessary.

9. Click the Invoke  arrow to invoke the service call.

If the call was successful, the response is displayed under the View Response  arrow.

10. To record a test with multiple calls, repeat steps 6 through 9.

11. When you have finished sending service requests, stop the recorder. You can do this by closing the 

generic service client or by clicking the Stop  push button  in the Recorder Control  view.

If you changed the network settings of the client program as described in step 8, you can revert to 

the default settings before closing the program.

The Generate Service Test  wizard opens.

12. Click Finish.

Alternatively, you can use the generic service client to create, edit, and invoke the calls without recording. 

Successful responses are added to the Request History  list. You can select calls in the Request History 

list, and click the Generate Test Suite  icon .

Related information

Service testing guidelines  on page81

Verifying WSDL syntax compliance for JMS services  on page84

Recording a service test through a client program  on page89

Preparing to record a test for the HTTP/2 service  on page94
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Creating a service test from a BPEL model  on page102

Creating a service test manually  on page104

Creating a service test for WebSphere MQ  on page105

Creating a service test for WebSphere Java MQ  on page107

Creating a service test for a plain XML call  on page110

Changing service test generation preferences  on page111

Sending service requests with the generic service client  on page431

Recording a service test through a client program  on page89

Recording sensitive session data  on page141

Sending service requests with WSDL files  on page448

Recording a service test through a client program
You can record tests for SOAP-based, XML, plain text, or binary services with any client program that 

uses the HTTP protocol. To record the test, the recorder intercepts the service calls and message returns 

between the client and the service. You can choose between an HTTP or SOCKS proxy recorder or a low-

level socket recorder, depending on the capabilities of the client program.

The following recorders are available for recording traffic from an application:

• SOCKS proxy recorder: Use this recorder when no proxy connections are required.

• HTTP proxy recorder: Use this recorder when a proxy connections is required to connect to the 

network or when the client program does not support SOCKS.

• Socket recorder: Use this recorder for low-level network traffic when the client does not support 

proxies. This recorder does not support SSL authentication or encryption of any kind and is only 

available if the IBM®  Rational®  Performance Tester  Extension for Socket Protocols  is installed.

Regardless of the recorder that you use, the client program must use the HTTP network protocol. For 

recording Java™  Message Service (JMS) or IBM®  WebSphere®  MQ tests, see Recording a service test 

with the generic service client  on page 86.

If you are using Secure Sockets Layer (SSL), the HTTP or SOCKS proxy can cause authentication 

problems because the proxy recorder relays traffic between the client and the server. Depending on the 

authentication method in place, the client might require that the proxy recorder authenticate itself as 

the server and the server might require that the proxy recorder authenticate as the client. If the client 
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program requires an authenticated server, you must either have access to the server certificate keystore 

and provide it to the proxy recorder or configure the client to accept the default certificate from the proxy 

recorder instead of the certificate from the actual server.

If you are testing a SOAP-based web service, ensure that you have access to a valid Web Services 

Description Language (WSDL) file. The wizard can import WSDL files from the workspace, the file 

system, a remote repository, or from a URL. Ensure that the WSDL files use the correct syntax for the test 

environment. The generic service client might not work with some WSDL files.

If you are using SOAP security, ensure that you have configured the environment with the correct libraries 

and configuration files. See Configuring the environment for SOAP security  on page  for more 

information.

To record a service test with a client program:

1. In the Performance Test perspective, click the New Test from Recording  toolbar button  or click 

File  > New  > Test from Recording.

2. In the New Test from Recording  wizard, click Create a test from a new recording, select Service 

Test, and click Next.

If you are recording sensitive data, you can select a Recording encryption level.

3. On the Select Location  page, select the project and folder to create the test in, type a name for the 

test, and click Next.

If necessary, click Create Parent Folder   to create a project or folder

4. On the Select Client Application  page, select the type of client program to use.

The program type defines the recorder that can be used. The following client program types are 

supported for recording a service test:

• Managed Application: This option starts a specified program and uses a proxy or socket 

recorder to record the traffic.

On the Managed Application Options  page, click Browse  to specify the Program path. If 

necessary, specify the Working directory, and type the command line Arguments  that the 

program requires.

If the program requires user input from a command-line interface, select Open console for 

user input.

• Choose a web browser to record traffic that is sent and received with the web browser.
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• Unmanaged Application: This option enables you to record traffic from one or multiple 

client programs that use a proxy. You must manually start the client programs and the proxy 

recorder records all traffic that is sent and received through the specified network port.

• Generic Service Client: This option uses the generic service client if you do not have access 

to a dedicated client for the service calls. See Recording a service test with the generic 

service client  on page 86 for using the generic service client to record service tests.

5. On the Recorder Settings  page, depending on the type of client program you selected, specify 

these details:

a. If you selected Managed Application, specify the recording method.

• Select Record traffic with the proxy recorder  to record HTTP or SOCKS traffic through 

a proxy.

• Select Record traffic with the socket recorder  to record low-level network traffic 

for applications where a proxy cannot be used. This recorder does not support SSL 

authentication or encryption.

Note:  When using proxy recording, you can filter out HTTP or HTTPS requests to a 

specific endpoints so that any requests to those endpoints are not recorded. See Proxy 

recording preferences  on page

b. If you selected Record traffic with the proxy recorder, specify whether the proxy recorder 

uses HTTP or SOCKS. Select HTTP  if a connection to proxy is required or if your application 

does not support SOCKS.

c. If you are using SSL authentication, specify the authentication settings for the proxy 

recorder.

During the recording, the proxy recorder is between the client and the server.

• If the server requires client SSL authentication, provide the client certificate for the 

proxy recorder to be authenticated by the server as though the proxy recorder were 

the client. Select The server requires a specific client certificate.

To provide single certificate keystore, specify the file name and password of the 

server certificate keystore. If multiple certificates are required, click Multiple 

certificates, and click Add  to specify a certificate keystore file name and password 

for each host name and port.

• To record a secured site using Internet Explorer or Google Chrome on Windows, 

install the recorder certificate by selecting Register the recorder root certificate 

authority. Before the recording starts, the browser prompts you to install the 

certificate. After the recording is stopped, the browser prompts you to uninstall the 
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certificate. To avoid multiple prompts for each recording, select Keep the recorder 

root certificate authority after recording.

Note:  If you already had the certificate from a version prior to 9.2.1 and then 

install the latest version of the product, you might have to install the certificate again.

This option is not available when you record by using the Firefox or Safari 

browser. To record a secured site on these browsers, manually import the 

certificate in the browser from the default location C:\Program Files 

(x86)\__VENDOR_NAME__\__VENDOR_NAME__IMShared\plugins

\com.ibm.rational.test.lt.recorder.proxy_version\SSLCertificate. 

For information about how to import the certificates, see the browser's 

documentation.

• If the client requires server authentication, you must provide the server certificate 

keystore for the proxy recorder to be authenticated by the client as though the proxy 

recorder were the server. Select The client requires a specific server certificate, and 

click Add  to specify a certificate keystore filename and password for each hostname 

and port. If you do not select this option, the proxy recorder provides its own default 

certificate.

Note:  The keystore must contain the private certificate of the server.

d. If you selected to use the HTTP proxy recorder, specify how to connect to the network. If 

necessary, specify an HTTP or SOCKS proxy or point to a proxy auto-configuration (PAC) file.

Use this option if you are connecting to the service through a corporate proxy or firewall.

6. Click Next. If this is the first time you record a service test and you did not select a web browser for 

the client application, read the Privacy Warning, select Accept, and click Finish  to proceed.

7. If you selected a proxy recorder with a managed or unmanaged application, change the network 

settings of the client program to use the proxy recorder.

The method for changing the network settings depends on the client program. However, you must 

be able to set the following proxy settings in the program:

• SOCKS or HTTP proxy: Specify the protocol that you selected for the proxy recorder in the 

wizard.

• Host name: Set to localhost.

• Port: Specify the port number that you selected for the proxy recorder in the wizard.

To avoid unexpected results, revert to the previous proxy settings before you stop the recording.

8. Use the client program to perform the actions to test.

You can use the Recorder Test Annotations  toolbar to add comments, record synchronizations, or 

take screen captures during the recording.
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• To add a comment to the recorded test, click the  Insert comment  icon .

• To add a screen capture to the recorded test, click the  Capture screen  icon . Screen and 

window captures make your tests easier to read and help you visualize the recorded test. 

You can change the settings for screen captures and add a comment to the image.

• To manually add a synchronization point to the recording, click the  Insert synchronization 

icon .

• To manually add a transaction folder to the recording, click the  Start Transaction  icon 

and  Stop Transaction   icon to start and stop the transaction.

• To insert a split point into the recorded test, click the  Split point  icon . With split points, 

you can generate multiple tests from a single recording, which you can replay in a different 

order with a schedule.

9. After you finish the user tasks in the client program, stop the recorder. You can do this by closing 

the client program or by clicking the button Stop  in the Recorder Control  view.

If you changed the network settings of the client program as described in step 8, you can revert to 

the default settings before closing the program.

The Generate Service Test  wizard opens.

10. If you inserted a split point during the recording, on the Destination  page, specify the location for 

the split test or merge the split recordings together.

See Splitting an HTTP test during recording  on page 23 for more information about splitting 

tests.

11. On the Service Test Generation Options  page, if you are testing a SOAP-based web service, specify 

a Web Services Description Language (WSDL) file from the workspace or click Add  to import a 

WSDL or to link to a remote WSDL file and click Next.

12. Select the domains to include in the test and click Finish. The domains that are not selected are 

not included in the test. You can add them back by generating the test again from the recording.

To include all the domains for all of the recordings, click the Select all and remember my decision 

check box. To enable the filter again for HTTP tests, click Window  > Preferences  > Test  > Test 

Generation  > HTTP Test Generation, and, for Service tests, click Service Test Generation  and then 

click the Enable domain review before test generation  check box.

13. Click Finish.

A progress window opens while the test is generated. On completion, the Recorder Control  view displays 

the Test generation completed  message, the test navigator lists your test, and the test opens in the test 

editor.
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Related information

Service testing guidelines  on page81

Verifying WSDL syntax compliance for JMS services  on page84

Recording a service test with the generic service client  on page86

Preparing to record a test for the HTTP/2 service  on page94

Creating a service test from a BPEL model  on page102

Creating a service test manually  on page104

Creating a service test for WebSphere MQ  on page105

Creating a service test for WebSphere Java MQ  on page107

Creating a service test for a plain XML call  on page110

Changing service test generation preferences  on page111

Recording a service test with the generic service client  on page86

Sending service requests with the generic service client  on page431

Recording sensitive session data  on page141

Sending service requests with WSDL files  on page448

Preparing to record a test for the HTTP/2 service
To test a web service that is based on the HTTP/2 protocol, record a test by using the SOA extension of 

Rational®  Performance Tester. Before recording the HTTP/2 service, follow the procedure in this topic to 

configure your computer.

This configuration is required because this feature is released as Beta and is intended for use in a non-

production environment only.

Use Mozilla Firefox or Google Chrome when recording on servers that support the HTTP/2 service.

1. Download the following Application Layer Protocol Negotiation (ALPN) boot jar file https://

mvnrepository.com/artifact/org.mortbay.jetty.alpn/alpn-boot/8.1.8.v20160420

2. Create or rename the productInstallDir\jdk  folder to ..\jdk.ibm. You can rename the 

folder back to jdk  later to test with the IBM JDK.

3. Download Oracle Java 1.8.0u92 from http://www.oracle.com/technetwork/java/javase/

downloads/jdk8-downloads-2133151.html. You can then either extract the compressed file or 

install Java at productInstallDir\jdk.

https://mvnrepository.com/artifact/org.mortbay.jetty.alpn/alpn-boot/8.1.8.v20160420
https://mvnrepository.com/artifact/org.mortbay.jetty.alpn/alpn-boot/8.1.8.v20160420
http://www.oracle.com/technetwork/java/javase/downloads/jdk8-downloads-2133151.html
http://www.oracle.com/technetwork/java/javase/downloads/jdk8-downloads-2133151.html
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4. Copy the ALPN jar file to productInstallDir\majordomo\lib.

5. From productInstallDir, open eclipse.ini  and add the following flags:

-Xbootclasspath/p:<productInstallDir>\majordomo\lib\alpn-boot-8.1.8.v20160420.jar

Note:  If there are any other flags starting with -X, delete those flags.

6. Configure Rational®  Performance Tester  Agent to use Oracle Java.

a. Stop the Majordomo process.

On Windows systems, run the following command: cd “c:\program files\ibm\sdp

\majordomo”  ngastop

On Linux systems, run the following command: cd /opt/IBM/SDP/Majordomo ./MDStop.sh

b. Set the environment variable RPT_JAVA  to the Oracle Java binary or executable file.

On Windows systems, run the following command: set RPT_JAVA=c:\program files\java

\jdk1.8.0_92\bin\java.exe

On Linux systems, run the following command: export RPT_JAVA=/root/jdk1.8.0_92/jre/

bin/java

c. Start the Majordomo process.

7. When you record a service by using a web browser against an HTTP/2 client, the HTTP/2 traffic 

is automatically captured. But, to record an HTTP/2 service by using the GSC client, in the HTTP 

transport protocol configuration dialog box, you must select the Activate  check box.
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8. Specify the following configuration options for HTTP/2:

HTTP/2

Note:  Testing HTTP/2 service is in the Beta mode. For more information, see 

Preparing to record a HTTP/2 service  on page 94.

To test a service that uses the HTTP/2 protocol, select the Activate  check box. This 

check box is automatically selected when you record a service by using a browser. If 

you use the Generic Service Client component to create a HTTP/2 test, you have to 

manually select the check box.
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HTTP/2 client connection timeout

Specifies the time limit for the HTTP/2 client to connect to the HTTP/2 server.

Time out for the HTTP/2 session creations

Specifies the time limit to create the HTTP/2 session. This time starts after the 

connection is established.

Enable HTTP/2 Push

The Push functionality of HTTP/2 automatically identifies and passes the related 

objects or requests to the client when a request is sent to the server. Clear the check 

box to not use the functionality.

Initial session window

Specifies the buffer size on the sessions.

Initial stream window

Specifies the window size for buffer on each stream after the connection is 

established.

HTTP/2 Client Input Buffer Size

Specifies the buffer size that is used to read the network traffic.

Maximum Quantity of Messages that can be queued

Specifies the maximum number of messages that can be queued for the HTTP/2 

client on a thread.

Maximum Quantity of HTTP/2 thread pool

Specifies the maximum number of thread pools that will be used by the HTTP/2 

client to distribute the workload.

Minimum Quantity of HTTP/2 thread pool

Specifies the minimum number of thread pools that will be used by the HTTP/2 client 

to distribute the workload.

HTTP/2 client bytebuffer pool size

Specifies the buffer size to receive the unciphered values.

Server Name Indication

Note:  Not applicable for HTTP/2.
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Clear this check box if you do not want to connect to the host computer by using 

the Server Name Indication protocol. If the host computer is already configured with 

Server Name Indication protocol, you should keep this check box selected.

Use HTTP Keep Alive

Select this option to keep the HTTP connection open after the request. This option is 

not available if you are using IBM®  Rational®  AppScan®.

Use SSL

Select this option to use an SSL configuration. Click Configure SSL  to create an SSL 

configuration or select an existing configuration.

Platform Authentication

In this section, specify the type of authentication that is required to access the 

service. Select None  if no authentication is required.

Basic HTTP authentication

Select this option to specify the User Name  and Password  that are used 

for basic authentication.

NTLM authentication

Note:  Not applicable for HTTP/2.

Select this option to use the Microsoft™  NT LAN Manager (NTLM) 

authentication protocol. NTLM uses challenge-response authentication. 

This view lists what is negotiated (supported by the client and 

requested of the server) and what is authenticated (the client reply to 

the challenge from the server).

Kerberos authentication

Note:  Not applicable for HTTP/2.

Select this option to use the Kerberos authentication protocol between 

the client and server.

Connect through proxy server

Note:  Not applicable for HTTP/2.
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If the HTTP connection needs to go through a proxy server or a corporate firewall, 

specify the Address  and Port  of the proxy server. If the proxy requires authentication, 

select either Basic proxy authentication  or NTLM proxy authentication.

Proxy authentication

In this section, specify the type of authentication that is required to 

access the proxy. Select None  if no authentication is required.

Basic proxy authentication

Select this option to specify the User Name  and Password 

that are used for basic authentication.

NTLM proxy authentication

Select this option to use the Microsoft™  NT LAN 

Manager (NTLM) authentication protocol. NTLM uses 

challenge-response authentication. This view lists what is 

negotiated (supported by the client and requested of the 

server) and what is authenticated (the client reply to the 

challenge from the server).

Custom class

Note:  Not applicable for HTTP/2.

Select this option if the communication protocol requires complex, low-level 

processing with a custom Java™  code to transform incoming or outgoing messages. 

Click Browse  to select a Java™  class that uses the corresponding API. This option is 

not available in IBM®  Security AppScan®.

9. Click OK. You have configured the workbench to test an HTTP/2 service.

You can now record a regular SOA test for the HTTP/2 service. After the recording, in the Version field of 

request details, the requests are marked with HTTP/2 indicating that the HTTP/2 traffic is captured. If the 

test playback fails, check if all the steps are correctly followed.

Related information

Service testing guidelines  on page81

Verifying WSDL syntax compliance for JMS services  on page84

Recording a service test with the generic service client  on page86
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Recording a service test through a client program  on page89

Creating a service test from a BPEL model  on page102

Creating a service test manually  on page104

Creating a service test for WebSphere MQ  on page105

Creating a service test for WebSphere Java MQ  on page107

Creating a service test for a plain XML call  on page110

Changing service test generation preferences  on page111

Optimizing HTTP/2 tests for SOA
HTTP/2 tests require a lot of CPU and memory resources. When you apply load on HTTP/2 tests using 

computers that do not have enough resources, the tests might fail. You might want to configure or tune 

the computers that run HTTP/2 tests.

CPU Usage
Ensure that the HTTP/2 tests get adequate CPU resources to run. If there are other processes running on 

the computer and they are not required, you can stop them. For example, the CPU usage statistic in the 

image below indicates that the other processes (shown in red) on the computer are consuming a lot of 

resources whereas the test execution process (shown in green) is getting less resources.

Memory usage and garbage collection

Ensure that enough memory is available for the test execution. You can configure the garbage collector 

and adjust the memory heap size.

Garbage Collection - Consider using the following values so that the garbage collector does not allocate 

large amount of temporary memory. By doing so, you are tuning the number of threads allocated for the 

garbage collector according to the capability of the computer. You apply the values for each location 

asset of the schedule.

RPT_VMARGS
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-XX:MaxGCPauseMillis=250 -XX:ParallelGCThreads=6 -XX:ConcGCThreads=3 

-XX:GCTimeRatio=19

Memory heap - Consider using the following values for memory heap:

RPT_VMARGS

-Xms11024m

RPT_DEFAULT_MEMORY

22412m

Thread Usage

Ensure that you start load testing with fewer virtual testers and gradually ramp up the workload. This 

practice helps in observing the changes in the workload, that is, the number of calls per second. In 

the graph, when the number of calls per second is flat, it indicates that the maximum capacity of the 

computer is reached and there is no need to add more virtual testers.
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Platform tuning

Configure the TCP/Socket capabilities of your system by following these two links:

https://wiki.eclipse.org/Jetty/Howto/High_Load

https://msdn.microsoft.com/en-us/library/aa560610%28v=bts.20%29.aspx

Creating a service test from a BPEL model
You can use Business Process Execution Language (BPEL) resources from your workspace to 

automatically generate a set of service tests that corresponds to the paths that are run in a synchronous 

BPEL model.

Tests are stored in test projects. If your workspace does not contain a test project, the test creation 

wizard creates one, enabling you to change its name. To store a test in a specific project, verify that the 

project exists before you record the test.

If you are using Secure Sockets Layer (SSL) authentication, ensure that you have any required key files in 

your workspace.

If you are using Java™  Message Service (JMS), ensure that you have configured the environment with 

the correct libraries and configuration files. Ensure that the WSDL files use the correct syntax for the test 

environment.

If you are using SOAP security, ensure that you have configured the environment with the correct libraries 

and configuration files.

BPEL models must be synchronous. Asynchronous BPEL models are not supported.

Ensure that the BPEL models refer to the WSDL files in a valid import statement, for example:

<bpws:import importType="http://www.w3.org/2001/XMLSchema" location="foo.wsdl" namespace="http://foo"/> 

Relative file paths, such as: "../../foo.wsdl" are not supported.

Ensure that you have one or more valid Web Services Description Language (WSDL) files and the 

associated BPEL model in your workspace. Only the calls to services with a valid web service binding 

are taken into account. For example, if the BPEL model was produced in IBM®  Websphere Integration 

Developer, then services must be exported with the following web service bindings:

<bpws:invoke name="myOperation" operation="myOperation" partnerLink="IServicePartner" portType="ns3:IService" 

 wpc:displayName="myOperation" wpc:id="20">

Only BPEL invoke  activities are considered for generating tests. Any BPEL receive  and reply  activities are 

ignored.

https://wiki.eclipse.org/Jetty/Howto/High_Load
https://msdn.microsoft.com/en-us/library/aa560610%28v=bts.20%29.aspx


Chapter 1. Test Author Guide

Websphere Integration Developer does not generate the required soapAction  attributes for the soap 

operations in the WSDL files. Please edit the generated WSDL files, as follows for every operation: 

<soap:operation soapAction=""/>.

To create a service test from a BPEL model:

1. In the Performance Test perspective, click File  > New  > Other  > Test  > Test Assets  > BPEL to Web 

service test, and then click Next.

2. Click Browse  to select a BPEL file from the workspace, and click Next.

3. On the Web service test generation  page, change the number of paths by specifying how activities 

and sequences from the flow of the BPEL model are processed. Each path generates one test.

a. In the Flow  section, select how any concurrent sequences that are found in the flow will be 

converted into paths.

b. In the Switch  section, select whether to test otherwise  activities from the flow.

c. In the Throw  section, select how throw  activities from the flow are converted into paths.

d. In the Invoke  section, select whether to test inline catches inside invoke  activities from the 

flow.

e. Select Enable data correlation in generated tests  to automatically create references in the 

generated test elements by propagating variables to the parameters of the web service call 

and message return elements.

4. Click Recount paths  to update the number of paths to test, and click Next.

One test is generated for each path.

5. For WSDL operations that are bound to multiple ports, you must select one port that is to be used 

for the test.

Under each test that will be generated, the Operations  list displays the WSDL operations that are 

bound to multiple ports.

If no WSDL operations are displayed under the tests, this means that all operations are bound to a 

single port. In this case, skip step 6.

a. In the Operations  list, expand a test and select a WSDL operation that requires binding.

b. In the Binding ports  list, select the port that you want to use to test the selected WSDL 

operation.

c. Repeat steps a and b for each WSDL operation that requires binding.

6. Click Next.

7. Select a location and a name for the new folder where the tests generated from the BPEL model 

are created, and click Finish.

103



Test Author Guide

104

A new folder is created in the Test Navigator containing the generated service tests. These tests are 

generated with default message content and must be edited with valid input values.

Related information

Service testing guidelines  on page81

Verifying WSDL syntax compliance for JMS services  on page84

Recording a service test with the generic service client  on page86

Recording a service test through a client program  on page89

Preparing to record a test for the HTTP/2 service  on page94

Creating a service test manually  on page104

Creating a service test for WebSphere MQ  on page105

Creating a service test for WebSphere Java MQ  on page107

Creating a service test for a plain XML call  on page110

Changing service test generation preferences  on page111

Creating a service test manually
You can create a service test without recording by simply adding the test elements as required and 

manually editing the test element details in the test editor.

Tests are stored in test projects, which are test projects that include a source folder. You must create a 

test project before creating a test.

Ensure that you have a valid WSDL file in your workspace. Ensure that the WSDL files use the proper 

syntax for the test environment.

If you are using Secure Sockets Layer (SSL) authentication, ensure that you have any required key files in 

your workspace.

If you are using SOAP security, ensure that you have configured the environment with the proper libraries 

and configuration files.

1. In the workbench, click File  > New  > Other  > Test  > Test Assets  > Web service test  or click the New 

Service Test   toolbar button.

2. Select a project and, in Name, type a name for the test, and then, click Next.
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The name that you type is the base name for the recording, test, and other required files. You see 

these files in standard Navigator or the Java™  Package Explorer with their distinguishing suffixes, 

but you see only the simple (test) name in the Test Navigator.

3. Select a web service request to create the test for.

If you select Web service request  or one of the options in Specification-based structure, specify a 

WSDL port and then configuration properties for the HTTP protocol. If you select, XML request  and 

Text request, specify the configuration properties for the HTTP, JMS, WebSphere MQ, WebSphere 

Java MQ, and Microsoft.Net protocols.

For information about the configuration properties of each protocol, see the topics in Sending 

service requests with the generic service client  on page .

4. Click Finish. The service test is created.

Related information

Service testing guidelines  on page81

Verifying WSDL syntax compliance for JMS services  on page84

Recording a service test with the generic service client  on page86

Recording a service test through a client program  on page89

Preparing to record a test for the HTTP/2 service  on page94

Creating a service test from a BPEL model  on page102

Creating a service test for WebSphere MQ  on page105

Creating a service test for WebSphere Java MQ  on page107

Creating a service test for a plain XML call  on page110

Changing service test generation preferences  on page111

Creating a service test for WebSphere®  MQ
You can create an IBM®  WebSphere®  MQ test by adding the test elements as required and editing the 

test element details in the test editor.

Tests are stored in test projects, which are Java™  projects that include a source folder. You must create a 

test project before creating a test.

Ensure that you have a valid Web Services Description Language (WSDL) file for a WebSphere®  MQ 

service in your workspace.
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If you are using Secure Sockets Layer (SSL) authentication, ensure that you have any required key files in 

your workspace.

If you are using SOAP security, ensure that you have configured the environment with the correct libraries 

and configuration files.

1. In the workbench, click File  > New  > Other  > Test  > Test Assets  > Web service test  or click the New 

Service Test   toolbar button.

2. Select a project, and then, in Test file name, type a name for the test and click Next.

The name that you type is the base name for the recording, test, and other required files. You 

see these files in the standard Navigator or the Java™  Package Explorer with their distinguishing 

suffixes, but you see only the simple (test) name in the Test Navigator.

3. In the Select a service request interface  page, complete one of the following steps:

a. To test a service that use a WSDL file, select Web service request  or Specification-based 

structure, click Next, and select a WSDL file.

b. To test a service that does not use a WSDL file, select XML Request, Text Request, Binary 

Request  or an Empty test.

4. Click Next  and select the WebSphere MQ  protocol.

5. In SOAP Action, specify the SOAP action to be used to invoke the MQ request.

6. To override the message header and descriptor that was specified in WebSphere MQ transport 

configuration, click Override MQ Protocol Configuration values  and specify the customize header 

and message descriptor.

7. Click Finish. The service test is created.

8. On the web service call, click Update Response.

This opens the Response Preview  window, displaying the data that will be used to perform the call.

9. Click Update Test.

This action calls the web service and creates a message return element with the return data. If a 

message return element already exists, then it is updated with latest return data. With the message 

return test element, you can implement data correlation and content-based verification points.

Related information

Service testing guidelines  on page81

Verifying WSDL syntax compliance for JMS services  on page84

Recording a service test with the generic service client  on page86

Recording a service test through a client program  on page89

Preparing to record a test for the HTTP/2 service  on page94
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Creating a service test from a BPEL model  on page102

Creating a service test manually  on page104

Creating a service test for WebSphere Java MQ  on page107

Creating a service test for a plain XML call  on page110

Changing service test generation preferences  on page111

Creating a service test for WebSphere Java MQ
To test Java-based applications, create a service test and add the WebSphere Java MQ messages. You 

can create a service test by using Generic Service Client option  or the New Service Test wizard .

Connect to a WebSphere MQ server.

If you are using Secure Sockets Layer (SSL) authentication, ensure that you have any required key files in 

your workspace.

If you are using SOAP security, ensure that you have configured the environment with the correct libraries 

and configuration files.

1. In the workbench, click File  > New  > Other  > Test  > Test Assets  > Web Service Test  or click Create 

a Service Test  .

2. Select a project, and then, in Test file name, type a name for the test.

The name that you type is the base name for the recording, test, and other required files. You 

see these files in the standard Navigator or the Java™  Package Explorer with their distinguishing 

suffixes, but you see only the simple test name in the Test Navigator.

3. In the Select a service request interface  page, complete one of the following steps:

a. To test a service that use a WSDL file, select Web service request  or Specification-based 

structure, click Next, and select a WSDL file.

b. To test a service that does not use a WSDL file, select XML Request, Text Request, Binary 

Request  or an Empty test.

4. Click Next, select the WebSphere Java MQ  protocol, and specify a transport configuration. If 

necessary, click New  to create the transport configuration for the call. See Creating a WebSphere 

Java MQ transport configuration  on page 442.

5. Complete the following information in the General  tab:

Learn more about the UI elements in the General tab:

Queue

Name of the queue as defined on the WebSphere MQ server.

107



Test Author Guide

108

Message type

The types of messages are these:

• Datagram  means that the message does not require a reply.

• Request  means that the message requires a reply.

• Reply  means that the message is a reply to an earlier request message.

• Report  means that the message is reporting on some expected or unexpected 

occurrence, usually related to some other message. An example is a request 

message that contained data that was not valid.

Message Persistence

This value indicates whether the message is persistent or not. If the message is 

persistent, it survives the system failures and restarts of the queue manager. If the 

message is not persistent, it survives a restart if it is present on a queue having the 

NPMCLASS(HIGH) attribute. However, even with the NPMCLASS(HIGH) attribute a 

message does not survive a QMGR class. Nonpersistent messages on queues having 

the NPMCLASS(NORMAL) attribute are discarded at queue manager restart, even if 

the message is found on the auxiliary storage during the restart procedure.

Dynamic Reply

Select this check box for the WebSphere MQ server to dynamically create a 

temporary queue as a reply. If this check box is not selected, the message in Reply 

Queue is used.

Reply Queue

This is the name of the message queue to which the application that issued the get 

request for the message should send the reply and report messages.

Reply Manager

This is the name of the queue manager on which the reply-to queue is defined.

Additional properties

Specify the additional properties for the queues.

6. Optional:  If necessary, complete the following information on the Config  tab:

Learn more about the UI elements in the Config tab:

Message Priority

This is the priority of the message. The lowest priority is 0.

Encoding
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This is the numeric encoding of numeric data in the message. This value does not 

apply to numeric data in the MQMD structure itself.

Expiry Interval

This is the period of time, in tenths of a second, after which the message becomes 

eligible to be discarded if it has not already been removed from the target queue. The 

expiry interval is set by the application that put the message.

Character set

This is the character set identifier of the character data in the application message 

data.

7. Optional:  In the Report  tab, select the report messages to receive.

8. Optional:  If necessary, complete the following information in the Context  tab:

Learn more about the UI elements in the Context tab:

Application Identity Data

This information is defined by the application suite. Use it to provide information 

about the message or its originator.

Application Origin Data

This information is defined by the application suite. Use it to provide additional 

information about the origin of the message.

Accounting Token

This information is needed by the application to appropriately charge for the work 

that is done as a result of the message.

User ID

This is the user identifier of the application that originated the message.

9. Optional:  In the Identifiers  tab, for the messages that require binary input, specify the ID in the 

string format in the second column. The first column is filled automatically in the hexadecimal 

format.

10. Optional:  In the Segmentation  tab, select the segment of the message and click Next.

11. If you had selected XML Request, click Next, select a XSD file and click Finish.

The new service test is created.

You can now enhance the test and run it.
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Related information

Service testing guidelines  on page81

Verifying WSDL syntax compliance for JMS services  on page84

Recording a service test with the generic service client  on page86

Recording a service test through a client program  on page89

Preparing to record a test for the HTTP/2 service  on page94

Creating a service test from a BPEL model  on page102

Creating a service test manually  on page104

Creating a service test for WebSphere MQ  on page105

Creating a service test for a plain XML call  on page110

Changing service test generation preferences  on page111

Creating a service test for a plain XML call
You can create a test for a plain XML call over HTTP, JMS, or IBM®  WebSphere®  MQ, by simply adding 

the test elements as required and editing the test element details in the test editor.

Tests are stored in test projects, which are Java™  projects that include a source folder. You must create a 

test project before creating a test.

If you are using Secure Sockets Layer (SSL) authentication, ensure that you have any required key files in 

your workspace.

If you are using SOAP security, ensure that you have configured the environment with the correct libraries 

and configuration files.

1. In the workbench, click File  > New  > Other  > Test  > Test Assets  > Service Test  or click the New 

Service Test   toolbar button.

2. Select a project, and then, in Test file name, type a name for the test and click Next.

The name that you type is the base name for the recording, test, and other required files. You 

see these files in the standard Navigator or the Java™  Package Explorer with their distinguishing 

suffixes, but you see only the simple (test) name in the Test Navigator.

3. On the Select Service Call Interface  page, select whether you want to create a test using a plain 

XML call  interface or a Web service call  interface.
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If you select web service call interface, select or add a WSDL file and then, select port to which the 

call will be binded. Click Next.

4. On the Configure Protocol  page, select either HTTP, JMS  or WebSphere®  MQ  as the protocol and 

then, specify the options for the selected Protocol configuration.

5. On the Select Root Element  page, you can select an XSD and then, select a root element for the 

call.

6. Click Finish.

Related information

Service testing guidelines  on page81

Verifying WSDL syntax compliance for JMS services  on page84

Recording a service test with the generic service client  on page86

Recording a service test through a client program  on page89

Preparing to record a test for the HTTP/2 service  on page94

Creating a service test from a BPEL model  on page102

Creating a service test manually  on page104

Creating a service test for WebSphere MQ  on page105

Creating a service test for WebSphere Java MQ  on page107

Changing service test generation preferences  on page111

Changing service test generation preferences
You can change default test generation values by changing the preference settings. The default settings, 

however, are appropriate for recording in most cases.

1. Click Window  > Preferences  > Test  > Web Services Test Generation

2. Select the setting to change.

Time out delay used for call

This is the default time out for web service calls. If the web service does not respond 

within this period, an error is produced.

Think time default value
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This is the default think time for generated tests.

3. After changing a setting, click Apply.

Related information

Service testing guidelines  on page81

Verifying WSDL syntax compliance for JMS services  on page84

Recording a service test with the generic service client  on page86

Recording a service test through a client program  on page89

Preparing to record a test for the HTTP/2 service  on page94

Creating a service test from a BPEL model  on page102

Creating a service test manually  on page104

Creating a service test for WebSphere MQ  on page105

Creating a service test for WebSphere Java MQ  on page107

Creating a service test for a plain XML call  on page110

Recording socket and TN3270 tests
When you record a test, the test creation wizard records your interactions with the application under test, 

generates a test from the recording, and opens the test for editing.

Socket performance testing guidelines
Before you can test the performance of TCP/IP socket-based applications, set up your test environment 

and incorporate these guidelines to produce reliable performance tests.

Limitations

You can use this extension to test applications that run in a client-server model, where the test simulates 

multiple clients that connect to one or several servers. Other models, such as peer-to-peer networks, are 

not supported.

IBM®  Rational®  Performance Tester  does not support socket recording in the 64 bit versions of 

Microsoft Windows 2003 and Windows XP. Also, you cannot record 64 bit applications on 64 bit Windows 

10 and Windows 2016 systems.
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Performance

When you deploy performance tests, use a relevant number of virtual users on a given computer is 

important. For example, if you deploy too many virtual users on a single computer, the results will reflect 

more the load of the test computer than the load of the server.

For best results with performance tests on an average test computer with a 1 GHz processor and 1 GB of 

RAM, do not exceed 1000 concurrent virtual users.

If you exceed the number of virtual users that a single test computer can run, the measured performance 

of the server will be affected by the performance of the test computer, which will invalidate the final 

results.

When editing a schedule for long performance tests, use these guidelines:

• In the schedule editor, reduce the Test log level  to None.

• In the schedule editor, set the Statistics sample interval  to approximately 1/60 of the run time, for 

example 12 minutes for an estimated 12-hour session.

• When possible, use loops inside test suites rather than loops in the schedule. Using loops inside 

test suites avoids connection problems that might occur over long duration tests and emphasizes 

measurement of the send and receive activity rather than connection and close activity.

SSL/TLS Authentication

Socket tests support simple or strong Secure Sockets Layer (SSL) or Transport Layer Security (TLS) 

authentication mechanisms, also called server authentication and client authentication.

For server authentication, the client must determine whether the server can be trusted. When you are 

recording or running a socket test with a proxy recorder, the proxy recorder sits between the server and 

the client. Therefore, you must "trick" the client application into behaving as though the proxy recorder is 

the certified server by performing either one of the following actions:

• Configure the SSL or TLS settings of the recorder proxy to authenticate itself as the actual server 

to the client and as the client to the service. This means that you must supply the recording proxy 

with the adequate certificates.

• Configure a managed client (an external client application) to accept the proxy recorder as though 

it were the certified server. The recording wizard provides a link to download and import an IBM® 

Rational®  Performance Testercertificate into the client application.

For client authentication, the server must authenticate the test client according to its root authority. 

Therefore, you must provide the client certificate that is expected by the server to authenticate the proxy 

recorder or the test agent as a certified client.
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See Digital certificates overview  on page 123 for more information about managing digital certificates.

TN3270 performance testing guidelines
Before you can test the performance of TN3270 terminal applications, set up your test environment and 

incorporate these guidelines to produce reliable performance tests.

Limitations

You can use this extension to test applications that run on a TN3270 terminal emulation client, where the 

test simulates multiple terminals that connect to one or several servers.

These TN3270 terminal emulation packages are supported:

• IBM®  Personal Communications

• Attachmate EXTRA! X-treme

• Managed Application

When you record a TN3270  session or a Managed Application  session by using the default options of the 

Socket I/O Recorder, the corresponding network traffic may not be captured. Therefore, an empty test is 

generated after the recording of the test is complete.

You should then select the Use MS-Detour for launching processes  option on the Socket I/O Recorder 

Secure Settings  page. The Socket I/O Recorder  then uses the Microsoft Detour library when attempting 

to capture the application’s network traffic when you record a test.

Performance

When deploying your performance tests, use a relevant number of virtual users on a given computer. For 

example, if you deploy too many virtual users on a single computer, the results reflect more the load of the 

test computer than the load of the server.

For best results with performance tests on an average test computer with a 1 GHz processor and 1 GB of 

RAM, do not exceed 1000 concurrent virtual users.

If you exceed the number of virtual users that a single test computer can run, the measured performance 

of the server is affected by the performance of the test computer, which invalidates the final results.

When editing a schedule for long performance tests, use these recommendations:
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• In the schedule editor, reduce the Test log level  setting to None.

• In the schedule editor, set the Statistics sample interval  value to approximately 1/60 of the run 

time, for example 12 minutes for an estimated 12-hour session.

• When possible, use loops inside test suites rather than loops in the schedule. Using loops inside 

test suites avoids connection problems that might occur over long-duration tests and emphasizes 

measurement of the send and receive activity rather than connection and close activity.

Recording a socket API performance test
You can record a socket API test from any client program on your computer. When you record, the 

recording wizard automatically starts the client program and records all the data that transits through the 

socket API.

Tests are stored in performance test projects. If your workspace does not contain a performance test 

project, the test creation wizard creates one with a name that you can change. To store a test in a specific 

project, verify that the project exists before you record the test.

Ensure that you have a working client program and that you can connect to the server.

Ensure that the session that you are recording is reproducible. This means that when the recorded actions 

are replayed by the test, the same responses from the server will be received.

IBM®  Rational®  Performance Tester  does not support socket recording in the 64 bit versions of 

Microsoft Windows 2003 and Windows XP. Also, you cannot record 64 bit applications on 64 bit Windows 

10 and Windows 2016 systems.

To record a socket test:

1. Open Rational®  Performance Tester.

2. Click the New Test from Recording  icon , and then click Socket Test.

Note:  You can also click File  > New  > Test From Recording, and then select Socket Test. You 

can then select the encryption level, if required and click Next  to open the Select Location  page.

The Select Location  page is displayed.

3. Create a test by performing the following steps:

a. Select a project, and then select a folder from the project.

b. Enter a name for the test.

c. Optionally, click Recording encryption level, and then select the encryption level when you 

are recording any sensitive data.
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4. Click Next.

The Select Client Application  page is displayed.

5. On the Select Client Application  page, select the type of client program to use to record the test:

• To specify any client program that is located on your computer, select Managed Application, 

and click Next.

The Managed Application Options  page is displayed.Specify the application to launch by 

performing the following action, and then click Next:

a. Click Browse  and specify the program path.

b. Click Browse  and specify the working directory, if required.

c. Specify the command-line arguments that the program requires in Arguments, if 

needed.

d. Select the Open console for user input  check box if the program requires user input 

from a command-line interface.

Specify the required secure options from the Socket I/O Recorder Secure Settings  page:

◦ Enable recording of SSL/TLS encrypted communication  to enable the recording of 

the SSL/TLS encrypted communication.

◦ Use MS-Detour for launching processes  to use the Microsoft Detour library when 

recording with the Socket I/O recorder.

• To record a TN3270 terminal emulation session, select IBM Personal Communication  or 

Attachmate EXTRA! X-treme  if these programs are installed, and click Next.

If required, specify a session file to start the TN3270 session.

Note:  Using this method to record a TN3270 session produces a low-level socket API 

performance test that is based on the TN3270 protocol traffic. To record a TN3270 test, see 

Recording a TN3270 performance test  on page 118.

• To record an HTTP session, select Microsoft Internet Explorer  or Mozilla Firefox, and click 

Next.

If you choose Mozilla Firefox, you can specify a Firefox profile.

Note:  Using this method to record an HTTP session produces a socket API 

performance test that is based on the HTTP traffic. To record an HTTP test, see Recording 

an HTTP test  on page 8.

6. If the application uses Secure Sockets Layer (SSL) and Transport Layer Security (TLS) 

authentication to authenticate the server or the client application, specify the following options, 

and click Next:
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• Select The server requires a specific client certificate  if you are using client authentication. 

Specify a certificate keystore file name and password. If multiple certificates are required, 

click Multiple certificates  and specify a certificate keystore file name and password for 

each host name and port.

• Select The client requires a specific server certificate  to provide the certificate keystore file 

name of the server and a password for each host name and port.

If you do not provide the server certificate, you must configure the client application to 

authenticate the certificate of the proxy recorder as though the proxy recorder were the 

actual server. Click Save this certificate  to save the certificate that is generated by IBM® 

Rational®  Performance Tester, and import the .cer  file into the client application.

If necessary, select whether to use SSL 3.0 and TLS 1.0 encryption. See Socket performance 

testing guidelines  on page 112 for more information about SSL and TLS authentication.

7. If this is the first time that you record a socket API performance test, read the Privacy Warning, and 

select Accept  to proceed.

8. Click Finish  to start recording.

A progress window opens while the client program starts.

9. Use the client program to perform the actions to test.

You can use the Recorder Test Annotations  toolbar to add comments, record synchronizations, or 

take screen captures during the recording.

• To add a comment to the recorded test, click the  Insert comment  icon .

• To add a screen capture to the recorded test, click the  Capture screen  icon . Screen and 

window captures make your tests easier to read and help you visualize the recorded test. 

You can change the settings for screen captures and add comments to images.

• To manually add a test synchronization to the recording, click the  Insert synchronization 

icon .

• To manually add a transaction folder to the recording, click the  Start Transaction  icon 

and  Stop Transaction  icon  to start and stop the transaction.

• To insert a split point into the recorded test, click the  Split point  icon . With split points, 

you can generate multiple tests from a single recording, which you can replay in a different 

order with a schedule. See Splitting a test during recording  on page  for more 

information about splitting a test.

10. When you have finished test actions in the program, stop the recorder. You can do this by closing 

the client program or by clicking the Stop  push button in the Recorder Control  view.

A progress window opens while the test is generated. On completion, the Recorder Control  view 

displays the Test generation completed  message, the Test Navigator lists your test, and the test 

opens in the test editor.
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Related information

Socket performance testing guidelines  on page112

Recording a TN3270 performance test  on page118

Recording sensitive session data  on page141

Recording an HTTP test  on page8

Recording service tests  on page81

Recording a TN3270 performance test
You can record a TN3270 test from a terminal emulation client. When you record, the recording wizard 

automatically starts the terminal emulation client and records all the screen and input activity that transits 

the socket connection.

Ensure that you have a TN3270 terminal emulation program installed on the local computer.

Tests are stored in performance test projects. If your workspace does not contain a performance test 

project, the test-creation wizard creates one with a name that you can change. To store a test in a specific 

project, verify that the project exists before you record the test.

Ensure that the session that you are recording is reproducible. This means that when the recorded actions 

are replayed by the test, the same responses from the server will be received.

To record a socket test:

1. Open Rational®  Performance Tester.

2. Click the New Test from Recording  icon , and then click TN3270 Test.

Note:  You can also click File  > New  > Test From Recording, and then select TN3270 Test. You 

can then select the encryption level, if required and click Next  to open the Select Location  page.

The Select Location  page is displayed.

3. Create a test by performing the following steps:

a. Select a project, and then select a folder from the project.

b. Enter a name for the test.

c. Optionally, click Recording encryption level, and then select the encryption level when you 

are recording any sensitive data.

4. Click Next.
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The Select Client Application  page is displayed.

5. On the Select Client Application  page, select any of the following type of client program to use to 

record the test, and then click Next:

• In most cases, select IBM Personal Communication  or Attachmate EXTRA! X-treme.

If required, specify a session file to start the TN3270 session.

• If you are using other TN3270 terminal emulation software, select Managed Application.

The Recording Method  page is displayed.

6. Select the required method from the Recording Method  page when you select Managed 

Application  in step 5  on page 119 for your recording.

• Proxy Recorder  method

Select Proxy Recorder  to record the HTTP activity of a client set up by using a proxy, and 

click Next.

The Managed Application Options  page is displayed.Specify the application to launch by 

performing the following action, and then click Next:

a. Click Browse  and specify the program path.

b. Click Browse  and specify the working directory, if required.

c. Specify the command-line arguments that the program requires in Arguments, if 

needed.

d. Select the Open console for user input  check box if the program requires user input 

from a command-line interface.

You can then specify the settings on the Proxy Recorder Settings  page.

• Socket I/O Recorder  method

Select Socket I/O Recorder  to record the client I/O operations, and then click Next.

The Managed Application Options  page is displayed.Specify the application to launch by 

performing the following action, and then click Next:

a. Click Browse  and specify the program path.

b. Click Browse  and specify the working directory, if required.

c. Specify the command-line arguments that the program requires in Arguments, if 

needed.

d. Select the Open console for user input  check box if the program requires user input 

from a command-line interface.

Specify the required secure options from the Socket I/O Recorder Secure Settings  page:
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◦ Enable recording of SSL/TLS encrypted communication  to enable the recording of 

the SSL/TLS encrypted communication.

◦ Use MS-Detour for launching processes  to use the Microsoft Detour library when 

recording with the Socket I/O recorder.

7. Click Finish  to start recording.

A progress window opens while the TN3270 terminal program starts.

8. Use the TN3270 terminal program to perform the actions to test.

You can use the Recorder Test Annotations  toolbar to add comments, record synchronizations, or 

take screen captures during the recording.

• To add a comment to the recorded test, click the  Insert comment  icon .

• To add a screen capture to the recorded test, click the icon  Capture screen. Screen and 

window captures make your tests easier to read and help you visualize the recorded test. 

You can change the settings for screen captures and add a comment to the image.

• To manually add a test synchronization to the recording, click the Insert synchronization 

icon .

• To manually add a transaction folder to the recording, click the Start Transaction  icon 

and Stop Transaction  icon  to start and stop the transaction.

• To insert a split point into the recorded test, click the Split point  icon . With split points, 

you can generate multiple tests from a single recording, which you can replay in a different 

order with a schedule. See Splitting a test during recording  on page  for more 

information about splitting a test.

9. When you have finished test actions in the program, stop the recorder. You can do this by closing 

the TN3270 terminal program or by clicking the Stop  push button  in the Recorder Control  view.

A progress window opens while the test is generated. On completion, the Recorder Control  view 

displays the Test generation completed  message, the Test Navigator lists your test, and the test 

opens in the test editor.

Related information

TN3270 performance testing guidelines  on page114

Recording a socket API performance test  on page115

Recording sensitive session data  on page141
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Changing test generation preferences
You can change the way that the test recorder organizes multiple send and receive elements in a new 

socket test by changing test generation preferences. To improve the readability of your test, you can 

merge consecutive send or receive elements that use the same connection.

To change the way that test elements are organized by default in a new test, you can change the test 

generation preferences before recording the test.

To merge or reorganize elements in an existing test, you can use the Organize  wizard. See Merging socket 

send and receive elements  on page 275 for more information.

To merge send or receive elements in a new socket test:

1. Click Window  > Preferences  > Test  > Test Generation  > Socket Test Generation.

The Socket Test Generation  preferences window opens.

2. Select Strategies.

You can create multiple organization strategies for handling different applications. Only one 

strategy is active during the recording.

3. Select Default Strategy  or click New  to create an organization strategy.

4. Click Settings.

5. In Edit Socket Strategy Settings, specify how you want the test recorder to generate multiple send 

and receive elements:

Send elements

Merge consecutive send elements

Select this option to merge together all the consecutive socket send 

elements that use the same connection.

Manipulate data with custom code

Select this option to force all the selected send elements to enable the 

Manipulate data with custom code  setting with the specified Class 

name  of a custom Java™  class that uses the API to process data in the 

socket send element.

Receive Actions

Do not merge

Select this option to keep receive elements unmodified as they are 

initially recorded.

Merge consecutive receive elements
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Select this option to merge together all the consecutive socket receive 

elements that use the same connection.

Keep only last receive element

Select this option to discard all multiple consecutive receive elements 

except the last one recorded.

Response timeout

The maximum delay (in seconds) to receive the first byte of the 

response. If no data is received before the end of the response timeout 

delay, the receive action produces an error in the test log. The response 

timeout counter starts when the receive action starts after the think 

time; the counter is interrupted when the first byte is received.

End policy

This option specifies when to stop receiving data and to move to the 

next test element.

• Receives exact number of bytes: The receive action stops when 

the recorded number of bytes is received. Specify a Timeout  (in 

seconds) after which the receive action produces an error in the 

test log, if the correct number of bytes is not received. If Link 

data size  is enabled, the receive action expects the number of 

bytes displayed in the Data  area. If Link data size  is disabled, the 

receive action expects the number of bytes displayed in Bytes. 

This is the default setting

• Receives until end of stream: The receive action stops when 

the connection is closed by the remote computer. If Accepts 

empty response  is selected, then the reception of a single byte 

is not  required and the Response Timeout  is ignored. Specify a 

Timeout  (in seconds) after which the receive action produces 

an error in the test log, if the correct number of bytes is not 

received.

• Matches a string: The receive action stops when a specified 

sequence of bytes is received. Specify a Timeout  (in seconds) 

after which the receive action produces an error in the test log, if 

the correct number of bytes is not received.

• Recognizes a regular expression: The receive action stops 

when a sequence of bytes that matches a regular expression is 



Chapter 1. Test Author Guide

received. Specify a Timeout  (in seconds) after which the receive 

action produces an error in the test log, if the correct number of 

bytes is not received.

• Delegated to custom code: The receive action stops when a 

condition is met in a custom Java™  class. This setting allows 

great flexibility, but requires coding of a custom Java™  class 

following the Rational®  Performance Tester  extension API. Click 

Generate Code  to generate a template based on the API or View 

Code  to open the specified class in the Java™  editor.

Except when the Receives until end of stream  policy is in force, receive 

actions produce an error in the test log when the connection is closed 

by the remote computer.

Timeout

For end policies that have a Timeout  setting, this setting specifies a 

delay (in seconds) after which the receive action produces an error in 

the test log if the end policy criteria is not met. The timeout counter 

starts when the first byte is received.

6. Click OK  to apply the changes, and close the Preferences  window.

Digital certificates overview
The digital certificates feature enables you to run tests against servers that use Secure Sockets Layer 

(SSL) for applications that require client-side digital certificates to authenticate users.

A digital certificate  is a file that binds a public cryptographic key with an identity (a user or an 

organization). Trusted certificate authorities issue digital certificates, which are then used to authenticate 

users and organizations for access to websites, email servers, and other secure systems. A certificate 

store  is an archive file that contains almost any number of digital certificates, possibly certificates that are 

issued from different certificate authorities.

To use digital certificates in tests:

1. Create a digital certificate store. For more information about this subject, see Digital certificate 

creation overview  on page 125 and Creating a digital certificate store  on page 129.

2. Record a test that requires that you use a digital certificate. For more information about this 

subject, see Recording a test with digital certificates  on page 132.
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3. Associate a digital certificate with a test for playback. For more information about this subject, see 

Playing back a test with a digital certificate  on page 133.

4. Optionally, you can associate the digital certificates in one or more digital certificate stores with a 

dataset. For more information about this subject, see Using a digital certificate store with a dataset 

on page .

Create a certificate store by running the supplied KeyTool command-line program. The program creates a 

certificate store that contains digital certificates.

Record a test that requires using a digital certificate. Specify the certificate and password that to use, and 

then begin recording the test. Browse the website as you typically would to record a test.

After you have finished recording, open the test for editing. On the Common Options page, under Digital 

Certificates, click Add. Type the name of the certificate store that you created previously; then select 

the certificate that you want to use. Save the test. When you run this test, the digital certificate from the 

certificate store is submitted to the server.

If you have recorded a test that does not use SSL, you can convert that test to be secure by adding an SSL 

object to the corresponding Server Access Configuration in the test. 

To use a certificate store with a dataset, open the test for editing. On the Common Options  page, click 

Add Dataset. Create a dataset with two columns that contains a list of the certificates in the certificate 

store and a list of passphrases for the certificates. Select Fetch only once per user. Save the dataset. 

On the Common Options page, under Digital Certificates, click Add. Select the certificate store that you 

created previously from the Certificate Store  column. Insert a Certificate Name  for the digital certificate. 

Highlight this name, and then select Substitute from dataset. Choose the dataset added previously, and 

then choose the column with the certificate name. Repeat this process to substitute passphrases from 

the dataset column containing passphrases. Save the test. Add the test to a schedule. When you run this 

schedule, the certificates from the certificate store are submitted to the server.

../../com.ibm.rational.test.lt.common.doc/topics/tcertdp.html
../../com.ibm.rational.test.lt.common.doc/topics/tcertdp.html
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Digital certificate creation overview
If you want to use digital certificates to run tests against applications that require client-side digital 

certificates to authenticate users, work with the appropriate server administrators to determine the types 

of certificates that you need to create.

In cryptography, a public key certificate is a document that uses a digital signature to bind a public key 

with a physical identity. These certificates are often referred to generically as digital certificates or client 

digital certificates. The most common standard for digital certificates is the X.509 standard.

In public key cryptography, each certificate has two associated keys: a public key and a private key. The 

public key is incorporated into the X.509 certificate and is always available with the certificate itself. 

The private key is always kept private (meaning, it is never transmitted). For ease of portability, the two 

keys (and the certificate) can be included in one, encrypted and passphrase-protected, format known as 

PKCS#12.

In order to verify the authenticity of a certificate, it is digitally signed by another certificate, known as a 

Certificate Authority (CA). This CA certificate may be one created (and kept secure) by a company hosting 

a secure application, or it could be created by a company such as Verisign.

When a web application requires digital certificates, an administrator typically creates digital certificates 

for each authorized user. The administrator digitally signs each certificate using the system CA 

certificate. These certificates, along with the public and private keys, are distributed to users. Often 

these keys will be distributed in the PKCS#12 format. Users then import these certificates into their web 

browsers. When the browser is challenged by the server, it will produce its certificate.

When importing certificates for web applications, select the check box that indicates that the keys be 

exportable. With this indication, the certificate can be exported to a PKCS#12 formatted file for later use 

by other programs.

Do not use certificates that are assigned to actual users for performance testing purposes. Use test 

certificates that do not correspond to actual users.

There are four types of certificates that can be used in testing:

• Self-signed certificates

• Signed certificates

• Certificate authority (CA) certificates

• Unsigned certificates (rarely used)
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Self-signed certificates  are used when no entity needs to vouch for the authenticity of the certificate. 

These are the simplest certificates to create and use. Typically, however, a signed certificate is used to 

represent a particular user.

Signed certificates  are used when a certificate needs to be created for and issued to one, and only one, 

user. Signed certificates are signed by a certificate authority (CA).

Certificate authority (CA) certificates  are self-signed certificates used to sign (certify) certificates.

Unsigned certificates  are certificates that are neither signed by a CA nor self-signed. Most web 

applications do not use unsigned certificates.

When you create a self-signed or signed certificate (including CA certificates) you can specify a subject. 

The subject of a certificate is the set of attributes of an X.500 Distinguished Name that is encoded in the 

certificate. The subject enables the recipient of a certificate to see information about the owner of the 

certificate. The subject describes the certificate owner, but is not necessarily unique. Think of subjects 

as entries in a telephone book; there can be multiple entries for Patel Agrawal, but each entry refers to a 

different person.

The subject can contain many different types of identifying data. Typically, the subject includes the 

following:

Attribute Example

COMMON NAME (CN) CN=Patel Agrawal

ORGANIZATION (O) O=XYZ Corporation

ORGANIZATIONAL UNIT (OU) OU=XYZ Software Group

COUNTRY (C) C=IN

LOCALITY (L) L=Bangalore

STATE or PROVINCE (ST) ST=Kanataka

E-MAIL ADDRESS (emailAddress) emailAddress=agrawal@xyz.com

This information can be typed as one string, using forward slashes to separate the data.

For example, the above subject would be typed as follows:

/CN=Patel Agrawal/O=XYZ Corporation/OU=XYZ Software Group/C=IN/L=Bangalore/ST=Karnataka/

emailAddress=agrawal@xyz.com

To learn more about using the supplied command-line program to create certificates, see Creating a 

digital certificate store  on page 129.
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Related information

Creating a digital certificate with OpenSSL  on page127

Creating a digital certificate store  on page129

Recording a test with digital certificates  on page132

Playing back a test with a digital certificate  on page133

Entrust TruePass authentication overview  on page134

Creating a digital certificate with OpenSSL
You can use the OpenSSL program to create digital certificates for use with tests.

OpenSSL is available from the OpenSSL Project at http://www.openssl.org/.

1. Create a certificate authority (CA).

For the purposes of testing, this CA takes the place of a recognized CA on the Internet, such as 

VeriSign. You use this CA to digitally sign each certificate that you plan to use for testing.

a. Create a certificate request (CSR) file. The "subject" (-subj) describes the user of the 

certificate. Enter dummy values as shown. The following command line sets the password 

for the certificate to abcdefg.

openssl req -passout pass:abcdefg  -subj "/C=US/ST=IL/L=Chicago/O=IBM 

Corporation/OU=IBM Software Group/CN=Rational Performance Tester CA/

emailAddress=rpt@abc.ibm.com"  -new > waipio.ca.cert.csr

b. Create a key file, waipio.ca.key, to store the private key.

This removes the password protection from the certificate request file so that you do 

not have to type the password every time you sign a certificate. Because the password 

protection has been removed, use the certificate request file for testing purposes only.

openssl rsa -passin pass:abcdefg  -in privkey.pem -out waipio.ca.key

c. Create an X.509 digital certificate from the certificate request. The following command line 

creates a certificate signed with the CA private key. The certificate is valid for 365 days.

openssl x509 -in waipio.ca.cert.csr -out waipio.ca.cert -req -signkey 

waipio.ca.key -days 365

127

http://www.openssl.org/


Test Author Guide

128

d. Create a PKCS#12-encoded file containing the certificate and private key. The following 

command line sets the password on the P12 file to default. Rational®  Performance Tester 

uses password of default  for all PKCS#12 files by default.

openssl pkcs12 -passout pass:default -export -nokeys -cacerts -in waipio.ca.cert 

-out waipio.ca.cert.p12 -inkey waipio.ca.key

You now have a CA certificate (waipio.ca.cert), which can be installed into the web server 

under test and a private key file (waipio.ca.key) that you can use to sign user certificates.

2. Create a digital certificate for a user.

a. Create a CSR file for the user. Set the initial password to abc. Optionally, provide an 

appropriate subject.

openssl req -passout pass:abc  -subj "/C=US/ST=IL/L=Chicago/O=IBM Corporation/

OU=IBM Software Group/CN=John Smith/emailAddress=smith@abc.ibm.com"  -new > 

johnsmith.cert.csr

b. Create a private key file without a password.

openssl rsa -passin pass:abc  -in privkey.pem -out johnsmith.key

c. Create a new X.509 certificate for the new user, digitally sign it using the user's private key, 

and certify it using the CA private key. The following command line creates a certificate 

which is valid for 365 days.

openssl x509 -req -in johnsmith.cert.csr -out johnsmith.cert -signkey 

johnsmith.key -CA waipio.ca.cert -CAkey waipio.ca.key -CAcreateserial -days 365

d. Optional:  Create a DER-encoded version of the public key. This file contains only the public 

key, not the private key. Because it does not contain the private key, it can be shared, and 

does not need to be password protected.

openssl x509 -in johnsmith.cert -out johnsmith.cert.der -outform DER

e. Create a PKCS#12-encoded file. The following command line sets the password on the P12 

file to default.

openssl pkcs12 -passout pass:default -export -in johnsmith.cert -out 

johnsmith.cert.p12 -inkey johnsmith.key

Repeat this step to create as many digital certificates as needed for testing. Keep the key files 

secure, and delete them when they are no longer needed. Do not delete the CA private key file. You 

need the CA private key file to sign certificates.
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Now you can install the CA certificate (waipio.ca.cert) into WebSphere®. Optionally, create a user 

certificate specifically for your web server, and install it into WebSphere®.

You can use user certificates individually to record tests. To use the user certificates 

(johnsmith.cert.p12) during test editing and playback, compress them in ZIP format to a file with 

the .rcs extension. This creates a digital certificate store. To learn more digital certificate stores, see 

Creating a digital certificate store  on page 129. You can also import user certificates into your web 

browser to interactively test them in your environment.

Related information

Digital certificate creation overview  on page125

Creating a digital certificate store  on page129

Recording a test with digital certificates  on page132

Playing back a test with a digital certificate  on page133

Entrust TruePass authentication overview  on page134

Creating a digital certificate store
The KeyTool command-line program enables you to create a Rational®  Certificate Store (RCS) file that 

contains digital certificates for use with tests. A Rational®  Certificate Store (RCS) file is a compressed 

archive file that contains one or more PKCS#12 certificates. You can also use the KeyTool program to 

remove certificates from a certificate store.

Rational®  Performance Tester  acts as a proxy between the browser and the server application to record 

the data exchange. When a secured page is recorded using Rational®  Performance Tester, the proxy 

certificate of the product is presented to the browser.

1. In the command line tool, navigate to the directory that contains the Keytool utility. By default, the 

utility is located at C:\Program Files\IBM\SDP\jdk\jre\bin.

2. Type the following command:

keytool.exe -genkeypair -alias certificateName  -keystore keystoreName  -storepass 

password  -validity 365  -keyalg RSA  -keysize 2048  -storetype pkcs12

For additional information about parameters by certificate generation, review the official keytool 

documentation.
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Option Description

-genkeypair Generate public and private keys for key pair.

-alias

Alias for your certificate in the key store. You 

may never use it, but every new certificate in 

your key store must have its own alias.

-keystore

Name of the key store file, which will be gen

erated as the result of the command. It holds 

your certificate and a corresponding private 

key. You can reuse this key store for next cer

tificates that you might generate. One key 

store can contain many certificates.

-storepass

Password that protects your key store file. 

You will have to enter it every time you want 

to sign a document.

-validity
Number of days the certificate is valid. You 

can enter more than 365.

-keyalg

Algorithm to generate the cryptographic keys 

that is corresponding to your certificate. You 

can use RSA or DSA.

-keysize
Length of the cryptographic keys. The more 

the length the stronger the signature.

-storetype

Format of the key store file. PKCS#12 (a.k.a 

PFX) key stores can be understood by a lot of 

different programs and you can also import a 

PKCS#12 file in your Windows key store (just 

double click it and follow the instructions).
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3. The certificate generation process prompts you to enter some information about you. Enter the 

information as 

prompted.

4. If prompted for a password when using the keystore, enter the same password as provided on the 

command line.

The key store file (.pfx) is stored in your current directory.

You now have a digital certificate store that you can use with tests. Because the KeyTool program has 

many options, you might want to create an alias or script file to use to invoke KeyTool. Use KeyTool to 

create and add as many digital certificates as you want. If you want to create a dataset of the names of 

certificates in the certificate store, run KeyTool again with the -list  option. This option writes a list of 

names that can then be imported to a dataset.

Before you start recording the application that requires client certification, import the certificate to the 

Rational®  Performance Tester  project. For information about how to import the certificate and record a 

test, see the Recording a test  on page  topic.

You do not have to use the KeyTool command-line program to create a certificate store. It is possible 

to use existing PKCS#12 certificates with Rational®  Performance Tester. PKCS#12 certificates can 

be exported from a web browser. PKCS#12 certificates encode the private key within the certificate by 

means of a password.

Note:  Do not use certificates associated with real users. Certificates associated with real users 

contain private keys that should not become known by or available to anyone other than the owner of the 

certificate. An intruder who gained access to the certificate store would have access to the private keys of 

all certificates in the store. For this reason, you must create, or have created for you, certificates that are 

signed by the correct certificate authority (CA) but that are not associated with real users.
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Related information

Digital certificate creation overview  on page125

Creating a digital certificate with OpenSSL  on page127

Recording a test with digital certificates  on page132

Playing back a test with a digital certificate  on page133

Entrust TruePass authentication overview  on page134

Recording a test with digital certificates
The test creation wizard starts when you record a test. This wizard combines these actions: recording 

a session with a web application, generating a test from the recording, and opening the test in the test 

editor. You can record a test from Internet Explorer (the default for the Windows™  operating system) or 

from another browser.

You must use a PKCS#12 digital certificate when recording performance tests.

1. Click File  > New  > Test from Recording.

2. In the Create New Test from Recording  window, select Create Test from New Recording  and HTTP 

Test, and then click Next.

3. In the list of projects, click the one in which to store this test and related files. The  icon 

identifies projects that are suitable for containing tests. Tests stored in other projects will not run.

Note:  If you have not yet created a project, the Project Name  field displays a default name of 

testproj, which you can change.

4. In the Test file name  field, type a name for the test, and click Next.

The standard Navigator and the Java™  Package Explorer use this name, with extensions. You will 

also see this name in the Test Navigator.

5. In the Enter Client Digital Certificate window  enable Use Client Digital Certificate, and then type or 

browse to the Path  to the digital certificate file that you want to use.

6. Type the Pass Phrase, or password, for the digital certificate, and then click Finish. A progress 

window opens while your browser starts.

Note:  The Java™  Runtime Environment (JRE) that the workbench uses must support the 

level of encryption required by the digital certificate that you select. For example, you cannot 

use a digital certificate that requires 256-bit encryption with a JRE that supports only 128-bit 

encryption. By default, the workbench is configured with restricted or limited strength ciphers. 



Chapter 1. Test Author Guide

To use less restricted encryption algorithms, you must download and apply the unlimited 

jurisdiction policy files (local_policy.jar  and US_export_policy.jar). You can download 

unlimited jurisdiction policy files from http://www.ibm.com/developerworks/java/jdk/security/60/. 

Click on “IBM®  SDK Policy files”, and then log in to developerWorks®. Download and extract 

unrestricted.zip, the 1.4.2+ version of the unlimited jurisdiction policy files. Before installing 

these policy files, back up the existing policy files in case you want to restore the original files later. 

Then overwrite the files in RPT_HOME/jdk/jre/lib/security/  directory with the unlimited 

jurisdiction policy files. By default, this directory is C:/Program Files/IBM/SDP/jdk/jre/

lib/security/. To learn more about JREs, see Working with JREs.

7. In the address box for your browser, type the address of the web-based application to test and 

activate the link.

8. Perform the user tasks that you want to test. While you are recording, follow these guidelines:

• Wait for each page to load completely. Waiting will not affect performance results, because 

you can remove extra "waiting time" (think time) when you play back the test.

• Do not change browser preferences.

9. After you finish performing the user tasks, stop recording. To stop recording, close your browser or 

click on the upper-right of the Recorder Control view bar.

A progress window opens while the test is generated.

On completion, the Recorder Control view displays the message Test generation completed, the Test 

Navigator lists your test, and the test opens for you to inspect or edit.

Related information

Digital certificate creation overview  on page125

Creating a digital certificate with OpenSSL  on page127

Creating a digital certificate store  on page129

Playing back a test with a digital certificate  on page133

Entrust TruePass authentication overview  on page134

Playing back a test with a digital certificate
After you create a digital certificate store and record a test using a digital certificate, you must associate 

the digital certificate with the test for playback.
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You need to record a test using a digital certificate, and you need a digital certificate store file containing 

one or more PKCS#12 certificates.

If your certificate extension is not .rcs, then you need to zip the certificate, rename the extension to .rcs, 

and copy it to the root directory of the project.

To associate a digital certificate with a test for playback:

1. Open the test for editing.

2. On the Security tab, under Digital Certificates, click Add.

3. Select or type the name of the certificate store file that you created previously.

You must type or select the file name. You cannot browse to locate the file. The certificate store 

must be a Rational®  Certificate Store (RCS) file. A Rational®  Certificate Store file is a compressed 

archive file that contains one or more PKCS#12 certificates.

4. Select the digital certificate that you want to use, and then click Select.

5. When prompted to place the digital certificate in a dataset, click No. To learn more about 

substituting digital certificates, see Using a digital certificate store with a dataset  on page .

Note:  If you add multiple certificates to the Digital Certificates  list on the Common Options 

page, the first certificate that satisfies the request from the server (in the order by which the 

certificates were entered) is used during playback.

6. Save the test.

When you run this test, the digital certificate from the certificate store is submitted to the server.

Related information

Digital certificate creation overview  on page125

Creating a digital certificate with OpenSSL  on page127

Creating a digital certificate store  on page129

Recording a test with digital certificates  on page132

Entrust TruePass authentication overview  on page134

Entrust TruePass authentication overview
Entrust provides digital identity and encryption technologies to governments and private industry. With 

Entrust TruePass software users can authenticate with secure web applications without installing a 

../../com.ibm.rational.test.lt.common.doc/topics/tcertdp.html
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digital certificate in their browsers. This makes it convenient for use in kiosks and other public user 

environments.

You can now run tests against servers that require Entrust TruePass authentication. Roaming mode with 

TruePass applet version 7.0 and later are supported. Local mode, and versions of the TruePass applet 

prior to 7.0, are not supported. Recording tests with Entrust TruePass applications works just as regular 

HTTP recording does.

The Entrust TruePass Authentication object is displayed in the test editor for tests that you record with 

Entrust TruePass applications. The Version  field displays the recorded version number of the Entrust 

TruePass applet. The Server Name  and Port  are correlated fields. Click Substitute  to use the Data 

Sources  view to change the server or port number for playback. The Application Context  displays where 

the Entrust application is mapped to in the application server. The User Name  and Passphrase  fields can 

be substituted with values from a dataset.

Related information

Digital certificate creation overview  on page125

Creating a digital certificate with OpenSSL  on page127

Creating a digital certificate store  on page129

Recording a test with digital certificates  on page132

Playing back a test with a digital certificate  on page133
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Kerberos overview
You can run HTTP tests against servers that use the Kerberos protocol for authentication.

Introduction

Kerberos is a security authentication protocol that requires users and services to provide proof of identity.

Note:  Kerberos is supported only for HTTP tests on Rational®  Performance Tester.

Supported environments

Kerberos is supported on HTTP for web servers running Internet Information Server (IIS) or WebSphere® 

with the Simple and Protected GSS-API Negotiation Mechanism (SPNEGO) trust association interceptor 

(TAI). Additionally, the Key Distribution Center (KDC) must be part of the Windows™  Domain Controller 

Active Directory. Internet Explorer, Mozilla Firefox, Opera, Apple Safari, and Google Chrome browsers are 

supported for recording tests. Kerberos is not supported on other protocols, environments, or browsers. 

For example, a KDC running on Linux™  is not supported.

Tips

For best results when you record tests that use Kerberos authentication, specify the host by name, not by 

numeric IP address. Also, note that user information is case-sensitive. Specify user information using the 

exact logon name from the user account in Active Directory. The User logon name  field in the properties 

for the user in Active Directory displays the correct user name in the correct case. To the right of the user 

name the realm or domain name is displayed in the correct case. For example:

• User ID: kerberostester

• Password: secret

• Realm: ABC.IBM.COM

User logon names of the form ABC\kerberostester are not supported.

Troubleshooting

Kerberos authentication is a complex process. If you encounter problems when you attempt to 

record and play back tests that use Kerberos authentication, change the problem determination 

log level toAll  and run the tests again with only one virtual user. To learn more about the problem 

determination log, see the help topic on changing the problem determination level. After running a test, 

the CommonBaseEvents00.log  file on the agent computer contains information that can help you 

determine why Kerberos authentication failed.
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Terms

Active Directory

Active Directory is an implementation of Lightweight Directory Access Protocol directory 

services created by Microsoft™  for use primarily in Windows™  environments. The main 

purpose of Active Directory is to provide central authentication and authorization services 

for Windows™  computers. With Active Directory, administrators can assign policies, deploy 

software, and apply critical updates to an organization.

Directory service

A directory service is a software application or set of applications that store and organize 

information about the users and resources of a computer network.

Generic Security Services Application Program Interface (GSS-API)

The GSS-API enables programs to access security services. The GSS-API alone does not 

provide any security. Instead, security service providers provide GSS-API implementations, 

typically in the form of libraries that are installed with their security software. Sensitive 

application messages can be wrapped, or encrypted, by the GSS-API to provide secure 

communication between client and server. Typical protections that GSS-API wrapping 

provides include confidentiality (secrecy) and integrity (authenticity). The GSS-API can also 

provide local authentication about the identity of a remote user or remote host.

Key Distribution Center (KDC)

The authentication server in a Kerberos environment is called the Key Distribution Center.

Lightweight Directory Access Protocol (LDAP)

LDAP is an application protocol for querying and modifying directory services running over 

TCP/IP. An LDAP directory tree typically reflects political, geographic, or organizational 

boundaries. LDAP deployments typically use Domain Name System (DNS) names for 

structuring the highest levels of the hierarchy. LDAP entries can represent many different 

types of objects including people, organizational units, printers, documents, or groups of 

people.

Simple and Protected GSS-API Negotiation Mechanism (SPNEGO)

SPNEGO is used when a client application attempts to authenticate to a remote server, 

but the authentication protocols supported by the remote server are unknown. SNPEGO 

is a standard GSS-API pseudo-mechanism. The pseudo-mechanism uses a protocol to 

determine which common GSS-API mechanisms are available, then SPNEGO selects one 

GSS-API mechanism to use for all future security operations.

Trust Association Interceptor (TAI)
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The TAI is a mechanism that establishes a secure connection between WebSphere®  and 

other application software.

Recording Kerberos applications with Internet Explorer
You must configure your browser before you attempt to record Kerberos applications.

The client computer must be a member of the domain for which single sign-on (SSO) has been defined.

To configure Internet Explorer to use Simple and Protected GSS-API Negotiation Mechanism (SPNEGO):

1. Log on to Windows™  with a user ID for the domain for which SSO has been defined.

2. Start Internet Explorer.

3. Click Tools  > Options.

4. Click the Security  tab.

5. Define the site to authenticate to using Integrated Windows™  Authentication. Depending on your 

enterprise policy, you define the site in either the Local intranet  zone or the Trusted sites  zone.

• To define the site in the Local intranet  zone, select Local intranet. The instructions that 

follow assume that you are defining the site in the Local intranet  zone.

• To define the site in the Trusted sites  zone, select Trusted sites. In the Security Settings 

for the Trusted sites, click Automatic logon with current username and password, not 

Automatic logon only in Intranet zone.

6. Click Sites.

7. Click Advanced.

8. Type the URL for the hostname for which you want to enable SSO. For example, type http://

abc.ibm.com.

9. Click Add.

10. Click OK.

11. Click OK  again.

12. Click the Advanced  tab.

13. Scroll down to Security, and select Enable Integrated Windows Authentication (requires restart).

This option is not available on Internet Explorer 5.5. Integrated Windows™  Authentication is always 

enabled on Internet Explorer 5.5.

14. Click OK.

15. Restart Internet Explorer.
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Related information

Recording Kerberos applications with Mozilla Firefox  on page139

Generating tests that use Kerberos  on page139

Recording Kerberos applications with Mozilla Firefox
You must configure your browser before recording Kerberos applications.

The client computer must be a member of the domain for which single sign-on (SSO) has been defined.

To configure Mozilla Firefox to use Simple and Protected GSS-API Negotiation Mechanism (SPNEGO):

1. Start Mozilla Firefox.

2. In the location bar, type about:config.

3. In the Filter  field, type network.n.

4. Double-click the network.negotiate-auth.trusted-uris preference.

The network.negotiate-auth.trusted-uris preference lists the sites that are permitted to engage in 

SPNEGO authentication with the browser.

5. In the Enter string value  window, type a comma-delimited list of URLs of trusted domains.

6. Click OK.

7. Optional:  If the application under test uses the advanced Kerberos feature called Credential 

Delegation, double-click the network.negotiate-auth.delegation-uris preference. Type a comma-

delimited list of URLs of trusted domains.

The network.negotiate-auth.delegation-uris preference lists the sites to which the browser may 

delegate user authentication.

Related information

Recording Kerberos applications with Internet Explorer  on page138

Generating tests that use Kerberos  on page139

Generating tests that use Kerberos
You must supply your Kerberos user name and password when generating tests that use Kerberos.
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The test generation process attempts to detect if Kerberos was used when a test was recorded. If the 

test generation process detects that Kerberos was used when a test was recorded, you are prompted 

for the Kerberos credentials. The test generation process might not differentiate between Kerberos 

authentication and NT LAN Manager (NTLM) authentication. In that case, you are prompted for the 

authentication type and credentials.

1. In the Kerberos  window, type in the Kerberos Realm name  field the Kerberos realm name that you 

used during recording.

If the test generation process cannot determine which type of authentication was used, the 

Authorization  window is displayed, not the Kerberos window. In that case, click the Kerberos  radio 

button before typing the Kerberos realm name.

2. In the User name  field, type the user name that you used during recording.

3. In the Password  field, type the password that you used during recording.

The test generation process creates a Kerberos configuration file. The file is krb5.ini  and it is stored in 

the root of the project workspace. This file is required to play back Kerberos tests. Typically, you need to 

ensure that the workbench computer that you use to record the test is in the same Kerberos realm as the 

agent computers that you use to play back the test. Advanced users and security administrators can edit 

this file with a text editor to tailor it to a specific test environment.

Related information

Recording Kerberos applications with Internet Explorer  on page138

Recording Kerberos applications with Mozilla Firefox  on page139

Annotating a test during recording
You can add comments, add transactions, or change a page name while you record a test. The advantage 

of adding these elements during (rather than after) recording is that you can place the annotations in 

the test exactly where you want. In addition, because annotations are part of the recorded test, they are 

regenerated when you regenerate the test. You can also insert split points into a test during record.

1. Start recording the test. The Recorder Test Annotations  toolbar opens near the top of the screen.

2. Click the appropriate icon.

You can use the Recorder Test Annotations  toolbar to add comments, record synchronizations, or 

take screen captures during the recording.
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• To add a comment to the recorded test, click the Insert comment  icon . You are prompted 

for a comment.

• To add a screen capture to the recorded test, click the Capture screen  icon . Screen and 

window captures make your tests easier to read and help you visualize the recorded test. 

You can change the settings for screen captures and add a comment to the image.

• To manually add a synchronization point to the recording, click the Insert synchronization 

icon .

• To manually add a transaction folder to the recording, click the Start Transaction  icon 

and Stop Transaction  icon  to start and stop the transaction. Transactions can be nested.

• To insert a split point into the recorded test, click the Split point  icon . With split points, 

you can generate multiple tests from a single recording, which you can replay in a different 

order with a schedule. See Splitting a test during recording  on page  for more 

information about splitting a test.

• When recording an HTTP test, to change the page name, click the Change page name  icon 

. In the resulting test, the page element in the test editor uses the new name, however 

the original name is preserved in the Page Title Verification Point  area so that page title 

verification points still work correctly.

3. Close the client program to stop the recording.

4. If you inserted a split point during the recording, on the Destination  page, in the Test Generation 

wizard, specify the location for the split test or merge the split recordings together.

The test is generated with the comments, transactions, and page names that you added.

Recording sensitive session data
You can keep recording session (.recsession) files to view the contents of a recording or to regenerate 

tests. However, if a recorded test contains sensitive information, you can choose to obfuscate, or encrypt, 

text strings in the recsession file.

To protect test data in a recording session file:

1. In the Performance Test perspective, click the New Test from Recording  toolbar button  or click 

File  > New  > Test from Recording.

2. In the New Test from Recording  window, select Create a Test from a New Recording, and select 

the type of test to create.

3. In Recording encryption level, select one of these options:
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• Obfuscated: This setting hides text strings to prevent viewing the raw data in recsession 

files with a text editor outside of the workbench. You can still use recsession file to generate 

tests and to view recording information.

• Passphrase: This setting uses an AES-128-bit algorithm to encrypt text strings in the 

recsession files. The encryption strength depends on the length of the passphrase. The 

recording session file is unrecoverable if the passphrase is lost.

4. On the Select Location  page, select the project and folder locations to contain the new test, type a 

name for the test, and click Next.

5. If you selected Passphrase, on the Passphrase Protection  page, type the passphrase twice in 

Passphrase  and Confirm passphrase.

For solid protection, make the passphrase longer than 24 characters if using English words or at 

least 12 random characters.

6. Click Next, and continue the recording session for the type of test that you selected.

Related information

Creating tests  on page3

Recording a test with digital certificates  on page132

Generating a new test from a recorded session
You can generate a new test from a recorded session. For example, if you accidentally damage a test 

during editing, or if you want to change a test preference, you can regenerate the test instead of re-

recording it. If split points were inserted in the recording, you can choose to generate a single test without 

split points.

To regenerate a complete test from a recording that contains split points:

1. In the test navigator, select the .recsession file of the test recording to regenerate.

2. Right-click, and then select Generate Test.

The Generation Test  wizard is displayed.

3. If the .recsession file is compatible with multiple test types, select the type of test that you want to 

generate and click Next.

For example, select HTTP Test  to generate an HTTP performance test.

4. On the Select Location  page, select the project and folder where you want to create the test, type a 

name for the test, and click Next.

If necessary, click Create the parent folder  to create a new performance test project or a folder
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5. If the .recsession file contains split points, on the Options  page, select Generate test without split 

points  if you want to regenerate the test as a single test.

6. Click Finish.

The test is regenerated and opened in the test editor.

Putting test assets under source control
Use version-control software, such as Rational®  ClearCase®  or Engineering Workflow Management , to 

put test assets under source control.

If you use version-control software, such as Rational®  ClearCase®  or Engineering Workflow Management 

, put the following assets under source control to share them with the members of your team that use the 

same source-control product. Put the different project assets in separate folders under the main project.

Asset File name extension Comments

Projects .project This enables the project to be seen and 

imported by another user.

Schedules .testsuite

Tests .testsuite

Custom code .java Put any custom code that you have 

written for a test under source control. 

Put this code under the src  folder for 

the project; for example, in src\cus

tom.

This code must be versioned as a sin

gle logical unit with the test that in

cludes it (that is, the code and the test 

should be versioned together).

Datasets .dataset

Locations .location

Results .stats, .rstats, .pstats, and .m

stats

Results assets, which are not vis

ible in the Test Navigator, contain 

the data used to create reports and 
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Asset File name extension Comments

should be under source control. To 

see these assets, in the Test Nav

igator view, click the drop-down 

icon and select Filters  and clear 

the Statistics Stores  check box. 

You can perform the check out and 

check in operations from this view. 

Store the results in a separate results 

folder, which you can specify when run

ning a schedule or test.

Follow these guidelines:

• Turn off the Eclipse prompt that is displayed every time you create a file, asking if you want to 

add it to source control. To do so, click Window  > Preferences  > Team  > ClearCase SCM Adapter 

preferences page and select Do Nothing.

• During a session, keep schedules and tests checked out for easy editing. When you exit Eclipse, 

you are prompted to check them back in.

• Put test logs (files with the .execution  file name extension) under source control, in the results 

folder.

• Do not put the class path file under source control.

Organizing test assets by type
By clicking an icon, you can view your test assets in a logical order, in separate folders for tests, 

schedules, results, locations, and datasets.

In the Test Navigator view, you can click Show Java Content  to see custom code that you created, click 

Show Missing Resources  to view unresolved references, and click Show File Extenstions  to view file 

extensions of test assets.
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1. On the Test Navigator toolbar, click the Show the logical test navigator   icon.

To see the Test Navigator view, click Windows  > Show view  and click Test Navigator.

2. Your assets are now grouped logically. To see them, open the appropriate folder.

Note:  In the Logical view, only if the asset is available the appropriate folder is displayed. For 

example, if the Results folder is displayed only after you have executed a test.

Editing tests
After you record a test, you can edit it to include datasets (to provide variable data rather than the data 

that you recorded), verification points (to confirm that the test runs as expected), and data correlation 

(to ensure that returned data is appropriate for the corresponding request). You can also add protocol-

specific elements to a test. When you edit a test, the modified items appear in italic type. The italic type 

changes to regular type after you save the test.

Editing HTTP tests
After you record a test, you can edit it to include variable data rather than the data that you recorded and 

can include verification points to confirm that the test runs as expected. You can also edit the test to 

include [NB1] transactions, conditional processing, custom code, and standard header or custom header 

to a request or response.

Redirection support for HTTP tests
When you run HTTP tests, redirect requests are followed automatically, which supports common usage 

patterns, such as load balancing.
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HTTP redirect responses are responses to requests with status codes in the 300 family, which indicate 

that the requested content is found at a different location. Redirect responses include HTTP status codes 

such as 301 Moved Permanently  and 302 Found. Some HTTP applications redirect clients to a specific URL, 

but the ultimate response to the client request can be handled by one of several servers to balance the 

load that each server handles. For example, a request that is sent to http://www.example.com/ might be 

redirected to http://www-1.example.com or http://www-2.example.com, depending on traffic and load 

conditions.

Both expected redirect and unexpected redirect responses are supported when you run tests. Expected 

redirect responses occur when you record tests. Unexpected redirect responses are received from the 

server when you run tests, but the responses are not present in the recorded test.

Expected redirect responses are handled by automatic data correlation. To automatically correlate host 

names and port numbers, click Window  > Preferences  > Test  > Test Generation  > HTTP Test Generation 

> Data Correlation, and then select the Automatically correlate URL pathname if redirected by response 

check box. This option is selected by default.

Unexpected redirect requests are followed until an HTTP status code that is not a redirect response, 

such as 200 OK, is returned by the server, or until the maximum number of redirect responses has been 

reached. By default, the maximum number of redirect responses to follow is 10. When a 200 OK  response 

is received, references that use the data in the final response are created.

Server access configurations are updated dynamically for unexpected redirect responses. For example, 

for a Config_1  server access configuration, where the host is abc.example.com and the port is 80, 

if a request that uses that configuration is redirected to port 8080 on the xyz.example.com host, all 

subsequent requests in the test that use the same configuration use port 8080 on the xyz.example.com 

host.

Verification points in a request are applied to the final destination. You can set a ResponseCode 

verification point in a request so that an unexpected redirection can be handled appropriately. If you set an 

exact ResponseCode verification point, it fails when a redirection occurs. A relaxed verification point also 

fails if the status codes in the 300 family are not part of the relaxed code list.

Creating secondary HTTP requests
A recording creates multiple HTTP requests and responses. In some cases, a response from the server 

can be dynamic, because of which the subsequent requests might need to be modified. While playing 

back the test, some of these dynamic requests might fail. For example, recording and playback might 

involve a different set of users with different permission settings or the UI elements might have changed 

since the time you recorded the test.  To ensure that the test is played back without the need to record it 
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again, you can create secondary requests which, based on the response received from the server, fetch 

the exact values that the test requires .

You identify the HTTP request for which to create a secondary request, and then create a reference for 

all the occurrences to dynamically generate the request. If you do not want to create a reference, you can 

define an array variable that lists the HTTP requests to use from playback. You can use the array variable 

from custom code.

From version 9.1.0.1 or later, you can also specify the number of requests to be send to the server in the 

Test Editor itself. After creating the secondary HTTP request, in the HTTP Secondary Request Generator 

Details area, specify the total number of requests. If the number of requests is greater than 0, the number 

that you specify in Total number of requests  takes precedence over the array variable.

You can also use the delays to control the flow of the requests to the server. In the Advanced  tab, go to 

the Delay Between Requests section and select the parameters for the flow of the requests. In Release 

When, select when exactly to release the request. For instance, First Character Sent indicates to release 

the second request after the first character in the first request is sent.

To create a secondary HTTP request:

1. Create a reference. See the Creating a reference  on page  topic.

2. Right-click the HTTP request for which to create the secondary request and click Create Secondary 

HTTP Request Generator. You can also select multiple HTTP requests that have common headers 

or connection attributes. If multiple requests do not have common attributes, you are prompted to 

select one request as template.

The original HTTP requests are disabled, indicating that the playback will now use only the 

secondary HTTP request.

3. Run the test.
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HTTP test editor overview
With the test editor, you can inspect or customize a test that you recorded.

The test editor lists the HTTP pages for a test, by title. The following example shows the visitIBM test, 

which was generated from a recording of these tester actions: type http://www.ibm.com, under Shop for 

select Software, stop recording.

The test editor window contains two main areas. The area on the left, Test Contents, displays the 

hierarchy of the HTTP pages for the test. The area on the right, Test Element Details, displays common 

options and specific information about the HTTP protocol. The HTTP options apply to every page an 

HTTP test.

The Test Variables  are listed at the top of the Test Contents  area. These variables, which are the host 

names and ports in the test, are automatically created when the test is generated. Click a variable name to 

see where it is used in the test. By changing these variables, you can share or reuse the test for different 

configurations and web hosts. User-defined variables are also listed at the top of the Test Contents  area. 

For more information on this subject, see related topics.

When you expand a test page, you see a list of the requests for the page, in separate folders, with names 

that are full web addresses minus the initial http://. The following example shows the expanded first 
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page of the visitIBM test with the page selected in the Test Contents  area. In this example, the settings 

that are displayed in the Test Element Details  apply to the selected page.

The primary request, which is listed in bold, is the basis of the page title. The primary request can be 

the web address that the tester typed into the browser, a hyperlink that was clicked, or a web address to 

which the tester was redirected from another page request. In the example, the primary request shows 

that the tester was redirected to www.ibm.com/us/ from the initial page request (www.ibm.com). If the 

primary request does not return a page title, the test generator creates a unique name for it from the first 

node of the web address.

Some requests are highlighted in yellow. This highlighting indicates that these requests contain one or 

both of the following types of information:

• A dataset candidate:  This is a value, usually one specified by the tester during recording, that the 

test generator determined is likely to be replaced by values in a dataset. An example of a dataset 

candidate is a string that you search for in a recorded test. The string is highlighted as a dataset 

candidate on the assumption that, before playback, you might want to associate the string with a 
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dataset column that contains appropriate substitute values. For more information on this subject, 

see related topics.

• Correlated data:  These are values in a test, usually one of them in a response and the other in a 

subsequent request, that the test generator determined needed to be associated in order to ensure 

correct test playback. An example is a photograph that is returned to the browser by a test that 

searches an employee database. The test generator automatically correlates employee names 

with photographs. Suppose that, before running the test with many virtual users, you replace 

the employee name searched for in the recorded test with names in a dataset. Because the test 

correlates the data, each virtual user searches for a different employee, and the server returns an 

appropriate photograph. For more information on this subject, see related topics.

Note:  To see an illustration of color coding in performance tests, click Window  > Preferences  > Test 

>  Test Editor, and then click the Colors and Fonts  tab.

When you expand a request, you see the Response  data for the request. As shown in the following 

example, requests can also contain Connection  data. Because the response is selected in the Test 

Contents  area, the Test Element Details  area displays the response data for this request.
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The Response  data inside each request shows the data that the web server returned to the browser based 

on that request. Collectively, the requests listed inside a page are responsible for everything that was 

returned by the web server for that page.

Select multiple responses to display a table under Test Element Details  that shows the following 

elements for the selected responses:

• Response code

• Response reason

• Response size

• Binary indicator

• Parent request

• Content verification point

• Response code verification point

• Response size verification point

Click Add  to add child elements to the selected test element. Alternatively, you can right-click a test 

element and select an action from a menu. The choices that you see depend on what you have selected. 

For example, after you select a test, you can add a new page, a block of custom code, or an IF condition. 

After you select a page, you can add a request or an IF condition.

The Insert  push button works similarly. Use it to insert a sibling element before the selected element.

The Remove, Up, Down  push buttons, and some Add  choices (HTTP Page, HTTP Request, Basic 

Authentication) are primarily for use with tests that you write by hand; these actions or choices are 

likely to break a generated test. The types of structures that are commonly used in generated tests are 

explained in Verifying expected behavior  on page 161 and Adding test elements  on page .

If you test Siebel applications, see Testing Siebel applications  on page 184 for prerequisites and details 

about the differences between standard HTTP tests and Siebel tests.

A portion of the test editor can occasionally be obscured. To see the obscured area, move the cursor over 

one of the blue lines until it changes to , and drag up or down while holding the left mouse button.

To resize the Test Editor window, do one of the following:

• Click Ctrl+Alt+> or Ctrl+Alt+< to enlarge or reduce the window.

• Hover at the left side of the Test Element Details  area. When you see a vertical blue line, right click 

the line and select a size ratio from the menu. 
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The new size remains the next time you open the window. Double click the blue line to return to a 50/50 

ratio.

Related information

Reusing tests on different hosts: Server connection variables  on page179

Providing tests with variable data (datasets)  on page

Correlating response and request data  on page

Specifying the number of allowable URL redirects during test runs
When you run a test in a load-sharing environment, an unexpected redirection loop might occur during 

HTTP processing. An unexpected redirect response occurs when an HTTP request that normally returns a 

specific document redirects the browser to another location.

When the system detects an infinite loop of redirects, the infinite loop is broken, an error verdict for the 

request is issued, and the following message is displayed:

Infinite redirection loop detected getting URL n. If this is expected and understood, 

increase RPT_VMARGS rptMaxRedirection parameter. Redirected history (from the first URL to 

the current one).

The default number of redirects is set at 10; however, you can edit the maximum number of redirects by 

updating the RPT_VMARGS  argument in the –DrptMaxRedirection  setting.

../../com.ibm.rational.test.lt.common.doc/topics/tvardata.html
../../com.ibm.rational.test.lt.common.doc/topics/tvardata.html
../../com.ibm.rational.test.lt.common.doc/topics/tvardata.html
../../com.ibm.rational.test.lt.common.doc/topics/tvardata.html
../../com.ibm.rational.test.lt.common.doc/topics/tdatacorrtop.html
../../com.ibm.rational.test.lt.common.doc/topics/tdatacorrtop.html
../../com.ibm.rational.test.lt.common.doc/topics/tdatacorrtop.html
../../com.ibm.rational.test.lt.common.doc/topics/tdatacorrtop.html


Chapter 1. Test Author Guide

To modify the number of allowable redirects before an error is reported, complete these steps on the 

workbench.

1. In the Test Navigator, expand the project until you find the agent computer at the deployment 

location to change.

Agent computers are represented by the  icon.

2. Right-click the agent computer, and then click Open.

3. Under Property Groups, click General Properties, and then click Add.

4. In the New Property  window complete these steps:

a. In the Property Name  field, type RPT_VMARGS.

b. In the Operator  field, confirm that the operator is =.

c. In the Property Value  field, type –DrptMaxRedirection=n, where n  is the maximum number of 

redirects that can occur before the error message is displayed, and then click OK.

d. Only one RPT_VMARGS  argument is allowed for each agent computer location. If multiple 

RPT_VMARGS  style properties are required, you must separate-Dname=Value  with a space. For 

example, -DrptMaxRedirection=15 -DanotherProperty=Value.

The following New Property  window sets the maximum number of redirects to 15:

Cutting and pasting in tests
You can cut, copy, and paste in HTTP tests.

The test editor supports the standard cutting, pasting, and copying of test elements by using the Edit 

menu or keyboard shortcuts. Test elements include HTTP pages, HTTP page elements, and requests. If 

you cut a test element, that element is not actually removed from the test until you next cut or paste.

If you copy a test element, that element is not actually copied until you next paste. For this reason, do not 

close the test from which you copy a test element until you have pasted the test element into another 

test. If you copy a test element from a test, and then close the test, nothing is pasted when you attempt to 
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paste the test element. When you cut an element, it becomes unavailable (gray) and is displayed in italics. 

When you paste an element, it is displayed in italics until you save the test.

If you copy a request from one test to another and the connection details are same, the connections are 

copied. If the server URL in the another test is different, the connection detail is not copied. Click Change 

to add a new connection.

Note:  Cutting and pasting can break correlations between test elements. For example, it is possible 

to cut a test element that contains a reference that a later portion of the test requires. When you cut, copy, 

or paste HTTP test elements, you are not warned of potential data correlation problems. You must ensure 

that the editing operation does not cause a data correlation error.

Defining requirements in tests
You can define requirements for elements in a test. These requirements specify acceptable thresholds 

of performance and validate service level agreements. Starting from version 9.2.0.1, you can define both 

performance and functional requirements in the tests. The verdict of the test is computed based on the 

requirements defined in the schedule. You can view the verdict in the Requirements report.

You can set requirements on protocol-specific test elements, on schedule elements, on data created 

by custom code, and on collected resource usage data. You define a requirement as standard  or 

supplemental. A standard requirement determines that the requirement is significant enough to cause 

the entire run to be declared a failure if it fails. A supplemental requirement, although important, is not 

significant enough to cause the run to fail. For example, a supplemental requirement might be a request 

from development to validate a very specific data item provided by WebSphere®  PMI monitoring.

To define a requirement for the elements in a test:

1. In the Test Navigator, browse to the test and double-click it.

The test opens.
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2. In the Test Contents  area, select the page or the request that will have the requirement.

You can select multiple pages or multiple requests.

3. In the Test Element Details  area, click the Advanced  tab, and select Enable Requirements.

A table of requirements that apply to the page or to the request is displayed.

4. Click the requirement to define, and add a definition, as follows:

Option Description

Name

You can change the name of a requirement 

to improve readability. However, changing a 

requirement name causes a mismatch be

tween the Requirements report, which us

es the changed name, and the other reports, 

which use the default name. Therefore, when 

you change a requirement name, be sure to 

keep track of the original name.

Operator Select an operator.

Value Type a value.

Standard

Select to make the requirement standard. 

A standard requirement can cause a test to 

have a verdict of fail. Clear to make the re

quirement supplemental. In general, supple

mental requirements are used for require

ments that are tracked internally. A supple

mental requirement cannot cause a run to 

fail, and supplemental results are restricted 

to two pages of the Performance Require

ments report.

5. Optionally, apply the defined requirement to other test elements:

a. In the Test Contents  area, select the test elements that will have the requirement.

The elements must be of the same type, for example, all page elements.

b. In the Requirements table, right-click the requirement row, and select Copy Requirements.

6. Optionally, select Hide Undefined Requirements  to hide the shaded rows, which indicate that a 

requirement is not defined, and improve readability.

7. Select a requirement and click Clear  to remove its definition. The requirement is still available and 

can be redefined.
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8. After you have defined a number of requirements on test elements, you might want to see all of the 

requirements defined for the test. To do so:

a. In the Test Contents  area, click the name (root) of the test.

b. In the Test Element Details  area, sekect the Requirements  category.

The Requirements  page displays a summary of the performance and functional 

requirements defined in the test.

c. To navigate to the original requirement definition, double-click the requirement row.

You can define requirements in a test or in a schedule. When you define a requirement in a test, the 

requirement is defined individually for each test element—even if you select multiple test elements and 

apply the requirement to all of them at the same time. When you define a requirement in a schedule, the 

requirement is applied to the aggregate of test elements.

For example, assume that you select every page in a test and define this requirement: Average response 

time for page [ms] [For Run]  must be less than 5 seconds. This means that if one page in the test has 

a response time of 6 seconds, the requirement on that page fails. The other pages, which have a response 

time of less than 5 seconds, pass.

Assume that you open a schedule and define this requirement: Average response time for all pages 

[ms] [For Run]  must be less than 5 seconds. This measures the average response time for all of the 

pages. One page can have a response time of 30 seconds, but if enough pages have a response time low 

enough to counter the negative effect of that one page, the requirement passes.

For information on defining requirements in schedules, see Defining requirements in schedules  on page 

513.

Adding an authentication folder
Web application servers can include an option to force a login. You might have recorded a test with this 

option disabled but want to run the test with the option enabled. Adding an authentication folder to the 

appropriate test request lets you do this without recording the test again.

To add an authentication folder to a request:

1. In the Test Navigator, browse to the test and double-click it. 

The test opens.

2. Click the request that will contain the authentication folder.
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3. Click Add  and select Basic Authentication.

A folder named Authentication  is added to the request, and the Test Element Details  area displays 

the Userid, Password, and Realm  fields.

Adding or removing header in batches
You can add or remove HTTP header from multiple HTTP requests or responses in batches to improve 

the script efficiency. For example, during the development process, there might be HTTP headers change 

or addition of new HTTP headers to the requests. These changes in the HTTP headers will result in the 

test script failure.

Adding HTTP header to multiple HTTP requests
During the development process, there might be a change in HTTP headers. To modify the test script in a 

faster and easier way, you can add the HTTP headers in batches to the requests.

To add HTTP headers to multiple HTTP requests at once:

1. Open the test.

2. In the test hierarchy, select a request (press Ctrl  key to choose multiple requests).

3. From the Options  drop-down list, select Add  > HTTP Header. The Add/Edit Headers  window opens.
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4. To add a standard header:

a. In the Available Headers  list, locate the header to add and click it. Type the name of the 

header in the Quick search  field and select the type of header that you are looking for in 

Header types  list to quickly locate a header in the Available Headers  list.

b. Click the right-angle bracket (>). The selected header moves into the Selected headers  list 

and your cursor is placed in the value column.

c. Type the value for the header.

5. To add a custom header:

a. In the Header types  list, select Custom.

b. At the bottom of the window, in the New custom header  area, type the header information in 

the Name  field and the Value  field, and then click Insert. The custom header is added to the 

Selected headers  list.

c. When you have finished adding headers, click OK.
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Removing HTTP header from multiple HTTP requests
During the development process, there might be addition of new HTTP headers. To modify the test script 

in a faster and easier way, you can remove the HTTP headers in batches from the requests.

To remove HTTP headers from multiple HTTP requests at once:

1. In the Test Navigator, browse to the test and double-click it. The test opens.

2. Right-click the test name, and then select Test Search.
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3. In Search for text, type the header name to locate.

4. In the Elements to search  list, select the HTTP Requests  check box.

5. On the right-hand side, where you can define how to search a selected element. Select the Headers 

Names  or Header Value  check box depending on the input provided in the Search for text  field.

6. Click Search. The Test Editor  window displays with the number of matches found.

7. In the Search view, select a result (press Ctrl  key to choose multiple results).

8. Right-click the selected results and click Delete Header.
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Verifying expected behavior
To check whether an expected behavior occurred during a run, you add verification points. When you run 

a test that contains a verification point, an error is reported if the expected behavior did not occur. When 

global verification points are disabled (the default), you can enable verification points for a specific test.

Enable verification points globally. Click Window  > Preferences  >  Test  >  Test Generation  >  HTTP Test 

Generation.

Specifying the expected page title
Page title verification points verify that the primary request for a page returns the expected page title. If 

the returned title is unexpected, the test log reports a failed verdict event. Although the comparison is 

case-sensitive, it ignores multiple white-space characters (such as spaces, tabs, and carriage returns).

1. In the Test Navigator, browse to the test and double-click it. 

The test opens.

2. Right-click the test name or a page, and select Enable Page Title VPs.

Your choice determines whether the verification point is added to all pages in the test or to one 

page.

3. Click the page title to display the editing fields in the Test Element Details  area. 
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4. Ensure that the Expected page title  field shows the string that you expect to be included in the 

response. Although you can change the string, the value listed is what was returned between the 

<title></title> tags during recording.

You can also change the preferences so that Page Title verification points are set automatically. To do 

this:

1. Change the HTML page title. Click Window  > Preferences  >  Test  >  Test Generation  >  HTTP Test 

Generation  >  Verification Points, and select HTML Page Title. This changes subsequent tests that 

you record.

2. Optionally, regenerate existing tests with the changed preference, as shown in Generating a new 

test from a recorded session  on page 142.

Specifying the expected response code
Response code verification points verify that the response code matches an expected value. If the 

returned code is does not match, the test log reports a failed verdict event. You can specify an exact 

response code or verify that the code is within the same category.

You can either change the preferences so that Response Code verification points are set automatically for 

all the tests or you can configure each test setting. To set response code in the preferences:

1. Change subsequent tests that you record. Click Window  > Preferences  >  Test  >  Test Generation  > 

HTTP Test Generation  >  Automatically include verification point of, select HTTP Return Code  and 

click Relaxed  or Exact. This changes subsequent tests that you record.

2. Optionally, regenerate existing tests with the changed preference, as shown in Generating a new 

test from a recorded session  on page 142.

To set response code setting for a test:
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1. In the Test Navigator, browse to the test and double-click it. 

The test opens.

2. Right-click the test name, a test page, or a request, and select Enable Response Code VPs.

Your choice determines whether a verification point is added to every request in the test, to 

every request in a page, or to a particular request. The following figure shows a response code 

verification point within a test:

Note:  When you modify a test, the modified items appear in italic type. The italic type changes 

to regular type after you save the test.

3. Click the verification point to display the response code editing fields in the Test Element Details 

area.

4. To disable an individual response code verification point, clear the Enable verification point  field.

5. From the Select matching method  list, click an option to indicate how closely the returned 

response code must match the recorded value.

Option Description

Relaxed

If the recorded response code is 200, 201, 

202, 204, 206, 301, 302, or 304, then a re

turned response code of any of those values 

causes the verification point to pass. If the 

recorded response code is any other value, it 
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Option Description

is the same as if you had specified an exact 

match.

Exact
An error is reported if the returned response 

code does not match the recorded value.

Specifying the expected response size
Response size verification points verify that the number of bytes returned in a response is what you 

expected. If the byte count does not match, the test log reports a failed verdict event. You can specify an 

exact response size or verify that the byte count is within a range.

1. In the Test Navigator, browse to the test and double-click it. 

The test opens.

2. Right-click the test name, a test page, or a request, and select Enable Response Size VPs

Your choice determines whether the verification point is added to all test pages, to a page in the 

test, or to a particular request. The following figure shows a response size verification point within 

a test:

Note:  When you modify a test, the modified items appear in italic type. The italic type changes 

to regular type after you save the test.

3. Click the verification point to display the response size editing fields in the Test Element Details 

area.
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Responses to HEAD requests, by definition, have no contents; the size is always 0.

4. To disable an individual response size verification point, clear the Enable verification point  field.

5. From the Select matching method  list, click an option to indicate how closely the response size 

that is returned in the page request must match the recorded response size.

• The default matching method for a primary request is Range, with a percentage adjustment 

based on the value in the field on the right. (You can change the percentage basis as well as 

the matching method.) When the test is run, an error is reported if the actual response size 

falls outside the adjusted range.

• For other requests, the default matching method is Exact. When the test is run, an error is 

reported if the response size does not exactly match the expected size.

You can also change the preferences so that Response Size verification points are set automatically. To 

do this:

1. Change subsequent tests that you record. Click Window  > Preferences  >  Test  >  Test Generation 

>  HTTP Test Generation  >  Verification Points, and select HTTP Response Size. This changes 

subsequent tests that you record.

2. Optionally, regenerate existing tests with the changed preference, as shown in Generating a new 

test from a recorded session  on page 142.

165



Test Author Guide

166

Specifying the expected content
Content verification points verify that the response contains—or does not contain—an expected string. If 

the content returned is unexpected, the test log returns a failed verdict event. You can create a content 

verification point from specific response text.

To create a content verification point from a response or a portion of a response:

1. In the Test Navigator, browse to the test and double-click it.

The test opens.

2. Click the response that contains the contents that you want to use for the verification point. If 

you do not see the contents, press Ctrl+Shift+Spacebar in the Test Element Details  area, under 

Content.

3. Select the content for the verification point, right-click, and select Add to Content Verification 

Point.

The content verification point and the selected string are displayed in the Test Contents  area.

4. Edit the new content verification point as needed. You can use the Add, Insert, and Remove  buttons 

to manipulate content verification points and content verification point strings. After you select 

a content verification point or content verification point string in the editor, you can also edit the 

verification points and strings by using the controls in the Test Element Details  area. For example, 

you might want to change part of the hard-coded response contents to a regular expression. To 

substitute from any data source that exists in the test, select the entire string or a portion of the 

text string, and then right-click, and select Substitute.

Note:  Responses to HEAD requests, by definition, have no content. Therefore, a content 

verification point that attempts to match a string in a response to a HEAD request will fail.

Specifying the expected content for multiple requests
Content verification points verify that the response contains—or does not contain—an expected string. If 

the content returned is unexpected, the test log returns a failed verdict event. You can advance through a 

test and create content verification points in multiple requests, or in the entire test.

To create content verification points in multiple requests:

1. Adjust the verification point scope. The default is to create content verification points in primary 

requests only and to skip responses with binary contents. Click Window  > Preferences  >  Test  > 

Test Editor  >  HTTP Test. Select or clear Skip responses with binary content  and Create only in 

primary responses  as needed.
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2. In the Test Navigator, browse to the test and double-click it. 

The test opens.

3. Right-click the test name, a test page, or a request, and select Verification Points  > Enable Content 

VPs.

Your choice determines whether the verification point is added to all test pages, to a page in the 

test, or to a particular request. Confirm that you want to modify the test elements, and click OK.

4. In the Create/Enable Content Verification Point  window, set Verification fails if  to either At least 

one of the checked strings is found  or to None of the checked strings are found.

5. In the list of strings in the Text  column, select the strings that the content verification point should 

search for.

• If you are editing an HTTP test, the window lists user-defined strings.

• If you are editing a Siebel HTTP test, the window also lists strings of interest in Siebel 

applications.

6. To create a new string from scratch, click New String. To create a new string by editing another 

string, click it and click Duplicate. To edit an existing string, click Edit. To remove a string, click 

Remove.

7. Optionally, insert a regular expression into the verification point. The most common regular 

expressions are *  for any number of characters, ?  for any single character, and \  for an escape to 

enter literals. For detailed information on Java™  regular expressions, see the Java™  documentation.

8. The Create/Enable Content Verification Point  window advances through the requests. The 

preference settings that you selected in the first step determine whether secondary requests and 

requests containing binary data are affected. Select one of the following:

Option Description

Skip
Advances to the next request without insert

ing a verification point in the current request.

Enable
Inserts a verification point into the current re

quest and advances to the next request.

Enable All

Inserts a verification point into every test re

quest (if the scope is the test) or every page 

request (if the scope is a page).

By default, a string that you set for a content verification point is available to all tests. To make the 

string available only to a specific test, or to clear the list of strings displayed when you create a 

verification point, change the preferences in the Content Verification Points  section of Window  > 

Preferences  >  Test  >  Test Editor  >  General.
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How loops affect the state of virtual users
If verification points fail unexpectedly during a run, the cause might be that virtual users in loops do not 

maintain their original state. To enable each virtual user to enter the loop in the original state, you can 

modify the test's HTTP options or add custom code.

By default, the cookie cache for a virtual user is not reset during a test run. This is consistent with a 

browser's behavior. If a test or schedule contains loops, and a web server sets a cookie during the first 

iteration of the loop, that cookie is "remembered" on subsequent iterations.

However, in certain instances, you might want to clear all cookies cached for a particular virtual user. For 

example, if you want each iteration of a loop to appear as a new user, you must reset the cache. If you do 

not, although the test completes, verification points that you have set within the test may fail.

There are two ways to reset the cookie cache, and each way has different effects.

To reset the cookie cache when looping in the schedule, or when the test follows another test in the 

schedule, use the following method. This resets the cache whenever the test is entered. Even if your tests 

do not loop, use this method if you are running back-to-back tests or Siebel tests.

1. In the Test Navigator, browse to the test and double-click it. The test opens.

2. On the HTTP options page, select Clear cookie cache when the test starts.

To reset the cookie cache from one loop iteration to the next when you have put a loop around the entire 

contents of the test, and the loop is inside the test, add custom code to the test and call an API, as 

follows:

1. Run the test or schedule to add the current Java™  libraries to the class path.

2. Open the test and select the test element located at the point where you want the cookie cache to 

be reset. Typically, this is at the end of the loop.

3. Click Add  or Insert  and select Custom Code.

Add  appends the custom code to the bottom of the selected element (test or test page). Insert 

adds the custom code above the selected page or page request.

4. Add the following Java™  import statement: Import 

com.ibm.rational.test.lt.execution.http.util.CookieCacheUtil;

5. Add the following Java™  code inside the exec method: CookieCacheUtil.clearCookieCache(tes);

The following example shows a custom code addition that resets the cookie cache. The lines that you 

add to the generated custom code template are shown in bold:
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Note:  For another example of custom code that sets and clears cookies, see Setting and clearing 

cookies for a virtual user  on page .

package test;

 

import com.ibm.rational.test.lt.execution.http.util.CookieCacheUtil;

import com.ibm.rational.test.lt.kernel.services.ITestExecutionServices;

 

public class Class1131739398417 implements

  com.ibm.rational.test.lt.kernel.custom.ICustomCode2 {

  

 public Class1131739398417() {

 }

 public String exec(ITestExecutionServices tes, String[] args) {

  CookieCacheUtil.clearCookieCache(tes);

  return null;

 }

 }

Related information

Running tests at a set rate  on page

Repeating tests in a schedule  on page515

Adding a loop to a test  on page

Splitting a test
After you record a test, you can split it into smaller tests. By splitting a test, you can create modular 

building blocks of smaller tests and combine them to make bigger tests. The original test is unchanged.

With the test-splitting capability, you can record a relatively long scenario with many functional steps 

against an application and then, in the editor, dissect the test into many smaller test segments, which you 

can run in various orders in a schedule. The wizard determines which variables need to persist among the 

split tests and creates the linkage so that you do not have to write custom code.

1. In the Test Navigator, browse to the test and double-click it.

The test opens.
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2. Select one or more elements in the test for splitting into a new test.

You must select contiguous elements. You can select elements, except for variable containers, that 

are immediate children of the root node of the test.

3. Right-click the selected elements, and then select Save Selection As New Test.

4. In the Save Selection as New Test  window, type a file name for the new test, and optionally provide 

a description or comment for the split test.

a. Select Also use description text for comment at beginning of each test  to add the 

Description/comment  field as a comment at the beginning of the split test.

b. Select Mark the selection in the editor  to mark the selection in the original test with marks 

of the form [N->  where N  is a positive integer that corresponds to the number of saved 

selections. For example, the first time you save a selection as a new test, the selection in the 

original test is marked with this identifier:[1->. If you save three selections, the original test 

is marked with these identifiers: [1->, [2->, and [3->.

c. Click Next.

Selecting Mark the selection in the editor  makes it easier to split a test into multiple parts. The 

marks in the editor are removed when you close the test. You cannot save marked test elements. 

Right-click and select Clear Range  to remove the marks if you want to save the selected test 

elements again.

5. Optional: On the next page of the Save Selection as New Test  wizard, examine the changes to be 

performed as a result of the split.

Typically, you leave Link tests through variables  and HTTP Specific Changes  selected; clearing 

these options might make a split test unusable or produce unpredictable results. However, you can 

clear specific Link tests through variables  boxes if you do not want certain data to be correlated 

between the tests.
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6. Click Finish.

The new test is created from the selected elements. The test variables that are created by splitting a 

test are listed in the Variables Created by Split Test  container in the new test. For best results, open the 

Variables Created by Split Test  container in the new test and make sure that the variables are created 

and assigned with values by a test that is executed before the newly split test. For more information on 

test variables, see About test variables  on page  and Declaring and assigning test variables  on page 

.

The original test is marked if you select the Mark the selection in the editor  option. To remove the marks, 

right-click the selected elements in the original test and select Clear Range. You are also prompted to 

delete the new test. Click Yes  to delete the new test or No  to preserve it.

Be aware of the choices that you make when you split a test and rearrange the split tests in a schedule. 

Assume that the visitIBM recorded test contains the following actions:

• Logging on to a server.

• Creating an entry on the server and removing the entry.

• Editing an entry, validating that the change occurred, and restoring the entry.

• Logging off of the server.
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You want to split the test into four parts: Logon, Create, Edit, and Logoff. You need to split the test four 

times.

• Open visitIBM and select the logon actions. Name the new test Logon, which contains the Logon 

actions.

• Select the create actions. Name the new test Create.

• Select the edit actions. Name the new test Edit.

• Select the logoff actions. Name the new test Logoff.

You then create a schedule that runs virtual users selected from a dataset. Each virtual user runs the 

Logon test, performs various combinations of the Create and Edit tests, and finally runs the Logoff test.

Be aware, however, that when you split the tests, the Create test might have initialized variables that the 

Edit test uses. Therefore, if you reverse the order during the run (that is, run the Edit test before the Create 

test), make sure that the variables that the tests share are initialized and set correctly.

Related information

Splitting an HTTP test during recording  on page23

Splitting a test page
You can split an HTTP page into two contiguous pages. The page title, think times, primary request, and 

delay are automatically recalculated for the affected pages. Customized page titles, think times, primary 

requests, and delays revert to the default values.

When you inspect a test, you might notice that some page boundaries are not at the correct place. A 

common cause is that, during recording, you did not wait for the page to fully load. Although you can 

rerecord a test, if your test is long or complex, it is often easier to split the incorrect page when you edit 

the test, rather than to rerecord the entire test.

1. In the Test Navigator, browse to the test and double-click it.

The test opens.

2. In the test, expand the page that you want to split.

3. Right-click on the request where you want the split to occur, and select Split page here.

4. In the Split HTTP Page  window, you can change the location of the split by clicking on another 

page element.

You can also create a new page, combine the elements above the insertion point with the previous 

page, or combine the elements below the insertion point with the next page.
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5. To split the page, click Finish.

You can also set preferences so that new pages are generated when the delay exceeds a specified value. 

Click Window  > Preferences  >  Test  >  Test Generation  >  HTTP Test Generation, and click the Protocol 

tab. Enter a value for Generate new page if delay between requests is >.

Merging test pages
You can two or more contiguous HTTP pages into one page. The page title, think times, primary request, 

and delay are automatically recalculated for the affected pages. Customized page titles, think times, 

primary requests, and delays revert to the default values.
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When you inspect a test, you might notice that some page boundaries are not at the correct place. These 

extra pages are caused by a variety of reasons. For example, during recording you might hover over a 

"hotspot" that fetches images as you move on and off of the spot. In this case, some pages in the test, 

which properly belong to the previous page, contain only .gif files. Although you can rerecord a test in the 

hope of fixing this problem, if your test is long or complex, it is often easier to merge the incorrect page 

when you edit the test, rather than to rerecord the entire test.

1. In the Test Navigator, browse to the test and double-click it. 

The test opens.

2. Select the pages to merge (the pages must be contiguous) and select Merge Selected Pages

3. The Merge Pages  window lists the pages that you are merging. From this list, select the page that 

will contain the other pages.

4. Optionally, click Keep empty pages  to keep the same number of pages in the test. For example, if 

you select this option and merge two pages, one page will contain all of the requests and the other 

page will be empty.

You can also set preferences so that new pages are not generated when the think time is less than 

specified value. Click Window  > Preferences  >  Test  >  Test Generation  >  HTTP Test Generation, and 

click the Protocol  tab. Enter a value for Do not generate new page if think time is <.

Disabling and enabling secondary HTTP requests
You can disable all secondary requests within an HTTP performance test or a subset of requests in the 

test. Secondary requests are all requests within a page other than the primary request.

To disable other elements in tests or schedules (for any protocol), see Disabling portions of a test or 

schedule  on page .

1. In the Test Navigator, browse to the test, and double-click it. 

The test opens.

2. In the Test Element Details  area, click the HTTP Options  tab.

3. At Secondary request behavior, click Modify.

4. In the Enable or Disable Secondary Requests box, select one or more of the following options:

Option Description

All secondary Selects all secondary requests.
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Option Description

Images

Selects all secondary requests that are im

age-related. This selection includes all sec

ondary requests where the Content-type 

header of the response contains image  or the 

path of the URI of the request contains a .gif, 

 .png, .jpg, .bmp. or .tif extension.

Host/Port based

Selects all secondary requests that use the 

specified host:port pair for connections. A list 

of host:port pairs in the test is displayed.

User-defined

Selects all secondary requests where the 

user-specified string, or a string matching a 

user-specified regular expression, is in the re

quest URI.

5. You typically keep the boxes under Do not disable secondary requests  selected, which leaves them 

enabled.

However, if you have extensive knowledge of the system under test and have already done some 

troubleshooting, you might clear these boxes in the following cases:

• With responses containing set-cookie headers: If the cookies set in a particular request are 

not important to the remaining requests, you may disable them. This decision requires you 

to know how the system under test uses cookies.

• With data sources used by enabled requests: If a test contains superfluous data correlation, 

you may disable it. This decision requires you to know how the system under test uses data 

correlation.

6. Select Disable  or Enable  to modify the secondary requests.

The requests are now enabled or disabled.

Adding custom actions to requests
After an HTTP test is generated, you might want to add a few actions before or after a particular request 

is processed. For instance, for preprocessors, you can modify the headers before sending them to the 

server. Similarly, for postprocessors, you can extract data from the response and set it to a variable.

The actions to be processed must be coded in Java. Note that the pre processor is the last thing to 

be sent to the server after all the processing (data substitution) for the request is complete. Also, a 

postprocessor is the last thing to be received after all response processing is complete from the server.
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You can add preprocessors and postprocessors at the test level and at the request level. When they are 

added at both the levels, the ones at the request level takes precedence.

The preprocessors and postprocessors for the HTTP extension uses the following interfaces and 

methods:

• IHTTPRequestInterface: Use this interface to process an action before the request is processed.

◦ setURI: Use this method to set or change the URL that is sent to the server.

◦ getHeader: Use this method to get the name of the header that requires a value. If there are 

more than one header with the same name, only the first value is returned.

◦ removeHeader: Use this method to remove the name of the header.

◦ setHeader: Use this method to set the name and value for the header. If the header does not 

exist, it is created. If the header exists, the value is changed. If there is more than one header 

with the same name, only the first header is changed.

◦ getContent: Use this method to view the content of the header.

◦ setContent: Use this method to set the content for the header or to override the existing 

content in the header.

• IHTTPResponseInterface: Use this interface to process an action after the request is processed.

◦ getResponseContent: Use this method to view the content of the response. If the response 

content exceeds the specified limit, the content is truncated.

◦ getResponseHeader: Use this method to view the name of the header. If there are more than 

one header with the same name in the response, only the first header is returned.

◦ getReturnCode: Use this method to view the return code of the current response.

• IHTTPRequestCommonInterface: Use this interface for both request and response interfaces.

◦ getURI: Use this method to view the current URI of the request.

◦ getHeaders: Use this method to view all of the headers associated with the request for pre 

processing or all of the headers associated with the response for post processing.

Preprocessor for the HTTP extension

The following is the sample code for the preprocessor for the HTTP extension:

package customproc;

 

import com.ibm.rational.test.lt.kernel.services.ITestExecutionServices;

import com.ibm.rational.test.lt.execution.http.external.IHTTPRequestPreProcessor;

import com.ibm.rational.test.lt.execution.http.external.IHTTPRequestInterface;

 

/**

 * @author Sample Provider
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 */

public class mypreproc implements com.ibm.rational.test.lt.execution.http.external.IHTTPRequestPreProcessor {

 

 /**

  * Instances of this will be created using the no-arg constructor.

  */

 public mypreproc() {

 }

 

 /**

  * For javadoc select 'Help Contents' in the

  * Help menu and select 'Extending Rational Performance Tester  functionality' -> 'Extending test execution with custom 

 code'

  */

 public void exec(ITestExecutionServices tes,

   com.ibm.rational.test.lt.execution.http.external.IHTTPRequestInterface arg) {

  // IHTTPRequestInterface allows users to interact with the HTTP request before the request is sent. 

  // This is the last thing to happen before the request is sent to the server

  // Users also have the full capability of the tes methods that can be used in custom code.  You can store values in 

  // user data area to retrieve at a later time, logging, and many other things

  

  // User can retrieve and manipulate header values

  arg.getHeader("Content-Type");  // users can get a header value

  arg.setHeader("sessionId", "123");  // users can add a header or change a header value by calling setHeader

 

  // User can retrieve and manipulate POST/PATCH/PUT content

  arg.getContent(1);  // This is used to retrieve the POST/PATCH/PUT data associated with a request.  

  // In the case of multi-part mime there can be more than one "chunk".  Specify the number of the chunk of data you 

 would like

  

  arg.setContent(1, "This is the content I really wanted"); // user can override what is in the POST data chunk with 

 anything they would like

 

  // User can get and set the URI

  arg.getURI(); // retrieve the current URI

  arg.setURI("/myURIIsGreat/go");
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  return;

 }

 

}

Postprocessor for the HTTP extension

The following is the sample code for the postprocessor for the HTTP extension:

package customproc;

 

import java.util.List;

 

import com.ibm.rational.test.lt.execution.http.external.HTTPHeaderData;

import com.ibm.rational.test.lt.kernel.services.ITestExecutionServices;

 

/**

 * @author Sample Provider

 */

public class mypostproc implements com.ibm.rational.test.lt.execution.http.external.IHTTPRequestPostProcessor {

 

 /**

  * Instances of this will be created using the no-arg constructor.

  */

 public mypostproc() {

 }

 

 /**

  * For javadoc select 'Help Contents' in the

  * Help menu and select 'Extending Rational Performance Tester  functionality' -> 'Extending test execution with custom 

 code'

  */

 public void exec(ITestExecutionServices tes,

   com.ibm.rational.test.lt.execution.http.external.IHTTPResponseInterface arg) {

  // Users can retrieve information from the response directly without having to create references

  

  List<? extends HTTPHeaderData> hdrs = arg.getHeaders(); // this returns the entire list of headers

  for (HTTPHeaderData hdr: hdrs){

   if (hdr.name.equals("MyHeader")) {
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    // do some processing. // maybe store value in a variable to use later

    tes.setValue("MyVar", ITestExecutionServices.STORAGE_USER, hdr.value);

    break;

   }

  }

  // the alternative to above is to instead just call directory with the header name you want

  arg.getResponseHeader("MyHeader");

  

  // you can get the response content and perform some kind of data extraction on it

  arg.getResponseContent();

  

  // you can evaluate the return code and do what you want with it. Maybe make a custom counter and report it

  arg.getReturnCode();

  

  return;

 }

 

}

To add a preprocessor or postprocessor:

1. Select a request in the Test Content  area of the Test editor.

2. Click the Advanced  tab in the Test Details  area of the Test editor.

3. Click Create  in Preprocessor  to add a custom action before a request is processed.

4. Specify a name for the Java file, and then click Finish.

A new Java file opens. Add the custom actions to be processed before the request and save the 

file.

5. Click Create  in Postprocessor  to add a custom action after a request is processed, and then follow 

step 4  on page 179.

You can now run the test to verify if the actions specified in preprocessors or postprocessors returned 

expected results.

Reusing tests on different hosts: Server connection variables
Your tests represent a significant investment in time and effort. You can share or reuse them for different 

configurations and web hosts by changing the variables for the host name and port.
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Before you begin, confirm that test generation preferences are set to support data correlation. Click 

Window  > Preferences  >  Test  >  Performance Test Generation  >  HTTP Test Generation, click the Data 

Correlation  tab, and verify that Automatically correlate host and port data  is selected. If not, select that 

option and regenerate the test.

Perhaps you develop the tests on a lab computer and then they want to run them on a production server. 

If the application that you are testing is identical on both computers, you can change the host name and 

reuse the tests on the production server.

To change the name of the host or proxy server on all requests in a test:

1. In the Test Navigator, browse to the test and double-click it. The test opens.

2. Expand the Test Variable  section at the top of the test, and click the Server Connection variable 

that contains the hostname that you want to change.

3. In the Test Element Details  area, perform the following steps:

a. Type the new host name in the Host  field.

b. Optional: Type a new port number in the Port  field.

The new hostname and port combination is correlated to the test variable, which contains the value 

currently being used.

Note:  To change the host names and ports of many tests, put the server connection variable in a 

dataset and associate the dataset with the tests. When you change the name and port in the dataset, that 

change is propagated throughout the tests in the dataset. For more information, see Creating a dataset 

associated with a test  on page .

Related information

About test variables  on page

Converting tests to use SSL connections
You can convert a test that was recorded without Secure Sockets Layer (SSL) connections to use SSL 

connections.

If you develop performance tests on a lab computer that does not use secure connections, and then you 

must run the tests against a production server that requires SSL connections, you can add SSL to the 

server access configurations and reuse the tests.

To convert a server access configuration to use SSL for all associated connections:
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1. In the Test Navigator, browse to the test, and double-click it. The test opens.

2. Expand the Test Resources  section at the top of the test.

3. Right-click the server access configuration that corresponds to the server where you want to add 

SSL, and then click Add  > SSL.

An SSL element is added as a child of the server access configuration.

4. In the Test Element Details  area for the server access configuration, type a new number in Port 

if the server uses a different port for SSL communication. If the port number is correlated with 

a server connection variable, select the port number, right-click, and select Go To  > Variable: 

variable_name  to navigate to the variable. Change the port number in the server connection 

variable.

5. In the Test Element Details  area for the SSL element, make a selection in Protocol, and type or 

select a name in Cipher.

6. Repeat the same steps for all server access configurations to convert to use SSL.

When you run the test, the connections that are associated with the server access configurations use SSL.

Related information

About test variables  on page

Working with Server Name Indication (SNI) recordings
If you have recorded against a server that supports Server Name Indication (SNI), an extension of the 

TLS protocol, the recording session file displays true  for the SNI Extension  field. There might be a need 

for you to access both SNI and non-SNI applications from the same server. To run the same test without 

using the SNI extension, you can manually change the value to false.
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The Server Access Configurations  resource of the test script also have SSL entries. Each SSL entry 

displays which TLS version and Cipher value was used. To edit multiple SSL entries, select them and in 

the Detail area, right-click the entries and click Edit multiple SSLs.

Related information

Web service test editor overview  on page223

Verifying application behavior  on page225

Adding elements to a service test  on page237

Managing JMS/MQ connections in a service test  on page241

Editing WSDL security profiles  on page242

Testing asynchronous services  on page262

Creating a reliable messaging call structure  on page266

Viewing a test in the Protocol Data view
The Protocol Data view enables you to inspect the actual test data. You can see requests, response 

headers, and response contents, as well as the rendered images that you see through your browser. Use 

this view to obtain the information you need to add custom code or to manually correlate data. This view 

also lets you compare the recorded data with the data retrieved during a run.
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1. In the Test Navigator, browse to the test and double-click it. 

The test opens.

2. Click the Protocol Data  tab to open the view.

Tip:  If you cannot locate the Protocol Data  tab, click Window  > Show View  > Protocol Data.

3. In the test, click the line that corresponds to the page, request, or response that you want to view.

4. In the Protocol Data view, click the tab that corresponds to the type of data or view of interest.

The selected data is displayed in the Protocol Data view.

If you have problems during playback, you can compare the data that was recorded with the data that was 

retrieved during the run. For information on displaying the data retrieved during the run, see Inspecting 

HTTP test logs in the Protocol Data view  on page .
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Related information

Managing HTTP information in the Protocol Data view  on page

Inspecting HTTP test logs in the Protocol Data view  on page

Testing Siebel applications
When you record a Siebel application, a Siebel-specific test is automatically generated. However, before 

you run this test, install the Siebel Test Automation library and edit the test to use built-in Siebel variables.

Note:  Rational®  Performance Tester  64-bit workbench does not support testing Siebel applications.

Prerequisites for Siebel testing
To test Siebel applications, the Siebel Test Automation and the Microsoft™  C++ runtime libraries must be 

installed on the workbench computer.

Siebel applications run only on Windows™  operating system, therefore you must run the Siebel tests only 

on Windows™. You must not add a Siebel test to a schedule that you deploy to run on operating systems 

other than Windows™.

Note:  Rational®  Performance Tester  64-bit workbench does not support testing Siebel applications.

To install the prerequisites for testing Siebel applications:

1. Obtain the Siebel Test Automation library, ssdtcorr.dll, from Siebel.

2. Copy the ssdtcorr.dll  file to the workbench computer in this path: , where is the product 

installation directory.

If the Siebel Test Automation library is not installed, Siebel tests will fail, and a warning message 

will display when you edit a Siebel test. After the library is installed on the workbench computer, it 

is automatically deployed as needed to any remote location. The library must be on any computer 

that runs a Siebel test.

You can use the rptExternal  variable in the config.ini  file to control where external files must 

be installed. By default, the rptExternal  variable is set to the product installation directory. Edit the 

rptExternal  variable if you want to install the .dll files to a different location.
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For example, if you set the rptExternal  variable to then you would install the Siebel Test Automation 

library in e:\ibm\sdp\rpt\external_files\deployable\siebel\. Note that you must use 

an extra backslash before the colon and backslashes in the path.

3. Copy the appropriate Microsoft™  C++ runtime library to the workbench computer in the same 

directory as the ssdtcorr.dll  file. Recent version of ssdtcorr.dll  (Version 8.1.1.14 for example) 

require msvcr110.dll. Older versions of ssdtcorr.dll  (like Version 7.7.0.0) need msvcr70.dll.

To download the appropriate Visual C++ runtime library from the Microsoft™  web site, download 

the Windows Server 2003 Resource Kit Tools for msvcr70.dll  or the Visual C++ Redistributable for 

Visual Studio 2012 to get msvcr110.dll. The file name is case-sensitive, and must be all lower-case. 

The file must be named msvcr70.dll, not MSVCR70.DLL

Once installed in the correct directory on the workbench computer, the Microsoft™  C++ runtime 

library is automatically deployed as needed to any remote location.

Related information

Differences between Siebel tests and HTTP tests  on page185

Correlating a request value with a built-in Siebel variable  on page186

Differences between Siebel tests and HTTP tests
Siebel tests precisely designate dataset candidates, include an additional type of data source, and store 

variables in a proprietary data structure. In addition, page names are created during test generation to 

help you find pages of interest.

The primary difference between a Siebel test and a standard HTTP test is in how dynamic data is stored 

and substituted during a test run:

• In a standard HTTP test, a data source (dataset variable, custom code, or a reference) is linked 

to a test value that is replaced at run time. Siebel tests support standard HTTP data sources 

and substitution. Datasets, which are explained in Providing tests with variable data  on page 

, work the same way in Siebel tests as in standard HTTP tests, but the dataset candidates 

in Siebel tests are more precisely designated than in standard HTTP tests. In many cases, dataset 

substitutions are the only changes that you need to make to a Siebel test.

• In a Siebel test, an additional type of data source, which is called a built-in data source, contains 

variables that you can use to replace a test value.
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These variables can be substituted for dates (in defined formats), time stamps, and counters 

throughout tests. In some cases, SWE Unique Value  can be used as an alternative to a dataset; for 

example, to supply variable account names. For detailed instructions, see Correlating a request 

value with a built-in Siebel variable  on page 186.

Siebel variables are stored in a proprietary data structure called a star array. A star array stores both 

strings and their length in hexadecimal format (length_string) or integer format (length*string). Siebel 

substituters have a method for substituting data and recomputing the length. You can substitute from 

a value in a star array (highlight a length_string or length*string format value, right-click, and then click 

Substitute). You are then asked whether you want a Siebel substitution or a standard HTTP substitution. 

You typically select Siebel data correlation.

Siebel tests are organized inside the test editor much like standard HTTP tests, but with some differences 

for pages:

• The first page of a Siebel test is named Message Bar, which emulates the ticker-tape message that 

Siebel application pages display.

• Page names are created during test generation to help you find pages of interest. For example, a 

typical change to make to a test before running it is to replace the user name and password that 

you typed during recording with values in a dataset. As shown in the example, the page from which 

you logged into the Siebel server is named Login - Send UserName/Password, to help you find this 

page quickly.

Related information

Prerequisites for Siebel testing  on page184

Correlating a request value with a built-in Siebel variable  on page186

Correlating a request value with a built-in Siebel variable
If you are editing a Siebel test, you can correlate request values with built-in Siebel variables.

To correlate a request value with a built-in variable:

1. In the Test Navigator, browse to the test and double-click it. 

The test opens.

2. Locate the value that should be replaced by a built-in variable.

3. Highlight the value: with the left mouse button pressed, drag your mouse over it.
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4. Right-click the highlighted value and click Substitute from  > Built-in data sources.

The Built-in Datasource Selection wizard displays the types of variables that can be substituted.

5. Select the type of variable and click either Next  or Finish.

• If you select Current Date, click Next, select the date format, and then click Finish.

• If you select SWE Counter, click Next, type values for the counter in the Current Value  and 

Maximum Value  fields, and then click Finish.

Related information

Prerequisites for Siebel testing  on page184

Differences between Siebel tests and HTTP tests  on page185

Editing SAP tests
After you record a test, you can edit it to include variable data (rather than the data that you recorded) and 

verification points (to confirm that the test runs as expected).

SAP test editor overview
You use the test editor to inspect or customize a SAP performance test that you recorded.

The test editor lists the SAP transactions for a test, by title. The following example shows the test 

MySAPTest, which was generated from a recording of these tester actions: logon to the server, launch a 

Material Master Display transaction (mm03), view the Basic Data screen for the item SCREW, and stop 

recording.
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There are two main areas in the test editor window. The area on the left, Test Contents, displays the 

hierarchy of the SAP transactions for the test. The area on the right, Test Element Details, displays details 

about the currently selected item (transaction or event) in the test hierarchy. In the preceding example, 

Test Element Details  displays information about the test because the name of the test, MySAPTest, is 

selected in the Test Contents  area.

When you expand a test transaction, you see a list of SAP screens. Each SAP screen corresponds to a 

new page or window in SAP GUI and is reflected by the screen capture in the SAP Protocol Data  view.

When you expand a SAP screen, you see the SAPGUI events for the screen, with names that describe the 

action. The following example shows the Material Master Display (mm03) transaction expanded with the 

SAP Easy Access screen. The set event that described the mm03 text input in the SAP GUI is selected in 

the Test Contents  area.
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Values can sometimes be highlighted in green. This highlighting indicates that these requests contain one 

or both of the following types of information:

• A dataset candidate:  This is a value, usually one specified by the tester during recording, that the 

test generator determined is likely to be replaced by values in a dataset. An example of a dataset 

candidate is a string that you search for in a recorded test. The string is highlighted as a dataset 

candidate on the assumption that, before playback, you might want to associate the string with a 

dataset column containing appropriate substitute values..

• Correlated data:  These are values in a test, usually one of them in a response and the other in 

a subsequent request, that the test generator determined needed to be associated in order to 

ensure correct test playback. An example is a material price returned to the browser by a test that 

searches a material database. The test generator automatically correlates material names with 

prices. Suppose that, before running the test with many virtual users, you replace the material 

name searched for in the recorded test with names in a dataset. Because the test correlates the 

data, each virtual user searches for a different material, and the server returns an appropriate price.

To see an illustration of color coding in performance tests or to change the color settings, click Window > 

Preferences > Test > Performance Test Editor, and then click the Fonts and Colors  tab.

189



Test Author Guide

190

The Response  data inside each request shows the data that the SAP server returned to the browser based 

on that request.

Click Add  to add elements to the selected test element. Alternatively, you can right-click a test element 

and select an action from a menu. The choices that you see depend on what you have selected. For 

example, after you select a test, you can add a new event.

The Insert  button works similarly. Use it to insert an element before the selected element.

The other buttons (Remove, Up, Down), are primarily for use when substantially modifying a test; these 

actions or choices are likely to break a recorded test. The types of structures that are commonly used 

in recorded tests are explained in Adding verification points to a SAP test  on page 191 and Adding 

elements to a SAP test  on page 194.

The test editor synchronizes with the SAP Protocol Data  view. When you select a test element in the 

test editor, the corresponding screen is displayed as a screen capture in the SAP Protocol Data  view. If a 

specific SAP GUI object is related to the test element, the object is highlighted in the SAP Protocol Data 

view. You can also right-click SAP GUI objects in the SAP Protocol Data  view to add associated events or 

verification points to your test.

Sometimes, the area of the editor where you need to work is obscured. To enlarge an area, move your 

cursor over one of the blue lines until your cursor changes shape (to a vertical line with an up arrow at the 

top and a down arrow at the bottom) and drag up or down while holding the left mouse button.
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Related information

Verifying expected behavior  on page191

Adding elements to an SAP test  on page194

Splitting an SAP test  on page201

Viewing GUI data in the SAP Protocol Data view  on page202

Verifying expected behavior
To check whether an expected behavior occurred during a run, you can add verification points. When you 

run a test that contains a verification point, an error is reported if the expected behavior did not occur.

Related information

SAP test editor overview  on page187

Adding elements to an SAP test  on page194

Splitting an SAP test  on page201

Viewing GUI data in the SAP Protocol Data view  on page202

Adding an SAP verification point
With SAP get and SAP call elements, you can retrieve a value from the SAP GUI to create verification 

points on an SAP screen element.

When you add SAP verification points, SAP get elements, and some SAP calls, retrieve the data from 

objects in the SAP GUI, such as windows or text fields. SAP get and SAP call elements are contained in 

SAP screens in the test suite. SAP screens can be windows, dialog boxes, or transaction screens that are 

part of a recorded transaction.

You can use either the test editor or the SAP Protocol Data  view to create or edit SAP get and SAP call 

elements and place verification points on them. When using the SAP Protocol Data  view, you can select 

SAP screen elements from the screen capture to specify the SAP GUI identifier for the get event. Using 

this method to create or edit an SAP verification point is easier than adding it manually from the test 

editor.
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The SAP Protocol Data  view contains two pages that are synchronized with each other and with the test 

editor:

• Screen Capture  displays a graphical screen capture of the SAP GUI. You can select all GUI objects 

such as windows, buttons, fields or areas.

• Object Data  provides information about the selected GUI object: identifier, type, name, text, tooltip, 

and subtype.

1. Open the test editor and the SAP Protocol Data  view.

If the SAP Protocol Data  view is not open, click Window  > Show View  > Other  > Test  > SAP 

Protocol Data.

2. In the Test Contents  area of the test editor, expand a transaction and an SAP screen.

The SAP Protocol Data  view displays a screen capture of the selected transaction.

3. Inside the transaction, select the item for which you want to enter a new value.

The Screen Capture page of the SAP Protocol Data view displays the screen capture of the SAP 

GUI with the corresponding GUI object highlighted in red.

4. In the SAP Protocol Data view, right-click the GUI field that you want to verify, and then select 

Create Verification Point.

If you want to create an advanced verification point using an SAP GUI call method, then you can 

select Create Element  instead.

5. In the Create Verification Point  or Create Element  window, specify the expected value for the 

verification point.

• If you want to verify a text value in the SAP GUI object, ensure that Verify text  is selected, 

and type the Expected value  that you want to verify; then click Finish.

• If you want to verify advanced properties of the SAP GUI object, you can select Advanced, 

and then specify the properties attached to the GUI object as well as the Expected values. 

Refer to SAP documentation for information about these properties.

• If you selected Create Element  to create a verification point on an SAP call, then select 

Advanced, choose an Element type  that returns a value, and then specify the properties 

attached to the GUI object. Refer to SAP documentation for information about these 

properties.

After creating the event, you can use the test editor to easily change the value. You can also enable and 

disable SAP verification points on SAP get and SAP call elements in the test editor.
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Related information

Specifying an expected screen title  on page193

Verifying response times  on page193

Specifying an expected screen title
Screen title verification points report an error if the title of an SAP screen is different from what you 

expected.

1. Select the SAP screen in the test editor and ensure that screen title verification is enabled for the 

SAP screen.

The Test Element Details  area includes a Screen Title Verification Point  section.

• If screen title verification was enabled for the entire test, the Enable verification point  check 

box is selected for all SAP screens in the test.

• If screen title verification was enabled for a specific SAP screen, the Enable verification 

point  check box is selected for the selected SAP screen.

You can enable or disable screen title verification for a specific SAP screen in the test editor by 

selecting or clearing the Enable verification point  check box.

2. Ensure that the Expected screen title  field shows the string that you expect to be included in the 

page title that is returned when this page is loaded.

When the test was recorded, SAP returned a default title for this screen. This value is displayed 

in the Recorded title  field, and is automatically copied to the Expected page title  field when the 

Enable verification point  check box is selected. You can change the string in the Expected page 

title  field as needed.

Whenever the test runs with page title verification enabled, an error is reported if the title returned 

for the page does not contain the expected title. Although the comparison is case-sensitive, it 

ignores multiple white-space characters (such as spaces, tabs, and carriage returns).

Related information

Adding an SAP verification point  on page191

Verifying response times  on page193
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Verifying response times
SAP request response times measure the delay between the moment the user submits a server request 

and the moment the server responds. Response time data is provided by the server. You can set a 

verification point on a response time threshold value. If the test encounters a response time above the 

threshold, the verification point is failed.

When the Verification points for SAP request response time threshold  option is selected in the SAP 

Test Generation preferences, all SAP server request elements contain a response time verification point. 

The default threshold value is calculated by applying a multiplier to the recorded response time. You can 

change the default multiplier in the SAP Test Generation preferences. The response time measurements 

are displayed in the SAP server request element, which is the last element in an SAP screen.

To define a response time verification point:

1. In the test editor Test Content  area, select an SAP server request element inside an SAP screen 

element.

2. In the Test Element Details, select Enable verification point, and then enter the Response time 

threshold  in milliseconds.

If the test encounters a response time that is higher than the threshold, the verification point is 

failed.

Related information

Adding an SAP verification point  on page191

Specifying an expected screen title  on page193

Adding elements to an SAP test
You can add a variety of elements to an SAP performance test, such as loops, conditions, SAP set, 

verification point or sequence elements.

Related information

SAP test editor overview  on page187

Verifying expected behavior  on page191
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Splitting an SAP test  on page201

Viewing GUI data in the SAP Protocol Data view  on page202

Adding an SAP set, SAP get, or SAP call element
You can use SAP set, SAP get, or SAP call elements in performance tests to add items such as a field 

selection, a keyboard entry, a get element for reference use, or any advanced interaction with the SAP 

client GUI.

SAP set elements represent user interactions with the SAP GUI, such as entering a value into a field. SAP 

set elements are contained in SAP screen elements. SAP screen elements can be windows, dialog boxes 

or transaction screens that are part of a recorded transaction.

SAP get elements enable you to retrieve information from the SAP GUI, such as field values. SAP get 

elements are contained in SAP screen elements. The primary use of an SAP get element is to create a 

reference field or a verification point in the test. An SAP verification point is actually an SAP get element 

with a verification point enabled.

SAP call elements represent all the various user interactions that are neither an SAP set or an SAP get 

element. For example, selecting an object, scrolling, or pressing the Enter key generates an SAP call.

You can use either the test editor or the SAP Protocol Data  view to create or edit SAP set, get, or call 

elements. When using the SAP Protocol Data  view, you can select SAP screen objects from the screen 

capture and copy the information directly to the new SAP set, get, or call element. Using the SAP Protocol 

Data  view to create or edit an SAP event is much easier than adding an event manually from the test 

editor.

The SAP Protocol Data  view contains two pages that are synchronized with each other and with the test 

editor:

• Screen Capture  displays a graphical screen capture of the SAP GUI. You can select all GUI objects, 

such as windows, buttons, fields or areas.

• Object Data  provides information about the selected GUI object: identifier, type, name, text, tooltip, 

and subtype.

To add an SAP set, get, or call element:

1. Open the test in the test editor and the SAP Protocol Data  view.

If the SAP Protocol Data  view is not open, click Window  > Show View  > Other  > Test  > SAP 

Protocol Data
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2. In the Test Contents  area of the test editor, expand a transaction and an SAP screen.

The SAP Protocol Data  view displays a screen capture of the selected transaction.

3. Inside the transaction, select the item for which you want to enter a new value.

The Screen Capture  page of the SAP Protocol Data  view displays the screen capture of the SAP 

GUI with the corresponding GUI object highlighted.

4. In the SAP Protocol Data  view, right-click the GUI object for which you want to create the SAP set, 

get, or call element, and then click Create Element.

This opens the window, which already contains the Identifier  from the recorded session.

5. In the Create Element  window, specify the type of SAP element that you want to create. Enter the 

value that you want to add, and then do one of the following procedures, depending on your testing 

objectives:

• To create a simple SAP set element, select Set text, and then type the text value that you 

want to input into the SAP GUI.

• To create an SAP get or an SAP call element, select Advanced, and then select SAP Set, or 

SAP Call  in the Element type  list. Use a SAP set to input a value into the SAP GUI client. Use 

a SAP call to call a method for advanced interaction with the SAP GUI. Specify the property 

to get or the method of the call. Refer to SAP documentation for information about SAP call 

methods and properties. SAP call elements are created with default values that you can 

change in the test editor. You can use SAP call methods to define a verification point or for 

data correlation.

• To create a non-text SAP set element, select Advanced, and then select SAP Set  in the 

Element type  list. Specify the property to set and enter a value if that property requires one.

6. Click Finish.

After creating elements, you can use the test editor to change values. You can also replace values with a 

dataset variable or a reference.

Related information

Adding an SAP sequence element  on page196

Adding a batch input transaction  on page198

Adding a verification point to an SAP GUI Grid View object  on page199

Adding an SAP sequence element
You can use SAP sequence elements to specify complex interactions with the SAP GUI that involve 

multiple actions within a single object.
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SAP sequence elements represent complex user interactions with the SAP GUI, and contain multiple 

SAP set, get, or call child elements where each child element of the sequence is an action that relies on 

the return result of the preceding child element. In most cases, SAP sequences are recorded when you 

interact with complex SAP GUI objects. However, with advanced knowledge of the SAP API, you can use 

SAP sequences to create complex actions or verification points.

SAP sequence elements are contained in SAP screen elements.

You can use either the test editor or the SAP Protocol Data  view to create or edit SAP sequences. When 

using the SAP Protocol Data  view, you can select SAP screen objects from the screen capture and copy 

the information directly to the new SAP sequence element.

The SAP Protocol Data view contains two pages that are synchronized with each other and with the test 

editor:

• Screen Capture  displays a graphical screen capture of the SAP GUI. You can select all GUI objects 

such as windows, buttons, fields or areas.

• Object Data  provides information about the selected GUI object: identifier, type, name, text, tooltip, 

and subtype.

1. Open the test in the test editor and the SAP Protocol Data  view.

If the SAP Protocol Data  view is not open, click Window  > Show View  > Other  > Test  > SAP 

Protocol Data

2. In the Test Contents  area of the test editor, expand a transaction and a SAP screen.

The SAP Protocol Data  view displays a screen capture of the selected transaction.

3. Inside the SAP screen, select where you want to enter the new sequence.

The Screen Capture  page of the SAP Protocol Data  view displays the screen capture of the current 

SAP screen.

4. In the SAP Protocol Data  view, right-click the SAP GUI object for which you want to create the SAP 

sequence element, and then click Create Element.

This opens the Create Element  window, which already contains the Identifier  from the recorded 

session.

5. Select Advanced, select SAP Sequence  in the Element type  list, and then click Finish.

6. In the Test Contents  area of the test editor, select the SAP sequence and click Add  > Element  to 

add a SAP set, get, or call element to the SAP sequence.

7. In the Test Contents  area of the test editor, select the SAP sequence, and then click Add  or Insert 

to add sequence child elements as required. In the Create Element  window, use the Cast  button to 

cast the results of the previous child element to match the expected input type. See the SAP API 

documentation for detailed information on SAP objects and calls.
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Related information

Adding an SAP set, SAP get, or SAP call element  on page195

Adding a batch input transaction  on page198

Adding a verification point to an SAP GUI Grid View object  on page199

Adding a batch input transaction
You can import batch input transactions that were recorded from the SAP GUI into an SAP batch input 

test. A batch input test can contain multiple batch input transactions.

You can add batch input transactions only to a batch input test, not to a regular SAP performance test. 

First create a new batch input test.

Batch input tests access the SAP server at a low level, bypassing the SAP GUI interface, and therefore 

cannot contain any verification points or SAP GUI elements. Their main purpose is to simulate a load on 

the server when added to a test schedule that already contains SAP performance tests. Only the SAP 

performance tests provide accurate SAP application performance measurement.

To add an SAP batch input transaction to a batch input test:

1. Open the batch input test in the test editor.

2. In the Test Contents  area of the test editor, right-click the test node, and click Add  > Transaction.

Placing the batch input transaction inside a transaction is not mandatory, but it is a good practice, 

because the performance report shows the results for each transaction separately.

3. Right-click the transaction and click Add  > SAP Batch Input Transaction.

This opens the SAP Batch Input File Selection  window.

4. Select a batch input transaction file that was recorded with the SAP GUI batch input recorder, and 

then click Open.

After creating elements, you can use the test editor to change values. You can also replace values with 

a dataset variable or a reference. You can also place the batch input transaction inside a loop to make it 

repeat several times during the test.
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Related information

Adding an SAP set, SAP get, or SAP call element  on page195

Adding an SAP sequence element  on page196

Adding a verification point to an SAP GUI Grid View object  on page199

Adding a verification point to an SAP GUI Grid View object
You can add a verification point to an SAP object in the SAP GUI Grid View to verify the state of the SAP 

object after the SAP recording is complete.

• Verified that SAP GUI scripting is enabled on the SAP server and the SAP GUI client. See 

Configuring SAP for performance testing  on page .

• Working SAP GUI client that you can connect to an SAP server.

When you record an SAP test, the recording wizard displays the SAP GUI client and records all the 

interactions that occur in the SAP client. The SAP Protocol Data  tab in the test editor displays a screen 

capture of the selected transaction in an SAP GUI Grid View.

Note:  The SAP GUI Grid View presents a tabular view of the SAP cell entries.

You can then add verification points to an SAP cell entry and save the test. After you save the SAP test, 

you can run the test and verify the verification point details.

You must install the latest version of SAP GUI when you want to record an SAP test in Rational® 

Performance Tester. For more information about supported SAP GUI versions, see System Requirements 

on page .

1. Open Rational®  Performance Tester.

2. Click the New Test From Recording  icon , and then click SAP Test.

The Select Location  page is displayed.

3. Create a test by performing the following steps:

a. Select a project, and then select a folder from the project.

b. Enter a name for the test.

c. Optionally, click Recording encryption level, and then select the encryption level when you 

are recording any sensitive data.

4. Click Next.

The Select Client Application  page is displayed.
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5. Click SAPGUI For Windows, and then select Next.

The SAP Connection  page is displayed.

6. Enter the SAP connection details on the SAP Connection  page by performing one of the following 

methods:

• Select SAP Logon, and then select the SAP connection name from the SAP system name 

drop-down list.

Note:  You must have created an SAP system connection entry on the SAP Logon  page.

• Select Service information, and then enter the information provided by the SAP 

administrator for the fields specified in the following table:

Fields Action

Application server Enter the SAP application server IP or 

hostname.

System number Enter the system number that corre

sponds to an SAP instance of the SAP 

server (For example, 00).

7. Click Finish.

The SAP GUI  window is displayed.

8. Record an SAP transaction with a screen that contains a Grid View (For example, SM04).

9. Select a column (For example, User ID) after you record the SAP transaction, and then select Sort 

in Descending Order  to sort the entries in descending order.

10. Click User  > Exit  or Close  to exit the SAP GUI Transaction  page.

11. Close the SAP session.

A Test Generation Progress  window is displayed while the test is being generated.

The following message is displayed on the progress window: Test Generation completed.

12. Select Open Test.

The test is displayed in the test editor.

13. Select an SAP element from the Test Contents  section.

The Screen Capture  in the SAP Protocol Data  tab displays the transaction details that you selected, 

in the SAP GUI Grid View.

Note:  If the SAP Protocol Data  tab is not open, click Window  > Show View  > Other  > Test  > 

SAP Protocol Data  to open the SAP Protocol Data  tab.

14. Right-click a cell entry from the SAP GUI Grid View object, and then click Create Verification Point.

The Create Verification Point  dialog box is displayed.
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15. Verify the expected value of the verification point, and then click Finish.

16. Save the test.

You have added a verification point to an SAP object in the SAP GUI Grid View of a recorded SAP test.

You can run the SAP test and verify the execution details of the verification point from the following 

pages:

• SAP Summary  tab in the SAP Statistical Report  page

• SAP Verification Point Report  page

• Test Log  page

Related reference

SAP Performance report  on page

Related information

Adding an SAP set, SAP get, or SAP call element  on page195

Adding an SAP sequence element  on page196

Adding a batch input transaction  on page198

Splitting an SAP test
After you record a test, you can split it into smaller tests. Splitting tests enables you to create modular 

building blocks of smaller tests and combine them to make bigger tests. The original test is unchanged. 

You can recombine these building blocks in a schedule, including loops and conditions.

When reusing split tests in a schedule, you must ensure that the general test structure is consistent 

including SAP session logon and logoff details. For example, if split test a  contains the session logon 

details and split test c  contains the logoff transaction, you must place them in the correct order in the 

schedule user group.

SAP tests can be split only at the transaction level. When the test is executed in the schedule, it must start 

with a SAP logon transaction and end with a SAP logoff transaction.

1. In the Test Navigator, browse to the test and double-click it. The test opens.

2. Right-click a SAP transaction in the test, and select Split Test. The page that you click is the first 

page of the new test.
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3. In the New Test Names  window, confirm the location of the split, optionally provide names and 

descriptions for the split tests, and click Next.

4. In the Split Test  window, examine the changes to be performed as a result of the split, and click 

Finish.

For example, you could record a test that contains the following actions:

• Logging on to a server.

• Creating an entry on the server and removing the entry.

• Editing an entry, validating that the change occurred, and restoring the entry.

• Logging off of the server.

You then split the test into four parts: Logon, Create, Edit, and Logoff. You create a schedule that 

runs virtual users selected from a dataset. Each virtual user runs the Logon test, performs various 

combinations of the Create and Edit tests, and finally runs the Logoff test.

Related information

SAP test editor overview  on page187

Verifying expected behavior  on page191

Adding elements to an SAP test  on page194

Viewing GUI data in the SAP Protocol Data view  on page202

Viewing GUI data in the SAP Protocol Data view
The SAP Protocol Data view provides a graphical view of screens as they are displayed in the SAP GUI. In 

addition, it provides a view of the SAP GUI object data. The data displayed in the SAP Protocol Data view 

is synchronized with the test elements selected in the test editor.

To view test contents in the SAP Protocol Data view:

1. Open the test.

2. Click the SAP Protocol Data  tab to activate the view.

As shown in the example, the tab color changes to blue and the tabs for the Protocol Data view are 

displayed.

If you cannot locate the SAP Protocol Data  tab, you can open this view by clicking Window  > Show 

View  > Other  > Test  > SAP Protocol Data.
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3. In the test editor, click the line corresponding to the transaction, screen or SAP event that you want 

to view.

4. In the SAP Protocol Data  view, click the tab corresponding to the type of data or view of interest.

• Clicking Screen Capture  opens a page that displays the corresponding screen as recorded 

in the SAP GUI client. If a SAP event is selected, the corresponding field, button or GUI object 

is highlighted in red.

• Clicking Object Data  opens a page that displays the SAP GUI object data for the 

corresponding object. This data can be used to identify the object in a test element.

Related information

SAP test editor overview  on page187

Verifying expected behavior  on page191

Adding elements to an SAP test  on page194

Splitting an SAP test  on page201

Editing Citrix tests
After you record a test, you can edit it to include variable data (rather than the data that you recorded), 

verification points (to confirm that the test runs as expected), transactions, conditional processing, and 

custom code.

Citrix test editor overview
With the test editor, you can inspect or customize a test that you recorded.

The test editor lists the window events for a test, in sequential order. New windows are displayed in bold. 

The Windows™  operating system assigns each window an ID number. This number changes on each 

execution of the test, but usually remains the same within the test, providing a means of identifying each 

window object.

Note:  In some cases, the operating system recycles destroyed window IDs. The test recorder 

identifies these properly by appending an extra number at the end of the window ID if necessary.

There are two main areas in the test editor window. The area on the left, Test Contents, displays the 

chronological sequence of events in the test. The area on the right, Test Element Details, displays 
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details about the currently selected item (window, mouse event, key event, or screen capture) in the test 

hierarchy. The Common Options  and Citrix Options  apply to the entire test.

Under the test is the Citrix session, which contains information about the connection and Citrix XenApp 

client options, such as color depth and resolution.

Window events are the primary test elements in a Citrix test and represent graphic objects that are drawn 

by the Citrix server, such as actual window, dialog boxes, menus, or tooltips. A Window event is recorded 

each time a window is created, destroyed, moved, or resized. The first occurrence of a window, a create 

window event, is displayed in bold. Window objects are typically identified by their title. If there is no 

window title, for example on menus or tooltips, then the test editor uses the window ID number.

Inside windows, you see a list of events for the window, such as create window events, screen captures, 

mouse or key board actions.

Some actions contain data that is highlighted. This highlighting indicates that the data contains one or 

both of the following types of information:

• A dataset candidate:  This is a value, usually one specified by the tester during recording, that the 

test generator determined is likely to be replaced by values in a dataset. An example of a dataset 

candidate is a string that you search for in a recorded test. The string is highlighted as a dataset 

candidate on the assumption that, before running the test, you might want to associate the string 

with a dataset column containing appropriate substitute values.

• References:  These are values in a test, usually one of them in a response and the other in a 

subsequent request, that the test generator determined needed to be associated in order to 

ensure correct test execution. An example is a photograph returned to the browser by a test that 

searches an employee database. The test generator automatically correlates employee names 

with photographs. Suppose that, before running the test with many virtual users, you replace 

the employee name searched for in the recorded test with names in a dataset. Because the test 

correlates the data, each virtual user searches for a different employee, and the server returns an 

appropriate photograph.

To see an illustration of color coding in performance tests, click Window > Preferences > Test > Test 

Editor, and then click the Fonts and Colors  tab.

Click Add  to add elements to the selected test element. Alternatively, you can right-click a test element 

and select an action from a menu.

The choices that you see depend on what you have selected. For example, inside a window, you can add 

a mouse action or a text input. The Insert  button works similarly. Use it to insert an element before the 

selected element. The Remove  button allows you to delete an item.
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Note:  Because Citrix performance tests rely on low level interaction with the server, manually 

changing test elements is likely to break a recorded test.

Related information

Citrix synchronization overview  on page205

Verifying application behavior  on page206

Adding elements to a Citrix test  on page211

Citrix synchronization overview
During the run of a Citrix session, the test uses window events or image recognition to ensure that the 

correct user input actions are maintained on track with the application events coming from the Citrix 

server.

The synchronization mechanism enables the test to remain synchronized without relying only on the 

timing, which could vary with the load on the Citrix server.

Synchronization is different from the function of verification points. Verification points check specified 

values of the application, such as window synchronizations, and produce a test status: pass, fail, error, 

or inconclusive. Synchronization is used for test execution and produces synchronization timeouts in the 

test log when the test fails to recognize the server output.

Synchronization occurs on window events or through the recognition of a screen area that you specify.

• Window event synchronization is produced automatically by the Citrix server. When the test is run, 

the virtual users send emulated user actions to the server, such as keyboard or mouse actions and 

the server responds with window events such as create, activate, or destroy. The test waits for the 

expected window events to occur before sending the next user actions to the server. The test uses 

window styles, and optionally, locations, sizes, and window titles, to recognize windows.

• Image synchronization enables you to require additional recognition of screen area contents. The 

test can synchronize on either a unique bitmap hashcode that is calculated from the image or on 

a text string retrieved from the image through optical character recognition. In some applications, 

such as web browsers or word processors, the actual window content changes more frequently 

then the window objects. In these cases, you must manually add image synchronization to critical 

parts of the test during the recording so that the test can synchronize with the window contents.

During test execution, the test waits for the window event or the image recognition to synchronize the 

user actions independently from the load on the server. If an expected window event fails to occur or an 
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expected image is not recognized, then the test produces a synchronization timeout that is reported in the 

test log. The test will attempt to resume the execution at the next synchronization point.

The base timeout delay is specified in the Citrix test generation preferences; however, the actual delay 

varies with the level of synchronization.

There are three levels of synchronization for window events and images that can be specified for each 

element in the test editor:

• Conditional: This is the default behavior for main windows and dialog boxes. If the synchronization 

fails, the test tries to continue and the synchronization timeout is logged in the Citrix performance 

report and the test log.

• Mandatory: If the synchronization fails after a period that is three times the base timeout delay (by 

default), the test exits with an error  status and the connection with the Citrix server is closed. The 

test execution continues to run until test results are finalized.

• Optional: Synchronization is not required but is logged in the test log. A timeout occurs after 1/10th 

of the base timeout delay.

The default timeout values can be overridden for each synchronization element in the test editor. The test 

recorder automatically sets the recommended synchronization level for window events depending on their 

nature:

• Main window create events are set to mandatory.

• Other window create events are set to conditional.

• Main window destroy events are set to conditional.

• Other window destroy events are set to optional.

• Image synchronizations are set to conditional.

Related information

Citrix test editor overview  on page203

Verifying application behavior  on page206

Adding elements to a Citrix test  on page211

Verifying application behavior
To check the expected behavior of the application during a Citrix performance test, you can add 

verification points at strategic points in the test. You can use window verification points to check that a 
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specific window opens during the test, regardless of its contents, or you can use image synchronization to 

verify the displayed contents. During the run, verification points produce a pass, fail, error, or inconclusive 

status in the Citrix Verification Point report. You can also measure response times between two test 

elements.

Related information

Citrix test editor overview  on page203

Citrix synchronization overview  on page205

Adding elements to a Citrix test  on page211

Enabling Citrix window verification points
You can use verification points on window titles to check whether a window with a specific caption is 

created during the test. Alternatively you can set a verification point on the synchronization criteria of the 

window to check whether the window position, size, and style match the expected criteria, regardless of 

the contents. You can enable window verification points for a specific test or generate them automatically 

by setting the test editor preferences.

During the run, verification points produce a pass, fail, error, or inconclusive status in the Citrix Verification 

Point report and in the test log.

Mandatory window synchronization events always have a verification point enabled. This setting causes 

the test to have a fail  status if the window does not synchronize.

To automatically enable verification points each time a window title changes during the recording, click 

Window  > Preferences  >  Test  >  Performance Test Generation  >  Citrix Test Generation, and select 

Verification point on every window title change.

When verification points are disabled, you can enable verification points for a specific test:

1. Open the test.

2. In the test editor, select a session or a window event.

Your choice determines whether the verification point that you select is added to all windows in the 

test or to a particular window in the test.

3. Right-click, and select Enable Window VPs.
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To inspect or set your verification points, see Specifying window verification point criteria  on page 

209.

Note:  Verification points on mandatory window synchronization elements cannot be disabled.

Related information

Enabling Citrix image synchronization verification points  on page208

Specifying window verification point criteria  on page209

Measuring response times  on page210

Enabling Citrix image synchronization verification points
You use verification points on image synchronization elements to check whether the contents of a screen 

area match either an expected bitmap or a text string. You can add image synchronization verification 

points to a recorded image synchronization element.

During the run, verification points produce a pass, fail, error, or inconclusive status in the Citrix Verification 

Point report and in the test log.

To add a verification point to a recorded image synchronization element:

1. In the test editor, select an image synchronization test element that you added during the 

recording.

2. In the Test Element Details  area, on the Synchronization page, select the verification method:

• Select Bitmap hash code  to verify the exact contents of the image.

• Select Optical character recognition  to verify the recognized text in the captured screen 

area, and then click Extract Text  to obtain the text that is expected.

If the text extraction is unsuccessful, try changing the text recognition settings on the 

Options  page. However, accuracy of the recognized text is not essential. It is only important 

that the recognized text is consistent each time the test runs for the verification to pass.

3. In the Test Element Details area, on the Settings page, select Enable verification point on 

synchronized image.
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Related reference

Citrix image synchronization details  on page

Citrix test generation preferences  on page

Related information

Enabling Citrix window verification points  on page207

Specifying window verification point criteria  on page209

Measuring response times  on page210

Citrix synchronization overview  on page205

Synchronizing tests with screen areas  on page216

Adding values to an image synchronization  on page219

Specifying window verification point criteria
Window verification points produce a fail status in the test execution report if they differ from the 

specified expected criteria.

1. In the test editor, select a window event element.

You can set a verification point on any window event that creates, activates, or destroys a window 

that contains a title.

2. Ensure that Enable verification point on synchronized window event  is enabled for the selected 

window event element.

3. In the test editor, select the window element that contains the window event.

4. Select the event synchronization criteria:

• X position  and Y position: Select these options to specify that the top left corners of the 

window must be located at the same coordinates.

• Width  and Height: Select these options to specify that the window must be the same size.

• Title: Select this option to specify that the window must have the same title.

The window styles are a mandatory criteria and cannot be disabled.

5. If you selected Title, the Window title  field shows the expected title. 

If necessary, you can change the expected title in the Window title  field.

You can use standard regular expressions to specify the expected title by selecting Use regular 

expressions.
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Whenever the test runs with a verification point enabled on a window create, activate, or destroy event, 

a fail  status is reported in the test log if the criteria returned by the Citrix server for the window does not 

contain the expected criteria.

Related information

Enabling Citrix window verification points  on page207

Enabling Citrix image synchronization verification points  on page208

Measuring response times  on page210

Measuring response times
A response time measures the delay between a specified start event and a specified stop event. Typically, 

the start of the measurement is set to a mouse or keyboard input. Similarly, the stop is set to a window 

create, window activate, or window destroy event that is a response to the input event, or an image 

synchronization element that was recorded with the test.

Response time measurements require a start element and a stop element. If either of these are missing, 

the response time definition is displayed with an error or warning marker.

When the Response time for main windows  option is selected in the Citrix Test Generation preferences, 

recorded tests are generated with a response time measurement each time a main window is created. 

Generated measurements start on the event that occurred immediately before a main window is created 

and stop when the main window is created.

You can view all the response times of a test by selecting the Citrix test element in the test editor. 

Response times are listed in the Response Time Definitions  table where they can be edited, renamed, or 

deleted.

1. In the test editor Test Contents  area, select a test element to start the response time 

measurement.

2. Press the Ctrl key, and select another test element to stop the response time measurement.

The two elements are selected in the test. The first element is the start of the response time 

measurement and the second is the stop.

3. Right-click either the start or stop element, and click Create Response Time.

4. A Create Response Time  window displays information about the new response time 

measurement. If the new response time measurement replaces a previous one, click Yes. 

Otherwise, click OK.
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5. Optional: To view all the response times that are defined for the test, click the test element in the 

test navigator, and select the Citrix Response Time  page.

Note:  By default, response time measurements are included in the test results, even when the 

synchronization fails with a timeout. To exclude failed synchronizations from the response time 

results, clear the State  option in the Response Time Definitions  list.

Related information

Enabling Citrix window verification points  on page207

Enabling Citrix image synchronization verification points  on page208

Specifying window verification point criteria  on page209

Adding elements to a Citrix test
You can add a variety of elements to a test, such as user input actions, comments, loops or conditions.

Related information

Citrix test editor overview  on page203

Citrix synchronization overview  on page205

Verifying application behavior  on page206

Editing a mouse action
You can edit mouse actions to manually specify how the mouse interacts with the Citrix server.

Mouse actions describe low-level user actions using the mouse such as mouse movements, clicks and 

double-clicks, or drag-and-drop operations. Mouse actions can be added only inside window events or 

mouse sequences. For example, a drag-and-drop operation is described as a mouse down action at a 

specific location, a sequence of mouse move actions, and a mouse up action at the destination location.

In most cases, you will rely on the mouse actions that were recorded with the test. However, in some 

cases, you might want to manually refactor mouse action sequences that are redundant or poorly 

recorded. For example, a double-click event can sometimes be recorded as a mouse down, a mouse up, 

and a click. The result will be the same as a double click action but the test will be more difficult to read.
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Note:  Because Citrix tests contain low level user input and synchronizations, minor changes can 

prevent the test from working. When editing these tests, you must ensure that they are functionally 

identical.

1. Open the test in the test editor.

2. Expand a window action.

• To edit a mouse action, select the event in the Test Contents  area.

• To create a new action at a specific location, select an action and click Insert  and Citrix 

Mouse.

3. In the Test Element Details  area, specify the type of event.

• Mouse move: This indicates that the mouse is moved from the current coordinates to the 

coordinates specified in X Position  and Y Position.

• Mouse click: This indicates that the mouse is clicked at the coordinates specified in X 

Position  and Y Position. In the Buttons  area, select the button that is clicked.

• Mouse double click: This indicates that the mouse is double clicked at the coordinates 

specified in X Position  and Y Position. In the Buttons  area, select the button that is double 

clicked.

• Mouse down: This indicates that a mouse button is pressed at the coordinates specified in 

X Position  and Y Position. In the Buttons  area, select the button that is double clicked.

• Mouse up: This indicates that a mouse button is released at the coordinates specified in X 

Position  and Y Position. In the Buttons  area, select the button that is double clicked.

4. You can specify the think time for the mouse action. This emulates the time spent by a user before 

initiating the current event.

Related information

Viewing a mouse sequence  on page212

Editing a keyboard action  on page214

Editing a text input  on page215

Synchronizing tests with screen areas  on page216

Manually adding an image synchronization  on page218

Adding values to an image synchronization  on page219

Using custom code with a Citrix test  on page221
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Viewing a mouse sequence
You can use mouse sequences to view complex mouse movements on the screen.

Mouse sequences provide a graphical view of a series of mouse move events. This is particularly useful 

when a large number of mouse move events are meaningful to the application. For example, drawing the 

letter e  in a paint program is represented as a mouse down event, a mouse sequence, and a mouse up. In 

the test editor, the sequence graphically displays how the letter e  is drawn in the application. If any screen 

captures were taken during the recorded session, the sequence will be shown over the screen capture.

In most cases, you will rely on the mouse sequences that were recorded with the test. However, in some 

cases, you might want to manually refactor mouse events into sequence.

Note:  Because Citrix tests contain low level user input and synchronizations, minor changes can 

prevent the test from working. When editing these tests, you must ensure that they are functionally 

identical.

1. Open the test in the test editor

2. Expand a window event and select the sequence in the Test Contents  area.

3. In the Test Element Details  area, you can view the following information:

Display mouse sequences for

This option specifies how you want to display previous, current, or all mouse 

sequences in the current mouse sequence:

Current®  sequence

Only the current mouse sequence is displayed in the test editor. This 

option is selected by default.

Previous and current sequences

The current mouse sequence is displayed with any previous mouse 

sequences.

All sequences

All mouse sequences are displayed simultaneously.

Fit screen to visible area

Select this option to adjust the display of the mouse sequence to the available area 

in the test editor. If disabled, the screen capture will be the actual size, which might 

require scrolling. This option is enabled by default.
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Screen capture area

This area represents the mouse movements on the screen. If a screen capture was 

recorded, it is displayed in the background. Mouse sequences are displayed as 

specified.

Related information

Editing a mouse action  on page211

Editing a keyboard action  on page214

Editing a text input  on page215

Synchronizing tests with screen areas  on page216

Manually adding an image synchronization  on page218

Adding values to an image synchronization  on page219

Using custom code with a Citrix test  on page221

Editing a keyboard action
You can edit keyboard actions to manually specify how the keyboard interacts with the Citrix server.

Keyboard actions describe low level user actions using the keyboard such as text inputs or keyboard 

shortcuts. Keyboard actions can be added only inside window events.

In most cases, you will rely on the keyboard actions that were recorded with the test. The recording tries 

to factor multiple key presses into text input actions. However, in some cases, you might need to manually 

factor keyboard actions that are redundant or poorly recorded. For example, in some cases, a text input 

string Hello  can be recorded as a press on the Shift key, a press on the H  key, a release of the Shift  key, a 

stroke of the E  key, and finally a text input of llo. By manually factoring keyboard actions into text inputs, 

you can handle text from dataset variables and references.

Note:  Because Citrix tests contain low level user input and synchronizations, minor changes can 

prevent the test from working. When editing these tests, you must ensure that they are functionally 

identical.

1. Open the test in the test editor

2. Expand a window event.
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• To edit a keyboard action, select the action in the Test Contents  area.

• To create a new keyboard action at a specific location, select an action and click Insert  and 

Citrix Keyboard.

3. In the Test Element Details  area, specify the type of action. 

• Key Stroke: This indicates that a key is pressed and released.

• Key Down: This indicates that a key is pressed and held down.

• Key Up: This indicates that a pressed key is released.

The Key Code  field displays the key code as interpreted by the Windows™  operating system and is 

translated in the Character field. Use the modifiers to specify the whether the Control key, Shift key, 

or Alt key is also pressed.

4. You can manually enter any Unicode character that is not normally available through single 

keystrokes by using the Character Edition  area. Select the input field and enter the character on 

your keyboard.

The Key Code  and Character  fields display the corresponding character.

Note:  The workbench uses some key combinations as keyboard shortcuts. Such combinations 

can be intercepted and cause undesirable actions instead of displaying a particular character in the 

Character field..

5. You can specify the think time for the keyboard event. This emulates the time spent by a user 

before initiating the current event.

Related information

Editing a mouse action  on page211

Viewing a mouse sequence  on page212

Editing a text input  on page215

Synchronizing tests with screen areas  on page216

Manually adding an image synchronization  on page218

Adding values to an image synchronization  on page219

Using custom code with a Citrix test  on page221

Editing a text input
You can edit text inputs to replace a sequence of keyboard events with text strings that are easier to 

handle as dataset variables or references.
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Text inputs describe a series of low-level keyboard events as a single text string. Text inputs can be added 

only inside window events.

In most cases, you will rely on the text inputs that were recorded with the test. The recording attempts to 

factor multiple key presses into text input events. However, in some cases, you might need to manually 

factor keyboard events that are redundant or poorly recorded. For example, in some cases, a text input 

string Hello  can be recorded as a press on the Shift  key, a stroke of the H  key, a release of the Shift  key, a 

stroke of the E  key, and finally a text input of llo. By manually factoring keyboard actions into text inputs, 

you can handle text from dataset variables and references.

Note:  Because Citrix tests contain low level user input and synchronizations, minor changes can 

prevent the test from working. When editing these tests, you must ensure that they are functionally 

identical.

1. Open the test in the test editor

2. Expand a window event.

• To edit a text input, select the action in the Test Contents  area.

• To create a new text input at a specific location, select an action and click Insert  and Citrix 

Text.

3. In the Test Element Details  area, edit the text string that will be entered during the test.

4. You can specify the think time for the keyboard event. This emulates the time spent by a user 

before initiating the current event.

Related information

Editing a mouse action  on page211

Viewing a mouse sequence  on page212

Editing a keyboard action  on page214

Synchronizing tests with screen areas  on page216

Manually adding an image synchronization  on page218

Adding values to an image synchronization  on page219

Using custom code with a Citrix test  on page221
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Synchronizing tests with screen areas
Image synchronization enables Citrix performance tests to keep track of the contents of a screen area 

during replay instead of focusing only on window events.

You can use image synchronization elements in a test to facilitate the test replay in applications that do 

not create or modify many windows, but update the contents of the window regularly.

The contents of an image are processed as a value that is either a calculated bitmap hashcode or a text 

string obtained by optical character recognition. During test execution, the test waits for the contents of 

a screen area to match the expected image synchronization value before proceeding with the test. If the 

value is not matched during the synchronization period, an image synchronization timeout is produced in 

the test log.

You can also add verification points to image synchronizations in the test editor. The verification point 

passes if the synchronization succeeds and fails if a timeout occurs.

You insert image synchronizations during test recording.

1. Start recording a Citrix performance test and record a sequence of user actions.

2. To add an image synchronization to the recorded test, in the Citrix Recorder Control  window, click 

the Insert image synchronization  button, select an area of the screen that will be used for 

synchronization, and then click the Insert image synchronization  button again.

3. Continue the recording. When you have completed the sequence of actions to be tested, end the 

Citrix session cleanly and close the Citrix XenApp client.

A progress window opens while the test is generated. On completion, the Recorder Control  view 

displays the message Test generation completed, the Test Navigator lists your test, and the test 

opens in the test editor.

4. In the test editor, select the Image synchronization  element.

a. Set the synchronization state to Conditional, Mandatory  or Optional. In most cases, 

because you are explicitly requesting for a synchronization to occur, you should leave the 

synchronization state as Conditional.

b. Specify one of two synchronization methods.

• Select Bitmap hash code  if you want the synchronization to occur when the selected 

area matches exactly the recorded image. A single pixel of difference will cause a 

synchronization timeout.

• Select Optical character recognition  if you want the synchronization to occur when 

a text string is recognized in the selected area. Click Extract text  to test the text 

recognition on the recorded image. Note that for synchronization purposes the text 

recognition results must be repeatable, not necessarily accurate.
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Note:  On Windows 2008, it is recommended to use the Bitmap hash code 

synchronization method for a Citrix test.

You can click Extract text  several times to make sure that the text recognition results 

are repeatable. If the recognized text differs, click Options  to change the Zoom factor 

or other optical character recognition settings. You should not manually correct the 

recognized text.

You can click Add  to specify multiple expected text strings, Use regular expression  to 

specify a text string as a regular expression, or Factorize  to automatically generate a 

regular expression from multiple expected text strings.

c. Specify whether you want to enable a verification point on the image synchronization. This 

enables the test to produce a pass or fail status in the Citrix Verification Points report.

Related information

Editing a mouse action  on page211

Viewing a mouse sequence  on page212

Editing a keyboard action  on page214

Editing a text input  on page215

Manually adding an image synchronization  on page218

Adding values to an image synchronization  on page219

Using custom code with a Citrix test  on page221

Manually adding an image synchronization
You can manually add an image synchronization element to an existing test to ensure that the 

test synchronizes correctly or to add a verification point. To do this, you must create the image 

synchronization element, and then perform a single run of the test to retrieve the image hash code or text 

detected by optical character recognition (OCR).

1. Open the test in the test editor.

2. Select the location where you want to create the image synchronization and click Insert  and Citrix 

Image Synchronization.
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This creates a new image synchronization element that is set to Conditional and has several values 

disabled. This is because the test does not yet contain the image hash code or recognized text.

3. In the screen capture area, move and resize the black rectangle to specify the zone of the image 

that will be used for the synchronization.

Alternatively, you can specify the pixel values in X position, Y position, Width  and Height.

4. Select File  > Save  to save the test, and then, in the test navigator, right-click the test and select Run 

As  > Performance Test.

This runs the test once to retrieve the image hash code or recognized text.

5. After running the test, right-click the test report, select Display Test Log, and then select the Events 

page.

6. Click the Events  tab.

7. Expand the top line of the Events  hierarchy and navigate to the Image timeout  element that was 

produced during the run.

8. Select the image timeout to open the Citrix Image Synchronization  view.

If necessary, you can open the Citrix Image Synchronization  view manually by selecting Window  > 

Show View  > Other  > Test  > Citrix Image Synchronization. This view shows the actual screen area 

encountered during the test and the expected image, as well as the corresponding hash codes or 

recognized text values.

9. To add the actual hash code or recognized text to the image synchronization, click the Add value 

 button.

Related information

Editing a mouse action  on page211

Viewing a mouse sequence  on page212

Editing a keyboard action  on page214

Editing a text input  on page215

Synchronizing tests with screen areas  on page216

Adding values to an image synchronization  on page219

Using custom code with a Citrix test  on page221
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Adding values to an image synchronization
You can replace or add alternative values in an image synchronization element so that synchronization is 

not restricted to the exact recorded image. Alternative values can also be useful in updating the test if the 

behavior of the application changes.

If you are using optical character recognition, simply click Add  in an image synchronization element in the 

test editor to add an alternative value, and enter a new text string in the Expected text  field.

If you are using the bitmap hash code synchronization or optical character recognition, you can use the 

following method to add an alternative hash code or recognized text value.

To add an alternative value to an image synchronization:

1. After inserting an image synchronization element, run the test from the Run menu.

If possible, arrange for the alternative condition to occur before starting the run. The test should 

produce an image synchronization timeout when the alternative condition is encountered.

2. In the Performance Test Runs  view, right-click the test log container, and then select Display Test 

Log.

The test log opens in the editor with the Overview  page selected.

3. Click the Events  tab.

4. Expand the top line of the Events  hierarchy and navigate to the Image timeout  element that was 

produced during the run.

5. Select the image timeout to open the Citrix Image Synchronization  view.

If necessary, you can open the Citrix Image Synchronization  view manually by selecting Window  > 

Show View  > Other  > Test  > Citrix Image Synchronization. When an image timeout is selected, this 

view shows the actual screen area encountered during the test and the expected image, as well as 

the corresponding hash codes or recognized text values.

6. You can either add the new hash code or recognized text value to the image synchronization as an 

alternative value or you can replace the existing value with the new value.

• To add the actual hash code or recognized text as an alternative value, click the Add value 

 button.

• To replace the expected value with the new value, click the Replace value  button.

Related information

Editing a mouse action  on page211

Viewing a mouse sequence  on page212

Editing a keyboard action  on page214
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Editing a text input  on page215

Synchronizing tests with screen areas  on page216

Manually adding an image synchronization  on page218

Using custom code with a Citrix test  on page221

Using custom code with a Citrix test
You can write custom Java™  code to expand the functions of IBM®  Rational®  Performance Tester.

Custom code requires knowledge of Java™  programming and the use of the Rational®  Performance 

Tester  API. See Executing test execution with custom code  on page  for more information.

To use custom code for test synchronization:

1. In the test navigator, select the test element location to insert the custom code.

2. Click Insert  > Custom Code.

A custom code test element is created in the test.

3. On the Test Element Details  page, click Generate Code  to create a Java™  class based on the 

Rational®  Performance Tester  API.

You can click View Code  to edit an existing class.

4. In the Java™  editor, add the import statement for Citrix tests: import 

com.ibm.rational.test.lt.execution.citrix.customcode.*;

5. Complete the exec  method to specify the function to create.

6. Save and close the Java™  class.

The following example is custom code class that can be used as a starting point to evaluate the results of 

a synchronization point. You can use this template to write a class that performs a synchronization when 

image synchronization and window-event synchronization are not practical for your test.

import com.ibm.rational.test.lt.kernel.services.ITestExecutionServices;

import org.eclipse.hyades.test.common.event.VerdictEvent;

import com.ibm.rational.test.lt.execution.citrix.customcode.CitrixCustomCodeImpl2;

import com.ibm.rational.test.lt.execution.citrix.customcode.ICitrixCustomCode2;

 

public String exec(ITestExecutionServices tes, String[] args) {

 ICitrixCustomCode2 thisCode = new CitrixCustomCodeImpl2(tes);
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 // to get the last VP status

 int verdict = thisCode.getLastVerificationPointVerdict();

 if (verdict != VerdictEvent.VERDICT_PASS) {

 

  // this example reports a message but must be adapted to your specific needs

  tes.getTestLogManager().reportMessage("last VP status: " + thisCode.verdictEventToString(verdict));

 

 }

 return null;

}

The following example demonstrates how you can record a screen capture during playback for 

debugging purposes. The screen capture is recorded in the test log and can be viewed in the Citrix image 

synchronization  view.

import com.ibm.rational.test.lt.kernel.services.ITestExecutionServices; 

import com.ibm.rational.test.lt.execution.citrix.customcode.*;

 

public String exec(ITestExecutionServices tes, String[] args) { 

 

 ICitrixCustomCode2 thisCode = new CitrixCustomCodeImpl2(tes); 

 

 // To capture and log the full screen: 

 thisCode.logFullScreenCapture(); 

 

 // To capture and log a part of the screen: 

 // thisCode.logPartialScreenCapture(x, y, width, height); 

 

 // To capture and log a part of the screen to a file: 

 // thisCode.savePartialScreenCapture(filename, x, y, width, height); 

 

 return null; 

}

After creating a custom code test, you can run the test as usual. If you need to debug the test, you can use 

the monitoring panel to insert breakpoints or to interact with the Citrix environment during execution.
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Related information

Editing a mouse action  on page211

Viewing a mouse sequence  on page212

Editing a keyboard action  on page214

Editing a text input  on page215

Synchronizing tests with screen areas  on page216

Manually adding an image synchronization  on page218

Adding values to an image synchronization  on page219

Debugging Citrix tests  on page

Editing service tests
After you record a service test, you can edit the calls and message returns to include variable data 

(rather than the data that you recorded). You can add verification points (to confirm that the test runs as 

expected), transactions, conditional processing, and custom code.

Web service test editor overview
With the test editor, you can inspect or customize a test that you recorded.

The test editor lists the web service call elements for a test, in sequential order.

There are two main areas in the test editor window. The area on the left, Test Contents, displays the 

chronological sequence of test elements in the test. The area on the right, Test Element Details, displays 

details about the currently selected item (test, call, message return, or verification point) in the test 

hierarchy.

Window events are the primary test elements in a Citrix test and represent graphic objects that are drawn 

by the Citrix server, such as actual window, dialog boxes, menus, or tooltips. A Window event is recorded 

each time a window is created, destroyed, moved, or resized. The first occurrence of a window, a create 

window event, is displayed in bold. Window objects are typically identified by their title. If there is no 

window title, for example on menus or tooltips, then the test editor uses the window ID number.

A service request node name can be updated automatically or you can use custom code or dataset to 

supply different names. To apply a dataset to a node name, in the test editor, select the node name. In the 
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Request Details area of the test editor, clear the Update node name automatically, select the name and 

substitute it with dataset.

Web service calls can contain web service message return elements, which display the results of the web 

service call. The XML message content can be displayed either in Form, Tree or Source view. Each of 

these views displays the same message content in different forms:

• Form  view provides a simplified view of the call elements focused on editing the values of the XML 

message content.

• Tree  view provides a hierarchical view of the XML structure, including elements, namespaces, and 

the associated values. Tree view also allows you to manipulate XML fragments.

• Source  view displays the XML contents of a web service or XML call or the plain text contents of a 

simple text message.

Message return elements can contain verification point elements that check that the actual return results 

match expected criteria.

Some actions contain data that is highlighted. This highlighting indicates that the data can be used as a 

dataset candidate or as a reference. See Data correlation overview  on page  for more information.

In service calls and message returns, you can use datasets and data correlation on values contained in 

the XML or on XML fragments. To use data correlation on XML fragments, switch to the Tree view, right-

click the XML element and select Create XML Fragment.

To view or modify the color coding in web service tests, click Window > Preferences > Test > Test Editor, 

and then click the Fonts and Colors  tab.

Click Add  to add elements to the selected test element. Alternatively, you can right-click a test element 

and select an action from a menu.

The choices that you see depend on what you have selected. For example, inside a web service call, you 

can add a web service message return. The Insert  button works similarly. Use it to insert an element 

before the selected element. The Remove  button allows you to delete an item.

Related information

Verifying application behavior  on page225

Working with Server Name Indication (SNI) recordings  on page181

Adding elements to a service test  on page237

Managing JMS/MQ connections in a service test  on page241

Editing WSDL security profiles  on page242
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Testing asynchronous services  on page262

Creating a reliable messaging call structure  on page266

Verifying application behavior
To check the expected behavior of the application during a service test, you can add verification points 

after a message return. During the run, verification points produce a pass, fail, error, or inconclusive status 

in the Web Service Verification Point report.

Related information

Web service test editor overview  on page223

Working with Server Name Indication (SNI) recordings  on page181

Adding elements to a service test  on page237

Managing JMS/MQ connections in a service test  on page241

Editing WSDL security profiles  on page242

Testing asynchronous services  on page262

Creating a reliable messaging call structure  on page266

Adding equal verification points
Equal verification points enable you to check that the contents returned by a service match exactly the 

contents specified in the verification point.

When you add verification points, the results from a service response are compared with the expected 

data specified in the verification point test element. Equal  or contain  verification points enable you to 

directly compare the XML document that the service returns.

• Contain verification points return a Pass status when the response XML document contains the 

expected XML data.

• Equal verification points return a Pass status when the response XML document matches exactly 

the expected XML data.

Complex service requests or verification points might have empty XML elements that are not needed in a 

test script. When playing back the test, you can skip such empty XML elements. In Window  > Preferences 
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> Test  > Test editor  > Service test  ensure that the Display the 'Skip if empty' column in XML tree viewer 

check box is selected. This option displays a Skip if empty  column in the tree view of the request. You can 

then choose the XML elements to skip.

1. Open the test editor, and right click a response element and select Add  > Equal Verification Point.

2. Select the verification point, and in the Test Element Details  area of the test editor, type a name for 

the verification point.

3. Select the verification options:

• Select Test using XML namespaces  to perform the verification on the qualified structure of 

the XML document, including the namespace tagging, instead of the simple name. Disable 

this option to check only the simple name of the element and the final return value.

• Select Text XML text nodes  to include the content of text elements in the verification.

• Select Text XML attributes  to include the content of attributes in the verification.

4. On the Message page, select the Form, Tree, or Source  view to specify the expected XML data.

For an equal verification point, the expected XML data contains the XML document from the 

response test element. If necessary, you can edit the expected XML data.

You can specify standard Java™  regular expressions in the Tree  view. To do this, select the Regular 

expression  column on the line of an attribute or text value and type the regular expression in the 

Value  column. For example, the following regular expression checks for a correctly formatted email 

address: /^([a-zA-Z0-9_\.\-])+\@(([a-zA-Z0-9\-])+\.)+([a-zA-Z0-9]{2,4})+$/

When using regular expressions, the number of XML nodes or XML fragments in the verification 

point must match the quantity of expected nodes.

You can enable or disable each verification point by right-clicking the verification point in the test editor 

and clicking Enable  or Disable.

Related information

Adding contain verification points  on page226

Adding Xpath query verification points  on page231

Adding attachment verification points  on page232

Adding Text verification points  on page233

Adding properties verification points to a test response  on page234

Adding XSD verification points  on page235
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Adding contain verification points
With contain verification points, you can check that one or several elements of the XML content returned 

by a service match the XML fragment that is specified in the verification point.

When you add verification points, the results from a service response are compared with the expected 

content that is specified in the verification point test element. Equal  or contain  verification points enable 

you to directly compare the XML contents that the service returns.

• Contain verification points return a Pass status when the response XML contents contain the 

expected XML fragment.

• Equal verification points return a Pass status when the response XML contents match exactly the 

entire expected XML content.

Complex service requests or verification points might have empty XML elements that are not needed in a 

test script. When playing back the test, you can skip such empty XML elements. In Window  > Preferences 

> Test  > Test editor  > Service test  ensure that the Display the 'Skip if empty' column in XML tree viewer 

check box is selected. This option displays a Skip if empty  column in the tree view of the request. You can 

then choose the XML elements to skip.

1. Open the test editor, and select a service response element.

2. In the Test Element Details  area, click the Message  tab and select the Form  or Tree  view.

3. Expand the envelope line, right click the element that you want to check, and then click Create 

Contain Verification Point. This action creates a contain verification point that includes the XML 

element from the recorded response.

Note:  You can also create a contain verification point with the message response by selecting 

the message response in the Test Contents  pane and clicking Add  > Contain Verification Point. 

However, the result is effectively the same as an equal verification point because the verification 

point contains the entire XML content of the message response.

4. Select the verification point, and in the Test Element Details  pane, type a name for the verification 

point.

5. Select the verification options:

• Select the Test using XML namespaces  check box to perform the verification on the 

qualified structure of the XML document, including the namespace tagging, instead of the 

simple name. Disable this option to check only the simple name of the element and the final 

return value.
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• Select the Test XML text nodes  check box to include the content of text elements in the 

verification.

• Select the Test XML attributes  check box to include the content of attributes in the 

verification.

6. If necessary, select the Form, Tree, or Source  views to edit the expected XML fragment.

For an equal verification point, the expected XML data contains the XML document from the 

response test element. If necessary, you can edit the expected XML data.

You can specify standard Java™  regular expressions in the Tree  view. Select the Regular 

expression  column on the line of an attribute or text value and type the regular expression in the 

Value  column. For example, the following regular expression checks for a correctly formatted email 

address: /^([a-zA-Z0-9_\.\-])+\@(([a-zA-Z0-9\-])+\.)+([a-zA-Z0-9]{2,4})+$/

When using regular expressions, the number of XML nodes or XML fragments in the verification 

point must match the number of expected nodes. The verification point returns a Pass status when 

all regular expressions in the XML fragment are matched.

You can use a contain verification point to check that the message response contains only a specific 

element with a specific value. For example, consider the following message response:

<s:Envelope

 xmlns:a="http://www.w3.org/2005/08/addressing"

 xmlns:s="http://www.w3.org/2003/05/soap-envelope">

  <s:Header>

    <a:Action

     s:mustUnderstand="1">http://www.w3.org/2005/08/addressing/soap/fault</a:Action>

    <a:RelatesTo>uuid:ed9bc447-d739-452f-989d-cd48344d494a</a:RelatesTo>

  </s:Header>

  <s:Body>

    <s:Fault>

      <s:Code>

        <s:Value>s:Sender</s:Value>

        <s:Subcode>

          <s:Value

           xmlns:a="http://schemas.xmlsoap.org/ws/2005/02/sc">a:BadContextToken</s:Value>

        </s:Subcode>

      </s:Code>

      <s:Reason>

        <s:Text
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         xml:lang="en-US">The message could not be processed. This is most likely because the action 

 &apos;http://Samples.ICalculator/Add&apos; is incorrect or because the message contains an invalid or expired security 

 context token or because there is a mismatch between bindings. The security context token would be invalid if the 

 service aborted the channel due to inactivity. To prevent the service from aborting idle sessions prematurely increase 

 the Receive timeout on the service endpoint&apos;s binding.</s:Text>

      </s:Reason>

      <s:Node>http://www.w3.org/1999/xlink</s:Node>

      <s:Role>http://www.w3.org/1999/xlink</s:Role>

      <s:Detail

       xmlns:tns0="http://schemas.com/2003/10/Serialization/"

       xmlns:tns15="http://Samples.Windows"

       tns0:Id="id"

       tns0:Ref="idref">

        <tns15:GetCallerIdentityResponse>

          <tns15:GetCallerIdentityResult>str</tns15:GetCallerIdentityResult>

        </tns15:GetCallerIdentityResponse>

      </s:Detail>

    </s:Fault>

  </s:Body>

</s:Envelope>

To check for the Subcode  element, the expected content of the contain verification point is the following 

XML fragment:

<s:Subcode

  xmlns:a="http://www.w3.org/2005/08/addressing"

  xmlns:s="http://www.w3.org/2003/05/soap-envelope">

   <s:Value

   xmlns:a="http://schemas.xmlsoap.org/ws/2005/02/sc">a:BadContextToken</s:Value>

</s:Subcode>

By default, the contain verification point checks whether an element named Subcode  contains one element 

named Value. You can use the following options:

229



Test Author Guide

230

• Test using XML namespaces: With this option, the verification point checks whether an element 

named "http://www.w3.org/2003/05/soap-envelope":SubCode  contains one element named 

"http://www.w3.org/2003/05/soap-envelope":Value.

• Test XML text node: With this option, the verification point also checks whether the element named 

Value  contains the text a:BadContextToken.

• Test XML attributes: With this option, the verification point also checks that the attributes match 

the expected XML fragment. In this example, the Test XML attributes  option is not necessary 

because the Subcode  element does not have any attributes.

To check that the Detail  element properly returns a specific value for GetCallerIdentityResult, the 

expected content of the contain verification point is the following XML fragment:

<s:Detail

 xmlns:a="http://www.w3.org/2005/08/addressing"

 xmlns:s="http://www.w3.org/2003/05/soap-envelope"

 xmlns:tns0="http://schemas.com/2003/10/Serialization/"

 xmlns:tns15="http://Samples.Windows"

 tns0:Id="regular_expression"

 tns0:Ref="idref">

  <tns15:GetCallerIdentityResponse>

    <tns15:GetCallerIdentityResult>IdentityValue</tns15:GetCallerIdentityResult>

  </tns15:GetCallerIdentityResponse>

</s:Detail>

You can use the following options:

• Test XML text node: With this option, the verification point also checks whether the element named 

GetCallerIdentityResult  contains the text IdentityValue.

• Test XML attributes: With this option, the verification point also checks that the attribute Id 

referred to by tns0:Id  has the expected value. You can specify a regular expression for this value 

by using the Regular expression  column in the Tree  view of the verification point. For example, 

tns0:Id="[a-zA-Z]"  checks that the value does not contains numbers.

You can enable or disable each verification point by right-clicking the verification point in the test editor 

and clicking Enable  or Disable.

Related information

Adding equal verification points  on page225

Adding Xpath query verification points  on page231
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Adding attachment verification points  on page232

Adding Text verification points  on page233

Adding properties verification points to a test response  on page234

Adding XSD verification points  on page235

Adding Xpath query verification points
With service query verification points, you can check that a response matches an Xpath query.

When you add verification points, the results from a service response are compared with the expected 

data that is specified in the verification point test element. With query  verification points, you can check 

that the number of nodes returned by an XML Path language query matches the expected number of 

nodes specified in the verification point.

Refer to the XPath specification for details on expressing an XPath query: http://www.w3.org/TR/xpath.

You can use the test editor to create or edit verification points.

1. Open the test editor, and select a web service response element.

2. Click Add, and select Query verification point.

3. In the Test Element Details  area of the test editor, type a name for the verification point.

4. Type a valid XPath expression  or click Build Expression  to open the XPath Expression Builder.

The XPath Expression Builder  helps you build and evaluate XPath expressions based on the 

recorded contents of the response.

5. Specify a Comparison operator  (=, >, or <), and the expected number of nodes that the query 

should return. Click Evaluate  to update the Expected Count with the actual result based on the 

recorded contents of the response.

You can enable or disable each verification point by right-clicking the verification point in the test editor 

and clicking Enable  or Disable.

Note:  Because XPath expressions require that the qualified name have a prefix, XPath expressions 

will return null for the default namespace declared with xmlns.

Related information

Adding equal verification points  on page225

Adding contain verification points  on page226
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Adding attachment verification points  on page232

Adding Text verification points  on page233

Adding properties verification points to a test response  on page234

Adding XSD verification points  on page235

Adding attachment verification points
Service attachment verification points enable you to check that the attachment of a service response 

matches the specified criteria.

When you add verification points, the results from a service response are compared with the expected 

data that are specified in the verification point test element. Attachment  verification points enable you to 

verify that an expected attachment is delivered with the response.

Attachment verification points return a Pass status when all the criteria of an attachment match the 

expected criteria specified in the verification point test element. If any of the criteria do not match, the 

verification point returns a Fail status.

You can use the test editor to create or edit verification points.

To add attachment verification points to a performance test:

1. Open the test editor and select a service response element.

2. Click Add  and select Attachment Verification Point.

3. In the Test Element Details  area of the test editor, type a name for the verification point, and 

specify the criteria to be verified. All criteria must match in order for the verification point to pass.

a. In the case of multiple attachments, set the Index of attachments  to the index number of the 

attachment to be checked. Type 1  if there is only one attachment in the response.

b. Specify the expected size in bytes of the attachment.

c. Specify the MIME type and encoding of the attachment.

You can enable or disable each verification point by clicking Enable verification point  in the test editor.

Related information

Adding equal verification points  on page225

Adding contain verification points  on page226

Adding Xpath query verification points  on page231
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Adding Text verification points  on page233

Adding properties verification points to a test response  on page234

Adding XSD verification points  on page235

Adding Text verification points
To check the text content that is returned by the service response, you can add a text verification point in 

the service test. When you add the verification point, you can check whether the text matches equally with 

the response or whether the response contains the text.

1. Open the Test editor, right-click a response element and select Add  > Text Verification Point.

2. In Verification Point Name, specify a name for the verification point.

3. In the Operator  field, select the basis of comparison between the text to be verified and the 

response content.

4. To search between the offset values, select From Offset  and To Offset  check boxes and specify the 

offset values.

5. To search between two string values, select From String  and To String  check boxes and specify the 

strings. You must also specify the number where the strings occurred.

For example, if there are four occurrences of 'My Text' in the content and you want to verify the text 

that is between second and third occurrence, you should specify 2 and 3 in From String  and To 

String  respectively.

6. To do a case-sensitive match, select the Case sensitive  check box.

7. To ignore carriage return/ line feed in the response, select the Ignore CL/LF when matching  check 

box.

8. Save the test and run it.

The Service Verification Point Report shows the number of Text Verification Points that passed or failed.

Related information

Adding equal verification points  on page225

Adding contain verification points  on page226

Adding Xpath query verification points  on page231

Adding attachment verification points  on page232
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Adding properties verification points to a test response  on page234

Adding XSD verification points  on page235

Adding properties verification points  to a test response
You can add verification points for the properties in a service test so that these properties in the test 

response are verified and validated when you play back the test.

You must have recorded or created a service test using the test editor.

When you add verification points, results from a service response are compared with the expected data 

specified as the verification point test element. You can add the verification point for the properties to an 

existing test response when the test is manually created or recorded. After you add the verification point 

for the properties to a test response, you can verify the selected response properties during the test run.

1. Identify the service test from Test Navigator  and double-click the service test to open it in the test 

editor.

2. Select a service response for a service request from the service test.

3. Right-click the service response, click Add  > Properties Verification Point.

The Properties Verification Point  is added based on the existing properties of the service 

response.

Note:  You can add multiple verification points for the properties, if required.

4. Perform any of the following on the verification points for the properties in the Properties 

Verification Point Details  pane.

To Do... Do This...

To add a new property and its value Click Add.

To edit the value of an existing property Click Edit.

To remove the property that you do not want 

to verify during the test run

Click Remove.

Note:  You can remove multiple proper

ties in a group at the same time.

5. Select or clear the Apply And Operator  check box based on the requirement as follows:

• To verify all the listed properties, select the Apply And Operator  check box.

• To verify one of the listed properties, clear the Apply And Operator  check box.
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6. Optionally, you can substitute the value of one or more properties in the verification point by using 

a test variable, data set, custom java code, or built-in variables.

7. Verify all the verification points for the properties that you entered, and then click Save.

The verification points that you added for the response properties are added to the service test.

You can run the test and after the test run, you can view and analyze the properties verification point 

details from the following page and reports:

• Verdict List  pane in the Test Log  page. Click any of the verification point from the list and view the 

details.

• Response Properties Verification Points  tab in the Service Verification Point Report. Click the 

Response Properties Verification Points  tab and view the verification point details.

• Verification points verdicts  pane from the Functional Test  report page. Click any of the verdict 

status to verify the expected value and actual value of the verification point for the properties.

Related reference

Web Service Verification Points report  on page

Related information

Adding equal verification points  on page225

Adding contain verification points  on page226

Adding Xpath query verification points  on page231

Adding attachment verification points  on page232

Adding Text verification points  on page233

Adding XSD verification points  on page235

Adding XSD verification points
XSD verification points enable you to check that the XML content of a service response comply with the 

rules defined in an XML Schema Definition (XSD) file.

When you add verification points, the results from a service response are compared with the expected 

data that are specified in the verification point test element. XSD  verification points return a Pass 

status when the XML contents of the response are compliant with the associated XSD or a Web Service 

Description Language (WSDL) file that contains XSD information.
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If you add multiple XSD files to the verification, then the XML content of the response must comply with 

all of the XSD files.

You can use the test editor to create or edit verification points.

To add an XSD verification point to a test:

1. Open the test editor and select a service response element.

2. Click Add  and select XSD Verification Point.

3. In the Test Element Details  area of the test editor, type a name for the verification point.

4. Click Add XSD  to add a an XSD file to the validation list or Add WSDL  to add a WSDL that contains 

XSD information.

Click Open  to display the XSD or WSDL contents.

You can enable or disable each verification point by right-clicking the verification point in the test editor 

and clicking Enable  or Disable.

Related information

Adding equal verification points  on page225

Adding contain verification points  on page226

Adding Xpath query verification points  on page231

Adding attachment verification points  on page232

Adding Text verification points  on page233

Adding properties verification points to a test response  on page234

Working with Server Name Indication (SNI) recordings
If you have recorded against a server that supports Server Name Indication (SNI), an extension of the 

TLS protocol, the recording session file displays true  for the SNI Extension  field. There might be a need 

for you to access both SNI and non-SNI applications from the same server. To run the same test without 

using the SNI extension, you can manually change the value to false.
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The Server Access Configurations  resource of the test script also have SSL entries. Each SSL entry 

displays which TLS version and Cipher value was used. To edit multiple SSL entries, select them and in 

the Detail area, right-click the entries and click Edit multiple SSLs.

Related information

Web service test editor overview  on page223

Verifying application behavior  on page225

Adding elements to a service test  on page237

Managing JMS/MQ connections in a service test  on page241

Editing WSDL security profiles  on page242

Testing asynchronous services  on page262

Creating a reliable messaging call structure  on page266

Adding elements to a service test
To improve the reliability of the test script, add the different elements to the service test.

Related information

Web service test editor overview  on page223

Verifying application behavior  on page225

Working with Server Name Indication (SNI) recordings  on page181
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Managing JMS/MQ connections in a service test  on page241

Editing WSDL security profiles  on page242

Testing asynchronous services  on page262

Creating a reliable messaging call structure  on page266

Adding a service request
You can use service request elements in tests to send a request to the service.

Complex service requests or verification points might have empty XML elements that are not needed in a 

test script. When playing back the test, you can skip such empty XML elements. In Window  > Preferences 

> Test  > Test editor  > Service test  ensure that the Display the 'Skip if empty' column in XML tree viewer 

check box is selected. This option displays a Skip if empty  column in the tree view of the request. You can 

then choose the XML elements to skip.

1. Open the test in the test editor, and select the first element in the test.

2. Click Add  and select a service request.

3. If you selected WSDL service request, select one or several WSDL files in your workspace for the 

web service that you want to test and click Next.

If necessary, you can import a WSDL file into the workspace with the Add  button.

4. Select either HTTP, JMS, or WebSphere MQ  depending on the transport protocol used by the web 

service, and provide the correct transport protocol configuration to perform the call.

You can create a New  transport configuration or reuse an existing one.

5. Click Finish.

This creates the web service request in the test editor.

6. On the Message  page of the request, select the Form, Tree, or Source  views to edit the service 

request contents.

7. If any resource files are to be attached to the request, select the Attachment  tab. Use Add, Remove, 

or Edit  to specify the resources that are to be attached to the request.

8. If the service uses encryption, signature or other security protocols, select the Security for Request 

and Security for Response  pages to configure the security for this particular service request or to 

open the WSDL security editor.

After creating elements, you can use the test editor to edit service requests. You can create a service 

response element to test the performance and behavior of the service. You can also replace some 

content values with dataset variables or a references.
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Updating a service response from the service
While you are developing a service test, you can send a request from the test editor to record or update 

the response element.

Service response elements are children of service request elements. Service tests use response elements 

to measure the response time between a call and the corresponding response. Response elements can 

also contain verification points.

You can click Update Response  in the request element to complete one of the following actions:

• Record a response from the service: This method sends the request and records the actual 

response from the service. For services that use the IBM®  WebSphere®  MQ or JMS transport 

protocols, multiple responses can be recorded.

• Update the current response content: If a response exists, its contents are replaced. If multiple 

responses are received, the number and order of the responses are updated.

Important:  After updating the response content, data correlation or verification points that referred to 

replaced content might no longer work.

You can use the test editor to create or edit response elements in a service test. There are three methods 

of adding a service response:

• Generate a response from Web Services Description Language (WSDL): If the service uses WSDL, 

then the response is created with the content structure that the WSDL specifies.

• Add a text response: In this response type, you specify free formatted content for the response.

• Record a response from the service: This method sends the request and records the actual 

response from the service.

WebSphere®  MQ and JMS requests can contain multiple response elements.

To add a response element to a service test:

1. Open the test in the test editor, and select a service request element.

2. On the Test Element Details  page, click Update Response.

Alternatively, right-click the service request element, and click Add  > Response from Request.

This action performs the service request. If the request is valid, the Update Response  window 

opens and displays the response data.

3. In the Return Preview  window, review the content of the response to ensure that it is correct.
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For the WebSphere®  MQ and JMS protocols, if multiple responses are received, then click the 

arrows to view each response.

a. Click the Message  tab to view the contents of the response in the Form, Tree  or Source 

view.

b. Click the Attachment  tab to view any resource files that were attached to the response.

c. Click the Response Properties  tab to view the properties of the response.

4. To use the received response in the test, click Update Test.

This creates the response elements as a child of the request element or updates the existing 

response elements with the new data.

After creating or updating response elements, you can create verification points on the response contents 

to test the behavior of the service.

Related information

Manually adding a response element  on page240

Verifying application behavior  on page225

Manually adding a response element
You can add service response elements to specify the received content of a service request. You can use 

the test editor to create or edit response elements in an existing service test.

Service response elements are children of service request elements. Service tests use response elements 

to measure the response time between a call and the corresponding response. Response elements can 

also contain verification points. IBM®  WebSphere®  MQ and JMS requests can contain multiple response 

elements.

Depending on the type of request, you can manually create several types of response elements:

• Response from Web Services Description Language (WSDL): For web services, this response type 

uses the WSDL file to create the specified XML structure of the response.

• XML response: This response type creates an empty response element in which you must 

manually create the expected XML structure. You can use an XML Schema Definition (XSD) 

document from the XSD catalog to assist you.

• Text response: This response type creates an empty response element, which can contain freely 

formatted text.
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Alternatively, you can automatically create and update response content by recording the actual response 

content that the service returns. See Updating a service response from the service  on page 239 for 

more information.

To add a response element to a service test:

1. Open the test in the test editor, and select a service request element.

2. Create one of these elements:

• For web service requests, click Add  > Response from WSDL.

• If the expected response contains XML content, click Add  > XML Response.

• If the expected response contains plain text, click Add  > Text Response.

This action creates the corresponding response element in the test. If the request uses the 

WebSphere®  MQ or JMS format, then you can create multiple responses.

3. Edit the message content of the response element to reflect to actual content that the service 

returns.

a. Click the Message  tab to view the contents of the response in the Form, Tree  or Source 

view.

b. Click the Attachment  tab to view any resource files that were attached to the response.

c. Click the Response Properties  tab to view the properties of the response.

After creating a message return, you can create verification points on the contents to test the behavior of 

the service.

Related information

Updating a service response from the service  on page239

Verifying application behavior  on page225

Managing JMS/MQ connections in a service test
When you run a service test that includes JMS or MQ protocol, the socket connections are created and 

closed in the background. When you include multiple tests in a compound test or a A schedule, in this 

context, is used to refer to both VU Schedule  and Rate Schedule, multiple connections are created and 

closed. Starting from 9.2, when you run service tests in a schedule, you can select a pooling strategy for 

these JMS/MQ connections so that when the connections are created, they do not close and are reused 

subsequently for the other JMS/MQ calls, if required.

You can set the scope of JMS/MQ connections to a test, compound test, or schedule. When you set the 

scope to test, existing behavior comes into play wherein duplicate connections could be created and 

241



Test Author Guide

242

closed. When you set the scope to a compound test or a schedule, the connections are reused for JMS/

MQ calls within a compound test or a schedule.

1. In the Test Navigator, browse to the schedule and double-click it. The schedule is displayed.

2. Select a schedule. In the VU Schedule  Details area, click the Advanced  tab and under Protocol-

specific options, click Edit Options.

3. In JMS/MQ connections scope, select the scope of the connections.

4. Use the following options to control the underlying MQ Connection Manager to create only the 

specified number of connections. These options are generally used by the MQ expert:

a. In Maximum quantity of connections, specify a number to ensure that a certain number of 

connections are open at a time only for MQ Java.

b. In Maximum quantity of unused connections, specify the maximum number of connections 

that should be unused among the open connections.

c. In Connection timeout (ms), specify a time after which there is no attempt to establish the 

connection.

When you run a schedule, the JMS/MQ connections are reused.

Related information

Web service test editor overview  on page223

Verifying application behavior  on page225

Working with Server Name Indication (SNI) recordings  on page181

Adding elements to a service test  on page237

Editing WSDL security profiles  on page242

Testing asynchronous services  on page262

Creating a reliable messaging call structure  on page266

Editing WSDL security profiles
To ensure that your service test uses the correct security protocols to access a SOAP-based service, you 

must specify a security profile for the (Web Service Description Language) WSDL file. After a security 

profile is set up, it can be reused in multiple web service calls.
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Related information

Web service test editor overview  on page223

Verifying application behavior  on page225

Working with Server Name Indication (SNI) recordings  on page181

Adding elements to a service test  on page237

Managing JMS/MQ connections in a service test  on page241

Testing asynchronous services  on page262

Creating a reliable messaging call structure  on page266

WSDL security editor overview
With the WSDL security editor you can create the SOAP algorithm stacks that are associated with a web 

service operation. Algorithm stacks contain digital certificate information and the security algorithms that 

are applied to messages to perform secure communication with a web service.

After you create an algorithm stack, you associate it with an operation that is specified in the Web 

Services Description Language (WSDL) file of the web service. Algorithm stacks remain available in the 

workspace and you can reuse them with other WSDL files. You can also edit a test to make the same web 

service call several times with different security configurations.

You use the WSDL security editor  to create and edit security configurations. The WSDL security editor 

contains two pages that correspond to the steps of setting up a security configuration:

• Describing a security stack

• Associating a security stack with each WSDL operation

Algorithm stacks

Algorithm stacks contain one or several algorithm blocks that are arranged in a sequence of steps. Each 

algorithm block modifies or transforms the message content. Algorithm blocks can add timestamps to, 

add tokens to, encrypt, or sign messages.

Use the Algorithm Stacks  page of the WSDL security editor to create stacks for service requests and 

responses. When a message is sent or received, each algorithm block in the stack is executed in the 

specified order. For example, you can define a request stack for outgoing requests that adds a timestamp, 

signs, and then encrypts the message content, and you can define a response stack that decrypts 

incoming responses. You can create as many algorithms as your application requires.
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You can edit algorithm blocks and move them up and down in the stack. Encryption and signature blocks 

can use keystores for digital certificates. Some algorithm blocks display messages that help you enter 

correct information. If the contents of the algorithm block are invalid, an error icon is displayed.

Raw transaction data view

When a stack is associated with a service request or response, viewing the results of each transformation 

step that is applied to the XML message content can be useful. You can use the Raw Transaction Data 

view to look at the message content before and after each algorithm in the stack.

Digital certificate keystores

You can add digital certificate keystores to a security stack to use with encryption or signature 

algorithms. Keystores must be declared with their associated passwords before the algorithms that use 

them. Digital certificates are contained in Java™  keystore files (KS, JKS, JCEKS, PKCS12, and PEM) that 

must be located in your workspace.

Associating stacks with WSDL operations

Use the Algorithms by WSDL operations  page of the WSDL security editor to associate a security 

algorithm stack with each web service call and message return in the WSDL file.

Related information

Creating security profiles for WSDL files  on page244

Using a security policy  on page246

Adding security stacks  on page248

Implementing a custom security algorithm  on page257

Adding WS-Addressing to a security configuration  on page260

Creating security profiles for WSDL files
You can create SOAP security profiles for the web service calls or message returns that require message 

encryption, signature or other advanced security algorithms.

You must have a Web Services Description Language (WSDL) file in your workspace.

If the security profile uses digital certificates for encrypting or signing requests or responses, you must 

have the corresponding keystore files (KS, JKS, JKECS, PKCS12, or PEM) in your workspace.
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If the WSDL is simple and you want to check its security, in the Request Stack  tab of the test editor, click 

Override Stack  > Tools  > Analyze Security from Pasted Content. Paste the SOAP XML message and 

click Next. The next page shows the different security algorithms used in the XML. Click Finish  to add the 

security algorithms to the editor.

Note:  When you add a secured SOAP XML message in Message  > Source  tab of the test editor, 

certain security related warnings are displayed in the Error Message  view. If you are aware of the secured 

SOAP XML message and do not want to view the warnings, click Window  > Preferences  > Generic Service 

Client  > Message Edition  and select the Analyze pasted SOAP content  check box.

If the WSDL uses WS-Policy, you must configure security as follows:

1. In the test navigator or project explorer, right-click the WSDL file and select Edit WSDL Security.

The WSDL security editor is displayed.

2. Click the Security Algorithms  tab.

Security profiles are described by adding elements to a stack. When a service request is sent or a 

response is received, each element in the stack is applied to the message in a specified order. If 

necessary, create one security profile for outgoing requests and one for incoming responses.

3. In the Security Algorithms  area, click Add  to create a new algorithm stack, and click Rename  to 

change the default name.

4. In the Algorithm Stack Details  area, click Add  to add a new algorithm element to the stack.

You can add time stamps, username tokens, encryption, or signatures.

5. Edit each element in the stack according to the requirements of the web service.

You can apply encryption and signature stack elements to portions of the web service call or 

message return document by specifying an Xpath query in User Xpath part selection. For example, 

you can encrypt one XML element with one encryption stack element, and another element with 

another stack element. You can use the Web Service Protocol Data  view to help identify the correct 

Xpath query for this option.

You can check whether the security stack is valid by clicking Tools  > Validate Selected Algorithm.

6. When all the stack elements are complete, ensure that the execution order is correct. 

If necessary, use the Up  and Down  buttons to change the order of elements in the stack.

7. Repeat steps 4 through 7 to create as many algorithms as are required for security profile.

8. Click the Algorithms by WSDL Operations  tab.

This page enables you to associate a security profile with each request or response operation in 

the WSDL.

9. In the WSDL Contents  column, select a service request or response.

10. In the Algorithm Stack column, select a security profile from the list.

If necessary, click <<  to open the stack on the Security Algorithms page.

245



Test Author Guide

246

After saving the security profile, the Web Service Protocol Data  view displays the effect of the security 

profile on the XML data of the web service.

Related reference

WSDL security editor reference  on page

Related information

WSDL security editor overview  on page243

Using a security policy  on page246

Adding security stacks  on page248

Implementing a custom security algorithm  on page257

Adding WS-Addressing to a security configuration  on page260

Using a security policy  on page246

Adding WS-Addressing to a security configuration  on page260

Implementing a custom security algorithm  on page257

Using a security policy
The WS-Policy specification enables web services to use XML to publish their security policies either as 

part of the Web Services Description Language (WSDL) file (compliant with the WS-PolicyAttachment 

specification) or as a separate XML document. With the WSDL Security Editor, you can create a security 

profile that uses a policy that complies with the WS-Policy specification.

Before creating a security configuration, you must have a WSDL file in your workspace.

If the security policy uses digital certificates for encrypting or signing requests or responses, you must 

have the corresponding keystore files (KS, JKS, JKECS, PKCS12, or PEM) in your workspace.

When you import a WSDL that contains a policy (with WS-PolicyAttachment), a security profile is 

automatically generated for each operation in the WSDL security editor.

1. In the test navigator or project explorer, right-click the WSDL file, and select Configure WSDL 

Security.

This opens the WSDL security editor.

2. Click the Security Algorithms  tab.

Security profiles are described by adding elements to a stack. When a service request is sent or a 

response is received, each element in the stack is applied to the message in the specified order.

unique_189
unique_189
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3. In the Security Algorithms  area, click Add  to create a profile, and click Rename  to change the 

default name.

4. In the Algorithm Stack Details  area, click Add  > WS-Policy  to add the WS-Policy element to the 

stack.

You can also add time stamps, user-name tokens, encryption, or signatures.

5. If the policy is included in the WSDL file, click Use policy included in WSDL (WS-

PolicyAttachment), and edit the WS-Policy settings as required:

Policy

If you are not using the WS-PolicyAttachment specification, specify the XML policy 

file. Click Browse  to add a policy file from the workspace or to import a policy file.

Signature configuration

Select this option to specify a keystore for any signature that is specified in the policy. 

Click Edit Security  to add a keystore from the workspace or to import a keystore.

Encryption configuration

Select this option to specify a keystore for any encryption that is specified in the 

policy. Click Edit Security  to add a keystore from the workspace or to import a 

keystore.

Decryption configuration

Select this option to specify a keystore for any decryption that is specified in the 

policy. Click Edit Security  to add a keystore from the workspace or to import a 

keystore.

Retrieve token from security token server (WS-Trust and WS-SecureConversation)

Select this option, and click Configure  to specify a Security Token Server (STS) to use 

with the policy.

Additional properties

Use this table to specify settings for the advanced properties or specific 

implementations of the WS-Security specification. Click Add  to add a property name 

and to set a value.

6. Check that the security profile is valid by clicking Tools  > Validate Selected Algorithm.

7. Click the Algorithms by WSDL Operations  tab.

On this page, you can associate a security profile with each request or response operation in the 

WSDL.

8. In the WSDL Contents  column, select a web service request or response operation.
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9. In the Algorithm Stack column, select a security profile from the list.

If necessary, click <<  to open the stack on the Security Algorithms  page.

After saving the security profile, the Web Service Protocol Data  view displays the result of the security 

profile on the XML data of the web service.

Related information

WSDL security editor overview  on page243

Creating security profiles for WSDL files  on page244

Adding security stacks  on page248

Implementing a custom security algorithm  on page257

Adding WS-Addressing to a security configuration  on page260

Creating security profiles for WSDL files  on page244

Adding WS-Addressing to a security configuration  on page260

Implementing a custom security algorithm  on page257

Adding security stacks
To provide better WSDL security, you can make use of many security algorithms in the service test.

1. From the Test Navigator view or from the Request Library section of Generic Service Client, right-

click the WSDL file and select Edit WSDL Security.

2. In the Security Algorithms  area of Algorithm Stacks  tab, click Add  to create a profile.

3. In the Stack Contents  area, click Add  and add any of the following security algorithms:

Custom Security Algorithm

If you want to use a Java™  class as a custom security algorithm, then use this stack 

element to apply the custom algorithm to the service.

Java™  Project

If you have not implemented a custom Java™  class, select Java 

Project, type a name for the new project, and click Generate  to create 

a new Java™  class with the default structure for custom security 

implementations.
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Note:  If you are using IBM®  Security AppScan®, this field is not 

available.

Implementation class

Specify the name of the class that implements the custom security 

algorithm. Click Browse Class  to select an existing Java™  class from 

the workspace.

Properties

Use this table to send any specific properties and associated values to 

the custom security algorithm.

WS-Addressing Algorithm

Use this block if your service uses either WS-Addressing 2004/08 or the WS-

Addressing 1.0 Core standard.

Namespace

Specify the namespace for either WS-Addressing 2004/08 or WS-

Addressing 1.0 Core.

Action if request uses WS-Addressing

Select the action to complete if WS-Addressing is already in the 

request.

Replace anonymous address in Reply-to with:

Select this option to generate the specified address in the Reply-to 

header instead of an anonymous address.

Remove WS-Addressing from response

Select this option to strip any WS-Addressing headers from the 

response.

Encrypted Key

This block defines an encrypted key that can be used in an XML signature or XML 

encryption block. The encrypted key block must be before a block that uses the 

encrypted key.

Actor / Role name

Specify the name of the recipient of the algorithm header element, if 

required.
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Must understand

Select whether it is mandatory that the algorithm header is processed 

by the recipient, if required. The recipient is either the Actor name or the 

server.

Key name

Specify the name of the encrypted key.

Identifier type

Select the type of key identifier to be used for the key. The following 

key identifiers are available, as defined in the the Web Service Security 

(WSS) specification X509 profile and OASIS WSS 1.1 specification:

• ISSUER_SERIAL

• BST_DIRECT_REFERENCE

• X509_KEY_IDENTIFIER

• THUMBPRINT_IDENTIFIER

• SKI_KEY_IDENTIFIER

Key size

Specify the size of the key in bits.

Key encoding algorithm name

Specify the algorithm to be used for encoding the key.

Keystore

Select a keystore or click Edit Security  to define a new keystore or to 

manage the existing keystores.

Name

Select a key contained in the specified keystore.

Password

Type the password for the selected key name.

XML Signature

The XML signature security algorithm specifies how the XML document is signed. For 

details on security algorithms, refer to the web service security specification.

Actor / Role name
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Specify the name of the recipient of the algorithm header element, if 

required.

Must understand

Select whether it is mandatory that the algorithm header is processed 

by the recipient, if required. The recipient is either the Actor name or the 

server.

Security token

Select the type of key identifier to be used for the signature. The 

following key identifiers are available, as defined in the the Web 

Service Security (WSS) specification X509 profile and OASIS WSS 1.1 

specification:

• ISSUER_SERIAL

• BST_DIRECT_REFERENCE

• X509_KEY_IDENTIFIER

• SKI_KEY_IDENTIFIER

• KEY_VALUE

• USER_NAME_TOKEN

• CUSTOM_SYMM_SIGNATURE

In addition, the following identifiers are available when the signature is 

based on a UsernameToken profile:

• USER_NAME_TOKEN

• CUSTOM_SYMM_SIGNATURE

User XPath part selection

Specify an XPath query that describes parts of the XML document that 

can be the subjects of the algorithm. By default, the body is the subject. 

Click the XPath Helper  button to build the Xpath expression.

Key

Select the key used for the encryption. The details of each key vary.

• x509 key: This key specifies the name and password of the x509 

key and the keystore where it is located.

• User name token key: This specifies a user name and password 

for the signature.
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• Encrypted key: This specifies a reference to an encrypted key 

that was previously defined in the security stack. Click Insert 

a new encrypted key  to create a new encrypted key definition 

block.

Signature algorithm name

Specify the signature method algorithm as described in the XML 

Signature Syntax and Processing specification.

Canonicalization

Specify the canonicalization method to be used as described in the 

XML Signature Syntax and Processing specification.

Digest algorithm method

Specify which digest method to be used based on the algorithm method 

used on the server side.

Inclusive namespaces

Specify whether the canonicalization is exclusive as described in the 

Exclusive XML Canonicalization specification.

XML Encryption

The XML encryption security algorithm specifies how the XML document is 

encrypted. For details on security algorithms, refer to the web service security 

specification.

Actor / Role name

Specify the name of the recipient of the algorithm header element, if 

required.

Must understand

Select whether it is mandatory that the algorithm header is processed 

by the recipient, if required. The recipient is either the Actor name or the 

server.

Identifier type

Select the type of key identifier to be used for the encryption. The 

following key identifiers are available, as defined in the Web Services 

Security (WSS) specification X509 profile and the OASIS WSS 1.1 

specification:
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• ISSUER_SERIAL

• BST_DIRECT_REFERENCE

• X509_KEY_IDENTIFIER

• SKI_KEY_IDENTIFIER

• EMBEDDED_KEYNAME

• THUMBPRINT_IDENTIFIER

• ENCRYPTED_KEY_SHA1_IDENTIFIER

User XPath part selection

This enables you to specify an XPath query that describes parts of the 

XML document that can be subjects of the algorithm. By default, the 

body is the subject.

Key

Select the key used for the encryption. The details of each key vary.

• x509 key: This specifies the name and password of the x509 key 

and the keystore where it is located.

• Raw key: This specifies the name and the byte value of your 

SecretKey in hexadecimal.

• Encrypted key: This specifies a reference to an encrypted key 

that was previously defined in the security stack. Click Insert 

a new encrypted key  to create a new encrypted key definition 

block.

Encoding Algorithm Name

Specify the encryption method to be used as defined in the XML 

Encryption Syntax and Processing specification.

Key Encoding Algorithm

Specify the standard algorithm for encoding the key as defined in the 

XML Encryption Syntax and Processing specification.

User name token

The user name token security algorithm adds a user name token to the XML 

document in the message. For details on security algorithms, refer to the web service 

security specification.

Actor / Role name

Specify the name of the recipient of the algorithm header element, if 

required.
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Must understand

Select whether it is mandatory that the algorithm header is processed 

by the recipient, if required. The recipient is either the Actor name or the 

server.

Name

Type the name of the user.

Password

Type the password of the user.

Password type

Specify the password type for the security algorithm as defined in the 

Web Services Security UsernameToken profile.

Use nonce

Select this check box to add the Nonce element to the User Name 

Token XML code. In most cases, the Nonce ID is required.

Use created

Select this check box to add current timestamp to the Created XML 

element in the User Name Token XML.

Time Stamp

The time stamp security algorithm adds time stamp information to the XML 

document in the response. For details on security algorithms, refer to the web service 

security specification.

Actor / Role name

Specify the name of the recipient of the algorithm header element, if 

required.

Must understand

Select whether it is mandatory that the algorithm header is processed 

by the recipient, if required. The recipient is either the Actor name or the 

server.

Expiration delay

Specify the delay after which the time stamp expires.

Millisecond precision



Chapter 1. Test Author Guide

Select this option to produce a time stamp that uses millisecond 

precision instead of the default (1/100th second).

SAML Assertion Block

To use the self-signed SAML assertion security algorithm, add the SAML Assertion 

stack to the request or WSDL files.

User XPath part selection

Specify an XPath query that describes parts of the XML document that can be the 

subjects of the algorithm. By default, the body is the subject. Click the XPath Helper 

button to build the Xpath expression.

Key

Select the key used for the encryption. The details of each key vary.

• x509 key: This key specifies the name and password of the x509 key and the 

keystore where it is located.

• User name token key: This specifies a user name and password for the 

signature.

• Encrypted key: This specifies a reference to an encrypted key that was 

previously defined in the security stack. Click Insert a new encrypted key  to 

create a new encrypted key definition block.

Signature algorithm name

Specify the signature method algorithm as described in the XML Signature Syntax 

and Processing specification.

Canonicalization

Specify the canonicalization method to be used as described in the XML Signature 

Syntax and Processing specification.

Digest algorithm method

Specify which digest method to be used based on the algorithm method used on the 

server side.

Inclusive namespaces

Specify whether the canonicalization is exclusive as described in the Exclusive XML 

Canonicalization specification.

Signed Assertion

Select this check box to self-sign the SAML Assertion.
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Issuer

Specify the description of the issuer of the SAML Assertion or protocol message.

Subject

Specify the principal that is the subject of all of the statements in the assertion. It 

might contain an identifier or a series of one or more subject confirmations.

Subject Qualifier

Specify the Name Qualifier of the Subject

Subject Format

Specify the format used for the Subject.

Subject Locality DNS

Specify the DNS domain name for the system from which the assertion subject was 

authenticated.

Subject Locality IP

Specify the IP address for the system from which the assertion subject was 

authenticated.

Statement Type

Specify the authentication method to use for the assertion.

Authentication: The assertion subject was authenticated

Attribute: The specified subject is associated with the supplied attributes.

Authorization decision: Permission to allow a subject to access the specified 

resource.

Requested Resource

When Authorization decision  option is used, specify the resource for which you need 

access.

Action

Specify what action to take to access the resource.

Confirmation number

Confirmation methods define the mechanism by which an entity provides evidence 

(proof) of the relationship between the subject and the claims of the SAML 

assertions.
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Sender vouches: Select this option when a server needs to share the client identity 

with SOAP messages on behalf of the client. This method is similar to identity 

assertion, but it has the added flexibility of using SAML assertions to share not only 

the client identity, but also client attributes.

Holder of key: Select this option when the proof of the relationship between the 

subject and claims is established by signing part of the SOAP message with the key 

specified in the SAML assertion. Because there is key material associated with a 

holder-of-key token, this token can be used to provide a message-level protection 

(signing and encryption) of the SOAP message.

Bearers: Select this option when the proof of the relationship between the subject 

and claims is implicit. No specific steps are taken to establish the relationship. 

Because there is no key material associated with a bearer token, protection of the 

SOAP message, if required, must be performed using a transport-level mechanism 

or another security token, such as an X.509 or Kerberos token, for message level 

protection.

Version

Specify the SAML version used.

4. Optional:  To verify simple SAML code, use the Analyze Security from Pasted Content  option.

For more information about that option, see Creating security for WSDL profiles  on page 244.

Related information

WSDL security editor overview  on page243

Creating security profiles for WSDL files  on page244

Using a security policy  on page246

Implementing a custom security algorithm  on page257

Adding WS-Addressing to a security configuration  on page260

Implementing a custom security algorithm
You can define your own security algorithms for SOAP security profiles by implementing custom security 

Java™  interfaces that can be used in the WSDL security editor. With custom security algorithms, you can 

implement proprietary security algorithms that transform the XML before sending and after receiving 

message content.
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The custom security interface and the JAR file that contains it are provided with the product in the 

customsecuritydefinition  folder of the com.ibm.rational.ttt.common.models.core 

plugin. You need these interfaces to create your own algorithms. If you are using IBM®  Rational® 

Performance Tester  or IBM®  Rational®  Service Tester for SOA Quality, see Extending test execution with 

custom code  on page  for more information about extending test capabilities with Java™  code.

1. In the test navigator or project explorer, create a new Java™  class in your web service test project 

folder.

2. Implement a security algorithm in Java™  using the following interface:

/**

* ***************************************************************

* IBM Confidential

* 

* (c) Copyright IBM Corporation. 2008. All Rights Reserved.

* 

* The source code for this program is not published or otherwise

* divested of its trade secrets, irrespective of what has been

* deposited with the U.S. Copyright Office.

* *************************************************************** 

* 

*/

 

package com.ibm.rational.test.lt.models.wscore.datamodel.security.xmlsec;

 

import java.util.Properties;

import org.w3c.dom.Document;

 

 

public interface ICustomSecurityAlgorithm {

 

 /**

  * The following methods can be used in both case:

  * Execution in the workbench and execution of the test.

  */

 

 

 /**

../../com.ibm.rational.test.lt.common.doc/topics/textndteswcc.html
../../com.ibm.rational.test.lt.common.doc/topics/textndteswcc.html
../../com.ibm.rational.test.lt.common.doc/topics/textndteswcc.html
../../com.ibm.rational.test.lt.common.doc/topics/textndteswcc.html
../../com.ibm.rational.test.lt.common.doc/topics/textndteswcc.html


Chapter 1. Test Author Guide

  * Called to process de Document that is sent over a transport.

  * @param subject

  */

 void process(Document subject);

 /**

  * Called to un process a document that is received from a server.

  * @param subject

  */

 void unProcess(Document subject);

 

 /**

  * Properties defined in the UI of the CustomSecurityAlgorithm.

  * @param map

  */

 void setProperties(Properties map);

 

 /**

  * The following methods can only be used in terms of cast to test service interface,

  * or in terms of access to the previous XML  information, when the jar containing

  * the custom security algorithm is deployed in the performance test project. In

  * this case you cannot use the algorimth directly from the workbench.

  */

 

 /**

  * This object corresponds to the ITestExecutionService object.

  * This applies only to an algorithm that must link to the execution of the test.

  * If you plan to use this object you will need to deploy the jar containing the

  * implementation into your performance test project and not directly into the JRE.

  * 

  * In case of a need of the previous xml document received from the execution you can 

  * obtain the value using:

  * IDataArea area = ((ITestExecutionService)executionObject).findDataArea(IDataArea.VIRTUALUSER);

  *String previousXML = (String) area.get("PREVIOUS_XML"); //$NON-NLS-1$

  * 

  */

 void setExecutionContext(Object executionObject);

The process  method modifies the XML before it is sent to the server.
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The unprocess  method modifies the XML after it is received from the server.

The setProperties  method retrieves any properties that are defined in the security editor for this 

custom security interface.

The setExecutionContext  method is called during test with the object ITestExecutionServices  that 

corresponds to the message using this custom security interface.

3. The custom security interface can be used either in the WSDL security editor  for web services or in 

XML call elements in the Local XML security  tab.

• If you are testing a WSDL-based web service, right-click the WSDL file in the test navigator or 

project explorer to open the WSDL security editor, select the Security Algorithms  page; then, 

under Details of selected security algorithm stack, click Add  > Custom Security Algorithm.

• If you are testing an XML call, open the XML call element in the test editor, select the Local 

XML Security  tab, and then, click Add  > Custom Security Algorithm

4. In custom security, click Browse Class  to select the class name of the custom security algorithm, 

for example : ICustomSecurityAlgorithm.

5. Type an Algorithm name  for the custom security algorithm.

6. In the properties list, use Add, Remove, or Edit  to specify any properties that are used by the 

setProperties  method in your custom security algorithm.

After saving the security configuration or the call element, the Web Service Protocol Data  view displays 

the effect of the security algorithm on the XML data of the web service.

Related reference

WSDL security editor reference  on page

Related information

WSDL security editor overview  on page243

Creating security profiles for WSDL files  on page244

Using a security policy  on page246

Adding security stacks  on page248

Adding WS-Addressing to a security configuration  on page260

unique_189
unique_189
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Adding WS-Addressing to a security configuration
The WS-Addressing specification provides transport-neutral mechanisms that enable SOAP-based web 

services to communicate addressing information. You can use WSDL security algorithms to add WS-

Addressing to your service tests.

Before adding WS-Addressing to a security configuration, you must have a service test with requests and 

responses that are related to a valid WSDL.

To add WS-Addressing to a WSDL security algorithm:

1. Open the test, select a service request, and in the Raw Transaction Data  view, select Enable the 

display of the XML document after the security processing.

2. On the Request Stack  page, click Edit WSDL Security .

Tip:  If you need to edit separate security or processing algorithms for incoming responses, 

click Show Response Stack  to add a Response Stack  page to the editor.

The WSDL security editor  opens.

3. Select the Algorithm Stacks  page of the WSDL security editor, and in the Security Algorithm  list, 

select or create a security algorithm.

4. In the Stack Contents  list, click Add  > WS-Addressing  and specify the settings that are 

implemented by the service.

WS-Addressing Algorithm

Use this block if your service uses either WS-Addressing 2004/08 or the WS-

Addressing 1.0 Core standard.

Namespace

Specify the namespace for either WS-Addressing 2004/08 or WS-

Addressing 1.0 Core.

Action if request uses WS-Addressing

Select the action to complete if WS-Addressing is already in the 

request.

Replace anonymous address in Reply-to with:

Select this option to generate the specified address in the Reply-to 

header instead of an anonymous address.

Remove WS-Addressing from response
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Select this option to strip any WS-Addressing headers from the 

response.

5. Save the WSDL security algorithm, and select the test editor.

The WS-Addressing namespace and header XML content is displayed in the Raw Transaction Data 

view.

Related reference

WSDL security editor reference  on page

Related information

WSDL security editor overview  on page243

Creating security profiles for WSDL files  on page244

Using a security policy  on page246

Adding security stacks  on page248

Implementing a custom security algorithm  on page257

Creating security profiles for WSDL files  on page244

Implementing a custom security algorithm  on page257

Testing asynchronous services
Use the asynchronous callback services for inter-object communications in a service test.

Related information

Web service test editor overview  on page223

Verifying application behavior  on page225

Working with Server Name Indication (SNI) recordings  on page181

Adding elements to a service test  on page237

Managing JMS/MQ connections in a service test  on page241

Editing WSDL security profiles  on page242

Creating a reliable messaging call structure  on page266

unique_189
unique_189
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Asynchronous service testing overview
Asynchronous services use a callback interaction pattern for inter-object communications. Asynchronous 

services can be used, for example, in publish-subscribe systems that are provided by message-oriented 

middleware vendors or in system and device management domains.

WS-Notification services

Asynchronous services are standardized in the WS-Notification  specifications:

• WS-BaseNotification  defines the web services interfaces for NotificationProducers  and 

NotificationConsumers. This specification includes standard message exchanges that are 

implemented by service providers that want to act in these roles, along with the associated 

operational requirements.

• WS-BrokeredNotification  defines the web services interface for a NotificationBroker. A 

NotificationBroker is an intermediary which, among other things, enables entities that are not 

service providers themselves to publish messages. It includes standard message exchanges that 

are implemented by NotificationBroker service providers, along with the associated operational 

requirements of service providers and requestors that participate in brokered notifications.

• WS-Topics  defines a mechanism to organize and categorize items of interest for subscription 

known as topics. These are used in conjunction with the notification mechanisms defined in WS-

BaseNotification and WS-BrokeredNotification.

You can test web services and XML services that implement the WS-Notification specification by creating 

an asynchronous request inside a test. The asynchronous request contains the interfaces for the 

corresponding WS-Notification specification, along with a callback structure.

Proprietary asynchronous services

You can test proprietary asynchronous services that do not implement WS-Notification specifications. To 

test these services, you manually create a service request that contains the interfaces for the service, and 

then, you can add the asynchronous callback structure to the request.

The XML data of the asynchronous request must contain an endpoint that specifies the URL of the 

callback receiver. During the test, this endpoint is used to redirect the callback to the tester instead of the 

real receiver.

Callback structure

To test asynchronous services, you must create an asynchronous request structure in your test as shown 

in the following diagram:
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A web service request or a plain XML request provides the subscription action and contains a callback 

element, which describes the behavior of the test in three states:

• Parallel  contains test elements that are run after the subscription request and while waiting for the 

notification response.

• Receive  contains test elements that are run when the notification response has been received from 

the service.

• Timeout  contains test elements that are run if the notification response is not received after a delay 

that is specified in the callback element.

When everything contained in the parallel, receive, and timeout elements have finished running, the run 

continues with the next element in the test after the asynchronous request.

The method for generating the asynchronous callback structure in the test depends on whether the 

asynchronous service uses the WS-Notification specification:

• WS-Notification services: Create the asynchronous request in the test.

• Proprietary services: Manually create a web service request or XML request in the test, and then 

add the asynchronous callback structure to the request.

Creating an asynchronous request structure
You can create an asynchronous request based on the WS-Notification  specification, which contains an 

callback structure.

1. In the test editor, select the test, and click Add, and then click Specification-based Structure.

The New Web Service Test  wizard opens.
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2. On the Web Services Specification Selection  page, Select WS-Notification, and click Next.

3. On the WS-Notification Details  page, if the service has a Web Services Description Language 

(WSDL) file, click Add  to associate it with the call.

4. Specify the Subscription identifier.

You can select default identifiers for Websphere Application Server or Apache Muse; or if your 

service does not use a standard identifier, you can select Custom, and type the Name  and 

Namespace  of the identifier.

5. In the Topic  area, replace the default Name  and Namespace  values with those of topic of your 

service.

6. Specify the Subscription duration.

Because this is a test environment, the subscription expires after the specified delay to save server 

resources.

7. If this is a WS-BrokeredNotification service, which implements a notify call when the subscription is 

received, you can select Add notify call, and type the message to be sent.

8. Click Next.

9. On the Configure Protocol  page, select a Protocol configuration, and specify the options of the 

configuration.

Select Generate SOAP 1.2 envelope  if you are testing a SOAP 1.2 web service.

10. Click Finish.

This action generates in the test editor a web service call or an XML request with a callback 

structure that contains a parallel, a receive, and a timeout element.

In the callback structure, add test elements to the parallel, receive, and timeout elements to specify the 

behavior of the test:

• Parallel  contains test elements that are run after the asynchronous call has been sent.

• Receive  specifies the message return of the callback and contains test elements that are run after 

the callback is received.

• Timeout  contains test elements that are run if the callback is not received after a specified delay.

Adding an asynchronous callback to a service request
To test a proprietary asynchronous service that does not implement the WS-Notification  specification, you 

can add an asynchronous callback to a service request or XML request.
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Manually create a web service call or XML call that invokes the asynchronous service. The call must 

contain an endpoint that specifies the URL of the callback receiver. This endpoint is used to redirect the 

callback to the tester.

If the service implements the WS-Notification specification, create the asynchronous call structure with 

the Create New WS-Notification Request and Callback  wizard instead. See Creating an asynchronous 

request structure  on page 264.

1. In the test editor, select a web service or XML request, click Add, and then click Asynchronous 

Callback.

The Create New Asynchronous Callback  wizard opens.

2. On the Select Callback Endpoint  page, select the XML element of the request where the endpoint 

URL of the callback is located.

3. If you have a web Services Description Language (WSDL) file for the web service, click Next. 

Otherwise, skip to step 5.

4. On the Bind Message to WSDL Port  page, select a port from the WSDL file. If the WSDL file for the 

service is not listed, click Add  to add a WSDL file from the workspace or to import a WSDL file.

5. Click Finish.

This generates a callback structure that contains a parallel, a receive, and a timeout element, in the 

test editor.

In the callback structure, you can add test elements to the parallel, receive, and timeout elements to 

specify the behavior of the test:

• Parallel  contains test elements that are run after the asynchronous request has been sent.

• Receive  specifies the message return of the callback and contains test elements that are run after 

the callback is received.

• Timeout  contains test elements that are run if the callback is not received after a specified delay.

Creating a reliable messaging call structure
You can create a test structure dedicated to testing service calls based on the WS-ReliableMessaging 

specification.

The WS-ReliableMessaging specification provides for a series of SOAP messages to be delivered reliably 

between distributed applications in the presence of software component, system, or network failures. In 

the context of a service test, a reliable messaging call structure consists of a series of calls that conform 
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to the specification. The structure can be created either as a sequential list of unique service calls or a 

loop that contains a call element and uses a dataset to identify the unique calls.

1. In the test editor, select the test, and click Add, and then click Specification-based Structure.

The New Web Service Test  wizard opens.

2. On the Web Service Specification Selection  page, Select WS-ReliableMessaging, and click Next.

3. Select one or several Web Services Description Language (WSDL) files in your workspace for the 

web service that you want to test, and click Next.

If necessary, you can import a WSDL file into the workspace with the Import  push button.

4. On theConfigure Protocol  page, select an existing HTTP transport configuration, or click New  to 

create a new configuration.

a. Specify the URL  of the service, the HTTP Method, and Version.

b. In the Header  table, click Add  to specify any specific headers that need to be added to the 

call.

c. In the Cookies  table, click Add  to specify any specific cookies that need to be used by the 

call.

d. Click Next.

5. On the Sequence Options  page, specify how the sequence structure will be created in the test.

a. In Message count, specify the number of calls in the list or the number loop iterations.

b. Select Create service call list  to generate a list of calls with the number of messages or 

Create loop with dataset  to generate a loop with a dataset.

The dataset defines the call number for each call in the loop.

c. Select Shuffle sequence  if you want the call numbers to be generated in a random order.

6. Click Finish.

This action generates a reliable messaging service call structure in the test.

Related information

Web service test editor overview  on page223

Verifying application behavior  on page225

Working with Server Name Indication (SNI) recordings  on page181

Adding elements to a service test  on page237

Managing JMS/MQ connections in a service test  on page241
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Editing WSDL security profiles  on page242

Testing asynchronous services  on page262

Editing Socket tests
Improve the Socket tests by adding test elements.

Socket API test editor overview
You use the test editor to inspect or customize a socket API test that you recorded.

The test editor lists the connections and data exchanges for a test as they occurred during the recording.

The test editor window has two main areas. The area on the left, Test Contents, displays the flow of the 

socket events that constitute the test. The area on the right, Test Element Details, displays details about 

the currently selected test element in the test hierarchy.

Values can sometimes be highlighted in green. This highlighting indicates that these requests contain one 

or both of the following types of information:

• A dataset candidate:  This is a value, usually one specified by the tester during recording, that the 

test generator determined is likely to be replaced by values in a dataset. An example of a dataset 

candidate is a string that you search for in a recorded test. The string is highlighted as a dataset 

candidate on the assumption that, before playback, you might want to associate the string with a 

dataset column that contains appropriate substitute values.

• Correlated data:  These are values in a test, usually one of them in a response and the other in a 

subsequent request. An example is a product price returned to the browser by a test that searches 

a product database. You can use these values as references that can be reused later in the test. 

Suppose that, before running the test with many virtual users, you replace the product name 

searched for in the recorded test with names in a dataset. Because the test correlates the data, 

each virtual user searches for a different product, and the server returns an appropriate price.

To see an illustration of color coding in performance tests or to change the color settings, click Window  > 

Preferences  > Test  > Fonts and Colors.

Click Add  to add elements to the selected test element. Alternatively, you can right-click a test element, 

and select an action from a menu. The choices that you see depend on what you have selected. For 

example, after you select a test, you can add a new event.

The Insert  button works similarly. Use it to insert an element before the selected element.
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Use the other buttons (Remove, Up, Down) primarily when you substantially modify a test.

Tip:  Performing actions with these buttons or choices are likely to break a recorded test.

Sometimes, the area of the editor where you need to work is obscured. To enlarge an area, move your 

cursor over one of the blue lines until your cursor changes shape to a vertical line with an up arrow at the 

top and a down arrow at the bottom, and drag up or down while holding the left mouse button.

Displaying binary data

With the Socket Details  view, you can display the binary data for send and receive elements in the test. 

The text area of the Socket Details  view supports many international character encoding standards. To 

open the Socket Details view, right-click a socket send or receive element, and click Show Socket Details.

In the test log, the Socket Details  view also displays actual the actual binary data sent and received during 

a test run.

Manipulating elements in the socket test editor
Socket tests are often made of a long series of send and receive elements to or from various 

connections. The test editor helps you to locate specific elements and to manipulate certain types of 

elements in the test editor. The following examples demonstrate how you can select and manipulate large 

sets of test elements:

• To select all the send or receive elements in the test: Click the Select  button and click Socket Send 

or Socket Receive.

• To locate all the connections in the test: Click the Select  button and click Socket Connection.

• To disable or remove all send and receive actions to or from a specific connection: Right click 

a test element, click Manage Socket Connections, click Only disable them, and select the 

connections that you want to disable or remove.

• To reenable all disabled send and receive actions to or from a specific connection: Right click a 

connection element, click Select All Related Actions, right-click again, and click Enable.

Related information

Merging socket send and receive elements  on page275

Changing multiple socket send and receive elements  on page276

Adding elements to a socket test
A socket test provides the flexibility to add close, send, and receive elements to the test.
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Adding a socket close
You can manually add a socket close element to a socket API performance test.

In a performance test, socket close elements close the connection to a server. A socket close element 

relates to a specific socket connection.

Ensure that for each socket connection, there is a corresponding socket close. If not, during the test run, 

the operating system can run out of socket handles, causing the test to fail.

1. Open the performance test in the test editor.

2. In the Test Contents  area of the test editor, right-click the test node, and click Add  > Socket Close.

3. In the Test Element Details  section, click Change  and select the socket connection that you want 

to close.

You can specify a Think Time  delay before the test establishes the connection.

After you have closed a connection, you can no longer send or receive data from that connection. If any 

test elements use a connection after the close element, they are flagged with an error in the test editor.

Adding a socket send
You can manually add a socket send element to a socket API performance test.

In a performance test, socket send elements describe how data is sent over a connection. A socket send 

element relates to a specific socket connection.

1. Open the performance test in the test editor.

2. In the Test Contents  area of the test editor, right-click the test node, and click Add  > Socket Send.

3. In the Test Element Details  section, click Change, and select the socket connection that you want 

to send data to.

You can specify a Think Time  delay before the test establishes the connection.

4. In the Data  area, type the data that you want to send.

By default, data is sent as 7-bit alphanumeric characters. To specify hexadecimal bytes, prefix the 

data with \x, for example: \x00\xff
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Adding a socket receive element
You can manually add a socket receive element to a socket API performance test.

In a performance test, socket receive elements describe how data is received over a connection. A socket 

receive element relates to a specific socket connection.

1. Open the performance test in the test editor.

2. In the Test Contents  area of the test editor, right-click the test node, and click Add  > Socket 

Receive.

3. In the Test Element Details  section, click Change  and select the socket connection that you want 

to receive data from.

You can specify a Think Time  delay before the test establishes the connection.

4. Specify the End Policy.

This specifies when the receive element stops receiving data and the test resumes:

• Detects inactivity: The receive action stops when no bytes are received from the connection 

after a delay specified in Inactivity threshold  (in milliseconds). After this delay, the remote 

computer has finished sending the response and is considered inactive. This is the default 

setting.

• Receives exact number of bytes: The receive action stops when the recorded number of 

bytes is received. Specify a Timeout  (in seconds) after which the receive action produces 

an error in the test log, if the correct number of bytes is not received. If Link data size  is 

enabled, the receive action expects the number of bytes displayed in the Data  area. If Link 

data size  is disabled, the receive action expects the number of bytes displayed in Bytes.

• Receives until end of stream: The receive action stops when the connection is closed by the 

remote computer. If Accepts empty response  is selected, then the reception of a single byte 

is not  required and the Response Timeout  is ignored. Specify a Timeout  (in seconds) after 

which the receive action produces an error in the test log, if the correct number of bytes is 

not received.

• Matches a string: The receive action stops when a specified sequence of bytes is received. 

Specify a Timeout  (in seconds) after which the receive action produces an error in the test 

log, if the correct number of bytes is not received.

• Recognizes a regular expression: The receive action stops when a sequence of bytes 

that matches a regular expression is received. Specify a Timeout  (in seconds) after which 

the receive action produces an error in the test log, if the correct number of bytes is not 

received.

5. In the Data  area, type the data that you expect to receive.

By default, data is sent as 7-bit alphanumeric characters. To specify hexadecimal bytes, prefix the 

data with \x, for example: \x00\xff.
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Verifying application behavior
Add the different verification points to verify the responses in a socket test.

Verifying received content
With content verification points, you can check that actual received data matches the expected data that 

is specified in the verification point.

When you add verification points, the received data is compared with the expected data that is specified 

in the verification point test element. With content verification points enable, you can directly compare the 

content data that the server returns and return a Pass status when the criteria is met.

To add a content verification point to a socket test:

1. Open the test editor, right click a socket receive element, and select Add  > Content Verification 

Point.

2. Select the verification point, and in the Test Element Details  area of the test editor, specify the 

verification criteria:

Comparison operator

Specify the criteria to use to perform the verification, among the following operators:

Equals

The verification point returns a Pass status if the received data exactly 

matches the text or binary content that is specified in the Data  area.

Contains

The verification point returns a Pass status if the text or binary content 

that is specified in the Data  area occurs at least once in the received 

data.

Starts with

The verification point returns a Pass status if the text or binary content 

that is specified in the Data  area occurs at the beginning of the received 

data.

Ends with

The verification point returns a Pass status if the text or binary content 

that is specified in the Data  area occurs at the end of the received data.
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Differs from

The verification point returns a Pass status if the received data does 

not exactly match the text or binary content that is specified in the Data 

area.

Does not contain

The verification point returns a Pass status if the text or binary content 

that is specified in the Data  area does not occur at least once in the 

received data.

Does not start with

The verification point returns a Pass status if the text or binary content 

that is specified in the Data  area does not occur at the beginning of the 

received data.

Data

Specify the data that is expected to be received through the connection.

Binary

In this view, edit the expected content as binary data.

Raw ASCII

In this view, edit the expected content as raw ASCII data. Bytes are 

expressed as 7-bit alphanumeric characters or two-digit hexadecimal 

bytes preceded with \x. Additionally, \r  and \n  stand for carriage-return 

and line-feed, while \\  represents the backslash character.

You can enable or disable each socket verification point by clicking Enable verification point  in the test 

editor.

Verifying received message size
With size verification points, you can check that actual received data matches the expected data size in 

bytes as specified in the verification point.

When you add verification points, the received data is compared with the expected data that is specified 

in the verification point test element. With size verification points, you can check the number of bytes in a 

socket receive element and return a Pass status when the criteria is met.
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To add a size verification point to a socket test:

1. Open the test editor, right click a socket receive element, and select Add  > Size Verification Point.

2. Select the verification point, and in the Test Element Details  area of the test editor, specify the 

verification criteria:

Comparison operator

Specify the criteria that is used to perform the verification with these operators:

• Is

• Is less than

• Is less or equals

• Is more than

• Is more than or equal to

• Is not

Value (bytes)

Specify the size criteria for the verification point.

You can enable or disable each socket verification point by clicking Enable verification point  in the test 

editor.

Verifying received data with custom Java™  code
With custom verification points, you can use Java™  code to verify the data received through a connection.

Using Java™  custom code requires knowledge of the Java™  programming language and of the Rational® 

Performance Tester  API. See Executing test execution with custom code  on page  for more 

information.

When you add verification points, the received data is compared with the expected data that is specified in 

the verification point test element. Custom verification points return a Pass status when the custom class 

returns a Pass status after performing a verification written in Java™  code.

To add a custom verification point to a socket test:

1. Open the test editor, right click a socket receive element, and select Add  > Custom Verification 

Point.

2. Select the verification point, and in the Test Element Details  area of the test editor, click Generate 

Code.
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This action generates a Java™  class that is based on the template of the Rational®  Performance 

Tester  API for socket custom verification points.

3. Edit the Java™  code to define the specific verification action to perform.

4. Save and close the Java™  class.

To modify the custom class, click View Code  to open the code in the Java™  editor. You can enable or 

disable each socket verification point by clicking Enable verification point  in the test editor.

Merging socket send and receive elements
With the Organize  wizard, you can merge consecutive send or receive elements that use the same 

connection to improve the clarity of your socket test.

The wizard can perform the following actions when merging socket test elements:

• Merge consecutive socket send elements that use the same connection.

• Merge consecutive socket receive elements that use the same connection.

• Delete all socket receive elements except for the last one, which is necessary to synchronize the 

test.

To perform a merge, the selected elements must be consecutive and must be to or from the same 

connection.

To merge send or receive elements in a socket test:

1. Select the socket send or receive elements that you want to merge.

Press the Shift  key to select multiple consecutive elements in the test editor.

2. Right-click the selection and click Organize Send and Receive Actions. This opens the Organize 

wizard.

3. Choose one of the following options:

• Select Merge all selected send or receive actions  to merge the selected elements.

• Select Merge all selected send and keep a single receive  to delete all socket receive 

elements except the last one.

4. Click Next.

5. If your selection contained send elements that could be merged, specify the Custom Code  settings 

that should be retained for the merged element, and click Next.

6. If your selection contained receive elements that could be merged, specify the Response Timeout 

and End Policy  settings that should be retained for the merged element, and click Next.

7. Click Finish  to perform the merge.
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Related information

Socket API test editor overview  on page268

Changing multiple socket send and receive elements  on page276

Changing multiple socket send and receive elements
You can perform global changes to multiple send and receive elements in a socket test.

With the Organize  wizard, you can perform the following global changes on multiple send and receive 

elements:

• Change the Custom Code data manipulation settings on selected send elements.

• Change the Response Timeout and End Policy settings on selected receive elements

You can also apply a global change strategy  that applies to all the selected send and receive elements. A 

change strategy can change the settings and merge send and receive elements at the same time.

To perform global changes on a series of send or receive elements:

1. Select the socket send or receive elements that you want to merge.

Press the Shift  key to select multiple consecutive elements in the test editor. Use the Select  button 

to select a specific type of test element. Right-click a connection and click Select All Related 

Actions  to select all elements that use a specific connection.

2. Right-click the selection and click Organize Send and Receive Actions. This opens the Organize 

wizard.

3. Choose one of the following options:

• If you want to modify the selected elements, select Change settings on all selected send 

and receive elements.

• If you want to modify all elements that use a specific connection, select Change settings on 

all elements related to a specific connection, click Next, and then select the connections for 

which you want to change the settings.

4. Click Next.

5. If you want to change send elements, select Globally change, specify the new custom code 

settings for data manipulation that you want to apply to all send elements, and then click Next.

6. If you want to change receive elements, select Globally change, specify the new response timeout 

or end policy settings that you want to apply to all receive elements, and then click Next.

7. Click Finish  to apply the changes.
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Related information

Socket API test editor overview  on page268

Merging socket send and receive elements  on page275

Splitting a socket test
After you record a test, you can split it into smaller tests. Splitting tests enables you to create modular 

building blocks of smaller tests and combine them to make bigger tests. The original test is unchanged. 

You can recombine these building blocks in a schedule, including loops and conditions.

When reusing split tests in a schedule, you must ensure that the general test structure is consistent 

including socket connection and close elements. For example, you must ensure that all socket send and 

receive elements are preceded with a corresponding socket connection and followed by a socket close 

element. When the split tests are recombined in the schedule, you must place them in the correct order.

1. In the Test Navigator, browse to the test and double-click it. The test opens.

2. Right-click a socket send or receive element in the test, and select Split Test. The page that you 

click is the first page of the new test.

3. In the New Test Names  window, confirm the location of the split, optionally provide names and 

descriptions for the split tests, and click Next.

4. In the Split Test  window, examine the changes to be performed as a result of the split, and click 

Finish.

For example, you could record a test that contains the following actions:

• Logging on to a server.

• Creating an entry on the server and removing the entry.

• Editing an entry, validating that the change occurred, and restoring the entry.

• Logging off of the server.

You then split the test into four parts: Logon, Create, Edit, and Logoff. You create a schedule that 

runs virtual users selected from a dataset. Each virtual user runs the Logon test, performs various 

combinations of the Create and Edit tests, and finally runs the Logoff test.
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Using custom code to specify an end policy
You can write a custom Java™  class to specify when a socket receive element stops receiving. This offers 

the most flexibility, but requires that you write your own Java™  class using the Rational®  Performance 

Tester  extension API.

The end policy specifies how the receive element stops receiving and allows the test to resume. There are 

several predefined end policies that you can choose from, for example after a certain number of bytes has 

been received, or when a specific string is detected. However, in some cases, a complex condition must 

be defined. This can be done by delegating the decision to custom code.

To create a new custom code class:

1. In the test editor, select a socket receive element.

2. In the End policy  section, select Delegated to custom code  and click Generate Code.

This creates a Java™  class template that follows the Rational®  Performance Tester  extension API. 

The Java™  class in created in the src  folder of the current project.

3. Write the custom code by extending the generating class. See Extending test execution with 

custom code  on page  for more information about extending Rational®  Performance Tester 

with Java™  code.

4. Save the custom code and the test.

You can click View Code  to edit the Java™  class later.

The following example is a sample custom class that demonstrates how to configure a custom end policy 

for the internet time protocol:

package test;

 

import java.text.DateFormat;

import java.util.Date;

import java.util.TimeZone;

 

import com.ibm.rational.test.lt.execution.socket.custom.ISckCustomReceivePolicy;

import com.ibm.rational.test.lt.execution.socket.custom.ISckReceiveAction;

import com.ibm.rational.test.lt.kernel.services.ITestExecutionServices;

 

/**

 *  Custom receive policy CustomReceive_TimeReceiver.

 *  For javadoc of ITestExecutionServices, select 'Help Contents' in the Help menu and select

 *  'Extending Rational®  Performance Tester  functionality' -> 'Extending test execution with custom code'
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 */

public class CustomReceive_TimeReceiver implements ISckCustomReceivePolicy {

 

 // static {

 //  static blocks are called once on each run and allow for example to bind

 //  to an external dynamic library

 // }

 

 ISckReceiveAction receiveAction;

 ITestExecutionServices testExecutionServices;

 

 public CustomReceive_TimeReceiver() {

  // The constructor is called during the test creation, not at the time of the execution of

  // the customized receive action

 }

 

 public void setup(ITestExecutionServices tesRef,

   ISckReceiveAction receiveActionRef) {

  testExecutionServices = tesRef;

  receiveAction = receiveActionRef;

 }

 

 public boolean onRead(int readByte) {

  // TIME protocol (RFC 868): a connected server returns 4 bytes and closes the connection

  // Those 4 bytes are the number of seconds since 1900/1/1

  // The test is simply made of a connection to one TIME server on port 37

  // (public servers are listed here: Got time server host name from http://tf.nist.gov/service/time-servers.html),

  // Then a receive delegated to this custom code class,

  // Then a close

  try {

   if (readByte == EndOfStream) {

    /* In case of success: */

    receiveAction.receiveSuccess();

    String message = extractAndCheckTime(receiveAction.getConnectionHolder().getFinallyReceivedBytes());

    /* A message is appended in the Test Log just after this receive action: */

    testExecutionServices.getTestLogManager().reportMessage(message);

    return true;
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   }

  } catch (Throwable t) {

   /* In case of exception: */

   receiveAction.handleException(t);

   return true;

  }

  if (receiveAction.getConnectionHolder().getCurrentlyReceivedBytesCount() > 4) {

   /* Unexpected condition: */

   receiveAction.handleException(new Exception("Time protocol server returned more than 4 bytes"));

   return true;

  }

  /* We need further bytes to complete this receive */

  return false;

 }

 

 private String extractAndCheckTime(byte[] bytes) {

  // This is network order, i.e. big endian

  long remoteTime = ((((long)bytes[0]) & 0x00000000000000ff) << 24) +

        ((((long)bytes[1]) & 0x00000000000000ff) << 16) +

        ((((long)bytes[2]) & 0x00000000000000ff) << 8) +

         (((long)bytes[3]) & 0x00000000000000ff);

  // 1900 to 1970: a difference of reference, see RFC 868 and java.util.Date javadoc

  remoteTime -= 2208988800L;

  Date remoteDate = new Date(remoteTime*1000);

  Date localDate = new Date();

  DateFormat dateFormat = DateFormat.getDateTimeInstance();

  dateFormat.setTimeZone(TimeZone.getTimeZone("GMT"));

  String message = "Remote time: " + dateFormat.format(remoteDate) + " GMT (TIME server is " +

           receiveAction.getConnectionHolder().getHostName() + ", port 37)\n" +

       "Local time:  " + dateFormat.format(localDate) + " GMT\n";

  long diff = localDate.getTime()/1000 - remoteTime;

  if (diff == 0) {

   message += "-> No difference";

  } else {

   message += "-> Difference (seconds): " + diff;

  }

  return message;
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 }

 

}

Using custom code to manipulate data
You can write a custom Java™  class to manipulate data in a send element. This offers flexibility for 

injecting data in test, but requires that you write your own Java™  class using the Rational®  Performance 

Tester  extension API.

In some cases, complex methods of generating data are required to send specific content to the server. 

This can be done by manipulating data with custom code.

To create a new custom code class:

1. In the test editor, select a socket send element.

2. Select Manipulate data with custom code  and click Generate Code.

This creates a Java™  class template that follows the Rational®  Performance Tester  extension API. 

The Java™  class in created in the src  folder of the current project.

3. Write the custom code by extending the generating class. See Extending test execution with 

custom code  on page  for more information about extending Rational®  Performance Tester 

with Java™  code.

4. Save the custom code and the test.

You can click View Code  to edit the Java™  class later.

Editing Kerberos tests
You can change the Kerberos realm, user name, and password when editing tests.

1. In the Test Navigator, browse to the test, and double-click the test name. The test opens.

2. Click the Security  tab.

3. Expand Kerberos.

To edit the Kerberos information in a test, Enable Kerberos authentication  must be selected.

4. Edit the Kerberos client realm name, client key distribution center (KDC), user name, and password 

as necessary.

The realm name, user name, and password are used for all Kerberos connections and requests in 

the test.
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5. Select Server is in a different realm than client  to edit the server realm name and server KDC if the 

server is in a different realm than the client.

6. Optional:  Click Edit krb5.ini, and then type a realm name, to edit the Kerberos configuration file.

Kerberos user names and passwords can be associated with a dataset. See the related topic on providing 

tests with variable data to learn more about datasets.

Related information

Providing tests with variable data (datasets)  on page

Adding test elements
You can add a variety of elements to a test, such as transaction blocks, IF-THEN conditions, loops, and 

comments.

Adding a comment
You can add a comment to document a test.

1. In the Test Navigator, browse to the test and double-click it.

The test opens.

2. In the test, select the item that you want to comment.

3. Click Add  and then click Comment.

The comment icon is placed before the selected item and the Comment text  field opens.

4. Add the comment to the Comment text  field. The comment is added to the test.

Related information

Adding a transaction to a test  on page283

Adding conditional logic  on page283

Synchronizing users in tests  on page287

Adding a loop to a test  on page288

Adding Dataset Mapper  on page290
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Adding data source controller  on page293

Controlling the flow of test  on page294

Adding a transaction to a test
A transaction  is a specific group of test elements whose performance you are interested in. When viewing 

the test results, you can view performance data about any transactions that you have added.

To put a group of test elements into a transaction:

1. In the Test Navigator, browse to the test and double-click it.

The test opens.

2. In the test, select the test elements to group together. Use Shift+click to select multiple contiguous 

elements; use Control+click to select multiple noncontiguous elements.

3. Click Add  (to place the transaction after the selected element) or Insert  (to place the transaction 

immediately before the selected element or block), and click Transaction.

4. You are prompted whether to move the selected objects into the transaction. Click Yes  or No.

5. Optional: In the transaction details, you can give the transaction a meaningful name. This is useful 

in the Transactions report, which lists transactions by name.

Related information

Adding a comment  on page282

Adding conditional logic  on page283

Synchronizing users in tests  on page287

Adding a loop to a test  on page288

Adding Dataset Mapper  on page290

Adding data source controller  on page293

Controlling the flow of test  on page294
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Adding conditional logic
You can add IF-THEN conditional logic around portions of a test/compound test or a A schedule, in this 

context, is used to refer to both VU Schedule  and Rate Schedule  to make those portions run if a specific 

condition is met.

A conditional block can run portions of a test depending on the value of a reference or field reference. The 

reference or field reference must exist in the test and precede the conditional block. If the reference or 

field reference that the conditional block uses for input does not exist, you must create the reference as 

explained in Creating a reference or field reference  on page 389.

The test might already contain the test elements that are to be run. If the test does contain the elements 

to be run, you must select the requests in step 2 of the procedure, and click Insert. The following 

instructions explain how to add a conditional block that contains such requests.

Otherwise, you can create an empty conditional block at the end of the selected item (test or request). 

Click the object, and then click Add.

1. In the Test Navigator, browse to the test and double-click it.

The test opens. You can also open a compound test  or a schedule.

2. Click a page or page request.

The conditional block is inserted before the selected item. By completing step 5, you can move the 

selected items into the block.

3. Press Shift  or Ctrl  when clicking to select multiple pages or requests to be moved into the block.

In step 6, if you add an Else  block, you can select one or more of these items to be moved into the 

Else  branch.

4. Right-click the item and select Insert  > Condition (IF).

A prompt Would you like to move selected objects into the new IF?  is displayed.

5. Click Yes  or No.

The If block is inserted into the test. If you click Yes, as shown in the example, the items that you 

selected are moved under If in the Test Contents  area. The following example shows an If block 

with an HTTP test.
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6. To add an Else block:

a. In the Test Contents  area, under If, select the items to be moved to the Else block. Press 

Shift or Ctrl when clicking to select multiple items.

b. Right-click and select Insert  > Condition (IF) - ELSE Block.

A prompt Would you like to move selected objects into the new ELSE?  is displayed.

c. Click Yes  or No.

The Else  block is inserted into the test. If you click Yes, as shown in the example, the items 

that you selected are moved under Else  in the Test Contents  area and into the Else  field in 

the Test Element Details  area. The following example shows an If-Then-Else block with an 

HTTP test.
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7. In the Test Element Details  area, under Condition, add conditions:

a. Next to the First operand  field, click Data Source, and then select a data source to be 

compared with the string in the Second operand  field, or type a value in the First operand 

field.

b. In the Operator  field, indicate the basis of comparison of the two operands.

Note that the two operands are strings.

Starting from 9.1.1.1, you can use the Matches regex  operator to match the operands. Click 

Verify  to verify whether the regular expression finds a match in the data source. If there is 

a match, the Verify  button is disabled. If there is no match, a message is displayed. If the 

regular expression is invalid, a message is displayed for that also.

c. Next to the Second operand  field, click Data Source, and select a data source to be 

compared with the First operand, or type a value in the Second operand  field.

When the defaults are used (both operand fields set to true  and the Operator  field set to 

Equals), the block is always processed.

8. In the Test Element Details  area, under Options, choose the required comparison type by selecting 

or clearing the check boxes.
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Related information

Adding a comment  on page282

Adding a transaction to a test  on page283

Synchronizing users in tests  on page287

Adding a loop to a test  on page288

Adding Dataset Mapper  on page290

Adding data source controller  on page293

Controlling the flow of test  on page294

Synchronizing users in tests
By inserting a synchronization point, you can coordinate the activities of a number of virtual users by 

pausing and resuming activities. You can synchronize all virtual users at the beginning of a test and 

stagger the release times so that the users do not overload the system. Synchronization points are also 

useful in stress testing.

You can insert a synchronization point into a schedule or a test. You typically insert synchronization 

points into schedules, because they are more visible at the schedule level and you can set the Release 

and Timeout  options within a schedule only, not within a test. However, in the following cases, insert a 

synchronization point into a test:

• You must control where the synchronization point is encountered. For example, you can insert a 

synchronization point just before a test sends a request to a server.

• You have edited a test, and the execution of a synchronization point depends on the logic that you 

have added.

Synchronization points within loops are not reset. In other words, after a synchronization point has been 

released (in the first iteration of a loop), the synchronization point stays released for all further iterations.

To insert a synchronization point into a test:

1. In the Test Navigator, browse to the test, and double-click it.

The test opens.
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2. Click the test element just below the place to add the synchronization point, and then click 

Insert  > Synchronization point. Depending on the nature of the test element, you can insert a 

synchronization point at some points in the test hierarchy but not at others.

3. Type a name for the synchronization point, or select the name of an existing synchronization point.

The synchronization point opens in the test. Note that Release Type  and Timeout  are not 

available for synchronization points in tests. Release Type  and Timeout  are available only for 

synchronization points in schedules.

4. To change the Release Type  or Timeout, open the synchronization point within a schedule, and 

make the changes. The changes affect all instances of the synchronization point.

Related information

Adding a comment  on page282

Adding a transaction to a test  on page283

Adding conditional logic  on page283

Adding a loop to a test  on page288

Adding Dataset Mapper  on page290

Adding data source controller  on page293

Controlling the flow of test  on page294

Adding a loop to a test
You can define part of a test as a loop that runs a specified number of times. If the loop contains a 

synchronization point, the synchronization point is released after the first iteration of the loop and stays 

released for all further iterations.

You can set a loop within a schedule or a test. The following table shows the advantages of both 

methods:

Loop 

loca

tion Results

Sched

ule

Loops in schedules are easy to locate and modify.Loops in schedules close the server con

nection at the end of each iteration and reopen it at the beginning of the next iteration. This 
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Loop 

loca

tion Results

action models the behavior of a user closing and reopening a browser. Use this method to 

run a test at a set rate.

Test Loops in tests can be more granular, and thus provide a higher level of control.

Loops in tests reuse the server connection during each loop iteration.

Use this method, with loops that have high iteration counts, to stress test a server.

1. In the Test Navigator, browse to the test, and double-click it. 

The test opens.

2. Click the page or the request that will be inside the loop.

Press Ctrl when clicking to select multiple pages or requests.

3. Click Insert, and select Loop.

4. You are asked whether you want to move the selected elements into a the loop. Click Yes.

If you click No, an empty loop is inserted into the test.

5. In the Loop Details  area, type the number of iterations for the loop to repeat.

Option Description

Count-based
Runs for the number of iterations that you se

lect.

Time-based

Runs for at least the time that you specify. 

The loop always finishes the iteration. For ex

ample, if you select a time of 1 second and a 

loop takes 10 seconds to run, the loop finish

es one iteration, and then checks the time.

Infinite Runs until the test stops.

Note:

If a test or a schedule includes multiple loops with dataset values and a new dataset value is 

required for the first iteration of the second loop, then a dataset increment is required before the 

second loop runs. To do this, you must insert a data source controller by clicking Insert  > Data 

Source Controller  before the second loop starts and then select the required dataset. You can then 

select the Increment  option for the data source from the Data Source Controller Details  pane that 

triggers the retrieval of the dataset value to automatically choose the new dataset value.
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6. Optional: Select Control the rate of iterations, and type your preferences for the pacing rate.

In specifying a number of iterations for a unit of time, you set a fixed period for the iterations to 

complete. If you select Randomly vary the delay between iterations, the total delay is randomly 

distributed. If you clear this check box, the same delay occurs between each iteration.

Note:  Statistically, the Randomly vary the delay between iterations  option sets delay amounts 

at random from a negative exponential distribution with the same mean as the fixed delay value. 

The negative exponential distribution has a long "tail," which means that a very small number of 

delays will have very large values. Therefore, make sure that the application you are testing is not 

negatively affected by long periods of inactivity (such as a timeout that disconnects the user).

Related information

Adding a comment  on page282

Adding a transaction to a test  on page283

Adding conditional logic  on page283

Synchronizing users in tests  on page287

Adding Dataset Mapper  on page290

Adding data source controller  on page293

Controlling the flow of test  on page294

Running tests at a set rate  on page

Adding Dataset Mapper
You can include a Dataset Mapper in a compound test or a schedule to assign the dataset values to the 

variables that are defined in multiple tests. In previous releases, to apply the dataset values to multiple 

tests, you had to associate the dataset to each test. The Dataset Mapper is able to map the dataset 

columns with the variables.

You must have created at least one dataset. See Creating a dataset in a workspace  on page 318.

For the Dataset Mapper to fetch the test variables, in the Variable Details section of the Test editor, you 

must set the Visible In  field for the variable to All tests for this user. You can also fetch the variables from 

the custom code calls.

If the compound test or the schedule includes a Dataset Mapper that retrieves values from one dataset 

and a test in the compound test or schedule is also associated with another dataset, the run uses both 

the datasets.
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Note:  When you run the schedule or compound test with a Dataset Mapper, by default the test picks 

up the dataset values from the first row. For the test to pick up all of the dataset values, you must put the 

test in a loop.

1. In the Schedule or Compound test editor, click Add  > Dataset Mapper.

2. In the Select Dataset  dialog box, select a dataset to use for the tests and click OK.

To change the dataset after it is associated, in Dataset Mapper Details, click Browse  and select 

another dataset.

3. Select the Open mode  for the dataset. This mode determines the view that virtual users have of the 

dataset. This option is useful when you do a parallel test run.

Option Description

Shared (per test execution)  (default)

When you choose the Shared (per test execu

tion) option, the virtual users running in the 

test share the dataset values in sequential or

der.

For example, if your dataset has 10 rows, the 

dataset values are taken from row 1, row 2, 

row 3, and so on when you select this option.

Private

Virtual users draw from a private view of the 

dataset, with dataset rows apportioned to 

each user in sequential order.

This option ensures that each virtual user 

gets the same data from the dataset in the 

same order. However, because each user 

starts with the first row of the dataset and 

accesses the rows in order, different virtual 

users will use the same row. The next row of 

the dataset is used only if you add the test 

that is using the dataset in a loop with more 

than one iteration.

Shared (for all test executions)

When you choose the Shared (for all test ex

ecutions) option, the virtual users running in 

multiple tests share the dataset values from 

the current row.
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Option Description

For example, if your dataset has 10 rows and 

when you set the current row as row 5, the 

dataset values are taken from row 5 instead 

of row 1 when you select this option. If you 

had set the current row as row 1 and used 

the dataset values until row 5, the dataset val

ues are retrieved from row 6 when you run the 

test next time.

4. Select the Access mode  for the dataset:

• Sequential: The rows in the dataset are accessed in the order in which they are physically 

stored in the dataset file, beginning with the first row and ending with the last.

• Random: The rows in the dataset are accessed in any order, and any given row can be 

accessed multiple times or not at all. Each row has an equal chance of being selected each 

time.

• Shuffled: Before each dataset access, the order of the rows is changed, and a different 

sequence results. Rows are accessed randomly but all rows must be selected once before a 

row is selected again.

5. Select whether the test will reuse data when it reaches the end of the dataset.

By default, when a test reaches the end of a dataset or dataset segment, it reuses the data from 

the beginning. To force a test to stop at the end of a dataset or segment, clear the check box Wrap 

when the last row is reached. Forcing a stop might be useful if, for example, a dataset contains 

15 records, you run a test with 20 virtual users, and you do not want the last five users to reuse 

information. Although the test is marked as “Fail”  because of the forced stop, the performance 

data in the test is still valid. However, if it does not matter to your application if data is reused, the 

default of wrapping is more convenient. With wrapping, you need not ensure that your dataset 

is large enough when you change the workload by adding more users or increasing the iteration 

count in a loop.

6. Select whether the test will make the data in the dataset record permanent for each virtual user.

By default, one row is retrieved from the dataset for each execution of a test, and the data in the 

dataset row is available to the test only for the duration of the test. Select Fetch only once per user 

to specify that every access of the dataset from any test being run by a particular virtual user will 

always return the same row.

To illustrate how these options affect the rows that are returned, assume that a test contains a 

loop which accesses a dataset. The loop has two iterations. The following table shows the row 

that is accessed in each iteration:
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Dataset option Iteration 1 Iteration 2

Sequential  and Private row 1 row 2

Shared  and Shuffled row x row y

Fetch only once per user row x row x

7. In the Columns mapping  table, the Column  is automatically filled with the column names from the 

dataset.

8. To use the variable names from the test, click the cell and click the Ellipsis button  and select 

the variable. By default, the variable names are also created with the same names as the dataset 

columns.

9. To fetch all the dataset values, put the Dataset Mapper in a loop. Select the Dadtapool Mapper  in 

the schedule and click Insert  > Loop.

10. Save the changes.

Related information

Adding a comment  on page282

Adding a transaction to a test  on page283

Adding conditional logic  on page283

Synchronizing users in tests  on page287

Adding a loop to a test  on page288

Adding data source controller  on page293

Controlling the flow of test  on page294

Adding data source controller
Use this test element to control how the data is fetched from the data sources to be used by the test. You 

can use data from dataset, array variables, built-in data sources, and correlation.

In the Test editor, the pages/requests succeeding the data source controller makes use of the data source 

associated to the controller. So, if there are 3 pages in your test and the first controller is placed before 

the first page and the second controller is before the last page, the first two pages use data associated 

with the first controller. The last page will use data associated with the second controller.
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1. In the Test editor, select the pages for which you want to substitute data and click Insert  > Data 

Source Controller.

2. Select the data source from where you want the succeeding pages to pick data and click Select.

The data source controller is added to the test.

3. In Data Source Controller Details section, select Increment  for the test to automatically pick the 

next value from the data source or select Reset  to pick the first available value from the data 

source.

4. Optional:  To change the data source, click Data Source  and save the test.

Related information

Adding a comment  on page282

Adding a transaction to a test  on page283

Adding conditional logic  on page283

Synchronizing users in tests  on page287

Adding a loop to a test  on page288

Adding Dataset Mapper  on page290

Controlling the flow of test  on page294

Controlling the flow of test
A test is usually run in the order it was recorded. However, you might want to add some conditions to the 

test that the users would actually face when interacting with the application under test. For example, if 

you select a product, you want to know its manufacturing date. If the date is not available, you want to 

exit. You can now add such control to the test.

1. In the Test Navigator view, browse to the test and double-click it.

2. Select the request or page that uses the IF  condition and click Insert  > Test Flow Control.

3. In the Test Flow Control Details  section, specify one of the following actions:

Action Description

Continue Continue running the test.

Exit Transaction Exit the transaction and continue running the 

test. If there are multiple levels of transac
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Action Description

tions, specify whether you want to exit the in

nermost or outermost transaction.

Exit Loop Exit the loop and continue running the test. 

If there are multiple levels of loops, specify 

whether you want to exit the innermost or 

outermost loop.

Continue to next iteration of loop Continue to run the next iteration of the loop 

after the existing iteration completes.

Exit test Exit the test.

Exit user Exit the currently running virtual user and 

start running with the next user.

Terminate Run Stop the A schedule, in this context, is used 

to refer to both VU Schedule  and Rate Sched

ule.

Related information

Adding a comment  on page282

Adding a transaction to a test  on page283

Adding conditional logic  on page283

Synchronizing users in tests  on page287

Adding a loop to a test  on page288

Adding Dataset Mapper  on page290

Adding data source controller  on page293

Searching within tests
Search request data or response content by right-clicking in the data or content and selecting Find. 

To search for specific element types and to display the results in a table, click Select. For a still more 

powerful search and replace, use the Test Search  function.

You can use a number of different methods to search within a test.
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• Use the Find  option to search within the Test Details  area and, optionally, to replace text.

• Use the Select  button to search within the Test Contents  area and display a table of like test 

elements.

• Use the powerful Test Search  function to search within the Test Contents  and the Test Details 

areas. For example, you can search for a type of verification point and also declare whether the 

result should include enabled verification points, disabled verification points, or verification points 

in both states. The specific data that you can search for and the search options are protocol-

dependent.

Locating specific types of test elements
A test script can include multiple requests and responses with many test elements and attributes. To 

locate elements of a specific type in the Test Contents  area, click Select. The results are displayed 

in a table, and you can sort the table columns. This option is also useful for viewing attributes of test 

elements that are the same type.

1. In the Test Navigator, browse to the test and double-click it.

The test opens.

2. To restrict the search to specific instances of elements, select them in the test. For example, you 

might want to search for text in specific responses, rather than in all responses.

3. Click the test editor tree to give it focus, and then click Select.

A list of element types opens. This list is generated dynamically based on the contents of the test. 

For example, if a test does not contain verification points, they are not listed.

4. To include only the elements that you selected, select Restrict To Highlighted Elements.

5. To include only the elements that contain specific text from the Test Contents  area, select Use 

Filter Text.

6. Select the type of test element to view from the list.
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7. If you selected Use Filter Text, enter the filter text in the prompt, and then click OK.

To use regular expressions in the filter text, click the Search Options  icon to the right of the prompt, 

and then select Regular expression. By default, if Regular expression  is not selected, the asterisk 

(*) and question mark (?) are interpreted as wildcard characters. To search for a URL that contains 

an asterisk or question mark, type a backslash (\) before the asterisk or question mark.

The Test Element Details  area displays the results under the heading Multiple Items.

The following example shows results for an HTTP request. Other protocols might display less detailed 

information. Double-click a table row to locate the element within the test.

Related information

Searching and replacing text in tests  on page297

Searching and replacing text in tests
With the Test Search  function, you can search for text in a test or search within specific test elements and 

optionally replace the found text.

1. In the Test Navigator, browse to the test and double-click it.

The test opens.

2. Right-click the test name, and then select Test Search.

3. In Search for text, type the text to locate.

You can leave this field blank, depending on your search strategy. For example, if you know that a 

string occurs in elements or element instances that you are not interested in, by using the options 
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described in steps 4, 6, and 8, you can locate the elements or element instances of interest before 

entering the search text into this field.

4. If you have selected pages or requests within the test, click More Options, and then select Restrict 

search to elements highlighted in Test Contents.

This restricts the search to the selected pages and requests.

5. To perform a case-sensitive search, select Case sensitive. To search with regular expressions, 

select Regular expression.

In regular expression mode, press Ctrl and type a space in Search for text  for content assistance. 

Content assistance lists the regular expression patterns and the content that they match.

6. To highlight found elements in the Test Contents  area, click More Options, and then select 

Highlight found elements in Test Contents.

You can use this option with the option that is described in step 4 to designate the element 

instances of interest before specifying the text of interest.

7. To have the search include children of the selected element, click More Options, and then select 

Recursive. This option is selected by default. If Recursive  is cleared, then only the selected 

element is searched.

8. To have the search locate both encoded and decoded versions of the specified text, click More 

Options, and then select Match encoded and decoded values.

This option is selected by default. The type of encoding that the search supports varies depending 

on the protocol.

For example, when searching in HTTP data, abc%123  and abc%25123  match.

9. In the Elements to search  list, select all test elements to search.

Selecting the check box in step 4 restricts the elements that you can select in this step to the 

instances that are selected in the Test Contents  area. For example, if you select HTTP Pages  here 

and only one page is selected in the Test Contents  area, only that page is found. If the check box in 

step 4 is cleared, every test page is found.

10. Optional: Click selected elements to define how to search them.

A new area opens, where you can define how to search a selected element.

To locate items, continue to the next step. To replace found strings, click Replace, and go to step 

12.

11. Click Search.

The results of your search are displayed in two views

• The Search view, which lists the objects that contain matches

• The Test Search Match Preview view, which displays the matches that were found

12. In the Search view, complete any of these search actions:
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• To preview a found string in the Test Search Match Preview, click the object.

• To open your test at the location where an instance is found, double-click the object.

• To perform a different search action (such as proceed to the next match or previous match, 

replace), right-click the object, and select your choice.

13. If you clicked Replace  in step 9, the Replace  window opens. In the With  field, type the replacement 

text.

14. Select the replacement action by clicking the appropriate push button.

If you are making selective replacements, found instances are displayed in the same order as in 

the Test Search Match Preview  view. Click Replace  or Skip  until all found instances have been 

displayed.

Related information

Locating specific types of test elements  on page296

Exporting a test
To share the test scripts with manual testers or reviewers who do not have the workbench, export the test 

scripts to text files. You can export one file at a time.

1. In the Test Navigator view, double-click a test.

2. In the test editor, right-click the root node of the test and click Export Contents to File.

3. Select a project and specify the name of the file to export to.

4. To add a separator between two steps or lines, select the Add line separators after each step 

check box and click Finish.

The text file opens on another tab in the workbench and is saved in the directory it is exported to.

Copying test assets with dependencies
You can export test assets, and then import them into another project or workspace without losing any 

dependencies. Test assets include projects, schedules, and tests. You can export and import test assets 

to collaborate with other testers.

If you plan to export assets with dependencies, make sure that you have migrated the test assets to the 

current version of the product before you start to export.
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When you copy a test with dependencies, any datasets or custom code referred to by the test are also 

copied. When you copy a schedule with dependencies, any locations or tests referred to by the schedule 

are also copied. When you copy results, any schedules or tests referred to by the results are copied.

1. In the Test Navigator  view, right-click the test assets to export, and then click Export.

You can export projects, schedules, tests, and test results with dependencies.

2. In the Export  window, expand the Test  folder, and then click Test Assets with Dependencies.

You can export test assets with dependencies if the test assets were created in the current version 

of the product. You cannot export test assets with dependencies if the test assets were created in 

a previous version of the product and the assets have not been migrated to the current version of 

the product.

3. Click Next.

4. Specify the path and name of the archive file into which you want to export the selected test 

assets.

5. Click Finish.

The assets are exported to the archive file. You are prompted if the total size of the test assets is 

larger than 4 GB, or if any individual test asset file is larger than 4 GB. To copy test asset files that 

are larger than 4 GB, copy the files manually.

6. If the target workspace is on a different computer, transfer the archive file to a location that is 

accessible to that computer.

7. In the Test Navigator  view, select the test project into which you want to import the test assets.

The target project must have the same name as the source project. Optionally, you can import test 

assets with dependencies into a workspace where no projects exist. If you import test assets with 

dependencies into a workspace where no projects exist, the Import wizard creates projects based 

on information from the archive file. To import test assets into a project with a different name, you 

must first import the test assets into a project with the same name, and then manually move the 

assets into the project with the different name.

8. Click File  > Import.

9. In the Import  window, expand the Test  folder, and then click Test Assets with Dependencies.

10. Click Next.

11. In the Import with dependencies  window, click Browse, and then select the archive file.

The test assets are displayed in the File contents  list.

12. Click Finish  to import the test assets with dependencies from the archive file into the target 

project.

If a file that you are attempting to import already exists in the target workspace, you will be 

prompted to choose whether to overwrite the file. You can also choose to overwrite all files 

that already exist in the target workspace, or not to overwrite any files that already exist in the 
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workspace. If you choose to overwrite all files that already exist in the target workspace, you will be 

prompted again if the import process encounters a .classpath  or .project  file in the source 

archive file.

Copying projects
You can export a test project from a workspace and import it into another workspace.

If you export test assets to an archive file and then import them to another project, ensure that both 

project names are the same. Otherwise, you might not be able to locate your imported test assets.

Note:  You can also export the test project with all the dependent assets in to an archive file. See 

Copying test assets with dependencies  on page 299 for the instructions.

1. Start Rational®  Performance Tester, and select the source workspace.

2. Export the test project to an archive file.

For instructions, see Exporting resources to an Archive file. Datasets can be located either in the 

same project as the tests that use them or in different projects. Be sure to export all the datasets 

that the exported tests require.

3. If the target workspace is on a different computer, transfer the archive file to a location that is 

accessible to that computer.

4. Start Rational®  Performance Tester, and select the target workspace.

5. Click File  > Import. Expand the General  folder, and click the Existing Projects into Workspace  icon; 

then click Next.

6. Click Select archive file, and then click Browse  to select the archive file. Click Finish  to import the 

source project from the archive file into the target workspace.

7. Optional: If the imported project contains custom code or tests that have been run, you might need 

to change the Java™  build path.

The following examples are cases that might require a change to the Java™  build path:

• The Java™  build path was manually changed in the project from which it was exported. In 

this case, the same changes need to be made in the imported project. While importing, you 

are asked whether to overwrite the class path file, which stores the Java™  build path for 

project. Answering Yes  reduces the likelihood that the build path will need to be changed.
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• The project was imported onto a different computer with a different Java™  installation 

configuration. In this case, missing libraries must be removed from the build path.

• The project was imported into a workspace on a different disk drive. When you are asked 

whether to replace the class path file, answering No  reduces the likelihood that the build 

path will need to be changed.

For instructions on changing the build path, see the Java™  Build Path page.

If you encounter errors after importing a test project or when using an existing workspace with a new 

version of the product, you might need to delete .java files from the src  folder in the workspace:

1. Click Window  > Open Perspective  > Resource  to open the Resource perspective.

2. In the Navigator  window, expand the test project folder, and locate the src  folder.

3. Delete all .java files in the src  folder, except for those that contain custom code.

4. Return to your test perspective: Click Window  > Open Perspective, and select Performance Test  (or 

Service Test, if you are using Rational®  Service Tester).

Disabling portions of a test
When you disable portions of a test, you can still see the disabled portion, but it is not executed during a 

run. You can also disable portions of a schedule by using the following procedure.

To disable secondary HTTP requests, see Disabling and enabling secondary HTTP requests  on page 

174.

To disable an element:

1. In the Test Navigator, browse to the test, and double-click it.

The test opens.

2. Right-click the element that you want to disable, and select Disable.

The element and the dependent child elements, which are disabled automatically, are shaded and 

preceded by two forward slashes (//) to remind you that they are disabled.

Note:  To change the color or symbol that represents disabled elements, click Windows  > 

Preferences  > Test  > Test Editor, and then click the Colors and Fonts  tab.

http://help.eclipse.org/juno/topic/org.eclipse.jdt.doc.user/reference/ref-properties-build-path.htm
http://help.eclipse.org/juno/topic/org.eclipse.jdt.doc.user/reference/ref-properties-build-path.htm
http://help.eclipse.org/juno/topic/org.eclipse.jdt.doc.user/reference/ref-properties-build-path.htm
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Although a disabled test element does not run, you can still work with it. For example, you can 

insert a test into a disabled user group for later use.

3. To enable a disabled element, right-click it, and select Enable. Select Enable All  to enable all 

disabled elements.

Disabling an element affects other elements in the following ways:

Disabled element Result

User group (percentage) The percentages in the remaining user groups 

are recalculated. When you enable the user 

group again, remember to return all of the affect

ed user groups to their original percentage.

User group (absolute) The number of users in the remaining groups 

might not match the total number of users spec

ified in the schedule. If so, new virtual users are 

redistributed among the remaining user groups 

so that the numbers will match. When you enable 

the user group again, remember to return all of 

the affected user groups to their original totals.

Request or step that contains a data correlation 

reference

Substitution in the remaining actions that de

pend on this request does not work.

Request or step that contains a data correlation 

substituter

Substitution does not occur because the en

tire action is omitted. The substituter that uses 

the disabled data source is also disabled. To re-

enable the substituter, select an enabled data 

source for substitution.

HTTP request that contains a server connection No effect. The connection is automatically creat

ed in the next request.

Portion of custom code Custom code with disabled arguments is 

flagged. If the disabling causes an unexpected 

number of arguments passed to custom code 

elements, you receive an error at runtime. To fix 

this, modify the custom code to check the num

ber of arguments.
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Disabled element Result

IF data_source  construct An IF construct is marked as invalid if it contains 

a disabled data source.

Test element and child are disabled If you disable a child element and then disable its 

parent (for example, a request and then a page), 

the disabled child element will have two prefixes: 

one created manually and one inherited. In the 

following example, the first request has inherited 

the disabled state. The second request has been 

manually disabled and has also inherited the dis

abled state:

//disabled page

 //request

 ////disabled request

Do one of the following to re-enable the second 

request:

• Re-enable the request, and then re-enable 

the page.

• Right-click the page and select Enable All.

A data source or a range of text that will be re

placed

The Data  table displays this text in gray.

Specifying error-handling behavior
You can specify how error conditions are handled when running a test or schedule. Error conditions 

include verification point failures,  connection failures, server timeouts, custom code alerts, and problems 

with data correlation.

You can specify error-handling behavior for the workbench, schedules, tests, and test elements/steps. 

The Errors report displays the error conditions and error behavior that occurred in a test or schedule. 

When you set the error-handling behavior for the workbench, it is applied to all the tests in the workbench. 

To apply it for the workbench, click Window  > Preferences  > Test  > Test Execution  > Error handling.
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Starting from 9.2, there is a new Error handling  preference - Mobile or Web UI Fatal Error  - to allow text 

execution for a compound test to continue even after a fatal exception in one of the tests in a compound 

test.

1. In the Test Navigator, browse to a test, and double-click it.

The test opens.

2. In the Test editor, complete one of the following steps:

a. To specify error-handling behavior for a request/step or other elements in the test hierarchy, 

in the Test Contents  section, select the element and in the Test Details  section, click the 

Advanced  tab.

b. To specify error-handling behavior for an element such as a connection, verification point, 

substitution, or reference, select the element, and then click Change. Skip to step 5.

c. To specify error-handling behavior for a dataset that is associated with a test, on the 

Common Options  page, select the dataset, and then click Dataset Properties. Click Change. 

Skip to step 5.

3. Under Error Handling, expand Click to show conditions.

The error condition table is displayed. The error condition table shows all possible conditions that 

can be handled in the test.

4. Select the check box next to the condition for which to specify behavior.

A window opens where you can specify the action to take and the message to log when the 

condition occurs.

5. To apply an action when the specified condition occurs, select the Override action upon error 

check box .

Option Description

Continue Click to continue running the test.

Exit transaction

Click to exit a transaction when the speci

fied condition occurs. Select the Innermost  or 

Outermost  transaction, or type the name of a 

transaction.

Exit loop

Click to exit a loop when the specified condi

tion occurs. Select the Innermost  or Outer

most  loop, or type the name of a loop.

Continue to next iteration of loop
Click to continue to the next iteration of a 

loop when the specified condition occurs. 
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Option Description

Select the Innermost  or Outermost  loop, or 

type the name of a loop.

Exit test
Click to exit the test when the specified con

dition occurs.

Exit user

Click to stop the virtual user that encounters 

the specified condition.

For a Web UI test, this action will stop the test 

execution.

Terminate run
Click to stop the run when the specified con

dition occurs.

6. To contribute to the health of the page, transaction, or loop, select the Override contribution to 

health status  check box and select Yes. The respective reports display the health of the page, 

transaction, or loop.

7. Optional:  To write a message to the test log when the specified condition occurs, select the 

Override log message upon error  check box and type a message.

8. Click OK.

To stop running a test when a substitution failure occurs in data correlation, select the Substitution 

Failure  check box. Click Exit Test, and then click OK. The error-handling behavior that is specified closest 

to where an error occurs takes precedence. If a specific request is set to continue if a substitution 

fails, and the schedule is set to stop if a substitution fails, then the schedule will continue running if the 

substitution fails in that request.

Related reference

Error conditions  on page

Running test elements in random order
You can record multiple user scenarios in a test and then run each scenario in a random order. To do this, 

you put each scenario under a random selector and then select the proportion of time that the scenario 

should be run.

unique_226
unique_226
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For example, you can record a test that includes logging on to a system, browsing through items in the 

system, buying various items, and then totaling the order. In this case, you could run the logging in and the 

totaling scenarios once, but put the browsing and buying scenarios under a random selector.

1. In the Test Navigator, browse to the test and double-click it.

The test opens.

2. Click the test element that will be controlled by the random selector, and then click Insert  > 

Random Selector.

Use Shift+Click to select multiple elements.

3. You are asked whether you want to move the selected elements into a new random selector. Click 

Yes.

Click No  to insert an empty random selector into the test.

Note:  To set whether or not elements are moved automatically, or whether you are prompted, 

click Window  > Preferences  > Test  > Test Editor, and click the General  tab.

4. Set the weight of the random selector. The weight determines the statistical probability that a 

specific element will be selected.

a. If you have added a number of test elements, the Create weighted blocks  window is 

displayed. You can select adjacent elements and group them. Each element—whether in a 

group or by itself—must be weighted.

b. If you have added only one test element, the weighted block is displayed in the Test Element 

Details  area with a default of 1.

When a selector contains many different weights, you can mathematically determine the likelihood that a 

block will be executed. To do this, add the weights together and divide the weight for each block by that 

total.

For example, assume a selector contains six blocks set to the following weight:

• two blocks set to a weight of 1

• one block set to a weight of 2

• two blocks set to a weight of 5

• one block set to a weight of 9

The total of the weights is: 1 + 1 + 2 + 5 + 5 + 9 = 23. Therefore, the statistical likelihood of selection is:

Weight of block Likelihood of block being selected

1 (two blocks) 1/23. = 0.0435, or about 4.35% (for each block)

2 2/23 = 0.0870, or about 8.70%
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Weight of block Likelihood of block being selected

5 (two blocks) 5/23 = 0.2174, or about 21.74% (for each block)

9 9/23 = 0.3913, or about 39.13%

Note that a higher weight increases the likelihood, but does not guarantee, that a block will be executed. 

Some variation might occur. For example, if you run a test 23 times, you cannot predict that the first and 

second blocks will execute exactly once, the third block exactly twice, the fourth and fifth blocks exactly 

five times, and the sixth block exactly nine times. However, the more times that the blocks are executed, 

the more accurate this prediction is.

Renaming test assets
As your test assets increase and become more complex, you might want to rename them. Use the Eclipse 

Rename  function or save the assets under a different name.

Use either of the following steps to rename a test asset:

1. When you use the Eclipse Rename  function, the new name is visible in the Test Navigator, but the 

underlying file system name is not changed. To use the Eclipse Rename  function:

a. In the Test Navigator, right-click the test asset, and then select Rename

b. Type the new name, and then click Enter

Be sure to click Enter, or the file will not be renamed.

2. When you rename a test asset by saving it under another name, the underlying file system name is 

changed, but you must perform manual cleanup. To save a test asset under another name:

a. In the Test Navigator, browse to the test and double-click it. The test asset opens.

b. Click File  > Save As, and save the asset under a different name.

c. Delete the original asset.

The following table summarizes how renaming an asset affects the other assets in your workspace.

Renamed asset Effect on other assets

Project Do not rename a project. Renaming a project 

might result in lost or corrupted project assets.

Schedule Renaming a schedule has no affect on other as

sets, but note that results cannot be renamed.
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Renamed asset Effect on other assets

Test When you use Rename, schedules that contain 

the old test name will still run correctly. To avoid 

confusion, manually update the schedule to use 

the new test name.

After you use Save As, manually update each 

schedule that uses the renamed test.

Custom code If you rename the custom code class (.java file), 

then the reference to the class in the custom 

code action of the test will not work. Typically 

rename the custom code class in the Resource 

perspective or the Java™  perspective.

If you change the name of the custom code 

class in the test editor that implements the cus

tom code action, the modification does not 

change the corresponding .java file; instead the 

modification causes the custom code action to 

refer to a different (and possibly new) custom 

code class.

Dataset When you use Rename  and open a test that con

tains the dataset, you are prompted to save the 

changes (in this case, the renamed dataset that 

the test now uses).

After you use Save As, manually update each 

test that uses the dataset.

Location When you use Rename, locations (agent comput

ers) are automatically updated in the schedules 

that use them.

When you use Save As, manually update each 

schedule that uses the test.

Results You cannot rename results.

Weighted block Renaming a weighted block has no affect on oth

er assets. To rename a weighted block, click the 
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Renamed asset Effect on other assets

block in the test, and type the new name in the 

Name  field.

Deleting test assets
As your test assets grow and become more complicated, you might want to delete the assets that you no 

longer use.

In the Test Navigator, right-click the test asset, and then select Delete.

The following table summarizes how deleting an asset affects the other assets in your workspace.

Note:  If you are deleting a test asset, you can choose to delete it from other test assets that refer 

it and you can choose to delete other test assets that are referenced only by the test asset that you are 

deleting.

For example, if you delete a dataset, the Remove references to test asset name  in other test assets 

option lets you delete the dataset from all the test assets that uses it.

If you delete a test, the Delete files that are referenced only by test asset name  option lets you delete all 

the test assets such as recsession and dataset that are referenced only by the test that you are deleting. 

If the dataset is used by another test too, it will not be deleted. The Preview  button lets you see the assets 

that are referenced by the test.

Deleted asset Effect on other assets

Project You are prompted whether to delete the project 

contents. If you click Yes, the contents are physi

cally deleted. If you click No, you will not see the 

contents in the Test Navigator, but the project re

mains in your workspace, which is, by default, C:

\Documents and Settings\username\__

VENDOR_NAME__\__SDP_FULL_SHORTNAME_

_n.n/workspace).

Schedule Deleting a schedule has no effect on other as

sets.

Test If you delete the test in the Test Navigator, the 

test is physically deleted.
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Deleted asset Effect on other assets

If you open a schedule and delete a test, the 

test is deleted from the schedule, but the test re

mains available as a test asset.

Custom code If you delete the custom code class (.java file), 

then the reference to the class in the custom 

code action of the test will not work. Typically 

you delete the custom code class from the Re

source perspective or the Java™  perspective.

If you delete the name of the custom code class 

that implements the custom code action, the 

deletion does not change the corresponding .ja

va file.

Dataset If you delete a dataset in the Test Navigator, the 

dataset is physically deleted. When you open a 

test that uses the dataset, you are prompted to 

take one of these actions:

• Locate the dataset

• Remove the dataset reference from the 

test

• Leave the invalid reference in

You must correct or delete the reference to run 

the test successfully.

If you open a test and delete the dataset from 

the Common Options  tab, only the reference to 

the dataset is deleted.

Location You are not asked to confirm the deletion, nor are 

you warned if a user group uses the location. The 

user group is marked with a red X  when you open 

the schedule that contains it.

Results You are asked to confirm the deletion, and the re

sults are physically deleted.
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Debugging custom code for tests and compound tests
If you have custom code added to a test or a compound test, you can debug the custom code for any 

errors by clicking the Debug  button.

This procedure can only be done when custom code is part of a test or compound test. If there are 

multiple custom code classes added to a test or compound test, the debug action debugs all the custom 

code classes.

You can use the debug option only in full Eclipse mode of the product. You cannot debug in the streamline 

mode.

1. Open a test or a compound test from the Test Navigator view.

2. Click the Debug  button.

The Debug view opens. If there are any breakpoints in the custom code, the test run pauses at the 

breakpoint. Press F8 to resume the test run.

Providing tests with variable data (datasets)
You can produce more realistic tests by changing them to use datasets. During execution, a test that uses 

a dataset replaces a value in the recorded test with variable test data that is stored in the dataset. This 

substitution allows each virtual user to generate a different request to the server.

Dataset overview
Datasets provide tests with variable data during a run. When you record a test, you perform a sequence of 

steps that you expect a typical user to perform. After the recording, a test is generated that captures these 

interactions. When you run this test, it uses the same data that you used during recording. To vary the 

data in the test, you use a dataset, that contains variable data. At run time, this variable data is substituted 

for the data in the recorded test.

If you need to create a dataset with many records, you can initialize the dataset quickly by importing data 

from a comma-separated-value (CSV) file. Also, you can export test data from your dataset into a CSV file 

to enable you to maintain large volumes of test data as a spreadsheet for reuse. Earlier to 9.5, the dataset 

(formerly known as datapool) was in .datapool format and starting from the 9.5 release, the dataset is in 

the csv format.

You can copy the CSV file and paste into your project to import the data from a CSV file and create a 

dataset. Similarly, to export the dataset values as a CSV file, you must copy the dataset from your project 

and paste it into your local machine.
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Note:  Alternatively, you can use the Import  option available in the CSV editor  to import the data from 

a CSV file. For more information, see Editing datasets  on page 332.

Perform the following steps should you plan to create a test that searches the IBM®  website for three 

items: IBM®  Rational®  Performance Tester, IBM®  Rational®  Functional Tester, and IBM®  Rational® 

Manual Tester:

1. Record a test that searches for one item. For more information, see Recording an HTTP test  on 

page 8.

2. Create a dataset and associate it with the test. For more information, see Creating a dataset 

associated with a test  on page 313.

3. Associate a request in the test with a column in the dataset. For more information, see Associating 

a test value with a dataset column  on page 328.

4. Add a loop in the test to fetch the values from different rows of a dataset. A test without a loop 

fetches the value only from the first row of the dataset. For more information, see Adding a loop to 

a test  on page 288.

Related information

Creating a dataset associated with a test  on page313

Creating a dataset in a workspace  on page318

Converting an existing datapool to a dataset  on page319

Creating datasets with multiple substitutions  on page320

How dataset options affect values that a virtual user retrieves  on page324

Enabling a test to use a dataset  on page325

Associating a test value with a dataset column  on page328

Viewing dataset candidates when you open a test  on page331

Editing datasets  on page332

Using a digital certificate store with a dataset  on page340

Navigating between a dataset and a test  on page341

Creating a dataset associated with a test
You can create a dataset that contains variable data for tests to use when they run. This is the preferred 

way to create a dataset because the dataset is automatically associated with a test. You can create 
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anything from an empty dataset that contains one column, which you can edit later, to a fully functioning 

dataset.

1. In the Test Navigator, browse to the test and double-click it.

The test opens.

2. In the Test Contents  area, click the name of the test.

3. In the Common Options  tab, click Add Dataset.

The options listed in the following table, enable you to create anything from a simple dataset that 

you can edit later to a complete dataset.

To create
Do this in the Test Edi

tor - Add Dataset window

A one-column dataset with a default access 

mode.

In Existing datasets in workspace, select 

New Dataset<testname>.csv, and click Fin

ish. You can optionally name the dataset col

umn in this session, and you can add other 

columns and data later.

A one-column dataset and choose the access 

mode.

In Existing datasets in workspace, select 

New Dataset<testname>.csv, and click Next. 

You can optionally name the dataset column 

in this session and you are prompted for the 

access mode. You can add other columns 

and data later.

An association between the test and an exist

ing dataset.

Select the dataset. The dataset is associated 

with the test, and you can optionally set the 

access mode in this session.

A new, fully functioning dataset. Select a project and click Use wizard to cre

ate new dataset.

4. Select Open mode  for the dataset. This mode determines the view that virtual users have of the 

dataset.

Different tests can open the same dataset differently, and you can change the open mode later by 

opening the test and double-clicking the dataset title.

Option Description

Shared (per test execution)  (default)
When you choose the Shared (per test execu

tion) option, the virtual users running in the 
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Option Description

test share the dataset values in sequential or

der.

For example, if your dataset has 10 rows, the 

dataset values are taken from row 1, row 2, 

row 3, and so on when you select this option.

Private

Each virtual user draws dataset values from a 

private view of the dataset, with dataset rows 

apportioned to each user in sequential order.

This option ensures that each virtual user 

gets the same data from the dataset in the 

same order. Because each user starts with 

the first row of the dataset and accesses the 

rows in order, different virtual users will use 

the same row. The next row of the dataset is 

used only if you add the test that is using the 

dataset to a loop in the schedule with multi

ple iterations.

Shared (for all test executions)

When you choose the Shared (for all test ex

ecutions) option, the virtual users running in 

multiple tests share the dataset values from 

the current row.

For example, if your dataset has 10 rows and 

when you set the current row as row 5, the 

dataset values are taken from row 5 instead 

of row 1 when you select this option. If you 

had set the current row as row 1 and used 

the dataset values until row 5, the dataset val

ues are retrieved from row 6 when you run the 

test next time.

5. If you are setting how the test accesses the dataset during this session, select one of the following 

options:
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• Sequential: Rows in the dataset are accessed in the order in which they are physically stored 

in the dataset file, beginning with the first row and ending with the last.

• Random: Rows in the dataset are accessed in any order, and any given row can be accessed 

multiple times or not at all. Each row has an equal chance of being selected each time.

• Shuffled: Before each dataset access, the order of the rows is changed that results in a 

different sequence. The rows are accessed randomly but all rows must be selected once 

before a row is selected again.

6. Select one of the following options.

Option Description

Wrap when the last row is reached

By default, when a test reaches the end of 

a dataset or dataset segment, it reuses the 

data from the beginning. To force a test to 

stop at the end of a dataset or segment, clear 

the Wrap when the last row is reached  check 

box. Forcing a stop might be useful if, for ex

ample, a dataset contains 15 records, you 

run a test with 20 virtual users, and you do 

not want the last five users to reuse infor

mation. Although the test is marked Fail be

cause of the forced stop, the performance da

ta in the test is still valid. However, if reusing 

dataset data does not matter to your appli

cation, the default of wrapping is more con

venient. With wrapping, you need not ensure 

that your dataset is large enough when you 

change the workload by adding more users or 

increasing the iteration count in a loop.

Note:

• With Random  access order, Wrap 

when the last row is reached  option is 

unavailable because you never reach 

the end of the row.

• With Shuffled  access order, if you se

lect Wrap when the last row is reached 

option, you resume selecting from the 

beginning of the row with the same ac
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Option Description

cess order after each row has been se

lected once. No more selections are 

required if you clear the Wrap when 

the last row is reached  option.

Fetch only once per user

By default, one row is retrieved from the 

dataset for executing each test, and the data 

in the dataset row is available to the test only 

for the duration of the test. Select Fetch only 

once per user  to specify that every access of 

the dataset from any test being run by a par

ticular virtual user will always return the same 

row.

To illustrate how these options affect the rows that are returned, assume that a test contains a 

loop which accesses a dataset. The loop has 2 iterations. The following table shows the row that is 

accessed in each iteration:

Dataset option Iteration 1 Iteration 2

Sequential  and Private row 1 row 2

Shared  and Shuffled row x row y

Fetch only once per user row x row x

7. If you are creating a fully functioning dataset, you can optionally import the data from a CSV file 

during this session by copying the CSV file and pasting into your project. For more information on 

importing dataset, see Editing datasets  on page 332.

After you have created a dataset and added data to it, the next step is to associate a value in the test with 

a column in the dataset, as discussed in Associating a test value with a dataset column  on page 328.

Related information

Dataset overview  on page312

Creating a dataset in a workspace  on page318

Converting an existing datapool to a dataset  on page319

Creating datasets with multiple substitutions  on page320
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How dataset options affect values that a virtual user retrieves  on page324

Enabling a test to use a dataset  on page325

Associating a test value with a dataset column  on page328

Viewing dataset candidates when you open a test  on page331

Editing datasets  on page332

Using a digital certificate store with a dataset  on page340

Navigating between a dataset and a test  on page341

Creating a dataset in a workspace
You can create datasets in a workspace containing variable data that tests use when they run. You can 

use this method to create a dataset if you have not yet created the test that will use it.

1. Click File  > New  > Dataset.

2. In the New Dataset  window, click the project that contains the dataset. The project is displayed in 

the Enter, create, or select the parent folder  field.

3. In the Name  field, type the name of the dataset, and then click Next.

4. In the window for describing the dataset, add a description.

5. In the Dimensions  field, specify the number of rows and columns for the dataset that you want to 

create.

6. Click Finish.

The new dataset opens in a browser. For instructions on how to add data to or edit the dataset, see 

Editing a dataset  on page 332.

After you have created a dataset and added data to it, you must associate a value in the test with a 

column in the dataset.

Related information

Dataset overview  on page312

Creating a dataset associated with a test  on page313

Converting an existing datapool to a dataset  on page319

Creating datasets with multiple substitutions  on page320

How dataset options affect values that a virtual user retrieves  on page324
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Enabling a test to use a dataset  on page325

Associating a test value with a dataset column  on page328

Viewing dataset candidates when you open a test  on page331

Editing datasets  on page332

Using a digital certificate store with a dataset  on page340

Navigating between a dataset and a test  on page341

Converting an existing datapool to a dataset
Starting from 9.5 the dataset formerly known as datapool is in the CSV format. You can convert any 

existing datapool to a dataset.

When you open the workspace earlier to 9.5 in IBM®  Rational®  Performance Tester  9.5, the existing 

datapools in the workspace are stored in the Datapools (Legacy-Unsupported) folder as shown in the 

following figure.

To convert the existing datapool to a dataset:

1. In the Test Navigator, browse and select the existing datapool.

2. Right-click and select Convert to Dataset…. Verify that the name of the dataset is the name of the 

existing datapool and format is .csv.

3. Click Finish. The converted datapool opens in a CSV editor.

After you have created a dataset and added data to it, you must associate a value in the test with a 

column in the dataset.
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Related information

Dataset overview  on page312

Creating a dataset associated with a test  on page313

Creating a dataset in a workspace  on page318

Creating datasets with multiple substitutions  on page320

How dataset options affect values that a virtual user retrieves  on page324

Enabling a test to use a dataset  on page325

Associating a test value with a dataset column  on page328

Viewing dataset candidates when you open a test  on page331

Editing datasets  on page332

Using a digital certificate store with a dataset  on page340

Navigating between a dataset and a test  on page341

Creating datasets with multiple substitutions
Earlier to 9.2, you could substitute one dataset value at a time. Starting from 9.2, after the test is 

generated, you can view all the dataset candidates, add multiple candidates as dataset values, substitute 

values, and create a new dataset out of it. You can also substitute multiple dataset candidates for an 

existing dataset.

When you substitute multiple dataset candidates to create a new dataset, the same number of columns 

are created in the dataset. The names of the candidates become the names of columns and values in the 

dataset. When you substitute multiple dataset candidates in an existing dataset, the column names in 

the dataset are retained. If the number of substitutions chosen was greater than the number of columns 

in the dataset, the extra number of substitutions are added as columns in the dataset. For instance, if a 

dataset has three columns and you substitute five dataset candidates, two new columns are created by 

using the names of the dataset candidates.

To create a dataset from multiple dataset candidates:

1. In the Test Editor, select the name of the test and from the Test Details section, select Common 

Options  and click Show Dataset Candidates.

Alternative: After the test generation when you open the test, you are prompted that “Some test 

data may need to be correlated or substituted”. If you click Yes, you can see the list of dataset 

candidates.
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2. Select the dataset candidates that you want to add as values to the dataset and click Substitute 

multiple candidates.

The Add Dataset  dialog box shows the list of datasets that are in the project but not associated 

with the test.

3. To associate an existing dataset with the test and assign the selected dataset candidates as 

values and substitutions, select a dataset and click Next. To associate a new dataset with the test, 

click the Use wizard to create new Dataset  and click Next.

4. Select Open mode  for the dataset. This mode determines the view that virtual users have of the 

dataset.

Different tests can open the same dataset differently, and you can change the open mode later by 

opening the test and double-clicking the dataset title.

Option Description

Shared (per test execution)  (default)

When you choose the Shared (per test execu

tion) option, the virtual users running in the 

test share the dataset values in sequential or

der.

For example, if your dataset has 10 rows, the 

dataset values are taken from row 1, row 2, 

row 3, and so on when you select this option.

Private

Each virtual user draws dataset values from a 

private view of the dataset, with dataset rows 

apportioned to each user in sequential order.

This option ensures that each virtual user 

gets the same data from the dataset in the 

same order. Because each user starts with 

the first row of the dataset and accesses the 

rows in order, different virtual users will use 

the same row. The next row of the dataset is 

used only if you add the test that is using the 

dataset to a loop in the schedule with multi

ple iterations.

Shared (for all test executions)

When you choose the Shared (for all test ex

ecutions) option, the virtual users running in 

multiple tests share the dataset values from 

the current row.
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Option Description

For example, if your dataset has 10 rows and 

when you set the current row as row 5, the 

dataset values are taken from row 5 instead 

of row 1 when you select this option. If you 

had set the current row as row 1 and used 

the dataset values until row 5, the dataset val

ues are retrieved from row 6 when you run the 

test next time.

5. If you are setting how the test accesses the dataset during this session, select one of the following 

options:

• Sequential: Rows in the dataset are accessed in the order in which they are physically stored 

in the dataset file, beginning with the first row and ending with the last.

• Random: Rows in the dataset are accessed in any order, and any given row can be accessed 

multiple times or not at all. Each row has an equal chance of being selected each time.

• Shuffled: Before each dataset access, the order of the rows is changed that results in a 

different sequence. The rows are accessed randomly but all rows must be selected once 

before a row is selected again.

6. Select one of the following options.

Option Description

Wrap when the last row is reached

By default, when a test reaches the end of 

a dataset or dataset segment, it reuses the 

data from the beginning. To force a test to 

stop at the end of a dataset or segment, clear 

the Wrap when the last row is reached  check 

box. Forcing a stop might be useful if, for ex

ample, a dataset contains 15 records, you 

run a test with 20 virtual users, and you do 

not want the last five users to reuse infor

mation. Although the test is marked Fail be

cause of the forced stop, the performance da

ta in the test is still valid. However, if reusing 

dataset data does not matter to your appli

cation, the default of wrapping is more con

venient. With wrapping, you need not ensure 
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Option Description

that your dataset is large enough when you 

change the workload by adding more users or 

increasing the iteration count in a loop.

Note:

• With Random  access order, Wrap 

when the last row is reached  option is 

unavailable because you never reach 

the end of the row.

• With Shuffled  access order, if you se

lect Wrap when the last row is reached 

option, you resume selecting from the 

beginning of the row with the same ac

cess order after each row has been se

lected once. No more selections are 

required if you clear the Wrap when 

the last row is reached  option.

Fetch only once per user

By default, one row is retrieved from the 

dataset for executing each test, and the data 

in the dataset row is available to the test only 

for the duration of the test. Select Fetch only 

once per user  to specify that every access of 

the dataset from any test being run by a par

ticular virtual user will always return the same 

row.

To illustrate how these options affect the rows that are returned, assume that a test contains a 

loop which accesses a dataset. The loop has 2 iterations. The following table shows the row that is 

accessed in each iteration:

Dataset option Iteration 1 Iteration 2

Sequential  and Private row 1 row 2

Shared  and Shuffled row x row y

Fetch only once per user row x row x

7. Click Finish.
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Related information

Dataset overview  on page312

Creating a dataset associated with a test  on page313

Creating a dataset in a workspace  on page318

Converting an existing datapool to a dataset  on page319

How dataset options affect values that a virtual user retrieves  on page324

Enabling a test to use a dataset  on page325

Associating a test value with a dataset column  on page328

Viewing dataset candidates when you open a test  on page331

Editing datasets  on page332

Using a digital certificate store with a dataset  on page340

Navigating between a dataset and a test  on page341

How dataset options affect values that a virtual user retrieves
The Open, Access, and Wrap modes that you select for a dataset affect the values that a virtual user 

retrieves.

The following table lists the most common types of datasets and the options that you select to create 

them.

Dataset purpose

Open 

mode 

selec

tion

Ac

cess 

mode 

selec

tion

Wrap 

mode se

lection

The virtual user retrieves the value from the current row of the dataset 

in a random order for every attempted transaction. Note that before 

accessing each row of the dataset the order of the rows is rearranged.

Shared 

(for all 

test exe

cutions)

Shuf

fled

Fetch on

ly once 

per user

The virtual user retrieves the value from the current row of the dataset 

in sequential order for every attempted transaction.

Shared 

(for all 

Se

quen

tial

Fetch on

ly once 

per user
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Dataset purpose

Open 

mode 

selec

tion

Ac

cess 

mode 

selec

tion

Wrap 

mode se

lection

test exe

cutions)

The virtual user retrieves the value from the beginning of the row of a 

dataset in a random order for every attempted transaction.

Shared 

(per test 

execu

tion)

Ran

dom

Wrap 

when 

the last 

row is 

reached

The virtual user retrieves the value from the current row of a dataset in 

sequential order for every attempted transaction. When a test reaches 

the end of a dataset, it reuses the data from the current row selection 

of the dataset.

Shared 

(for all 

test exe

cutions)

Se

quen

tial

Wrap 

when 

the last 

row is 

reached

Related information

Dataset overview  on page312

Creating a dataset associated with a test  on page313

Creating a dataset in a workspace  on page318

Converting an existing datapool to a dataset  on page319

Creating datasets with multiple substitutions  on page320

Enabling a test to use a dataset  on page325

Associating a test value with a dataset column  on page328

Viewing dataset candidates when you open a test  on page331

Editing datasets  on page332

Using a digital certificate store with a dataset  on page340

Navigating between a dataset and a test  on page341
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Enabling a test to use a dataset
Before a test can use variable data from a dataset, you must update the test to include a reference to that 

dataset.

1. In the Test Navigator, browse to the test and double-click it. The test opens.

2. Right-click the test name, and click Add  > Dataset.

The Select Dataset File  window is displayed listing the datasets available to the test. If a test is 

already using a dataset, it does not appear in the list.

3. In the Existing Dataset in workspace  list, click the name of the dataset that your test will use and 

click Next.

4. Select the Open mode  for the dataset. This mode determines the view that virtual users have of the 

dataset. This option is useful when you do a parallel test run.

Option Description

Shared (per test execution)  (default)

When you choose the Shared (per test execu

tion) option, the virtual users running in the 

test share the dataset values in sequential or

der.

For example, if your dataset has 10 rows, the 

dataset values are taken from row 1, row 2, 

row 3, and so on when you select this option.

Private

Virtual users draw from a private view of the 

dataset, with dataset rows apportioned to 

each user in sequential order.

This option ensures that each virtual user 

gets the same data from the dataset in the 

same order. However, because each user 

starts with the first row of the dataset and 

accesses the rows in order, different virtual 

users will use the same row. The next row of 

the dataset is used only if you add the test 

that is using the dataset in a loop with more 

than one iteration.

Shared (for all test executions)
When you choose the Shared (for all test ex

ecutions) option, the virtual users running in 
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Option Description

multiple tests share the dataset values from 

the current row.

For example, if your dataset has 10 rows and 

when you set the current row as row 5, the 

dataset values are taken from row 5 instead 

of row 1 when you select this option. If you 

had set the current row as row 1 and used 

the dataset values until row 5, the dataset val

ues are retrieved from row 6 when you run the 

test next time.

5. Select the Access mode  for the dataset:

• Sequential: The rows in the dataset are accessed in the order in which they are physically 

stored in the dataset file, beginning with the first row and ending with the last.

• Random: The rows in the dataset are accessed in any order, and any given row can be 

accessed multiple times or not at all. Each row has an equal chance of being selected each 

time.

• Shuffled: Before each dataset access, the order of the rows is changed, and a different 

sequence results. Rows are accessed randomly but all rows must be selected once before a 

row is selected again.

6. Select whether the test will reuse data when it reaches the end of the dataset.

By default, when a test reaches the end of a dataset or dataset segment, it reuses the data from 

the beginning. To force a test to stop at the end of a dataset or segment, clear the check box Wrap 

when the last row is reached. Forcing a stop might be useful if, for example, a dataset contains 

15 records, you run a test with 20 virtual users, and you do not want the last five users to reuse 

information. Although the test is marked as “Fail”  because of the forced stop, the performance 

data in the test is still valid. However, if it does not matter to your application if data is reused, the 

default of wrapping is more convenient. With wrapping, you need not ensure that your dataset 

is large enough when you change the workload by adding more users or increasing the iteration 

count in a loop.

7. Select whether the test will make the data in the dataset record permanent for each virtual user.

By default, one row is retrieved from the dataset for each execution of a test, and the data in the 

dataset row is available to the test only for the duration of the test. Select Fetch only once per user 

to specify that every access of the dataset from any test being run by a particular virtual user will 

always return the same row.
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To illustrate how these options affect the rows that are returned, assume that a test contains a 

loop which accesses a dataset. The loop has two iterations. The following table shows the row 

that is accessed in each iteration:

Dataset option Iteration 1 Iteration 2

Sequential  and Private row 1 row 2

Shared  and Shuffled row x row y

Fetch only once per user row x row x

8. Click Finish.

A reference to the dataset is added to the test, and the Test Details  area is updated with the 

dataset information.

9. Save the test.

Now that you have created a reference between the test and the dataset, the next step is to associate a 

value in the test with a column in the dataset.

Related information

Dataset overview  on page312

Creating a dataset associated with a test  on page313

Creating a dataset in a workspace  on page318

Converting an existing datapool to a dataset  on page319

Creating datasets with multiple substitutions  on page320

How dataset options affect values that a virtual user retrieves  on page324

Associating a test value with a dataset column  on page328

Viewing dataset candidates when you open a test  on page331

Editing datasets  on page332

Using a digital certificate store with a dataset  on page340

Navigating between a dataset and a test  on page341
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Associating a test value with a dataset column
After you have created a dataset and have enabled your test to use the dataset, you can associate a 

specific value in the test with a specific dataset column.

1. In the Test Navigator, browse to the test and double-click it. The test opens.

2. Locate and click a request that contains a value to replace with variable data.

Clicking a test page displays a table that lists dataset candidates and correlated data on that 

page. (If correlated data is not displayed, right-click the table and verify that Show References  is 

selected.) References are color coded in blue and dataset candidates are color coded in black.

If the contents of the Value column corresponds exactly with column data in your dataset, click the 

row, and then click Substitute. The Select Data Source  window is displayed. Skip to step 6. You can 

ignore step 8 because the URL encoding is preselected.

Otherwise, double-click the row to navigate to the page request that contains the value to replace 

from a dataset, and continue to the next step.

The value to replace from a dataset might not be listed in any page table. In this case, manually 

locate the request string that includes the value.

3. If the value to replace from a dataset is part of a string that has been designated a dataset 

candidate, you must remove the light green highlight: right-click and select Remove Substitution.

For example, if you searched for doe, john  in your test, the dataset candidate in your test is 

displayed as doe%2C+john. Suppose that you do not want to associate this candidate with a single 

dataset column that contains data in the format doe, john. Instead, you want to associate doe  and 

john  with separate dataset columns. In this case, you must first remove the substitution.

4. Highlight the value: With the left button pressed, drag your mouse over the value.

5. Right-click the highlighted value, and select Substitute  > Select Data Source.

The Select Data Source  window is displayed.

Note:  To use a dataset that is not listed, click Dataset: the Select dataset column  window is 

displayed.

6. Click the name of the dataset variable, or column, to associate with the test value.
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7. Click Select.

To indicate that the association has been set, the highlighting for the selected test value turns dark 

green, and the dataset table for this page is updated as shown in the example.

8. Optional: Encode variable data when it is substituted from a dataset.

If a test value contains special characters such as spaces or commas, click the row and select 

URL Encode. With this option, special characters are encoded when variable data is substituted 

from a dataset. For example, data that is space-separated in a dataset column might need to be 

encoded. When the URL encoding is enabled, John Doe  is substituted as John%20Doe. If the URL 

encoding is not selected, the variable data that is substituted is literal. Do not enable URL encoding 

for datasets that contain data that is already encoded.

9. Optional:  If you substitute an element of a page with a dataset column, to view the substitutions 

in the Page Elements report, in the Test Elements Details area of the request click the Use the 

substituted URL in performance reports  check box.

10. Save the test.

Related information

Dataset overview  on page312

Creating a dataset associated with a test  on page313

Creating a dataset in a workspace  on page318

Converting an existing datapool to a dataset  on page319

Creating datasets with multiple substitutions  on page320

How dataset options affect values that a virtual user retrieves  on page324

Enabling a test to use a dataset  on page325

Viewing dataset candidates when you open a test  on page331

Editing datasets  on page332

Using a digital certificate store with a dataset  on page340
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Navigating between a dataset and a test  on page341

Adding data source controller  on page293

Viewing dataset candidates when you open a test
Dataset candidates are displayed automatically when you open a test for the first time. From the dataset 

candidates window you can view the dataset candidates in the test, bookmark locations of interest, and 

add or remove dataset references.

1. Record a test.

When the test opens for the first time in the Test Navigator, the Show Dataset Candidates 

window is displayed. The Show Dataset Candidates  window is displayed only if there are dataset 

candidates and if Always display this dialog when a test is first opened  is selected. To prevent the 

Show Dataset Candidates  from being displayed when a test opens, clear the Always display this 

dialog when a test is first opened  check box in the Show Dataset Candidates  window.

2. Do one of the following:

Option Description

To view details about the 

dataset candidates in a test

Navigate through the Dataset Candidates 

field to see them previewed in the Preview 

pane. Click the Next  and Previous  icons to 

move the selection down or up in the list of 

dataset candidates. Click the Show as Tree 

icon to toggle between tree format and list 

format. Click the Sort  icon to sort the list of 

dataset candidates. Click the Bookmark  icon 

to bookmark a location for later review.

To select a data source 

for a dataset candidate

Select the dataset candidate in the Dataset 

Candidates  field, and then click Substitute. 

The Select Data Source  window opens.

To find more values in the test 

that have the same value as 

the selected dataset candidate

Click Find More and Substitute. These values 

can be reviewed and substituted interactively 

as needed.

To remove a substitution
Select a substitution site, and then click Re

move Substitution.
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3. Click Close  to close the Show Dataset Candidates  window and proceed to the test in the test 

editor.

To display the Show Dataset Candidates  window again while in the test editor, click the root node 

of the test. Then click the Common Options  tab under Test Element Details, and then click Show 

Dataset Candidates.

Related information

Dataset overview  on page312

Creating a dataset associated with a test  on page313

Creating a dataset in a workspace  on page318

Converting an existing datapool to a dataset  on page319

Creating datasets with multiple substitutions  on page320

How dataset options affect values that a virtual user retrieves  on page324

Enabling a test to use a dataset  on page325

Associating a test value with a dataset column  on page328

Editing datasets  on page332

Using a digital certificate store with a dataset  on page340

Navigating between a dataset and a test  on page341

Editing datasets
You can add, modify, remove, import, or export data from a dataset by using the CSV Editor. The working 

principle of the CSV Editor is similar to that of a spreadsheet.

You must have created a dataset. See Creating a dataset in a workspace  on page 318.

In Rational®  Performance Tester  V9.5.0 or later, you can use the CSV Editor to view and edit data in the 

dataset. You can also view the datasets in other editors by right-clicking the dataset and selecting the 

Open With  option.

You can perform basic tasks in the CSV Editor by right-clicking any row, column, or cell of the dataset to 

organize your data in a better way. For example, updating the data in a cell, inserting or deleting rows and 

columns, or renaming column names.
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When you edit the dataset in a CSV Editor, you can use the following keyboard shortcuts to control the 

cursor selection in the CSV Editor:

• Tab  - To move the cursor control to the next available option.

• Shift-Tab  – To move the cursor control to the previous option.

• Shift+F10  – To open the context menu from the dataset cell.

Note:  You cannot resize the width of rows in the CSV Editor. When you have a large amount of data in 

a cell, you can right-click the cell and select Copy  (or Ctrl+C), and then paste it into a text-editing program 

to view the content. Alternatively, you can hover the mouse over the cell to view the content.

When you have a CSV file that has data separated from a character, then you can import that CSV file into 

the dataset. You can select any of the following separator characters from the Configure Dataset  window, 

and the selection can be the separator character that you used in the CSV file:

• Comma

• Semicolon

• Space

• Tab

• Other

Consider that you have the data in the CSV file in the following format:

When you import the CSV file in the dataset, and then select the separator value as Semicolon, the data in 

the dataset is displayed as follows:
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If you want the data in its original format, that is, a semicolon (;) character to separate the data, then you 

can choose any other separator value from the Configure Dataset  window.

Note:  The default separator value is Comma.

1. Double-click the dataset that you want to edit in the Test Navigator.

The dataset opens in the CSV Editor in a browser.

2. Perform the following actions to use the options available in the CSV Editor:

Options Actions

Find and 

Replace 

To find:

a. Click the Find and Replace  icon .

b. Enter the content that you want to search in the Find  field.

c. Select any or all the following options to find the search content more ef

fectively:

• Select the Case sensitive  check box to search the content that is 

the exact letter case of the content entered in the Find  field.

• Select the Match entire cell contents  check box to search for cells 

that contain only the characters that you have entered in the Find 

field.

• Select the Search using regular expression  check box to search 

the pattern that matches strings.

For example, to search a cell that contains any number between 0 

to 9, do the following:

i. Enter \d  in the Find  field.

ii. Select the Search using regular expression  check box.

iii. Click Find.

d. Click Find. If the text is found, the cell containing that text is selected.

e. Click Find  again to find further instances of the search text.

To find and replace:

a. Click the Find and Replace  icon .

b. Enter the content that you want to search in the Find  field.

c. Enter the content that you want to replace in the Replace  field.

d. Select any or all the following options to find and replace the content 

more effectively:
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Options Actions

• Select the Case sensitive  check box to find the content that is the 

exact letter case of the content entered in the Find  field.

• Select the Match entire cell contents  check box to find and re

place for cells that contain only the characters that you have en

tered in the Find  and Replace  fields.

• Select the Search using regular expression  check box to find and 

replace the pattern that matches strings.

e. Click Replace  to replace the individual instances.

f. Click Replace All  to replace every instance of the content throughout the 

dataset.

Undo a. Click the Undo  icon .

b. Select the recent changes from the list that you want to undo, and then 

click the list.

The Undo  option undoes anything you do in the dataset. The CSV Editor saves 

the unlimited undo-able action. You can perform the undo action even after you 

save your changes made to the dataset.

Redo a. Click the Redo  icon .

b. Select the recent changes from the list that you want to redo, and then 

click the list.

The CSV Editor saves the unlimited redo action.

Import 
a. Click the Import  icon .

b. Click Choose File  and select the CSV file that you want to import in the 

Import File  dialog box.

Note:  If the CSV file contains test data with Unicode characters in it, 

you must save the CSV file in UTF-8  format. You can then choose the CSV 

file and import the test data from the CSV file into the dataset.

c. Optional. Click Overwrite  to add the rows and columns from the selected 

CSV file from the beginning of the dataset.

d. Optional. Click Append  to add rows and columns from the selected CSV 

file to the end of the dataset.

e. Optional. Select the First row contains headers  check box if your CSV file 

contains the header.

335



Test Author Guide

336

Options Actions

Export 
Click the Export  icon  to download the dataset as a CSV file.

Set as cur

rent row

Right-click any cell in a row and select Set as current row.

When rows are deleted:

If you delete any row between row 1 to current row, the current row data is taken 

from the next row.

For example, when you set the current row as 6, and then you delete any row be

tween row 1 to row 6, the current row remains at row 6, but the content of row 7 

is moved to row 6.

When rows are inserted:

If you insert any new row between row 1 to the current row, the current row data 

is taken from the previous row.

For example, when you set the current row as 6, and then you insert any row be

tween row 1 to row 6, the current row remains at row 6, but the content of row 5 

is moved to row 6.

Dataset 

configu

ration set

tings 

In the Configure Dataset  window, you can set the separator value, change the 

row and column settings, and configure the string values in the dataset.

a. Click the Menu  icon , and then select the Configure  option.

b. Select any of the separator values that you used in the CSV file.

The available options are Comma, Semicolon, Space, Tab, and Other. In 

the CSV file, if you have any other separator characters other than the 

available options, then you can select the Other  option, and then can 

specify a value.

For example, if the data in the CSV file is separated by a character #, then 

select the Other  option and enter #  in the field.

c. Configure the following options to change the row and column settings:
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Options Actions

• Column header  - Use an up-down control button to increment or 

decrement the value of the column header.

• Data start point  - Use an up-down control button to increment or 

decrement the value of the data starting pointer.

• Current row  - Use an up-down control button to increment or 

decrement the value of the current row.

d. Configure the following options to change the string values in the 

dataset:

• Treat as null  - Enter a string value that is to be treated as null 

when running the test.

• Treat as empty  - Enter a string value that is to be treated as empty 

when running the test.

For example, when you run the test and the data 123  in the dataset 

to be treated as empty, then you can specify 123  in the Treat as 

empty  field.

• Treat empty text as null  - Select this field when you want the 

dataset that contains any blank cells, and the value of those blank 

cells to be interpreted as null.

e. Click Update  to apply the changes.

Discard 
Click the Menu  icon , and then select Discard  to discard the changes made 

to the dataset.

3. Click the Save  icon  to save the changes made to the dataset.

You have edited the dataset.

Related information

Dataset overview  on page312

Creating a dataset associated with a test  on page313

Creating a dataset in a workspace  on page318

Converting an existing datapool to a dataset  on page319

Creating datasets with multiple substitutions  on page320
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How dataset options affect values that a virtual user retrieves  on page324

Enabling a test to use a dataset  on page325

Associating a test value with a dataset column  on page328

Viewing dataset candidates when you open a test  on page331

Using a digital certificate store with a dataset  on page340

Navigating between a dataset and a test  on page341

Encrypted datasets overview
You can encrypt one or more columns in a dataset. If you want to encrypt confidential information such 

as a set of passwords or account numbers that are used during a test, you can use an encrypted dataset.

Dataset columns are encrypted using the RC4 private-key algorithm. You can use only one password to 

encrypt columns in any given dataset. Encrypted datasets are not supported on agent computers that are 

running the z/OS®  or AIX®  operating systems.

Important:  If you forget the password to a dataset, there is no way to recover the password.

When you run a test that uses a dataset that contains encrypted variables, you are prompted for the 

dataset password. If the test uses multiple encrypted datasets, you must enter the password for every 

encrypted dataset that the test uses.

When you run a test that uses a dataset with an encrypted column, the value of the column is decrypted at 

a run time. The column value is sent as a cleartext string in the requests to the server. The actual values 

of the encrypted dataset variables are not displayed in the test log. The test log displays asterisks for the 

encrypted dataset variables.

To see the actual values of variables that are sent to the server at run time, you must use custom code. 

You can send the dataset column value to custom code that writes the value to a file other than the 

test log. If the custom code writes to the test log using tes.getTestLogManager().reportMessage(), then 

asterisks are displayed instead of the decrypted variables.
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Encrypting a dataset column
To secure test data, you must encrypt datasets. You can encrypt data in the columns of a dataset by 

using an encryption key. When you run a test that utilizes a dataset with encrypted variables, you must 

enter the encryption key for the encrypted column that the test uses.

You must have created a dataset. See Creating a dataset in a workspace  on page 318.

1. Double-click the dataset in the Test Navigator.

The dataset is displayed in a browser.

2. Right-click any cell in a column that you want to encrypt and select Encrypt column data.

The Encrypt Column  window is displayed.

3. Enter an encryption key in the Encryption Key  field to encrypt the data in the column.

Remember:  When you have already encrypted other columns in the dataset, you must enter 

the same encryption key that you used previously. You can use only one encryption key to encrypt 

columns in a dataset.

Important:  The encryption keys you use to encrypt data in a dataset are not stored on the 

server nor can be retrieved from the server. Therefore, you must remember to store the encryption 

keys in a secure location. You must use the same encryption keys to view the encrypted values, to 

decrypt data, or enable the use of the encrypted dataset during test runs.

4. Click Encrypt Column.

Asterisks are displayed instead of actual data for the encrypted column.

The dataset column is encrypted.

Related information

Decrypting a dataset column  on page339

Decrypting a dataset column
To view the content of an encrypted dataset, you can decrypt the dataset. Removing encryption from a 

dataset revokes the protection offered to the test data.

You must have created a dataset with at least one encrypted column. See Creating a dataset in a 

workspace  on page 318 and Encrypting a dataset column  on page 338.
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1. Double-click the dataset in the Test Navigator.

The dataset is displayed in a browser.

2. Right-click encrypted cells that display the contents with asterisks, and then select Decrypt column 

data.

The Decrypt Column  window is displayed.

3. Enter the encryption key that you used to encrypt the data in the column in the Encryption Key  field.

4. Click Decrypt Column.

Asterisks are replaced with the actual data in the decrypted column.

The encryption is now removed from the selected column in the dataset. When you run a test that uses 

a dataset that contains decrypted data, the variable data is substituted for the data in the recorded test 

without prompting for the encryption key.

Related information

Encrypting a dataset column  on page338

Using a digital certificate store with a dataset
You can associate the certificates in one or more certificate stores with a dataset to use multiple digital 

certificates during testing.

1. Open a test for editing. On the Common Options  page, click Add Dataset.

2. Create a dataset with two columns that contains a list of the certificates in the certificate store 

and a list of passphrases for the certificates. To learn more about adding datasets, see Creating 

a dataset in a workspace  on page 318. You can use the supplied KeyTool program to generate 

a list of names of certificates in a certificate store. To learn more about KeyTool, see Creating a 

digital certificate store  on page .

3. Select Fetch only once per user.

4. Save the dataset.

5. On the Security  page, under Digital Certificates, click Add.

6. Select a certificate from the certificate store that you created previously.

7. Type the passphrase for the selected certificate.

8. When prompted to dataset the digital certificate, click Yes.

9. In the Select dataset column  wizard, choose the dataset that you added previously, and substitute 

the appropriate columns for the certificate name and passphrase.

10. Save the test, and then add the test to a schedule.

../../com.ibm.rational.test.lt.doc/topics/tcreatecert.html
../../com.ibm.rational.test.lt.doc/topics/tcreatecert.html
../../com.ibm.rational.test.lt.doc/topics/tcreatecert.html
../../com.ibm.rational.test.lt.doc/topics/tcreatecert.html
../../com.ibm.rational.test.lt.doc/topics/tcreatecert.html
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When you run this schedule, the certificates from the certificate store are submitted to the server.

Related information

Dataset overview  on page312

Creating a dataset associated with a test  on page313

Creating a dataset in a workspace  on page318

Converting an existing datapool to a dataset  on page319

Creating datasets with multiple substitutions  on page320

How dataset options affect values that a virtual user retrieves  on page324

Enabling a test to use a dataset  on page325

Associating a test value with a dataset column  on page328

Viewing dataset candidates when you open a test  on page331

Editing datasets  on page332

Navigating between a dataset and a test  on page341

Navigating between a dataset and a test
After you have created a dataset or imported a comma-separate values (CSV) file into a dataset, you can 

navigate between the dataset and associated tests in the test editor. You can enlarge the test and the 

dataset, list the datasets that a test uses, navigate from a row in a dataset to the corresponding element 

in the test, see the data for a page or request, and add or remove dataset references.

1. In the Test Navigator, browse to the test and double-click it. The test opens.

2. Do one of the following actions:

Option Description

Maximize the test window

Double-click the test tab (for example, 

). Do not click the x, or you 

will close the test. To return to the default 

perspective, click Window  > Reset Perspec

tive.
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Option Description

View the datasets that a test uses
In the Test Contents  area, click the first line 

of the test, which is the test name.

Navigate from a row in a dataset 

to its corresponding element

a. In the Test Contents  area, click the 

test name, which displays the dataset.

b. Expand the dataset to display the 

rows.

c. Double-click the row.

View the data for a page or request
In the Test Contents  area, click the page or 

request.

To add a reference to a dataset

In the Test Element Details  area, drag your 

cursor over the candidate, right-click, and se

lect Substitute  > Select Data Source. The 

Select Data Source  window opens. If you 

have not already added the dataset to the 

test, click Dataset, and then add the new 

dataset.

Remove a reference to a dataset

In the Test Element Details  area, drag your 

cursor over the reference, right-click, and se

lect Remove Substitution.

3. Save the test, if you have made any changes.

Related information

Dataset overview  on page312

Creating a dataset associated with a test  on page313

Creating a dataset in a workspace  on page318

Converting an existing datapool to a dataset  on page319

Creating datasets with multiple substitutions  on page320

How dataset options affect values that a virtual user retrieves  on page324

Enabling a test to use a dataset  on page325

Associating a test value with a dataset column  on page328

Viewing dataset candidates when you open a test  on page331
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Editing datasets  on page332

Using a digital certificate store with a dataset  on page340

Test variables
A test variable is a user-defined, name-value pair that stores and refers to information throughout a test 

and between tests.

Sharing variables among tests
A variable is declared in the test variables section of the test. You can use it throughout the test as a 

reference for any field that can be substituted. Substituting data from a test variable is achieved using the 

Test Variables  page of the Test Data Source view. You can do the following actions to a test variable:

• Provide a default value to the variable during declaration.

• Change the value of the variable using Set Variable statement. You can use the Add and Insert 

menus of the Test Editor to create Set Variable statements.

• Set hard-coded value or value retried from a data source, such as dataset or reference that appears 

before the Set statement to the variable.

If a variable is initialized at various places such as test, compound test, schedule, or user group, the 

product uses the following order to initialize the value of the variable when running the test. The variable 

set in the variable table of the compound test editor takes the highest precedence followed by others:

1. Compound test setting in the variable table UI

2. Compound test specified in a var file

3. User group setting in the variable table UI

4. User group specified in a var file

5. Schedule specified setting in the variable table UI

6. Schedule specified in a var file

7. Command line

Note:  You must select All tests for this user  from the Visible in  drop-down list to take the precedence 

of variable initialization.

In order to share variables between tests, all the tests must contain the variables with the same name. 

The variables must also have Visible in  set to All tests for this user. When these conditions are met and 
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multiple tests have been placed in a schedule, then variable in the dataset of one test can be used in the 

other test.

A common reason to share data between tests is to perform data correlation. With data correlation, a 

variable is set to a response that comes from a request in one test and is used in requests performed in 

a different test. Assume that you are testing an employee database. The Create Employee test creates 

an employee record and the Modify Employee test modifies an employee record. When a new record is 

created, it is assigned a record ID. Variables can be used to pass the record ID from a response in the 

Create Employee test to the Modify Employee test. A user-defined variable is not shared among different 

virtual users. The variable is shared only among the different tests of the same virtual user. If you set 

Visible in  to This test only, then dataset from a test is not available to another even if both tests contain 

variables with the same name.

If you want to share variables between the different types of test scripts in your product, consider the 

following points:

• Declare the test variables with the same name across all the test scripts for the variables to 

communicate with each other. Set Visible in  to All tests for this user.

• Include the required test scripts into a compound test.

Using test steps, you can share the default values of the variables to another test script. You can also 

assign new values to the variables and use the latest values in another test script.

If you want to share variables between the test scripts of different testing products such as Rational® 

Functional Tester, Rational®  Performance Tester, or Rational®  Integration Tester, you must consider the 

following points:

• If you are using Installation Manager, you must shell-share or install the products in the same 

package group.

• Declare the test variables with the same name across the Rational®  Functional Tester  and 

Rational®  Performance Tester  test scripts. Set Visible in  to All tests for this user.

• Include the required test scripts into a compound test.

• If you are using Rational®  Integration Tester  test scripts, you must map your tags with the test 

variables of Rational®  Functional Tester  or Rational®  Performance Tester.
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Using variables to access datasets

You can define variables so that they share data from a dataset throughout tests. This is achieved by 

having the value field of a Set Variable statement substituted from a dataset. By doing so, the first test 

which appears in the schedule can set the variable from a dataset and share it with the other test in a 

schedule.

Assume that you have two tests that log in to an application using a user ID from a dataset. The first test 

can set the value of a variable from the dataset, and both tests can use the variable, instead of directly 

using the dataset. In this case both use the same record from the dataset. This is similar to the fetch-only-

once-per-user behavior of a dataset. However, fetching once means that during playback, a virtual user 

gets only one record from the dataset. The one-record limit holds even if the tests are in a loop, and are 

run several times by the virtual user. By using the user-defined variables, the virtual user retrieves a new 

record each time through the loop, and both tests can use the same record.

Note:  Assignment (set) operators can not only have a variable value substituted from a dataset, but 

also in the declaration of a variable. You can substitute the assignment operator and variable value from 

any data source, and thus that value can be shared between tests as well.

Array variables

You create an array variable to add multiple values to a variable. If you create a secondary HTTP request, 

add complete paths of the requests in the array variable that can be used a custom code during playback.

Declaring and assigning test variables
When you declare a variable, you can create a container for it, initialize it to a string or a dataset value, and 

set its scope. Then, within the test, you can reassign another value to the variable.

If the data that you want to assign to a variable is only available after a specific test step, instead of 

initializing the variable, you need to add a variable assignment further down in the test, so that when the 

assignment occurs, the data that you need to use is available. Otherwise, when you try to initialize the 

variable (or do the assignment), the value that you want to use will not be available and will not show up 

as an option to select.

If a variable is initialized at various places such as test, compound test, schedule, or user group, the 

product uses the following order to initialize the value of the variable when running the test. The variable 

set in the variable table of the compound test editor takes the highest precedence followed by others:

1. Compound test setting in the variable table UI

2. Compound test specified in a var file
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3. User group setting in the variable table UI

4. User group specified in a var file

5. Schedule specified setting in the variable table UI

6. Schedule specified in a var file

7. Command line

Note:  You must select All tests for this user  from the Visible in  drop-down list to take the precedence 

of variable initialization.

To create, initialize, and assign a value to a test variable:

1. In the Test Navigator, browse to the test and double-click it.

The test opens.

2. To create a container for the test variables that you create in a test:

a. Open the test, and in theTest Contents  area, click Test Variables.

b. Select Add  >  Test Variable Container.

A container named Test Variables  is created for the user-defined variables.

c. Select the container to rename it.

The  Test Element Details  area opens for you to type a new name in the Name  field.

3. To declare or define a test variable:

a. Open the test, and in the  Test Contents  section, click the user-defined container to contain 

the variable.

b. To create a variable, select Add  >  Variable Declaration. To create an array variable, select 

Add  >  Array Variable Declaration.

c. Type the name of the variable, and click OK.

The variable is added as the last element in the container and the  Test Element Details  area 

opens.

d. In the  Test Element Details  area, set the scope and initial value for the variable.

Visible in: Select This test only  to restrict data to the current test only. Even if another test 

has a variable with the same name, that variable will not change. Select All tests for this 

user  to share the value of this variable when the test runs in a schedule. For the variable to 

be shared, both tests must have a variable with the same name and must have this option 

enabled.
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Check Value: Select When first used to check whether or not a variable is initialized only 

after the test execution reaches the first request that uses a variable. Select At test start to 

check whether or not a variable is initialized when starting the execution of the test. If the 

variable is not initialized, then an error message is displayed, depending on the behavior set.

If not initialized, set to: Select Text  to initialize the variable to a specific value whenever the 

test runs in the schedule. Select Dataset value  and, in the Select Data Source  window, select 

the dataset that will initialize the variable.

Run-time error if variable not initialized: Select the action for the run when it encounters an 

uninitialized test variable. If you select Issue test log warning  or Issue test log error, verify 

that the Test log  page in the schedule sets errors, failures, and warnings to All, which is the 

default setting. If you select Exit the test, the schedule continues to run although the virtual 

users that have the uninitialized variable stop. If you select Do nothing, the test continues to 

run.

4. To assign or initial a value to a test variable:

a. Open the test, and in the  Test Contents  area, select a test element.

b. Select Insert  >  Variable Assignment, which inserts the assignment before the selected 

element.

The Test Editor  window opens and lists the variables available to the test.

c. Select the variable that you are assigning a value to and, in the Set to  box in the Test 

Element Details  area, set the value for the variable.

You can set the value to a text string, to any data source that exists in the test before the 

assignment statement, or to Not initialized.

A Set  statement is added to the test, with the value you chose.

Related information

Initializing variables from the command line  on page347

Initializing variables from Rational Quality Manager  on page360

Initializing variables from the command line
To initialize test variables from an XML file, you can run the test from the command-line interface using 

the varfile  option.
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• Declare the variables using IBM®  Rational®  Performance Tester.

• You must have set the Web Reports  preferences in the desktop client to view the status of the test 

run from the command line. See Accessing reports remotely  on page .

• Create an XML file that contains the variables with values. The XML file would have a structure 

similar to the following image 

If a variable is initialized at various places such as test, compound test, schedule, or user group, the 

product uses the following order to initialize the value of the variable when running the test. The variable 

set in the variable table of the compound test editor takes the highest precedence followed by others:

1. Compound test setting in the variable table UI

2. Compound test specified in a var file

3. User group setting in the variable table UI

4. User group specified in a var file

5. Schedule specified setting in the variable table UI

6. Schedule specified in a var file

7. Command line

Note:  You must select All tests for this user  from the Visible in  drop-down list to take the precedence 

of variable initialization.

1. Navigate to the directory that contains the cmdline.bat  and cmdline.sh  files.

On Windows™  operating systems, this directory is located at 

productInstallationDirectory\cmdline. For example, C:\Program Files\IBM\SDP

\cmdline.

2. Issue the following command:

cmdline  -workspace  workspace_full_path  -project  proj_rel_path  -eclipsehome  eclipse_full_path 

-plugins  plugin_full_path  -schedule   sched_rel_path  -suite  suite_rel_path  -importzip 

file_full_path.zip  -varfile  variable_file_full_path  -servicename  service   -serviceargs 

service_args  -configfile  file_full_path  -results  result_file  -overwrite  {"true" | "false"}  -quiet 

-users  nn  -vmargs  JVM_args  -rate  RateRunnerGroupName=iterationNumber/duration, 

iterationNumber/duration-duration  Stage1=durationOfStage; Stage2=durationOfStage  -publish 

serverURL#project.name=projectName  -publish_for  {ALL,PASS,FAIL,ERROR, INCONCLUSIVE} 

unique_250
unique_250
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-exportlog  log_full_path  -exportstats  local_dir_path  -exportstatsformat  name of the file format  

-timerange  "all, 5 Users, 10 Users"  -exportstatshtml  local_dir_path  -compare  "result_path1, 

result_path2"  -exportstatreportlist  stats_list  -execsummary  local_dir_path  -execsummaryreport 

reportID  -usercomments  "any user comment"  -publishreports  "FUNCTIONAL, MOBILE_WEBUI, 

STATS, TESTLOG"   -stdout   -swapdatsets  existing_dataset_file_path:new_dataset_file-path 

-hitory  jaeger,testlog,null  -overridermlabels  "label name 1,label name 2"

Notes:

• The workspace is locked after you issue the command. To check the progress of the test 

or schedule  during the run, invoke another workspace and open the project through that 

workspace.

• On Linux operating system, the command must start with cmdline.sh.

• The command line does not provide a way to specify the secure storage password for 

resource monitoring. You must provide the password in the workbench and ensure that it is 

stored and persisted in the schedule before you execute the schedule from the command 

line.

If a value contains spaces, enclose the value in quotation marks. To see the online help for this 

command while you are in the directory that contains the .bat file, type cmdline -help.

The following table explains each options:

-work

space

Required. The complete path to the Eclipse workspace.

-project Required. The path, including the file name of the project relative to the work

space.

-eclipse

home

Optional.

The complete path to the directory that contains eclipse.exe.

For example, C:\Program Files\IBM\SDP

-plugins Optional. The complete path to the folder that contains the plugins. Typically, on 

Windows operating systems, this folder is located at C:\Program Files\IBM

\IBMIMShared\plugins.

Required. This option is required only if the folder is at a different location.

-schedule Optional. However, in a command, it is mandatory to use one of the following op

tions:
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• -suite

• -schedule

• -servicename

You must not use the -schedule  option along with the other options. The path in

cludes the file name of the schedule to run relative to the project.

Starting from V9.2.1.1, you can execute multiple schedules simultaneously.

For example, -schedule  sch1:sch2:sch3

-suite Optional. However, in a command, it is mandatory to use one of the following op

tions:

• -suite

• -schedule

• -servicename

You must not use the -suite  option along with the other options. The path in

cludes the file name of the suite to run relative to the project.

Starting from V9.2.1.1, you can execute multiple tests simultaneously.

For example, -suite  test1:test2:test3.

-im

portzip

Optional. To import the project as test assets with dependencies into your work

space, use the -importzip  option. This command is available from V9.2.1.1 and 

later.

You can execute test assets from the imported zip file, but you must specify the 

-importzip  {complete path where the zip file is stored on your computer}  option 

along with the -schedule  or  -suite  options.

For example, C:\User\Desktop\test1.zip

-varfile Optional. You can use this option to specify the complete path to the XML file 

that contains the variable name and value pairs.

-service

name

Optional. However, in a command, it is mandatory to use one of the following op

tions:

• -suite

• -schedule

• -servicename

You must not use the -servicename  option along with the other options. The path 

includes the file name of the service to run relative to the project. Instead of run

ning a performance test, the specified service is run when it is available.
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-ser

viceargs

Optional. You can use this option to specify a series of arguments to pass to the 

service specified.

For example, -serviceargs  "-myserviceparm1 myserviceparm1value"

The values are in quotation marks as they contain spaces.

-config

file

Optional. You can use this option to specify the complete path to a file that con

tains the parameters for a test or schedule  run. Each parameter must be on a 

single line. To create a configuration file, you must use an editor that does not 

wrap lines. Any parameters, whether required or optional, can be set in the con

figuration file. The command line parameters override the values in this file.

Notes:

• If you are creating a config file manually, the file must be in the UTF-8 for

mat. You must not use quotation marks in this file even for values that 

contain spaces.

• You can create command line config file from the product, which you can 

use while running tests or schedules  from the command-line interface or 

Maven. For more information about how to create a command line config 

file from the product, see related links.

-results Optional. You can use this option to specify the name of the results file. The de

fault result file name is the test or schedule  name with a time stamp appended. 

You must specify a folder name that is relative to the project to store the test re

sults.

For example, -results  folder/resultname

-over

write

Optional. Determines whether a result file with the same name is overwritten. 

The default value, false, indicates that the new result file is created. If the value 

is true, the file is overwritten and retains the same file name. You must use dou

ble quotes “”  for values true  or false.

-quiet Optional. Turns off any message output from the launcher and returns to the 

command shell when the run or the attempt is complete.

-users Optional. Overrides the default number of virtual users in the run. For a schedule, 

the default is the number of users specified in the schedule editor. For a test, the 

default is one user. This option creates a new copy of the schedule that contains 

the specified number of users.
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-vmargs Optional. To specify the Java™  maximum heap size for the Java™  process that 

controls the command line playback, use the -vmargs  option with the -Xmx  argu

ment.

For example, when you use-vmargs  -Xmx4096m, specify a maximum heap size 

of 4096m. This method is similar to specifying -Xmx4096m  in the eclipse.ini file 

for the workbench when playing back the test from the user interface.

-rate Optional. You can use this argument to specify a rate that you want to achieve 

for a workload in the Rate Runner group. For example, -rate  "Rate Runner Group 

1=1/s, 3/m; Rate Runner Group 2=5/s, 10/s".

Here, Rate Runner Group 1  is the name of the Rate Runner group that has two 

stages. The desired rate for the first state is one iteration per second and the 

rate for the second stage is three iterations per minute.

Note:  The Rate Runner group name must match with the name in the Rate 

Schedule.

-duration Optional. You can use this argument to specify the duration of the stages in the 

Rate Schedule.

For example, -duration  Stage1=10s; Stage2=3m

Note:  The stage number specified must exist in the Rate Schedule.

-publish Optional. You can use -publish  parameter to publish test results to Rational® 

Test Automation Server. You can use the following options along with the -pub

lish  parameter:

• no

You can use the no  option if you do not want to publish test results after 

the run. This option is useful if the product preferences are set to publish 

the results, but you do not want to publish them.

• You can use any of the following options to specify the project name:

◦ serverURL  #project.name=projectName&teamspace

.name=name_of_the _teamspace

◦ serverURL  #project.name=projectName&teamspace.alias=name_

of_the _teamspace_alias

You must consider the following points while providing the project name:
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◦ If the project name is not specified, then the value of the  -project 

parameter is used.

◦ If you have a project with the same name in different team spaces, 

then you can append either the &teamspace.name=name_of_the 

_teamspace  or &teamspace.alias==name_of_the_teamspace_

alias  options along with the -publish  parameter.

For example: -publish “https://local

host:5443/#project.name=test&teamspace.name=ts1”

Where:

▪ https://localhost:5443  is the URL of the server.

▪ test  is the name of the project.

▪ ts1  is the name of the team space.

Note:  If the name of the project or team space contains a space character, 

then you must replace it with %20.

For example, if the name of the team space is Initial Team Space, then you must 

provide it as Intial%20Team%20Space.

Remember:  If you provide the server and the project details under Window  > 

Preferences  > Test  > Rational Test Automation Server  in the product and if you 

use serverURL#project.name=projectName  along with the -publish  para

meter, the server details in the command-line interface take precedence over the 

product preferences.

Important:  You must provide the offline user token for the server by using 

the RTCP_OFFLINE_TOKEN  environment variable before you use the -publish  pa

rameter in the command-line interface.

-publish_

for

Optional. You can use this option to publish the test results based on the com

pletion status of the tests:

• ALL - This is the default option. You can use this option to publish test re

sults for any text execution verdict.

• PASS - You can use this option to publish test results for the tests that 

have passed.

• FAIL - You can use this option to publish test results for the tests that 

have failed.
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• ERROR - You can use this option to publish test results for the tests that 

included errors.

• INCONCLUSIVE - You can use this option to publish test results for the 

tests that were inconclusive.

You can add multiple parameters separated by a comma.

-export

log

Optional. You can use this parameter to specify the file directory path to store 

the exported HTTP test log, UI Test report, and Unified report.

Starting from V10.0.1, by using the -exportlog  parameter, you can provide multi

ple parameter entries when running multiple tests. You must use a colon to sep

arate the parameter entries.

For example: -exportlog  c:/logexport.txt:c:/secondlogexport.txt

If there are multiple -suite  parameter entries with a single -exportlog  parameter 

entry, then the -exportlog  parameter generates the appropriate number of test 

logs by appending 0, 1, 2, and so on to the -exportlog  parameter entry name.

For example: -suite  "sampletest1:sampletest2:sampletest3"  -exportlog  c:/logex

port.txt  The command generates the following test logs:

• logexport_0.txt

• logexport_1.txt

• logexport.txt

The last test log generated has the same name as that of the initial -exportlog 

entry.

Note:  If there are multiple -suite  and -exportlog  parameter entries, the num

ber of -suite  entries must match with the number of -exportlog  entries. Other

wise, the following error message is displayed:

Error, number of -suite and -exportlog entries do not match.

-export

stats

Optional. You can use this option to export reports in comma-separated values 

(CSV) format, with the file name derived from the report name. This directory can 

be relative to the project or a directory on your file system. If the -exportstatre

portlist  option is not specified, the reports specified on the Export Reports  page 

of the Performance Test Report  preferences are exported.

-export

statsfor

mat

Optional. You can use this option to specify a format for the result that you want 

to export along with the -exportstats  option. You must use at least one of the fol

lowing parameters with the -exportstatsformat  option:
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• simple.csv

• full.csv

• simple.json

• full.json

• csv

• json

For example, -exportstats  <local_dir_path>  -exportstatsformat  simple.json

You can add multiple arguments separated by a comma.

For example, -exportstats  <local_dir_path>  -exportstatsformat  simple.json, ful

l.csv

When you want to export both simple and full type of test results in a json or csv 

format, you can specify json  or csv  as the arguments in the command. When the 

test run completes, the test result exports to simple.json and full.json files.

For example, -exportstats  <local_dir_path>  -exportstatsformat  json

You can select the Command Line  check box from the product preferences 

(Window  > Preferences  > Test  > Performance Test Reports  > Export Reports) 

when you want to export test results to one of the selected formats after the test 

run completes.

Remember:  When you run the test from the command line, and if you use 

the  -exportstats  parameter, then the command line preferences take prece

dence over the preferences set in the product. Therefore, by default, the test re

sult exports to a CSV format.

For example, when you select the Command Line  option and Report format  to 

json  in the product preferences, and run the test from the command-line inter

face without using the -exportstats  option. The result is exported to a json file 

after the test run is complete.

-

timerange

Optional. You can use this option along with -exportstats, -exportstatshtml, and 

-execsummary  to export test results within one or more time ranges. The value 

is the time range that you specify in the schedule.

For example, “all, 5 Users,10 Users”. You must separate time ranges with a com

ma and use double quotation marks (“”) when there is space in a time range.
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-export

statshtml

Optional. When you want to export web analytic results, you can use this option. 

The results are exported in the specified directory. You can then analyze the re

sults on a web browser without using the test workbench.

-compare You can use this argument along with -exportstatshtml  and -execsummary  to 

export the result in compare mode. The value can be paths to the runs and are 

relative to the workspace. You must separate the paths by a comma.

-export

statre

portlist

Optional. You can use this option to specify a comma-separated list of report IDs 

along with -exportstats  or -exportstatshtml  to list the reports that you want to 

export in place of the default reports, or the reports selected under Preferences. 

To view this setting, navigate to Window  > Preferences  > Test  > Performance 

Test Reports  > Export Reports.

To copy the report IDs list into your command line, navigate to Window  > Pref

erences  > Test  > Performance Test Reports  > Export Reports. Under Select re

ports to export, select the required reports, and click Copy ID to clipboard. You 

can then paste the clipboard content on to your command line editor

-exec

summary

Optional. You can use this option to export all of the reports for the test run in a 

printable format, also known as an executive summary, to the local computer. 

You must specify the path to store the executive summary.

-exec

summa

ryreport

Optional. You can use this option to export a specific report as an executive 

summary for the test run to the local computer. You must specify the ID of the 

report to export.

For example, to export an HTTP performance report, specify http. You must use 

this option along with -execsummary.

To copy the report IDs list into your command line, navigate to Window  > Pref

erences  > Test  > Performance Test Reports  > Export Reports. Under Select re

ports to export, select the required reports, and click Copy ID to clipboard. You 

can then paste the clipboard content on to your command line editor

-user

com

ments

Optional. You can add text within double quotation mark (“”) to display it in the 

User Comments  row of the report.

Note:  You can use the file CommandLine.exe  to run the command to add 

comments in a language that might not support Unicode characters on Windows 

operating system.
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-pub

lishre

ports

Optional. You can use this option to publish test results in Rational®  Test Au

tomation Server. The parameters that you can use with it are the following:

• FUNCTIONAL

• MOBILE_WEBUI

• STATS

• TESTLOG

For example, -publishreports  "STATS, TESTLOG"

You must prefix with “!”  to publish all the reports except the specified one.

For example, -publishreports  "! TESTLOG"

All the reports except the TESTLOG report is published to Rational®  Test Au

tomation Server  after executing the command.

-stdout Optional. You can use this option to display the information about the test or 

schedule  on the command line.

After you run a test or schedule  from the command line, the following outputs 

are displayed to give you the overall information of the test or schedule:

• --VERDICT: The verdict of the test or schedule.

• --REMOTE_RESULT: The URL of the result published to Rational®  Test Au

tomation Server.

• --REMOTE_RESULT_UI: The URL of the result published to Rational®  Test 

Automation Server  and can be opened in a browser to analyze the result.

• --LOCAL_RESULT: The path of the result saved locally.

For example, -workspace  workspace_full_path  -project  proj_rel_path  -schedule 

sched_rel_path  -publishpublish_url  -stdout

-swap

datasets

Optional. Use this option to replace dataset values during a test or schedule. If a 

test or schedule  is associated with a dataset, you can replace the dataset at run 

time while initiating the run from the command line.

You must ensure that both original and new datasets are in the same workspace 

and have the same column names. You must also include the path to the dataset 

when you run the -swapdatasets command.

For example, -swapdatsets  /project_name/ds_path/ds_filename.csv:/project_

name/ds_path/new_ds_filename.csv

You can swap multiple datasets that are saved in a different project by adding 

multiple paths to the dataset separated by a semicolon.
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For example, -swapdatsets  /project_name1/ds_path/ds_filename.csv:/project_

name1/ds_path/new_ds_filename.csv;/project_name2/ds_path/ds_file

name.csv:/project_name2/ds_path/new_ds_filename.csv

-history Use this command when you want to view a record of all events that occurred 

during a test  or schedule  run. However, you must use the command suffixed with 

any of the following options:

• jaeger: To send test logs to the Jaeger UI during the test  or schedule  run.

• testlog: To send test logs as traditional test logs in Rational®  Perfor

mance Tester  during the test   or schedule  run.

• null: To send no test logs either to the Jaeger UI or Rational®  Perfor

mance Tester  during the test   or schedule  run.

For example:

-workspace workspace_full_path -project proj_rel_path 

-suite suite_rel_path -stdout -history comma delimited list of modes

-workspace C:/Users/IBM/rationalsdp/test_ws -project Project1 

-suite test1.testsuite -stdout -history jaeger

Note:  You can add multiple options separated by a comma to send test logs 

during the test   or schedule  run to Rational®  Performance Tester  and the Jaeger 

UI.

For example:

-workspace C:/Users/IBM/rationalsdp/test_ws -project Project1 

-suite test1.testsuite -stdout -history jaeger, testlog

For more information about how to view test logs in the Jaeger UI and Rational® 

Performance Tester, see related links.

- overrid

ermlabels

Optional. By using the -overridermlabels  command, you can control the Re

source Monitoring sources that are required to collect in a performance sched

ule during the schedule run.

You can use this command if you want to perform any of the following actions:

• To enable the Resource Monitoring from Service  option for a perfor

mance schedule if the Resource Monitoring from Service  option is not 

enabled from the schedule editor in Rational®  Performance Tester.

• To ignore Resource Monitoring sources that were set in the performance 

schedule and to change for a label matching mode.
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• To replace an existing set of Resource Monitoring labels that were set 

in the performance schedule and run the schedule with a new set of Re

source Monitoring labels.

Note:  You must add the Resource Monitoring labels to the Resource 

Monitoring sources on the Resource Monitoring  page in your Rational® 

Test Automation Server  project. You can use these labels for adding the 

Resource Monitoring sources to run the performance schedule through 

the command line interface.

The command accepts a comma-separated list of labels.

For example, if you have added a label in Rational®  Test Automation Server  for 

a Resource Monitoring source as rm1, then run the following command to collect 

data from the source as follows:

-workspace workspace_full_path -project proj_rel_path 

-suite suite_rel_path -overridermlabels "rm1"

Note:  You can add multiple labels to a performance schedule separated by 

a comma  to collect data from the multiple sources during the schedule run. For ex

ample:

-workspace workspace_full_path -project proj_rel_path

 -suite suite_rel_path -overridermlabels "rm1,rm2,rm3"

If your label contains a comma (,), then when running the -overridermlabels 

command, you must replace the single comma  with the double comma  in the la

bel.

For example, if you have added a label to a Resource Monitoring source as 

(rm1,test), then you must run the following command to collect data from 

source as follows:

-

workspace workspace_full_path -project proj_rel_path -suite suite_rel_path -overridermlabe

ls "rm1,,test"

To stop the test run, you can open another command prompt window and use one of the following 

options with the cmdline  option:
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Com

mand

Description

-sto

prun

Optional. Stops the test run after the specified number of seconds. The block is ex

ecuted, and the test log is transferred before stopping the run. You must use the 

-workspace  command and specify the location of the workspace.

-

aban

don

run

Optional. Stops the test run immediately. You must use the -workspace  command 

and specify the location of the workspace.

Note:  Messages are displayed to indicate when the test or schedule  is launched and when it is 

completed unless you include the -quiet  option.

cmdline  -workspace C:/RPTWorkspace  -project testProj  -eclipsehome C:\Program Files

\__BRAND_NAME__\__SDP_PATH__\eclipse.exe  -schedule MySchedule  -varfile C:/Assets/

testProjVar.xml

Related information

Declaring and assigning test variables  on page345

Initializing variables from Rational Quality Manager  on page360

Initializing variables from Rational®  Quality Manager
If you want to run an IBM®  Rational®  Performance Tester  test from IBM®  Rational®  Quality Manager, 

you can pass the execution variables defined in Rational®  Quality Manager  to the Rational®  Performance 

Tester  test.

• Configure the Rational®  Quality Manager  adapter in Rational®  Performance Tester. For more 

information, see the Configuration  on page  topic.

• Variable names must be the same in Rational®  Quality Manager  and Rational®  Performance 

Tester.

• The Visible in  value for the variable in the Rational®  Performance Tester  test must be set to All 

tests for this user.

When you pass an execution variable to a Rational®  Performance Tester  test, the value initialized in the 

test is replaced by the value in the execution variable. If you modify the value that is initialized in the test, 

unique_251
unique_251


Chapter 1. Test Author Guide

after the test is executed, the modified value is passed back to the execution variable in Rational®  Quality 

Manager.

To initialize an execution variable value to a test, run the test from Rational®  Quality Manager. For 

information about execution variables, see Using execution variables in manual test.

Related information

Declaring and assigning test variables  on page345

Initializing variables from the command line  on page347

Correlating response and request data
For a test to run correctly, a request that is sent to a server might need to use a value that was returned 

by a previous request. By ensuring that this data is correlated accurately, you can produce better 

performance tests.

Data correlation overview
A request can include data that was returned in the response to a previous request. Associating data in 

this manner is called data correlation.

Video: Data correlation

Interactions with an application are typically related to each other. For example, consider the following 

interactions with a web-based application, in which each request depends on information returned from a 

previous response:

1. A payroll clerk types the web address for an application, which sends a login prompt. When the 

clerk logs in, the web server returns a page that indicates that login has succeeded and a unique 

session ID to the web browser that the clerk is using.

2. The clerk clicks a link on the returned page, which requests that the web server open the page for 

searching the employee database. The web browser includes the session ID when sending the 

request. Based on the session ID, the web server knows that the request comes from someone 

who is already logged on, and so opens the search form for the employee database. The clerk then 

searches for a specific employee. The web server returns a photograph of that employee and the 

employee's unique ID.
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3. The clerk clicks a link that requests the web server to return the payroll record for the employee. 

With this request, the web browser sends two IDs:

• The session ID, so that the web server knows that the request comes from some who is 

logged on

• The employee ID, so that the web server can locate and return the correct information

In this example, request 2 depends on request 1, and request 3 depends on requests 1 and 2.

If you record these interactions in a test, before running the test with multiple users, you would vary the 

test data. For example, you would replace the user name and password values, the employee name 

search values, or both, with values that datasets contain. When you run the test, each virtual user returns 

a different employee payroll record, based on the contents of the datasets.

In a generated test, where data in a request depends on data that is contained in the response to a 

previous request, the request data is substituted from the response data on which it depends. The term 

for this internal linking of response and request data is data correlation. When you run a test with multiple 

users and varied data, data correlation is required to ensure that the test runs correctly.

A reference  is a value in a test (typically in a response) that can be used by a subsequent value in the test 

(typically in a request). When the test generator detects that a request value must be substituted from a 

previous value, it designates the earlier value as a reference and correlates the subsequent request value 

with the reference. This process is called automated data correlation. You can also manually correlate any 

two values in a test or unlink existing correlations.

Note:  You can change or disable automated data correlation. To do so, click Window  > Preferences, 

expand Test, and then click Test Generation.

By default, the empty strings are not correlated because it might increase the time taken to generate a 

test. However, sometimes empty strings such as spouse name or middle initial become important to 

correlate. To correlate the empty strings, click Window  > Preferences  > Test  > Test Generation  > HTTP 

Test Generation  > Data Correlation  and select the Create substitutions for empty strings  check box.

Generally, the HTML response content after the recording appears as <input type="username" 

name="User" id="aaa" value="John"/>. Some applications dynamically update the name  attribute. 

Therefore, when you play back the test, the HTML response content appears as <input type="username" 

name="idt020" id="aaa" value="John"/>. Because the name  attribute changes dynamically, data 

correlation does not occur and the playback fails. For data correlation to correlate the response content 

based on the ID  attribute, ensure that you have selected ON  in the Priortize correlation based on ID  option 

at Window  > Preferences  > Test  > Test Generation  > HTTP Test Generation  > Data correlation.

To help you work with correlated data, the test editor uses color coding and provides navigational aids:
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• When you click a page, you see a Test Data table for that page. By default, related dataset 

candidates are shown in green text on a light green background, values that are already associated 

with a dataset are shown in white text on a green background, and references are shown in blue 

text.

• If correlated data is not displayed, right-click the table and verify that Show References  is selected. 

To navigate directly to a page request containing correlated data, double-click a table row. To 

associate correlated data from this table with a dataset, click the row, click Substitute, and then 

click Select Data Source  to open the Select Data Source  window. You can also use the Test Data 

Sources  view to make substitutions. In the test editor, right-click the Test Data  table, and then 

select Link with Test Data Sources View. When you click a row in the Test Data  table, the Test Data 

Sources  view displays information about the selected substitution site.

• When you expand a page, green text indicates page requests that contain dataset data or 

candidates. Blue text indicates page requests that contain references. 

• When you click a highlighted request, dataset candidates are highlighted in light green, data that is 

associated with a dataset is highlighted in dark green, and correlated data is highlighted in red. If 
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you right-click a value for correlated data, as shown in the example, you can then click Go To  to see 

its reference: 

• References are highlighted in dark blue.

Related information

Viewing data correlation  on page364

Data correlation rules overview  on page366

Test data sources overview  on page380

Viewing references  on page386

Creating a reference or field reference  on page389

Selecting a reference in a response  on page391

Correlating multiple fields in a test  on page394

Guidelines for adjusting data correlation  on page397

Finding data correlation errors  on page401

Disabling data correlation  on page402

Recorrelating test data  on page403
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Viewing data correlation
You can switch between viewing all test elements in the test editor and viewing only elements related 

to data correlation in the test editor. Viewing only data correlation elements makes it easier to add and 

remove substitutions.

1. In the Test Navigator, browse to the test, and double-click it. The test opens.

2. In the Test Contents  area, click Options.

3. Click Show  > Data Correlation.

The test editor window displays only elements that are related to data correlation. Alternately, click 

View  under Test Contents  to switch between Display all Test Contents  and Show Substitutions.

4. Select a single test element in the Test Contents  area to see the current data source and to remove 

or change the substitution in the Test Element Details  area. Select multiple elements in the Test 

Contents  area to see the data in tabular form in the Test Element Details  area. Different controls 

are available depending on the type and number of elements that you select in the Test Contents 

area.

5. Optional: In the Test Elements Details area, click Substitute  > Select Data Source  to open the 

Select Data Source  window, where you can specify the data source for the selected substitution 

site.

To view all test elements, click Options  > Show  > Data Correlation  again.

Note:  If you select a test element while viewing all test contents, and then switch to viewing only 

data correlation elements, then the corresponding substituters and dataset candidates are selected. For 

example, if you select an HTTP page in the test editor, and then switch to viewing only data correlation 

elements, then all substituters and dataset candidates for all requests from the HTTP page are selected.

Related information

Data correlation overview  on page361

Data correlation rules overview  on page366

Test data sources overview  on page380

Viewing references  on page386

Creating a reference or field reference  on page389

Selecting a reference in a response  on page391

Correlating multiple fields in a test  on page394

Guidelines for adjusting data correlation  on page397
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Finding data correlation errors  on page401

Disabling data correlation  on page402

Recorrelating test data  on page403

Data correlation rules overview
You can use the data correlation rules editor to customize how data is correlated. You can control how 

references and substitutions are generated in tests, and store these rules so that you do not have to 

manually correlate data in every test that you record against a particular application.

You create data correlation rule sets in the rules editor. Data correlation rule sets are also known as rules 

files. Each rule set can contain multiple rule passes, and each rule pass can contain multiple rules. When 

you re-correlate test data with data correlation rules, each rule set is applied in the order that you specify. 

Within each rule set, each rule pass is applied in order. Within each rule pass, each rule is applied in order.

You can use data correlation rules to do these tasks:

• Create a reference, substitution, variable, or dataset column

• Link a substitution to a reference

• Rename a reference or substitution

• Encode a substitution

• Unlink a substitution from a reference

• Remove a specific reference, substitution, or variable

• Remove all references or substitutions

Typically, you create a substitution and then link a reference to the substitution. References are located in 

the data that the server under test returns, while substitutions are in the data that is sent to the server. To 

create a substitution and then link a reference to the substitution in the rules editor, see Example: Linking 

references to substitutions with rules  on page 373.

Rule sets are hierarchical trees. You can insert child rules, which accept values generated by parent rules 

as input. To find a particular reference by name, first add a Find a reference  rule, and then add a child 

Reference name  rule. In the rules editor, you can also combine rules by using And  and Or  and Not  rules.

Related information

Data correlation overview  on page361

Viewing data correlation  on page364
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Test data sources overview  on page380

Viewing references  on page386

Creating a reference or field reference  on page389

Selecting a reference in a response  on page391

Correlating multiple fields in a test  on page394

Guidelines for adjusting data correlation  on page397

Finding data correlation errors  on page401

Disabling data correlation  on page402

Recorrelating test data  on page403

Creating data correlation rule sets
To use rules-based data correlation, you must create a data correlation rule set. Data correlation rule sets 

are also known as rules files.

1. Click File  > New  > Data Correlation Rule Set.

The New Data Correlation Rule Set  wizard opens.

2. Select a parent folder, and then in File name  provide a name.

3. Click Finish.

The data correlation rules editor opens.

An empty rule set is created. Data correlation rule sets are XML files with the .dcrules  file extension. 

Typically, you use the rules editor to edit data correlation rule sets. You can also use any XML editor to 

edit a data correlation rule set file.

Creating a reference using data correlation rules
You can create a data correlation rule that creates a reference from a regular expression when the rule is 

applied to test data.

1. Open a data correlation rule set in the rules editor.

A new rule set contains one empty rule pass.

2. Click Insert, and then select Create a reference.

An empty Create a reference  rule is inserted in the rule pass.
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3. Under Details, supply information for all fields that are marked with asterisks and shaded in red. 

For Reference field, click the down arrow to select the field in which to create the reference. Use 

the push buttons at the top of the window to select a protocol, and then select a field.

For example, to create a reference in the content field of an HTTP response, click the down arrow, 

and then click HTTP  > Content. To create references in multiple fields, click the Add field  push 

button to add another Reference field.

4. In Regular expression, type an expression to use to locate the reference. If only a part of the 

regular expression is required for a reference, enclose that part in parentheses.

a. Open the test, and locate the response to create the reference in.

b. Copy the text from the response to the clipboard.

c. In the rules editor, click the Toggle regular expression assistant  push button to open the 

regular expression assistant.

d. Paste the text from the clipboard to the Test regular expression  page of the regular 

expression assistant window.

If the Test regular expression  page is empty, the contents of the clipboard is automatically 

pasted in.

e. Click the Captured group  tab in the regular expression assistant.

The overall group is displayed, and the captured groups are displayed. If no groups are 

displayed, edit the regular expression accordingly.

To create more than one reference using the same regular expression, enclose each part in 

parentheses. For example, two references can be created from this regular expression: name=(\S

+)\svalue=(.+?).

5. In Reference names, provide names for the references.

The names that you specify are available to child rules. To use the references as arguments in child 

rules, enclose the reference name in percent signs.

For example, if you specify a reference name of name, you can use %name%  as an argument in a child 

rule.

6. If an attribute contains multiple matches for the regular expression, in Occurrence, type or select 

the occurrence to use to create the reference.

7. Under Create reference only if used, select true  to create a reference only if a substitution site 

uses the reference. Select false  to create the reference regardless of whether a corresponding 

substitution site is found.

8. Under Overlapping site action, select the action to take when a new reference overlaps with 

existing references.
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Option Description

Always remove existing
If the new reference overlaps with other refer

ences, the other references are removed.

Keep existing
If the new reference overlaps with other refer

ences, the other references are not removed.

Keep existing only if used

If the new reference overlaps with other refer

ences, the other references are removed only 

if the references are unused.

9. Under Create reference even if overlapping, select true  to create a reference even if the new 

reference overlaps with existing references.

10. In Log level, select the level of error data to be written to the error log. With logs, you can see which 

rules worked and which did not. When you are debugging data correlation rules, use the Action 

log level. If the Action  log level does not provide enough data for troubleshooting, use the Detail 

log level. The Detail  log level products a significantly higher number of log entries. Typically, when 

you are sure that the data correlation rules that you have written work correctly, use the None  or 

Summary  log levels to reduce memory and disk-space consumption and unrequired entries in the 

error log.

Option Description

None Nothing is logged.

Warning

A message is logged when there are potential 

problems that are detected when the rule is 

applied.

Summary
One message is logged for the rule, no matter 

how many times the rule is applied.

Important

A message is logged every time the rule is ap

plied in a manner that is not typical. This is 

the default log level.

Action
A message is logged every time the rule is ap

plied.

Detail
A detailed message is logged every time the 

rule is applied.
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11. In Label, type a label for the rule. If you do not type a label name, the rule is given a default name. 

The default name is the base name with the regular expression appended.

12. In Description, describe the rule. Descriptions can be useful if you share rule set files with other 

testers.

Creating a substitution with data correlation rules
You can create a data correlation rule that creates a substitution from a regular expression that is applied 

to test data.

1. Open a data correlation rule set in the rules editor.

A new rule set contains one empty rule pass.

2. Click Insert, and then select Create a substitution.

An empty Create a substitution  rule is inserted in the rule pass.

3. Under Details, supply information for all fields that are marked with asterisks and shaded in 

red. For Field, click the down arrow to select the field for which to create a substitution. Use the 

push buttons at the top of the window to select a protocol, and then select a field. To create a 

substitution in the data field of an HTTP request, click the down arrow, and then select HTTP  > 

Data.

4. In Regular expression, type a regular expression to use to locate the substitution. If only a part of 

the regular expression is required for a substitution, enclose that part in parentheses.

a. Open the test, and locate the request to create the substitution in.

b. Copy the text from the request to the clipboard.

c. In the rules editor, click the Toggle regular expression assistant  push button to open the 

regular expression assistant.

d. Paste the text from the clipboard to the Test regular expression  page of the regular 

expression assistant window.

If the Test regular expression  page is empty, the contents of the clipboard is automatically 

pasted in.

e. Click the Captured group  tab in the regular expression assistant.

The overall group is displayed, and the captured groups are displayed. If no groups are 

displayed, edit the regular expression accordingly.
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To create more than one substitution site using the same regular expression, enclose each part in 

parentheses. For example, two substitution sites can be created from this regular expression: (.

+?)=(.*?).

To use values that were created in a parent Create a reference  rule as arguments in the regular 

expression, enclose the reference names in percent signs. For example, if a parent rule created a 

name  reference and a value  reference, you could use them in this regular expression: \:\{%name%,

%value%\}. When the rule is run, %name%  and %value%  are substituted with the values extracted by the 

parent rule, and then the resulting regular expression is evaluated. Two substitutions are created, 

each linked to the corresponding reference.

5. In Substitution names, type names for the substitutions.

6. Under Decode the field, select true  to decode the specified attribute before searching for a 

matching reference. Select false  to search for a matching reference without decoding the attribute. 

The type of encoding depends on the selected protocol and attribute. For example, HTTP data can 

be URL-encoded.

7. Under Create substitution only if used, select true  to create a substitution only when a matching 

data source is found. Select false  to create the substitution regardless of whether a matching data 

source is found.

8. Under Conflict action, select the action to take when a new substitution overlaps with existing 

substitutions.

Option Description

Always replace existing

If the new substitution overlaps with other 

substitutions, the other substitutions are re

moved.

Replace existing if dataset candidate

If the new substitution overlaps with other 

substitutions, and all the other substitutions 

are dataset candidates, other substitutions 

are removed. If at least one current substitu

tion site that overlaps with the new substitu

tion site is associated with a reference, then 

no current substitution is changed, and the 

new substitution is not created.

Replace existing if enclosed in the new site

If the new substitution overlaps with other 

substitutions that are all completely enclosed 

in the new substitution, other substitutions 

are removed. If at least one current substitu
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Option Description

tion overlaps with the new substitution with

out being completely enclosed by the new 

substitution, then no current substitution is 

changed, and the new substitution is not cre

ated.

Replace existing if dataset 

candidate or enclosed

If the new substitution overlaps with other 

substitutions, and each of the other substitu

tions is either a dataset candidate or is com

pletely enclosed in the new substitutions, oth

er substitutions are removed. If at least one 

current substitution overlaps with the new 

substitution without being completely en

closed by the new substitution, or if at least 

one current substitution site that overlaps 

with the new substitution site is actually as

sociated with a reference, then no current 

substitution is changed, and the new substi

tution is not created.

Keep existing

If the new substitution overlaps with other 

substitutions, the other substitutions are not 

removed. The new substitution is not created.

9. In Log level, select the level of error data to be written to the error log. With logs, you can see which 

rules worked and which did not. When you are debugging data correlation rules, use the Action 

log level. If the Action  log level does not provide enough data for troubleshooting, use the Detail 

log level. The Detail  log level produces a significantly higher number of log entries. Typically, when 

you are sure that the data correlation rules that you have written work correctly, use the None  or 

Summary  log levels to reduce memory and disk-space consumption and unrequired entries in the 

error log.

Option Description

None Nothing is logged.

Warning
A message is logged when potential prob

lems are detected when the rule is applied.



Chapter 1. Test Author Guide

Option Description

Summary
One message is logged for the rule, no matter 

how many times the rule is applied.

Important

A message is logged every time that the rule 

is applied in a manner that is not typical. This 

is the default log level.

Action
A message is logged every time the rule is ap

plied.

Detail
A detailed message is logged every time the 

rule is applied.

10. In Label, type a label for the rule. If you do not type a label name, the rule is given a default name. 

The default name is the base name with the regular expression appended.

11. In Description, describe the rule. Descriptions can be useful if you share rule set files with other 

testers.

Example: Linking references to substitutions with rules
You can create data correlation rules to link references to substitutions.

If you know which field in a request or in POST data must be correlated, write a Create a substitution 

rule for that field, and then insert a Create a reference  rule as a child of the Create a substitution  rule.

1. Open a data correlation rule set in the rules editor.

A new rule set contains one empty rule pass.

2. Create a Create a substitution  rule. See Creating a substitution with data correlation rules  on 

page 370 to learn more about creating a Create a substitution  rule.

3. Right-click the Create a substitution  rule, and then click Insert Item  > Find data source for 

substitution.

4. Right-click the Find data source for substitution  rule, and then click Insert Item  > Create a 

reference. If the reference exists, select Find a reference  instead of Create a reference.

A Create a reference  or Find a reference  rule is inserted as a child of the Find data source for 

substitution  rule. To use the value of the substitution extracted by the parent rule, type %subname

%  for the Regular expression, where subname  is the name of the substitution that is created by 

the parent rule. See Creating a reference using data correlation rules  on page 367 to learn more 

about creating a Create a reference  rule.
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When you recorrelate test data using this rule set, the references and substitutions that you defined are 

created and linked.

Assume that a URI in your test is http://host:port/RPThelp/index.jsp?topic=datacorrelation.html. Assume 

that some of the response data from a previous request includes ...<id=2 docHelpName=recordtest> 

<id=23 docHelpName=datacorrelation> <id=24 docHelpName=rules>.... Write a rule that creates 

a substitution site in the URI for datacorrelation  and sets the substitution name to helpname. Then, 

add rules that create a reference as a child of the substitution rule. The regular expression for the 

reference rule is docHelpName=%helpname%>. Thus, the regular expression in the reference rule evaluates to 

docHelpName=datacorrelation>. This regular expression ensures that the correct reference is linked to the 

substitution site.

Example: Linking substitutions to references with rules
You can create data correlation rules to link substitutions to references.

If you are familiar with the application under test and know the exact location of the reference in the 

response data, write a Create a reference  rule that uses a regular expression to locate the reference data, 

and then insert a Create a substitution  rule as a child of the Create a reference  rule.

1. Open a data correlation rule set in the rules editor.

A new rule set contains one empty rule pass.

2. Create a Create a reference  rule. See Creating a reference using data correlation rules  on page 

367 to learn more about creating a Create a reference  rule.

3. Right-click the Create a reference  rule, and then click Insert Item  > Link with substitutions.

4. Right-click the Link with substitutions  rule, and then click Insert Item  > Create a substitution. To 

use the value of the reference that is extracted by the parent rule, type %refname%  for the Regular 

expression, where refname  is the name of the reference that is created by the parent rule. See 

Creating a substitution with data correlation rules  on page 370 to learn more about creating a 

Create substitution  rule.

A Create a substitution  rule is inserted as a child of the Link with substitutions  rule.

When you recorrelate test data with this rule set, the references and substitutions that you defined are 

created and linked.

Assume that a response in your test data contains an ID that is present in URIs and in POST data 

throughout the test. For example, the response includes ...<NeededID=ID123 docHelpName=rules>.... 

Assume that a URI in the test is http://host:port/RPTHelpID123/index.jsp?topic=datacorrelation.html 
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and the POST data includes ...nameID123=ID123.... Because you know the exact location of the ID in 

the response, you can write a rule that creates a reference for the ID. Specify the Reference name  as ID. 

Then, add rules for two substitutions as children of the reference rule. Add one substitution with a URI 

attribute and one with a data attribute. Specify %id%  in Regular expression  for both substitution rules. 

Thus, the regular expression in the substitution rule becomes the ID123  value when the rules run. This 

regular expression creates substitution sites in every location where the ID123  value is found in URIs and 

in POST data. In this example, three substitution sites would be created: RPThelpID123, nameID123, and 

nameID123=ID123.

Example: Linking substitutions to built-in data sources with rules
You can create data correlation rules to link substitutions to built-in data sources. Built-in data sources 

include the dynamically calculated variables such as Current Date, Random Number, and Timestamp.

1. Open a data correlation rule set in the rules editor.

A new rule set contains one empty rule pass.

2. Create a Create a built in data source  rule.

3. Right-click the Create a built in data source  rule, and then click Insert Item  > Link with 

substitutions.

4. Right-click the Link with substitutions  rule, and then click Insert Item  > Create a substitution. See 

Creating a substitution with data correlation rules  on page 370 to learn more about creating a 

Create substitution  rule.

A Create a substitution  rule is inserted as a child of the Link with substitutions  rule.

When you recorrelate test data with this rule set, the built-in data sources and substitutions that you 

defined are created and linked.

Recorrelating data with rules
After you have created a data correlation rule set, you can recorrelate data in tests.

Record a test, and create a data correlation rule set.
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1. Open a test for editing. To recorrelate data in tests that are not open in the editor, select multiple 

tests in the Test Navigator  window.

2. To recorrelate a test that is open in the test editor, click Edit  > Re-correlate test and transform 

data. To recorrelate multiple tests, right-click the selected tests in the Test Navigator  window, and 

then select Apply data correlation rules.

The Data Correlation and Transformation  window opens.

3. Select Do rule-based data correlation.

4. Optional: To remove data correlation from the test data, select Clear existing data correlation. 

Select Do automatic data correlation  to recorrelate the test data by using the automatic data 

correlation.

You can control automatic data correlation in the preferences. Click Window  > Preferences  > Test  > 

Test Generation. Click HTTP Test Generation, and then click the Data Correlation  tab for additional 

controls over automatic HTTP data correlation.

5. Click Add.

The Rules File Selection  window opens.

6. Expand the list of resources to locate the data correlation rules file to add.

7. Select the data correlation rules file to add, and then click OK.

Data correlation rules files have the .dcrules  extension by default.

The rules file is added to the list under Rules Files.

8. Optional: Click Add  to add more rules files. Use the Up  and Down  push buttons to move rules files 

in the list. The data correlation rules are applied in the order in which the files are listed.

9. Click Finish.

The test data is recorrelated.

If you recorrelate test data in multiple tests that are not open in the test editor, the original tests are 

backed up. The backup copies are displayed in the list in the Test Navigator  window. To restore the 

original version of the test, right-click the backup copy in the Test Navigator  window, and then select 

Restore test.

Recording tests with data correlation rules
After you have created a data correlation rule set, you can record a test that uses those rules.

Create a data correlation rule set.
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1. In the Performance Test  perspective, click the New Test From Recording  toolbar button or click 

File  > New  > Test From Recording.

2. In the New Test From Recording  wizard, click Create a test from a new recording, select the type of 

test to create, and click Next.

3. On the Select Location  page, select the project and folder to create the test in, type a name for the 

test, select Customize automatic data correlation, and click Next.

4. Continue recording a test.

After you have recorded the test, the Data Correlation  window opens.

5. Select Do rule-based data correlation.

6. Optional: Select Do automatic data correlation  to correlate the test data using the automatic data 

correlation.

You can control automatic data correlation in the preferences. Click Window  > Preferences  > Test  > 

Test Generation. Click HTTP Test Generation, and then click the Data Correlation  tab for additional 

controls over automatic HTTP data correlation. For example, when recording an HTTP test with 

data correlation rules, you might select Automatically correlate host and port data, Automatically 

correlate URL pathname if redirected by response, and Automatically correlate Referers, and then 

clear Enable all other data correlation.

7. Click Add.

The Rules File Selection  window opens.

8. Expand the list of resources to locate the data correlation rules file to add.

9. Select the data correlation rules file to add, and then click OK.

Data correlation rules files have the .dcrules  extension by default.

The rules file is added to the list under Rules Files.

10. Optional: Click Add  to add more rules files. Use the Up  and Down  push buttons to move rules files 

in the list. The data correlation rules are applied in the order in which the files are listed.

11. Click Finish.

The recorded test data is correlated.

Generate data correlation rules in the test editor
Instead of writing rules in the rules editor, you can generate rules automatically based on data correlation 

adjustments that you make while editing tests.

To see what data correlation looks like in rule form, generate rules while you edit tests, and then examine 

the rules in the rules editor. To generate a rule set file that you can use to correlate data on multiple tests 

that run against the same application, save all manual correlations in a rule set file.

377



Test Author Guide

378

Generating rules while you edit
You can generate rules automatically as you make changes to data correlation in the test editor. With this 

feature, you can see what a typical data correlation action looks like in rule form.

Record a test.

1. Rules accumulation is enabled by default. To enable rules accumulation, right-click in the Test 

Contents  window, and then select Data Correlation  > Allow rules accumulation.

2. Adjust data correlation as you typically would in the test editor. For example, create or delete 

references, substitution sites, datasets, or variables.

To learn more about adjusting data correlation, see Guidelines for adjusting data correlation  on 

page 397.

3. Right-click in the Test Contents  window, and then select Data Correlation  > Show accumulated 

rules.

The Save Data Correlation Rule Set  wizard opens. The data correlation rules that are generated 

while you manually edited the test are displayed.

4. Clear the check boxes of any rules that you do not want to save, and then click Next.

5. Type a file name, and then click Save.

Examine the data correlation rules in the rules editor. To learn more about the types of data correlation 

rules available, see Data correlation rules  on page .

Saving manual data correlation in a rule set file
You can generate data correlation rules based on the data correlation changes made to a performance 

test. This feature analyzes the data correlation adjustments that you have made to a test and saves those 

adjustments as a data correlation rule set file. You can use the rule set file to automatically correlate the 

data for other tests that run against the same application.

Create a performance test. Adjust the data correlation so that the test runs correctly. To learn more about 

adjusting data correlation, see Guidelines for adjusting data correlation  on page 397.

1. Open a performance test for editing.

2. Adjust data correlation as you typically would in the test editor. For example, create or delete 

references, substitution sites, datasets, or variables.

3. Right-click in the Test Contents  window, and then select Data Correlation  > Save All Manual 

Correlation in Ruleset file.

unique_273
unique_273
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The test is analyzed to determine the set of data correlation rules that represents the adjustments 

that you have made to data correlation. The Save Data Correlation Rule Set  wizard opens. The data 

correlation rules are displayed.

4. Clear the check boxes of any rules that you do not want to save, and then click Next.

Typically, when saving manual data correlation, you save all the generated rules, because the 

generated rules represent the data correlation required for the test to run correctly.

5. Type a file name, and then click Save.

You can use the generated rules file to perform data correlation on other tests that run against the same 

application. To learn more about applying data correlation rules to existing tests, see Recorrelating data 

with rules  on page 375.

Viewing data correlation rule usage
To see a record of all the elements that changed when data correlation rules are applied, open the data 

correlation rules log. You can use the data correlation rules log to determine which rules worked and 

which did not.

The Data Correlation Rules Log  view opens automatically when you apply data correlation rules to a test.

1. In the Data Correlation Rules Log  view, consider the following options:

• You can apply data correlation rules when you record a test, or you can recorrelate existing 

test data. To learn more about recorrelating test data, see Recorrelating data with rules  on 

page 375.

• You can specify the logging level in the data correlation rules file, or on the Data Correlation 

and Transformation  wizard page.

• You can use the Action  log level to debug data correlation rules. If the Action  log level does 

not provide enough data for troubleshooting, use the Detail  log level.

• You can view the data correlation actions in the chronological order. Click the Chronological 

log view  icon  to view test elements that are created or removed by the data 

correlation rules.

• When you are sure that the data correlation rules that you wrote work correctly, use the 

None  or Summary  log levels to reduce memory, disk-space consumption, and unnecessary 

entries in the error log.

2. Expand the first element of the log, and navigate to the detail that you want to see. Use the icons 

in the upper-right corner of the view to navigate through the log. For example, to navigate to the 

corresponding element in the test editor, select a log entry, and then click Go to test element.
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Test data sources overview
Use the Test Data Sources  window to add or change data correlation for any supported test element.

The test generator attempts to perform automated data correlation. You can also manually correlate 

request values with other test data. The Test Data Sources  window displays the following types of test 

data that you can substitute from:

• References

• Datasets

• Custom code

• Test variables

• Built-in datasources

You can right-click references, custom code, and built-in data sources to display a menu that contains 

commonly used commands. In addition, you can use the toolbar and menu at the top of the Test Data 

Sources  window to complete common operations, such as creating a dataset or switching from tree 

view to list view. The Substitute From  push button is enabled when you select a substitution site in the 

test editor and a data source from one of the five categories in the Test Data Sources  window. Click 

Substitute From  to correlate the data source and the substitution site.
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References

The data sources that have been created in the test and the potential matches that are 

available for a selected substitution site. For example, text that is found in a response and 

used in a subsequent request is automatically created as a reference. Clear the Matching 

References Only  check box to see all the references that occur before the substitution site 

in the test. Select Include Potential Matches  to see a list of locations that might match 

the substitution site. Replace the type filter text  string with keywords to filter the list of 

references. Select a reference in the References  table to display the reference in the pane at 

the bottom of the window. Use the controls to the left of the preview pane to switch between 

inline view and tree view.

Datasets

The datasets that have been added to the test. To add a new dataset, click the Add new 

Dataset  icon ( ).

Custom Code
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The custom code that is available as data sources for this substitution site, if you have 

written Test Execution Services (TES) custom code.

Test Variables

The test variables and their types that are available as data sources for this substitution site. 

Replace the type filter text  string with keywords to filter the list of test variables.

Built-in Datasources

The dynamically calculated data sources, such as Current Date, Random Number, 

Sequential Numberand Timestamp, that are available as data sources for this substitution 

site. To create a built-in data source, right-click inside the Built-in Datasources  page, and 

select New, or click the New  push button at the top of the window.

To assign a unique value for every substitution, when creating the built-in data sources, 

select the Get New Value Each Time Used  check box.

Detaching the Test Data Sources window

The Test Data Sources  window is detachable. To detach the Test Data Sources  window, right-click the 

Test Data Sources  tab, and then select Detached. When detached, the Test Data Sources  window is 

always displayed in front of the other windows that make up the workbench.

Related information

Data correlation overview  on page361

Viewing data correlation  on page364

Data correlation rules overview  on page366

Viewing references  on page386

Creating a reference or field reference  on page389

Selecting a reference in a response  on page391

Correlating multiple fields in a test  on page394

Guidelines for adjusting data correlation  on page397

Finding data correlation errors  on page401

Disabling data correlation  on page402

Recorrelating test data  on page403
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Correlating a request value with test data
If a test runs without error but does not generate the results that you expect, you might need to correlate a 

value in a request with other test data.

You can correlate a request value with the following types of test data:

• References

• Datasets

• Custom code

• Test variables

• Built-in datasources

For example, if you recorded a test and searched on a date, you might want to substitute the built-in 

data source Current Date  so that the test will search on the playback date, not on the recorded date. For 

information on the different types of test data, see Test data sources overview  on page 380.

1. In the Test Navigator, browse to the test, and double-click it. The test opens in the test editor.

2. Locate the value that the other test data will replace.

3. Highlight the value: Press and hold the left mouse button and drag your mouse over the value.

4. In the Test Data Sources  window, click the appropriate tab: References, Datasets, Custom Code, 

Test Variables, or Built-in Datasources. To see all references, clear the Matching Only  check box.

5. In the Test Data Sources  window, select the test data to use. For references and custom code, 

you can double-click the entry in the Test Data Sources  window to find the data source in the test 

editor.

6. Click Substitute From.

The value is shown in purple text to indicate that it has been correlated and the correlation is added 

to the Test Data table, which contains the substitution sites for the page.

Substituting request content with file contents
You can substitute the content portion of a protocol request with the contents of a file. This feature 

is only supported in certain sections of a test, depending on the protocol. For example, HTTP tests 

support file content substitution only in the POST data section of a request. SOA tests support file content 

substitution for MIME and DIME attachments, XML node values and fragments, and text content. File 

content substitution works in the same manner as other substitutions. All standard test data sources 

such as test variables, datasets, and references can be used. The data from the source is treated as 
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a full path to a file. The file is opened, its contents are read, and then those contents are used in the 

substitution.

You must copy the files that contain the substitution content to the agent computers. You must record a 

test with locations for substitution from a file. For example, record an HTTP test that contains multipart 

MIME data in a POST request.

1. Create a data source that contains the full path to the file from which you want to substitute 

content.

Specify an absolute path to the file. Use path separator characters appropriate to the operating 

system of the agent computer running the test. Optionally, specify a character set to use in reading 

the file. The existence of the file is not validated. If the file cannot be opened when the test runs, a 

message is written to the test log. If you use path separator characters that are not appropriate for 

the operating system of the agent computer, the substitution cannot be completed. For example, if 

you use a path of D:\DataFiles\file1  on an agent computer running Linux™, the substitution 

cannot be completed, because Linux™  uses forward slashes as path separator characters.

2. In the test editor, navigate to the request where you want to substitute content, and then select the 

request data that you want to substitute.

3. Right-click, and then select Substitute  > Select Data Source.

4. Select the data source that contains the path to the file from which you want to substitute.

5. Right-click the substitution site, and then select File Contents Substituter.

When the test runs, the content in the protocol request is substituted with the specified file contents.

HTTP POST data is displayed in the test editor in chunks. You can create a file contents substitution 

in the POST data of an HTTP POST request by selecting the data chunk that you want to correlate, and 

then clicking Substitute. The test data source that you select is automatically treated as a file contents 

substituter. The entire data chunk is replaced with the contents of the file when the test runs, even if only 

a portion of the text in a text data chunk is selected by the substituter.

Built-in Datasources
You can use built-in data sources instead of creating custom data sources to substitute the recorded 

values. The Built-in Datasources section in the Test editor displays the data sources that have been used 

and unused. You can modify their properties from a location.

The built-in data sources are Current Date, Random Number, Sequential Number, and Timestamp. The 

values of these data sources are dynamically calculated and submitted to the test.
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Assigning random numbers to users or clients
To assign unique random numbers to all the virtual users in a test, you can create a random number data 

source in the workbench. This data source will generate unique integers or floating point numbers for 

the users or clients. You can choose to distribute the numbers of the virtual users or clients in a uniform, 

normal, or negative exponential way.

1. In the Test editor, select the root node (name of the test) and from the Test Details area, select 

Built-in Datasources.

2. Select the Random Number  data source and click Add Built-in Datasource.

3. Type a name for the data source.

4. Select how do you want to generate the numbers:

• Uniform: Click this option to generate random numbers with a uniform distribution. Specify 

the minimum and maximum values for the generated numbers.

• Normal: Click this option to generate random numbers with a normal or Gaussian 

distribution. Specify the average and the standard deviation for the generated numbers.

• Negative Exponential: Click this option to generate random numbers with an exponential 

distribution. Specify the average for the generated numbers.

5. Select how do you want to format the numbers. You can select Common  to format the numbers in 

decimal or scientific notations.

You can choose Custom  to specify a Format mask  by using the standard Java formatting syntax. 

The changes that you specify can be previewed in Formatted output.

6. To substitute the built-in data source every time with a new value for the requests, select the Get 

new value each time used  check box.

Assigning sequential numbers to users
To assign unique sequential numbers to all the virtual users in a test, you can create a sequential number 

data source in the workbench. This data source will generate unique integers or floating point numbers 

for the users.

You can use the sequential built-in data source option wherever data correlation substitutions are 

permitted, such as Transactions or Delays.

You define an initial value that should be assigned to the first virtual user and a step value that is a 

number by which the current value increments after each retrieval by a virtual user. If initial value is 1 and 

step value is 5, the workbench generates numbers in the sequence of 1, 5, 10, 15, and so on and each 

number is mapped to a virtual user. If a test is run on multiple agent machines, the workbench assigns a 

sequential value to all the users in all the agent machines.
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You can also assign a full sequence of numbers of one virtual user. The sequence number increments in 

the request for each time the request in the multi-request generator is executed.

1. In the Test Contents area of the test, click an element in the test where data correlation 

substitution is permitted, such as a transaction name or delays.

2. In the Test Element Details area, right-click the name of the element and click Substitue  > Built-in 

Datasources.

3. In Built-in Datasource Selection Wizard, click Sequential Number  and click Next.

4. Assign a name for the data source.

5. In Initial Value, type a number to be assigned to the first virtual user.

6. In Step Value, type a number.

7. In Formatting Options, you can format the number in the manner you want to use.

8. Optional:  To assign a full sequence of numbers to one virtual user, select the Execute for 

individual user  check box.

9. Optional:  To substitute the built-in data source every time with a new value for the requests, select 

the Get new value each time used  check box.

10. Click Finish.

11. Save and run the test.

After you add the test to a schedule and run the schedule, the test log displays each element name where 

the data source is applied with the unique sequential number assigned to the virtual user.

Viewing references
You can use the Test References  window to view, modify, or verify references in a test.

1. In the Test Navigator, browse to the test, and double-click the test name. The test opens.

2. Optional: To view references in only part of a test, select test elements in Test Contents  before 

continuing.

3. In the Test Contents  area, click Options.

4. Select Display References.

The Test References  window opens. All references in the test or the selected test elements are 

displayed in tabular format.

5. Do one of these tasks:
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Option Description

To view details about the references in a test

Navigate through the References  table to 

preview the references in the Preview  area. 

Click the Next  and Previous  icons to move 

the selection down or up in the list of refer

ences. Click the Show as Tree  icon to tog

gle between tree format and list format. Click 

the Show Usage  icon to view the substitution 

sites that are associated with each reference. 

Click the Bookmark  icon to bookmark a loca

tion for later review.

To verify regular expressions that 

are associated with references

Select the check box next to each reference 

to verify, and then click Verify Checked. The 

verification procedure completes this proce

dure:

a. Checks that the regular expression 

finds the correct content. Regular ex

pressions can stop working if you 

modify a test.

b. Checks that there are no references 

with duplicate names. Troubleshooting 

data correlation problems is easier if 

references have unique names.

c. Checks that there are no overlapping 

correlations.

To find more locations in the test that have 

the same value as the selected reference

Select a reference, and then click Find and 

Substitute. These locations can be reviewed 

and substituted interactively as needed.

To modify a reference Select a reference, and then click Properties.

To use the regular expression as

sistant to edit the regular expres

sion used to locate a reference

a. Select a reference, and then click 

Properties.

b. Click the Toggle regular expression 

assistant  push button on the Proper

ties  window. The regular expression 

assistant opens. The response data 
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Option Description

that is matched by the current refer

ence is automatically copied into the 

Test regular expression  window.

c. Click the Captured group  tab in the 

regular expression assistant. The reg

ular expression assistant displays the 

response content that is matched by 

the regular expression and the groups 

that are captured by the regular ex

pression. If no groups are displayed, 

edit the regular expression according

ly.

To remove a reference

Select a reference, and then click the Clear 

Reference  icon. The reference is removed 

from the test when you close the Test Refer

ences  window.

6. Click Close  to close the Test References  window and return to the test in the test editor.

When you close or save a test, you are prompted if any changes that you made to the test might 

affect the integrity of references in the test.

Related information

Data correlation overview  on page361

Viewing data correlation  on page364

Data correlation rules overview  on page366

Test data sources overview  on page380

Creating a reference or field reference  on page389

Selecting a reference in a response  on page391

Correlating multiple fields in a test  on page394

Guidelines for adjusting data correlation  on page397

Finding data correlation errors  on page401
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Disabling data correlation  on page402

Recorrelating test data  on page403

Creating a reference or field reference
When you designate a test value as a reference or designate a set of test data as a field reference, you 

can use the data elsewhere in the test.

A reference, which is typically located in response data, points to a specific value that you want to use in 

a subsequent test location, typically a request. You can substitute a request value with a reference. This 

substitution is called data correlation. You can also use a reference as input to an IF-THEN condition in a 

test or as input to custom Java™  code that your test calls.

A field reference  points to an entire block of test data. For example, an entire HTTP response can be 

designated as a field reference. You can use a field reference as input to custom Java™  code that your 

test calls.

1. In the Test Navigator, browse to the test, and double-click it. The test opens.

2. Locate the value or set of data to designate as a reference or field reference.

Different protocols support different references. For HTTP tests, you can create references and 

field references in these fields:

• A response header value, the Value column of a Response Headers table

• Response content, the Content field

For HTTP responses, you can create field references in these fields:

• The Status field

• The Reason field

3. Create the reference:

a. For response contents, highlight the value. For response header contents, click the row in 

the Response Headers table, and then click Modify.

b. Right-click, and then click Create Reference.

The value is highlighted in light blue to indicate that it is an unused reference. When you 

use it, the highlight changes to dark blue. The reference is given a name automatically. To 

see the name of the reference, right-click the value, and then select Properties. To edit the 

regular expression that is used to locate the reference, click the Toggle regular expression 

assistant  push button on the Properties  window. The regular expression assistant displays 

the response content matched by the regular expression and the groups captured by the 
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regular expression. To ensure that the details about the reference is always logged, select a 

reference and click Properties, and then click the Always log details  check box. To create a 

reference that will be used by the HTTP secondary request, you must select All occurrences. 

You can also match the reference within a given range of all the occurrences.

Note:

If an HTTP response is JSON, you can create a reference of that JSON value and use the 

JSON expression. You can select the JSON value, right-click the value, and then click Create 

Reference  to create a reference. The Regular Expression  field in the Reference  dialog box 

displays the JSON expression instead of the regular expression.

You can also verify the same from the reference Properties  dialog box after the reference is 

created. From the test editor, select and right-click the JSON value that is highlighted in dark 

blue color, and then select Properties  to open the Reference  dialog box. You can see that 

the Regular Expression  field displays the JSON expression.

Note:

A reference that is created to be used by the HTTP secondary request cannot be used by custom 

code or other data sources.

If you select the Always log details  check box, the details will be logged irrespective of the logging 

level set for a schedule. You must use this option only for debugging purpose.

You can always log the details of Substituters, Data Sources, and Requests.

4. To create a field reference, do not highlight the value. Instead, right-click the value, and then click 

Create Field Reference.

a. Field references are not automatically given names. To name a field reference, right-click the 

field reference, and then select Properties. Type a name in the Name  field, and then click OK.

The entire field is highlighted in yellow to indicate that it is a field reference.

Related information

Data correlation overview  on page361

Viewing data correlation  on page364

Data correlation rules overview  on page366

Test data sources overview  on page380

Viewing references  on page386

Selecting a reference in a response  on page391
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Correlating multiple fields in a test  on page394

Guidelines for adjusting data correlation  on page397

Finding data correlation errors  on page401

Disabling data correlation  on page402

Recorrelating test data  on page403

Selecting a reference in a response
When a response contains multiple matches for the regular expression that defines a reference, you can 

select which match is used subsequently as the data source. You can specify a particular occurrence, or 

you can specify a random occurrence.

An application under test might return responses that contain multiple matches for a regular expression 

that defines a reference. For example, a response might contain multiple links to rows of data, where each 

row represents a different user. You can control which occurrence of the regular expression is used as the 

data source in subsequent data correlation.

If you edit the Regular Expression  that is associated with a reference, and then click Verify  or OK, and the 

new regular expression still connects to the highlighted string in the preview window, then the Specific 

occurrence number  is updated automatically, overwriting any changes.

1. In the Test Navigator, browse to the test, and double-click it. The test opens.

2. Locate the response that contains the reference that you want to specify.

3. In the Content  field under Test Element Details, right-click the reference, and then select 

Properties.

4. Optional: To edit the regular expression that is used to locate the reference, click the Toggle 

regular expression assistant  push button on the Properties  window. The regular expression 

assistant displays the response content that is matched by the regular expression and the groups 

that are captured by the regular expression.

Note:

If an HTTP response is JSON, you can create a reference of that JSON value and use the JSON 

expression. You can select the JSON value, right-click the value, and then click Create Reference 

to create a reference. The Regular Expression  field in the Reference  dialog box displays the JSON 

expression instead of the regular expression.
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You can also verify the same from the reference Properties  dialog box after the reference is 

created. From the test editor, select and right-click the JSON value that is highlighted in dark blue 

color, and then select Properties  to open the Reference  dialog box. You can see that the Regular 

Expression  field displays the JSON expression.

5. On the Properties  page for the reference, select which Occurrence  to use as the data source. By 

default, the first occurrence of a match for the Regular Expression  is used as the data source.

• To specify a particular occurrence, select Specific occurrence number, and then type 

the number of the match. For example, type 4  to specify the fourth match of the regular 

expression in the response.

• To specify a random occurrence, select Random occurrence.

• To specify the last occurrence, select Last occurrence.

6. Click OK.

The occurrence that you specified is used as the data source for data correlation when you run the 

test.

Related information

Data correlation overview  on page361

Viewing data correlation  on page364

Data correlation rules overview  on page366

Test data sources overview  on page380

Viewing references  on page386

Creating a reference or field reference  on page389

Correlating multiple fields in a test  on page394

Guidelines for adjusting data correlation  on page397

Finding data correlation errors  on page401

Disabling data correlation  on page402

Recorrelating test data  on page403

Selecting a reference in a response
When a response contains multiple matches for the regular expression that defines a reference, you can 

select which match is used subsequently as the data source. You can specify a particular occurrence, or 

you can specify a random occurrence.
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An application under test might return responses that contain multiple matches for a regular expression 

that defines a reference. For example, a response might contain multiple links to rows of data, where each 

row represents a different user. You can control which occurrence of the regular expression is used as the 

data source in subsequent data correlation.

If you edit the Regular Expression  that is associated with a reference, and then click Verify  or OK, and the 

new regular expression still connects to the highlighted string in the preview window, then the Specific 

occurrence number  is updated automatically, overwriting any changes.

1. In the Test Navigator, browse to the test, and double-click it. The test opens.

2. Locate the response that contains the reference that you want to specify.

3. In the Content  field under Test Element Details, right-click the reference, and then select 

Properties.

4. Optional: To edit the regular expression that is used to locate the reference, click the Toggle 

regular expression assistant  push button on the Properties  window. The regular expression 

assistant displays the response content that is matched by the regular expression and the groups 

that are captured by the regular expression.

Note:

If an HTTP response is JSON, you can create a reference of that JSON value and use the JSON 

expression. You can select the JSON value, right-click the value, and then click Create Reference 

to create a reference. The Regular Expression  field in the Reference  dialog box displays the JSON 

expression instead of the regular expression.

You can also verify the same from the reference Properties  dialog box after the reference is 

created. From the test editor, select and right-click the JSON value that is highlighted in dark blue 

color, and then select Properties  to open the Reference  dialog box. You can see that the Regular 

Expression  field displays the JSON expression.

5. On the Properties  page for the reference, select which Occurrence  to use as the data source. By 

default, the first occurrence of a match for the Regular Expression  is used as the data source.

• To specify a particular occurrence, select Specific occurrence number, and then type 

the number of the match. For example, type 4  to specify the fourth match of the regular 

expression in the response.

• To specify a random occurrence, select Random occurrence.

• To specify the last occurrence, select Last occurrence.

6. Click OK.

The occurrence that you specified is used as the data source for data correlation when you run the 

test.
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Related information

Data correlation overview  on page361

Viewing data correlation  on page364

Data correlation rules overview  on page366

Test data sources overview  on page380

Viewing references  on page386

Creating a reference or field reference  on page389

Correlating multiple fields in a test  on page394

Guidelines for adjusting data correlation  on page397

Finding data correlation errors  on page401

Disabling data correlation  on page402

Recorrelating test data  on page403

Correlating multiple fields in a test
Some tests are structured in such a way that you must correlate data for multiple fields.For example, 

assume that you plan to dataset an item that a virtual user is buying. For the test flow to be correct, you 

must also dataset all occurrences of that item in the test. You can find and correlate all instances of 

that item in one procedure. Typically, you use Find More and Substitute  in the Show Dataset Candidates 

window to correlate data for multiple fields. See Viewing dataset candidates when you open a test  on 

page 331. Alternatively, you can use the Test Search  page to correlate data for multiple fields.

To find all instances of a field in a test and correlate some or all of the instances with a data source, such 

as a dataset:

1. In the Test Navigator, browse to the test, and double-click the test. The test opens.

2. Locate the item or the substitution site to change or create a reference for. If the item is plain text, 

select the item. If the item is an existing reference, click the highlighted area.

3. Right-click, and then click Find  > More Substitution Sites.

4. Click OK.

5. On the Test Search  page, select Case sensitive  to perform a case-sensitive search or Regular 

expression  to perform a search using regular expressions. In regular expression mode, press 

Ctrl+spacebar key in Search for text  for content assistance. Content assistance lists the regular 

expression patterns and the content that they match.
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6. Click More Options, and then select the appropriate options:

Restrict to elements highlighted in Test Contents

Search only in elements that are selected in the Test Contents  area.

Highlight found elements in Test Contents

Highlight found elements in the Test Contents  area.

Recursive

Searches the child test elements in addition to the element. For example, if you 

search an HTTP page, select this option to search the requests and responses within 

the page.

Match encoded and decoded values (protocol-specific)

When selected, searches for matches of the unencoded and URL-encoded versions 

of the specified text. For example, when searching in HTTP data, abc%123  and abc

%25123  match.

Include matches with overlapping data correlation

Include sites that are contained in, or overlap with, an existing substitution site. If you 

decide to substitute, the conflicting substitutions are automatically removed.

Include matching substituters

Click to return elements that originally matched the search string but have since been 

substituted. Clear to skip existing substitution sites when results are returned.

7. Click Close.

8. Click Search. The search results are displayed in the Search  view.

9. In the Search  view, select the matches to substitute, and then right-click the selection.

10. Optional: To select all matches, right-click the test name.

11. Click Substitute in DataSource View.

This action sends the selected matches to the Test Data Sources  window.

12. In the Test Data Sources  window, click the tab that corresponds to the type of data source to use:

Option Description

References

The data sources that have already been cre

ated in the test and the possible matches that 

are available as data sources for the select

ed substitution site. For example, text that 

is found in a response and used in a subse

quent request is automatically created as a 
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Option Description

reference. Clear the Matching References 

Only  check box to see all the references that 

occur before the substitution site in the test.

Datasets

The datasets that have been added to the 

test. To add a new dataset, click the Add new 

Dataset  icon ( ).

Custom Code

If you have written test execution services 

(TES) custom code, the custom code that is 

available as data sources for this substitution 

site.

Test Variables

The test variables and their types that are 

available as data sources for this substitution 

site.

Built-in Datasources

The dynamically calculated data sources 

(Current Date, Random Number, Sequen

tial Number, and Timestamp) that are avail

able for this substitution site. To create a 

new built-in data source, right-click inside the 

Built-in Datasources  page, and select New.

13. Select the data source, and click Substitute From.

The Substitute Multiple Items  window is displayed, showing information about the data source 

and substitutions sites that you selected.

14. For each site with a selected check box, click Substitute Checked  to substitute the data source or 

clear the check box to skip the site.

Click Always Prompt  to examine every substitution site one at a time. Click Prompt on overlapping 

data correlations  to examine a site only if the site you are substituting into is contained in, or 

overlaps with, an another substitution site. If you decide to substitute, the conflicting substitutions 

are automatically removed.

The selected instances of the field are correlated with the data from the data source.
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Related information

Data correlation overview  on page361

Viewing data correlation  on page364

Data correlation rules overview  on page366

Test data sources overview  on page380

Viewing references  on page386

Creating a reference or field reference  on page389

Selecting a reference in a response  on page391

Guidelines for adjusting data correlation  on page397

Finding data correlation errors  on page401

Disabling data correlation  on page402

Recorrelating test data  on page403

Guidelines for adjusting data correlation
When you run a test, you might notice that the server is not under the expected load or that your database 

is not being updated as expected. Incomplete or incorrect data correlation can cause these problems.

To identify data correlation problems:

1. Use the Potential Correlation Errors  view to find missing or incorrect data correlations. See Finding 

data correlation errors  on page 401 for more information.

2. Run a test individually or in a schedule with the Log Level  for errors, failures, and warnings set to 

All.

3. After the run, open the test log as explained in Viewing the test logs  on page .

The data correlation algorithms that are used during test generation are based on well known best 

practices. However, because these practices continually evolve, various types of errors can occur during 

automated data correlation:
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• Insufficient correlation:  Test values that must be correlated are not. Some possible causes follow:

◦ Two parameters that must be correlated have different names.

◦ A value must be correlated with a previous value that does not occur in the expected 

location.

◦ A parameter or value must be correlated with a previous parameter or value that does not 

occur in the test because it is a computed value.

• Superfluous correlation:  Unrelated test values are correlated.

• Incorrect correlation:  Test values that must be correlated are correlated incorrectly.

Insufficient correlation: Parameters have different names or occur in unexpected 
locations

When two parameters that must be correlated have different names, automated data correlation 

does not recognize that the two parameters are related. For example, consider this request: http://

www.example.com?id=12345. Suppose that this request must be correlated with the server response 

that contains customer_ID=12345, not ID=12345. In this case, the ID  parameter must be correlated with 

customer_ID.

Data correlation typically links a response value that was returned from the server with a subsequent 

request value. The automated correlation algorithms search in the URL and the POST data for potential 

matches; however, other schemes for returning parameters are possible. For example, consider this 

request: http://www.example.com?id=12345. Suppose that this request must be correlated with the 

server response that contains the name and entity pair href name="customer_ID" entity="12345", not 

ID=12345. In this case, the ID  parameter must be correlated with name="customer_ID"  and value 12345 

must be correlated with entity="12345".

Here are some additional causes of insufficient correlation:

• Siebel uses the star array format. Standard correlation algorithms can neither retrieve from this 

format nor substitute into this format.

• SOAP designates correlation parameters in external XML files. The correlation algorithms cannot 

correlate parameters in the external file with parameters in the test.

To manually correlate data in these cases:

1. In the test editor, use search or browse to locate the two parameters for correlation.

2. Navigate to the parameter that occurs later in the test, and select the parameter. This is the 

substitution site.

3. In the Test Data Sources  window, click the References  tab.

4. Select the data source to use as a reference, and then click Substitute From.
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Insufficient correlation: One parameter is unnamed

Sometimes a parameter or value must be correlated with a previous parameter or value that is not named 

in the test, because it is computed, for example, by a JavaScript™  program. In this case, in order to 

correctly correlate the data, you must understand how and where the parameter or value is computed, and 

then use a custom code block. See Extending test execution with custom code  on page  for more 

information about custom code.

For example, consider the web address http://www.example.com?login_stamp=12345_Apr_11_07, where 

the value for login_timestamp  is the concatenation of the login ID and the current date. In this case, you 

must generate a custom code that concatenates the login ID and the date.

For another example, suppose that the server returned the login ID and date as separate entities: 

href "customer_id=12345" Date="Apr_11_07". In this case, you can put these parameters in separate 

references and, in subsequent requests that use customer ID and date, substitute them separately.

Superfluous correlation

Automated data correlation is based on pattern matching: A parameter or parameter value is correlated 

with a subsequent parameter or parameter value with an exact or similar name. But sometimes 

parameters with exact or similar names are in fact unrelated. In the best case, unneeded correlation is 

either harmless or adds a slight load that is inappropriate. In the worst case, the application does not 

expect a correlation and fails during playback.

To remove a superfluous data correlation:

1. In the test editor, search or browse to locate the substitution site that must not be correlated. By 

default, purple letters indicate correlated data.

2. Right-click the substitution site.

3. Click Remove Substitution.

Incorrect correlation

A parameter that requires data correlation might occur many times throughout a test. For example, a 

session ID parameter that is used initially when a user logs in might also be used in every subsequent 

request. If multiple instances of a parameter in a test are not same, the correlation algorithms might use 

the wrong instance.

With the HTTP Test Generation preferences, you can optimize automatic data correlation for accuracy or 

for efficiency.
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• Accuracy: Each occurrence of a parameter is correlated with the nearest previous occurrence. This 

is the default setting.

• Efficiency: Each occurrence of a parameter is correlated with a single previous occurrence.

Note:  If you do not manually apply a correlation in the Referer field in an HTTP request header, then 

the Referer field is automatically correlated as needed. If you manually apply a correlation in the Referer 

field in an HTTP request header, then no automatic correlation is performed.

Incorrect correlations are more likely to happen when Optimize automatic data correlation for execution 

is set to Efficiency. To fix an incorrect correlation:

1. In the test editor, search or browse to locate the value that is incorrectly correlated.

2. Right-click the substitution site.

3. Click Remove Substitution.

4. Right-click the substitution site again.

5. Click Substitute, and select the correct parameter.

Generally, the HTML response content after the recording would look like <input type="username" 

name="User" id="aaa" value="John"/>. Some applications dynamically update the name attribute. 

So, when you play back the test the HTML response content would look like <input type="username" 

name="idt020" id="aaa" value="John"/>. Because the name attribute is changing dynamically, data 

correlation would not occur and the playback would fail.

Such correlations are the result of the tool using the name  attribute as the basis for correlating other 

attributes in the response code instead of the ID. To correlate the responses based on ID, select ON  in 

Window  > Preferences  > Test  > Test Generation  > HTTP Test Generation  > Data correlation types  > 

Prioritize correlation based on ID.

Related information

Data correlation overview  on page361

Viewing data correlation  on page364

Data correlation rules overview  on page366

Test data sources overview  on page380

Viewing references  on page386

Creating a reference or field reference  on page389

Selecting a reference in a response  on page391

Correlating multiple fields in a test  on page394
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Finding data correlation errors  on page401

Disabling data correlation  on page402

Recorrelating test data  on page403

Finding data correlation errors
You can use the Potential Correlation Errors  view to find missing or incorrect data correlations.

Run a test or a single-user schedule. The Potential Correlation Errors  view does not support multiple-user 

schedules. If verification points fail while you are running a test, you are prompted to open the Potential 

Correlation Errors  view when the test run is complete.

To find data correlation errors:

1. In the Test Navigator, select the result of the test run where you want to find correlation errors.

2. Right-click the result, and then select Find Data Correlation Errors. You can choose Missing 

Correlation, Incorrect Correlation, or All.

3. The Potential Correlation Errors  view opens.

After the test log is processed, the view is populated. Depending on the size of the test log, it can 

take significant time to populate the view. The potential missing or incorrect data correlations are 

displayed, in descending order of the likelihood that the correlation is incorrect. Selecting an item 

in the Potential Correlation Errors  view automatically selects the corresponding element in the test 

editor, so that you can fix the potential error.

4. Use the Compare with Test Log  toolbar button in the upper-right corner of the view to compare the 

request or response in the test with the same object in the test log.

5. For missing correlations, use the Suggest Fix  toolbar button in the upper-right corner of the view to 

search for other instances of the value in all responses in the test. If a matching value occurs in an 

earlier response in the test, create a reference in that response.

Related information

Data correlation overview  on page361

Viewing data correlation  on page364

Data correlation rules overview  on page366

Test data sources overview  on page380

Viewing references  on page386
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Creating a reference or field reference  on page389

Selecting a reference in a response  on page391

Correlating multiple fields in a test  on page394

Guidelines for adjusting data correlation  on page397

Disabling data correlation  on page402

Recorrelating test data  on page403

Disabling data correlation
You can disable a data correlation source or a substitution site. When you disable a data source, none 

of the substitution sites that use the source will be correlated when you run tests. When you disable 

a substitution site, only that specific substitution site is disabled. Other substitution sites that use the 

same reference will be correlated when you run tests. You can also disable data correlation entirely for 

subsequent tests that you record.

To disable a data correlation source or substitution site:

1. In the Test Navigator, browse to the test and double-click it. The test displays in the test editor.

2. In the Test Contents  area, click a request.

3. In the Test Element Details  area, locate the data correlation source or substitution site.

4. Right-click the data value and select Disable  from the menu.

To re-enable a disabled data source or substitution site, right-click the data value and select Enable 

from the menu.

The data correlation source or substitution site is disabled.

Note:  To disable data correlation for the entire workspace, click Window  > Preferences  >  Test 

Generation, and clear Enable automatic data correlation. Subsequent tests that you record or regenerate 

will not include data correlation.

Related information

Data correlation overview  on page361

Viewing data correlation  on page364

Data correlation rules overview  on page366

Test data sources overview  on page380
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Viewing references  on page386

Creating a reference or field reference  on page389

Selecting a reference in a response  on page391

Correlating multiple fields in a test  on page394

Guidelines for adjusting data correlation  on page397

Finding data correlation errors  on page401

Recorrelating test data  on page403

Recorrelating test data
If you disabled automatic data correlation before recording a test, you can regenerate the test with 

automatic data correlation enabled.

1. Click Window  > Preferences  > Test  > Test Generation.

The Test Generation  preferences window opens.

2. Click the Data Correlation  tab.

3. Select the types of data correlation to enable, and then click OK.

4. In the Test Navigator, browse to the test and double-click it. The test displays in the test editor.

5. Click Edit  > Re-correlate test data.

The test is regenerated with the types of automatic data correlation that you selected.

Related information

Data correlation overview  on page361

Viewing data correlation  on page364

Data correlation rules overview  on page366

Test data sources overview  on page380

Viewing references  on page386

Creating a reference or field reference  on page389

Selecting a reference in a response  on page391

Correlating multiple fields in a test  on page394

Guidelines for adjusting data correlation  on page397
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Finding data correlation errors  on page401

Disabling data correlation  on page402

Data transformation
You can transform HTTP application specific data such as JSON data, binary data and encoded data to a 

more readable format to use data correlation.

Viewing binary data
You can view binary data in tests. Use the binary editor to inspect test data, to determine if the binary data 

is of interest or should be transformed so that it can be correlated. You can also edit binary data in tests. 

To edit binary data you need to have in-depth knowledge of the data format in question. Typically, you do 

not edit binary data in tests.

Record a test that contains binary data.

1. In the Test Navigator, browse to the test, and double-click it.

The test opens.

2. Select a test element that contains binary data.

3. In the Test Element Details  area, press the Ctrl key and click in the Content  field. Alternately, type 

Ctrl+Shift+Space.

The Test Editor - Content  window opens.

4. Select the bytes to inspect, and then right-click to manipulate the selected data.

Option Description

Select

Use this page to programmatically select bi

nary data by string or by specifying the num

ber of characters to select.

Click Null terminated string from caret  to 

make a selection that starts at the current 

cursor position and ends at the next null char

acter. If you select Select NULL character al

so, the null character is included in the selec

tion.



Chapter 1. Test Author Guide

Option Description

Click characters from caret, and type a num

ber to select that number of characters start

ing from the current cursor position.

Click Selection contains number of charac

ters to select  to select the number of charac

ters specified by the current selection in the 

binary editor. For example, if you have 08  se

lected in the binary editor, this will select the 

next eight characters after the 08  byte. This 

control is not available if no data is selected 

in the binary editor.

Click Sign  to choose signed or unsigned data.

Click Endianness  to choose between big en

dian  or little endian  representation.

Edit Integer value

Use this page to edit data that you have se

lected in the binary editor. This page is avail

able only when the binary editor is not in read-

only mode.

Select Update contents from editor selection 

to update the Value  field when you change 

the selection in the Test Editor  window. Clear 

this check box to prevent the Value  field from 

being updated when you change the selection 

in the Test Editor  window.

Type the new data in the Value  field. Select 

the appropriate base, such as decimal  or 

hexadecimal, from the list.

Click negate  to negate the value of the select

ed data.

Click Size  to choose the size, in bytes, of the 

selected data.

Click Sign  to choose signed or unsigned data.
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Option Description

Click Endianness  to choose between big en

dian  or little endian  representation.

The Preview area shows how the bytes will 

change in the binary editor after you click Ap

ply  or OK.

Show Integer value

Use this page to show the integer value of se

lected binary data in different formats. This 

page is available only when the binary editor 

is in read-only mode.

Select the appropriate base, such as decimal 

or hexadecimal, from the list. The input field 

is not available.

Click Size  to choose the size, in bytes, of the 

selected data.

Click Sign  to choose signed or unsigned data.

Click Endianness  to choose between big en

dian  or little endian  representation.

Binary Padding

Use this page to insert and overwrite binary 

data.

Type the data to insert in the Pad with  field. 

Select the appropriate format, such as bytes 

or ASCII, from the list.

Click Pad selection only  to replace the bytes 

that you have selected in the binary editor. 

This control is not available if you have not 

selected any bytes in the binary editor.

Click Number of occurrences, and then type 

the number of times to repeat the binary 

padding.

Go to Offset

Use this page to move the cursor to a differ

ent position in the binary data.

Type the offset in the Enter offset  field.
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Option Description

Select Make selection with previous and new 

offset  so that the bytes between the current 

cursor position and new cursor position are 

selected when you click OK.

Click Absolute  or Relative  to choose an ab

solute offset or relative offset. An absolute 

offset starts with the first byte of data. A rel

ative offset is measured from the current cur

sor position.

Click Forward  or Backward  to choose the di

rection for relative offsets. This control is not 

available for absolute offsets.

Find/Replace

Use this page to search for binary data and to 

replace binary data, if necessary. This page is 

available only when the binary editor is not in 

read-only mode.

Type the data to search for in the Find  field. 

Select the appropriate format, such as bytes 

or ASCII, from the list.

Type the replacement data in the Replace 

field. Select the appropriate format, such as 

bytes  or ASCII, from the list.

Click Forward  or Backward  to choose the di

rection to search from the cursor position.

Click All  or Selection  to choose between 

searching all of the binary data or searching 

only the data selected in the binary editor.

Find

Use this page to search for binary data. This 

page is available only when the binary editor 

is in read-only mode.

Type the data to search for in the Find  field. 

Select the appropriate format, such as bytes 

or ASCII, from the list.
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Option Description

Click Forward  or Backward  to choose the di

rection to search from the cursor position.

Click All  or Selection  to choose between 

searching all of the binary data or searching 

only the data selected in the binary editor.

Encodings
Select from the list the encoding to use for 

displaying binary data.

Read-only

Click Read-only  to toggle between read-on

ly and writable states. If the binary data con

tains a data-correlation reference, it is read-

only and cannot be changed to writable.

Paste

This page is displayed only if you attempt to 

paste data from the clipboard into the editor 

and the data on the clipboard includes char

acters that are not valid in the current encod

ing scheme. For example, this page is dis

played if you attempt to paste accented char

acters when the encoding is set to ASCII.

Click Paste only the valid character  to paste 

only the characters that are valid in the cur

rent encoding scheme. All characters that are 

invalid in the current encoding scheme will be 

discarded.

Click Replace invalid character by 00 byte  to 

paste the string from the clipboard, replacing 

all characters that are invalid in the current 

encoding scheme with a null character.

Related information

Viewing JSON data  on page411

Viewing or transforming GWT encoded data  on page411

Transforming GraniteDS or BlazeDS data  on page412
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Transforming SAP Web DynPro XML to ASCII  on page414

Creating custom data transformations  on page414

Transforming binary data in tests
You can transform binary data in tests to view the data in a more readable format and to assist with data 

correlation. Binary data in a test might contain values that must be correlated for the test to play back 

properly.

Record a test that contains binary data.

To transform all the binary data in a test:

1. Open a test for editing.

2. Click Edit  > Re-correlate test and transform data.

3. In the Data Correlation and Transformation  window, select the Apply data transformation  check 

box.

4. From the list, select a transformation to perform:

• To convert the binary data to the equivalent ASCII representation, select the Convert To 

Ascii Text  check box. Characters that are not part of the readable ASCII character set are 

shown as escaped hexadecimal values.

• To convert the binary serialized representation of a Java™  object into XML format, select 

the Convert Java Serialized Object to XML  check box. You can also use this transformation 

to examine and perform data correlation on tests against applications that use serialized 

Java™  objects.

• To transform Adobe Flex objects into XML format, select the Convert AMF to XML  check 

box.

• To transform the Windows Communication Foundation binary code into XML, select the 

Convert Microsoft WCF-Binary to XML  check box.

All binary data in the test is transformed by using the transformation that you specified.

5. To apply built-in data correlation rules, select the Apply corresponding data correlation rules if 

transformation succeeds  check box, and then click Finish.

Note:  To remove data transformation from the test, clear the check boxes in the list of 

available transformers and generate the test.
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Transforming binary data in specific requests
You can transform binary data in requests to view the data in a more readable format.

Record a test that contains binary data.

1. Open a test for editing.

2. In the Test Contents  area, select the request that contains binary data to transform.

3. Scroll to the bottom of the Test Element Details  area, and then click the Advanced  tab.

4. In the Data Transformation  area, click Change.

The current data transformation is displayed in the Applied Transform  field in the Data 

Transformation  area.

The Select Transformation Adapter  window opens.

5. Select the data transformation to perform. To remove data transformation from the request, select 

[none].

If the application under test uses serialized Java™  objects, do not transform individual requests. 

Instead, configure the product to automatically apply the Convert Java Serialized Object to XML 

transformation to all binary data.

The binary data in the request is transformed using the specified transformation adapter.

Transforming binary data automatically
You can configure the product to automatically transform binary data in tests into more readable formats. 

Automatically transforming all binary data in a test can increase the time it takes to generate a test. The 

alternative to automatically transforming all binary data in a test is to transform data in a specific request.

1. Click Window  > Preferences.

The Preferences  window opens.

2. Click Test  > Test Generation.

3. Click Enable data transformation.

4. From the list of available transformers, select the transformations to apply to the binary data.

If you choose the Convert To Ascii Text  transformation on a test that contains readable data in a 

format other than ASCII, that data becomes unreadable. For example, text in languages that use a 

double-byte character set becomes unreadable.

5. Select Apply corresponding data correlation rules if transformation succeeds  to apply built-in 

rules for Flex applications if the Convert AMF to XML  transformation is successful.

6. Click OK.
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Viewing JSON data
You can view the JSON data in a JSON format from the test editor, and you can use this data for data 

correlation.

You must have completed the following tasks:

• Recorded an HTTP test that contains JSON data.

• Selected the JSON value as ON  from the product preferences (Windows  > Preferences  > Test  > 

Test Generation  > HTTP Test Generation  > Data Correlation Types).

When HTTP tests contain JSON data in a POST request or response, you can view the JSON data in the 

Rational®  Performance Tester  test editor. You can inspect the JSON data to determine if the data can be 

transformed to a more readable JSON format so that you can use this data for easier data correlation.

1. Open the HTTP test from the Test Navigator.

2. Expand the test in the Test Contents  area.

3. Select a POST request or a response element that contains JSON data.

You have viewed the JSON data in the Content  section.

You can inspect the JSON data for easier data correlation. You can also create a reference in the JSON 

data to use the JSON notation instead of regular expressions to locate the JSON value at run time. See 

Creating a reference or field reference  on page 389.

Related information

Viewing binary data  on page404

Viewing or transforming GWT encoded data  on page411

Transforming GraniteDS or BlazeDS data  on page412

Transforming SAP Web DynPro XML to ASCII  on page414

Creating custom data transformations  on page414

Viewing or transforming GWT encoded data
When you record an application that is developed on Google Web Toolkit(GWT), the recorded data is 

encoded. To view the encoded data, open the test editor. You can also transform the encoded data into 

XML format, which you can use for data correlation.
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• Record an application that is based on GWT. For supported GWT versions, see the Software 

Product Compatibility Reports .

• You must have access to the classes that contain the exchanged objects.

• You must add the JAR file that contains the classes that are serialized and exchanged between 

client and server to your project. To add the JAR file, in the Test Navigator  view, right-click the 

project, click Properties, and, on the Library  tab add the JAR file.

1. To view the encoded data, in the Test Navigator, browse to the test, and double-click it.

2. Select a test element or request that contains the encoded data.

The Content  field in the Test Element Details area contains the encoded data.

3. To transform the encoded data, click Edit  > Re-correlate test and transform data.

4. Confirm that the Apply data transformation  check box is selected and select Convert GWT RPC to 

XML.

5. Optional:  To use data correlation after the transformation is successful, select the Apply 

corresponding data correlation rules  check box.

6. Click Finish.

The encoded data transforms into XML format.

Related information

Viewing binary data  on page404

Viewing JSON data  on page411

Transforming GraniteDS or BlazeDS data  on page412

Transforming SAP Web DynPro XML to ASCII  on page414

Creating custom data transformations  on page414

Transforming GraniteDS or BlazeDS data
To test an application that is developed on Granite Data Services (GraniteDS) or Adobe BlazeDS 

framework, you must deserialize or transform the objects that are encoded in the AMF format to the XML 

format.

• IBM®  Rational®  Performance Tester  supports GraniteDS 2.3.2.

• For GraniteDS transformation, you must add the lt-granite.jar  and granite.jar  to the 

class path, along with any other JAR files that are required for the deserialization process.

http://www-969.ibm.com/software/reports/compatibility/clarity/index.html
http://www-969.ibm.com/software/reports/compatibility/clarity/index.html
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• For BlazeDS, you must add the JAR files that are required for the deserialization process to the 

class path. To add lt-granite.jar  or any other JAR files to the class path perform the steps as 

follows:

1. Right-click the project in the Test Navigator view, and then click Properties.

2. Click the Libraries  tab, and then click Add External JARs.

3. Browse to PathToTheProduct\IBMIMShared\plugins

\com.ibm.rational.test.lt.datatransform.adapters_VersionNumber  to 

select lt-granite.jar  or to any other folder to select other JAR files.

• You must set the JAR files and ensure that you have the following order by clicking the Order and 

Export  tab:

1. JRE.

2. Plug-in Dependencies.

3. lt-granite.jar.

4. Any Application JAR files.

5. BlazeDS JAR files if you use BlazeDS. For instance, flex-messagin-common.jar  and 

flex-messaging-core.jar.

6. granite.jar.

To transform the GraniteDS or BlazeDS data:

1. Record the test.

2. On the toolbar, click the Re-correlate test and transform data  icon.

3. Click the Convert Granite Data Service (AMF) to XML  check box and click Finish.

The AMF data is transformed to XML.

You can now correlate the data.

Related information

Viewing binary data  on page404

Viewing JSON data  on page411

Viewing or transforming GWT encoded data  on page411

Transforming SAP Web DynPro XML to ASCII  on page414

Creating custom data transformations  on page414
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Transforming SAP Web DynPro XML to ASCII
To test applications that are built using the SAP Web DynPro framework and correlate data, you must 

transform data to the ASCII format.

By default, when you generate a test that contains Web DynPro XML, IBM®  Rational®  Performance Tester 

transforms data to the ASCII format. If the data is not transformed automatically, you must manually 

select the transform option and rerun the test.

To manually select the transform option:

1. In Rational®  Performance Tester, click Window  > Preferences  > Test  > Test Generation.

2. Select the Convert SAP Web DynPro XML Encoding to Ascii  check box.

3. Click OK.

Related information

Viewing binary data  on page404

Viewing JSON data  on page411

Viewing or transforming GWT encoded data  on page411

Transforming GraniteDS or BlazeDS data  on page412

Creating custom data transformations  on page414

Creating custom data transformations
You can create your own data transformations to transform binary data in tests. Data transformations can 

convert binary data to a more readable format and can assist with data correlation.

To create a data transformation, you must be familiar with developing Java™  methods in Eclipse.

To create a data transformation:

1. Click File  > Switch Workspace  > Other, and then type a workspace name to create a new 

workspace.

The product restarts in the new workspace.

2. Extract the MyTransformProject.zip  archive file.

The MyTransformProject.zip  archive file contains the MyNewDataTransformFeature and 

MyTransformProject projects . By default, this file is installed in the C:\Program Files\IBM
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\IBMIMShared\plugins\com.ibm.rational.test.lt.sampleversion_date\install 

directory.

3. Import the MyNewDataTransformFeature and MyTransformProject projects into the new 

workspace.

See Importing existing projects  for more information about importing projects.

4. Click Window  > Open Perspective  > Resource  to open the Resource  perspective.

5. Open the MyTransformer.java  file for editing.

6. Implement the transformData and unTransformData methods to create your data transformations.

7. Optional:  If you need other .jar  files to implement your transformations, add the .jar  files to a 

user library.

a. Right-click the MyTransformProject project in the Resources  view, and then click Build Path 

> Configure Build Path.

b. Click the Libraries  tab.

c. Click Add Library.

The Add Library  window opens.

d. Select User Library, and then click Next.

e. Click User Libraries.

f. Click New, and then type a library name.

g. Click Add JARs, and the select the .jar  files to add.

The code in the .jar  files is now available to the MyTransformProject project.

8. Start another copy of the workbench to debug your transformations.

To learn more about debugging, see Local Debugging  in the Eclipse documentation.

a. Click Run  > Debug Configurations.

b. Select Eclipse Application.

c. Click the New launch configuration  icon.

d. Edit the new configuration, and then click Debug.

9. In the copy of the workbench started for debugging, record a test, and then open the test for 

editing.

10. Click Edit  > Data Transformation.

The Select Transformation Adapter  window opens. The MyTransformer transformation is listed 

along with the default transformations supplied with the product.

11. Select the MyTransformer transformation, and then click OK.
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Data correlation is removed when you apply a transformation. To correlate the test data again, click 

Edit  > Re-correlate test data.

12. Right-click MyNewDataTransformFeature, and then click Export.

13. Select Plug-in Development  > Deployable features, and then click Next.

The Deployable features  window opens.

14. Select MyNewDataTransformFeature.

15. On the Destination  page, type or click Browse  to specify a directory, and then click Finish.

The installable feature is exported to the specified directory. The exported files can be compressed 

into archives to make it easier to copy them to other computers.

Related information

Viewing binary data  on page404

Viewing JSON data  on page411

Viewing or transforming GWT encoded data  on page411

Transforming GraniteDS or BlazeDS data  on page412

Transforming SAP Web DynPro XML to ASCII  on page414

Using custom data transformations
After you have created a custom data transformation, you can apply it to binary data in tests. To use a 

custom data transformation, you must create and install the corresponding feature.

Create a custom data transformation.

To use a custom data transformation:

1. To install the feature on computer different from the computer where you created the 

transformation, click Help  > Install New Software.

2. On the Available Software  window, click Add.

The Add Repository  window opens.

3. Click Local.

4. Navigate to the installable feature, and then click OK.

5. On the Available Software  window, clear the Group items by category  check box.

MyNewDataTransformFeature is displayed in the list of available software.

6. Select MyNewDataTransformFeature, and then click Finish.
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Your custom data transformation is available when you click Edit  > Data Transformation.

Compound tests
You can create compound tests to help you organize smaller tests into scenarios that can then be run 

end-to-end. You can combine tests from different extensions to achieve end-to-end flow.

If you need to combine various tests into a single workflow or end-to-end scenario, you can organize the 

tests into a compound test. Each test may perform a part of the scenario. Each test may also run in a 

different domain, for example, different web browsers. A typical example of a compound test is an online 

buying workflow. You may have built smaller tests for each part of an online purchase transaction, such 

as "log on", "log out", "view item", "add to cart", and "check out". You can combine these tests into a single 

flow in a compound test. When the compound test is run, its individual tests are run in sequence.

The types of tests you can combine into a compound test depend on the testing capabilities you have 

purchased. You can also shell-share IBM®  Rational®  Test Workbench  family products to add multiple 

tests into a compound test.

To build the scenario you require in a compound test, you can also add the following annotations:

• Comments

• Synchronization points

• Loops

• Delays

• Transaction folders

• IF-THEN-ELSE

• Tests that are mandatory, using the Finally  blocks

• Tests to be run in random order, using the Random Selector

Creating a compound test
You can create compound tests to help you organize smaller tests into scenarios that can then be run 

end-to-end. You can combine tests from different extensions to achieve end-to-end flow.

1. Create a test workbench  project.

2. In the Web UI Test perspective, in the Test Navigator, right-click the test workbench  project and 

click New, and then click Compound Test.
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3. In the New Compound Test  dialog box, specify the name of the compound test and the location 

where it must be stored. By default, the test is stored in the workspace of the test workbench 

project you selected. You can select a different project location if desired.

The file extension testsuite  is added to the file name, and the new compound test is added 

to the Compound Tests folder of the test workbench  project, visible in the Logical View. The new 

test is also visible in the Resource View, under the test workbench  project. The contents and test 

element details are displayed in the compound test editor in the right panel.

4. In the compound test editor, add the components of the compound test.

The types of tests you can combine into a compound test depend on the testing requirements and 

on the components that you have licensed. For example, if you have the appropriate licenses, you 

can add Web UI tests, performance tests, mobile web tests, and functional tests into a compound 

test.

5. To build the scenario you require in a compound test, you can also add the following annotations 

by clicking Add  and selecting the appropriate option:

• Comments

• Synchronization points

• Loops

• Delays

• Transaction folders

• Tests that are mandatory, using the Finally  blocks

• Tests to be run in random order, using the Random Selector

6. Save your changes.

Viewing compound tests
You can view a compound test in the Compound Test Editor.

When you open a workspace, the tests and projects that reside in the workspace are listed in the Test 

Navigator.

You can view compound tests in the Logical and Resource Views in the Test Navigator. From any of these 

views, you can open the test in the Compound Test Editor.
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• In the Logical View of the Test Navigator, compound tests are listed in the Compound Tests 

folder under the project into which they were imported. Double-click the compound test under the 

Compound Tests folder to open it in the Compound Test Editor.

In the Resource View, all tests under a project are shown in the project folder. Double click the 

compound test under the project folder to open it in the Compound Test Editor.

• In the Java perspective, compound tests under a project are shown under the root project folder. 

Double click the compound test under the project folder to open it in the Compound Test Editor.

• The Compound Test Editor contains two panels - the Compound Test Elements  panel, where the 

elements of the workflow are listed. Click one of the elements, and its details are displayed int the 

far right portion of the right panel, which is the Compound Test Element Details  panel. Double-click 

any of the test or the test elements to view its details. The name of the test, test path, source type 

and execution mode are displayed.

Adding tests into a compound test
After creating a compound test, you can add the smaller test pieces that contribute to the larger workflow 

you are constructing with the compound test. When you run a compound test, each of the tests added to 

it are invoked in the sequence defined.

You can add many tests of the same type, or different types, to a compound test, depending on the testing 

requirements.

To add tests to a compound test, complete these steps:

1. In the Test Navigator, double-click the compound test to which you want to add a test. The 

contents of the compound test are shown in the Compound Test Contents  panel in the Compound 

Test editor.

2. Do one of the following:

• Click Add  to add a test as the first element in the compound test.

• To insert a test before a specific element in the compound test, select the element and click 

Insert.

The Select Tests  dialog box is opened, and the tests found in the Eclipse Client workspace are 

displayed.

3. Select the test you want to add to the Compound test, and click OK. The test is added to the 

compound test, and is displayed as part of the elements of the compound test in the Compound 

Test Contents  panel. When you click the test you added, its details are displayed in the Compound 

Test Element Details  panel in the Compound Test editor.

4. Save your changes.
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In addition to the tests that you can add to a compound test, you can also add the following elements to 

construct the workflow you need:

• Comments to document the test

• Delays in the test

• Synchronization points

• Loops

• Transaction folders

• Parts of the test that are mandatory

• Tests to be run in random order

Modifying a compound test
You can modify a compound test in the Compound Test Editor.

A compound test is a testing workflow comprising smaller tests and other test elements in a certain 

sequence. You might want to order the tests and test elements to suit your workflow requirement, or add 

further tests and elements.

1. In the Test Navigator, double-click the compound test that you want to modify. Its elements are 

shown in the Compound Test Contents  right panel in the Eclipse Client.

2. To add a test or test element at the beginning of the compound test elements list, select the 

compound test in the Compound Test Contents  panel, click Add, and then click Test. To insert a 

test or test element into the test, select the test element before which the insertion must be made, 

and click Insert.

3. Add or insert the test or test element you need, and click OK. The modified compound test displays 

its updated elements in the Compound Test Contents  right panel.

4. Save your changes.

Running compound tests
When you run a compound test, its test elements are run in the order defined in the compound test.

When you run a compound test, you are prompted to open the Test Execution perspective, in which details 

of the test run are displayed. When the test run is complete, the Test Log displays the run results.
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Prior to 9.2, text execution would terminate on a fatal exception in any of the tests in a compound test. 

Starting from 9.2, there is a new preference to allow text execution for a compound test to continue 

after a fatal exception in one of the tests. To set the preference, see Window  > Preferences  > Test  > Test 

Execution  > Error handling  > UI Fatal Error.

1. In the Test Navigator, select the compound test to run.

2. Click the Run As icon on the toolbar. The test runs. To run a launch configuration option, click the 

arrow beside the Run As icon and select Run Configuration. Select a configuration option and run 

the test.

The Confirm Perspective Switch  dialog box is opened, prompting you to switch to the Test 

Execution perspective. Click Yes.

3. Select an option to run the test.

The Test Execution perspective is opened and the test runs. On completion, the test log is 

displayed.

You can work with the test log by exporting it into a flat file.

Generating compound test result reports
When a compound test run is completed, a Test Log is shown in the Test Execution perspective. You can 

work with the information in the test log and also generate test result reports.

Exporting the Test Log
When a compound test run is completed, a Test Log is displayed in the Test Execution perspective.

The Test Log displays the following details:

• The General Information tab displays the name of the compound test and its description. The 

location of the test log file is also shown.

• The Common Properties tab shows the verdict of the test results.

• The Verdict Summary and Verdict List tabs provide a pie chart of verdicts for different components 

of the test, and a list of the first 20 verdicts. You can view details about the verdicts by clicking the 

links in the Verdict List tab.

You can export the contents of the test log to a full-text file.

421



Test Author Guide

422

1. To export the contents of the test log to a full-text file, right-click the test run result under the 

Results folder of the compound test, and click Export Test Log.

2. In the Export Test Log  dialog box, specify where the test log should be exported to, in the Location 

field.

3. Select the format in which the log must be exported, from the list in the Export Format  field. You 

can select either Flat Text - Default Encoding or Flat Text - Unicode Encoding.

4. Click Finish.

The test log is exported as a full-text file, with the test results run name, to the location you 

specified.

Generating a functional test report
You can generate a functional test report from the test run results as a HTML file.

When you generate a functional test report as a HTML file, the following details are displayed in the 

report:

• A global summary, which lists the number of tests run, verification points, defects

• A test summary which displays the name of each test, the start and end times and the verdicts.

1. Test run results are displayed under the Results folder of a project. Right-click the test run result 

you want to view and click Generate Functional Test Report.

The  Generate Functional Test Report  dialog box is opened.

2. Select the parent folder in which the report must be stored.

3. By default, the name of the compound test and the date and time stamp is displayed as the name 

of the report in the Name  field. You can change the name.

4. Click Next.

5. Select the report template to be used. If you select the Common Functional Test Report (XSL) 

format, the report is generated as a HTML file. If you select the Common Test Functional Report 

format, you can select either the HTML or PDF output format.

6. Click Finish.

The report is generated and displayed. The report is listed under the Functional Reports folder 

under the compound test in the Test Navigator.

Creating an executive summary
You can create an executive summary or test statistics report from the test run results. Executive 

summaries are generated according to the type of test.
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An executive summary displays the tests and methods that were run, and their success or failure 

information. This information is shown in summary charts as well as in bar graphs.

1. Under the Results folder of the project, right-click the test run result you want to view and click 

Create Executive Summary. 

The  Generate Functional Test Report  dialog box is opened.

2. Select the type of test report you want to generate.

3. Click Finish.

The report is generated and displayed. The report is listed under the Functional Reports folder 

under the compound test in the Test Navigator.

Adding a compound test to a Test Workbench project
You can create a compound test in a test workbench  project. If you have an existing compound test, you 

can import the test to a test workbench  project.

Creating a compound test in a test workbench  project
You can create a compound test in a test workbench  project.

1. Create a test workbench  project.

2. In the Web UI Test perspective, in the Test Navigator, right-click the test workbench  project and 

click New, and then click Compound Test.

3. In the New Compound Test  dialog box, specify the name of the compound test and the location 

where it must be stored. By default, the test is stored in the workspace of the test workbench 

project you selected. You can select a different project location if desired.

The file extension testsuite  is added to the file name, and the new compound test is added 

to the Compound Tests folder of the test workbench  project, visible in the Logical View. The new 

test is also visible in the Resource View, under the test workbench  project. The contents and test 

element details are displayed in the compound test editor in the right panel.

4. In the compound test editor, add the components of the compound test.

The types of tests you can combine into a compound test depend on the testing requirements and 

on the components that you have licensed. For example, if you have the appropriate licenses, you 

can add Web UI tests, performance tests, mobile web tests, and functional tests into a compound 

test.

5. To build the scenario you require in a compound test, you can also add the following annotations 

by clicking Add  and selecting the appropriate option:
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• Comments

• Synchronization points

• Loops

• Delays

• Transaction folders

• Tests that are mandatory, using the Finally  blocks

• Tests to be run in random order, using the Random Selector

6. Save your changes.

Importing a compound test into a Test Workbench project
You can import a compound test into a test workbench  project.

1. In the Web UI Test perspective, in the Test Navigator, right-click the test workbench  project into 

which you want to import the compound test and click Import.

2. In the Import  dialog box, expand General  in the source list, select Import test assets with 

dependencies  and then click Next.

3. Specify the directory in which the compound test resides. Click Browse.

By default, the compound test is imported into the test workbench  project folder.

4. The compound test assets in the folder you selected are displayed. Select the components you 

want to import.

5. Click Finish.

The imported compound test is displayed in the Compound Test Elements  panel in the Compound 

Test editor.

Adding compound tests to schedule
To test the performance of multiple tests, you can add all the tests to a compound test and add the 

compound test to a user group or a rate runner group. When you run a schedule, all the tests in the 

compound test are run in a sequential order.

To add a compound test:

1. In the schedule editor, add a user group or a rate runner group.

2. Select the group and in Behavior, click Use compound test.

3. Select a compound test and click OK. If there are no compound tests in the project, click Create, 

specify a name for the compound test, and click Finish. If there are test variables associated with 

a compound test and also defined in the schedule, the variables with the compound test take 

precedence while running the schedule.

4. Save the schedule.
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Related information

Schedule overview  on page

Simulating services with stubs
Service stubs enable you to simulate the behavior of an actual service for a wide variety testing or 

integration purposes.

Service stub overview
Service stubs are simulations of an actual service, which can be used to functionally replace the service in 

a test environment. A stub server replaces the actual application server.

From the point of view of the client application, the service stub looks identical to the actual service that it 

simulates. To use a service stub in replacement of the actual service, you must be able to replace the URL 

of the original service in the client application with the URL of the stub server.

Important:  For version 8.7 and later, you cannot use the schedule option of IBM®  Rational® 

Performance Tester  to deploy stub servers remotely. If you have already deployed stub servers remotely, 

you must install IBM®  Rational®  Service Tester for SOA Quality  or  Rational®  Performance Tester  on 

those computers and then deploy the stub servers locally.

Use case examples
There are several cases where it can be useful to deploy a stub services instead of using the actual 

services for your tests:

• If you are testing a local service that uses data from another remote service, you might need to 

inject specific content to the service under test from the remote service. You can simulate the 

remote service with a service stub to ensure that the local service responds properly to some 

specific input.

• Some commercial services charge users for each call. If you are testing such a service, you can 

develop and debug your test against a stub service, which is based on the WSDL of the actual 

service, without being charged by the commercial service.

• During integration of a large application involving multiple clients and services, some services 

might not yet be operational, although their WSDL specifications are available. You can simulate 

the missing services with service stubs, which will allow you to proceed with the integration work.
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Service stub architecture

You create a service stub by providing an existing WSDL specification. The service stub is generated with 

the exact same ports and bindings as the original service so that it can be addressed with exactly the 

same interface. Each operation in the service returns a default response of the type defined by the WSDL.

You can edit the service stub in the stub editor to change the default response or to create conditional 

responses that simulate the actual responses of the original service.

When you have finished editing the service stub, you can deploy it on a local stub server, which runs in the 

workbench. The stub server simulates an actual application server and can host multiple service stubs. 

You control the stub server from the stub monitor view.

Finally, to use the service stub instead of the original service, you change the URL used by the client 

application to point to the local stub server instead of the original application server. This URL, as well as 

the WSDL of the service stub, is provided in the stub monitor view.

Related information

Creating a service stub  on page426

Editing a service stub  on page427

Deploying service stubs  on page428

Recording service stub activity in a log file  on page429

Setting log level for service stubs  on page431

Creating a service stub
You can use a WSDL (Web Service Description Language) specification file to generate a service stub that 

can simulate the behavior of the original service and uses the exact same interface.

Service stubs are stored in test projects. If your workspace does not contain a test project, the test 

creation wizard creates one, enabling you to change its name. To store a service stub in a specific project, 

verify that the project exists before you create the stub.

If you are using Secure Sockets Layer (SSL) authentication, ensure that you have any required key files in 

your workspace.

The wizard can import WSDL files from the workspace, the file system, a remote repository, or from a URL. 

Ensure that the WSDL files use the correct syntax for the test environment. Service stub generation might 

not work with some Web Services Description Language (WSDL) files.
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1. In the workbench, click File  > New  > Other  > Test  > Test Assets  > Service Test  or click the New 

Service Stub   toolbar button.

2. Select the WSDL of the service that you want to simulate. If necessary, you can import the WSDL 

from the file system, a URL, or a WSRR or UDDI repository.

3. Click Next.

4. Select a project location and a name for the new service stub. Click Finish.

The wizard generates a working service stub that reproduces the interface of the original service as 

defined in the WSDL specification. Each operation is reproduced with a default response. You can edit the 

service stub with the stub editor to change the default response or to create conditional responses.

Related information

Service stub overview  on page425

Editing a service stub  on page427

Deploying service stubs  on page428

Recording service stub activity in a log file  on page429

Setting log level for service stubs  on page431

Editing a service stub
Service stubs are generated with a single default response for each operation in the WSDL specification. 

You can edit the service stub to change the default responses or to add conditional responses that can 

simulate the actual service.

To edit the behavior of a service stub:

1. In the test navigator, double-click the stub to open the stub editor.

Each operation simulated by the stub is represented by an operation element, which contains Case 

elements that describe a condition. Each case contains a response element. Case elements are 

similar to test verification points and use the same presentation.

2. To change the default response of an operation:

a. Expand the operation and the Case : Default  element, and then select the response element.

The Case : Default element describes the response of the service stub when no other case 

condition is met.

b. Edit the Message  content to specify the XML content returned by the service stub.

3. To add a conditional response case:
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a. Right-click the operation and select Add  > Equals Case, Contains Case, or Query Case.

These conditional case types are similar to the Equals, Contain  and Query  verification points 

in service tests.

• Use Equal Case  to specify a response that is returned by the stub when the entire 

incoming message content fully matches the specified message content.

• Use Contains Case  to specify a response that is returned by the service stub when a 

portion of the incoming message content matches the specified message content.

• Use Query Case  to specify a response that is returned by the service stub when an 

XPath query meets the specified criteria.

You can add as many case elements as necessary to simulate the behavior of the original 

service. Use the Up  and Down  buttons to change the order in which the case conditions are 

evaluated. Only the first matching condition is executed.

The default case cannot be removed and is always the last case element in the operation.

b. Select the response element and edit the Message  content to specify the XML content 

returned by the service stub. Use the Form, Tree, and Source  views to change the XML 

content display mode.

4. Select File  > Save  or click the Save  toolbar button.

When you have finished editing the service stub, you can deploy the stub to a stub server.

Related information

Service stub overview  on page425

Creating a service stub  on page426

Deploying service stubs  on page428

Recording service stub activity in a log file  on page429

Setting log level for service stubs  on page431

Deploying service stubs
You deploy and run service stubs on a stub server, which is a small application server dedicated to 

running service stubs. The client application, or test, addresses the stub server instead of the actual 

application of the original service.

The local stub server runs in the workbench on the local computer. Service stubs can be accessed locally. 

The local stub server is automatically stopped when you close the workbench.
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To use a service stub instead of the original service, you must be able to change the endpoint of the client 

application or service test to replace the URL of the original application with the URL of the stub server.

1. In the stub editor, click the Deploy  button.

Alternatively, you can right-click the stub in the test navigator and select Deploy On  > Local stub 

server

This opens the Stub Monitor  view.

2. In the Stub Monitor  view, click Run. 

If you make any changes to the service stub, the stub is redeployed to the stub server after saving.

3. To add more service stubs to the stub server, click Add  and select a service stub from the 

workspace.

4. Copy the URL of the service stub from the Stub Monitor  view and paste it into the configuration of 

the client application.

You can also directly access the WSDL specification of the service stub, which is a copy of the 

original WSDL with replaced URL endpoints.

You can validate that the service stub is responding correctly by using the generic service client to invoke 

a call.

Related information

Service stub overview  on page425

Creating a service stub  on page426

Editing a service stub  on page427

Recording service stub activity in a log file  on page429

Setting log level for service stubs  on page431

Recording service stub activity in a log file
With service stub logging, you can monitor the interactions between an application and the stub server. 

When the option is enabled, one log file is created for each deployed stub. The log files are presented as a 

formatted HTML report.

You must have created one or several service stubs.

To log service stub activity:
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1. Add the following virtual machine (VM) argument to the eclipse.ini  file: 

-DSTUB_LOG_LEVEL=log_level.

Use one of the following values for the log_level  variable:

• 0: Disable the log.

• 1: Log stub activity without details.

• 2: Log stub activity including content of sent and received messages.

• 3: Same as level 2 with HTTP headers of received messages.

• 4: Same as level 3 with attached files.

You can also add the following optional arguments:

• -DSTUB_LOG_KEEP_PREVIOUS=true: This option creates a separate log file each time the service 

stub is redeployed. If the value is not true  or if the option is not present, the log file is erased 

if the service stub is redeployed or when the stub server is stopped.

• -DSTUB_LOG_SERIALIZE_XML=true: This option displays the XML content (with log levels 2, 

3, and 4) without formatting or indentation. If the value is not true  or if the option is not 

present, the XML content is formatted and indented in the log.

The eclipse.ini  file is located in the same directory as the eclipse.exe  launcher binary file 

that is used to run the product.

For example, to enable logging with basic content, add the following line to the end of the 

eclipse.ini  file: -DSTUB_LOG_LEVEL=2.

2. Restart the workbench, and in the Stub Monitor  window, click the Run  icon  to restart the stub 

servers.

3. If the server was launched by a schedule in the performance testing application, then 

corresponding logs are automatically created in the workspace. If not, complete the following 

steps to retrieve the log files from the stub server:

Important:  The stub server must be running.

a. After running your tests, to view the service stub log files, open the Stub Monitor, and click 

the tab for the stub server.

b. Click the Synchronize  toolbar button for the selected server. 

An HTML log file is created and displayed for each deployed service stub.

The stub log reports are located in a folder named stubLogs, which is in the same folder as the 

corresponding service stub.
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Related information

Service stub overview  on page425

Creating a service stub  on page426

Editing a service stub  on page427

Deploying service stubs  on page428

Setting log level for service stubs  on page431

Setting log level for service stubs  on page431

Setting log level for service stubs
While recording a service test, you can set the level of the log details that you want to collect for 

debugging purposes.

You must stop the stub server.

The log level that you set in this way takes precedence over the log level setting that you specify in the 

eclipse.ini  on page 429 file.

1. In the Stub Monitor  view, in the Service Stubs section, click the Edit log options  icon .

2. Select one of the log level options and click OK.

Start the server again for the changes to take effect.

Related information

Service stub overview  on page425

Creating a service stub  on page426

Editing a service stub  on page427

Deploying service stubs  on page428

Recording service stub activity in a log file  on page429

Recording service stub activity in a log file  on page429
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Sending service requests with the generic service client
The generic service client enables you to send requests to services for which you do not have a 

convenient client and to view the responses returned by the service.

Generic service client overview
The purpose of the generic service client is to send requests to any service that uses an HTTP, JMS, 

WebSphere®  MQ, or Microsoft™ .NET transport. The generic service client also displays the response 

returned by the service.

The generic service client is useful for debugging or testing a service when you do not have access 

to a dedicated client to send the request. You can set up a large variety of transport and security 

configurations for the service, edit the parameters of the request and send attachments.

When a request is successfully invoked, its message return is added to the Request History. You can use 

this feature to look back at results that were produced at different times.

If you are using IBM®  Rational®  Performance Tester  or IBM®  Rational®  Service Tester for SOA Quality, 

you can select requests in the Request History  and click Generate Test  to generate a test that will replay 

all the selected requests. You can edit the test to replace recorded test values with variable test data, or 

add dynamic data correlation to the test. You can also set verification points on the contents of the XML 

documents in the service response.

Supported services
The generic service client enables you to send requests for many types of services that use the following 

transport protocols:

• HTTP

• Java™  Message Service (JMS), including JBoss and WebSphere®  implementations

• WebSphere®  MQ

• Microsoft™ .NET Framework Windows™  Communication Foundation (WCF).

Note:  If you are using IBM®  Security AppScan®, only the HTTP transport protocol is supported.

Encryption and security

The Java™  Runtime Environment (JRE) that the product uses must support the level of encryption 

required by the digital certificate that you select. For example, you cannot use a digital certificate 

that requires 256-bit encryption with a JRE that supports only 128-bit encryption. By default, the 
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product is configured with restricted or limited strength ciphers. To use less restricted encryption 

algorithms, you must download and apply the unlimited jurisdiction policy files (local_policy.jar  and 

US_export_policy.jar).

For Oracle Java, download the files from this site:http://www.oracle.com/technetwork/java/javase/

downloads/jce8-download-2133166.html.

Before installing these policy files, back up the existing policy files in case you want to restore the original 

files later. Then overwrite the files in /jre/lib/security/  directory with the unlimited jurisdiction 

policy files.

SSL Authentication
Service tests support simple or double SSL authentication mechanisms:

• Simple authentication (server authentication): In this case, the test client needs to determine 

whether the service can be trusted. You do not need to setup a key store. If you select the Always 

trust  option, you do not need to provide a server certificat key store.

If you want to really authenticate the service, you can configure an certificate trust store, which 

contains the certificates of trusted services. In this case, the test will expect to receive a valid 

certificate.

• Double authentication (client and server authentication): In this case, the service needs to 

authenticate the test client according to its root authority. You must provide the client certificate 

keystore that needs to be produced to authenticate the test as a certified client.

When recording a service test through a proxy, the recording proxy sits between the service and the 

client. In this case, you must configure the SSL settings of the recording proxy to authenticate itself as 

the actual service to the client (for simple authentication), and as the client to the service (for double 

authentication). This means that you must supply the recording proxy with the adequate certificates.

When using stub services, you can also configure the SSL settings of the stub service to authenticate 

itself as the actual server. This means that you must supply the service stub with the adequate certificate.

NTLM and Kerberos Authentication

The product supports Microsoft™  NT LAN Manager (NTLMv1 and NTLMv2) and Kerberos authentication. 

The authentication information is recorded as part of the test during the recording phase.

To enable NTLMv2 support, you must add a third party library to the workbench. For more information, 

see Configuring the workbench for NTLMv2 authentication  on page 439.
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Digital certificates

You can test services with digital certificates for both SSL and SOAP security protocol. Digital certificates 

must be contained in Java™  Key Store (JKS) keystore resources that are accessible in the workspace. 

When dealing with keystore files, you must set the password required to access the keys both in the 

security editor and the test editor. For SOAP security you might have to provide an explicit name for the 

key and provide a password to access the private keys in the keystore.

Limitations

Arrays are not supported.

Because of a lack of specification, attachments are not supported with the Java™  Message Service (JMS) 

transport. The envelope is directly sent using UTF-8 encoding.

All security algorithms are not always available for every Java™  Runtime Environment (JRE) 

implementation. If a particular security implementation is not available, add the required libraries to the 

class path of the JRE that this product uses.

The Microsoft™ .NET transport protocol does not support transactions, scopes, or duplex mode requests 

such as callbacks or two-way services based on the MS-MQ transport.

Related information

Creating transport protocol configurations  on page435

Sending service requests with WSDL files  on page448

Sending HTTP endpoint requests  on page451

Sending a JMS endpoint request  on page453

Sending a WebSphere MQ endpoint request  on page455

Sending OData endpoint batch requests  on page457

Sending WebSphere Java MQ endpoint requests  on page459

Testing all operations in a WSDL file  on page462

Viewing message content  on page464

Synchronizing a remote WSDL file  on page466

Synchronizing a local WSDL file with GSC  on page468

Adding static XML headers to a service request  on page468

Opening file attachments  on page470
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Creating transport protocol configurations
Read these topics to configure various transport protocols.

Related information

Generic service client overview  on page432

Sending service requests with WSDL files  on page448

Sending HTTP endpoint requests  on page451

Sending a JMS endpoint request  on page453

Sending a WebSphere MQ endpoint request  on page455

Sending OData endpoint batch requests  on page457

Sending WebSphere Java MQ endpoint requests  on page459

Testing all operations in a WSDL file  on page462

Viewing message content  on page464

Synchronizing a remote WSDL file  on page466

Synchronizing a local WSDL file with GSC  on page468

Adding static XML headers to a service request  on page468

Opening file attachments  on page470

Creating an HTTP transport configuration
You can create an HTTP transport configuration that describes the transport settings for a service 

request. Transport and security settings can be associated with any service request.

If you are using Secure Sockets Layer (SSL) authentication, ensure that you have valid key files in your 

workspace.

If you are using SOAP security, ensure that you have configured the environment with the correct libraries 

and configuration files.

1. Click the Generic service client  toolbar button to open the generic service client and click the 

Transport  tab.

This opens the Transport Configurations  page.

2. On the Transport Configurations  page, click  Create an HTTP configuration  ( ) to create a new 

HTTP transport configuration.
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3. Type a Name  for the new transport configuration.

4. Specify the following options for the HTTP transport:

HTTP/2

Note:  Testing HTTP/2 service is in the Beta mode. For more information, see 

Preparing to record a HTTP/2 service  on page 94.

To test a service that uses the HTTP/2 protocol, select the Activate  check box. This 

check box is automatically selected when you record a service by using a browser. If 

you use the Generic Service Client component to create a HTTP/2 test, you have to 

manually select the check box.

HTTP/2 client connection timeout

Specifies the time limit for the HTTP/2 client to connect to the HTTP/2 server.

Time out for the HTTP/2 session creations

Specifies the time limit to create the HTTP/2 session. This time starts after the 

connection is established.

Enable HTTP/2 Push

The Push functionality of HTTP/2 automatically identifies and passes the related 

objects or requests to the client when a request is sent to the server. Clear the check 

box to not use the functionality.

Initial session window

Specifies the buffer size on the sessions.

Initial stream window

Specifies the window size for buffer on each stream after the connection is 

established.

HTTP/2 Client Input Buffer Size

Specifies the buffer size that is used to read the network traffic.

Maximum Quantity of Messages that can be queued

Specifies the maximum number of messages that can be queued for the HTTP/2 

client on a thread.

Maximum Quantity of HTTP/2 thread pool

Specifies the maximum number of thread pools that will be used by the HTTP/2 

client to distribute the workload.
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Minimum Quantity of HTTP/2 thread pool

Specifies the minimum number of thread pools that will be used by the HTTP/2 client 

to distribute the workload.

HTTP/2 client bytebuffer pool size

Specifies the buffer size to receive the unciphered values.

Server Name Indication

Note:  Not applicable for HTTP/2.

Clear this check box if you do not want to connect to the host computer by using 

the Server Name Indication protocol. If the host computer is already configured with 

Server Name Indication protocol, you should keep this check box selected.

Use HTTP Keep Alive

Select this option to keep the HTTP connection open after the request. This option is 

not available if you are using IBM®  Rational®  AppScan®.

Use SSL

Select this option to use an SSL configuration. Click Configure SSL  to create an SSL 

configuration or select an existing configuration.

Platform Authentication

In this section, specify the type of authentication that is required to access the 

service. Select None  if no authentication is required.

Basic HTTP authentication

Select this option to specify the User Name  and Password  that are used 

for basic authentication.

NTLM authentication

Note:  Not applicable for HTTP/2.

Select this option to use the Microsoft™  NT LAN Manager (NTLM) 

authentication protocol. NTLM uses challenge-response authentication. 

This view lists what is negotiated (supported by the client and 

requested of the server) and what is authenticated (the client reply to 

the challenge from the server).

Kerberos authentication
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Note:  Not applicable for HTTP/2.

Select this option to use the Kerberos authentication protocol between 

the client and server.

Connect through proxy server

Note:  Not applicable for HTTP/2.

If the HTTP connection needs to go through a proxy server or a corporate firewall, 

specify the Address  and Port  of the proxy server. If the proxy requires authentication, 

select either Basic proxy authentication  or NTLM proxy authentication.

Proxy authentication

In this section, specify the type of authentication that is required to 

access the proxy. Select None  if no authentication is required.

Basic proxy authentication

Select this option to specify the User Name  and Password 

that are used for basic authentication.

NTLM proxy authentication

Select this option to use the Microsoft™  NT LAN 

Manager (NTLM) authentication protocol. NTLM uses 

challenge-response authentication. This view lists what is 

negotiated (supported by the client and requested of the 

server) and what is authenticated (the client reply to the 

challenge from the server).

Custom class

Note:  Not applicable for HTTP/2.

Select this option if the communication protocol requires complex, low-level 

processing with a custom Java™  code to transform incoming or outgoing messages. 

Click Browse  to select a Java™  class that uses the corresponding API. This option is 

not available in IBM®  Security AppScan®.

See Creating SSL configurations  on page 446 for more information about SSL authentication.

5. Click OK  to create the new configuration.
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Once created, you can use your new configuration with any service request that uses the HTTP transport 

protocol. You can use the Configurations  list in the generic service client to edit existing configurations or 

to create duplicate configurations.

Configuring the workbench for NTLMv2 authentication
NTLMv2 authentication requires access to a third-party library. To record and execute a test that contains 

NTLMv2 authentication, you must download the library and place it at the right location.

Before you can test SOAP-based services that use security algorithms, you must obtain and install a third-

party library file.

By default, the HTTP test generation does not enable NTLMv2 authentication, even if it was part of the 

recording. To automatically enable the correct NTLM version from the recording, set the Generated NTLM 

Version  setting to Guess from recorded data  in the HTTP Test Generation preferences.

To configure the workbench to enable NTLMv2 authentication

1. Download the jcifs-1.3.19.zip  file from https://www.jcifs.org/src/.

2. Unarchive the zip file and copy the JAR file to the installation directory: 

InstallationDirectory\plugins\com.ibm.rational.test.lt.provider_<version>

3. To automatically enable the correct NTLM version from the recording, In the workbench, click 

Window  > Preferences  > Test  > HTTP Test Generation  and set the Generated NTLM Version 

setting to Guess from recorded data.

When a test was recorded with NTLMv2, the Generated NTLM Version  setting is selected in the test 

editor, under NTLM Authentication.

Creating a JMS transport configuration
You can create an JMS transport configuration that describes the transport settings for a service request 

that uses the Java™  Message Service (JMS) protocol, including JBoss and IBM®  WebSphere®  JMS. 

Transport and security settings can be associated with any service request.

If you are using SOAP security, ensure that you have configured the environment with the correct libraries 

and configuration files.
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1. Click the Generic service client  toolbar button to open the generic service client and click the 

Transport  tab.

This opens the Transport Configurations  page.

2. On the Transport Configurations  page, click one of the following buttons:

• Create a basic JMS configuration  ( ) to create a new generic JMS transport configuration.

• Create a JBoss JMS configuration  ( ) to create a JMS configuration preconfigured for 

JBoss.

• Create a WebSphere JMS configuration  ( ) to create a JMS configuration preconfigured 

for WebSphere®  JMS.

3. Type a Name  for the new transport configuration and select whether the service is a queue  or a 

topic  destination.

4. Type the address of the JMS end point.

5. Select Use temporary object  to provide the address of the reception point to the service as 

a temporary object. If you disable this setting, you must manually specify the reception point 

address.

6. If the service requires authentication, select Basic Authentication  and type the user name and 

password to access the service.

7. If the service requires a custom Java™  Naming and Directory Interface (JNDI) adapter, you can 

provide your own Java™  class that extends the Apache Axis class. In this case, select Custom 

Adapter and specify the name of the custom Java™  class. See Extending test execution with 

custom code  on page  for more information about custom code.

8. Specify whether the message type is Text  or Binary.

9. If necessary, click Add  or Edit  to specify the Context factory properties  or Connector properties 

required to access the service.

10. Click OK  to create the new configuration.

Once created, you can use your new configuration with any service request that uses the JMS transport 

protocol. You can use the Configurations  list in the generic service client to edit existing configurations or 

to create duplicate configurations.

Creating a WebSphere®  MQ protocol configuration
When you want to send requests to a service that uses WebSphere MQ transport protocol, you can create 

a protocol configuration to describe the transport settings for a service request.

If you are using SOAP security, ensure that you have configured the environment with the correct libraries 

and configuration files.

../../com.ibm.rational.test.lt.common.doc/topics/textndteswcc.html
../../com.ibm.rational.test.lt.common.doc/topics/textndteswcc.html
../../com.ibm.rational.test.lt.common.doc/topics/textndteswcc.html
../../com.ibm.rational.test.lt.common.doc/topics/textndteswcc.html
../../com.ibm.rational.test.lt.common.doc/topics/textndteswcc.html
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By default, messages are sent in bytes. Starting from V10.1.0, you can select message type as Text 

Message. After you create the protocol configuration, you can change the message format by selecting 

the Text Message  check box in the Message Structure.

Transport and security settings can be associated with any service request. You can edit the existing 

configuration or duplicate the default configuration. You must have configured the environment with the 

correct libraries and configuration files when you use SOAP security.

1. Click the Generic service client  toolbar button, and then click the Transport  tab.

2. From the Protocol  list, right-click MQ, and then click New MQ protocol configuration.

3. Enter a name for the new transport configuration in the Name  field.

4. Enter a name for the queue manager that receives the call in the Queue Manager Name  field.

5. Enter a name for the queue managed by the queue manager in the Send Queue Name  field.

6. Select the Authentication  check box and specify the user name and password to authenticate with 

the MQ server.

Alternatively, add or update the login credentials in the Protocol Configuration  tab of a service test.

7. Select the Use Local Queue Manager  check box when the WebSphere MQ server is running on the 

local computer.

8. Perform the following steps if the MQ server is installed on a remote computer:

a. Clear the Use Local Queue Manager  check box.

b. Enter the remote WebSphere MQ server details in the following fields:

• The IP address or host name in the Address  field.

• Listener port number in the Port  field.

• Server connection mode channel name in the Client Channel  field.

9. Select the Use Temporary Queue for Response  check box if you want the server to create a 

temporary queue for receiving messages.

10. Perform the following steps to specify the queue that receives the response messages from the 

queue manager:

a. Clear the Use Temporary Queue for Response  check box.

b. Enter a name for a queue in the Receive Queue Name  field.

11. Optional:  Specify the name of the target service in the Target service  field when you are using the 

Microsoft .NET framework with SOAP over MQ.

12. Optional:  Select Use RFH2 header  when you are using SOAP over MQ. Otherwise, specify the 

Message Descriptor  and Encoding  options for the message header.

13. Optional:  Click Configure SSL  to select an existing SSL configuration or to create a new one when 

the service requires SSL authentication.

14. Click OK  to create the protocol configuration.
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You have created a configuration for the WebSphere MQ transport protocol.

• You can use the protocol configuration for the WebSphere MQ with any service request.

• You can change the message format by selecting the Text Message  check box in the Message 

Structure.

Related information

Creating SSL configurations  on page446

Creating a WebSphere®  Java MQ transport configuration
You can create a transport configuration that describes the transport settings for a service request that 

uses the IBM® WebSphere® Java MQ protocol. Transport and security settings can be associated with 

any service request.

This topic has instructions to specify the MQ server settings. If you have a single MQ server, you can 

choose to use the Default Java MQ protocol configuration  option. If, for a new request, you must point to 

another MQ server, you can use the instructions in this topic to create a new transport configuration.

1. Click Generic service client   and click the Transport  tab.

2. To create a new Java MQ transport configuration, in Configurations, select Java MQ.

3. In Create Java MQ protocol configuration, specify a name for the transport configuration.

4. Complete the following steps in the Settings  tab:

a. Host: Specify the host name or IP address of the MQ server.

b. Port: Specify the port number that is used on the MQ server.

c. Channel: Name of the MQ communication channel that is used for sending and receiving 

messages and specified on the server. This field is case-sensitive.

d. Queue Manager: Name of the MQ queue manager as specified on the server.

e. Optional:  Use credential: To access the secure server, specify the login credentials that is 

needed by the connection.

5. Optional:  If necessary, complete the following steps in the SSL  tab:

Learn more about the UI elements in the SSL tab:

• Select the Use MQ SSL  check box when the connection to the Queue manager uses SSL.

• Peer Name: Distinguished Name (DN) of the queue manager to be used by SSL. The 

Distinguished Name is available in the SSL certificate. In MQ, a DN pattern is specified by 

using the sslPeerName  variable of MQEnvironment. Connections succeed only if Peer 

Name matches the pattern that is specified.



Chapter 1. Test Author Guide

• Cipher Suites: Select one of the available cipher suites to use for encrypting the transport 

communications.

• Fips Required: This option specifies whether the requested cipher suite must use FIPS-

certified cryptography in WebSphere MQ.

• KeyResetCount: The total number of non-encrypted bytes that can be sent and received 

within an SSL conversation before the secret key is renegotiated. If left blank or set to zero 

(default), the secret key is never renegotiated. This value is ignored if no cipher suite is 

specified. Valid values are integers 0 - 999,999,999.

• SSL Configuration: Select a SSL setting for the connection or click Configure SSL  to create 

a new SSL configuration. See Creating SSL configurations  on page 446.

6. Optional:  Use the Options  tab to configure actions such as read, write, and browse on the selected 

MQ Queues. Click  to select the configuration options.

7. Optional:  Use the Advanced  tab to specify the number of queue manager connections for reading 

messages, temporary destination settings, and to associate a reply with a request.

8. To test the connection, click Test Transport  and then click OK.

You have created a new transport configuration to point to a MQ server.

You can now send the Java MQ requests to the configured server. See Sending WebSphere Java MQ 

endpoint requests  on page 459.

Creating Microsoft™ .NET transport configurations
You can manually create a Microsoft™ .NET transport configuration to describe the transport settings for 

service requests that use the Windows™  Communication Foundation (WCF) protocol.

If you are using SOAP security, ensure that the environment is configured with the correct libraries and 

configuration files.

Certificates and libraries required by the Microsoft™  client proxy must be installed on the computer, 

including Microsoft™ .NET libraries.

You must link a modified version of the Microsoft™  client proxy configuration file of the WCF service (by 

default client.exe.config) to the Microsoft™ .NET transport configuration. You must rename the file 

to soaclient.exe.config  and edit it as described in the following procedure.

Tip:  You can create a Microsoft™ .NET transport configuration automatically by importing the 

Microsoft™ .NET WSDL file. In this case, you must still manually edit the Microsoft™ .NET transport 

443



Test Author Guide

444

configuration to point to the modified soaclient.exe.config  file as described in the following 

procedure. For more information, see Sending service requests with WSDL files  on page448

The product supports testing WCF services that use the following bindings:

• BasicHttpBinding

• WsHttpBinding

• NetMsMqBinding for 1-way calls only

• WSFederationHttpBinding

• WS2007FederationHttpBinding

• NetTcpBinding

• Custom bindings that do not integrate custom extensions in the channel, serialization of the 

message, transport, and security

Note:  The following WCF services are not supported:

• Transaction and scopes

• Duplex mode requests, such as callbacks or 2-way services based on the Microsoft™  Message 

Queuing (MS-MQ) transport

Only for IBM AppScan users:  To use Generic Service Client with IBM Appscan to test a WCF 

application, add the following code to the WCF configuration file:

<system.diagnostics>     <trace autoflush="true" />    

      <sources>       <source name="System.Net"

      maxdatasize="1048576"><listeners><add

    name="System.Net"/></listeners></source>       <source

      name="System.Net.Cache"><listeners><add

      name="System.Net"/></listeners></source>       <source

      name="System.Net.Http"><listeners><add name="System.Net

      "/></listeners></source>       <source

      name="System.Net.Sockets"><listeners><add

      name="System.Net"/></listeners></source>       <source

      name="System.Net.WebSockets"><listeners><add

      name="System.Net"/></listeners></source>     </sources>    

      <sharedListeners>       <add

    name="System.Net"           

      type="IBM.ServiceModel.Soa.Extension.tools.TrafficTraceListener,

      Soa-Behavior-Library"           
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    initializeData=""        />    

    </sharedListeners>     <switches>       <add name="System.Net"

      value="All"/>       <add name="System.Net.Cache"

    value="All"/>       <add name="System.Net.Http"

    value="All"/>       <add name="System.Net.Sockets"

    value="All"/>       <add name="System.Net.WebSockets"

    value="All"/>     </switches></system.diagnostics>

IBM Appscan expects only HTTP requests in WCF. The following HTTP bindings are supported:

• BasicHttpBinding

• Custombinding above standard httpTransport

• WsHttpBinding

• WsFederationHttpBinding

• WS2007FederationHttpBinding

Also, the following patterns are supported:

• Action value ( mandatory )

• Reply Action value ( mandatory )

• Protection level

1. Create a modified soaclient.exe.config  file by completing the following steps:

a. Create a copy of client.exe.config  (or proxy_client_name.config) file from the 

Microsoft™ .NET project and rename the copy to soaclient.exe.config.

b. Edit the soaclient.exe.config  file to use the version of Microsoft™ .NET that the 

product supports, as specified on the following line:

<supportedRuntime version="v4.0" sku=".NETFramework,Version=v4.0"/>

c. Edit the soaclient.exe.config  file so that the endpoints in the configuration file point to 

the client contract of the product, as specified on the following line:

contract="IBM.ServiceModel.Soa.Extension.Stub.IStubTest"

d. Import the modified soaclient.exe.config  file into the workspace.

After you create the soaclient.exe.config  file, you can skip the following steps and import 

the WSDL file to automatically create a Microsoft™ .NET transport configuration based on the 
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information provided by the WSDL. For more information, see Sending service requests with WSDL 

files  on page 448.

2. Click the Generic service client  toolbar button ( ) to open the generic service client and click the 

Transport  tab.

3. On the Transport Configurations  page, click Create a Microsoft .NET configuration.

4. Type a name for the new transport configuration and specify the following options:

Location of soaclient.exe.config

Specify the location of the soaclient.exe.config  file. You must create this 

file manually by copying and editing the client.exe.config  file from the 

Microsoft™ .NET service.

User authentication

If the service requires authentication, select User Authentication  and type the user 

name and password to access the service.

Endpoint protection

By default, the transport configuration uses the endpoint protection level that is 

described in the soaclient.exe.config  file. Use this setting to specify a different 

Protection level:

• Signature: Select this option to digitally sign requests.

• Encryption and Signature: Select this option to digitally sign and encrypt 

requests.

Advanced properties

Use this table to list the request and response actions by order of the methods in 

the WSDL file. Click Add  to specify the name and value of request and response 

actions that are required by the service. This table is generated automatically when 

you import a Microsoft™ .NET WSDL file.

5. Click OK  to create the transport configuration.

After you create the configuration, you can use it with any service call that uses the Microsoft™ .NET 

transport protocol. You can use the Configurations  list in the generic service client to edit existing 

configurations or to create duplicate configurations.
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Creating SSL configurations
You can create a Secure Sockets Layer (SSL) configuration that describes the settings for a service 

request that uses SSL certification mechanisms. SSL configurations can be associated with any service 

request that uses the HTTP or IBM®  WebSphere®  MQ transport protocols.

If you are using SSL, ensure that you have valid certificate keystore files in your workspace.

If you are using SOAP security, ensure that you have configured the environment with the correct libraries 

and configuration files. See Configuring the environment for SOAP security  on page  for more 

information.

If you have to use different mutual SSL authentications for virtual testers in a test, you can create a 

dataset that stores all of the trust aliases names. In the test editor, in the SSL Configuration  tab, you add 

a SSL configuration and associate it with the dataset. When a schedule is run, the SSL configuration is 

applied to each virtual tester.

1. Click the Generic service client  toolbar push button to open the generic service client, and click 

the Transport  tab.

2. Either open an existing HTTP or WebSphere®  MQ transport configuration, or create a new one, and 

then click Configure SSL.

3. Click

Rename 

to rename the default SSL configuration or New  to create one.

4. Specify the following settings for the SSL configuration.

Server Authentication

This section describes how the client trusts the server.

Always trust server

Select this option if no authentication is required or to ignore server 

certificates so that all servers are trusted. If you are using single 

authentication and you want to accept trusted servers only, then disable 

this option and specify a truststore that contains the trusted server 

certificates.

Client truststore
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When you are using single authentication, the client truststore contains 

the certificates of all trusted servers. Click Browse  to specify a KS, JKS, 

or JCEKS file containing valid certificates of the trusted servers.

Password

If the client truststore file is encrypted, type the password required to 

access the file.

Mutual Authentication

This section describes how the server trusts the client in addition to server 

authentication.

Use client-side certificate

If you are using double authentication, select this option to specify a keystore 

containing the client certificate. This certificate allows the server to authenticate the 

client.

Client certificate keystore

Click Browse  to specify a KS, JKS, or JCEKS file containing a valid 

certificate that authenticates the client.

Password

If the client truststore file is encrypted, type the password required to 

access the file.

Select trust alias for Mutual Authentication

Select an alias to be used for the SSL configuration. There could be multiple aliases 

in a keystore for different security certificates. Choose an appropriate alias for a user. 

You can also use dataset to store aliases that you can apply to virtual users at run 

time.

Note:  You can copy the contents from an SSL configuration into another SSL configuration by 

using Copy  and Paste  in the SSL editor.

5. Click OK  to create the configuration, and close the SSL editor.

When the SSL configuration is created, you can use the SSL configuration with any service request that 

uses SSL certification. You can use the SSL editor to edit existing configurations.
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Sending service requests with WSDL files
You can send requests to services based on SOAP, Java Messaging Service (JMS), WebSphere®  MQ, and 

Microsoft™ .NET that use a Web Service Description Language (WSDL) file to specify the contents of the 

service request.

Ensure that you have a valid WSDL file, which is accessible either on the file system, in the workspace, 

at a specific URL, or in an IBM®  WebSphere®  Service Registry and Repository  or a Universal Description 

Discovery and Integration (UDDI) repository.

Ensure that the WSDL files use the correct syntax for the test environment. The generic service client 

might not work with some WSDL files.

If the service uses Secure Sockets Layer (SSL) authentication, create an SSL configuration before sending 

the request. For more information, see Creating SSL configurations  on page 446.

If the service uses SOAP security for encryption, signature, or other security algorithms, you must first 

configure the environment with the correct libraries and configuration files, and then create a WSDL 

security profile. For more information, see Configuring the environment for SOAP security  on page 

and Creating security profiles for WSDL files  on page 244.

To import a WSDL file from a secured site that requires mutual authentication, you must have the 

Keystore file in the workspace.

When you create a call from a WSDL file, the call is configured automatically with any SOAP, JMS, 

WebSphere®  MQ, or Microsoft™ .NET endpoints that are available in the WSDL file. Select the 

corresponding transport configuration on the Transport  page of the request.

Note:  For the specific requirements related to Microsoft™ .NET support, see Creating Microsoft .NET 

transport configurations  on page 443.

To send a service request based on a WSDL file:

1. Click the Open the Generic Service Client  toolbar button  and select the Requests  page.

2. Click Add   and select the method to add a WSDL file or click the corresponding shortcut button 

on the main page.

• Click Add WSDL from Workspace  to add a WSDL file from the local workspace.

• Click Add WSDL from File System  to add a WSDL file from the file system.

• Click Add WSDL from URL  to download and import an online WSDL from the web.
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• Click Add WSDL from WSRR  to add a WSDL from WebSphere®  Service Registry and 

Repository. Enter the URL of the WebSphere®  Service Registry and Repository  and click 

Connect. You can click Search   to browse the contents of the repository.

• Click Add WSDL from UDDI  to add a WSDL from a Universal Description Discovery and 

Integration (UDDI) repository. Enter the URL of the UDDI and click Connect. You can click 

Filter   and Search   to browse the contents of the repository.

Note:  If you are importing the WSDL file from a secured site that requires certificate 

authentication, click Import Properties  and, for Keystore, select the keystore file that contains the 

certificate to be provided to the server, and for the Keystore password, type the password.

3. Click OK.

The WSDL file is added to the Request Library.

4. In the Request Library, expand the WSDL file, binding, and operation, and then select the call 

element.

The generic service client shows three steps: Edit Data, Invoke  and View Response. The details for 

the call are displayed under the Edit Data  step.

5. On the Message  page, use the Form, Tree, or Source views to edit the contents of the request. 

Each view shows a different format of the same data. To add or remove XML elements in the Form 

or Tree view, click Schema  > Validate and Assist  to comply with an XML Schema Definition (XSD) 

specified in the schema catalog.

6. On the Transport  page, specify the transport configuration for the request.

The transport information from the WSDL file is imported automatically into the transport 

configuration.

For Microsoft™ .NET, select the corresponding transport configuration and specify the location of 

the soaclient.exe.config  file. You must create this file manually. For details, see Creating 

Microsoft .NET transport configurations  on page 443.

Note:  If you are using IBM®  Security AppScan®, only the HTTP and .Net transport protocols 

are available.

7. On the Request Stack  page, specify whether to override the security or processing algorithms that 

are applied to the outgoing request for the WSDL file.

Click Show Response Stack  to add a Response Stack  page to edit the security or processing 

algorithms for incoming responses.

Note:  These settings apply only to the current request. If you want to edit the request or 

response stack for all requests that use the current WSDL file, click Edit WSDL Security  to open the 

WSDL Security Editor.
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8. When you are ready to send the service request, click Invoke.

The generic service client sends the request and displays the message return under the View 

Response  step.

Successful requests are recorded and added to the Request History  list. If you are using IBM®  Rational® 

Performance Tester  or IBM®  Rational®  Service Tester for SOA Quality, you can create a service test by 

clicking the Generate Test Suite  button ( ).

Related information

Generic service client overview  on page432

Creating transport protocol configurations  on page435

Sending HTTP endpoint requests  on page451

Sending a JMS endpoint request  on page453

Sending a WebSphere MQ endpoint request  on page455

Sending OData endpoint batch requests  on page457

Sending WebSphere Java MQ endpoint requests  on page459

Testing all operations in a WSDL file  on page462

Viewing message content  on page464

Synchronizing a remote WSDL file  on page466

Synchronizing a local WSDL file with GSC  on page468

Adding static XML headers to a service request  on page468

Opening file attachments  on page470

Sending HTTP endpoint requests
You can send requests to services that use an HTTP endpoint.

If the service uses Secure Sockets Layer (SSL) authentication, create an SSL configuration before sending 

the request. For more information, see Creating SSL configurations  on page 446.

If the service uses SOAP security for encryption, signature, or other security algorithms, you must first 

configure the environment with the correct libraries and configuration files, and then create a security 

profile for the WSDL file. For more information, see Configuring the environment for SOAP security  on 

page  and Creating security profiles for WSDL files  on page244
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To send a request to an HTTP service:

1. Click the Open the Generic Service Client  toolbar button  and select the Requests  page.

2. Click the Add  icon  and click a type of request that you want to send or in Request Library, right-

click EndPoints  and select a type of request that you want to send.

3. In the Configure Protocol  window, select HTTP  and specify the HTTP transport configuration.

If necessary, click New  to create an HTTP transport configuration for the call.

To send the HTTP/2 requests, in the Create HTTP Protocol configuration  window, click the 

Activate  check box. Before capturing the HTTP/2 traffic, configure the computer. See Preparing to 

record a test for the HTTP/2 service  on page 94 for instructions.

4. Type the URL of the call, the HTTP method and version, and specify any header or cookie 

properties.

Click the Rest mode  check box to split the URL into resource and parameters.

5. Click Next.

6. On the Select Root Element  page, if the service uses a specific XML Schema Definition (XSD), 

select one from the list or click Browse  to import the XSD file, and then, select the root element for 

the request.

If no XSD is available for the service, select No Schema.

7. Click Finish.

The request is added to the Endpoints  section of the Request Library.

8. In the Request Library, select the request element.

The generic service client shows three steps: Edit Request, Invoke, and View Response. The 

details for the request are displayed under the Edit Request  step.

9. Based on the request selected in Step 2, on the Message  page, use the Form, Tree, or Source  views 

to edit the contents of the request.

Each view shows a different format of the same data. To add or remove XML elements in the Form 

or Tree  view, click Schema  > Validate and Assist  to comply with an XSD specified in the schema 

catalog.

10. On the Attachments  page, specify any file attachments to send with the request.

To add an attachment, click Add  and follow the wizard to attach a file with the request.

11. On the Transport  page, if necessary, change the transport configuration to be used by the request.

To create and edit transport and security configurations, use the Transport  tab.

12. If you selected SOAP XML request in step 2, on the Request Stack  page, specify whether you want 

to override the security or processing algorithms that are applied to the outgoing request for the 

WSDL file.

To add a Response Stack  page to edit the security or processing algorithms for incoming 

responses, click Show Response Stack.
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Note:  These settings apply only to the current request. To edit the request or response stack 

for all requests that use the current WSDL file, click Edit WSDL Security  to open the WSDL Security 

Editor.

13. When you are ready, click Invoke  to send the service request.

The generic service client sends the request and displays the message return under the View 

Response  step.

Successful requests are recorded and added to the Request History  list. If you are using IBM®  Rational® 

Performance Tester  or IBM®  Rational®  Service Tester for SOA Quality, you can create a service test by 

clicking the Generate Test Suite  button ( ).

Related information

Generic service client overview  on page432

Creating transport protocol configurations  on page435

Sending service requests with WSDL files  on page448

Sending a JMS endpoint request  on page453

Sending a WebSphere MQ endpoint request  on page455

Sending OData endpoint batch requests  on page457

Sending WebSphere Java MQ endpoint requests  on page459

Testing all operations in a WSDL file  on page462

Viewing message content  on page464

Synchronizing a remote WSDL file  on page466

Synchronizing a local WSDL file with GSC  on page468

Adding static XML headers to a service request  on page468

Opening file attachments  on page470

Sending a JMS endpoint request
You can send requests to services that use a Java™  Messaging Service (JMS) endpoint.

If the service uses Secure Sockets Layer (SSL) authentication, create an SSL configuration before sending 

the request. For more information, see Creating SSL configurations  on page 446.
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To send a request to a JMS service:

1. Click the Open the Generic Service Client  toolbar button ( ) and select the Requests  page.

2. Click Add  ( ) and click a type of request that you want to send or in Request Library, right-click 

EndPoints  and select a type of request that you want to send.

3. In the Configure Protocol  window, select JMS  and specify the JMS transport configuration.

If necessary, click New to create an JMS transport configuration for the call.

4. Click Add  to specify any properties that are to be sent with the call.

5. Click Next.

6. On the Select Root Element  page, if the service uses a specific XML Schema Definition (XSD), 

select one from the list or click Browse  to import the XSD file, and then, select the root element for 

the call.

If no XSD is available for the service, select No Schema.

7. Click Finish.

The request is added to the Endpoints  section of the Request Library.

8. In the Request Library, select the request element.

The generic service client shows three steps: Edit Request, Invoke, and View Response. The 

details for the request are displayed under the Edit Request  step.

9. Based on the request selected in Step 2, on the Message  page, use the Form, Tree, or Source  views 

to edit the contents of the request.

Each view shows a different format of the same data. To add or remove XML elements in the Form 

or Tree  view, click Schema  > Validate and Assist  to comply with an XSD specified in the schema 

catalog.

10. On the Transport  page, if necessary, change the transport configuration to be used by the request.

To create and edit transport and security configurations, use the Transport  tab.

11. If you selected SOAP XML request in step 2, on the Request Stack  page, specify whether you want 

to override the security or processing algorithms that are applied to the outgoing request for the 

WSDL file.

To add a Response Stack  page to edit the security or processing algorithms for incoming 

responses, click Show Response Stack.

Note:  These settings apply only to the current request. To edit the request or response stack 

for all requests that use the current WSDL file, click Edit WSDL Security  to open the WSDL Security 

Editor.

12. When you are ready, click Invoke  to send the service request.

The generic service client sends the request and displays the message return under the View 

Response  step.
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Successful requests are recorded and added to the Request History  list. If you are using IBM®  Rational® 

Performance Tester  or IBM®  Rational®  Service Tester for SOA Quality, you can create a service test by 

clicking the Generate Test Suite  button ( ).

Related information

Generic service client overview  on page432

Creating transport protocol configurations  on page435

Sending service requests with WSDL files  on page448

Sending HTTP endpoint requests  on page451

Sending a WebSphere MQ endpoint request  on page455

Sending OData endpoint batch requests  on page457

Sending WebSphere Java MQ endpoint requests  on page459

Testing all operations in a WSDL file  on page462

Viewing message content  on page464

Synchronizing a remote WSDL file  on page466

Synchronizing a local WSDL file with GSC  on page468

Adding static XML headers to a service request  on page468

Opening file attachments  on page470

Sending a WebSphere®  MQ endpoint request
You can invoke calls to services that use a WebSphere®  MQ endpoint.

If the service uses Secure Sockets Layer (SSL) authentication, create an SSL configuration before sending 

the request. For more information, see Creating SSL configurations  on page 446.

If the service uses SOAP security for encryption, signature, or other security algorithms, you must first 

configure the environment with the correct libraries and configuration files, and then create a security 

profile for the WSDL file. For more information, see Configuring the environment for SOAP security  on 

page  and Creating security profiles for WSDL files  on page 244.

To send a request to an WebSphere®  MQ service:
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1. Click the Open the Generic Service Client  toolbar button ( ) and select the Requests  page.

2. Click Add  ( ) and click a type of request that you want to send or in Request Library, right-click 

EndPoints  and select a type of request that you want to send

3. In the Configure Protocol  window, select WebSphere MQ  and specify the WebSphere®  MQ 

transport configuration.

If necessary, click New  to create an WebSphere®  MQ transport configuration for the call. For 

more information about creating a new WebSphere MQ transport configuration, see Creating a 

WebSphere MQ transport configuration  on page 440.

4. Specify the SOAP action.

If the service requires that you override the header specified in the WebSphere®  MQ transport 

configuration, select Override MQ protocol configuration values  and specify the correct details.

5. Click Next.

6. On the Select Root Element  page, if the service uses a specific XML Schema Definition (XSD), 

select one from the list or click Browse  to import the XSD file, and then, select the root element for 

the request.

If no XSD is available for the service, select No Schema.

7. Click Finish.

The request is added to the Endpoints  section of the Request Library.

8. In the Request Library, select the request element.

The generic service client shows three steps: Edit Request, Invoke, and View Response. The 

details for the request are displayed under the Edit Request  step.

9. Based on the request selected in Step 2, on the Message  page, use the Form, Tree, or Source  views 

to edit the contents of the request.

Each view shows a different format of the same data. To add or remove XML elements in the Form 

or Tree  view, click Schema  > Validate and Assist  to comply with an XSD specified in the schema 

catalog.

10. On the Transport  page, if necessary, change the transport configuration to be used by the request.

To create and edit transport and security configurations, use the Transport  tab.

11. If you selected SOAP XML request in step 2, on the Request Stack  page, specify whether you want 

to override the security or processing algorithms that are applied to the outgoing request for the 

WSDL file.

To add a Response Stack  page to edit the security or processing algorithms for incoming 

responses, click Show Response Stack.

Note:  These settings apply only to the current request. To edit the request or response stack 

for all requests that use the current WSDL file, click Edit WSDL Security  to open the WSDL Security 

Editor.
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12. When you are ready, click Invoke  to send the service request.

The generic service client sends the request and displays the message return under the View 

Response  step.

Successful requests are recorded and added to the Request History  list. If you are using IBM®  Rational® 

Performance Tester  or IBM®  Rational®  Service Tester for SOA Quality, you can create a service test by 

clicking the Generate Test Suite  button ( ).

Related information

Generic service client overview  on page432

Creating transport protocol configurations  on page435

Sending service requests with WSDL files  on page448

Sending HTTP endpoint requests  on page451

Sending a JMS endpoint request  on page453

Sending OData endpoint batch requests  on page457

Sending WebSphere Java MQ endpoint requests  on page459

Testing all operations in a WSDL file  on page462

Viewing message content  on page464

Synchronizing a remote WSDL file  on page466

Synchronizing a local WSDL file with GSC  on page468

Adding static XML headers to a service request  on page468

Opening file attachments  on page470

Sending OData endpoint batch requests
To test services that use OData protocol, you can send requests in a batch. The request contains HTTP 

operations such as GET, POST, and PUT to manage data in the service.

You must have sent individual requests through Generic Service Client (GSC).

When you send requests in a batch, you can group a set of operations into one HTTP request. You can 

start a batch request from GSC or from a service test. To initiate a batch request from a service test in the 

Test editor, select multiple requests to include in a batch, right-click and select $batch odata requests.

To initiate a batch request from GSC, complete the following steps:
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1. Click the Open the Generic Service Client  toolbar button  and select the Requests  page.

2. Click the Add  icon  and click a type of request that you want to send or in Request Library, right-

click EndPoints  and select Send a Batch Request.

3. In the ODATA batch information  page, select the OData version that your application supports.

4. To set HTTP headers, ensure that the Set ODATA batch request http headers  radio button is 

selected.

If needed, you can change the headers on the next page of the wizard.

5. To group appropriate requests into change sets, select the ODATA batch with changesets  radio 

button.

6. In Selection of calls to batch, select the requests to include in the batch.

If you initiated the batch request from the service test, the requests are already selected.

7. Click Next.

8. In the Configure Protocol  window, select HTTP  and specify the HTTP transport configuration.

If necessary, click New  to create an HTTP transport configuration for the call.

To send the HTTP/2 requests, in the Create HTTP Protocol configuration  window, click the 

Activate  check box. Before capturing the HTTP/2 traffic, configure the computer. See Preparing to 

record a test for the HTTP/2 service  on page 94 for instructions.

9. Click Finish.

The request is added to the Endpoints  section of the Request Library.

10. In the Request Library, select the request element.

The generic service client shows three steps: Edit Request, Invoke, and View Response. The 

details for the request are displayed under the Edit Request  step.

11. On the Transport  page, if necessary, change the transport configuration to be used by the request.

To create and edit transport and security configurations, use the Transport  tab.

12. When you are ready, click Invoke  to send the service request.

The generic service client sends the request and displays the message return under the View 

Response  step.

Related information

Generic service client overview  on page432

Creating transport protocol configurations  on page435

Sending service requests with WSDL files  on page448

Sending HTTP endpoint requests  on page451

Sending a JMS endpoint request  on page453

Sending a WebSphere MQ endpoint request  on page455
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Sending WebSphere Java MQ endpoint requests  on page459

Testing all operations in a WSDL file  on page462

Viewing message content  on page464

Synchronizing a remote WSDL file  on page466

Synchronizing a local WSDL file with GSC  on page468

Adding static XML headers to a service request  on page468

Opening file attachments  on page470

Sending WebSphere Java MQ endpoint requests
You can send requests to services that use a WebSphere Java MQ endpoint.

If the service uses Secure Sockets Layer (SSL) authentication, create an SSL configuration before sending 

the request. For more information, see Creating SSL configurations  on page 446.

To send a request to a Java MQ service:

1. Click Open the Generic Service Client  ( ) and select the Requests  page.

2. Click Add  ( ) or in Request Library, right-click EndPoints  and select a type of request to send.

3. In the Configure Protocol window, select WebSphere Java MQ  and specify the transport 

configuration. If necessary, create the transport configuration for the call by clicking New  (see 

Creating a WebSphere Java MQ transport configuration  on page 442).

4. Complete the following information in the General  tab:

Learn more about the UI elements in the General tab:

Queue

Name of the queue as defined on the WebSphere MQ server.

Message type

The types of messages are these:

• Datagram  means that the message does not require a reply.

• Request  means that the message requires a reply.

• Reply  means that the message is a reply to an earlier request message.

• Report  means that the message is reporting on some expected or unexpected 

occurrence, usually related to some other message. An example is a request 

message that contained data that was not valid.

459



Test Author Guide

460

Message Persistence

This value indicates whether the message is persistent or not. If the message is 

persistent, it survives the system failures and restarts of the queue manager. If the 

message is not persistent, it survives a restart if it is present on a queue having the 

NPMCLASS(HIGH) attribute. However, even with the NPMCLASS(HIGH) attribute a 

message does not survive a QMGR class. Nonpersistent messages on queues having 

the NPMCLASS(NORMAL) attribute are discarded at queue manager restart, even if 

the message is found on the auxiliary storage during the restart procedure.

Dynamic Reply

Select this check box for the WebSphere MQ server to dynamically create a 

temporary queue as a reply. If this check box is not selected, the message in Reply 

Queue is used.

Reply Queue

This is the name of the message queue to which the application that issued the get 

request for the message should send the reply and report messages.

Reply Manager

This is the name of the queue manager on which the reply-to queue is defined.

Additional properties

Specify the additional properties for the queues.

5. Optional:  If necessary, complete the following information on the Config  tab:

Learn more about the UI elements in the Config tab:

Message Priority

This is the priority of the message. The lowest priority is 0.

Encoding

This is the numeric encoding of numeric data in the message. This value does not 

apply to numeric data in the MQMD structure itself.

Expiry Interval

This is the period of time, in tenths of a second, after which the message becomes 

eligible to be discarded if it has not already been removed from the target queue. The 

expiry interval is set by the application that put the message.

Character set
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This is the character set identifier of the character data in the application message 

data.

6. Optional:  In the Report  tab, select the report messages to receive.

7. Optional:  If necessary, complete the following information in the Context  tab:

Learn more about the UI elements in the Context tab:

Application Identity Data

This information is defined by the application suite. Use it to provide information 

about the message or its originator.

Application Origin Data

This information is defined by the application suite. Use it to provide additional 

information about the origin of the message.

Accounting Token

This information is needed by the application to appropriately charge for the work 

that is done as a result of the message.

User ID

This is the user identifier of the application that originated the message.

8. Optional:  In the Identifiers  tab, for the messages that require binary input, specify the ID in the 

string format in the second column. The first column is filled automatically in the hexadecimal 

format.

9. Optional:  In the Segmentation  tab, select the segment of the message and click Next.

10. This step is not applicable for a Text request. On the Select Root Element page, if the service 

uses a specific XML Schema Definition (XSD), select one from the list. If the XSD element is not 

listed, click Browse  to import the XSD file, and select the root element for the request. If no XSD is 

available for the service, select No Schema.

11. Click Finish. The request is added to the Endpoints  section of the Request Library.

12. In the Request Library, select the request element.

The generic service client shows three steps: Edit Request, Invoke, and View Response. The 

details for the request are displayed under the Edit Request  step.

13. Based on the request selected in Step 2, on the Message  page, use the Form, Tree, or Source  views 

to edit the contents of the request.

Each view shows a different format of the same data. To add or remove XML elements in the Form 

or Tree  view, click Schema  > Validate and Assist  to comply with an XSD specified in the schema 

catalog.

14. On the Transport  page, if necessary, change the transport configuration to be used by the request.
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To create and edit transport and security configurations, use the Transport  tab.

15. If you selected SOAP XML request in step 2, on the Request Stack  page, specify whether you want 

to override the security or processing algorithms that are applied to the outgoing request for the 

WSDL file.

To add a Response Stack  page to edit the security or processing algorithms for incoming 

responses, click Show Response Stack.

Note:  These settings apply only to the current request. To edit the request or response stack 

for all requests that use the current WSDL file, click Edit WSDL Security  to open the WSDL Security 

Editor.

16. When you are ready, click Invoke  to send the service request.

The generic service client sends the request and displays the message return under the View 

Response  step.

Successful requests are recorded and added to the Request History  list. If you are using IBM®  Rational® 

Performance Tester  or IBM®  Rational®  Service Tester for SOA Quality, you can create a service test by 

clicking the Generate Test Suite  button ( ).

Related information

Generic service client overview  on page432

Creating transport protocol configurations  on page435

Sending service requests with WSDL files  on page448

Sending HTTP endpoint requests  on page451

Sending a JMS endpoint request  on page453

Sending a WebSphere MQ endpoint request  on page455

Sending OData endpoint batch requests  on page457

Testing all operations in a WSDL file  on page462

Viewing message content  on page464

Synchronizing a remote WSDL file  on page466

Synchronizing a local WSDL file with GSC  on page468

Adding static XML headers to a service request  on page468

Opening file attachments  on page470



Chapter 1. Test Author Guide

Testing all operations in a WSDL file
You can use the generic service client to rapidly send requests to a service using all the operations in a 

Web Services Description Language (WSDL) file. The calls are generated with default values based on the 

type of data.

Ensure that you have a valid WSDL file. Ensure that the WSDL files use the correct syntax for the test 

environment. The generic service client might not work with some Web Services Description Language 

(WSDL) files.

If the service uses Secure Sockets Layer (SSL) authentication, create an SSL configuration before invoking 

the call. See Creating SSL configurations  on page 446 for details.

If the service uses SOAP security for encryption, signature, or other security algorithms, you must first 

configure the environment with the correct libraries and configuration files, and then create a security 

profile for the WSDL. See Configuring the environment for SOAP security  on page  and Creating 

security profiles for WSDL files  on page 244 for details.

Calls will be generated for each operation in the WSDL file using the default values for each type. For 

example, strings will use the default value str. You can change the default values in the XML Default 

Values  preferences.

1. Open the generic service client and click the Requests  tab, and then, click  Add a WSDL file.

2. In the Add WSDL Files window, select an existing WSDL or import a WSDL with one of the following 

methods:

• Click Import from File  to import a WSDL file from the file system.

• Click Import from URL  to download and import an online WSDL from the web.

• Click Import from WSRR  to import a WSDL from an IBM®  WebSphere®  Service Registry and 

Repository (WSRR). Enter the URL of the WSRR and click Connect. You can click  Search 

to browse the contents of the repository.

• Click Import from UDDI  to import a WSDL from a Universal Description Discovery and 

Integration (UDDI) repository. Enter the URL of the UDDI and click Connect. You can click 

Filter  and  Search  to browse the contents of the repository.

3. Click OK.

The WSDL is added to the Call Library.

4. In the Call Library, right-click the WSDL and select Test WSDL Methods.

The call is automatically configured with any SOAP or JMS endpoints that are available in the 

WSDL.
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Successful calls are recorded and added to the Request History  list. If you are using IBM®  Rational® 

Performance Tester  or IBM®  Rational®  Service Tester for SOA Quality, you can click the Generate Test 

Suite  ( ) button to create a service test.

Related reference

Auto values preferences  on page

Related information

Generic service client overview  on page432

Creating transport protocol configurations  on page435

Sending service requests with WSDL files  on page448

Sending HTTP endpoint requests  on page451

Sending a JMS endpoint request  on page453

Sending a WebSphere MQ endpoint request  on page455

Sending OData endpoint batch requests  on page457

Sending WebSphere Java MQ endpoint requests  on page459

Viewing message content  on page464

Synchronizing a remote WSDL file  on page466

Synchronizing a local WSDL file with GSC  on page468

Adding static XML headers to a service request  on page468

Opening file attachments  on page470

Viewing message content
The Raw Transaction Data  view displays the raw XML, text, or binary content of any service request or 

response that is selected in the generic service client.

The Raw Transaction Data  view displays plain text, XML, or binary data, depending on the type of the 

message content.

To view text, XML, or binary message content:
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1. In the generic service client, click the View  menu, and select Raw Transaction Data.

If you are using IBM®  Rational®  Performance Tester  or IBM®  Rational®  Service Tester for SOA 

Quality, click Window  > Show View  > Other  > Generic Service Client  > Raw Transaction Data

2. Select a service request or response.

If you are using Rational®  Performance Tester  or Rational®  Service Tester for SOA Quality, this 

view is also linked to the selected request or response in service tests, service stubs, or in the test 

log.

3. Depending on the nature of the message content, the following actions are available:

Text mode

When a plain text element is displayed, you can select and copy text. Click Colorize 

Text  to enable or disable text colorization for HTML.

XML mode

When an XML element is displayed, you can select and copy text. Click Colorize Text 

to enable or disable text colorization for XML. Click Enable XML Pretty Serialization 

to improve readability by adding line breaks and indentation to the XML content.

If the XML content is modified by a request or response stack or by the WSDL 

security editor, the Stack Contents  pane displays the list of steps in the stack. You 

can select each step to view the changes to the XML content. You can also select 

one or two steps and click Compare Steps  to open a comparison window.

Binary mode

When a binary element is displayed, you can switch between Binary  and Raw-ASCII 

views. Right-click the binary view to perform the following actions:

• Select: Opens the Select  window, where you can select binary data by string 

or by specifying the number of characters to select. When a portion of binary 

data is selected, you can copy it to the clipboard.

• Go to Offset: Opens the Go to Offset  window, where you can move to bytes at 

a particular offset.

• Find: Opens the Find  window, where you can search for and replace binary 

data in a number of formats.

• Encodings: Select the encoding to use for displaying binary data in the text 

column.
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Related information

Generic service client overview  on page432

Creating transport protocol configurations  on page435

Sending service requests with WSDL files  on page448

Sending HTTP endpoint requests  on page451

Sending a JMS endpoint request  on page453

Sending a WebSphere MQ endpoint request  on page455

Sending OData endpoint batch requests  on page457

Sending WebSphere Java MQ endpoint requests  on page459

Testing all operations in a WSDL file  on page462

Synchronizing a remote WSDL file  on page466

Synchronizing a local WSDL file with GSC  on page468

Adding static XML headers to a service request  on page468

Opening file attachments  on page470

Synchronizing a remote WSDL file
For web services that make their Web Services Description Language (WSDL) file available from a URL, 

you might have to ensure that the WSDL that you work with is always up to date. By synchronizing the 

WSDL, you ensure that the local copy of the WSDL in your workspace is regularly synchronized with the 

remote WSDL.

Ensure that you have a valid WSDL file. Ensure that the WSDLs use the correct syntax for the test 

environment. The product might not work with some WSDL files.

WSDL synchronization only works with remote WSDLs that are imported from a URL.

The WSDL synchronization runs either when the workbench is started or after a specified period. If the 

remote WSDL changes, the local copy of the WSDL is updated. Depending on the changes, a merge is 

performed and any service requests that use the WSDL are updated. If the changes to the WSDL cannot 

be automatically applied to the service requests, for example if an operation is removed or renamed or if 

the XML structure of the service request is changed, the test is marked with a error.

To import a synchronized remote WSDL:
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1. Open the generic service client, click the Requests  tab, and then, click  Add a WSDL file  .

2. In the Add WSDL Files  window, click Import from URL  to download and import a remote WSDL 

from the web.

3. On the Import WSDL from URL  page, type the URL of the remote WSDL.

If you are connecting through a proxy or a corporate firewall, click Proxy properties  to specify your 

network settings.

4. In the Synchronization policy  area, specify whether and when to synchronize WSDLs:

• Select Never  if you do not want the remote WSDL to be updated.

• Select On session launch  to synchronize the WSDL each time you start the workbench.

• Select Every  to specify a synchronization period in days.

5. Click OK.

The WSDL is added to the Call Library.

After the WSDL is imported, you can change the synchronization settings by right-clicking the WSDL in the 

generic service client Call Library  or in the test navigator. Then select WSDL Synchronization. The WSDL 

Synchronization  window also displays the date of the latest synchronization.

Related information

Generic service client overview  on page432

Creating transport protocol configurations  on page435

Sending service requests with WSDL files  on page448

Sending HTTP endpoint requests  on page451

Sending a JMS endpoint request  on page453

Sending a WebSphere MQ endpoint request  on page455

Sending OData endpoint batch requests  on page457

Sending WebSphere Java MQ endpoint requests  on page459

Testing all operations in a WSDL file  on page462

Viewing message content  on page464

Synchronizing a local WSDL file with GSC  on page468

Adding static XML headers to a service request  on page468

Opening file attachments  on page470

Sending service requests with WSDL files  on page448

Testing all operations in a WSDL file  on page462
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Synchronizing a local WSDL file with GSC
If you edit a local WSDL source file, the Generic Service Client (GSC) should display the changes in the 

UI. You must keep the GSC up-to-date with the WSDL changes to ensure that you test the latest service 

request.

When you set GSC to automatically pick the WSDL changes, the GSC calls are fully re-created. This means 

that when you make some changes to WSDL, there might be some content that you did not change, 

however, was dependent on the changed content. Therefore, when you use this preference, the whole 

structure of the GSC calls is re-created.

The Request History view in GSC shows the changes occurred to the WSDL file.

To apply the local WSDL changes in GSC:

1. Click Window  > Preferences  > Generic Service Client.

2. Select the Apply WSDL changes to GSC  check box.

Related information

Generic service client overview  on page432

Creating transport protocol configurations  on page435

Sending service requests with WSDL files  on page448

Sending HTTP endpoint requests  on page451

Sending a JMS endpoint request  on page453

Sending a WebSphere MQ endpoint request  on page455

Sending OData endpoint batch requests  on page457

Sending WebSphere Java MQ endpoint requests  on page459

Testing all operations in a WSDL file  on page462

Viewing message content  on page464

Synchronizing a remote WSDL file  on page466

Adding static XML headers to a service request  on page468

Opening file attachments  on page470
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Adding static XML headers to a service request
You can add static XML headers to service requests to ensure compliance with WS-Addressing, WS-

ReliableMessaging, and WS-Coordination specifications as well as other predefined standards.

Static XML headers are compliant with the web service specifications for service-oriented architecture 

(SOA). Checks are performed to ensure that the XML headers are valid.

To add a static XML header to a request:

1. Open a service request in the generic service client. The location of the XML header depends on 

the product that you are using:

• For IBM®  Security AppScan®, click the Request Stack  tab and in the algorithm stack for the 

request, click Add  > Static XML Headers.

• For IBM®  Rational®  Performance Tester, IBM®  Rational®  Service Tester for SOA Quality,  or 

other products, click the Message  tab and click Form.

2. On the Header  bar, click Add  ( ) to open the menu.

3. Select the web service specification for the request to be comply with, or click More  to open a 

detailed list of specifications.

The XML structure of the header is created.

4. Edit the header as required.

Some elements require completion or content to be specified. XML elements that are invalid or 

require attention are marked with a warning or an error symbol.

Related information

Generic service client overview  on page432

Creating transport protocol configurations  on page435

Sending service requests with WSDL files  on page448

Sending HTTP endpoint requests  on page451

Sending a JMS endpoint request  on page453

Sending a WebSphere MQ endpoint request  on page455

Sending OData endpoint batch requests  on page457

Sending WebSphere Java MQ endpoint requests  on page459

Testing all operations in a WSDL file  on page462

Viewing message content  on page464

Synchronizing a remote WSDL file  on page466
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Synchronizing a local WSDL file with GSC  on page468

Opening file attachments  on page470

Editing WSDL security profiles  on page242

Adding WS-Addressing to a security configuration  on page260

Opening file attachments
When a service sends a file attachment with the response, you must import it as a resource to open the 

attachment.

Ensure that you have specified an editor to view the attachment type in. Click Window  > Preferences  > 

General  > Editors  > File associations, and specify the editor.

1. Open the message return, and click the Attachment  tab.

File attachments are listed with a default name, a MIME type, and a contents ID.

2. Select the line for the attachment that you want to open, and click Open.

3. In the Create Resource  window, type a name for the resource, and select a location where it will be 

imported, and click OK.

Ensure that the name of the resource includes a file extension that is compatible with the MIME 

type of the attachment.

After the attachment has been imported, you can click on Open  again to open the file in the corresponding 

editor.

Related information

Generic service client overview  on page432

Creating transport protocol configurations  on page435

Sending service requests with WSDL files  on page448

Sending HTTP endpoint requests  on page451

Sending a JMS endpoint request  on page453

Sending a WebSphere MQ endpoint request  on page455

Sending OData endpoint batch requests  on page457

Sending WebSphere Java MQ endpoint requests  on page459
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Testing all operations in a WSDL file  on page462

Viewing message content  on page464

Synchronizing a remote WSDL file  on page466

Synchronizing a local WSDL file with GSC  on page468

Adding static XML headers to a service request  on page468

Emulating workloads
You emulate a workload by creating a schedule and adding user groups/rate runner groups, tests, and 

other elements to it.

Schedule overview
A schedule is the "engine" that runs a test. However, schedules are much more than simple vehicles for 

running tests. You can design or emulate the real-life workload by creating various groups and dividing the 

load across different remote agents that generate load on the application under test. A schedule can be 

as simple as one virtual user or one iteration running one test, or as complicated as hundreds of virtual 

users or iteration rates in different groups, each running different tests at different times.

You can create a VU Schedule  or a Rate Schedule. The VU Schedule  is used to add virtual users to 

generate the load on the application under test. The Rate Schedule  is used to ascertain the rate at which a 

task can be achieved in a specific time frame.

You can use a schedule to control tests in the following ways:

• Group tests under groups, to emulate the actions of different types of users or rates.

• Set the order in which tests run: sequentially, randomly, or in a weighted order.

• Set the number of times that each test runs.

• Run tests at a certain rate

• Run tests for a certain time, and increase or decrease virtual users or rate during the run

When you create a schedule, it is displayed with one group, as shown in the following image. You can add 

more groups, tests, and other items to the schedule to emulate a workload.
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When you add items to a schedule, they appear in italic type, as shown i. The italic type changes to regular 

type after you save the schedule.

Creating a VU Schedule
You can create a VU Schedule  to accurately emulate the actions of individual users.

1. Right-click the project in the Test Navigator view, and then click New  > VU Schedule.

2. Enter a name for the VU Schedule, and then click Finish.

A new VU Schedule  that contains one user group is displayed.

3. Perform the following steps to add User Group and Locations on which each user group must run:
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a. Right-click the VU Schedule, and then click Add  > User Group.

b. Click a user group, and then select Run this group on the following locations  from the 

Locations  tab.

4. Right-click the User Group, and then click Add  > Loop  to set the loops for the tests.

Loops are used to run many iterations of a test, to run tests at a set rate, and to run tests in stages.

5. Right-click the Schedule Contents, and then click Add  > Random Selector  to contain the selector 

and their weights.

Selectors are used to run a series of tests in random order, thus emulating the varied actions of 

real users, instead of running each test within a user group sequentially. The weight that you assign 

each selector determines the statistical probability that its child element is selected during an 

iteration.

6. Right-click the Schedule Contents, and then click Add  > Test  to contain the test.

7. Perform the following steps to set the stages for the VU Schedule:

a. Select the User Load  from the Category  field.

b. Click Add.

c. Enter a value in the Number of users  field in the stage.

d. Select the appropriate option to set duration of the stage.

e. Click OK.

Each stage lasts for a specific amount of time and contains a specific number of users. By setting 

stages, you can model workloads that reflect real-world usage over time. Putting the tests in a 

stage in an infinite loop prevents virtual users from finishing before the stage ends.

8. Add other schedule elements to refine the schedule structure: Right-click a schedule element, and 

click Insert  (adds the new element before the selection) or Add  (adds the new element after the 

selection).

Element Purpose For more information

Synchronization point Used for coordinating the ac

tivities in a schedule, such as 

forcing virtual users to wait at 

a specific point

Synchronizing users  on 

page490

Delay Used to emulate user actions 

accurately; for example, a 

user might delay before plac

ing an order

Delaying virtual users or ac

tions  on page489
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Element Purpose For more information

Comment Used for your notes and com

ments regarding the schedule 

element

9. Set the VU Schedule  options:

Category options Typical setting For more information

User Load Select this option to mod

el workloads over time and 

change the number of users 

that perform certain tasks to 

reflect real-world usage.

Setting user loads  on 

page477

Think time Use the options on this page 

to increase, decrease, or ran

domize the think time. The 

default setting is to use the 

recorded think time.

Think time overview  on 

page503

Resource Monitoring Select Enable resource mon

itoring  to enable resource 

monitoring.

You can capture resource 

monitoring data from these 

sources:

• Apache HTTP Server 

Managed Beans

• Apache Tomcat Man

aged Beans

• IBM®  DB2®  monitor

ing

• IBM®  Tivoli®  monitor

ing

• IBM®  WebSphere® 

Performance Monitor

ing Infrastructure

Enabling Resource Monitor

ing from the workbench  on 

page 534

Enabling Resource Monitor

ing on Windows Vista, Win

dows 7, and Windows Server 

2008  on page535
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Category options Typical setting For more information

• JBoss Application 

Server Managed 

Beans

• Java™  Virtual Machine 

Managed Beans

• Oracle Database moni

toring

• Oracle WebLogic Serv

er Managed Beans

• SAP NetWeaver Man

aged Beans

• The rstatd daemon 

(UNIX™)

• Simple Network Man

agement Protocol (SN

MP) agents

• Windows™  Perfor

mance Monitor

Resource Monitoring from 

Service

Select this option to continu

ally observe the health of the 

system's resources. To mon

itor a remote system under 

test, you can install an agent 

on that system.

Resource Monitoring Service 

on page560

Statistics log level Typically, keep the default 

settings. If you are running 

a long test, change the sam

pling rate from the default 5 

seconds to a larger interval.

Setting the statistics dis

played during a run  on 

page566

Variable Initialization A variable is declared in the 

test variables section of the 

test. You can use it through

out the test as a reference for 

any field that can be substi

tuted.

Test variables  on page343
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Category options Typical setting For more information

Requirements You can define performance 

requirements to specify the 

acceptable thresholds for the 

performance parameters in a 

schedule.

Defining requirements in 

schedules  on page513

Test log level Typically, keep the default 

setting of Primary test ac

tions. You must have at least 

this level of logging to create 

a Page Percentile report and 

to see page title verification 

points that you have set.

Setting the data that the test 

log collects  on page569

Response time breakdown Select Enable collection of 

response time data  to enable 

response time breakdown.

You can collect response 

time breakdown data from 

HTTP or SOA tests.

Enabling response time 

breakdown collection  on 

page 561

Enabling response time 

breakdown collection on Win

dows Vista, Windows 7, and 

Windows Server 2008  on 

page562

Problem definition log level Change the default settings 

only when requested to do so 

by Support.

Setting the problem determi

nation level for schedules  on 

page575

Application Performance 

Management

You can use Application 

Performance Management 

(APM) in a schedule to en

able the  Dynatrace applica

tion and enhance the data 

collection during load test

ing by adding HTTP headers 

to the request in your HTTP 

tests.

Using Application Perfor

mance Management in a 

schedule  on page501
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Category options Typical setting For more information

Advanced tab (at the bottom 

of the VU Schedule Details 

area)

Click Edit Options  to set pro

tocol-specific options that ap

ply to all tests in the sched

ule. Setting protocol-specific 

options for a schedule is sim

ilar to setting protocol-specif

ic options for a user group.

Emulating slower network 

traffic  on page 486

Running long duration Citrix 

tests  on page

After you create a VU Schedule  that describes the behavior for your software system, run it against 

successive builds of the application under test or with an increasing number of virtual users. Then 

analyze the results that are reported.

Setting user loads
By setting stages, you can model workloads over time and change the number of users that perform 

certain tasks to reflect real-world usage. You can vary the user load and collect performance metrics for 

each stage independently, which means that a single run can more efficiently accomplish the work of 

multiple runs that require shutting down and restarting users. Each stage, which lasts a specific amount 

of time and contains a specific number of users, defines a different load.

When a VU Schedule  contains stages, you can place the tests in the schedule in an infinite loop, as shown 

in the following figure. This setting prevents virtual users from finishing the stage before the allotted time.

You can also use the Percentage of users allowed to exit during execution  option to specify the number 

of users that can stop during a stage without stopping the stage or the entire test run.

To add stages to a VU Schedule:
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1. In the Test Navigator, browse to the schedule and double-click it.

By default, the User Load option contains one stage with five users that run until finished. The 

following figure shows the default User Load option.

2. In the User Load section, click Add.

3. In the Create User Stage  window, enter the information for a stage, and click OK.

Options Description

Number 

of users

Enter the total number of users in the stage. This is not the number of users to 

add to or to remove from those currently running; it is the total number of active 

users at this stage.

Stage Du

ration

Enter the length of time (and the time units) for the stage to run. After the Num

ber of users  setting is achieved, the users will run for up to this amount of time. 
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Options Description

When the time expires, the users continue to run if they are needed for the next 

stage, or, if not, they are stopped.

Rate of 

Change

Specify the amount of time to delay, when changing the number of users, be

tween adding or removing each user.

Adding or removing all users over a time period changes the users in a uniform 

random distribution over the time specified for changing users, which is the time 

before the settle and the stage begin. This slight variance closely emulates hu

man behavior.

Adding or removing one user every time unit adds the same delay for each user. 

Although this option does not emulate human behavior as closely as the first op

tion, it is useful when you must adhere to a certain rate because of limitations 

of the system under test, such as the time it takes for a user to log on to the sys

tem.

Settle 

Time

After the desired user population has been reached, a system might still experi

ence a period of flux in reaction to the change in user population. Setting a settle 

time allows the system to re-establish its steady-state equilibrium so that it can 

accurately reflect the user population.

The Stage Duration  starts after the settle time expires. The settle time is not 

part of the stage duration and the settle-time metrics are not included in the 

Compare report, which is generated at the end of the run. However, settle time 

does affect how long a VU Schedule  runs, because it adds time to the begin

ning of each stage. And, although the Compare report does not include the set

tle-time metrics, these metrics are collected and you can include them by chang

ing the time range of the report.

If your system does not have significant flux or if the stage is long enough that 

the flux comprises only a minor part of it, you might not need a settle time.

4. In the User Load section, modify the stages as necessary:

a. Click Up  or Down  to change the order of the rows.

b. Double-click a row to modify it.

5. Enter the Time limit for a user to respond to a stop request  value.

If a stage contains fewer virtual users than its predecessor, the excess users are asked to stop. 

This value gives a stopped virtual user extra time to complete its current action (such as an HTTP 

request). If the virtual user cannot complete its action before the time limit expires, it is forced to 

stop. Note that a long time limit might delay the next stage.
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6. Enter a value for Percentage of users allowed to exit during execution  to specify the percentage of 

users that can stop during a stage of a test run. The default is 0%, which means if any users stop 

during a stage, the entire test ends after that stage completes. If you enter a value, the test run can 

continue to the next stage even if some users stop running. You can specify a value from 0 to 100 

with fractions up to one decimal place. Examples of valid percentages include 0.5%, 3%, and 99.1%.

7. To stop the run after a specific number of successive failed stages, select the Exit run for failing 

requirements  check box and specify a value in Number of failing stages in a row. If, at the end of 

a completed stage, that stage has failed, and if such stage failures happen successively for the 

specified number of times, the VU Schedule  will stop.

8. Examine the User Load Preview  section to verify that the stages are set correctly. The red line 

segments indicate that the total number of users has been achieved for the stage and the settle 

time, if one is specified, has ended.

The following figure illustrates a VU Schedule  with two 16-minute stages. The second stage has a 

4-minute change rate and a 4-minute settle time:



Chapter 1. Test Author Guide

You can display a Compare report, which compares the time ranges of each stage, when the run is 

complete. This report provides a quick side-by-side analysis of how the system under test performs under 

various user loads. To display a Compare report, right-click the test results; then click Compare All Time 

Ranges.

User group overview
User groups enable you to group tests in a logical order.

With user groups, you can control test execution in several ways:
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• Group tests by characteristics. For example, you could have two user groups—a Buyers group and 

a Browsers group—that represent the types of users on your system.

• Influence the order in which tests are run.  When you run a VU Schedule, the first test in each user 

group runs—in parallel, not sequentially. After the first test in a user group is completed, the second 

test runs, then the third, and so on.

The following VU Schedule  contains one user group.

If you run this VU Schedule  with 10 users, they are assigned to the only user group—Browsers and Buyers. 

When the run starts, the 10 virtual users start running the first test in parallel. As soon as one test is 

finished, a virtual user moves to the second test. Thus, you have 10 virtual users, all starting at the same 

time and running each test sequentially. This does not give you much control over the run.

The following VU Schedule  contains the same tests in the same order, but they are divided between 

two user groups. Conceptually, this VU Schedule  is easier to understand, because the user's tasks are 

grouped logically—the Browsers browse, and the Buyers browse and then bid on a product. But, even 

more important, this one gives a more accurate representation of the types of users on your system, 

because each user group contains tests that represent the actions that they do, and the proportions of the 

user groups (70% and 30%) represent the proportions of the users on your system.

If you run this VU Schedule  with 10 users, seven are assigned to the Browsers group, and three are 

assigned to the Buyers group. When the run starts, the seven Browsers and the three Buyers start in 

parallel. Thus, you have seven Browsers, each running two tests sequentially, and three Buyers, each 

running three tests sequentially.
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Adding a user group to VU Schedule
By defining user groups, you can group related tests and run the tests in parallel. Tests belonging to 

different user groups run in parallel.

1. In the Test Navigator, double-click the VU Schedule.

2. Right-click the name of VU Schedule, and then click Add  > User Group.

3. In Group name, type a descriptive name for the user group.

4. Under Group size, select Absolute  or Percentage, and type the number of users or a percentage of 

users in the group.

Option Description

Absolute

Specifies a static number of virtual users. 

Type the maximum number of virtual users 

that you want to be able to run. For exam

ple, if you type 50, you can run up to 50 virtual 

users each time you run a schedule. Typically, 

you create an Absolute  user group only if the 

group does not add a workload. For example, 

if one test prepared a website for use and an

other test restored the site to its initial state, 

each test would be in an Absolute  user group 

that contains one user.

Percentage

Specifies a dynamic number of users. Type 

the percentage of the workload that the user 

group represents. Typically, you assign user 

groups a percentage, rather than an absolute 

number. For example, perhaps 70.0% of your 

users browse your website, and 30.0% order 

an item from your website. Set up two user 

groups in this proportion. Then, at the sched

ule level, type the initial number of users to 

run. You can also add users during the run. 

The schedule distributes the users among the 

dynamic user groups according to the per

centages you specify.
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Option Description

Tip:  You can specify fractional percent

ages.

5. Under Locations, select Run this group on the local computer  or Run this group on the following 

locations.

Option Description

Run this group on the local computer

The user group runs on your computer. Use 

this option if the workload is small or if you 

are testing the VU Schedule.

Note:  If you use PVU licensing, you can

not run a group on a local computer.

Run this group on the following locations

Typically, you run user groups on remote 

computers. When user groups run on remote 

computers, the workbench activity on the lo

cal computer does not affect the ability to ap

ply load. Run user groups at remote locations 

in these cases:

• When a large number of virtual users 

are running and the local computer 

does not have enough processor or 

memory resources to support this 

load. You can conserve resources by 

running the users on different loca

tions, so that fewer users run on each 

computer.

• When a test requires specific client li

braries or software. The user group 

that contains this test must run on a 

computer that has the libraries or soft

ware installed.

6. To declare a remote location:
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a. Click Add  > Add New.

The Add New  wizard opens. On the first page of the wizard, you can specify general 

properties for the remote location.

b. In Hostname, type the IP address or the fully qualified host name of the remote computer.

c. In Name, type a descriptive name for the remote computer.

d. In Deployment Directory, type the directory on the remote computer to store the test assets.

The directory, which is created if it does not exist, stores the temporary files that are needed 

during a schedule run.

e. In Operating System, select the operating system of the remote computer, and then click 

Next.

f. Specify the IP aliasing properties for this location. To make it appear as though each virtual 

user has its own IP address, click Enable IP Aliasing.

g. To use IP addresses from all network interfaces at the remote location, click Use IP 

addresses from all network interfaces.

h. To use addresses from a subset of network interfaces, click Only use IP addresses from the 

following network interfaces.

Tip:  Click Add  to add the name of an interface and Edit  to change the interface name. 

Specify network interfaces separated by commas, for example, eth0, eth1. If you do not 

use this form, the connection attempt fails.

i. Click Next. On the third page of this wizard, you can specify file locations.

j. In File name, type the name of the file to contain information about this computer, and then 

click Next.

Note:  The data stored in the file includes information such as the host name and 

deployment directory. You can change this information later by opening the Test Navigator 

and double-clicking the file.

7. To add an already declared location:

a. Click Add  > Add Existing.

b. In the Select Location  window, select the computer on which the user group will run, and 

then click OK.
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The following schedule shows two user groups. Browsers represent 70.0% of the users, and Buyers 

represent the remaining 30.0%:

After you have added user groups to the VU Schedule, add the tests that each user group will run.

Adjusting user groups
You can adjust multiple user groups simultaneously to distribute a load across groups and to set the 

groups to run on the workbench computer. Typically, when you run VU Schedule, user groups run on 

remote agent computers, not on the local workbench computer.

1. In the Test Navigator, double-click the VU Schedule.

2. Under Schedule Contents, select the groups to adjust.

3. Under User Group Details, adjust the group sizes or set all groups to run on the workbench 

computer.

Option Description

Percentage
Click to distribute the load for the user group 

based on percentage.

Absolute
Click to distribute the load for the selected 

user group,based on absolute numbers.

Emulating slower network traffic
You can emulate various WAN connection speeds used for HTTP traffic to determine its effect on 

response times and throughput.

You can set a user group to emulate the speed at which HTTP data is sent and received. By delaying the 

network uploads and downloads to emulate a slower network connection, the user group mirrors real-

world interaction with production servers.

To emulate line speed:
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1. In the Test Navigator, browse to the schedule and double-click it.

The schedule opens.

2. In the schedule, click the user group for which you want to define a line speed.

3. In the Schedule Element Details area, click the Options  tab.

4. To declare the line speed value:

a. Click Enable line speed control.

b. Select the actual line speed, or select Custom values  to enter a value.

c. Select the required line speed, or select Custom values  to enter a value, which must be 

lower than the actual line speed.

If a user group employs multiple agent computers (locations) that have different real line speed values, 

to obtain the highest possible accuracy, we recommend that you divide the user group into smaller user 

groups so that each user group contains agents with the same actual line speed value. However, even 

if the actual line speeds are different, if they are both much larger than the required line speed, then the 

inaccuracy will be small, and may even be tolerable.

The following example illustrates this difference. The actual line speeds are different (100 Mbps and 10 

Mbps) but are both much larger than the desired line speed of 56 Kbps:

The computed line speed delay for a 5000 byte response where the actual line speed is 100 Mbps and the 

desired line speed is 56 Kbps is 706 ms. The computed line speed delay for a 5000 byte response where 

the actual line speed is 10 Mbps and the desired line speed is 56 Kbps is 702 ms. In this example, the 

inaccuracy is only 4 ms.

Running a user group at a remote location
You can run a user group at a remote location (also called an agent computer), rather than on your local 

computer, to prevent your workbench activity from affecting the ability to apply load.

Before you run a user group at a remote location, verify that:

• IBM®  Rational®  Performance Tester  Agent is installed on the remote computer. The agent is 

configured and connected to the Rational®  Performance Tester  workbench.

• Firewall is disabled on the workbench computer or configured to allow incoming connections on 

the port number 7080.

• A reasonable number of virtual users will run at the remote location. When you assign a user group 

to a remote location, do not overload the remote computer (agent). If you exceed the number of 
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virtual users that the remote computer can run, the performance measurements of the server will 

be skewed because they will be affected by the performance of the computer. The test results will 

reflect the load of the computer more than the load of the server. For best results on a computer 

with a 1 GHz processor and 1 GB of RAM, do not exceed 1000 concurrent virtual users.

Generally, you should run user groups at a remote locations. You must  run a user group at a remote 

location in these cases:

• When a large number of virtual users are running and the local computer does not have enough 

processor or memory resources to support this load. You can conserve resources by running the 

users on different locations, so that fewer users run on each computer.

• When a test requires specific client libraries or software. The user group that contains this test 

must run on a computer that has the libraries or software installed.

1. In the Test Navigator, browse to the schedule and double-click it.

The schedule opens.

2. In the schedule, click the user group that you want to run on a different computer.

3. In the Schedule Element Details area, click Run this group on the following locations.

4. To declare a remote location:

a. Click Add  > Add New.

The Add New  wizard opens. On the first page of the wizard, you can specify general 

properties for the remote location.

b. In Hostname, type the IP address or the fully qualified host name of the remote computer.

c. In Name, type a descriptive name for the remote computer.

d. In Deployment Directory, type the directory on the remote computer to store the test assets.

The directory, which is created if it does not exist, stores the temporary files that are needed 

during a schedule run.

e. In Operating System, select the operating system of the remote computer, and then click 

Next.

f. Specify the IP aliasing properties for this location. To make it appear as though each virtual 

user has its own IP address, click Enable IP Aliasing.

g. To use IP addresses from all network interfaces at the remote location, click Use IP 

addresses from all network interfaces.
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h. To use addresses from a subset of network interfaces, click Only use IP addresses from the 

following network interfaces.

Tip:  Click Add  to add the name of an interface and Edit  to change the interface name. 

Specify network interfaces separated by commas, for example, eth0, eth1. If you do not 

use this form, the connection attempt fails.

i. Click Next. On the third page of this wizard, you can specify file locations.

j. In File name, type the name of the file to contain information about this computer, and then 

click Next.

Note:  The data stored in the file includes information such as the host name and 

deployment directory. You can change this information later by opening the Test Navigator 

and double-clicking the file.

5. To add an already declared location:

a. Click Add  > Add Existing.

b. In the Select Location  window, select the computer on which the user group will run, and 

then click OK.

Delaying virtual users or actions
By adding a delay to a schedule or a compound test, you can emulate user actions more accurately.

1. In the Test Navigator, browse to the schedule or compound test and double-click it.

2. Right-click the schedule or test element to be delayed, and then click Add  > Delay.

3. In the Element Details area, type the length and the time units of the delay.

After you add a delay, you generally add the schedule or test elements that the delay controls. The 

elements are at the same level as the delay—they are not children of the delay.

The following schedule shows three delays. The Browsers delay 10 seconds between each browse action. 

The Buyers delay 30 seconds between each Browse action and one minute before they decide to bid on 

an item.
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Synchronizing users
Inserting a synchronization point enables you to coordinate the activities of a number of virtual users by 

pausing and resuming activities. You can synchronize all virtual users at the beginning of a schedule and 

stagger the release times so that the users do not overload the system. Synchronization points are also 

useful in stress testing.

You can insert a synchronization point into a schedule or a test. The advantage of inserting a 

synchronization point into a schedule is that the synchronization point is more visible than in a test. Also, 

you can define release options and select a timeout for a synchronization point set in a schedule.

Synchronization points within loops are not reset. In other words, once a synchronization point has been 

released (in the first iteration of a loop) it stays released for all further iterations.

To insert a synchronization point into a schedule:

1. In the Test Navigator, browse to the schedule and double-click it.

The schedule opens.

2. Right-click the element just below the place that you want to add the synchronization point, and 

then click Insert  > Synchronization point.

3. Enter a name for the synchronization point, or select the name of an existing synchronization point 

to modify its release type.
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The synchronization point opens in the schedule for you to set its attributes.

4. Set the release type; that is, whether you want the users to be released at the same time or at 

staggered times. Use the Together  release type when you are preforming a stress test on the 

system. Use the Staggered  release type when you want the users released in such a way that they 

will not overwhelm the system.

Option Description

Together

Releases all users at once from a synchro

nization point. The default restart time is 0, 

which means that when the last user reach

es the synchronization point, all users are re

leased together immediately.

To delay the users, enter a number in the 

Restart Time  field. For example, if you set 

the restart time to 4 seconds, after all of the 

users reach the synchronization point (or the 

timeout occurs), they wait 4 seconds, and 

then they are all released.

Staggered
Releases the users one by one from a syn

chronization point.
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Option Description

The amount of time that each user waits to 

be released is chosen at random and is uni

formly distributed within the range that you 

set in the Minimum time  and the Maximum 

time  fields.

For example, if the Minimum time  is 1 sec

ond and the Maximum time  is 4 seconds, af

ter the users reach the synchronization point 

(or the timeout occurs), each user waits be

tween 1 and 4 seconds after being released. 

All users are distributed randomly between 1 

and 4 seconds.

5. Set the timeout period. The timeout period begins when the first virtual user reaches the 

synchronization point. If all the users that are associated with the synchronization point do not 

reach it when the timeout period ends, any users at the synchronization point are released. A 

timeout of 0 means that there is no timeout.

Setting a timeout is useful, because one user might encounter a problem that prevents him from 

reaching the synchronization point. You do not want to hold up all users because of a problem with 

one user.

A user reaching a synchronization point after a timeout is not held. However, the user is delayed if 

the Minimum time  and Maximum time  are set.

Related reference

Synchronization Point report  on page

Related information

Synchronizing users in tests  on page

Creating a Rate Schedule
By creating a Rate Schedule, you can model the different behaviors of how the application is accessed 

and measure the rate accuracy.

The Rate Schedule  can be run only on agent locations.

unique_354
unique_354
../../com.ibm.rational.test.lt.common.doc/topics/tsyncpttest.html
../../com.ibm.rational.test.lt.common.doc/topics/tsyncpttest.html
../../com.ibm.rational.test.lt.common.doc/topics/tsyncpttest.html
../../com.ibm.rational.test.lt.common.doc/topics/tsyncpttest.html


Chapter 1. Test Author Guide

When you run a Rate Schedule, it tries to achieve the desired rate with the specified number of clients. 

However, if the actual rate falls below the specified threshold level, the product will automatically add 

more number of clients within the purview of the maximum number of clients to reach the desired rate. 

You can modify the threshold level based on the need of the tests at Window  > Preferences  > Test  > Test 

Execution  > Actual rate threshold (percentage).

1. Click File  > New  > Rate Schedule  or from the Test Navigator view, right-click the project and click 

New  > Rate Schedule.

2. Select a project for the Rate Schedule, specify the name of the Rate Schedule, and click Next.

3. Specify the number of stages and the number of rate runner groups for the Rate Schedule.

The number of stages and rate runner groups is determined by the amount of load you want to 

generate and the model of the workload.

4. Click Finish.

The Rate Schedule  is created.

5. To make changes to the stages in the Rate Schedule, for the Load  category in the Rate Schedule 

Details section, click Add, Edit, or Remove  buttons.

6. To add tests to the Rate Runner Group, select it and click AddTest  and select a test.

7. To add a new Rate Runner Group, select the Rate Schedule and click Add  > Rate Runner Group. For 

more information, see Adding Rate Runner Groups  on page 496.

8. To specify the agents to generate the load, select the Agents  category in the Rate Schedule Details 

section and add agent locations. For more information, see Adding Agent Locations  on page 

499.

9. Optional:  Set the loops for the tests (or other schedule elements) to use: Right-click the Rate 

Runner Group to contain the loop, and click Add  > Loop. Loops are used to run many iterations of a 

test, to run tests at a set rate, and to run tests in stages.

10. Add selectors and their weights: Right-click the schedule element to contain the selector, and click 

Add  > Random Selector. Selectors are used to run a series of tests in random order, therefore 

emulating the varied actions of real users, instead of running each test within a Rate Runner Group 

sequentially. The weight that you assign each selector determines the statistical probability that 

its child element is selected during an iteration. For more information, see Running tests in random 

order  on page 521.

11. Add other schedule elements to refine the schedule structure: Right-click a schedule element, and 

click Insert  (adds the new element before the selection) or Add  (adds the new element after the 

selection).

Some of the elements to add to the Rate Schedule:
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Element Purpose More information

Delay Used to emulate actions ac

curately; for example, a trans

action might be delayed be

fore placing an order.

Delaying actions  on 

page489

Comment Used for your notes and com

ments regarding the schedule 

element.

Transaction Used to group certain actions 

in a transaction.

Adding transactions  on 

page523

12. Save the Rate Schedule.

Setting rate load
By setting stages, you can model workloads over time and change the number of transactions that 

perform certain tasks to reflect real-world usage. You can divide the load into stages and collect 

performance metrics for each stage independently, which means that a single run can more efficiently 

accomplish the work of multiple runs. Each stage, which lasts a specific amount of time and contains 

a specific number of transactions, defines a different load. Each load is used to derive a certain rate of 

transactions in a given time.

You can add load only to the Rate Schedule Details  section. When you add the load, they are 

automatically displayed in the Rate Runner Group Details  section. Managing the rate at which the load is 

to be run is specified in the Rate Runner Group Details  section. You can change the rate at the time of the 

run too.

1. In the Test Navigator, browse to the rate schedule and double-click it. In the Rate Schedule editor 

that opens, the Load  category displays one stage that runs for 10 minutes.

2. In Rate Schedule Details section, click Add.

3. Specify the duration of the stage and the settle time. The time required for the system to stabilize 

in between reaching the peak load and starting another stage is called settle time.

4. Click OK.

The new stage is added to the Rate Schedule and is displayed to all the Rate Runner Groups.

5. In Time limit to respond to a stop request, specify a duration value.

If a stage contains fewer iterations than its predecessor, the excess iterations in the previous stage 

are asked to stop. This duration value gives a stopped iteration extra time to complete its current 
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action (such as an HTTP request). If the iteration cannot complete its action before the time limit 

expires, it is forced to stop. Note that a long time limit might delay the next stage.

6. Optional:  To update the stage details, click a Rate Runner Group, select a stage from the table, and 

click the Show Advanced  check box. You can also click the Edit  button and update the following 

options.

Iteration rate

Specify the rate at which a transaction needs to be executed.

Distribution

Specify the frequency rate at which the rate generator should run.

Constant: The workload of the rate generator occurs exactly at the rate you specify. 

For example, if the iteration rate is 4 per minute, the workload starts at 15 seconds, 

30 seconds, 45 seconds, and 60 seconds, which is exactly 4 every minute, evenly 

spaced, with a 15-second interval.

Uniform: The time between each workload is not constant. However, the workload 

that occurred over time averages out to the rate that you specified. The time between 

the start of each workload is chosen randomly with a uniform distribution within the 

selected range.

Negative Exponential: This type of distribution emulates the spike of activity followed 

by a lean period that is typical of user behavior. Therefore, if the rate is 4 every 

minute, the probability that the workload starts immediately is high but decreases 

over time. Rational®  Performance Tester  maintains the desired average rate.

Change Rate

Use this option to ramp up or ramp down the iteration rate to the desired level.

Min Clients

Specify the minimum number of clients to be used to achieve the desired rate of 

execution. This option is typically used by an advanced user if the default number of 

clients do not meet the desired rate.

Max Clients

Specify the maximum number of clients to be used to achieve the desired rate of 

execution.

7. Save the Rate Schedule.
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Rate Runner group overview
With the Rate Runner group, you can group tests in a logical order and run them in parallel.

You can control test execution in Rate Runner groups in several ways:

• Group tests by characteristics: For example, you could have two groups such as Buyers group and 

Browsers group. These groups represent the types of users on your system.

• Influence the order in which tests are run: When you run the Rate Schedule, the first test in each 

group runs in parallel, and not in sequence. After the first test in the group is completed, the second 

test runs, then the third, and so on.

The following Rate Schedule  contains one user group.

If you run this Rate Schedule  with 10 iterations, they are assigned to the only Rate Runner group: Browsers 

and Buyers. When the run starts, the 10 iterations start running the first test in parallel. As soon as 

one test is finished, an iteration moves to the second test. Thus, you have 10 iterations, all starting 

simultaneously and running each test sequentially. This does not give you much control over the run.

The following Rate Schedule  contains the same tests in the same order, but they are divided between two 

Rate Runner groups. Conceptually, this Rate Schedule  is easier to understand, because the user's tasks 

are grouped logically as Browsers browse and Buyers browse and then bid on a product.

Adding Rate Runner Groups
By defining Rate Runner Groups, you can group related tests. The tests within a group run in a sequence 

and the tests across the groups are run in parallel.
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For example, there are two Rate Runner Groups, such as Rate Runner Group A and Rate Runner Group B. 

Each group contains one test. When you run the Rate Schedule, both the tests run in parallel. If there are 

more tests in the groups, those tests will run after the first test completes.

1. From the Test Navigator view, double-click the Rate Schedule.

2. In the Rate Schedule  editor, select the schedule and click Add  > Rate Runner Group.

3. In the Group name, type a descriptive name for the user group.

4. In the table, click Show Advanced  check box and click Edit.

5. You can modify the following options for the Rate Runner Group:

Iteration Rate

Specify the rate at which a transaction needs to be executed.

Distribution

Specify the frequency rate at which the rate generator should run.

Constant: The workload of the rate generator occurs exactly at the rate you specify. 

For example, if the iteration rate is 4 per minute, the workload starts at 15 seconds, 

30 seconds, 45 seconds, and 60 seconds, which is exactly 4 every minute, evenly 

spaced, with a 15-second interval.

Uniform: The time between each workload is not constant. However, the workload 

that occurred over time averages out to the rate that you specified. The time between 

the start of each workload is chosen randomly with a uniform distribution within the 

selected range.

Negative Exponential: This type of distribution emulates the spike of activity followed 

by a lean period that is typical of user behavior. Therefore, if the rate is 4 every 

minute, the probability that the workload starts immediately is high but decreases 

over time. Rational®  Performance Tester  maintains the desired average rate.

Change Rate

Click this option to set a delay between starting and stopping each iteration. The All 

iterations over  option produces a slight variance that is representative of human 

behavior. The One iteration every  option adds the same delay to each iteration, which 

prevents many iterations from performing an action simultaneously if the system 

under test has limitations.

Min Clients
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Specify the minimum number of clients to be used to achieve the desired rate of 

execution. This option is typically used by an advanced user if the default number of 

clients do not meet the desired rate.

Max Clients

Specify the maximum number of clients to be used to achieve the desired rate of 

execution.

6. Define the scope of the tests in the Rate Runner Group.

Define Locally: Click this button to use the tests from the Rate Schedule.

Use compound test: Clkick this button to define the group from the compound test. You can click 

Browse  to add an existing compound test to the Rate Runner group or click Create  to create a 

compound test. The definition of the compound test is then applied to the Rate Runner group.

7. In the Options  tab, define the protocol-specific options.

Select Override think time options  to specify a think time behavior for the current group.

Use the recorded think time

Select to play back a test at the same rate that it was recorded. This option has no 

effect on the think time.

Specify a fixed think time

Each think time is exactly the same value that you specify. Although this does not 

emulate users accurately, it is useful if you want to play a test back quickly.

Increase/decrease the think time by a percentage

Type a percentage in the Think time scale. Each think time is multiplied by that 

percentage. A value of 100 causes no change in think times. A value of 200 doubles 

the think times, therefore the schedule plays back half as fast as it was recorded. A 

value of 50 reduces the think times by half, therefore the schedule plays back twice 

as fast. A value of 0 indicates no delays.

Vary the think time by a random percentage

Each think time is randomly generated within the upper and lower bounds of the 

percentages that you supply. The percentage is based on the recorded think time. For 

example, if you select a Lower limit  of 10 and an Upper limit  of 90, the think times 

will be between 10 % and 90 % of the original recorded think time. The random time is 

uniformly distributed within this range.

Limit think times to a maximum value
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Setting a maximum think time is useful with tests that emulate actual think times. By 

setting a maximum, you do not have to search for and edit each long think time within 

a test, if, for example, you are interrupted during recording. No think time used will 

be greater than the maximum limit you set, even if you have chosen to vary the think 

time by a percentage that would exceed this maximum. To restore the original think 

times, clear this check box.

8. Click the Edit Options  button to edit certain options that apply to specific test extensions.

9. In the Variable Initialization  tab, create or select the existing variables to be used by all the tests 

in a Rate Runner group. For more information, see Assigning variables to schedule and groups  on 

page512

10. Save the schedule.

Run a Rate Runner group at a remote location
To generate good amount of load, you need computers with enough processing capability and 

throughput. It is a good practice to install the workbench on your computer and the agents on remote 

computers. The agents on the remote computers help generate the load.

Before you run a user group at a remote location, verify that:

• IBM®  Rational®  Performance Tester  Agent is installed on the remote computer. The agent is 

configured and connected to the Rational®  Performance Tester.

• One transaction rate per second is equivalent to one Virtual Tester. From V9.2.0.1, to run a Rate 

Schedule  with more than 5 transactions per second, you must have appropriate VT Pack licenses.

• Firewall is disabled on the workbench computer or configured to allow incoming connections on 

the port number 7080.

• A reasonable number of iterations will run at the remote location. When you assign a Rate Runner 

group to a remote location, do not overload the remote computer (agent). If you exceed the number 

of iterations that the remote computer can run, the performance measurements of the server will 

be skewed because they will be affected by the performance of the computer. The test results will 

reflect the load of the computer more than the load of the server. For best results on a computer 

with a 1 GHz processor and 1 GB of RAM, do not exceed 1000 concurrent iterations.

Generally, you should run the groups at a remote locations. You must  run a Rate Runner group at a remote 

location in these cases:
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• When a large number of iterations are running and the local computer does not have enough 

processor or memory resources to support this load. You can conserve resources by running the 

iterations on different locations, so that reasonable number of iterations run on each computer.

• When a test requires specific client libraries or software. The Rate Runner group that contains this 

test must run on a computer that has the libraries or software installed.

1. From the Test Navigator view, double-click the Rate Schedule

2. Select the name of the Rate Schedule  and from the Rate Schedule  Details section, select the 

Agents  category.

You can also select the agents at the Rate Runner Group level. Select a Rate Runner Group and 

click the Agents  tab.

Note:  When the agents are declared for both Rate Runner Group and Rate Schedule, the Rate 

Runner Group agents take precedence.

3. To declare a remote location:

a. Click Add  > Add New.

The Add New  wizard opens. On the first page of the wizard, you can specify general 

properties for the remote location.

b. In Hostname, type the IP address or the fully qualified host name of the remote computer.

c. In Name, type a descriptive name for the remote computer.

d. In Deployment Directory, type the directory on the remote computer to store the test assets.

The directory, which is created if it does not exist, stores the temporary files that are needed 

during a schedule run.

e. In Operating System, select the operating system of the remote computer, and then click 

Next.

f. Specify the IP aliasing properties for this location. To make it appear as though each virtual 

user has its own IP address, click Enable IP Aliasing.

g. To use IP addresses from all network interfaces at the remote location, click Use IP 

addresses from all network interfaces.

h. To use addresses from a subset of network interfaces, click Only use IP addresses from the 

following network interfaces.
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Tip:  Click Add  to add the name of an interface and Edit  to change the interface name. 

Specify network interfaces separated by commas, for example, eth0, eth1. If you do not 

use this form, the connection attempt fails.

i. Click Next. On the third page of this wizard, you can specify file locations.

j. In File name, type the name of the file to contain information about this computer, and then 

click Next.

Note:  The data stored in the file includes information such as the host name and 

deployment directory. You can change this information later by opening the Test Navigator 

and double-clicking the file.

4. To add an already declared location:

a. Click Add  > Add Existing.

b. In the Select Location  window, select the computer on which the user group will run, and 

then click OK.

5. Save the schedule.

Using Application Performance Management in a schedule
You can use Application Performance Management (APM) in a schedule to enable Dynatrace application 

and enhance the data collection during load testing by adding HTTP headers to the request in your HTTP 

tests. You can also use APM to monitor the performance of applications.

You must have completed the following tasks:

• Created a VU schedule or Rate schedule.

• Added an HTTP test to the schedule.

You can select the page or the transaction to enable the data to be displayed in the selected application 

and run the schedule. After the schedule run is complete, you can open the Test Log  page, and select the 

request. You can then click the Protocol Data  tab and open the Request  page.

Based on the page or transaction that you select, the Request  page displays a header that is added 

automatically to the current page of every request as described in the following table:

If you select... Then...

Pages A header called PT-Page  with a value of the cur

rent page is added to every request.
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If you select... Then...

Transactions A header called PT-Transaction  with a value of 

the current page is added to every request.

Note:  If you do not add any transaction to 

the schedule, then the header is not added to the 

request.

Note:  The PT-Page  and PT-Transaction  request headers that are added to the selected requests 

during the test run can enhance the data collection with Dynatrace.

1. Open the schedule from the test editor.

2. Select the schedule from the Schedule Contents  section.

3. Select Application Performance Management  from the Category  field.

4. Select Enable Dynatrace  checkbox to enable transaction and page requests into the Dynatrace 

application by using HTTP headers.

5. Select any of the following checkboxes to control the header that is added to every request:

• Pages: Select this checkbox to add a header called PT-Page  with a value of the current page 

name to every request.

• Transactions: Select this checkbox to add a header called PT-Transaction  with a value of 

the current transaction name to every request within a transaction.

6. Select one of the following options to filter the requests:

• All: Click this option to add headers to all the requests.

• Primary Request Only: Click this option to add headers to the primary requests only.

7. Select the Filter by Host/Port  checkbox to filter the requests based on the hostname and port 

number of the existing connections in the tests.

8. Select the Filter by User Defined  checkbox, and then perform the following steps if you want to 

filter the requests based on the strings that you defined:

a. Click Add.

b. Enter a string name in the Text  field.

c. Select any of the following checkboxes based on your requirement:
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• Case-sensitive: Select this checkbox to find the content that is sensitive to the 

capitalization of letters that are entered in the Text  field.

• Regular expression: Select this checkbox to accept a regular expression to match the 

string that is entered in the Text  field.

d. Click OK.

9. Select any one of the following checkboxes to add the filters for the category:

• Both filters match: Click this option to select only the requests that match both the Filter by 

Host/Port  and Filter by User Defined  filters.

• Either filter matches: Click this option to select the requests that match either Filter by 

Host/Port  or Filter by User Defined  filters.

You have enabled the Dynatrace application in a schedule by using APM.

You can save and run the schedule. After the schedule run is complete, you can open the Test Log  page, 

and select the request. You can then click the Protocol Data  > Request  and verify the request details.

Think time overview
Think time  is a delay in the processing of a request to reproduce the time that a human would take to 

read or examine the data that is displayed from a previous user action. Think time is calculated from the 

time that a request is received (that is, the display is complete on the monitor) until the time that the user 

clicks a key or link to perform an action.

Setting think time behavior in schedules
You can increase, decrease, or randomize think time in your tests, or you can play it back exactly as 

recorded.

To set the think time in a schedule:

1. In the Test Navigator, browse to the schedule and double-click it.

The schedule opens.

2. You can set the think time behavior for an entire schedule or you can override the think time 

behavior for any specific user group.
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• To set the think time behavior for the entire schedule, in the Schedule Contents  area, click 

the name of the schedule and click the Think Time  tab.

• To override the think time behavior for a specific user group, in the Schedule Contents  area, 

click the name of the user group, click the Options  tab, and select the Override think time 

options  check box.

3. Set the think time behavior to one of the following options:

Option Description

Use the recorded think time.

This option does no affect the think time. The 

time that it takes for a test to play back is 

the same as the time that it took to record it. 

So, for example, if you were interrupted for 

five minutes during recording, the same five-

minute think time occurs when you run the 

test.

Specify a fixed think time.

Each virtual user's think time is exactly the 

same value: the value that you type. Although 

this option does not emulate users accurate

ly, it is useful if you want to play a test back 

quickly.

Increase/decrease the 

think time by a percentage.

In the Think time scale  field, specify a per

centage by which each virtual user's think 

time is multiplied. A value of 100 indicates no 

change in think time. A value of 200 doubles 

the think times, so that the schedule plays 

back half as fast as it was recorded. A value 

of 50 reduces the think times by half, so that 

the schedule plays back twice as fast. A val

ue of 0 indicates no delays at all.

Vary the think time by a random percentage.

Each virtual user's think time is randomly gen

erated within the upper and lower bounds of 

the percentages that you supply. The percent

age is based on the recorded think time. For 

example, if you select a lower limit of 10 and 

an upper limit of 90, the think times are be

tween 10 percent and 90 percent of the orig
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Option Description

inal recorded think time. The random time is 

distributed uniformly within this range.

4. To set a maximum think time, select the Limit think times to a maximum value  check box and 

specify a value.

5. Save the schedule.

Related information

Limiting think times in schedules  on page505

Limiting think times in tests  on page505

Limiting think times in schedules
You can speed up playback by defining a maximum value for the think times of virtual users in schedules.

Setting a maximum think time is useful with tests that mimic the actual user's think times. For example, if 

you are interrupted when you record a test, you do not have to record the test again. Instead, you can set 

a maximum think time. By setting a maximum, you can truncate all think times that exceed the specified 

value, without having to search for and edit each long think time. No think time used will be greater than 

the maximum limit you set, even if you have chosen to vary the think time by a percentage that would 

exceed this maximum.

1. In the Test Navigator, browse to the schedule and double-click it.

The schedule opens.

2. In the Schedule Contents area, click the name of the schedule.

3. Click the Think Time  tab and select the Limit think times to a maximum value  check box.

4. In Maximum think time, type a number and select a time unit.

To restore the original think times, clear the Limit think times to a maximum value  check box.

Related information

Setting think time behavior in schedules  on page503

Limiting think times in tests  on page505
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Limiting think times in tests
You can speed up playback and the time that debugging tests requires by defining a maximum value for 

the think time of a single user test playback.

Limiting think time is especially useful when you are debugging a test. By setting a maximum, you can 

truncate all think times that exceed the specified value, without having to search for and edit each long 

think time. No think time will be greater than the maximum you set.

Note:  This maximum applies to running individual tests. The limit does not apply to running tests in 

schedules. When a test is run as part of a schedule, the maximum think time value is ignored.

1. In the Test Navigator, click Window  > Preferences  > Test  > Test Execution.

The Test Execution  window opens.

2. The default value for maximum think time is 2 seconds. To change the maximum think time value, 

in Max think time (seconds), change the number. If you do not want to limit the amount of think 

time during test playback, enter a large number.

3. Click Apply, and then click OK.

To restore the original think time default settings, click Restore Defaults.

Related information

Setting think time behavior in schedules  on page503

Limiting think times in schedules  on page505

Working with agents
If you have a significant workload to test, typically a single computer might not be able to process 

the load efficiently. You need to distribute the load across multiple computers, also called Rational® 

Performance Tester  agents. The agents are installed on computers to generate the load on the 

application.

You create VU Schedule  to generate user load and you create Rate Schedule  to generate transaction 

load on the agent locations. You use the Rational®  Performance Tester  workbench to distribute the 

load. When you distribute the load among agent computers, carefully consider the load that each agent 

computer can take efficiently. For more information, see Capacity planning  on page .

To view the health of the agent computers, see Agents Health Report  on page .

Rational®  Performance Tester  agent, also known as load generation agent, is used to generate load for 

the application under test by creating simulated connections.

../../com.ibm.rational.test.lt.install.doc/topics/ccapacityplanning.html
../../com.ibm.rational.test.lt.install.doc/topics/ccapacityplanning.html
../../com.ibm.rational.test.lt.install.doc/topics/ccapacityplanning.html
../../com.ibm.rational.test.lt.install.doc/topics/ccapacityplanning.html
unique_367
unique_367
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When you install Rational®  Performance Tester  Agent, you can specify the host name of the workbench 

to poll. After the installation, the agent automatically connects to the workbench. If you want to share the 

agent with multiple workbenches, you can either manually add them to the majordomo.config  file at 

installationDir/Majordomo  or use the Share Agent with New Workbench  option that is mentioned 

in the Checking status of agents  on page 508 topic.

When you run a schedule with multiple agents, an agent might be lost, especially during the long load test 

run. Losing an agent is not common and occurs during some extreme cases such as when computer's 

memory is exhausted. When an agent is lost, by default, the schedule is stopped. When the schedule 

is stopped in this manner, you must fix the reason of agent loss or add more agents before running 

the schedule. To continue to run the schedule without the lost agent, in the Schedule editor, click the 

Advanced  tab and clear the Loss of an agent halts execution  check box.

For more information about the benefits of the IBM®  Rational®  Performance Tester  Load Generation 

Agent and insight into its architecture, see: Tips for using the Load Generation Agent in performance 

testing.

Note:

• You can install Rational®  Performance Tester  and Rational®  Performance Tester  Agent on 

any of the supported platforms that are mentioned in the System requirements page http://

www.ibm.com/support/docview.wss?uid=swg27036460. It is not necessary that both are installed 

on the same platforms or the bitness of the platform must be same.

• If you are creating load on the Rational®  Performance Tester  Agent computer, ensure that, in the 

workbench, you point to the agent computers.

• If you are using Rational®  Performance Tester  workbench 8.3 or later, you must use Rational® 

Performance Tester  Agent 8.3 or later. Also, it is recommended to use the same release version for 

both.

The Rational®  Performance Tester  workbench automatically deploys test assets that are required for 

execution to participating agents. For more information about the deployment directory, see Managing 

deployment directory  on page 510.

A typical setup of Rational®  Performance Tester  workbench, Rational®  Performance Tester  agents, and 

the system under test is shown here:
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Related information

Troubleshooting performance testing  on page

Configuring port numbers for agents  on page509

Checking the status of agents
Before running a schedule or test, you can check whether the agents are active and connected to the 

workbench.

Ensure that the Rational®  Performance Tester  agent is running and points to the correct workbench. 

When installing the agent, ensure to specify the correct non-secure port number where the workbench 

listens for the agent. You can view or change the non-secure port number of the current workbench at 

Windows  > Preferences  > Test  > Server.

An agent can be in one of the following statuses:

Agent status Description

Ready Majordomo is running on an agent computer and 

is in regular (default 5 seconds) contact with a 

workbench.

Busy Agent is participating in the schedule execution.

unique_370
unique_370
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Agent status Description

Lost Contact Agent has not contacted the workbench for the 

past 10 seconds.

If you want an agent to take direction from more than one workbench, you can share the agent with those 

workbenches. Also, if you no longer wish for an agent to contact a workbench you can disconnect it.

Note:  The majordomo.config  file located at installationDir/Majordomo  in the Rational® 

Performance Tester  agent computer contains the host name and the port number of the workbench the 

agent polls for work to do. By default, the agent polls for work at the interval of every 5 seconds.

1. To check the status of agents, on the toolbar, click .

The Agent Status  window lists the agents that are connected to the workbench, the license mode, 

operating system, architecture, and status of the agents.

2. To share an agent with other workbenches, in the Agent Status  window, select an agent and click 

Share Agent with New Workbench.

3. Specify the host name and port number of the new workbench and click OK.

4. To disconnect an agent from the workbench, select an agent and click Disconnect Agent from this 

Workbench.

To disconnect the agent from all the workbenches, you must perform the disconnection from each 

workbench.

Configuring port numbers for agents
If any service, such as an application server, on the workbench computer uses the default port numbers, 

you can change the port numbers so that agents can communicate through the new port numbers.

By default, the port numbers for unsecured and secured ports are 7080 and 7443. The IBM®  Rational® 

Performance Tester  agents poll the workbench using the non-secure port number. If you want to encrypt 

the communication between the workbench and agents, select Workbench and agent communication 

is encrypted using TLS/SSL. Rational®  Performance Tester  then uses the secure port number for 

communicating with agents. The workbench internally sends the secure port number to the agents via 

messages exchanged over the non-secure port number.

Note:
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• If you change the non-secure port number, you must configure the agents to poll the new port 

number. In the Rational®  Performance Tester  computer, open the majordomo.config  file located 

at installationDir/Majordomo  and update the port number.

• If two instances of a workbench are opened on one computer, first workbench gets access to port 

7080 to communicate to an agent. For the another workbench to access the agent, you must use a 

different port number.

• To work with a dataset, you must ensure that two consecutive port numbers are available. One 

of the ports is used to communicate between the workbench and agent, and the other is for the 

dataset server. For example, you must ensure that the port number 7081 is open for the dataset 

server if the default port number 7080 is used to communicate between the workbench and agent. 

Similarly, if you use any different port number for communication between the workbench and 

agent, you must ensure that the next port number is available for the dataset server.

1. In Rational®  Performance Tester, click Windows  > Preferences  > Test  > Server.

2. Specify the new port numbers and click OK.

You must now update the majordomo.config  file for the agents to poll the new port numbers.

Managing the deployment directory for agents
You can choose to delete or keep the deployment directory for agents after schedule execution. By 

default, Rational®  Performance Tester  does not delete the deployment directory.

The deployment directory stores the files that are required for test execution. If you do not delete the 

deployment directory, the next time that you run a schedule, Rational®  Performance Tester  only retrieves 

the test assets that it does not have or that have changed since the last execution. This mechanism 

reduces the launch time for subsequent test executions.

However, if you have many schedules and the accumulation of files in the deployment directory might 

create a problem, you can choose to delete the deployment directory on the agent computers. The 

deletion of the deployment directory depends on the successful completion of a schedule. A schedule 

execution is deemed successful when all the agents reach a state of inactivity with no active users or 

when the schedule execution reaches the end of the last stage and then stops.

Note:  If the run is stopped manually, the run encounters a severe error, or communication between 

the agents and workbench stops, the deployment directory is not deleted even if you specify to delete it.
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To delete the deployment directory on the agent computers after schedule execution, click Windows  > 

Preferences  > Test  > Server  and select the Delete deployment directory on the agent after execution 

check box.

Configuring the high-resolution timer
You can configure agent computers to use a high-resolution timer when collecting performance data. The 

high-resolution timer ensures that all measurements are precise to within 1 millisecond.

The high-resolution timer is used by default on the Linux™  operating system. You do not need to configure 

the high-resolution timer on the Linux™  operating system. For the Microsoft™  Windows™, AIX®, and z/

OS®  operating systems, the high-resolution timer is not used by default.

Enabling the high-resolution timer can increase processor usage on Windows™  agent computers. 

Typically, processor usage increases by 10% to 25%, but the increase can vary based on workload. Enable 

the high-resolution timer on Windows™  agent computers if you are measuring response times less than 

15 milliseconds. Enable the high-resolution timer if you are measuring response times of less than 150 

milliseconds and need 1 millisecond precision instead of 15 millisecond precision. If you enable the high-

resolution timer on Windows™  agent computers, monitor the processor usage to determine whether the 

trade-off of higher processor usage is acceptable.

To enable the high-resolution timer on an agent computer:

1. In the Test Navigator, open the location that represents the agent computer.

2. Click the General Properties  tab.

3. On the General Properties  page, click Add  to create a property for the selected location.

4. In the New Property  window, create a property entry:

a. In Property Name, type RPT_VMARGS.

b. In Operator, select =.

c. In Property Value, type -DrptNanoTime.

If you need to set multiple RPT_VMARGS values for a location, place them in the same property 

entry and separate them with a space. Do not use multiple property entries to set multiple 

RPT_VMARGS values for a location.

5. Click OK, and then save the location.

The high-resolution timer is enabled for the location.
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Adding a test to a schedule
By adding a test to a A schedule, in this context, is used to refer to both VU Schedule  and Rate Schedule, 

you can emulate the action of an individual user.

1. In the Test Navigator, browse to the schedule and double-click it.

The schedule opens.

2. Right-click the schedule element that will contain the test, and then click Add  > Test.

3. In the Select Tests  window, expand the project name to display the test that you want to add.

4. Click the name of the test, and then click OK.

The test is displayed in the schedule.

Adding must run tests
In a schedule, you can use the Finally  block to specify tests that must be run after the main workload is 

completed, when the last stage duration is expired, or a schedule is stopped manually.

A schedule can contain many user groups. A user group can contain only one Finally block. A Finally block 

can contain many tests.

1. From the Test Navigator, open a schedule.

2. Select a user group and click Add  > Finally.

3. Select the Finally  block and click Add  > Test Invocation.

4. Select the tests that you want to add and click OK.

Assigning variables to schedule and groups
In addition to assigning variables at the test level, you can assign variables at the A schedule, in this 

context, is used to refer to both VU Schedule  and Rate Schedule  level and User or Rate Runner group 

level. When you assign variables at the schedule level, all the tests and groups in the schedule can use the 

variable initial values, if they have the same variable names.

When you initialize variables at the schedule level, all the groups in the schedule use the variable initial 

values, except those for which a specific value is defined. If the same variable initial value is defined at 

the group level and schedule level, precedence is given to the group level and then to the schedule level. If 

the visibility of a test variable is set to This test only, the test does not use the value that is defined at the 

group level or schedule level.

If a variable is initialized at various places such as test, compound test, schedule, or user group, the 

product uses the following order to initialize the value of the variable when running the test. The variable 

set in the variable table of the compound test editor takes the highest precedence followed by others:
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1. Compound test setting in the variable table UI

2. Compound test specified in a var file

3. User group setting in the variable table UI

4. User group specified in a var file

5. Schedule specified setting in the variable table UI

6. Schedule specified in a var file

7. Command line

Note:  You must select All tests for this user  from the Visible in  drop-down list to take the precedence 

of variable initialization.

1. In the Test Navigator  view, double-click a schedule to open it.

2. To assign a variable at the schedule level or a group level, in the Schedule Contents area, select a 

schedule or a group.

3. In the Schedule Elements Details  area, for a schedule select the Variable Initialization  category, or 

at the group level, click the Variable Initialization  tab, and click Add.

4. Type a variable name and its initial value.

If you have already defined the variables at the test level and want to reuse them, click Select 

existing variables.

5. Optional:  To use the variables from an existing file, click the Use variable initial values file  check 

box, browse for the file, and click Finish.

6. Click Options  > Save.

Defining requirements in schedules
You can define performance requirements to specify the acceptable thresholds for the performance 

parameters in a schedule. The performance requirements that you define can also be used to validate the 

service-level agreements.

You can define both the performance and functional requirements in the schedules. The verdict of the 

schedule is computed based on the requirements defined in the schedule. You can view the verdict in the 

Requirements report. You can add the requirement for counters, which you can generate, by using the 

custom code in a schedule. After the test run is initiated, you can view the information about the counters 

graphically when the test run starts the custom code.

1. Find the schedule you want and double-click it.

The schedule is displayed.
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2. Perform the following steps in the VU Schedule Details  pane:

a. Select Requirements  from the Category  field.

b. Select Enable Requirements  check box.

3. Enter a name for a requirement in the Name  field.

Alternatively, you can click Use Defaults  to use the default name for a requirement.

4. Perform the following steps, to set an Operator  and Value  for the requirements you defined:

a. Click the Operator  field to display the list of mathematical operators and select an operator 

for the requirement from the list.

b. Enter a value for the requirement in the Value  field.

The value you enter is selected as the standard value for the requirement by default.

c. Clear the Standard  check box or let the selection remain as is based on the following 

options:

• Clear the selection – This action enables the value of the selected requirement to be 

a supplemental value.

• Retain the selection – This action enables the value of the selected requirement to be 

a standard value.

5. Perform the following steps to add the counter information generated by using the custom code to 

a requirement:

a. Expand the Custom  section and double-click the row.

The Add Custom Requirement  window is displayed.

b. Enter the path that you used in the custom code in the Counter path  field.

For example, if you specify the counter as getValueCounter("New Counter","Test","Test 

Value")  in the custom code, then you must enter the counter path as /New Counter/Test/

Test Value.

c. Select the Component  from the list, and then click OK.

6. To remove the selected requirement, select the requirement, and then click Clear.

Note:  The requirement is disabled and can be redefined.

You can define the performance requirements in a schedule or in a test if your protocol supports it. When 

you define a requirement in a test, the requirement is defined individually for each test element even if you 

select multiple test elements. When you define a requirement in a schedule, the requirement is applied to 

the aggregate of test elements.
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For example, assume that you select every page in a test and define the following as a requirement: Page 

Response Time(Average)  must be less than 5  seconds.

This means that if one page in the test has a response time of 6  seconds, the requirement on that page 

fails. If the other pages have a response time of less than 5  seconds, the requirement is pass.

For example, in a schedule you can define the following requirement: Response Time For All Pages 

(Average)  as less than 5  seconds. This measures the average response time for all the pages. If one page 

has a response time of 30  seconds and if there are 7  pages that have a lower response time such that 

the average response time is less than 5  seconds, then the page with a response time of 30  seconds also 

passes the requirement.

After you defined the requirements in a VU Schedule, you can run the requirement against the application 

under test, and then analyze the results that are reported.

Related information

Defining requirements in tests  on page154

Reports and counters  on page

Creating custom Java code  on page

Adding custom counters to reports  on page

Repeating tests in a schedule
By adding a loop to a A schedule, in this context, is used to refer to both VU Schedule  and Rate Schedule, 

you can repeat a test for a number of iterations and set the rate for running a test. If the loop contains a 

synchronization point, the synchronization point is released after the first iteration of the loop and stays 

released for all further iterations.

A schedule that contains only user groups and tests runs each test in a user group sequentially. Loops 

provide more sophisticated control than running a simple sequence of consecutive tests.

You can set a loop within a schedule or a test. The following table shows the advantages of both 

methods:
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Loop 

loca

tion Results

Sched

ule

Loops in schedules are easy to locate and modify.

Loops in schedules close the server connection at the end of each iteration and reopen it at 

the beginning of the next iteration. This action models the behavior of a user closing and re

opening a browser.

Use this method to run a test at a set rate. For more information, see Running tests at a set 

rate  on page 520.

Test Loops in tests can be more granular, and thus provide a higher level of control.

Loops in tests reuse the server connection during each loop iteration.

Use this method, with loops that have high iteration counts, to stress test a server.

To add a loop to a schedule:

1. In the Test Navigator, browse to the schedule and double-click it.

The schedule opens.

2. Click the item that you want to be the parent of the loop, and then click Add  > Loop.

3. In the Schedule Element Details area, type the number of iterations for the loop to repeat.

Option Description

Count-based
Runs for the number of iterations that you se

lect.

Time-based

Runs at least for the time that you specify. 

The loop always finishes the iteration. For ex

ample, if you select a time of 1 second and a 

loop takes 10 seconds to run, the loop finish

es one iteration, and then checks the time.

Infinite

Runs until the schedule duration ends. Use 

this option to gather performance data over 

time: set an infinite loop, and then set the 

schedule to stop after a specific time.

4. To maintain a set transaction rate for all schedule items that are children of this loop:
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a. Select Control the rate of iterations.

b. In the Iteration rate  field, type a number, and select a time unit.

This sets the actual rate.

c. Select or clear the Randomly vary the delay between iterations  check box. Selecting this 

check box causes the delay to vary slightly. This option models users more accurately, 

because the iterations are spread out randomly over a certain period of time.

Note:  Statistically, the Randomly vary the delay between iterations  option sets delay 

amounts at random from a negative exponential distribution with the same mean as the 

fixed delay value. The negative exponential distribution has a long "tail," which means that 

a very small number of delays will have very large values. Therefore, make sure that the 

application you are testing is not negatively affected by long periods of inactivity (such as a 

timeout that disconnects the user).

d. Select or clear the Delay before the first iteration of the loop  check box. Selecting this 

check box staggers the first delay in each iteration so that you get a realistic mix at the first 

iteration.

The following schedule contains two loops. Note that the Browse and Bid tests, which are controlled by 

the loop, must be children of the loop.

Related information

How loops affect the state of virtual users  on page168

Adding a loop to a test  on page
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Creating rate generators in user groups
A rate generator is a workload container that specifies the number of tasks that the virtual testers run in a 

given time period. For example, you might be testing an Order Entry group that completes 10 forms every 

hour, or you might be testing a web server that you want to be able to support 100 hits every minute. Use 

a rate generator to model this time-based behavior.

Create a schedule and ensure that user groups have tests.

If the rate generator does not meet the target rate, it could mean that there are performance issues with 

the application or there are insufficient virtual users or agents to meet the target rate. All rate generators 

are coordinated, which means they have a built-in synchronization point and all virtual testers work 

together to generate the workload. You can add a rate generator to a user group in a schedule.

Some of the important points about the rate generator are as follows:

• You cannot have elements such as loop, finally, rate generator, or transaction as a parent to the rate 

generator.

• The same rate generator, as identified by name, can appear in more than one User Group in a 

schedule.

• Rate generators can only be added to percentage user groups. A percentage user group containing 

a rate generator may not be modified to be a fixed user group.

1. From the Test Navigator view, double-click a Schedule to open.

2. Select a user group, and then click Add  > Rate Generator.

3. Specify a name to the rate generator.

4. Set the duration of the rate generator.

• To specify the number of iterations that the rate generator should run, select Count-based.

• To specify the minimum time for the generator to run, select Time-based. The generator 

always finishes the iteration. For example, if you select a time of 1 second and a rate 

generator takes 10 seconds to run, the generator finishes one iteration, and then checks the 

time.

• To continue running the rate generator until it is manually stopped by you or when the last 

schedule stage duration expires, select Infinite.

5. The Uninterruptible iteration  option modifies the behavior of the rate generator if schedule 

execution is stopping. Select this check box to continue running the rate generator until the current 

iteration completes. If a timeout to stop schedule execution occurs before an iteration completes, 

the rate generator stops.

6. Set the rate type of the rate generator.
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• To ensure that all of the virtual users in the schedule maintain the desired transaction rate 

irrespective of the user load, select Total Rate.

• To adjust the transaction rate proportionally to the number of virtual users specified in a 

stage of a schedule, select User Rate. For example, to compare a workload at 100 virtual 

users a minute, 200 virtual users a minute, and 300 virtual users a minute, set the stages 

with that many virtual users. User rate is dynamic and is adjusting at stages, whether users 

are ramping up or down or are added manually.

7. In Iteration rate, specify the number of times the rate generator runs in a specified time period.

8. In Variance, specify a percentage value that is used to determine the range when the transactions 

start.

For example, the transaction rate is 4 every minute (that is, 1 transaction for every 15-second 

interval). If you select a variance of 20%, your transaction has a 3-second window on each side of 

that 15-second interval, because 20% of 15 seconds is 3 seconds. Therefore, the first transaction 

starts at 12–18 seconds. The second transaction starts 15 seconds (plus or minus 3 seconds) 

after the first transaction starts. If the first transaction starts at 12 seconds, the second transaction 

would start at 24 to 30 seconds. However, if the first transaction starts at 18 seconds, the second 

transaction would start at 30 to 36 seconds.

Because each transaction starts randomly within the range that you specify, it is normal for 

transactions to run at a rate that is faster or slower than the rate that you selected for short periods 

of time. For example, if a transaction starts every 12 seconds for a minute, the rate for that initial 

interval is 5 every minute and not the rate of 4 every minute that you selected. Over time, however, 

the transaction rate averages out to 4 every minute.

9. In Distribution, specify the frequency rate at which the rate generator should run.

• Select Constant  for the workload of the rate generator to occur exactly at the rate you 

specify. For example, if the iteration rate is 4 every minute, the workload starts at 15 

seconds, 30 seconds, 45 seconds, and 60 seconds, which is exactly 4 every minute, evenly 

spaced, with a 15-second interval.

• Select Uniform  when the time between each workload is not constant. However, the 

workload that occurred over time averages out to the rate that you specified. The time 

between the start of each workload is chosen randomly with a uniform distribution within 

the selected range as specified in Variance.

• Select Negative Exponential  to emulate the spike of activity followed by a dull period that 

is typical of user behavior. So, if the rate is 4 every minute, the probability that the workload 

starts immediately is high, but decreases over time. IBM®  Rational®  Performance Tester 

maintains the desired average rate.

10. Add the test under the Rate Generator and save the schedule. After the schedule run completes, in 

addition to the Performance Report, the Rate Generator report is available.
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Related reference

Rate Generator report  on page

Running tests at a set rate
To run a test at a set rate, you add a loop to the schedule to control the iteration rate, and then add tests 

to the loop. The tests, which are children of the loop, are controlled by the loop. If the loop contains a 

synchronization point, the synchronization point is released after the first iteration of the loop and stays 

released for all further iterations.

To add a loop that controls the iteration rate for running tests:

1. In the Test Navigator, browse to the schedule and double-click it.

The schedule opens.

2. Click the element that will be the parent of the loop, and then click Add  > Loop.

3. In the Schedule Element Details  area, type the number of iterations that the loop will repeat.

4. To continue executing the loop even after a request to stop the schedule execution is issued, select 

the Uninterruptible iteration  check box.

The schedule execution stops after the current loop iteration is complete. This check box is 

available only for schedules.

5. To maintain a set transaction rate for all schedule items that are children of this loop, select the 

Control the rate of iteration  check box.

6. At Iteration rate, type a number and select a time unit.

This sets the actual rate.

7. Select or clear the Randomly vary the delay between iterations  check box. Selecting this check box 

causes the delay to vary slightly. This option models your users more accurately because rather 

than delaying iterations at fixed intervals, the delay amounts are varied randomly while maintaining 

the same average iteration rate.

Note:  Statistically, the Randomly vary the delay between iterations  option sets delay amounts 

at random from a negative exponential distribution with the same mean as the fixed delay value. 

The negative exponential distribution has a long "tail," which means that a very small number of 

delays will have very large values. Therefore, make sure that the application you are testing is not 

negatively affected by long periods of inactivity (such as a timeout that disconnects the user).

8. Select or clear the Delay before the first iteration of the loop  check box. Selecting this check box 

staggers the first delay in each iteration, so that you get a realistic mix at the first iteration.
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After you have added the loop, you add the schedule items, usually tests, that the loop controls.

Related information

Adding a loop to a test  on page

Running tests in random order
A schedule that contains only user groups and tests will run each test in a user group sequentially. By 

adding a random selector to a schedule, you can repeat a series of tests in random order, thus emulating 

the varied actions of real users.

To add a random selector to a schedule:

1. In the Test Navigator, browse to the schedule and double-click it.

The schedule opens.

2. Click the name of the schedule element to contain the random selector, and then click Add  > 

Random Selector.

3. In the Schedule Element Details area, add the number of iterations to loop.

Think of yourself as a "random selector." You are blindfolded, and you have a bucket that contains 

10 red balls and 10 green balls. You have a 50% chance of picking a red ball, and a 50% chance 

of picking a green ball. You pick a ball randomly—it is red. You then replace the ball in the bucket. 

Every time you pick a ball, you have a 50% chance of getting a red ball. Because the ball is replaced 

after each selection, the bucket always contains 10 red balls and 10 green balls. It is even possible 

(but unlikely) that you will pick a red ball every time.

4. Set the weight of the random selector. The weight determines the statistical probability that a 

specific element will be selected.

a. Right-click the random selector and click Add  > Weighted Block.

b. In the Weight  field, type an integer.

This integer shows the relative proportion that each test runs.
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Assume that a random selector contains two tests: Browse and Bid. You assign Browse a weight 

of 7 and Bid a weight of 3. Each time the loop is processed, Browse has a 70% chance of being 

selected, and Bid has a 30% chance of being selected.

When a selector contains many different weights, you can mathematically determine the likelihood that a 

block will be executed. To do this, add the weights together and divide the weight for each block by that 

total.

For example, assume a selector contains six blocks set to the following weight:

• two blocks set to a weight of 1

• one block set to a weight of 2

• two blocks set to a weight of 5

• one block set to a weight of 9

The total of the weights is: 1 + 1 + 2 + 5 + 5 + 9 = 23. Therefore, the statistical likelihood of selection is:

Weight of block Likelihood of block being selected

1 (two blocks) 1/23. = 0.0435, or about 4.35% (for each block)

2 2/23 = 0.0870, or about 8.70%



Chapter 1. Test Author Guide

Weight of block Likelihood of block being selected

5 (two blocks) 5/23 = 0.2174, or about 21.74% (for each block)

9 9/23 = 0.3913, or about 39.13%

Note that a higher weight increases the likelihood, but does not guarantee, that a block will be executed. 

Some variation might occur. For example, if you run a test 23 times, you cannot predict that the first and 

second blocks will execute exactly once, the third block exactly twice, the fourth and fifth blocks exactly 

five times, and the sixth block exactly nine times. However, the more times that the blocks are executed, 

the more accurate this prediction is.

Adding a transaction to a schedule
A transaction  is a specific group of test elements whose performance you are interested in. When viewing 

the test results, you can view performance data about any transactions that you have added.

You can add a transaction to a test or to a A schedule, in this context, is used to refer to both VU Schedule 

and Rate Schedule. When specifying error conditions for a transaction, you can set the behavior of the 

condition to affect the health of the transaction. The Transaction Health tab of the Transaction report 

displays the health of the transactions in a test.

To put a group of schedule elements into a transaction:

1. In the Test Navigator, browse to the schedule and double-click it.

The schedule opens.

2. In the schedule, select the test elements to group together. Use Shift+click to select multiple 

contiguous elements; use Control+click to select multiple noncontiguous elements; each 

noncontiguous element is put in a separate transaction.

3. Click Add  (to place the transaction after the selected element) or Insert  (to place the transaction 

immediately before the selected element or block), and click Transaction.

4. In the Schedule Element Details  area, give the transaction a meaningful name. This is useful in the 

Transactions report, which lists transactions by name.

You can now use the Add  or Up  and Down  buttons to add the tests or elements to the transaction.
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Emulating network traffic from multiple hosts
By default, when you run a schedule, each virtual user has the same IP address. However, you can make 

each virtual user appear as though it is running on its own host. To do this, you configure IP aliases on the 

host computer, and enable IP aliasing in the schedule. When you run the schedule, the network traffic will 

appear to be generated by multiple hosts.

To avoid IP conflicts, the IPs have to be legitimate, available within the same subnet, and blocked for 

distribution.

Configuring IP aliases for a remote Windows™  location
To make it appear that a virtual user has its own IP address during a schedule run, configure IP aliases for 

each Windows™  remote location.

1. Click Start  > Settings  > Control Panel  > Network Connection.

2. Open the network interface that you want to associate the IP aliases with. In most cases this is the 

Local Area Connection. Click Properties.

3. Scroll down to Internet Protocol (TCP/IP), and click Properties.

4. You must be using static IP addresses to create IP aliases on this host. Therefore, confirm that Use 

the following IP address  is selected, and then click Advanced.

5. Create the IP aliases: 

a. Click Add  in the IP Addresses  area of the IP Settings page to specify the IP address of the 

new alias. Make sure that the address is valid for the network and is not being used by 

another host.

b. Enter the IP address and the subnet mask of the new alias.

6. After you create the alias, click OK  in each previous dialog box to complete the configuration.

7. Set the schedule so that the virtual users will use IP aliases during a run; for information, see 

Enabling virtual users to use IP aliases  on page 526.

When you run the schedule, it will give the impression that the network traffic is being generated from 

multiple hosts.

You can insert custom code into your test to retrieve the runtime IP addresses of each virtual user. For 

information, see Retrieving the IP address of a virtual user  on page .

Note:  To add multiple IP aliases, use the netsh command, as shown in the following example:

netsh -c Interface ip add address name="Gig Ethernet" addr=10.10.0.21 mask=255.255.0.0
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The ntcmds.chm file, typically located in C:\WINDOWS\Help, contains more details about the netsh 

command. When you are finished with the IP aliases, use the following command to remove them:

netsh -c Interface ip delete address name="Gig Ethernet" addr=10.10.0.21 

You can also use a batch file to add and delete the aliases.

Related information

Configuring IP aliases for a remote Linux location  on page525

Configuring IP aliases for a remote AIX location  on page526

Enabling virtual users to use IP aliases  on page526

Configuring IP aliases for a remote Linux™  location
To make it appear that a virtual user has its own IP address during a schedule run, configure IP aliases for 

each Linux™  location.

1. Use the ip(8) command to create an IP alias.

The following example attaches the IP address 9.37.207.29 to the eth0 network interface:

# ip address add 9.37.207.29 dev eth0

Note:  To create a large number of aliases on a Redhat Linux™  platform, follow the instructions 

in the file /etc/sysconfig/network-scripts/ifup-aliases.

The following example deletes the alias:

# ip address del 9.37.207.29 dev eth0

2. Set the schedule so that the virtual users will use the IP aliases during a run; for information, see 

Enabling virtual users to use IP aliases  on page 526.

When you run the schedule, it will give the impression that the network traffic is being generated from 

multiple hosts.

You can insert custom code into your test to retrieve the runtime IP addresses of each virtual user. For 

information, see Retrieving the IP address of a virtual user  on page .
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Related information

Configuring IP aliases for a remote Windows location  on page524

Configuring IP aliases for a remote AIX location  on page526

Enabling virtual users to use IP aliases  on page526

Configuring IP aliases for a remote AIX®  location
To make it appear that a virtual user has its own IP address during a schedule run, configure IP aliases at 

each remote AIX®  location

1. Use the ifconfig command to create an IP alias.

To have the alias created when the system starts, add the ifconfig command to the /etc/rc.net 

script.

The following example creates an alias on the en1 network interface. The alias must be defined on 

the same subnet as the network interface.

# ifconfig en1 alias 9.37.207.29 netmask 255.255.255.0 up

The following example deletes the alias:

# ifconfig en1 delete 9.37.207.29

2. Set the schedule so that the virtual users will use the IP aliases during a run; for information, see 

Enabling virtual users to use IP aliases  on page 526.

When you run the schedule, it will give the impression that the network traffic is being generated from 

multiple hosts.

You can insert custom code into your test to retrieve the runtime IP addresses of each virtual user. For 

information, see Retrieving the IP address of a virtual user  on page .

Related information

Configuring IP aliases for a remote Windows location  on page524

Configuring IP aliases for a remote Linux location  on page525

Enabling virtual users to use IP aliases  on page526
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Enabling virtual users to use IP aliases
After you have configured aliases at on remote computers, you set the schedule so that the virtual users 

can use the configured IP aliases.

Before you can enable virtual users to use IP aliases, you must:

1. Configure the aliases at the remote location.

2. Add the remote location to the user group.

To set the schedule so that the virtual users will use the IP aliases during a run:

1. In the Test Navigator, browse to the schedule and double-click it.

The schedule opens.

2. Click the user group whose virtual users will use aliasing.

3. Click Run this group on the following locations.

The list of locations shows whether IP aliasing is enabled at that location.

4. To change whether IP aliasing is enabled or disabled, click a row in the table, and then click Edit.

5. On the IP aliasing page, click Enable IP Aliasing.

Option Select when

Use IP addresses from all network interfaces
You have one network interface, or you have 

multiple interfaces and want to use them all.

Only use IP addresses from the 

following network interfaces

You want to use some, but not all, network 

interfaces. Select the check box next to the 

interfaces that you want to use. Click Add 

to add a new network interface. Typically, 

you enter an interface name in the form eth0 

(Windows™  and Linux™) or en0 (AIX®).

Related information

Configuring IP aliases for a remote Windows location  on page524

Configuring IP aliases for a remote Linux location  on page525

Configuring IP aliases for a remote AIX location  on page526
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Monitoring resource data
Resource Monitoring is used to capture data, such as processor or memory usage, while running a test 

schedule. It can provide a comprehensive view of a system under test, to help identify issues. You can 

monitor data sources from a local or cloud schedule, or from a Service.

To use Resource Monitoring, you must enable Resource Monitoring in the test schedule and add data 

sources. There are two options to monitor data sources from the schedule editor:

• Monitoring data sources that are available in the local schedule or the cloud schedule, you must 

enable resource monitoring from the workbench to use the data sources of the local or cloud 

schedule.

• Monitoring data sources from a Service, you must enable this option to connect the workbench 

with the server on which the Resource Monitoring Service is installed.

By default, this is IBM®  Rational®  Test Automation Server' s URL that is entered in the preferences but it 

can be changed for another URL if the data sources must be monitored from another server.

Enablement of Resource Monitoring services for a schedule
You can enable the Resource Monitoring service in IBM®  Rational®  Performance Tester  for a 

performance schedule to monitor the resources in a schedule and capture the performance statistics of 

such resources during the run time of the schedule.

When you connect Rational®  Performance Tester  to Rational®  Test Automation Server, the Resource 

Monitoring sources that you added at project level in Rational®  Test Automation Server  are displayed in 

Rational®  Performance Tester.

You can configure Rational®  Performance Tester  to access Rational®  Test Automation Server  by using 

an offline user token. You must generate the offline user token from Rational®  Test Automation Server 

that you can provide on the product Preferences  window in Rational®  Performance Tester  so that a 

connection is established between Rational®  Performance Tester  and Rational®  Test Automation Server.

After you establish the connection with Rational®  Test Automation Server, you can then monitor the 

following Resource Monitoring sources in Rational®  Performance Tester:

• Apache httpd server

• NGINX server

• Java Virtual Machine

• Windows Performance Host

• Linux Performance Host

• Docker Host
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• OpenMetrics exporter

• Prometheus server

If you enable the Resource Monitoring service for a schedule, then you can add the Resource Monitoring 

sources by using any of the following methods:

• Resource Monitoring sources that are displayed by names

• Resource Monitoring sources that are displayed by labels

After you add the Resource Monitoring sources to the performance schedule that is available in your 

Rational®  Performance Tester  project, you can run the schedule from Rational®  Performance Tester.

If you want to run a performance schedule from the Rational®  Performance Tester  command line, you 

can use the -overridermlabels  parameter to enable the Resource Monitoring service. See Running a 

schedule from a command line  on page .

Adding Resource Monitoring sources to a performance schedule
You can add the Resource Monitoring sources to a performance schedule. After you add the Resource 

Monitoring sources, you can run the schedule from Rational®  Performance Tester.

You must have completed the following tasks:

• Accessed IBM®  Rational®  Test Automation Server.

• Configured the Resource Monitoring sources in Rational®  Test Automation Server  for your project. 

For more information about Resource Monitoring sources, refer to Monitoring host resources.

• Specified the Rational®  Test Automation Server  URL in the product preferences window (Window  > 

Preferences  > Test  > Rational®  Test Automation Server  > Resource Monitoring).

• Generated an offline user token in Rational®  Test Automation Server.

For more information about generating an offline token, refer to Generating an offline token.

• Selected the project in the product Preferences  window from the Project to get sources from  the 

drop-down list.

Note:  The Project to get sources from  the drop-down list displays all the projects on 

Rational®  Test Automation Server. The name of the team space for the project is displayed within 

parenthesis. You can select the appropriate project when there are identical project names in 

different team spaces.
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You can add only Resource Monitoring sources that you added on the Resource Monitoring  page of the 

Rational®  Test Automation Server  project to the schedule. The Resource Monitoring sources that are 

added in the team space are not available for selection.

You can add the Resource Monitoring sources to the schedule by using the labels. In this method, you 

can select all the Resource Monitoring sources that are added to Rational®  Test Automation Server  at the 

project and the team space level.

1. Find a schedule from the Test Navigator  pane and double-click it.

The schedule is displayed in a schedule editor.

Note:  A schedule can be a VU schedule or a Rate schedule.

2. Perform the following steps in the Schedule Details  section of the schedule editor:

a. Select the Resource Monitoring from Service  option from the Category  drop-down list.

b. Select the Enable resource monitoring from service  checkbox.

The methods of adding the Resource Monitoring sources are displayed.

3. Select the Collect from the following sources  option.

4. Perform the following steps to select the Resource Monitoring sources to the schedule:

a. Click Add/Remove.

The list of Resource Monitoring sources that you added in Rational®  Test Automation 

Server  is displayed.

Note:  Only the Resource Monitoring sources that you added on the Resource 

Monitoring  page of the Rational®  Test Automation Server  project is displayed. The 

Resource Monitoring sources that are added in the team space are not displayed.

Tip:  If you are unable to view the Resource Monitoring source in Sources from the 

Resource Monitoring Service  dialog box, you can click Refresh  to fetch the list of available 

Resource Monitoring sources.

b. Select the Resource Monitoring sources that you want to add to the schedule.

c. Click Finish.

The selected Resource Monitoring sources are added to the schedule.

5. Perform the following steps to set the Polling Time  interval:
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a. Click the Polling Time  option for the corresponding Resource Monitoring source that you 

added, and then click the Menu  icon.

The Set Time  dialog box is displayed.

b. Enter a time duration in the Polling interval  field.

c. Select the time unit from the drop-down list.

Note:  The default Polling Time  is 5 Seconds.

d. Click OK.

The polling time is a time interval at which time the values for the Resource Monitoring source are 

collected when the schedule runs. For example, if you set the polling time as 5 seconds, data from 

the Resource Monitoring source is collected every 5 seconds.

6. Select the Ignore invalid resources when executing the schedule  checkbox to suppress any error 

message about the Resource Monitoring sources and continue running the schedule during the run 

time.

Note:  The errors can occur if the Resource Monitoring sources are unreachable or unavailable. 

After the schedule run completes, you can view the logs and verify the error messages.

7. Save the schedule.

You have enabled the Resource Monitoring service for the performance schedule and added the Resource 

Monitoring sources to the performance schedule in Rational®  Performance Tester.

You can add a test to the schedule and run the schedule in Rational®  Performance Tester. After the run 

completes, you can view the details of the Resource Monitoring sources in the Performance Report  as 

follows:

• The Resources  page displays the following information:

◦ Resource monitoring sources that were monitored during the run time of the schedule.

◦ All resource counters for those Resource Monitoring sources that were monitored during the 

run time of the schedule.

◦ Unavailable Resource Monitoring sources that were unreachable or unavailable during the 

run time of the schedule.

• The Performance Summary  table under the Resources graph  lists the following information:

◦ The type of Resource Monitoring sources.

◦ The most recent values of their corresponding resource counters were monitored during the 

run time of the schedule.
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Related information

Resource page in the Performance report  on page

Adding Resource Monitoring sources to a performance schedule by using labels  on 

page532

Adding Resource Monitoring sources to a performance schedule by using 
labels
You can add the Resource Monitoring sources to a performance schedule in Rational®  Performance 

Tester  by using labels that are created in Rational®  Test Automation Server. After you add the Resource 

Monitoring sources, you can run the schedule from Rational®  Performance Tester.

You must have completed the following tasks:

• Accessed IBM®  Rational®  Test Automation Server.

• Configured the Resource Monitoring sources in Rational®  Test Automation Server  for your project. 

For more information about Resource Monitoring sources, refer to Monitoring host resources.

• Specified the Rational®  Test Automation Server  URL in the product preferences window (Window  > 

Preferences  > Test  > Rational®  Test Automation Server  > Resource Monitoring).

• Generated an offline user token in Rational®  Test Automation Server.

For more information about generating an offline token, refer to Generating an offline token.

• Selected the project in the product Preferences  window from the Project to get sources from  the 

drop-down list.

Note:  The Project to get sources from  the drop-down list displays all the projects on 

Rational®  Test Automation Server. The name of the team space for the project is displayed within 

parenthesis. You can select the appropriate project when there are identical project names in 

different team spaces.

After the schedule run completes, you can view the labels and the Resource Monitoring sources 

associated with those labels on the Resource  page of the Performance Report. The Resources  page also 

displays the Resource Monitoring sources that were unreachable or unavailable during the run time of the 

schedule.

You must note down the labels that you added to the Resource Monitoring sources in Rational®  Test 

Automation Server. Because you must use these labels to add the Resource Monitoring sources to the 

performance schedule.

unique_390_Connect_42_resource
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When you run the schedule from Rational®  Test Automation Server, the same labels are displayed on the 

Results  page for the schedule. You can open the schedule and go to the Details  card to view the Resource 

Monitoring labels for the schedule that you run.

1. Find a schedule from the Test Navigator  pane and double-click it.

The schedule is displayed in a schedule editor.

Note:  A schedule can be a VU schedule or a Rate schedule.

2. Perform the following steps in the Schedule Details  section of the schedule editor:

a. Select the Resource Monitoring from Service  option from the Category  drop-down list.

b. Select the Enable resource monitoring from service  checkbox.

The methods of adding the Resource Monitoring sources are displayed.

3. Select the Collect from sources matching at least one of the following labels  option.

4. Perform the following steps to select the Resource Monitoring sources to the schedule:

a. Click Add.

The Add Label  dialog box is displayed.

Note:  All labels that you added at the team space level or project level for the Resource 

Monitoring sources in Rational®  Test Automation Server  are available for selection.

b. Select a label from the drop-down list.

c. Optional:  Enter a name for the label in the Enter a label  field.

You can add a label in a performance schedule, and then use the same label for the 

Resource Monitoring source in Rational®  Test Automation Server  before running the 

schedule.

d. Click OK.

Note:  You can add multiple labels to a performance schedule if required.

Optionally, you can edit or delete the labels that you added if required. You can select the label from 

the Data Source table, and then click Edit  to edit an existing label. If you want to remove an existing 

label that you do not want to use in the schedule, you can click Remove.

5. Enter a time duration in the Polling Time  field, and then select the time unit from the drop-down 

list.
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The polling time is a time interval at which time the values for the Resource Monitoring source are 

collected when the schedule runs. For example, if you set the polling time as 5 seconds, data from 

the Resource Monitoring source is collected every 5 seconds.

6. Select the Ignore invalid resources when executing the schedule  checkbox to suppress any error 

message about the Resource Monitoring sources and continue running the schedule during the run 

time.

Note:  The errors can occur if the Resource Monitoring sources are unreachable or unavailable. 

After the schedule run completes, you can view the logs and verify the error messages.

7. Save the schedule.

You have enabled the Resource Monitoring service for a performance schedule and added the Resource 

Monitoring sources by using labels to the performance schedule in Rational®  Performance Tester.

You can add a test to the schedule and run the schedule in Rational®  Performance Tester. After the run 

completes, you can view the labels and the Resource Monitoring sources in the Performance Report  as 

follows:

• The Resources  page displays the following information:

◦ Labels and Resource Monitoring sources associated with those labels that were monitored 

during the run time of the schedule.

◦ All resource counters for those Resource Monitoring sources that were monitored during the 

run time of the schedule.

◦ Unavailable Resource Monitoring sources that were unreachable or unavailable during the 

run time of the schedule.

• The Performance Summary  table under the Resources graph  lists the following information:

◦ The type of Resource Monitoring sources.

◦ The most recent values of their corresponding resource counters were monitored during the 

run time of the schedule.

Related information

Resource page in the Performance report  on page

Enabling Resource Monitoring from the workbench
You can enable Resource Monitoring from the workbench to capture system resource data such as 

processor or memory usage.

unique_390_Connect_42_resource
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To capture accurate resource monitoring data, you must ensure that the clocks on all computers are 

synchronized.

Note:  If you do not synchronize the clocks on the workbench and on all of the computers involved in 

a test, resource counters will be displayed inaccurately (with respect to time) in the reports. (There are a 

number of tools that are available at no cost on the web to help you accomplish synchronization.)

1. Open a schedule in the editor.

2. In the Performance Schedule Details  area, select the Resource Monitoring  option in the Category 

drop-down list.

3. Select the Enable resource monitoring  check box.

This activates the Data Source table.

4. If this is a new schedule, the Data Source table is empty. If the resource monitoring data sources 

are available in the local schedule and you create the cloud schedule from it, the data sources are 

automatically added to the cloud schedule. Clicking Remove  does not delete the data source from 

the file system; it merely removes it from this view. Other test schedules or applications might still 

use the data source.

5. If you have existing locations in your workspace, you can click Add  to add and configure them. If 

you do not configure the existing location, you are warned in the Data Source table that it is Not 

Configured.

6. Select Ignore invalid resources when executing the schedule  to suppress error messages about 

resource monitoring data sources. These errors can occur if the data sources are unreachable or 

invalid. If you select this option, you must view logs to see the error messages.

You have enabled Resource Monitoring from the workbench.

You must specify the data sources. Configuration changes that you make for a particular data source are 

stored with that location. This configuration storage means that you have to set up a data source only 

once. If you export a schedule, it contains the data source configuration information. This data might 

include potentially sensitive information, such as stored passwords.

Related information

Importing resource monitoring data - Legacy Reports  on page

535
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Enabling Resource Monitoring on Windows™  Vista, Windows™  7, and 
Windows™  Server 2008
The Windows™  Vista, Windows™  7, and Windows™  Server 2008 operating systems include security 

features that are not found in previous versions of Windows™. You must adjust the security settings 

to collect resource monitoring data. To enable the resource monitoring feature on Windows™  Vista, 

Windows™  7, or Windows™  Server 2008, you must start the Remote Registry service, disable the remote 

User Account Control, and configure the firewall.

1. Start the Remote Registry service.

The Remote Registry service is disabled by default on Windows™  Vista, Windows™  7, and 

Windows™  Server 2008. This service must be running to collect resource monitoring data:

a. Open the Administrative Tools  Control Panel.

b. Open Services.

c. On the Remote Registry  service entry, click Start.

d. Optional:  To launch the Remote Registry service automatically every time the operating 

system starts, right-click the Remote Registry  service, and then click Properties, and set the 

Startup type  to Automatic.

2. Disable the remote User Access Control (UAC).

When a user authenticates remotely, the UAC grants the user only standard privileges, even 

if the supplied credentials are in the Administrators group. To work around this, modify the 

LocalAccountTokenFilterPolicy registry key:

a. Click Start  > Run, and type regedit  to open the Registry Editor.

b. Navigate to HKEY_LOCAL_MACHINE\Software\Microsoft\Windows\CurrentVersion\Policies

\System.

c. Right-click the LocalAccountTokenFilterPolicy  key, and select Modify; then change the value 

to 1.

d. If the LocalAccountTokenFilterPolicy key does not exist, right-click on the 

LocalAccountTokenFilterPolicy  window, and select New DWord; then type the name 

LocalAccountTokenFilterPolicy, and set its value to 1.

Note:  To reset these remote authentication settings to their original state, set this key to 

0.

e. Restart the computer.

3. Configure the firewall.

The firewall blocks remote administrative requests by default:
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a. Open the Firewall  Control Panel.

b. Click Change settings.

c. Click the Exceptions  tab.

d. Select the Remote Administration  option.

e. Restart the computer.

4. Check that the Remote Registry path is accessible.

a. Open the Administrative Tools  Control Panel.

b. Open Local Security Policy.

c. Expand Local Policies.

d. Select Security Options.

e. In the Policy  column, right-click Network access: Remotely accessible registry paths and 

sub-paths  and select Properties.

f. Ensure that Software\Microsoft\Windows NT\CurrentVersion\Perflib  is displayed in the 

list. If not, add Software\Microsoft\Windows NT\CurrentVersion\Perflib  to the list.

Adding sources for resource monitoring data
If you enable resource monitoring, you must specify the sources of resource monitoring data. A cloud 

schedule can contain resource monitoring locations that can be in the local premises, in the cloud 

location, or in both the places.

1. Open a schedule for editing.

2. At the bottom of the Resource Monitoring  page, click Add. You might need to scroll down in the 

view.

The Create and manage configurations  wizard opens.

3. Do one of these steps:

• To create a resource monitoring location, click Create new resource monitoring location.

• To add an existing location or to create a resource monitoring location that is based on 

an existing location, click Create or add a resource monitoring location from an existing 

source.

4. Type an IP address or the fully qualified host name. This address or host name is for the node to 

monitor, not the Tivoli Enterprise™  Monitoring Server. The IP address can be of a computer that is 

in the cloud.

You can choose the types of data sources.

5. Select from these data sources:
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• Apache HTTP Server Monitoring

• Apache Tomcat Application Server Monitoring

• IBM DB2 Monitoring

• IBM Tivoli Monitoring

• IBM WebSphere PMI Monitoring

• JBoss Application Server Monitoring

• JVM Monitoring

• Oracle Database Monitoring

• Oracle WebLogic Server Monitoring

• SAP NetWeaver Web Application Server Monitoring

• SNMP Monitoring

• UNIX rstatd monitor

• Windows Performance Monitor

You can select multiple types of data sources, but you must configure each one separately. You 

cannot collect Windows™  Performance Monitoring data from a computer that is running the 

Linux™  operating system. Also, you cannot collect Windows™  Performance Monitoring data if 

your workbench is running the Linux™  operating system. In other words, to collect Windows™ 

Performance Monitoring data, the workbench and the node to monitor must both be running the 

Windows™  operating system.

Configure the data sources.

Adding Apache HTTP Server sources
To capture resource monitoring data from Apache HTTP Server, you must configure the data source.

Enable Status Support on the Apache HTTP Server by modifying the httpd.conf file. Refer http://

httpd.apache.org/docs/2.2/mod/mod_status.html  for details.

Then, restart Apache HTTP Server.

1. On the Location  page, specify the connection and authentication information for the server that 

runs Apache HTTP Server. If you have to change the port that is used to communicate with 

the server, change the information in Connection. Typically, your Apache HTTP Server system 

administrator specifies this information. The port number must match the port that you specified 

when configuring Java™  Management Extensions on the server.

2. If administrative security is enabled on the server, select Administrative security enabled.

http://httpd.apache.org/docs/2.2/mod/mod_status.html
http://httpd.apache.org/docs/2.2/mod/mod_status.html
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a. Type the user ID and password for Apache HTTP Server in Authentication.

b. Select Save Password  to save your password locally. If you do not save your password, you 

might be prompted for it (depending on the host system configuration) when you edit the 

configured location or when you run test schedules that use the location.

3. On the Resource  page, select the type of data to capture. The tree view shows the counter groups 

and counters that are available from the application server. Be selective; monitoring all possible 

resource data requires substantial amounts of memory. Hold your mouse pointer over a counter to 

see details about what the counter measures.

4. Configure the options on the Options  page.

a. Click Reset counters at start of run (client side reset only)  to set the counters to 0 at the 

start of a schedule run. This does not change the actual values of the counters on the 

application server. Instead, the recorded values of the counters are corrected to start at 0.

b. In Polling Interval, specify in seconds the interval for collecting resource data. For example, 

if you accept the default setting of 5 seconds, counter information is collected at 5-second 

intervals from the specified host during the schedule run.

c. In Timeout Interval, type a time value in seconds. If the resource monitoring host does not 

respond within this amount of time during a schedule run, an error is logged.

5. To collect the resource monitoring data for the system under test that is in the cloud, in the Cloud 

Options  tab, click the Location in Public Cloud  check box.

6. Click Next.

7. Specify a location and name and click Finish.

Related information

Adding Apache Tomcat sources  on page540

Adding IBM DB2 sources  on page541

Adding IBM Tivoli Monitoring sources  on page544

Adding IBM WebSphere Performance Monitoring Infrastructure sources  on page545

Adding Java Virtual Machine sources  on page547

Adding JBoss Application Server sources  on page548

Adding Microsoft Windows Performance Monitor sources  on page550

Adding Oracle Database sources  on page552

Adding Oracle WebLogic Server sources  on page553

Adding SAP NetWeaver sources  on page555
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Adding Simple Network Management Protocol sources  on page557

Adding UNIX rstatd sources  on page558

Adding Apache Tomcat sources
To capture resource monitoring data from Apache Tomcat, you must configure the data source.

The Java™  Management Extensions must be configured on the server that is running Apache Tomcat. 

After installing Apache Tomcat on Microsoft™  Windows™, run the Configure Tomcat  shortcut. Click the 

Java  tab, and then edit the Java Options. Following are sample Java™  options:

-Dcom.sun.management.jmxremote

-Dcom.sun.management.jmxremote.port=8880

-Dcom.sun.management.jmxremote.ssl=false

-Dcom.sun.management.jmxremote.authenticate=false

On Linux™, set the environment variable CATALINA_OPTS  in either TOMCAT_HOME/bin/setenv.sh  or 

TOMCAT_HOME/bin/catalina.sh  file. For example,

export CATALINA_OPTS="-Dcom.sun.management.jmxremote=true 

                      -Dcom.sun.management.jmxremote.port=8686 

                      -Dcom.sun.management.jmxremote.ssl=false 

                      -Dcom.sun.management.jmxremote.authenticate=false

                      -Djava.rmi.server.hostname=your.server.domain.com"

Then, restart Apache Tomcat.

1. On the Location  page, specify the connection and authentication information for the server that 

runs Apache Tomcat. If you need to change the port that is used to communicate with the server, 

change the information in Connection. Typically, your Tomcat system administrator specifies this 

information. The port number must match the port that you specified when configuring Java™ 

Management Extensions on the server.

2. If administrative security is enabled on the server, select Administrative security enabled.

a. Type the user ID and password for Apache Tomcat in Authentication.

b. Select Save Password  to save your password locally. If you do not save your password, you 

might be prompted for it (depending on the host system configuration) when you edit the 

configured location or when you run test schedules that use the location.

3. On the Resource  page, select the type of data to capture. The tree view shows the counter groups 

and counters that are available from the application server. Be selective; monitoring all possible 
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resource data requires substantial amounts of memory. Hold your mouse pointer over a counter to 

see details about what that counter measures.

4. Configure the options on the Options  page.

a. In Polling Interval  specify in seconds the interval for collecting resource data. For example, 

if you accept the default of 5 seconds, counter information is collected at 5-second intervals 

from the specified host during the schedule run.

b. In Timeout Interval, type a time value in seconds. If the resource monitoring host does not 

respond within this amount of time during a schedule run, an error is logged.

5. To collect the resource monitoring data for the system under test that is in the cloud, in the Cloud 

Options  tab, click the Location in Public Cloud  check box.

6. Click Next.

7. Specify a location and name and click Finish.

Related information

Adding Apache HTTP Server sources  on page538

Adding IBM DB2 sources  on page541

Adding IBM Tivoli Monitoring sources  on page544

Adding IBM WebSphere Performance Monitoring Infrastructure sources  on page545

Adding Java Virtual Machine sources  on page547

Adding JBoss Application Server sources  on page548

Adding Microsoft Windows Performance Monitor sources  on page550

Adding Oracle Database sources  on page552

Adding Oracle WebLogic Server sources  on page553

Adding SAP NetWeaver sources  on page555

Adding Simple Network Management Protocol sources  on page557

Adding UNIX rstatd sources  on page558

Adding IBM®  DB2®  sources
To capture resource monitoring data from IBM®  DB2®, you must configure the data source.

Your DB2®  administrator must turn on the snapshot monitor switches for the resource monitoring data 

to collect. If the monitor switches are off, none of the resource counter groups will contain counters. For 
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more information on the DB2®  snapshot monitor, see these topics in the DB2®  documentation:System 

monitor switches  and Snapshot monitor.

To configure the DB2®  data source:

1. On the Location  page, specify the connection and authentication information for the instance of 

DB2®  to use to capture resource monitoring data. If you need to change the port that is used to 

communicate with the computer that is running DB2®, change the information in Connection. 

Typically, your DB2®  system administrator specifies this information.

2. Under Database Settings, type a name in Database Name  and partition number in Partition 

number.

If the instance of DB2®  to monitor uses the Database Partitioning Feature (DPF), then change 

the partition number to the partition to monitor. Otherwise, leave the partition number set to the 

default, 0.

3. Type the user ID and password for DB2®  in Authentication.

To collect resource monitoring data from DB2®, the specified user account must have SYSADM, 

SYSCTRL, SYSMAINT, or SYSMON authority.

a. Select Save Password  to save your password locally. If you do not save your password, you 

might be prompted for it (depending on the host system configuration) when you edit the 

configured location or when you run test schedules that use the location.

4. Optional: On the Monitoring Status  page, click Check Monitoring Status  to determine the state of 

the monitor switches on the DB2®  server.

The states of the following monitor switches are checked:

DFT_MON_BUFPOOL

Buffer pool switch

DFT_MON_LOCK

Lock switch

DFT_MON_SORT

Sort switch

DFT_MON_STMT

Statement switch

DFT_MON_TABLE

Table switch

DFT_MON_TIMESTAMP

http://publib.boulder.ibm.com/infocenter/db2luw/v9r7/topic/com.ibm.db2.luw.admin.mon.doc/doc/c0005719.html
http://publib.boulder.ibm.com/infocenter/db2luw/v9r7/topic/com.ibm.db2.luw.admin.mon.doc/doc/c0005719.html
http://publib.boulder.ibm.com/infocenter/db2luw/v9r7/topic/com.ibm.db2.luw.admin.mon.doc/doc/c0006003.html
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Timestamp switch

DFT_MON_UOW

Unit of work switch

5. On the Resource  page, select the type of data to capture. The tree view shows the database server 

and its counter groups and counters. Be selective; monitoring all possible resource data requires 

substantial amounts of memory. Clear the Show only selected counters  check box to see all 

available counters. Hold your mouse pointer over a counter to see details about what that counter 

measures.

6. Configure the option on the Options  page.

a. In Polling Interval  specify in seconds the interval, for collecting resource data. For example, 

if you accept the default of 5 seconds, counter information is collected at 5-second intervals 

from the specified host during the schedule run.

b. In Timeout Interval, type a time value in seconds. If the resource monitoring host does not 

respond within this amount of time during a schedule run, an error is logged.

7. To collect the resource monitoring data for the system under test that is in the cloud, in the Cloud 

Options  tab, click the Location in Public Cloud  check box.

8. Click Next.

9. Specify a location and name and click Finish.

Related information

Adding Apache HTTP Server sources  on page538

Adding Apache Tomcat sources  on page540

Adding IBM Tivoli Monitoring sources  on page544

Adding IBM WebSphere Performance Monitoring Infrastructure sources  on page545

Adding Java Virtual Machine sources  on page547

Adding JBoss Application Server sources  on page548

Adding Microsoft Windows Performance Monitor sources  on page550

Adding Oracle Database sources  on page552

Adding Oracle WebLogic Server sources  on page553

Adding SAP NetWeaver sources  on page555

Adding Simple Network Management Protocol sources  on page557

Adding UNIX rstatd sources  on page558
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Adding IBM®  Tivoli®  Monitoring sources
To capture resource monitoring data from an IBM®  Tivoli Enterprise™  Monitoring Server, you must 

configure the data source.

To configure the IBM®  Tivoli®  Monitoring source:

1. On the Tivoli Enterprise™  Monitoring Server page, specify the monitoring server that you want to 

use to capture resource monitoring data.

a. Type the IP address or the fully qualified host name of the monitoring server in the Host  field 

on the Tivoli Enterprise™  Monitoring Server page. This is different from the Host  field at the 

top of the Create and manage configurations  wizard.

b. Type the user ID and password for the monitoring server in Authentication.

c. Change the Connection  information if needed. Typically, your Tivoli®  system administrator 

will specify this information.

d. Select Save Password  to save your password locally. If you do not save your password, you 

might be prompted for it (depending on the host system configuration) when editing the 

configured location or when running test schedules that use the location.

After you have specified the monitoring server, you can choose resources to capture. If the host is 

not managed by the monitoring server, you will see an error message.

2. On the Resource page, select the type of data that you want to capture. The tree view shows the 

host and all of its available IBM®  Tivoli®  Monitoring agents, and their respective counter groups 

and counters. Be selective; monitoring all possible resource data requires substantial amounts of 

memory. Clear the Show only selected counters  check box to see all available counters. Hold your 

mouse pointer over a counter to see details about what that counter measures.

3. Configure time intervals on the Options  page.

a. Type the Polling Interval  in seconds, for collecting resource data. For example, if you accept 

the default of 5 seconds, counter information will be collected at 5-second intervals from 

the specified host during the schedule run.

b. In Timeout Interval, type a time value in seconds. If the resource monitoring host does not 

respond within this amount of time during a schedule run, an error is logged.

4. To collect the resource monitoring data for the system under test that is in the cloud, in the Cloud 

Options  tab, click the Location in Public Cloud  check box.

5. Click Next.

6. Specify a location and name and click Finish.
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Related information

Adding Apache HTTP Server sources  on page538

Adding Apache Tomcat sources  on page540

Adding IBM DB2 sources  on page541

Adding IBM WebSphere Performance Monitoring Infrastructure sources  on page545

Adding Java Virtual Machine sources  on page547

Adding JBoss Application Server sources  on page548

Adding Microsoft Windows Performance Monitor sources  on page550

Adding Oracle Database sources  on page552

Adding Oracle WebLogic Server sources  on page553

Adding SAP NetWeaver sources  on page555

Adding Simple Network Management Protocol sources  on page557

Adding UNIX rstatd sources  on page558

Adding IBM®  WebSphere®  Performance Monitoring Infrastructure sources
To capture resource monitoring data from the IBM®  WebSphere®  Performance Monitoring Infrastructure, 

you must configure the data source.

To configure the IBM®  WebSphere®  Performance Monitoring Infrastructure data source:

1. On the Location page, specify the connection and authentication information for the instance of 

WebSphere®  Application Server to use to capture resource monitoring data. If you need to change 

the SOAP port used to communicate with the computer that is running WebSphere®  Application 

Server, change the Connection  information. Typically, your WebSphere®  system administrator will 

specify this information.

2. If administrative security is enabled on the computer that is running WebSphere®  Application 

Server, select Administrative security enabled.

a. Type the user ID and password for WebSphere®  Application Server in Authentication.

b. Select Save Password  to save your password locally. If you do not save your password, you 

might be prompted for it (depending on the host system configuration) when you edit the 

configured location or when you run test schedules that use the location.
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3. On the Resource page, select the type of data to capture. The tree view shows the application 

server and its counter groups and counters. Be selective; monitoring all possible resource data 

requires substantial amounts of memory. Clear the Show only selected counters  check box to 

see all available counters. Hold your mouse pointer over a counter to see details about what that 

counter measures.

4. Configure the options on the Options page.

a. Click Reset counters at start of run (client side reset only)  to set the counters to 0 at the 

start of a schedule run.

This does not change the actual values of the counters on the application server. Instead, 

the recorded values of the counters are corrected to start at 0. For example, if you monitor 

the ServletRequestCount counter, it starts at 0 instead of its previous value.

b. Type the Polling Interval  in seconds, for collecting resource data. For example, if you accept 

the default of 5 seconds, counter information will be collected at 5-second intervals from 

the specified host during the schedule run.

c. In Timeout Interval, type a time value in seconds. If the resource monitoring host does not 

respond within this amount of time during a schedule run, an error is logged.

5. To collect the resource monitoring data for the system under test that is in the cloud, in the Cloud 

Options  tab, click the Location in Public Cloud  check box.

6. Click Next.

7. Specify a location and name and click Finish.

Related information

Adding Apache HTTP Server sources  on page538

Adding Apache Tomcat sources  on page540

Adding IBM DB2 sources  on page541

Adding IBM Tivoli Monitoring sources  on page544

Adding Java Virtual Machine sources  on page547

Adding JBoss Application Server sources  on page548

Adding Microsoft Windows Performance Monitor sources  on page550

Adding Oracle Database sources  on page552

Adding Oracle WebLogic Server sources  on page553

Adding SAP NetWeaver sources  on page555
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Adding Simple Network Management Protocol sources  on page557

Adding UNIX rstatd sources  on page558

Adding Java™  Virtual Machine sources
To capture resource monitoring data from a Java™  Virtual Machine (JVM), you must configure the data 

source.

The Java™  Management Extensions must be configured on the server that is running the JVM. Following 

are sample arguments to pass to the JVM:

-Dcom.sun.management.jmxremote

-Dcom.sun.management.jmxremote.port=8880

-Dcom.sun.management.jmxremote.ssl=false

-Dcom.sun.management.jmxremote.authenticate=false

1. On the Location  page, specify the connection and authentication information for the computer that 

is running the JVM. If you need to change the port that is used to communicate with the server, 

change the information in Connection. The port number must match the port that you specified 

when configuring Java™  Management Extensions on the server.

2. If administrative security is enabled on the JVM computer, select Administrative security enabled.

a. Type the user ID and password in Authentication.

b. Select Save Password  to save your password locally. If you do not save your password, you 

might be prompted for it (depending on the host system configuration) when you edit the 

configured location or when you run test schedules that use the location.

3. On the Resource  page, select the type of data to capture. The tree view shows the counter groups 

and counters that are available from the computer running the JVM. Be selective; monitoring all 

possible resource data requires substantial amounts of memory. Hold your mouse pointer over a 

counter to see details about what that counter measures.

4. Configure the option on the Options  page.

a. In Polling Interval  specify in seconds the interval for collecting resource data. For example, 

if you accept the default of 5 seconds, counter information is collected at 5-second intervals 

from the specified host during the schedule run.

b. In Timeout Interval, type a time value in seconds. If the resource monitoring host does not 

respond within this amount of time during a schedule run, an error is logged.

5. To collect the resource monitoring data for the system under test that is in the cloud, in the Cloud 

Options  tab, click the Location in Public Cloud  check box.
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6. Click Next.

7. Specify a location and name and click Finish.

Related information

Adding Apache HTTP Server sources  on page538

Adding Apache Tomcat sources  on page540

Adding IBM DB2 sources  on page541

Adding IBM Tivoli Monitoring sources  on page544

Adding IBM WebSphere Performance Monitoring Infrastructure sources  on page545

Adding JBoss Application Server sources  on page548

Adding Microsoft Windows Performance Monitor sources  on page550

Adding Oracle Database sources  on page552

Adding Oracle WebLogic Server sources  on page553

Adding SAP NetWeaver sources  on page555

Adding Simple Network Management Protocol sources  on page557

Adding UNIX rstatd sources  on page558

Adding JBoss Application Server sources
To capture resource monitoring data from JBoss Application Server, you must configure the data source.

Before you can capture resource monitoring data from JBoss Application Server, you must specify the 

path to the JBoss client file, jbossall-client.jar  on the JBoss Client Preferences  page. The JBoss 

client file is provided with JBoss, not with Rational®  Performance Tester. The version of the JBoss client 

file must match the version of JBoss Application Server running on the server under test.

Note:  Rational®  Performance Tester  supports JBoss Application Server version 5.x.

To configure the JBoss Application Server data source:

1. On the Location page, specify the connection and authentication information for the instance 

of JBoss Application Server to use to capture resource monitoring data. If you need to change 

the SOAP port used to communicate with the computer that is running JBoss Application Server, 
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change the Connection  information. Typically, your JBoss system administrator specifies this 

information.

2. If administrative security is enabled on the computer that is running JBoss Application Server, 

select Administrative security enabled.

a. Type the user ID and password for JBoss Application Server in Authentication.

b. Select Save Password  to save your password locally. If you do not save your password, you 

might be prompted for it (depending on the host system configuration) when you edit the 

configured location or when you run test schedules that use the location.

3. On the Resource page, select the type of data to capture. The tree view shows the application 

server and its counter groups and counters. Be selective; monitoring all possible resource data 

requires substantial amounts of memory. Clear the Show only selected counters  check box to 

see all available counters. Hold your mouse pointer over a counter to see details about what that 

counter measures.

4. Configure the option on the Options  page.

a. Type the Polling Interval  in seconds, for collecting resource data. For example, if you accept 

the default of 5 seconds, counter information will be collected at 5-second intervals from 

the specified host during the schedule run.

b. In Timeout Interval, type a time value in seconds. If the resource monitoring host does not 

respond within this amount of time during a schedule run, an error is logged.

5. To collect the resource monitoring data for the system under test that is in the cloud, in the Cloud 

Options  tab, click the Location in Public Cloud  check box.

6. Click Next.

7. Specify a location and name and click Finish.

Related information

Adding Apache HTTP Server sources  on page538

Adding Apache Tomcat sources  on page540

Adding IBM DB2 sources  on page541

Adding IBM Tivoli Monitoring sources  on page544

Adding IBM WebSphere Performance Monitoring Infrastructure sources  on page545

Adding Java Virtual Machine sources  on page547

Adding Microsoft Windows Performance Monitor sources  on page550

Adding Oracle Database sources  on page552

Adding Oracle WebLogic Server sources  on page553
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Adding SAP NetWeaver sources  on page555

Adding Simple Network Management Protocol sources  on page557

Adding UNIX rstatd sources  on page558

Adding Microsoft™  Windows™  Performance Monitor sources
To capture resource monitoring data from Microsoft™  Windows™  Performance Monitor, you must 

configure the data source.

The Windows Performance Monitor option is enabled only for Microsoft Windows computers. If you are 

monitoring a non-Windows computer, this option is disabled.

To configure the Windows™  Performance Monitor data source:

1. On the Location page, type the user ID, password, and domain. The domain is optional, required 

only if you need to perform cross-domain authentication.

Note:  The user ID must correspond to a user that is a member of the Performance Monitor 

Users group or the Administrators group on the computer from which you want to collect resource 

monitoring data. If the user is not in the Performance Monitor Users group or the Administrators 

group on the computer that you want to monitor, no Windows™  Performance Monitor data is 

collected.

2. Select Save Password  to save your password locally. If you do not save your password, you might 

be prompted for it (depending on the host system configuration) when editing the configured 

location or when running test schedules that use the location.

3. On the Resource page, select the type of data that you want to capture. The tree view shows the 

host and all of its respective counter groups and counters. To see all the available counters, clear 

the Show only selected counters  check box.

Be selective; monitoring all possible resource data requires substantial amounts of memory. Hold 

your mouse pointer over a counter to see details about what that counter measures.

4. Configure time interval on the Options  page.

a. Type the Polling Interval  in seconds, for collecting resource data. For example, if you accept 

the default of 5 seconds, counter information will be collected at 5-second intervals from 

the specified host during the schedule run.

b. In Timeout Interval, type a time value in seconds. If the resource monitoring host does not 

respond within this amount of time during a schedule run, an error is logged.
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5. To collect the resource monitoring data for the system under test that is in the cloud, in the Cloud 

Options  tab, click the Location in Public Cloud  check box.

6. Click Next.

7. Specify a location and name and click Finish.

Note:  The host that you want to monitor must be accessible through the Windows™  network. 

Resource monitoring data is collected using the net use  command to establish a connection to remote 

computers. File and printer sharing must be enabled on the computer running the Windows™  operating 

system. Simple File Sharing, where remote connections are processed as access by the Guest user, must 

be disabled. In addition, system policies must not be set so that remote connections are processed as 

access by the Guest user. For example, if the Network security: Sharing and security model for 

local accounts  policy is set to Guest only - local user authenticate as Guest  and the Accounts: 

Guest account status  policy is set to Enabled, then remote connections are processed as access by the 

Guest user. In that case, resource monitoring data is not collected.

Typically, if you are able to connect to a shared hard disk drive on the remote host from the workbench, 

then you will also be able to collect resource monitoring data from Windows™  Performance Monitor on 

the remote host. If file and printer sharing is not enabled on the remote host and you attempt to set up 

resource monitoring in a schedule, the following message is displayed:

IWAY0241E The host name IP_address  is either not a known host or is not a Windows host.

To enable Windows™  file and printer sharing:

1. Open the Network Connections Control Panel.

2. Right-click the Local Area Connection  (or the currently active network adapter).

3. In the menu, click Properties.

4. Select File and Printer Sharing for Microsoft Networks  in This connection uses the following 

items.

5. Click OK.

Related information

Adding Apache HTTP Server sources  on page538

Adding Apache Tomcat sources  on page540

Adding IBM DB2 sources  on page541

Adding IBM Tivoli Monitoring sources  on page544

Adding IBM WebSphere Performance Monitoring Infrastructure sources  on page545

Adding Java Virtual Machine sources  on page547
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Adding JBoss Application Server sources  on page548

Adding Oracle Database sources  on page552

Adding Oracle WebLogic Server sources  on page553

Adding SAP NetWeaver sources  on page555

Adding Simple Network Management Protocol sources  on page557

Adding UNIX rstatd sources  on page558

Adding Oracle Database sources
To capture resource monitoring data from Oracle Database, you must configure the data source.

Before you can capture resource monitoring data from Oracle Database, you must specify the path to the 

Oracle Database client file, ojdbc6.jar  on the Oracle Database Client Preferences  page. The Oracle 

Database client file is provided with Oracle Database, not with Rational®  Performance Tester. The version 

of the Oracle Database client file must match the version of Oracle Database that is running on the server 

under test.

1. On the Location  page, specify the connection and authentication information for the server that 

runs Oracle Database. If you have to change the port that is used to communicate with the server, 

change the information in Connection. Typically, your Oracle Database system administrator 

specifies this information.

2. In Database Name, type the name of the database to monitor.

3. On the Resource  page, select the type of data to capture. The tree view shows the counter groups 

and counters that are available from the application server. Be selective; monitoring all possible 

resource data requires substantial amounts of memory. Hold your mouse pointer over a counter to 

see details about what that counter measures.

4. Configure the options on the Options  page.

a. In Polling Interval, specify in seconds the interval for collecting resource data. For example, 

if you accept the default setting of 5 seconds, counter information is collected at 5-second 

intervals from the specified host during the schedule run.

b. In Timeout Interval, type a time value in seconds. If the resource monitoring host does not 

respond within this amount of time during a schedule run, an error is logged.

c. Clear the Keep cursors open during runtime  check box to allow database cursors to close 

while tests run. By default, Keep cursors open during runtime  is selected, which prevents 

database cursors from being closed while tests run.
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5. To collect the resource monitoring data for the system under test that is in the cloud, in the Cloud 

Options  tab, click the Location in Public Cloud  check box.

6. Click Next.

7. Specify a location and name and click Finish.

Related information

Adding Apache HTTP Server sources  on page538

Adding Apache Tomcat sources  on page540

Adding IBM DB2 sources  on page541

Adding IBM Tivoli Monitoring sources  on page544

Adding IBM WebSphere Performance Monitoring Infrastructure sources  on page545

Adding Java Virtual Machine sources  on page547

Adding JBoss Application Server sources  on page548

Adding Microsoft Windows Performance Monitor sources  on page550

Adding Oracle WebLogic Server sources  on page553

Adding SAP NetWeaver sources  on page555

Adding Simple Network Management Protocol sources  on page557

Adding UNIX rstatd sources  on page558

Adding Oracle WebLogic Server sources
To capture resource monitoring data from Oracle WebLogic Server, you must configure the data source.

To capture resource monitoring data from Oracle WebLogic Server, you must specify the path to the client 

files:

• wljmxclient.jar

• wljmsclient.jar

• wlclient.jar

These Oracle WebLogic client files are provided with Oracle WebLogic, not with IBM®  Rational® 

Performance Tester, so you must copy the client files from the server to a folder on the workbench 

computer. In Rational®  Performance Tester, click Window  > Preferences  > Test  > Performance Resource 

Monitoring  > Oracle WebLogic Client Preferences  and specify the path to the folder containing the client 
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files. The versions of the client files must match the version of Oracle WebLogic Server running on the 

server under test. By default, for Oracle WebLogic Server 10g Release 3 (10.3), the client files are installed 

in the c:\bea\wlserver_10.3\server\lib\  folder.

The resource monitoring for Oracle WebLogic server works with the Internet Inter-ORB Protocol (IIOP). If 

you use JMX protocol in Oracle WebLogic Server, you can use the JVM monitoring option.

1. In the Schedule editor, select the Resource Monitoring  category, and click Add.

2. On the Location  page, for a new resource monitoring location, specify the connection and 

authentication information for the computer that runs the Administration Server instance of Oracle 

WebLogic Server for the domain. If you need to change the port that is used to communicate with 

the Administration Server for the domain, change the information in Connection. Typically, your 

WebLogic system administrator specifies this information.

An Oracle WebLogic domain consists of one or more Oracle WebLogic Server instances. 

One server is the Administration Server. If you want to collect resource monitoring from an 

Oracle WebLogic domain that consisting of multiple servers, the specified host must be the 

Administration Server. The Administration Server is also known as the domain controller.

3. If administrative security is enabled on the Administration Server, select Administrative security 

enabled.

a. Type the user ID and password for Oracle WebLogic Server in Authentication.

b. Select Save Password  to save your password locally. If you do not save your password, you 

might be prompted for it (depending on the host system configuration) when you edit the 

configured location or when you run test schedules that use the location.

4. On the Resource  page, select the type of data to capture. The tree view shows the application 

servers that the Administration Server manages and their counter groups and counters. Be 

selective; monitoring all possible resource data requires substantial amounts of memory. Clear the 

Show only selected counters  check box to see all available counters. Hold your mouse pointer over 

a counter to see details about what that counter measures.

5. Configure the options on the Options  page.

a. In Polling Interval  specify in seconds the interval for collecting resource data. For example, 

if you accept the default of 5 seconds, counter information is collected at 5-second intervals 

from the specified host during the schedule run.

b. In Timeout Interval, type a time value in seconds. If the resource monitoring host does not 

respond within this amount of time during a schedule run, an error is logged.

6. To collect the resource monitoring data for the system under test that is in the cloud, in the Cloud 

Options  tab, click the Location in Public Cloud  check box.

7. Click Next.

8. Specify a location and name and click Finish.
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Related information

Adding Apache HTTP Server sources  on page538

Adding Apache Tomcat sources  on page540

Adding IBM DB2 sources  on page541

Adding IBM Tivoli Monitoring sources  on page544

Adding IBM WebSphere Performance Monitoring Infrastructure sources  on page545

Adding Java Virtual Machine sources  on page547

Adding JBoss Application Server sources  on page548

Adding Microsoft Windows Performance Monitor sources  on page550

Adding Oracle Database sources  on page552

Adding SAP NetWeaver sources  on page555

Adding Simple Network Management Protocol sources  on page557

Adding UNIX rstatd sources  on page558

Adding SAP NetWeaver sources
To capture resource monitoring data from SAP NetWeaver, you must configure the data source.

Before you can capture resource monitoring data from SAP NetWeaver, you must specify the path to the 

client files:

• com_sap_pj_jmx.jar

• exception.jar

• logging.jar

• sapj2eeclient.jar

Specify the path to the client files on the SAP NetWeaver Web Application Server Client Preferences 

page. The SAP NetWeaver client files are provided with SAP NetWeaver, not with IBM®  Rational® 

Performance Tester. The versions of the client files must match the version of SAP NetWeaver running 

on the server under test. Copy the client files to the workbench computer, and then specify the path to the 

files.

The resource monitoring feature was tested on SAP NetWeaver 7.0 (2004s). Resource monitoring from 

other versions of SAP NetWeaver might not be supported.
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1. On the Location  page, specify the connection and authentication information for the instance 

of SAP NetWeaver to use to capture resource monitoring data. If you need to change the port 

for communicating with the computer that is running SAP NetWeaver, change the Connection 

information. Typically, your SAP NetWeaver system administrator specifies this information. 

Use the P4 port to communicate with the computer that is running SAP NetWeaver. The default 

value of the P4 port is 50004. For more information about port numbers, see the SAP NetWeaver 

documentation.

2. Ensure that Administrative security enabled  is selected.

a. Type the user ID and password for SAP NetWeaver in Authentication.

To capture resource monitoring data from SAP NetWeaver, you must use an account with 

administrator rights.

b. Select Save Password  to save your password locally. If you do not save your password, you 

might be prompted for it (depending on the host system configuration) when you edit the 

configured location or when you run test schedules that use the location.

3. On the Resource  page, select the type of data to capture. The tree view shows the application 

server and its counter groups and counters. Be selective; monitoring all possible resource data 

requires substantial amounts of memory. Clear the Show only selected counters  check box to 

see all available counters. Hold your mouse pointer over a counter to see details about what that 

counter measures.

4. Configure the options on the Options  page. Type the Polling Interval  in seconds, for collecting 

resource data. For example, if you accept the default setting of 5 seconds, counter information will 

be collected at 5-second intervals from the specified host during the schedule run.

5. To collect the resource monitoring data for the system under test that is in the cloud, in the Cloud 

Options  tab, click the Location in Public Cloud  check box.

6. Click Next.

7. Specify a location and name and click Finish.

Related information

Adding Apache HTTP Server sources  on page538

Adding Apache Tomcat sources  on page540

Adding IBM DB2 sources  on page541

Adding IBM Tivoli Monitoring sources  on page544

Adding IBM WebSphere Performance Monitoring Infrastructure sources  on page545

Adding Java Virtual Machine sources  on page547
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Adding JBoss Application Server sources  on page548

Adding Microsoft Windows Performance Monitor sources  on page550

Adding Oracle Database sources  on page552

Adding Oracle WebLogic Server sources  on page553

Adding Simple Network Management Protocol sources  on page557

Adding UNIX rstatd sources  on page558

Adding Simple Network Management Protocol sources
To capture resource monitoring data from a Simple Network Management Protocol (SNMP) agent, you 

must configure the data source.

1. On the Location  page, specify the connection and authentication information for the SNMP agent.

2. In MIB path, type or browse to the management information base (MIB) file. Typically, MIB files are 

supplied by manufacturers of devices that support SNMP.

3. On the Resource  page, select the type of data to capture. The tree view shows the counter groups 

and counters that are available from the application server. Be selective; monitoring all possible 

resource data requires substantial amounts of memory. Hold your mouse pointer over a counter to 

see details about what that counter measures.

4. Configure the options on the Options  page.

a. Click Reset counters at start of run (client side reset only)  to set the counters to 0 at the 

start of a schedule run.

This setting does not change the actual values of the counters on the device that runs the 

SNMP agent. Instead, the recorded values of the counters are corrected to start at 0.

b. In Polling Interval, specify in seconds the interval for collecting resource data. For example, 

if you accept the default setting of 5 seconds, counter information is collected at 5-second 

intervals from the specified host during the schedule run.

c. In Timeout Interval, type a time value in seconds. If the resource monitoring host does not 

respond within this amount of time during a schedule run, an error is logged.

5. To collect the resource monitoring data for the system under test that is in the cloud, in the Cloud 

Options  tab, click the Location in Public Cloud  check box.

6. Click Next.

7. Specify a location and name and click Finish.
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Related information

Adding Apache HTTP Server sources  on page538

Adding Apache Tomcat sources  on page540

Adding IBM DB2 sources  on page541

Adding IBM Tivoli Monitoring sources  on page544

Adding IBM WebSphere Performance Monitoring Infrastructure sources  on page545

Adding Java Virtual Machine sources  on page547

Adding JBoss Application Server sources  on page548

Adding Microsoft Windows Performance Monitor sources  on page550

Adding Oracle Database sources  on page552

Adding Oracle WebLogic Server sources  on page553

Adding SAP NetWeaver sources  on page555

Adding UNIX rstatd sources  on page558

Adding UNIX™  rstatd sources
To capture resource monitoring data from the UNIX™  rstatd daemon, you must configure the data source. 

UNIX™  rstatd is bundled with most Linux™  distributions.

To collect resource monitoring data from UNIX™  rstatd, the portmapper service must be enabled on 

the host computer. To determine whether the portmapper service is enabled, type the following on the 

command line of the host computer:

rpcinfo -p localhost

The portmapper service is listed in the output of the rpcinfo  command. If it is not, contact your system 

administrator for help with installing or configuring the portmapper service.

1. On the Resource Monitoring  tab of the schedule editor, click Enable resource monitoring, and then 

click the Add  button.

2. Click Next  and type the hostname of the computer that you want to monitor.

3. In Data Sources, click UNIX rstatd monitor, and on the Locations  tab, specify the connection 

parameters:

a. Click UDP  or TCP  protocol.

b. To use a different port number, click Use port  and type the port number.
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4. On the Resource  tab, select the type of data that you want to capture. The tree view shows all 

available performance counters, with a default set of counters preselected. To see all available 

counters, clear the Show only selected counters  check box.

Be selective; monitoring all possible resource data requires substantial amounts of memory. Hold 

your mouse pointer over a counter to see details about what that counter measures.

5. Configure time interval on the Options  page.

a. In Polling Interval, type a time value in seconds for collecting resource data. For example, 

if you accept the default of 5 seconds, counter information will be collected at 5-second 

intervals from the specified host during the schedule run.

b. In Timeout Interval, type a time value in seconds. If the resource monitoring host does not 

respond within this amount of time during a schedule run, an error is logged.

6. To collect the resource monitoring data for the system under test that is in the cloud, in the Cloud 

Options  tab, click the Location in Public Cloud  check box.

7. Click Next.

8. Specify a location and name and click Finish.

Related information

Adding Apache HTTP Server sources  on page538

Adding Apache Tomcat sources  on page540

Adding IBM DB2 sources  on page541

Adding IBM Tivoli Monitoring sources  on page544

Adding IBM WebSphere Performance Monitoring Infrastructure sources  on page545

Adding Java Virtual Machine sources  on page547

Adding JBoss Application Server sources  on page548

Adding Microsoft Windows Performance Monitor sources  on page550

Adding Oracle Database sources  on page552

Adding Oracle WebLogic Server sources  on page553

Adding SAP NetWeaver sources  on page555

Adding Simple Network Management Protocol sources  on page557
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Resource Monitoring Service
When you apply load to a system under test, the system's resources are consumed increasingly. If the 

capacity of the resources does not match the load, you will notice performance degradation in the results. 

With the Resource Monitoring Service, you can continually observe the health of the system's resources.

To monitor a remote system under test, you can install an agent on that system. For testing, you would 

need many machines. For example, you might have one machine with the application server, another 

machine with the database server, and some machines to apply the user load. Due to network or firewall 

issues, sometimes, it becomes difficult for multiple machines to connect to each other. Resource 

Monitoring Agents are installed on the target machines so that they can establish a connection with 

Rational®  Test Automation Server  to gather resource statistics of the target host.

The agent always initiates the connection with the Resource Monitoring Service. Also, to monitor the 

resources, you must first add them to the Resource Monitoring Service web UI. For example, if you want to 

view the throughput, requests rate, and CPU usage of the Apache server, you must add it as a data source. 

For more information about Resource Monitoring Agents and Services, see Rational®  Test Automation 

Server  documentation.

Starting Resource Monitoring Service
You must access the Resource Monitoring web UI to perform the resource monitoring operations such as 

adding the data sources, counters, and viewing the live performance statistics.

You must have installed IBM®  Rational®  Test Automation Server. For more information about installing 

the software, see Rational®  Test Automation Server  documentation.

1. Go to the Rational®  Test Automation Server  URL.

For example, https://server.ip.nip.io.

2. Enter your user name and password, and then click Login.

Monitoring response time breakdown
You can use response time breakdown to see statistics on any page element that is captured while 

running a test schedule or imported from historical data.

Response time breakdown is a type of application monitoring that shows how much time was spent in 

each part of the system under test as the system was exercised. The response time breakdown view is 

associated with a page element (URL) from a particular execution of a test or schedule. This view shows 

the "insides" of the system under test, because the data collection mechanisms are on the systems under 

https://help.blueproddoc.com/rationaltest/rationaltestautomationserver/index.html
https://help.blueproddoc.com/rationaltest/rationaltestautomationserver/index.html
https://help.blueproddoc.com/rationaltest/rationaltestautomationserver/index.html
https://help.blueproddoc.com/rationaltest/rationaltestautomationserver/index.html
https://help.blueproddoc.com/rationaltest/rationaltestautomationserver/index.html
https://www.ibm.com/support/knowledgecenter/SSBLQQ_server10.0.2/com.hcl.test.server.overview.doc/server_welcome.html
https://www.ibm.com/support/knowledgecenter/SSBLQQ_server10.0.2/com.hcl.test.server.overview.doc/server_welcome.html
https://www.ibm.com/support/knowledgecenter/SSBLQQ_server10.0.2/com.hcl.test.server.overview.doc/server_welcome.html
https://www.ibm.com/support/knowledgecenter/SSBLQQ_server10.0.2/com.hcl.test.server.overview.doc/server_welcome.html
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test, not the load drivers. Response time breakdown provides information down to the Java™  EE method 

level for applications that are running on IBM®  WebSphere®  Application Server or BEA WebLogic Server, 

as well as calls from Java™  EE methods to plain old Java™  objects (POJOs).

You can collect response time breakdown data from HTTP and SOA tests. Response time breakdown 

does not apply to other protocols, such as SAP.

Typically, you capture response time breakdown in real time in development, or test, environments, rather 

than production environments. To capture response time breakdown data, you must enable it in a test or 

schedule and configure the amount of data to be captured.

The data collection infrastructure collects response time breakdown data. Each application server 

on which the application runs and from which you want to collect data must have the data collection 

infrastructure installed and running. In addition, each application server must be configured, or 

instrumented, to use the data collection infrastructure. See the installation guide to learn more about 

installing the data collection infrastructure.

IBM®  Rational®  Performance Tester  provides limited ability to collect response time breakdown data. 

You can collect response time breakdown data for up to four processor cores on one application tier. For 

enhanced response time breakdown collection, contact your account representative to learn more about 

IBM®  Rational®  Application Performance Analyzer. To use Rational®  Application Performance Analyzer, 

you need a license key that is enabled to use the functionality.

Note:  Rational®  Application Performance Analyzer  is a version of Rational®  Performance Tester  that 

is licensed for extended response time breakdown data collection. To install, configure, or use Rational® 

Application Performance Analyzer, follow the documentation for Rational®  Performance Tester.

Enabling response time breakdown collection
You can enable response time breakdown collection to see how much time is spent in each part of the 

application as it runs.

To collect response time breakdown, the data collection infrastructure must be installed, configured, and 

running on all computers that are used in the distributed application under test. To learn how to install 

and configure the data collection infrastructure, see the Installation guide  on page  and Configuring 

the data collection infrastructure  on page . If you enable response time breakdown collection for 

a test and the remote computers are not running the data collection infrastructure, the following error 

is displayed: IWAY0159E The data collection infrastructure does not appear to be running on 

hostname. Please ensure that it is running and try again.
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1. Open a schedule in the editor.

2. In the Schedule Element Details  area, click the Response Time Breakdown  tab.

3. Select Enable collection of response time data.

This activates the test list, the location list, and Options.

4. Click Add.

• To add a new response time breakdown location, select Add New.

• To add an existing response time breakdown location, select Add Existing.

Add locations for every application server from which to collect response time breakdown 

information.

You have enabled response time breakdown data collection.

Set logging detail levels.

Related information

Importing response time breakdown data - Legacy Reports  on page

Configuring the data collection infrastructure  on page

Enabling response time breakdown collection on Windows™  Vista, 
Windows™  7, and Windows™  Server 2008
Microsoft™  Windows™  Vista, Windows™  7, and Windows™  Server 2008 include security features that 

are not in previous versions of Windows™. You must adjust the security settings of these operating 

systems to collect response time breakdown data. The default security settings do not allow response 

time breakdown collection. By default, the firewall blocks inbound connection attempts. You must create 

an inbound connection rule to allow the IBM®  Rational®  Performance Tester  Agent to connect to the 

computer.

To collect response time breakdown, the data collection infrastructure must be installed, configured, 

and running on all computers that are used in the distributed application under test. To learn how to 

install the data collection infrastructure, see the Installation guide  on page . If you enable response 

time breakdown collection for a test and the remote computers are not running the data collection 

infrastructure, the following error is displayed: IWAY0159E The data collection infrastructure does 

not appear to be running on hostname. Please ensure that it is running and try again.

1. Open the Windows™  Administrative Tools Control Panel, and click Local Security Policy.

The Local Security Policy  window opens.

unique_411
unique_411
unique_410
unique_410
unique_409
unique_409


Chapter 1. Test Author Guide

2. Expand Windows Firewall with Advanced Security.

3. Expand Windows Firewall with Advanced Security - Local Group Policy Object.

4. Select Inbound Rules. Right-click the pane on the right, and select New Rule; then complete these 

steps:

a. On the Rule Type  page, select Port; then click Next.

b. On the Protocol and Port  page, select TCP, and enter these ports: 10002, 10003, 10004, 

10005, 10006; then click Next.

c. On the Action  page, ensure that Allow the Connection  is selected; then click Next.

d. On the Profile  page, select all profiles; then click Next.

e. On the Name  page, type a name, for example, Remote Agent Controller, and click Finish.

5. Right-click the new rule, and select Enable Rule.

Related information

Configuring the data collection infrastructure  on page

Setting logging levels
To limit the amount of response time breakdown data collected, adjust logging levels.

To set logging levels, you need to have a schedule where you have enabled response time breakdown 

data collection.

1. Open a schedule in the editor.

2. In the Schedule Element Details area, click the Response Time Breakdown  tab.

3. Choose a Detail level  of Low, Medium, or High.

4. If you set the detail level to High  or Medium, also click Only sample information from a subset of 

users  to prevent the log from getting too large.
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a. Click Fixed number of users, and type a number to specify that the given number of users 

from each group is sampled. Unless you have specific reasons to collect data from multiple 

users, select Fixed number of users, and specify one user per user group.

b. You can also click Percentage of users, and specify a percentage. That percentage is 

sampled from each user group, but at least one user is sampled from each user group.

Now you can run schedules and capture response time breakdown data.

Related information

Filtering POJO packages, methods, and classes  on page565

Enabling response time breakdown collection for specific page elements
You can enable response time breakdown for specific pages or page elements to see how much time is 

spent in each part of the application as the schedule runs. Enabling response time breakdown collection 

for only certain page elements can be useful if you want to minimize the amount of collected data. 

Enabling response time breakdown collection for a whole test or schedule can require substantial 

amounts of memory.

To collect response time breakdown, the data collection infrastructure must be installed, configured, and 

running on all computers that are used in the distributed application under test. To learn how to install 

and configure the data collection infrastructure, see the installation guide  on page  and Configuring 

the data collection infrastructure  on page . If you enable response time breakdown collection for 

a test and the application servers are not running the data collection infrastructure, the following error 

is displayed: IWAY0159E The data collection infrastructure does not appear to be running on 

hostname. Please ensure that it is running and try again.

1. Open a test in the editor.

2. Expand the list under Test Contents  to display the pages or page elements of interest.

3. Select the pages or page elements to collect response time breakdown data for. Under Test 

Element Details, select Enable response time breakdown. You might need to scroll down in the test 

editor view to display the Enable response time breakdown  check box.

The Enable response time breakdown  check box is displayed only for elements that support 

response time breakdown data collection. The specific elements that support response time 

breakdown vary depending on the protocol (HTTP, SAP, Citrix, and so on).

../../com.ibm.rational.test.lt.install.doc/topics/c_installingproduct.html
../../com.ibm.rational.test.lt.install.doc/topics/c_installingproduct.html
../../com.ibm.rational.test.lt.install.doc/topics/c_installingproduct.html
../../com.ibm.rational.test.lt.install.doc/topics/c_installingproduct.html
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Note:  Restricting the scope of the response time breakdown collection improves performance 

and memory utilization. Enable response time breakdown at as fine-grained a level as possible. 

Enabling response time breakdown at too broad a scope can greatly increase the time spent in 

areas with a large number of Java™  EE interactions.

You are prompted to select an existing response time breakdown location or to add a new 

response time breakdown location.

4. To add other response time breakdown locations, click Add  on the Advanced  page.

• To add a new response time breakdown location, select Add New.

• To add an existing response time breakdown location, select Add Existing.

Add locations for every server from which to collect response time breakdown information.

You have enabled response time breakdown data collection for the specified page elements.

Related information

Configuring the data collection infrastructure  on page

Filtering POJO packages, methods, and classes
You can filter selected plain old Java™  object (POJO) packages, methods, and classes from response 

time breakdown collection.

Create a test or schedule that is enabled for response time breakdown collection.

1. Open the location that you used for response time breakdown collection.

2. Click the General Properties  tab.

3. Click Add  to create a new property.

4. In the New Property  window, type RTB_POJO_EXCLUDE  for the Property Name.

5. In Property Value, type a semicolon-separated list of the POJO packages, methods, and classes to 

filter.

Use an asterisk (*) for a wildcard character.

When you run the test again, the POJO methods and classes that you selected are filtered from 

response time breakdown collection.

Assume that the RTB_POJO_EXCLUDE property has this property 

value:com.ibm._js*;com.ibm.websphere.samples.plantsbywebspherewar.*;com.ibm.websphere.samples.plantsbywebsphereejb.Util.debug. 

All packages with names that start with com.ibm._js, the 
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com.ibm.websphere.samples.plantsbywebspherewar  package, and the 

com.ibm.websphere.samples.plantsbywebsphereejb.Util.debug  method are excluded from 

response time breakdown results.

Setting log and statistic levels
Within a schedule, you set the size and sampling rate of the test log and the problem determination log, as 

well as the statistics that are displayed during a run.

Setting the statistics displayed during a run
You can set the type of data that you see during a run, the sampling rate for that data, and whether data is 

collected from all users or a representative sample.

To set the level of statistics logging:

1. In the Test Navigator, browse to the schedule and double-click it.

The schedule opens.

2. In the Schedule Contents area, click the name of the schedule.

3. On the Statistics page, set Statistics log level  to one of the following options:

Option Description

None

No statistics are displayed during the run, 

and any report that depends on statistics is 

not generated. At the end of the run, you see 

only a Summary report that contains three 

items: the time the run took, whether the re

sults were on the local computer (or, if a re

mote location, which one), and the status of 

the run, which is Complete.

Schedule Actions

Select this option if you are interested only in 

the number of users. Schedule actions report 

the number of active and completed users in 

the run.
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Option Description

Primary Test Actions

Select this option to limit the processing re

quired by the workbench. Primary test actions 

include all schedule actions plus:

• For HTTP tests, HTTP page-related ac

tions (attempts, hits, and verification 

points).

• For SAP tests, SAP screens.

• For Citrix tests, all keyboard and 

mouse actions.

• For socket tests, this option does not 

apply.

Secondary Test Actions

Select this option to limit the processing re

quired by the workbench. Secondary test ac

tions include all primary test actions plus 

HTTP page element–related actions.

• For HTTP tests, HTTP page ele

ment–related actions.

• For SAP tests, SAP screen element–re

lated actions.

• For Citrix tests tests, statistics are 

identical to Primary Test Actions.

• For socket Send and Receive actions, 

the exchanged data is also available in 

the test log, by means of attachments.

All

For HTTP, SAP, and Citrix tests, provides sta

tistics for all actions.

For socket Send and Receive actions, the ex

changed data is also available in the test log, 

by means of attachments.

4. In Statistics sample interval, type a number and select a time unit.

When you run a schedule, the reports show such information as response time during a specific 

interval, the frequency of requests being transferred during an interval, and average response trend 

during an interval. You set this interval here.
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5. To set a sampling rate, select Only sample information from a subset of users, then select one of 

the following options.

The number or the percentage that you specify is applied to each user group. If you are running 

user groups at remote locations, the number or percentage that you select is distributed evenly 

among the remote locations.

Option Description

Fixed number of users

The number is applied to each user group. 

Assume that a schedule contains two user 

groups. One group contains four users, and 

another group contains 1000 users. If you 

specify “2”  for this option, two users are sam

pled from each group.

Percentage of users

The percentage is applied to each user group, 

but at least one user will be sampled from 

each group. Assume that a schedule con

tains two user groups. One group contains 

four users, and another group contains 1000 

users. If sampling rate is set to 10%, one user 

is sampled from the first group, and 100 

users are sampled from the second group. 

Similarly, if sampling rate is set to 25%, one 

user is sampled from the first group, and 250 

users are sampled from the second group.

6. Typically, you should select Only store All Hosts statistics.

Selecting this option reduces the amount of statistical data stored, thus enabling you to test a 

larger load over a longer period of time with significantly less memory usage. Although you will 

not be able to analyze data from each computer that adds to your test, this data is generally not of 

interest.

However, if you are running a test over different WANs—and if you are interested in seeing the data 

from each remote computer—you should clear this box.
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Related information

Setting the data that the test log collects  on page569

Setting the problem determination level for schedules  on page575

Setting problem determination level for tests  on page578

Setting the data that the test log collects
The test log shows the events that occurred during a run. By setting the level of information that is 

collected for a schedule run, you can control whether you receive individual response-time statistics for 

Page Percentile reports and information about verification points. You can set the level of detail for each 

type of event: errors, warnings, and other events.

The level of information collection directly affects log sizes. Depending on the setting that you select, the 

logs can become quite large. By limiting the log level and collecting the information from a representative 

sample of users, you can decrease your log size and still have sufficient information for analysis.

For example, if you are debugging a test, you might set all three What to Log  fields to All  or Action Details. 

These settings produce large test logs, especially if your tests are long or you are running a large number 

of users. Large test logs, in turn, increase the test log transfer time, and might even cause your computer 

to run out of disk space or the agent computer to run out of memory. To reduce transfer times and the 

likelihood of running out of disk space, sample information from a very small subset of users; smaller 

even than the default of 5 users per user group. A fixed sampling rate samples the same number of virtual 

users from each group. A percentage sampling rate samples a percentage of virtual users from each 

group, but guarantees that at least one user is sampled from a group.

To set the amount of information collected in the test log and the rate of sampling:

1. In the Test Navigator, browse to the schedule, and double-click it.

The schedule opens.

2. In the Schedule Contents  area, click the name of the schedule.

3. On the Test Log page, select the types of events that you want to collect under What to Log. You 

can collect errors only, errors and warnings, or all events. In other words, Also show warnings  and 

And also show all other types  are unavailable until you select Show errors and failures. Similarly, 

And also show all other types  is unavailable until you select Also show warnings. If none of the 

What to Log  check boxes are selected, no test log events are collected.

4. For each type of event, set the Log Level  to one of the following options:
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Option Description

Schedule Actions

Collects events that correspond to actions ex

ecuted in the schedule:

• The overall schedule verdict. The ver

dict can be one of these values:

◦ Pass  indicates that all verifica

tion points matched or received 

the expected response. For ex

ample, a response code verifi

cation point is set to PASS  when 

the recorded response code 

is received during playback. If 

your test does not contain verifi

cation points, PASS  means that 

all primary requests in the test 

were successful.

◦ Fail  indicates that at least one 

verification point did not match 

the expected response or that 

the expected response was not 

received.

◦ Error  indicates one of the fol

lowing results: a primary re

quest was not successfully sent 

to the server, no response was 

received from the server for a 

primary request, or the primary 

request response was incom

plete or could not be parsed.

• The start and stop time of the sched

ule, each user group, each virtual user, 

and each test invocation.
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Option Description

• The start and stop time of each loop 

iteration, if loops are set in the sched

ule.

• The start and stop time of each selec

tor, if selectors are set.

Primary Test Actions

Typically, you set data collection at this lev

el. Primary test actions include schedule ac

tions, plus the following actions:

• Test verdict, test start, and test stop 

events.

• Loop iteration start and loop iteration 

stop events, if loops are present in the 

test.

• Transaction start and stop events if 

transactions are present in the test.

• For HTTP tests, Page title verification 

points. With this option you can see 

any page title verification points that 

you have set. The following events are 

collected:

◦ The page verdict. You see a 

page verdict only if a connec

tion problem occurs or if you 

have set verification points. Any 

failures or errors are rolled up to 

the test verdict level.

◦ The start and stop time of each 

page.

◦ The start and stop time of each 

loop, and the number of itera

tions of each loop, if you have 

set loops within a page.

◦ The start and stop time of each 

transaction, and the duration of 
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Option Description

each transaction, if you have set 

page-level transactions in your 

test.

• For SAP tests, SAP screen information, 

such as SAP screen title verification 

points.

• For Citrix tests, connection elements, 

window events, and image synchro

nizations

• For socket tests, connect, send, re

ceive, and close elements.

Secondary Test Actions

Secondary test actions include primary test 

actions, plus this information:

• For HTTP tests, request-level events. 

To collect information about response 

code or response size verification 

points that you have set, set data col

lection at this level of detail or greater.

◦ The time that the first byte and 

last byte were sent.

◦ The time that the first byte and 

last byte were received.

◦ The character set of the re

sponse data.

◦ Expected and actual values of 

page-level verification points 

that you have defined.

◦ HTTP think events.

◦ The start and stop time of each 

transaction, and the duration 

of each transaction, if you have 

set request-level transactions in 

your test.

• For SAP tests, SAP element informa

tion (primarily Set Property or Call 

Method actions).
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Option Description

• For Citrix tests, synchronization points, 

delays, text elements, and logoff ele

ments.

• For socket tests, this option does not 

apply.

Action Details

Action details include secondary test actions, 

plus this information:

• For HTTP tests, request and response 

data; for example, HTTP headers and 

any request data.

• For SAP tests, think time information.

• For Citrix tests, think time information, 

mouse actions, and keyboard actions.

• For socket tests, this option does not 

apply.

All

For HTTP, SAP, and Citrix tests, All  and Action 

Details  provide the same information.

For socket send and receive actions, the ex

changed data is also available in the test log, 

by means of attachments.

5. To set a sampling rate, select Only sample information from a subset of users.

The number or percentage that you select is applied to each user group. If you are running user 

groups at remote locations (that is, on agent computers), the number or percentage that you select 

is distributed evenly among each location.

Option Description

Fixed number of users

The number is applied to each user group. 

Assume that a schedule contains two user 

groups. One group contains four users, and 

another group contains 1000 users. If you 

specify “2”  for this option, two users are sam

pled from each group.

Percentage of users
The percentage is applied to each user group, 

but at least one user will be sampled from 
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Option Description

each group. Assume that a schedule con

tains two user groups. One group contains 

four users, and another group contains 1000 

users. If sampling rate is set to 10%, one user 

is sampled from the first group, and 100 

users are sampled from the second group. 

Similarly, if sampling rate is set to 25%, one 

user is sampled from the first group, and 250 

users are sampled from the second group.

6. If you want to log health failure events irrespective of the standard Test Log  settings, enter a value 

in Number of health failure events to log (regardless of logging level). By default, this option is set 

to 50  and is useful to limit the number of events in the Test Log for playbacks that are expected to 

generate many failures.

Option Description

Fixed number of users

The number is applied to each user group. 

Assume that a schedule contains two user 

groups. One group contains four users, and 

another group contains 1000 users. If you 

specify “2”  for this option, two users are sam

pled from each group.

Percentage of users

The percentage is applied to each user group, 

but at least one user will be sampled from 

each group. Assume that a schedule con

tains two user groups. One group contains 

four users, and another group contains 1000 

users. If sampling rate is set to 10%, one user 

is sampled from the first group, and 100 

users are sampled from the second group. 

Similarly, if sampling rate is set to 25%, one 

user is sampled from the first group, and 250 

users are sampled from the second group.

With the default settings for the Test Log, where Show errors and failures  option is set to All, the 

value specified in this field is relevant only if you are sampling for a subset of users. If you are not 
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sampling for a subset of users, all the errors or failures will be logged regardless of the value in this 

field.

If you clear the Show errors and failures  or select the Only sample information from a subset of 

users, then you can use Number of health failure events to log (regardless of logging level)  option 

to control how many failures appear in the test log. You can further refine which failure events are 

logged by setting the Affects page health  to No  in the Error Handling  page.

Perform the following sub-steps to minimize the logging of failure events:

a. Clear all the What to Log  options.

b. Set the Number of health failure events to log (regardless of logging level)  to 0.

c. Disable the Execution Event Console by clearing the When schedules start  check box in the 

Execution Event Console  settings because failures are logged if they are reported in the 

Execution Event Console  page.

The default setting, to log all errors and warnings, as well as primary test actions, fits most purposes. 

However, you can log any type of information, from no information to all information from all users, 

although neither is a typical situation.

• To see only errors and warnings, set the first two What to Log  check boxes to All  and clear the third 

check box, And also show all other types, to avoid logging successful events.

• To check a schedule's structure, when you are not interested in the test execution results, set all 

three What to Log  boxes to Schedule Actions.

Both choices, as well as the default setting, will limit the size of the test log and reduce the total 

time to run the schedule by significantly shortening the test log transfer time at the end of a test.

If you are debugging a test, you might set all three What to Log  fields to All  or Action Details. These 

settings produce large test logs, especially if your tests are long or you are running a large number of 

users. Large test logs, in turn, increase the test log transfer time, and might even cause your computer to 

run out of disk space.

Related information

Setting the statistics displayed during a run  on page566

Setting the problem determination level for schedules  on page575

Setting problem determination level for tests  on page578
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Setting the problem determination level for schedules
You can set the level of information that is saved in the problem determination log during a run. By 

default, only warnings and severe errors are logged. Typically, you change this log level only when 

requested to do so by the Support person.

The problem determination logs contain internal information about the playback engine. These logs 

are particularly useful for debugging problems such as Kerberos authentication, SSL negotiation, 

and resource constraints on an agent. The log files are named CommonBaseEvents00.log 

and are located in the deployment directory. For example, if you play back a schedule 

on an agent and set C:\Agent  as the deployment directory, the problem determination 

log files are in a directory similar to C:\Agent\deployment_root\<UserName>

\A1E14699848784C00D2DEB73763646462\CommonBaseEvents00.log. If a large amount of log 

information is generated, multiple CommonBaseEvents  files are created.

To set the level of problem-determination logging and the sampling rate:

1. In the Test Navigator, browse to the schedule and double-click it.

The schedule opens.

2. In the Schedule Contents area, click the name of the schedule.

3. On the Problem Determination page, set Problem determination log level  to one of the following 

options:

Option Description

All, Finest, Finer, Fine
Set these options only if you are requested to 

do so by technical support.

Config

Logs static configuration messages. Config

uration messages, which include hardware 

specifications or system profiles, require no 

corrective action.

Info

Logs informational messages. Information

al messages, which include system state, re

quire no corrective action.

Warning

Logs warning messages. This is the default 

setting. Warning messages, which might indi

cate potential problems, require no corrective 

action.



Chapter 1. Test Author Guide

Option Description

Severe

Logs critical and unrecoverable errors. Crit

ical and unrecoverable messages interrupt 

normal program execution, and require cor

rective action.

None Turns logging off.

4. To set a sampling rate, select Only sample information from a subset of users.

The number or the percentage that you select is applied to each user group. If you are running 

user groups from remote locations, the number or percentage that you select is distributed evenly 

among the remote locations.

Option Description

Fixed number of users

The number is applied to each user group. 

Assume that a schedule contains two user 

groups. One group contains four users, and 

another group contains 1000 users. If you 

specify “2”  for this option, two users are sam

pled from each group.

Percentage of users

The percentage is applied to each user group, 

but at least one user will be sampled from 

each group. Assume that a schedule con

tains two user groups. One group contains 

four users, and another group contains 1000 

users. If sampling rate is set to 10%, one user 

is sampled from the first group, and 100 

users are sampled from the second group. 

Similarly, if sampling rate is set to 25%, one 

user is sampled from the first group, and 250 

users are sampled from the second group.

When a user group runs on your local computer, the problem determination logs are in the 

deployment_root  directory in your workspace. When a user group runs at a remote location, which 

is the typical use case, each remote location has a deployment directory, which you define and which is 

listed on the Locations page for that user group.
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Note:  Common Base Event XML logs from remote locations use Universal Coordinated Time (UTC), 

also called Zulu time, which is likely different from your local time. For example, Eastern Standard Time 

(EST) is 5 hours behind UTC time.

To view the problem determination log, open the log file in an XML editor. Select the log whose timestamp 

matches that of the problem run. The most recent log has the suffix 00.log.

Related information

Setting the statistics displayed during a run  on page566

Setting the data that the test log collects  on page569

Setting problem determination level for tests  on page578

Setting problem determination level for tests
You can set the level of information that is saved in the problem determination log during a run. By 

default, only warnings and severe errors are logged. Typically, you change this log level only when 

requested to do so by the Support person.

The problem determination logs contain internal information about the playback engine. These logs 

are particularly useful for debugging problems such as Kerberos authentication, SSL negotiation, 

and resource constraints on an agent. The log files are named CommonBaseEvents00.log 

and are located in the deployment directory. For example, if you play back a schedule 

on an agent and set C:\Agent  as the deployment directory, the problem determination 

log files are in a directory similar to C:\Agent\deployment_root\<UserName>

\A1E14699848784C00D2DEB73763646462\CommonBaseEvents00.log. If a large amount of log 

information is generated, multiple CommonBaseEvents  files are created.

1. Open the test for which you want to set the problem determination log level.

2. Select the root node and from the Test Details  section, select Problem Determination.

3. On the Problem Determination page, set Problem determination log level  to one of the following 

options:

Option Description

All, Finest, Finer, Fine
Set these options only if you are requested to 

do so by technical support.

Config
Logs static configuration messages. Config

uration messages, which include hardware 
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Option Description

specifications or system profiles, require no 

corrective action.

Info

Logs informational messages. Information

al messages, which include system state, re

quire no corrective action.

Warning

Logs warning messages. This is the default 

setting. Warning messages, which might indi

cate potential problems, require no corrective 

action.

Severe

Logs critical and unrecoverable errors. Crit

ical and unrecoverable messages interrupt 

normal program execution, and require cor

rective action.

None Turns logging off.

4. Save the test.

Related information

Setting the statistics displayed during a run  on page566

Setting the data that the test log collects  on page569

Setting the problem determination level for schedules  on page575
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user's responsibility to evaluate and verify the operation of any non-IBM®  product, program, or service.

IBM®  may have patents or pending patent applications covering subject matter described in this 

document. The furnishing of this document does not grant you any license to these patents. You can send 

license inquiries, in writing, to:

IBM Director of Licensing

IBM Corporation

North Castle Drive, MD-NC119

Armonk, NY 10504-1785

US

For license inquiries regarding double-byte character set (DBCS) information, contact the IBM® 

Intellectual Property Department in your country or send inquiries, in writing, to:

Intellectual Property Licensing

Legal and Intellectual Property Law

IBM Japan Ltd.

19-21, Nihonbashi-Hakozakicho, Chuo-ku

Tokyo 103-8510, Japan

INTERNATIONAL BUSINESS MACHINES CORPORATION  PROVIDES THIS PUBLICATION "AS IS" WITHOUT 

WARRANTY OF ANY KIND, EITHER EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE 

IMPLIED WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS FOR A PARTICULAR 

PURPOSE. Some jurisdictions do not allow disclaimer of express or implied warranties in certain 

transactions, therefore, this statement may not apply to you.

This information could include technical inaccuracies or typographical errors. Changes are periodically 

made to the information herein; these changes will be incorporated in new editions of the publication. 
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IBM®  may make improvements and/or changes in the product(s) and/or the program(s) described in this 

publication at any time without notice.

Any references in this information to non-IBM®  websites are provided for convenience only and do not in 

any manner serve as an endorsement of those websites. The materials at those websites are not part of 

the materials for this IBM®  product and use of those websites is at your own risk.

IBM®  may use or distribute any of the information you provide in any way it believes appropriate without 

incurring any obligation to you.

Licensees of this program who wish to have information about it for the purpose of enabling: (i) the 

exchange of information between independently created programs and other programs (including this 

one) and (ii) the mutual use of the information which has been exchanged, should contact:

IBM Director of Licensing

IBM Corporation

North Castle Drive, MD-NC119

Armonk, NY 10504-1785

US

Such information may be available, subject to appropriate terms and conditions, including in some cases, 

payment of a fee.

The licensed program described in this document and all licensed material available for it are provided by 

IBM®  under terms of the IBM®  Customer Agreement, IBM®  International Program License Agreement or 

any equivalent agreement between us.

The performance data discussed herein is presented as derived under specific operating conditions. 

Actual results may vary.

Information concerning non-IBM®  products was obtained from the suppliers of those products, their 

published announcements or other publicly available sources. IBM®  has not tested those products and 

cannot confirm the accuracy of performance, compatibility or any other claims related to non-IBM® 

products. Questions on the capabilities of non-IBM®  products should be addressed to the suppliers of 

those products.

Statements regarding IBM®'s future direction or intent are subject to change or withdrawal without notice, 

and represent goals and objectives only.

This information contains examples of data and reports used in daily business operations. To illustrate 

them as completely as possible, the examples include the names of individuals, companies, brands, and 

products. All of these names are fictitious and any similarity to actual people or business enterprises is 

entirely coincidental.
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This information contains sample application programs in source language, which illustrate programming 

techniques on various operating platforms. You may copy, modify, and distribute these sample programs 

in any form without payment to IBM®, for the purposes of developing, using, marketing or distributing 

application programs conforming to the application programming interface for the operating platform 

for which the sample programs are written. These examples have not been thoroughly tested under 

all conditions. IBM®, therefore, cannot guarantee or imply reliability, serviceability, or function of these 

programs. The sample programs are provided "AS IS", without warranty of any kind. IBM®  shall not be 

liable for any damages arising out of your use of the sample programs.

Each copy or any portion of these sample programs or any derivative work must include a copyright 

notice as follows: 

© (your company name) (year). 

Portions of this code are derived from IBM Corp.  Sample Programs. 

© Copyright IBM Corp.  2000, 2017.

Trademarks
IBM®, the IBM®  logo, and ibm.com®  are trademarks or registered trademarks of International Business 

Machines Corp., registered in many jurisdictions worldwide. Other product and service names might be 

trademarks of IBM®  or other companies. A current list of IBM®  trademarks is available on the web at 

"Copyright and trademark information" at www.ibm.com/legal/copytrade.shtml.

Terms and conditions for product documentation
Permissions for the use of these publications are granted subject to the following terms and conditions.

Applicability

These terms and conditions are in addition to any terms of use for the IBM®  website.

Personal use

You may reproduce these publications for your personal, noncommercial use provided that all proprietary 

notices are preserved. You may not distribute, display or make derivative work of these publications, or 

any portion thereof, without the express consent of IBM®.

Commercial use

You may reproduce, distribute and display these publications solely within your enterprise provided that all 

proprietary notices are preserved. You may not make derivative works of these publications, or reproduce, 

http://www.ibm.com/legal/us/en/copytrade.shtml
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distribute or display these publications or any portion thereof outside your enterprise, without the express 

consent of IBM®.

Rights

Except as expressly granted in this permission, no other permissions, licenses or rights are granted, either 

express or implied, to the publications or any information, data, software or other intellectual property 

contained therein.

IBM®  reserves the right to withdraw the permissions granted herein whenever, in its discretion, the use 

of the publications is detrimental to its interest or, as determined by IBM®, the above instructions are not 

being properly followed.

You may not download, export or re-export this information except in full compliance with all applicable 

laws and regulations, including all United States export laws and regulations.

IBM®  MAKES NO GUARANTEE ABOUT THE CONTENT OF THESE PUBLICATIONS. THE PUBLICATIONS 

ARE PROVIDED "AS-IS" AND WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESSED OR IMPLIED, 

INCLUDING BUT NOT LIMITED TO IMPLIED WARRANTIES OF MERCHANTABILITY, NON-INFRINGEMENT, 

AND FITNESS FOR A PARTICULAR PURPOSE.

IBM Online Privacy Statement
IBM Software products, including software as a service solutions, (Software Offerings) may use cookies 

or other technologies to collect product usage information, to help improve the end user experience, 

to tailor interactions with the end user, or for other purposes. In many cases no personally identifiable 

information is collected by the Software Offerings. Some of our Software Offerings can help enable you 

to collect personally identifiable information. If this Software Offering uses cookies to collect personally 

identifiable information, specific information about this offering use of cookies is set forth below.

This Software Offering does not use cookies or other technologies to collect personally identifiable 

information.

If the configurations deployed for this Software Offering provide you as customer the ability to collect 

personally identifiable information from end users via cookies and other technologies, you should seek 

your own legal advice about any laws applicable to such data collection, including any requirements for 

notice and consent.

For more information about the use of various technologies, including cookies, for these purposes, 

see IBM's Privacy Policy at http://www.ibm.com/privacy  and IBM's Online Privacy Statement at http://

www.ibm.com/privacy/details  in the section entitled Cookies, Web Beacons and Other Technologies, 

and the IBM Software Products and Software-as-a-Service Privacy Statement at http://www.ibm.com/

software/info/product-privacy.
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